
Read Me
Version 2.5
=====================================================
This Read Me file contains Tips, Tricks and Known Issues. Please refer to the Quick Start and
Manual for Installation Instructions/Fundamentals, and the Release Notes for New Features.

A new Dongle and Sentinel Driver are required to run v2.5. Contact Error! Bookmark not
defined. with any questions.

When importing a v2.0 project in v2.5 software, please make sure all aspects of the project
converted over properly.  Since there are new features in the v2.5 software, it is extremely
difficult for us to “guarantee” perfect transfer.  It is the user’s responsibility to ensure proper setup
in the new version.

Tips and Tricks

Slide Shows
a) For consistent/reliable Playback of Slide Shows, it is recommended that the Slide Show

contain an audio track.
#2071, TN#169

b) When combining slide shows and video files in the same timeline, it is suggested that to
ensure reliable playback from players, use “create sync audio track”. Associating the
appropriate audio files for the video, and (as long as they are not the first file in the
timeline) nothing for the slides. This way silence will be placed where the slides are
located, and a seamless transition will go directly into the video/audio file, helping to
ensure that the player will not have trouble.

c) This technique can also be used for slide show only movies. After creation of the slide
show, select “create sync audio track”. Leave the “sync to audio timecode” selection
checked. Specify an audio file that has timecode associated to it, to correlate with the
first slide. Select “create sync audio”. The Create Sync Audio feature will compare the
timecode associated to the video (slide in this case) with that of the selected audio file, if
it finds common (same) timecode information it will sync accordingly, if it does not find
any common (same) information it will insert silence. Since Slides contain no associated
timecode information, silence will be the resultant audio track.

d) If you find that the thumbnail display of slides in the timeline looks distorted or you are
seeing inconsistent behavior when playing back the slides within the timeline, it is
suggested that you close the project, and throw away the Thumbnails and
MPEGConverted folders located in the directory where the slides are located.
Sometimes these files may become corrupted, this most commonly occurs when
changing versions. By throwing them away, new files will be generated when the project
is re-opened. FYI: The MPEG Converted files are the .prv files that are generated when
the slides are placed in the Asset Bin. The Thumbnails are files which are generated
when the slide are dragged into the timeline.

Mixed/Multi-Angle
a) The total of:

Highest Video Bitrate + All Audio Track Bitrates + All Subtitles Track Bitrates
Cannot exceed 8mbs.

Preferences
a) The Preferences that are set when the project is started are the ones that apply to the

default movie/menu. Changing Default settings does not affect existing movies/menus,
only newly created, after the default has been changed.
#2764

Timeline
a) Assets are now locked when playback/pause is initiated from the timeline. Stop must be

engaged prior to moving any assets.
b) Importing a .chp (Chapter List) into the timeline will delete any existing chapter points.

#2860
c) If multiple assets with redundant timecodes are located in the same timeline, it is

suggested that Zero Based be selected as the display for the timeline.
#2500

d) With INVT material, if Chapter Increments of 15 are desired on the timeline, it is
suggested to use a GOP size of 12 during encoding.

e) Thumbnail and full frame support for all aspect Ratios has been implemented.

Command Sequences/Register Mapping
a) “Reset Names” resets the naming structure for the selected GPRM(Register) only. To

reset names for all GPRM’s (Register’s), select GPRM0, reset name; select GPRM1,
reset name; select GPRM2, reset name; etc… .
#2760

b) Care should be exercised when loading command sequences from version 2.0 and
editing the 2.5 register mappings.  For best results registers should be re-mapped only
for new command sequences created in version 2.5.

Create Sync Audio Track
a) This feature can be used even if only one video file exists within the timeline. Because of

the increased functionality with the new Implementation “Create Sync Audio Track” can
be used, in a sense, to edit/trim the audio file to match the video file. Example: If the
audio file is longer at the head (starts earlier than the video file) it will trim the file to
match the video, as opposed to placing the file on the timeline and aligning the start of
the video with the start of the audio file, potentially resulting in sync issues. See the
Manual for Specific Functionality Instructions.
#1181, 1192

b) Only Like files (type, bitrate, coding mode) can be concatenated together.
#1165

DVD-R
a) We have found great reliability if you don't have a disc in the player when you hit the

button "Write to DVD-R in the foreground".  The application then prompts you with a
"Please insert blank media and hit ok".  At this point, open the drive door and place a
blank DVD-R in it.  Now DON'T close the door manually.  Hit the ok button and
everything is taken care of for you.
TN#85, #575

b) It is recommended to name the DVD Volume both in the Project Properties as well as
Disc Image Properties since the Project’s Name is maintained separately from the DVD
Volume name within the Disc Image Properties. If no name is specified, it will default to
UNDEFINED.
#1913

Overall Project
a) A First Play MUST be assigned. Previous functionality was that if no First Play was

assigned, VTS1 would default playing. Now nothing will play.
TN#168

MPX2000
a) Disable any screen saver that may be active on your computer, it can adversely affect

the functionality of the Serial Port connection located on the MPX2000.
TN#170

b) Currently the Default settings are 5 for 1 Pass VBR and 16 for 2 Pass VBR. These are
optimal for the MPX2000.



c) Encoding I-Only or IP GOP structures with “DVD Compliant” Selected will conform to
DVD compliancy resulting in the “Low-Delay” Bit set to “OFF”. For Mpeg2 compliancy
and setting the “Low-Delay” Bit to “ON”, Un-Select “DVD Compliant”, the resultant
streams will be Non-DVD Compliant and therefore unusable within the Authoring Tool.

d) When using “CUE CONTROL” for Machine control, clicking an d holding the slider bar all
the way to the Left or Right, will now FF or REW the VTR.

e) The Digital Connect should be powered “OFF” when installing the MPX2000 Drivers.

MPX3000
a) Prior to initiation of the first encode of the day, it is suggested to play the source tape,

select “preview” only and just do a play through to confirm that signal flow is correct and
that the buffers are stable and flowing properly.

b) If Inverse Telecine was applied to the original encode. The Inverse Telecine option is
grayed out and checked during segment re-encode. This is due to the fact that the INVT
pattern information is saved off from the main video file and is being re-applied for the
segment re-encode. Therefore INVT will automatically be applied if it existed in the
original video file.

c) The Minimum bitrate for MPEG2 has been lowered to 1mbs. For best results when
encoding MPEG2 at 1 or 2mbs it is suggested that ½ D-1 Scaling be used.
#2590

d) PCM and Mpeg1 Layer 2 Audio Encoding is supported with the MPX3000. Just as with
AC3 encoding, the Audio input signal must be connected to ch. ½ of the audio breakout
cable connected to the MPX3000.

e) A Manual Prompt has been implemented, allowing for more accurate control of manual
encoding. After the manual encode is initiated and elementary stream is named, the user
is prompted to hit play on the VTR and select OK when the desired punch In point is
reached. Encoding begins directly at the point when OK is selected.

f) The Length value within the encoder can now be displayed both as NDF and DF for
NTSC.

g) A .enc file is now being generated for every encode. All of the parameters for the encode
are retained within this file. The .enc file can then be “Loaded” to restore the original
encoding parameters.

h) “Restore to Defaults” no longer changes the Picture Rate. This means that all other
settings will be returned to a default state, while the Picture Rate retains the existing
setting.
#3022

i) The ability to start encoding a batch at a selected entry has been implemented. This
option can be accessed via the VIEW menu, ASSIGN TAPE NAME. When this
functionality is enabled, the highlight color for the batch window is displayed as Red. The
Naming structure will also start counting up from the selected entry.

j) Video Compensation for use with outboard filters and processors has been implemented.
When this feature is enabled the IN, OUT and LENGTH fields will display orange
numbers.

k) When using “CUE CONTROL” for Machine control, clicking and holding th e slider bar all
the way to the Left or Right, will now FF or REW the VTR.

l) The ability to save I-frame Insertion points with batch information has been
implemented. Each entry within a batch can have it’s own I-frame list. This information
can be saved and modified just as with normal batches. The insertion points  are then
restored/displayed within the I-frame Insertion List when the entries are executed.

Segment Re-encode Guidelines
a) The Re-encode GOP structure and size must match that of the original video file.

#2190
b) Only Closed GOP structures are to be used for both the Main video file and the Re-

encodes. Closed GOP structures are: IBBPcl, IBPcl, IP and I-Only. NOTE: These same
GOP structures are also the only supported types for Multi-Angle as well.
TN#94, #1039, #1150

c) For best quality encoding results it is recommended to use IBBPclosed, GOP size 15,
New GOP on Scene Change enabled and Inverse Telecine if the source is the
appropriate material.

d) When encoding with Lower bitrates it is suggested to Select, Temporal Filter Enabled.
This parameter is designed specifically for the lower bitrate interpolation. NOTE: As a
result of enabling this filter, examine situations where dark objects are moving within the
foreground over lighter backgrounds, possibly a trailing shadow effect may result.

e) Enable no more than two punch points at a time for segment re-encode
f) To execute a segment re-encode to the end of a file, only specify one punch point for the

re-encode. The re-encode will then be executed from the specified punch point to the
end. See below for know issues.

g) The encoder now generates .enc files for every encode that is executed. This file retains
the settings of the initial encode. Upon segment re-encode, these settings appear as the
initial settings within the encoder. If this file is not present when the segment re-encode
is initiated, the encoder setting will appear as the last known non-segment re-encode
state.
#2599

h) If chapter points are located within the IN and OUT point range, this information is stored
with the .enc file. When the .enc file is loaded into the settings, I-Frame Insertion points
are specified for these locations. Also, for Segment re-encoding locally, the I-Frame
Insertion points are automatically specified when the encoder is invoked.

i) More responsive and intelligent commands have been implemented to communicate
with the RS422 machine control. Therefore, if you receive the message “An
unsuccessful attempt was made to calculate the timecode frame rate! Please roll the
VTR to assure proper frame rate indication before attempting next capture” follow the
instructions. All this means is that the VTR may not have gotten up to speed in enough
time to pre-roll so that the frame rate could be displayed. Hitting play on the machine
control will allow initialization.

j) “Export Re-encode Settings” has been implemented within the timeline. This allows the
ability to set an IN and an OUT point, then right mouse click and select “Export Re-
encode Settings” to save off a .enc file which contains all of the parameters from the
original video file, including Inverse Telecine. This .enc file can then be “Loaded” in to
the encoder. The desired “re-encode In and Out points are specified and the original
video settings are restored.
NOTE: The information contained within the .enc file which is created via “Export
Re-encode Settings”, only applies to the specified IN and OUT Re-encode points
at the time the .enc file is created. Once the .enc file is loaded into the Encoder, if
either the IN or OUT point are adjusted, all other settings are voided. Meaning
specifically that if the original Video file contained Inverse Telecine, this
information will not be applied to the re-encode. It is suggested that if the IN and
OUT points need adjustment, return to the original video file, specify the new IN
and OUT points and generate a new .enc file.

k) Asset timecode must be contiguous if multiple segments exist on the timeline and a
segment re-encode is initiated between the segments. Multiple segments with non-
contiguous or redundant timecode are not supported with segment re-encode.
#3015

l) The Digital Connect should be powered “OFF” when installing the MPX3000 Drivers.

ACX5100
a) For the most reliable behavior with the ACX5100 put it in a higher order slot than the

MPX3000 or the MPX2000. TN#104,
#1666

b) When encoding PCM and MPEG1 Layer 2 audio with systems which contain both the
ACX5100 and the MPX3000, the input audio signal MUST BE CONNECTED TO THE ½
INPUT ON THE BREAKOUT CABLE connected to the MPX3000. PCM and MPEG1
Layer 2 audio encoding is not supported for the ACX5100.



QI
a) How to set the QI/Ravisent Cinemaster card so that PAL color bars are the default.

1. From the Start Menu, choose Run...
2. Type in <regedit> and hit enter.  This launches the Registry Editor.
3. Hit Ctrl-F to perform a find.
4. Type in and hit Find.
5. IdleScreenMode should be found in the following path:
     HKEY_LOCAL_MACHINE
          SYSTEM

ControlSet001
     Services
         CINEMAST

Parameters
    VideoOut

6. Double Click on the IdleScreenMode
7. In the Value data: field, input 1 for NTSC or 0 for PAL.
TN#137

Known Issues
Buttons On the Timeline

a) Button Grouping for Buttons on the timeline is not supported.
c) Auto Action for the first button highlight does not take immediate effect the button must

be re-selected.
TN#105 #1650

d) Button Highlight fades have been removed.
#2752

e) "Buttons over video" do not work when "Disable Last Chapter Skip" is enabled.
#3008

Button Pre-select
a) We do not pre-highlight based on the subtitle stream being OFF. The way button pre-

select currently works is that it picks the button number depending on which
audio/subtitle stream is in use. So, stream 1 goes to button 1, stream 2 goes to button 2,
and so on. This does not work if you do not set the buttons up according to this
methodology.
TN#82, #242

Timeline
a) Appended (Super Video Files) Video files are not editable on the timeline.

#2127
b) When the audio file is offset from the beginning of the timeli ne, inconsistent playback

may occur. Results are potentially slide duration not being observed, or video and audio
playback stopping. As a guideline, as mentioned previously, it is recommended that
slides should always have a corresponding audio track. See item “C” above in Tips and
Tricks – Slide Shows
#2075&2081

c) Appended (Super Video Files) Video files are not interchangeable with Inserted video
files on the timeline.

d) If the first asset in the timeline is trimmed (shortened) at the Beginning (head) of the file
the “Video Time Offset” will not be updated. WORK AROUND: Select “Properties” for
the trimmed asset, add the value located within the “Asset Offset” field to the original
“Video Time Offset”. The resultant value can be entered as the updated “Video Time
Offset”.
#2256

e) Chapter Point Thumbnails are not displaying the frame that represents the actual chapter
location. The Thumbnail that represents the chapter point location displays the frame
from the I-Frame or Temporal Reference 0. Due to the nature of the MPX3000 GOP

structures, BBI…  and that Chapter Points can only be located at the head of a GOP, this
results in the Chapter Previewer frame displaying 2 frames later than where the chapter
point is located.
#2530

Slide Shows
a) For consistent/reliable Playback of Slide Shows, it is recommended that the Slide Show

contain an audio track. WORK AROUND: See item “C” above in Tips and Tricks –
Slide Shows
#2071, TN#169

Asset Bin
a) Crashing sometimes occurs if files are deleted while they are parsing in the Asset Bin.

#1436
b) When deleting a file, a sharing violation error will occur if that file is located within the

current working directory.
#1110

c) The length display of files which do not contain a timecode reference (Mpeg and PCM
audio by nature) is based on the Properties Settings for that particular project(PAL or
NTSC).
#2735, #1964

d) File lengths are displayed only to the frame boundary, no rounding occurs. Therefore a
file that is 1 sample short will display as one frame short.
#1181, TN#145

e) Assets from v2.0 and earlier will re-parse when imported into v2.5.

Menu Editor
a) Only 10 Lines of text can be to be typed into the menu. Anything greater 10 is

disregarded.
#2181

b) Only 18 buttons are allowed in a 16x9 menu. This is a DVD Spec limitation. Since we
are creating 2 button groups (1 for wide screen, 1 for letterbox) when using 16x9 menus,
only up to 18 buttons (36/2) can be created,
TN#157, #2508

c) Menu Buttons sometimes become unselectable upon creating of a new DVD Menu or
opening an existing Menu, it may happen that that none of the buttons can be selected,
and new buttons cannot be drawn. This situation occurs when the system, for unknown
reasons, creates a single button that fills the whole Menu workspace. WORK AROUND:
If this problem occurs, press the keyboard “Delete” key. This removes the ‘phantom’
button and restores normal operation of the Menu editor.

Subtitle Editor
a) When using a bitmap file as a subpicture in the subtitle editor it is not possible to move

the image horizontally by a negative amount.

Subtitle Import
a) .SON files do not import if no video file is located in the timeline, receive "No

corresponding subtitles found." Message.
#2831

Movie Properties/Disable User Actions
a) No warning appears if the “otherwise got to” field is left blank for conditional display of a

movie. Leaving this field blank has the same effect as setting the field to “Always True”.
#2937

Command Sequences/Register Mapping
a) When re-loading previously saved sequences, the targets of the Jump commands are

not recalled. They must be put back in for the new project.



#1423
b) Once a GPRM is defined and used, it is not possible to modify Allocation Type in the

register mapping dialog.
#2837

c) Command sequences from version 2.0 loaded into PowerPack 2.5 will need to have
GPRM values reset after being loaded.
#2768

d)  Crashing occurs within the Navigation Simulator when activating a command sequence
that references a deleted item. WORK AROUND: Confirm that when deleting items from
the project that none of the existing command sequences are referencing these items.
#2490

Create Sync Audio Track
a) If an invalid audio file is associated to the first video file in the timeline, it is not possible

to create a sync audio track. The Message “The Audio format must be the same for all
selected audio files”.
#2325

b) The last second of audio will be repeated in some cases when using the create sync
audio track function with PCM files which are shorter in length than the corresponding
video file
#3036

c) If an invalid audio file is associated to any file other than the first in the timeline, silence
will be inserted in its place.
#2325

Navigation Simulator
a) Infinite Hold stills are not taking effect within the simulator.

#1616
b) Buttons on the timeline (both highlight and action) are not active in simulation.

#1621
c) “Set Temporary Parental Level” does not display within the simulator.
d) Registry Mapping does not display within the simulator.

#2757
e) Menu’s which contain Stills with either pcm or mpeg1 audio, do not display the

subpicture during simulation or emulation. WORK AROUND: Burning a DVD-R will
display the menu correctly.
TN #19

e) Crashing occurs within the Navigation Simulator when activating a command sequence
that references a deleted item. WORK AROUND: Confirm that when deleting items from
the project that none of the existing command sequences are referencing these items.
#2490

Mixed/Multi-Angle
a) When editing on the timeline it is possible to create illegal multi and mixed angle

situations. A check has been implemented to detect these situations. This occurs when
the project is initially compiled. A warning message will appear stating the nature of the
error. See user documentation for guidelines in correctly creating these types of projects.

List View
a) The Hold Length Field located in the List View is read-only.

#1579
b) Start/End/Play cursor edit fields are read-only.

TN #106
c) Audio and subtitles are not being played back from List View. WORK AROUND: Initiate

playback from the timeline.
#2779

Markers
a) Chapter List Import scripts support only Asset Based Timecode reference.

#2205
b) Chapter List Import scripts do not support Chapter Names.

#2207
c) When Importing Chapter Lists if “Nearest” is selected for “ Snap chapter to GOP”, the

chapter point will be placed previous to the specified point even if a GOP exists at a
closer location after the specified point.
#2677

Graphic Files
a) Photoshop files that contain Linked Layers or Alpha Channel Information are not

supported.
#1835

Karaoke
a) Currently, detection for Karaoke type encoded audio files is not implemented.

#1211

Overall Project
a) Currently 99 movies and 10,000 menus are the maximum supported within v2.0.

TN#6, 163
b) Project that are created in v2.5 are not compatible with any previous version of software.

TN#92, #1138
c) Full Resolution support is no yet implemented for MPEG1 Video files. This means that

motion menus that contain MPEG1 Video files will not display the first frame within the
Menu Window.

d) Multiple instances of the application open concurrently may result in unstable behavior,
“EOF“ errors, loss of machine control, digital connect and audio board as well as “Error
Reading Video Input file” errors.
#1751, 2264

e) The use of Non-Standard Fonts may result in some fields being too small to display all of
the text contained in them.
#2466

f) Project names that contain ampersands are not displayed correctly in the application
window title.
#2486

g) Having multiple movie and/or menu windows open simultaneously, may result in slow or
sluggish response within the UI and increased compile times.
TN#171

Segment Re-Encoding
a) Punch Points can only be set at GOPs that begin with Top Field First. The timeline

automatically adjusts the location of the punch point if the initial location is not that of a
Top Field First GOP.
#2875, TN#93

b) Setting Punch Point within a video file that contains an extremely sporadic or virtually
non-existent Inverse Telecine cadence could result in Punch Points being set a Bottom
Field First GOPs. The resultant Re-encode file will not insert correctly into the main
video file. WORK AROUND: Move the punch points one GOP earlier or later until a
correct re-encode is achieved.
#3024

c) Files which contain all BFF GOPs except for the first GOP, are allowing BFF GOPs to
be set for the out punch point. The resultant re-encode will not be allowed for insertion
into the timeline. WORK AROUND: Move the Punch Out Point and re-initiate the
segment re-encode
#3059



MPX2000
a) Segment re-encode with MPEG1 video files is not supported
b) Encoding MPEG1 audio with a bitrate of 192 or lower yields Buffer management issues

that result in Invalid Sample Rate errors.
c) Encodes which have settings with very high video bitrates and very low audio bitrates

increase the instance of buffer management issues.
#1052

d) The Out point is not adjusted, when the GOP structure is changed within the Settings
Window as well as when the IN, OUT and Length fields are adjusted.
#1167

e) Audio tapes (example: DA-88, 98, PCM800) that do not contain timecode are not
machine controllable via the 9pin RS422.
#1161

f) The instance of buffer issues resulting in EOF errors is increased when encoding 1 pass
VBR MPEG1 SIF with MPEG Audio.
#1179

g) Machine Control with the DA88, 98 and PCM800 via Serial Port, is not responding after
Re-Scan.
#2602

h) Stopping a manual encode (even if only previewing), throws "no sequence end code"
message.
#2618

i) The Decoder must be set to “None” (Real View disabled) to successfully complete an I-
Frame Only encode.
#1528

j) Mpeg Audio Only Encoding with bitrates of 192 and lower result in EOF errors. WORK
AROUND: Either set the Decoder to “None”(Real View disabled) during encoding, or
execute an audio/video encode with the desired settings.
#1221

k) AC3 Audio Only Encoding with bitrates of 192 and lower result in EOF errors. WORK
AROUND: Either set the Decoder to “None”(Real View disabled) during encoding, or
execute an audio/video encode with the desired settings.
#2850

l) IP GOP structures are displaying out of sync with the 1.2NT Quadrant board. This occurs
during encoding, playback from the decoder, playback from the timeline, simulation and
emulation. The files are encoded correctly, this can be confirmed by playing the files
back using another decoder or burning a DVD-R and playing back in set-top players.
#2885, #2921, #3014, #2919

m) With PAL files, Realtime Preview during encoding is not displaying the last frame of
video. Files are encoded correctly.
#2943

n) A pause has been implemented within the Decoder. What happens is RealTime Preview
will pause briefly if the “Decoder In” buffer level falls below a minimum value. This
behavior may occur with low bitrate conditions or VBR technology. The output file is not
affected by this pausing.

o) Audible stuttering occurs upon initiation of an Audio only encode. The encoded file does
not display this behavior and will play back correctly. This is due to a bug in the
Quadrant Decoder Board.
#2952

p) System is blue screening and then restarting at the end of a +4 gig encode. The encoded
file is fine.
#2973

q) When changing settings for a segment re-encode, the message “Out Time has been
adjusted to accommodate the GOP structure” may appear. If this message occurs, the
In and Out points are indeed being changed, under the surface. At this point it is
necessary to close out of the encoder dialogue and adjust the IN and OUT points so that
the desired GOP structure can be used. Then re-initiate the segment re-encode.
#2996

r) It is suggested that if segment re-encoding with Inverse Telecine is desired, contact your
sales representative for information regarding available trade in options for the MPX3000
encoder that offers this functionality.
#3009

s) When encoding Mpeg1 Video and Mpeg1-Layer2 Audio, Real Time Preview is not
always displaying the entire encoded file.
# 3032

t) Sometimes during encoding Mpeg Audio files are not parsed correctly resulting in the
length display being 1 to 2 frames short within the Asset Bin. WORK AROUND: Delete
the file from the Asset Bin, throw away the .pra file for that asset. Re-import the asset
into the Asset Bin, it will re-parse and the length display will be correct.
#3056

u) Field Encoding with Segment Re-encoding is not supported.
#3062

MPX3000
a) Encoded file sizes may be as much as  +5% and below.

#2057
b) Segment re-encode with MPEG1 video files is not supported.

#2163
c) The Inverse Telecine option is grayed out during segment re-encode. See above for

functionality.
d) When initiating a segment re-encode to the end of a video file, dependent upon on how

the GOP structures fall, the re-encode may not execute to the very end of the original
file. There may possibly be a few frames at the end that are not included on the segment
re-encode. The video file still plays back and functions correctly.
#2157

e) When initiating a segment re-encode to the end of a file (no specified out point), after
completion of the re-encode, upon insertion into the timeline, the message “Insertion
Timecodes do not fit the base Video GOP structure”. This is due to the previous known
issue. Say OK to the dialogue and right click on the timeline to use the context menu to
re-insert the segment into the timeline.

f) Manually encoded files (no In and Out Points or initiated with no machine control)
sometimes yield a file which has an offset of 00:00:00:01 as opposed to 00:00:00:00.
The encoded file is fine. Where the confusion may occur is when the file is placed on the
timeline, it will begin with 00:00:00:01 as opposed to 00:00:00:00, which is the norm.
#2041

g) Due to the nature of Inverse Telecine there may be times where the encode is 1 or 2
frames longer than specified within the encoder. 2 Pass VBR has now been adjusted to
compensate for this, and thus should always produce the specified length files. CBR and
1 Pass VBR have not been modified, therefore they may still display this behavior.
#2117

h) Audio tapes (example: DA-88, 98, PCM800) that do not contain timecode are not
machine controllable via the 9pin RS422.
#1161

i) It is not possible to encode using a Non-TBC (Time Base Corrected) source i.e.
consumer VHS, with the digital connect box.
#2296

j) Only 48k PCM encoding is supported.
#2532, 2533

k) The Linear timecode from a Digital-S VTR cannot be read properly via the Timecode
Tab within the AC3 Settings window. This is due to DC component that is contained
within the timecode information. Introducing a Balancing Transformer prior to the
Timecode input of the board resolves this issue.
#2665

l) PCM Audio Only Encoding is not supported.
#2026



m) Potentially poor video quality or blocky frames with 2pass VBR, if/when the scene
change does not occur on a GOP boundary.
#2404

n) Inverse Telecine is sometimes not being detected in the first and part of the second
GOP of an encode.
#2515

v) The Decoder must be set to “None” (Real View disabled) to successfully complete an I-
Frame Only encode.
#1528

w) I-Frame Insertion points could be as much as +3 frames in relation to the specified
location.

x) Mpeg Audio Only Encoding with bitrates of 192 and lower result in EOF errors. WORK
AROUND: either set the Decoder to “None”(Real View disabled) during encoding, or
execute an audio/video encode with the desired settings.
#1221

y) DA-88, 98, PCM-800, the tape will not eject from a Paused State. The machine control
must be in a stopped state.
#2853

z) AC3 Audio Only Encoding with bitrates of 192 and lower result in EOF errors. WORK
AROUND: either set the Decoder to “None”(Real View disabled) during encoding, or
execute an audio/video encode with the desired settings.
#2850

aa) IP GOP structures are displaying out of sync with the 1.2NT Quadrant board. This occurs
during encoding, playback from the decoder, playback from the timeline, simulation and
emulation. The files are encoded correctly, this can be confirmed by playing the files
back using another decoder or burning a DVD-R and playing back in set-top players.
#2885, #2921, #3014, #2919

bb) With PAL files, Realtime Preview during encoding is not displaying the last frame of
video. Files are encoded correctly.
#2943

cc) A pause has been implemented within the Decoder. What happens is RealTime Preview
will pause briefly if the “Decoder In” buffer level falls below a minimum value. This
behavior may occur with low bitrate conditions or VBR technology. The output file is not
affected by this pausing.

dd) Audible stuttering occurs upon initiation of an Audio only encode. The encoded file does
not display this behavior and will play back correctly. This is due to a bug in the
Quadrant Decoder Board.
#2952

ee) Quant Scale has been removed from the UI. This parameter is automatically being set
by the encoder to achieve optimal quality.

ff) The ability to encode I-Frame Only has been removed.
#2960

gg) When encoding Mpeg1 Video and Mpeg1-Layer2 Audio, Real Time Preview is not
always displaying the entire encoded file.
# 3032

hh) Sometimes during encoding Mpeg Audio files are not parsed correctly resulting in the
length display being 1 to 2 frames short within the Asset Bin. WORK AROUND: Delete
the file from the Asset Bin, throw away the .pra file for that asset. Re-import the asset
into the Asset Bin, it will re-parse and the length display will be correct.
#3056

Encoder/Decoder General
a) The location/timecode display does not always display the frame accurate location when

using the scroll bar. WORK AROUND: Close the encoder and display the file from the
timeline. Frame accurate markers can be set at desired locations on the fly.
#2523

ACX5100
a) The Linear timecode from a Digital-S VTR cannot be read properly via the Timecode

Tab within the AC3 Settings window. This is due to DC component that is contained
within the timecode information. Introducing a Balancing Transformer prior to the
Timecode input of the board resolves this issue.
#2665

Player Issues
a) Toshiba Players, 16x9 film in PS mode, show from the left side, cutting off the right,

rather than cutting off right and left equally.
#2232

QI
a) Transitions between movies and menus may display a gap of black when audio is

present.
#1427

b) Menu buttons that contain an offset cannot be activated by the QI numerical keypad.
#2474

c) Crash occurs when selecting “Next” action and the QI Player is not set to Max Parental
Level.
#2514

d) “Set Temporary Parental Level” does not display within emulation.
e) Menu’s which contain Stills with either pcm or mpeg1 audio does not display the

subpicture during emulation. WORK AROUND: Burning a DVD-R will display the menu
correctly.
TN#19

f) Subtitles don't display in RT preview or emulation when muxed with slides or low bitrate
video and MPEG1 audio.
#2734

g) Frame stepping with PAL MPEG2 video files only displays I and P frames, therefore a
GOP structure of IBBP, will display every third frame and a GOP structure of IBP will
display every second frame.
#2877

h) IP GOP structures are displaying out of sync with the 1.2NT board. This occurs during
encoding, playback from the decoder, playback from the timeline, simulation and
emulation.
#2885, #2921, #3014, #2919

i)  With PAL files, Realtime Preview during encoding is not displaying the last frame of
video. Files are encoded correctly.
#2943

j) Audible stuttering occurs upon initiation of an Audio only encode. The encoded file does
not display this behavior and will play back correctly
#2952

ii) When encoding Mpeg1 Video and Mpeg1-Layer2 Audio, Real Time Preview is not
always displaying the entire encoded file.
# 3032

jj) Playback within the decoder, of 32k mpeg1 video, mpeg1 audio displays frame
dropping resulting in sync issues. Encoded files mux and play back correctly in other
media players.
#3037
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Spruce Technologies 

DVD Authoring System 

Version 2.5 Release Notes 

Introduction 

Welcome to Version 2.5 of Spruce’s award-winning DVD authoring software. We hope that you 
enjoy its many powerful new features. 

Your Version 2.5 package includes complete new User Guides for both the authoring 
(DVDMaestro™, DVDConductor™, and PowerPack™) and encoding (DVDEncoder™) 
programs. The new features of each are described in detail in special addenda sections in the 
rear of each volume.  

These release notes provide an overview of the new features incorporated into Version 2.5, and 
details on the operation of additional features added after the User’s Guides were committed to 
print. 

• New features for DVD authoring are detailed in Addendum C, pages C-1 to C-43 of 
the User’s Guide for DVDMaestro/DVDConductor V2.5.  

• New features for MPEG, AC-3, and PCM audio encoding are detailed on pages 101-
124 of the User’s Guide for DVDEncoder. 

Changes to System Feature Sets 

In order to serve our users better, a variety of features are now available in DVDConductor and 
DVDConductor with PowerPack that were formerly reserved for DVDMaestro only. 

DVDConductor™ 

DVDConductor in its base-level configuration now offers:  

• 8 audio streams  

• 32 subtitle streams 

• Motion Menu support 

• Menu timeout support 
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• Selection of audio stream, subtitle stream, and camera angle from a Menu 

All other features remain the same. 

DVDPowerPack™ 

DVDPowerPack now provides the following: 

• Close caption line 21 support 

• Spruce Advanced Register Mapping for GPRM memory (up to 128 virtual registers) 

• Expands multiangle from 2 to 9 

• Playlists 

• Advanced DVD Rom (hybrid) support (re-order of files) 

• Dual layer support 

• Button number offset 

• Buttons over video 

• Playback disable of User Ops 
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V2.5 New Features Included in User's Guide 
The following describes the benefits and general operation of each new feature in Version 2.5. 
Detailed operating instructions are included in the V2.5 User’s Guides for authoring and for 
encoding. 

New Features for DVD Authoring  

General Authoring/Premastering Features 

Printable Project Log 

For each project, a log can be printed that lists the status of project properties such as copy 
protection, region coding, etc. This log can accompany the finished master as documentation 
for quality assurance. 

ISO Publisher ID field 

The DVD specification provides for the insertion of a Publisher ID for copyright enforcement. 
This feature is supported in Version 2.5. 

Region 8 (Airline) Support 

Regionaliztion has been extended to support Region 8, which has been defined for the growing 
application of DVD in in-flight entertainment systems. 

DVD Jacket Picture Support (DVDMaestro only) 

At the option of the authorist, a set of still pictures at different scalings can be included in the 
project at mastering. Consumer DVD changers (Sony has a 200-disc model out) and DVD 
jukeboxes use these ‘Jacket Pictures’ to provide catalog screens for disc selection. 

TimeLine/Movie Features  

Multiple Colors for Subtitling 

Subtitles for a DVD Movie can appear in different colors, with a palette of 16 colors defined by 
the author for each Movie. Different subtitle streams can appear in different colors, and 
individual subtitles in a single stream can appear in alternate colors (such as a different color for 
each person who speaks).  
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Scriptable Colors for Subtitles 

Colors of subtitles may be defined in the subtitle script by specifying an index into the current 
color palette. Colors may be defined for individual subtitles or for an entire subtitle stream. 

Auto-Conform for PCM Audio 

Spruce’s groundbreaking audio auto-conform (Create Sync Audio Track) feature has been 
extended to work with PCM audio. This greatly extends the flexibility of this popular feature. 

Default Settings for Audio and Subtitle Languages 

International users can assign the default language for audio and subtitles (previously only 
English) to conform to their home market or to specific projects. 

Grab Still From Video 

For the creation menu backgrounds, title cards, etc., it is often useful to grab a still frame from 
video. In version 2.5, this can be done directly in the authoring app by creating a new Marker 
or re-opening the Edit Marker dialog for an existing Chapter Point or other Marker type. A single 
button in the Edit Marker dialog captures the frame at the marker position as a bitmap (.bmp) 
file. 

Support for Matrox Digisuite DTV MPEG Files (AVI) 

Matrox Digisuite uses a unique form of MPEG encoding in its AVI files. Spruce authoring tools 
can import these files directly, intelligently parsing the video content for authoring. 

Pre-Conditions for Movie Display (DVDMaestro only) 

Spruce’s innovative approach to conditional display of DVD Menus (extensively used in multi-
language releases to match menu language with audio language) has been extended to DVD 
Movies. At the option of the authorist, a conditional test on any of a number of parameters such 
as audio language, etc., can be used to invoke a custom experience. An example of application 
would be to display different copyright, warning, and censor’s certificates depending on audio 
or subtitle language selected. 

Menu Editor Features 

Version 2.5 implements several important enhancements for DVD Menus. 

10,000+ Menu Limit 

DVD titles can now be built with more than 10,000 Menus. The previous limit was 
approximately 1,000. 
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Scroll Bars in Menu Editor 

Scroll bars have been added to the workspace in the Menu Editor to accommodate working 
with smaller displays. 

User-OP Control of Menu Button Activation from Numeric Keypad (DVDMaestro only) 

The DVD author can define which buttons in a DVD Menu are selectable by the player’s 
numeric keypad, and which must be selected by onscreen selection. This feature is commonly 
desired for chapter menus which have numbered chapters as well as unnumbered buttons to 
move between screens. 

Pan-Scan/Letterbox Setting for 16:9 Menus (DVDMaestro only) 

Authorists now have the option of specifying display of 16:9 menus on 4:3 screens in the ‘Pan-
Scan’ mode. This mode clips content from the left and right sides of the menu, resulting in a full 
screen as opposed to a ‘Letterbox’ display mode. 

Extended Parental Management Functions  

(DVDMaestro and DVDConductor with PowerPack option) 

Reflecting increased interest in the use of DVD parental management functions, Version 2.5 
implements a group of features that extend the capability of the system in this area.  

Support 8 Parental Levels for International Use 

Starting with Version 2.5, Spruce DVD authoring systems now support all levels of parental 
management defined by the DVD specification.   

Set Parental Level for Individual Movies 

The parental permission level can be set individually for each Movie in a project, allowing for 
much more flexible application of parental control. 

Set Temporary Parental Level by Command Sequence 

Command sequences can be used to prompt the user to enter a password to change the 
parental permission level temporarily, so that the master setting of the player is restored after 
playing a particular title. This operation increases the convenience for the viewer, and is 
increasingly being specified for major feature releases on DVD. 

Note that in V2.5, Set Temporary Parental Level functions are not reproduced in the Navigation 
Simulator or in the DVD Player emulation program. In order to review operation, it is necessary 
to create a DVD-R or check disc and play it back on a set-top player or PC-based DVD player 
that supports this function.  
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Spruce Advanced GPRM Memory Management™ 

(DVDMaestro and DVDConductor with PowerPack option) 

Advanced GPRM Memory Management is an exclusive Spruce feature that extends the utility of 
DVD program memory far beyond the 16 ‘GPRMs’ (General Purpose Register Memory) 
provided by the DVD specification, with up to 128 (!) user-defined (and named) variables that 
can be used in Command Sequences. 

User-Defined Variable Memory (Up To 128 Storage Locations) 

By accessing a special setup dialog, users of Command Sequences can define any group of bits 
in a GPRM as a separate variable. This vastly increases the utility of the limited number of 
GPRMs that the DVD spec provides, allowing a single GPRM to function as a number (up to 16) 
of individual variables. 

Variables Addressed by User-Defined Name 

By defining variables by name, programming of Command Sequences becomes much easier. 
Combined with the ‘GPRM splitting’ function described above, programming of complex 
interactivity becomes easier than ever before. 

Re-Order for Command Sequences 

The function of re-ordering, which has been available for Movies and Menus since Version 1.3, 
is provided for use with Command Sequences. This makes it easier to manage Command 
Sequences for complex projects. 

New Features for Video and Audio Encoding  

Version 2.5 implements specific new features in encoding to extend the capability of the 
MPX3000 encoder, as well as the older MPX2000. The combination of these professional 
features with the MPX3000’s recognized superior encoding quality makes it the leading 
performer for fully professional MPEG encoding. 

MPEG-2 Bitrate Down to 1 Mbps 

Encoder microcode and UI support have been modified to provide MPEG-2 encoding at bit 
rates as low as 1 mbps. This rate can be used as lower limit for 2-pass VBR, for more efficient 
coding of varied program material.  

MPEG-1 Audio Encoding 

The MPX3000 now supports audio encoding in MPEG-1 Layer 2 format. This format is used 
extensively for MPEG-1 operations, and greatly increases the range of application of our newest 
encoder. 
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PCM Audio Capture 

The MPX3000 can now also capture uncompressed PCM audio at a sample rate of 48 kHz and 
bit-resolution of 16 bits. This greatly increases the flexibility of the encoder, and obviates the 
need for external audio capture and editing equipment. 

Encoding for Video CD 

By combining MPEG-1 Layer 2 audio encoding with the included Offline Multiplexer 
application, the MPX3000 system becomes fully compatible with encoding for Video CD 
applications, providing more ways for our users to make money from their system. 

One-Button Restore of Default Settings for AC-3 

A single button in the user interface now restores all settings for audio. 

Forced Entry Point (I-Frame) Insertion for MPX3000 

(DVDMaestro and DVDConductor with Advanced Encoding option) 

With this feature, the operator can define the placement of new ‘GOPs’ (MPEG ‘Group of 
Pictures) by time code location. These are also known as “forced entry points” or (inaccurately) 
“forced I-frames”. The benefit to the operator is that chapter points can be defined with frame 
accuracy, which is a frequent requirement for feature-film releases. The list of forced entry 
points can be defined by hand or by importing a formatted list of time codes from an EDL. This 
feature is available with the MPX3000 only. 

Delay Compensation for Video Pre-Processing  

(DVDMaestro and DVDConductor with Advanced Encoding option) 

High-end encoding facilities frequently make use of ‘video noise reduction’ or other 
preprocessing to optimize the video signal before it reaches the MPEG encoder. These devices 
introduce a delay of some number of frames in the video signal, which affects audio-video 
synchronization. In version 2.5, the encoder interface includes a setting, expressed in frames, 
which compensates for this preprocessing delay and makes the MPX3000 compatible with the 
full range of professional video systems. 

Parameter Exchange for Segment Re-Encode on Network (DVDMaestro only) 

Spruce’s segment re-encoding features lead the industry in ease-of-use and integrations with the 
authoring process. Now this feature can be used when encoding and authoring take place on 
different systems, by handing the re-encoding start-stop times and other settings from the 
authoring system to the encoding system. This feature has strong benefits for high-throughput 
production. 
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Late-Breaking Features not in User's Guide 
The following new features were added after the User’s Guides had gone to print, and are not 
included in that document. 

Late-Breaking Feature (Authoring):  

MPEG Video Export from Timeline 

Note: This feature is available in DVDMaestro and DVDConductor with PowerPack option. It is 
not available in the base-level Conductor configuration. 

In the Video Timeline, it is now possible to export video that has been concatenated from 
multiple files to a new, seamless MPEG file. This also works for video that has been trimmed at 
head and/or tail. The function can be used to turn multiple MPEG files (such as a multi-reel film) 
into a single file, or to isolate portions of longer streams for reuse in motion menus or other 
projects. 

 

How to perform MPEG Video Export 

To export edited video into a new MPEG file: 

1) Create a Movie and prepare video as desired using video concatenate and trim functions. 

2) Right-click anywhere in the video timeline. Select the command ‘Export MPEG File’. 
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3) In the File Save dialog that appears, designate the file name and path of the new file to be 
created. Click OK. 

 

A progress-bar dialog appears, indicating the creation of the new file. Upon completion, the 
new file may be imported into the media asset bin and placed on the timeline, as shown. It may 
also be retained and used in other elements of the same project, including motion menus. 
Likewise, the same file may be retained for use in other projects. 

 

Usage Notes for Video Export 

• This feature applies to motion video content only. It will not work with still images. 

• Upon import into the Media Asset Bin, the newly created file is ‘parsed’ to create the 
meta-data files required for authoring. This generally takes on the order of 1/5 the play 
time of the file. 

• On import to Media Asset Bin, an error message may appear reporting that a Sequence 
End Code was not found. This does not affect authoring with the file. 

• When Exporting video from the timeline, be sure that the target volume has enough 
space for the file to be created. 
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Late-Breaking Feature (Authoring):  

Changes in First-Play Default Behavior 

In previous versions, if the user did not specify a target for the First Play item in the Connections 
window, the system would automatically define the first Movie in the Project View as the first 
play. As a result, all discs authored with Spruce systems would automatically trigger PLAY when 
inserted into a DVD player. 

 

For greater flexibility, this behavior has been modified as follows: 

• If no entry is made to First Play in the Connections window, the finished disc will not 
automatically start on insertion to a DVD Player. When the PLAY button is pressed, 
playback starts from the first Movie in the Project View. The player’s MENU button may 
also be used to access the Menu connection of the first Movie from the stop state. 

• If you wish the finished disc to initiate play automatically upon insertion to a DVD 
Player, you must define the First Play item in the Connections window. 

Note that Navigation Simulation has been changed to reflect this new functionality. The specific 
changes are described below. 
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Late-Breaking Feature (Authoring): 

First-Play and Stop in Simulation 

If there is no First Play item specified in the Connections Window, then Navigation Simulation 
behaves as the final disc, i.e. simulation begins in a stopped state.  

 

 

 

Page 12  Spruce Technologies Version 2.5 Release Notes 

The button labeled as “First Play” in previous versions appears with the name “Play”. Clicking 
on this button starts playback from the first Movie. 

 

During play, the label of the “Play” button changes to “Stop”. Clicking on this will return the 
Simulation to the original stopped condition. Playback can be reinitiated by clicking on “Play”. 

When an item is specified in the First Play field of the Connections view, Navigation Simulation 
will behave as in previous versions. That is, playback begins immediately and the “First Play” 
button can be used to return to the start of simulation. 
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Late-Breaking Feature (Authoring): 

Changes in Next-Previous Link Function 

The options of ‘Next’ and ‘Previous’ links for a Movie, visible when Advanced Source is selected 
in the Connections View, makes it possible to use the Jump Ahead and Jump Back buttons on 
the DVD player (usually labeled as ‘<<’ and ‘>>’ or similar) for functions beyond their 
ordinary stepping from one chapter to the next or previous chapter.  

 

By specifying a target for Next and/or Previous, the corresponding button can link from the last 
chapter of a Movie to another destination, or from the first chapter back to a defined point in 
play.  

It has been found that not all DVD Players reproduce this function correctly. In order to avoid 
compatibility issues with players that do not handle this link properly, the interface has been 
changed as follows: 
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Upon specifying a target for the Next or the Previous link, the Menu Key links for a Movie are 
restricted to one link for the first chapter. The Menu Key items for all chapters beyond Chapter 
1 are removed from the Connections view, as well as from the pull-right menus in the timeline. 

This modification of the function avoids all known player-side issues with regard to Next and 
Previous links. 

Late-Breaking Feature (Authoring):  

Fades Disabled for Button Highlights 

Previous versions allowed the setting of fade-in and fade-out in the subtitle editor when using 
button highlights over video in the timeline. It turns out that this contravenes the DVD 
specification and produces player compatibility problems. For these reasons, this function is 
disallowed in version 2.5. This applies to DVDMaestro and DVDConductor with the PowerPack 
option. 

Late-Breaking Feature (Encoding): 

Buffer Underflow Protection during Encode 

Under certain conditions, the buffer memory for audio/video encoding may ‘starve’ of 
information, which can cause encoding to fail.  

To prevent this from happening, version 2.5 will temporarily suspend updating of the decoded 
output whenever buffer memory falls below a specific level.  

Viewing the preview monitor, the user will see the picture freeze for a period of 2-3 seconds. 
Do not be alarmed if this occurs. All that is happening is that the writing of encoded data to the 
hard disc is being given priority over data fed to the preview decoder, preserving data integrity 
and ensuring successful encoding.  
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Late-breaking Feature (Encoding): 

GOP-structure Selection 

Version 2.5 supports the following MPEG GOP structures: IBBP closed, IBBP open, IBP closed, 
IBP open, IBB, IB, and IP.  

 
For most DVD purposes, GOP structures of IBBP closed or IBP closed at sizes of 12 to 16 
frames are recommended. Smaller GOP structures such as IP, IB, or IBB are very inefficient at 
bit rates compatible with DVD, and are recommended only in exceptional circumstances and 
then only for short sequences. I-frame only encoding is not supported, as this mode is not 
suitable for use at DVD bit rates. 
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Late-Breaking Feature (Encoding):  

Batch Encode with Multiple Reels 

The batch encode function has been modified to provide for multiple tape reels. The user may 
define any number of batch entries, spread across any number of individual reels. Upon 
execution of Batch Encode, the system prompts for the insertion of each named reel. Batch 
items that have the same tape reel name assigned execute without interruption. 

How to perform Batch Encode with Multiple Reels: 

1) If not already visible, bring the Batch Window into view by clicking on BATCH WINDOW in 
the View menu of the Encoder Control Panel. 

2) Using the Encoder Control Panel and the Settings Window, set the start/stop times, 
bitrates, and other encoding parameters as required for the first item in the batch list. 
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3) From the View menu, Encoder Control Panel, select the command ASSIGN TAPE NAME. 

The modal Tape Name dialog appears as shown below. 

 

4) Enter the name of the first tape reel in the designated field. 

5) Click <OK> to close the Tape Name dialog. 

6) In the Batch Window, click on the MODIFY button to register the tape name to the first 
batch item. 

7) Enter the next item into the Batch List. If this item is from a different reel of tape, repeat 
steps 3 thru 6 to enter the new reel name and register it to the selected entry. 

Now, when the Batch List is executed (as described in the User’s Guide), the system will prompt 
the user to insert the correct tape reel at each point that a new tape reel name appears, as 
shown below 

 

Usage Notes for Multi-Reel Batch Encoding 

• The checkbox ‘Ignore first tape name request’ may be used to prevent tape ejection 
and prompting on the first item in the Batch Encode. 
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• When modifying existing entries, be careful that you don’t inadvertently change the 
Tape Name attached to the selection. Note that double-clicking on the entry in the 
Batch Window loads all encoding parameters except the Tape Name. 

Late-Breaking Feature (Encoding):  

Partial and Interrupted Batch Encode 

The Tape Name dialog contains a checkbox that, when selected, causes batch encoding to 
begin from the currently selected list entry rather than from the beginning of the list.  

 

This allows for encoding a portion of a list rather than the entire list. To interrupt encoding 
before the end of the list, you may either terminate encoding manually when that point is 
reached, or you can delete the entries after the last desired and save the list under an alternate 
name. 
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Late-Breaking Feature (Encoding):  

Display Format, Encode Length 

The Option menu of the Encoder Control Panel now includes an option to define the display 
mode of the Length field. This allows for display of length in true clock time, even when the 
source time code is 29.97 fps non-dropframe. 

 

When encoding with machine control, the video standard of the source transport determines 
whether options for NTSC or PAL frame rates are available. In the case of manually controlled 
encoding, all options are presented. 
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Late-Breaking Feature (Encoding):  

Instant Manual Encode 

The Encoder Control Panel Option menu now includes an option to provide prompting for 
encoding in Manual mode, so that encoding can begin immediately at the point determined by 
the operator. 

 

When this option is selected, the system brings up additional alerts on triggering of Manual 
encoding, ensuring that the operator has started the video/audio source before encoding 
actually begins. Encoding begins immediately when this prompt is acknowledged by the 
operator. This allows the user to more precisely control the start of Manual mode. 

The exact prompts that appear depend on whether a machine controlled source is connected. 
In the event that the source device is not under serial machine control, the following prompt 
appears. 
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In the case of encode from a machine-controlled source, the following appears: 

 

The transport control in this dialog may be used to start playback. Encoding begins immediately 
after the operator selects ‘OK’. 

If the Manual Prompt option is deselected, Manual encoding behaves as in previous versions. 

Late-Breaking Feature (Encoding):  

Length Control for 2-pass VBR encoding with Inverse Telecine 

Note that this feature is available with DVDMaestro or DVDConductor with the Advanced 
Encoding option. 

The use of Inverse Telecine for transfer from film-originated video at 29.97 fps implies 
conformance between the MPEG GOP structure and 3:2 pull-down cadence. This means that 
frequently the defined length of video cannot be correctly processed at a defined GOP 
structure. This situation may be handled in one of two ways.  

One method is to extend the length by one or two frames, allowing for accurate inverse telecine 
but at the expense of a precise length. The other method is to allow an inverse telecine error in 
the final encoded GOP where a different GOP structure can be selected, resulting in a precise 
length. Version 2.5 allows the operator to choose the tradeoff strategy most appropriate for the 
situation. 
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General Usage Notes 
This section contains information of general note, including application tips and workarounds 
for known issues in the software. 

Bug – Emulation Does Not Support Button Number Offset 

The DVDPlayer application does not correctly support Button Number Offset, though this 
function works correctly on all set-top players tested. 

Workaround 

Verify button number offset using the Navigation Simulator and/or DVD-R or test discs. The 
DVDPlayer emulation function cannot be relied on for this particular function. 

Bug – Menu Buttons Become Unselectable 

Upon creating a new DVD Menu or opening an existing Menu, it may happen that that none of 
the buttons can be selected, and new buttons cannot be drawn. This situation occurs when the 
system, for unknown reasons, creates a single button that fills the whole Menu workspace. 

Workaround 

If this problem occurs, press the keyboard ‘Delete’ key. This removes the offending ‘phantom’ 
button and restores normal operation of the Menu editor. 

Bug – Improper Operation if Command Sequence Targets Are Deleted 

At present, the system does not perform error checking for the situation in which the operator 
has configured a Command Sequence with jumps to a defined target, but that target has been 
deleted. 

Workaround 

In this case, simulation or compilation of the offending project is likely to cause unpredictable 
behavior both of the Spruce system, and of DVD titles replicated or transferred to DVD-R. 
When using Command Sequences, please be aware of the need to maintain congruity between 
Command Sequence targets and existing project elements. 
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Installing or Upgrading to the v2.5 Spruce 

Technologies Software and Hardware 

Introduction 

This document details installation and upgrading procedures for the Spruce Technologies line of authoring 
system's v2.5 software release.  

What To DoWhat To DoWhat To DoWhat To Do    

The first step is to use the installer included with your authoring software (DVDMaestro, DVDPowerPack, 
DVDConductor, or DVDVirtuoso). This installer must be run prior to installing several of the hardware drivers. 

The next step is to install the new dongle. This dongle runs both the new v2.5 software as well as the previous 
v2.0 version. Once the dongle is installed you are able to run the authoring part of the new software, however, 
you must install new hardware drivers before running the encoder software.  

The last step is to actually install the updated hardware drivers. 

Installing the Authoring Software 

Install Spruce authoring software using standard Windows NT procedures, as follows:  

1. Insert the Spruce v2.5 CD ROM into your system's CD ROM drive.  

2. Click on Start, then Run…, then use Browse to locate the drive. The disc's root shows an install 
directory matching your particular configuration (DVDMaestro, DVDPowerPack, DVDConductor, or 
DVDVirtuoso), for example, E:\DVDMaestro Install. Select the appropriate install directory. 

3. Select the Setup.exe file. This takes you back to the initial Run dialog.  

4. Click Run. This starts the installation wizard that steps you through the process. 

You are provided three installation options: Typical (recommended), Custom, and Compact (not 
recommended). The Typical option does not copy the updated hardware drivers to the hard drive. You copy 
them from the CD ROM as needed when going through the driver upgrade procedure. The Custom option 
allows you to copy the drivers to the system's hard drive, to the C:\Program Files\Spruce 
Technologies\DVDXXX\Device Drivers directory (replacing DVDXXX with the authoring system actually installed). 
They are not installed though, and you still must go through the driver upgrade procedure. The only difference 
is that you copy them from the hard drive to their proper places, not from the CD ROM.  

Installing the v2.5 Dongle 

Once the software is installed, the next step is to install the new v2.5 dongle. It is highly recommended that you 
use the following procedure whenever it is necessary to remove and install dongles. 

1. Power down your system. 

2. Wait for one minute before removing the existing v2.0 dongle.  

3. Install the new v2.5 dongle. 

4. Power up the system. You are now able to run the authoring part of the software. 

If you received the v2.5 dongle as part of an upgrade, please return the v2.0 dongle to Spruce using the 
enclosed shipping label.  
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Installing the v2.5 Hardware Drivers 

Hardware ConfigurationsHardware ConfigurationsHardware ConfigurationsHardware Configurations    

There are four common hardware configurations for encoding. Each has its own requirements for driver 
upgrading.  

MPX2000 Systems 
An MPX2000 encoder handles MPEG-1 Layer II audio. The ACX2000 option is used to provide 2-channel AC-3 
audio encoding. The ACX5100 option is used to provide 5.1-channel audio encoding. 

Systems with an MPX2000 encoder and no ACX option do not need to upgrade their drivers. Feel free to stop 
reading this and go enjoy your new software. 

Systems with an MPX2000 encoder and either of the ACX options need to upgrade their drivers only for the 
AC-3 encoding option. See the section Upgrading the AC-3 Encoder Drivers. 

MPX3000 Systems 
An MPX3000 encoder handles PCM, MPEG-1 Layer II, and 2-channel AC-3 audio. The ACX5100 option is 
used to provide 5.1-channel audio encoding. 

All MPX3000 systems need to go through the Upgrading the MPX3000 Encoder Drivers and Upgrading the AC-3 
Encoder Drivers. 

Driver SectionsDriver SectionsDriver SectionsDriver Sections    

This section is broken into the following separate tasks—use the one(s) appropriate for your system and 
situation. 

• Upgrading the MPX3000 Encoder Drivers — This is required when upgrading an existing MPX3000 
system from v2.0 drivers to v2.5 drivers. 

• Upgrading the AC-3 Encoder Drivers — This upgrades the drivers in MPX3000 systems and 
MPX2000 systems with the ACX5100 or ACX2000 options from v2.0 to v2.5. 

• Installing the v2.5 MPX3000 Drivers — Use this when you are installing the drivers on a new system. 
Also described is installing the QI DVD Player driver.  

• Reverting Back to v2.0 from v2.5 — This describes how to change from the v2.5 drivers back to the 
v2.0 drivers. 
 

√√√√        Note: You must power the system off and cold-boot it whenever you make any changes 
to the drivers. To protect the dongle, it is recommended that it be kept off for one minute 
before turning it back on. 
 

Where Are the New Drivers?Where Are the New Drivers?Where Are the New Drivers?Where Are the New Drivers?    

The v2.5 drivers are located within a Drivers subdirectory in the Install directory used to install the authoring 
software (e.g. E:\DVDMaestro Install\Drivers). There are several subdirectories containing the actual drivers. The 
\ACX-Oynx NT4, \DVX NT4, and \QI NT4 subdirectories are used for the above procedures. If you chose to 
copy the drivers to your hard drive as part of a Custom installation, the drivers are in the C:\Program 
Files\Spruce Technologies\DVDXXX\Device Drivers directory (replacing DVDXXX with the authoring system 
actually installed). 



 

 Page 3 

Upgrading the MPX3000 Encoder Drivers Upgrading the MPX3000 Encoder Drivers Upgrading the MPX3000 Encoder Drivers Upgrading the MPX3000 Encoder Drivers     

The first step to upgrading your v2.0 drivers is to stop them from running. To do this: 

1. Open Control Panel window (Start → Settings → Control Panel). 

2. Double click on Devices. 

3. For the video drivers, locate DVX and highlight it. 

4. Click the Stop button. This stops the MPX3000 DVX services. 

5. Close the Devices dialog. 

Now delete the following files (located in the \WinNT\System32\drivers folder): 

Dvx.NMS  

Dvx.sys  

DvxNTSC.ux  

DvxNTSC1.ux  

DvxNTSCN.ux  

DvxNTSCT.ux  

DvxPAL.ux  

DvxPAL1.ux  

DvxPALN.ux  

DvxPALT.ux 

 

The next step is to install the new MPX3000 DVX drivers.  

1. Copy the contents of the \DVX NT4 folder (except for the DVX.reg file) to the 
\WinNT\System32\drivers folder. 

2. Double-click on the DVX.reg file to automatically update the Windows NT registry. 

Following is a list of the files that the preceding procedures copied to the system. These are copied to the 
\WinNT\System32\drivers folder. 

Dvx.sys 

DvxNTSC.ux 

DvxNTSC1.ux 

DvxNTSCN.ux 

DvxNTSCT.ux 

DvxPAL.ux 

DvxPAL1.ux 

DvxPALN.ux 

DvxPALT.ux 

 

You must now proceed to the next section Upgrading the AC-3 Encoder Drivers.  
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Upgrading the ACUpgrading the ACUpgrading the ACUpgrading the AC----3 Encoder 3 Encoder 3 Encoder 3 Encoder DriversDriversDriversDrivers        

This upgrades the drivers in MPX3000 systems (with or without the ACX5100 option) and MPX2000 systems 
with the ACX5100 or ACX2000 options. 

The first step is to disable and remove the current v2.0 drivers: 

1. Open Control Panel window (Start → Settings → Control Panel). 

2. Double click on Devices. 

3. Locate ACXxEncs and highlight it. The "x" in the name is replace with a "2" when a 2-channel AC-3 
encoder is used, or a "6" with a 5.1 channel encoder. 

4. Click the Stop button. This stops the ACX services. 

5. Close the Devices dialog. 

6. Double click the Multimedia icon in the Control Panel window (Start → Settings → Control Panel). 
This opens the Multimedia Properties dialog. 

7. Choose the Devices tab. 

8. Locate ACX Family…Encoder Driver under Other Multimedia Devices. The "…" actually shows your 
channel configuration. 

9. Click the Remove button at the bottom of the Devices box. This removes the v2.0 driver from your 
system. 

The next step is to install the ACX/Onyx driver for the audio encoder.  

1. Choose the Devices tab of the Multimedia Properties dialog. Select the Add button at the bottom to 
open the Add dialog.  

2. Highlight Unlisted or Updated Driver and select OK. The Install Driver dialog now opens. 

3. Use Browse to locate the directory containing the ACX drivers (the \ACX-Oynx NT4 folder) and click 
OK. This takes you back to the Install Driver dialog.  

4. Click OK. The Add Unlisted or Updated Driver dialog now opens. 

5. Choose the ACXpress Digital Audio Encoder and select OK.  

6. The OnyxEncs NT4 Driver dialog now opens. Click OK. 

7. The driver is now installed. Select OK to exit the Multimedia Properties dialog. 
 

√√√√        Note: You must power the system off and cold-boot it whenever you make any changes 
to the drivers. To protect the dongle, it is recommended that it be kept off for one minute 
before turning it back on. 

 

Following is a list of the files that the preceding procedures copied to the system. These are copied to the 
\WinNT\System32 folder. 

boot.cld 

boot_peg.cld 

boot_phe.cld 

boot13.cld 

boot23.cld 
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enc_peg.cld 

enc_pegm.cld 

enc_phe.cld 

enc_phem.cld 

enc11.cld 

enc11m.cld 

enc13.cld 

enc23.cld 

enc33.cld 

OnyxEncd.dll 

The following file is copied to the \WinNT\System32\drivers folder. 

OnyxEncs.sys 
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Installing the v2.5 MPX3000 Drivers 

Use the following when installing the drivers onto a new system. The following installs the DVX drivers first, 
then the AC-3 drivers, and finishes with the Cinemaster QI DVD player driver. 

First, install the video (DVX) MPX3000 drivers. 

1. Copy the contents of the \DVX NT4 folder (except for the DVX.reg file) to the 
\WinNT\System32\drivers folder. 

2. Double-click on the DVX.reg file to automatically update the Windows NT registry. 

The next step is to install the ACX/Onyx driver for the AC-3 audio encoder.  

1. Double click the Multimedia icon in the Control Panel window (Start → Settings → Control Panel). 
This opens the Multimedia Properties dialog. 

2. Choose the Devices tab. 

3. Select the Add at the bottom of the dialog. This opens the Add dialog.  

4. Highlight Unlisted or Updated Driver and select OK. The Install Driver dialog now opens. 

5. Use Browse to locate the directory containing the ACX drivers (the \ACX-Oynx NT4 folder) and click 
OK. This takes you back to the Install Driver dialog.  

6. Click OK. The Add Unlisted or Updated Driver dialog now opens. 

7. Choose the ACXpress Digital Audio Encoder and select OK.  

8. The OnyxEncs NT4 Driver dialog now opens. Click OK. 

The driver is now installed. Select OK to exit the Multimedia Properties dialog. 

Following is a list of the files that the preceding procedures copied to the system.  

Video (DVX) Files 
These are copied to the \WinNT\System32\drivers folder. 

Dvx.sys 

DvxNTSC.ux 

DvxNTSC1.ux 

DvxNTSCN.ux 

DvxNTSCT.ux 

DvxPAL.ux 

DvxPAL1.ux 

DvxPALN.ux 

DvxPALT.ux 

 

Audio (ACX) Files 
These are copied to the \WinNT\System32 folder.  

boot.cld 

boot_peg.cld 

boot_phe.cld 

boot13.cld 

boot23.cld 

enc_peg.cld 
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enc_pegm.cld 

enc_phe.cld 

enc_phem.cld 

enc11.cld 

enc11m.cld 

enc13.cld 

enc23.cld 

enc33.cld 

OnyxEncd.dll 

 

The following file is copied to the \WinNT\System32\drivers folder. 

OnyxEncs.sys 

 

Cinemaster QI DVD Player Driver 
DVDMaestro and DVDConductor systems need to install the driver for the Cinemaster QI DVD player. To do 
this: 

1. Click on Start, then Run…, then use Browse to locate the CD ROM drive. The disc's root shows an 
install directory matching your particular configuration (DVDMaestro, DVDPowerPack, 
DVDConductor, or DVDVirtuoso), for example, E:\DVDMaestro Install. Select the appropriate install 
directory. 

2. Browse to the \QI NT4 sub-directory. 

3. Select the Setup.exe file. This takes you back to the initial Run dialog.  

4. Click Run. This installs the driver. 

    

√√√√        Note: You must power the system off and cold-boot it whenever you make any changes 
to the drivers. To protect the dongle, it is recommended that it be kept off for one minute 
before turning it back on. 
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Reverting Back to v2.0 from v2.5 

The first step to reverting back to the v2.0 drivers is to stop them from running. To do this: 

1. Open Control Panel window (Start → Settings → Control Panel). 

2. Double click on Devices. 

3. For the video drivers, locate DVX and highlight it. 

4. Click the Stop button. This stops the MPX3000 DVX services. 

5. Close the Devices dialog. 

Now delete the following v2.5 files (located in the \WinNT\System32\drivers folder): 

Dvx.sys  

DvxNTSC.ux  

DvxNTSC1.ux  

DvxNTSCN.ux  

DvxNTSCT.ux  

DvxPAL.ux  

DvxPAL1.ux  

DvxPALN.ux  

DvxPALT.ux 

 

Remove the audio (ACX/Onyx) portion of the drivers using the following procedure: 

1. Open Control Panel window (Start → Settings → Control Panel). 

2. Double click on Devices. 

3. Locate OnyxEncs and highlight it.  

4. Click the Stop button. This stops the ACX services. 

5. Close the Devices dialog. 

6. Double click the Multimedia icon in the Control Panel window (Start → Settings → Control Panel). 
This opens the Multimedia Properties dialog. 

7. Choose the Devices tab. 

8. Locate ACXpress Digital Audio Encoderunder Other Multimedia Devices.  

9. Click the Remove button at the bottom of the Devices box. This removes the v2.0 driver from your 
system. 

10. Click OK to close the Multimedia window. 

The next step is to install the v2.0 drivers using the procedure supplied with them. 

√√√√        Note: You must power the system off and cold-boot it whenever you make any changes 
to the drivers. To protect the dongle, it is recommended that it be kept off for one minute 
before turning it back on. 
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And That's It! 

Once you have loaded the new drivers and re-booted your system, you are finally able to explore the new v2.5 
software. Enjoy it! 

 

Should you have any difficulties with this process, please contact Spruce Technologies at: 

techsupport@spruce-tech.com 

• • • User’s Guide for
DVDMaestro™/DVDConductor™

Version 2.5

Spruce Technologies, Inc.
tel: 408·861·2200

Technical Support (US & Canada)
1·877·277·7823
1·877·2SPRUCE

Technical Support (International)
+1·408·861·2299

World Wide Web
www.sprucetechnologies.com
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1Chapter 1
Introduction

Welcome to the Spruce Technologies family of users, and thank you for purchasing one of
our award-winning DVD authoring solutions.

We’re dedicated to providing you with the fastest, easiest, and most powerful DVD
authoring tools available. We’re also committed to providing you with unparalleled
customer service. Hopefully you’ll find all the answers you need in this User’s Guide; your
QuickStart Guide; the Support area of our Web site (www.spruce-tech.com); or your
Spruce authoring software’s built-in Help feature.

Should you encounter any questions or difficulties that are not resolved by one of the re-
sources, please be sure to contact us directly — and we’ll do our best to get you back to
authoring as soon as possible. You’ll find contact information for Spruce Technologies
Technical Support at the end of this chapter.

Please Read Your QuickStart Guide First

Before reading further — and before you start using your Spruce Technologies authoring
software or DVDStation — please review the QuickStart Guide that accompanies this
User’s Guide, and was included with your Spruce Technologies authoring software or
DVDStation.

In your QuickStart Guide, you’ll find important basic information about:

• DVDMaestro and DVDConductor authoring software;
• DVDStationMX and DVDStationCX authoring systems;
• our philosophy behind our products;
• what you’ll need to know in order to use Spruce Technologies authoring tools;
• how to set up your DVDStation;
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• what hardware you’ll need to provide;
• how to start your system, Windows NT, and DVDMaestro or DVDConductor;
• plus an overview of the authoring process, using DVDMaestro or DVDConductor (du-

plicated in Chapter 2 of this User’s Guide).

About This User’s Guide

We expect that you’ll be tempted to try your hand with Spruce authoring software before
you read much of this User’s Guide — and that’s fair enough! However, we strongly rec-
ommend that you do take the time to read this User’s Guide thoroughly before you begin
any authoring projects in earnest — especially any projects for commercial release, or
which are facing deadline pressures. By doing so, you’ll probably end up saving yourself
considerable time.

What Applies to DVDMaestro & What Applies to DVDConductor?
As we described in the QuickStart Guide, DVDMaestro is our top-of-the-line authoring soft-
ware, designed for creating no-compromise DVD titles of almost any kind. DVDConductor, on
the other hand, gives you the tools to do most DVD titles for an “entry level” price.

Importantly, as we also mentioned, DVDConductor is also designed to be a modular pro-
gram. You can start with a basic version of the program, and, as you need them, you can
add any of two different enhancement “Packs,” including:

• DVDPowerPack — for authoring more complex titles, this enhancement to
DVDConductor gives you a full nine camera angles, dual-layer support, interactive
command scripts (GPRM support), playlists, closed-captioning support, and more.

• DVDEncoderPack — provides three professionally oriented encoder features beyond
those included with DVDConductor, including segment re-encoding, multipass vari-
able bit-rate (VBR), inverse telecine, and forced I frames.

Chapter 1: Introduction 1-5

1Or, if you want all the features of Spruce authoring software, you may upgrade to
DVDMaestro, which has all the features of DVDConductor, including DVDPowerPack and
DVDEncoderPack. DVDMaestro also includes the following advanced features:

• Parental lock, regional lock, CGMS support, APS copy protection, CSS Encryption,
karaoke support, publisher I.D. field support, DVD jacket picture support, and more.

Unless otherwise noted, everything we describe in this User’s Guide applies to both
DVDMaestro and DVDConductor. We’ll highlight any of those features or specifications
that do not apply to DVDConductor, or which require one of the enhancement Packs
listed above, by making a note in the text and/or in the margin.

Note: So that we don’t need to continually repeat “DVDMaestro and DVDConductor
authoring software,” we’ll often just refer to either or both of them as “authoring software.”
Again, unless otherwise noted, all features and specs will apply to both programs.

How We’ve Organized This User’s Guide
This User’s Guide combines both tutorial and reference material into one manual. As you
begin using Spruce authoring software, you might find that the best way to familiarize
yourself with its features is to sit at your computer with this manual at hand, and to go
through the following chapters sequentially. Thereafter, you may find it easiest to look up
specific information using the Index located at the back of this User’s Guide.

If you’re particularly experienced with authoring DVD-Video titles, the next chapter, “Fun-
damentals,” should give you much of what you need to get going with Spruce authoring
software.

Note: Please note that in a few cases, Spruce authoring software offers multiple ways of ac-
cessing certain functions; this is particularly true of certain “Properties” settings. Conse-
quently, in a few areas of this manual, you’ll find information that duplicates (or nearly du-
plicates) information found elsewhere. We’ve done this so that you’ll learn what you need
to know in context, with a minimum of jumping back and forth throughout the manual.
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What’s New in 2.0 
(DVDMaestro Users Only)

Note: This section is intended for users already familiar with earlier versions of DVDMaestro
authoring software. If you’re a user of DVDConductor, we’re happy to point out that many of
the features new to DVDMaestro 2.0 are also shared by the current version of DVDConductor.

When DVDMaestro 1.0 was introduced in early 1998, it was quickly hailed as an entirely
new approach to DVD authoring software, one which combined powerful technology with
an intuitive, easy-to-understand user interface. When it came time for us to create
DVDMaestro version 2.0, our primary goal was to enhance both the software’s underlying
technology, and its user interface, to make the program even more powerful and even
easier to use.

To achieve this goal, we’ve added over 40 new features to DVDMaestro. These features
span almost every operational area of DVDMaestro. In every case, however, we’ve worked
hard to incorporate these new features as seamlessly as possible. Consequently, if you’re
already familiar with DVDMaestro versions 1.0 to 1.3, you’ll find the transition to 2.0 to be
straightforward — and, we trust, as intuitive as the program itself.

Some of What We’ve Come Up With…
Among the many new features of 2.0, you’ll find:

• Enhanced DVD Menus, with support for:

° importing Adobe Photoshop™ files directly into DVD Menus, with “smart
layer” recognition of backgrounds and subpictures;

° overlapping button highlight areas;

° drag-and-drop linking of Chapter Start Markers and button highlight areas;

° saving custom Color Map settings;

° three Color Groups, so that different sets of buttons can have different high-
light areas;

° right-clicking in the Target window to change the target;

° and more.
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1• Enhanced DVD Movies, with support for:

° “mixed” multi-angle video, with multi-angles available in specific sections of
video only;

° incorporating still images in a DVD Movie;

° 16:9 dynamic DVD Menus (motion menus);

° EDL-style views of DVD Movies, with start/end time information;

° on-the-fly concatenation of multiple video files within a single track;

° multiple options for Chapter Markers, including Chapter Start, End actions,
and Remote Key actions (without having to use the Connections window);

° display of Video Bit Rate (VBR) in the video track;

° the ability to add active buttons and button highlighting within the moving
video stream of a DVD Movie;

° and more.

• And many other enhancements, including:

° support for DTS™-encoded audio;

° advanced encoding features, including forced I-frame insertion and “smart
segment re-encode” for film-mode (requires Spruce Technologies MPX-3000
hardware);

° improved Subtitle Editor features;

° improved Navigation Simulator features;

° and much more.

Keep Those Suggestions Coming!
Many of these features are a direct response to suggestions from DVDMaestro 1.x users.
For all of you who offered your ideas for improvements, we thank you very much. And for
everyone, once you’ve become familiar with DVDMaestro (or DVDConductor, for that
matter), we encourage you to let us know what other new features you’d like to see in fu-
ture versions of your authoring software.
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If you have an idea for a new feature, or new product you’d like to see, please email us at:

• suggestions@spruce-tech.com

We’d love to hear from you.

Contacting Spruce Technologies
Technical Support

Should you run into any questions or problems for which you don’t find answers in this
manual, Spruce Technology’s technical support staff is ready to help you.

Here’s how you can reach our Technical Support staff:

Spruce Technologies Technical Support
• toll-free telephone (US & Canada): (877) 2-SPRUCE / (877) 277-7823
• international telephone: +1 (408) 861-2299
• fax: (408) 863-9701
• email: techsupport@spruce-tech.com
• Web: www.spruce-tech.com

Our technical support hours are Monday through Friday 9am to 5pm (North American Pa-
cific time). Our main switchboard telephone number is (408) 863-9700.

•        •        •

Chapter 2: 

Fundamentals
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Chapter 2
Fundamentals

In this chapter, we’ll begin by starting up your Spruce Technologies DVDStation (or your
own PC, if you didn’t purchase a DVDStation turnkey authoring system) and launching
your DVDMaestro or DVDConductor authoring software. Then, we’ll outline the basic
concepts of using Spruce authoring software.

Naturally, if you’re already familiar with DVD authoring concepts and technology, the
basic concepts in this chapter may make more sense to you than if you’re new to DVD
authoring. If you find yourself scratching your head during any of these steps, don’t worry:
You’ll find all the detailed explanations you need further into this User’s Guide.

Starting Windows NT

Note: You may have already read the following pages in this chapter in your QuickStart
Guide. Since these pages provide a good overview of working with your DVDMaestro or
DVDConductor authoring software, we duplicate them here for your convenience.

Once you’ve set up your DVDStation, or have installed your Spruce authoring software on
your own computer system, it’s time to power it up. First you need to start Windows NT,
after which you can launch DVDMaestro.

As we described in the QuickStart Guide, DVDMaestro and DVDConductor run on
Windows NT. Unlike Windows 95 or 98 operating systems, Windows NT provides greater
security for multiple users. 

Consequently, you’ll need to “log on” to Windows NT whenever

you start or restart your PC.

To start your DVDStation (or own computer system) & Windows NT:

1. First, ensure that your audio playback system is turned down. This is to protect your
system (and possibly your ears) in the unlikely event that the DVD hardware decoder
card should generate any spurious pops and other sounds during the start-up process.
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2. Press the POWER ON button on the front panel of the PC. The power on indicator
should illuminate, and you should hear whirring and other sounds, as the fans and hard
drives rev up to speed. If not, be sure to check your power cables and power supply.

3. Turn on your computer monitor.

4. You will be presented with a choice of which operating system mode you wish to use:
Windows NT Workstation or Windows NT Workstation (VGA mode). Select the former.
(If you do nothing, the system will automatically select the former after a few seconds.)

5. After a few more seconds, you will be presented with the Windows NT Begin Logon
dialog. Hold down CONTROL-ALT-DELETE to log onto the system software.

6. The Logon Information dialog will appear. You’ll see that User Name is ADMINISTRATOR

— do not change this name. You’ll also see the cursor blinking in the Password box
— do not enter a password. Simply click OK (or hit ENTER on your computer keyboard.)

7. Windows NT will start, and the Windows desktop will appear.

Note: If you have multiple users, you may wish to create multiple user names, and possi-
bly use passwords. Multiple user names and passwords are established via the Window NT
User Manager. For more information, please see your Windows NT manual.

Launching & Quitting
Your Spruce Authoring Software

In the Windows Start menu, you’ll notice an icon labeled DVDMAESTRO or DVDCONDUCTOR

at the top. This is a Windows shortcut that “points” to the actual Spruce authoring soft-
ware; clicking on it is the most efficient way to launch the program. (For those of you more
familiar with the Macintosh, a shortcut is like an “alias.”)

Clicking this shortcut in the Windows Start menu will launch DVDMaestro. (DVDConductor owners will click on
a shortcut labeled “DVDConductor.”)

Chapter 2: Fundamentals 2-5

2

To launch Spruce authoring software:

1. Simply click on the shortcut to DVDMAESTRO or DVDCONDUCTOR, in the Windows Start menu.

2. The program will launch, with a new, unsaved Project called UNTITLED 1.

Note: In case you should accidentally delete the shortcut, you should find the actual
program in the following directory: C:\program files\Spruce\DVDMaestro (or
“….\DVDConductor”).

To quit Spruce authoring software:

1. Simply select EXIT under the application’s File menu, or click the close (“x”) box in
the upper right-hand corner of the application.

2. If you have made any changes to the current Project, you will be prompted to save
them before the program quits. (This and other aspects of managing your Projects are
detailed in Chapter 12, “The Pull-Down Menus & The Toolbar.”)

To shut down or restart your system, simply go to the Windows Start menu, and select SHUT

DOWN. Another dialog will appear offering you the choice of shutting down or restarting (or
to close all programs and log on with a different name).

The Basic Concepts of Spruce Authoring Software

DVDMaestro and DVDConductor each provide you with a fast, easy, and powerful way to
assemble all the elements of a DVD-Video title, and to prepare those elements for ultimate
replication, using either your DVD-R recorder or a commercial disc manufacturing facility.
In most situations, everything you create in Spruce authoring software is ultimately des-
tined to be seen, heard, and otherwise experienced by end-users — who will be playing
back your DVD-Video discs using stand-alone consumer-style DVD players (or DVD-
Video-capable PCs with DVD-ROM players).

With Spruce authoring software, we call the current file a “Project.” (Projects are like
“sessions,” “compositions,” “sequences,” and similar names that other media tools use for
referring to the current project at hand.) Normally, you’ll work with one Project per title,
although that can increase, especially if you are creating two-sided discs.
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Let’s begin with an introductory onscreen tour of a typical Spruce Project, and then move
to the “Spruce Authoring Software Quick Start” — a typical overview of how you might
work with DVDMaestro or DVDConductor.

Spruce Authoring Software Introductory Tour

This screenshot shows a typical DVDMaestro or DVDConductor Project, in a typical viewing configuration. The
visible windows and panes include (clockwise from upper left) the Project Manager; the Workspace (showing a
DVD Movie as the topmost, active window); the Assets Bin; the RealView Previewer; and the Output Log. Note
that in this viewing configuration, all the windows in the Workspace are shown in Cascade view, and that all the
panes are docked. (For more information on viewing configurations, please see Chapter 3.)
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Pull-Down Menus & Toolbar

Along the top of every Project is a series of pull-down menus: “File,” “Edit,” View,” etc.
(We call them “pull-down” menus, to distinguish them from DVD Menus that we create in
our Projects.) DVDMaestro’s pull-down menus can change depending upon which win-
dows are active in the program, which operating mode the program is in, and so forth.
(We’ll be describing various pull-down menu choices as we proceed through this User’s
Guide. For a complete detailed description of all the pull-down menus, please refer to
Chapter 11.)

Just beneath the pull-down menus is the application Toolbar. With the Toolbar, you can
access many of the most common menu commands directly — just by clicking on the
appropriate Toolbar button, and without having to pull down a menu.

As you pass the mouse cursor over each Toolbar button, ToolTips (highlighted descriptions
of the buttons) will appear onscreen for a few seconds.

Note: You can hide or show the Toolbar by opening the View menu and clicking next to
TOOLBAR; a checkmark indicates that the Toolbar is being displayed.

The Primary Windows: DVD Movies, DVD Menus, & The Connections Window

Moving on, your Spruce authoring software has three primary windows that you’ll get to
know very well:

• DVD Movies;

• DVD Menus; and

• the Connections window.

Here’s one way to think of the relationship between your Spruce authoring software, its
primary windows, and the Project you’re authoring. First, think of your Project as a musi-
cal composition — and you’re the composer who gets to create the composition, while
also deciding the “feel” and overall “structure” of the composition.

Helping you do this is a DVD Movie — a timeline-based window that acts like a conduc-
tor, keeping track of the performance’s time, and controlling what gets “played” when.
(You may find yourself using more than one DVD Movie, but it is not unusual to author a
complete DVD-Video title using just one DVD Movie.)
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Working in concert with the DVD Movie are DVD Menus. These are like program guides
for the end-user, typically offering an outline to the performance — and offering the end-
user choices — about what they’re going to experience.

A typical DVD Menu (as detailed in Chapter 7).

(Both DVD Movies and DVD Menus are constructed using “assets.” These are the video,
audio, bitmapped image, and other files that you import into your Project, and which we’ll
discuss more of later in this chapter. For now, you can think of assets as the “players” for
your composition.)
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The Connections window (as detailed in Chapter 9).

And as for the Connections window, you can think of it as the stage manager for the
performance — making sure that everything flows smoothly, and as you intended, from
one portion of the performance to another.

The Workspace & Panes

Normally, the DVD Movie, DVD Menu, and Connections windows appear onscreen in an
area known as the Workspace. Spruce authoring software also has other windows outside
of the Workspace, which we call “panes.” The panes include:

• the Project Manager, where you create, edit, duplicate and otherwise manage DVD
Movies and DVD Menus;

• the Assets Bin, which you use to import video, audio, and other assets into your Project;

• the RealView™ Previewer, which lets you playback the DVD Movie portions of your
title as an end-user might experience them; and

• the Output Log, which keeps a running log of your successful attempts to create Disc
Images and write to tape (as described later). It also keeps track of any Project
compilation or Disc Image creation problems you may encounter.
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And That’s Not All…

In addition, each Project gives you access to a number of Tools, Properties pages, and
other features. We’ll detail these in the coming chapters.

Typical Project Flow 
Whether you’re using DVDMaestro or DVDConductor, a major benefit is that you can
work with your authoring software in a great variety of ways, and in almost any order you
like. Here, let’s look at some of the major steps involved in a typical Project. This will give
you an idea of how most users will work (and if you already understand DVD-Video
concepts, this might be enough to get you going).

Note: Please keep in mind several things as you read this section:

1. This is just an example of how a typical Project might go. There are many different
ways in which you can build a Project.

2. Since this is a “quick start” overview, we’ll be skipping over many of the necessary
steps and details.

3. You’ll find all the detailed information you need about the procedures described in
this section later in this User’s Guide.

Launch DVDMaestro or DVDConductor & Create a New Project

Once you launch your Spruce authoring software you’ll usually want to name and save the
Project before anything else. If the application is already open, you can create a new
Project by selecting NEW under the File menu, and then DVDMAESTRO (or DVDCONDUCTOR)
PROJECT.

Set Project Properties

This would also be a good time to check some of the Project’s properties.

Most of these properties are set when you establish the program’s User Preferences, as
detailed later in this chapter. Furthermore, there are several ways to establish some of your
Project’s properties. However, at this stage, it would be worthwhile checking the current
properties by right-clicking on the Project name in the Project Manager and selecting
PROPERTIES. Here, you can confirm properties which apply to the Project in general (such as
whether you are using NTSC or PAL format video); which apply to the replication of your
final disc; and so forth. (You may need to wait to set some of these properties until you are
further into the Project and have a better idea of the size and other properties of the disc
you are authoring.)

Chapter 2: Fundamentals 2-11

2

Encode Assets (Optional)

In some cases, encoding (digitizing) of video and audio assets is performed before Projects
are begun. Similarly, the people — or even the facilities — performing the encoding may
be completely different from those who author Projects.

Now that DVDMaestro and DVDConductor have integrated encoding features, however,
there’s no reason why encoding can’t be a direct part of the authoring cycle, assuming you
have the necessary video and encoding hardware. (Most Spruce DVDStations include all
necessary encoding hardware, except, of course, for video and audio playback decks.)

The details of encoding are described in Chapter 5 of this User’s Guide, and, where
applicable, in the separate encoder manuals that came with your DVDStation.

Import Assets

Next, you’ll typically want to import some already encoded assets into your Project —
specifically, a video file, plus one or more audio files. Importing of assets is done (most
typically) via the Assets Bin, by right-clicking in the Assets Bin and selecting IMPORT MEDIA ASSET.

Add Assets to a DVD Movie

Once you’ve imported assets, you can begin crafting a DVD Movie by opening the DVD
Movie and then dragging assets from the Assets Bin into its Video or Audio Timelines.
Within the Audio Timeline are multiple audio tracks, which you can use, for instance, to
create multiple-language titles.

Add Subtitles

Subtitles are also added to DVD Movies and are placed in the Subtitle Timeline — which
has 32 subtitle tracks, also typically used for multiple-language titles. As we’ll cover,
subtitles are imported into DVD Movies directly from the Subtitle Timeline (rather than the
Assets Bin). Also, you can create subtitles from “scratch,” or modify existing subtitles, using
your Spruce authoring software’s helpful Subtitle Editor.

Craft DVD Menus

Once the elements of your DVD Movie are in place (naturally, you can go back and change
them later), you might want to start creating your DVD Menus. You’ll typically import two
images for use in each DVD Menu: a background image and a subpicture image.
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As we’ll also detail later, the subpicture sits on top of the background and is where you
define button highlight areas — that is, areas which are highlighted when the end-user
uses his or her remote control to select a “visible” button. There are many more features to
DVD Menus — such as the Color Mapping, Stream Pre-Selection, the Navigation Simula-
tor, End State controls, and more — which we’ll also detail later in this manual.

(By the way, both DVDMaestro and DVDConductor support both “static” DVD Menus and
“dynamic” DVD Menus. This means that when end-users see the menu onscreen, you can
present them with either still image menus or with “motion” menus — where a video back-
ground takes the place of a still background, with or without an accompanying audio track.)

Once your first DVD Menu is complete, you might continue to create any of the other
DVD Menus you intend to include in your Project.

Establish Connections

Once your DVD Menus are set up, you’ll probably turn to the Connections window. Here,
you’ll define, for instance, what happens when the end-user chooses a particular button in
a particular DVD Menu — or what should happen when a given DVD Movie finishes
playing. The choices are broad and powerful and provide you many interesting ways to
craft the end-user’s ultimate experience when they play your title.

At this stage, you’ll be ready for the last four stages, where you complete your Project by
previewing your work and preparing the Project for replication…

Preview the DVD Movies & Simulate Navigation

Before you compile the Project — and with your DVD Movies, DVD Menus, and connec-
tions in place — you’ll want to take your Project for a “test drive.” To do this, you’ll use
the RealView Previewer and Navigation Simulator, both of which will give you a good
representation of what end-users will experience as they watch DVD Movies or navigate
through DVD Menus.

Using the RealView Previewer and Navigation Simulator are excellent ways to confirm
that all of your DVD Movies, DVD Menus, and connections are working as you intended.
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Compile the Project

Next, after you’ve crafted the Project to your liking, it’s time to compile the Project with
the aid of the Compile Tool. This is where your Spruce authoring software assembles all of
your current Project’s information — including DVD Menus, DVD Movies, whatever
connections you’ve established, the assets, the language selections and so forth. You can
think of it as a kind of “inventory” step for the current Project, a necessary step before you
can create a Disc Image.

After compiling, and before you create a Disc Image, it’s a good idea to run a utility called
DVDPlayer, which is included with your Spruce authoring software. This utility lets you
“play” your entire compiled Project from your hard drive — as if it were an actual DVD-
Video disc. (For more information about the DVDPlayer utility, please see Appendix of
your User’s Guide.) If, using DVDPlayer, you notice any problems with your title (for
instance, a button highlight area that doesn’t lead to the correct DVD Movie), you’ll want
to return to your Project, fix the problem, then re-compile. Once the title “runs” to your
satisfaction, you’ll be able to close the DVDPlayer utility, leave compiling behind and
move onto the next step.

Create a Disc Image (Optional)

Current versions of DVDMaestro and DVDConductor perform on-the-fly Disc Image
formatting, which means that it is generally not necessary to perform the separate step of
creating a Disc Image on the hard drive before writing to tape or DVD-R.

In certain very rare cases, however, it may be necessary to create a Disc Image. For
instance, if you’re creating a hybrid DVD-ROM—and you have modified the physical file
order of the DVD-ROM directory—then you will need to create a Disc Image.  This is
done using the Disc Image Creation tool.

A Disc Image is a UDF-Bridge volume — the same volume that gets written onto your final
replicated disc — and is an optional step before you write a Digital Linear Tape (DLT) or
DVD-R disc. Before you create a Disc Image, you’ll also want to review and set the Disc
Image Properties.
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Write to Tape or DVD-R

Finally, after you’ve successfully compiled the Project (or optionally created a Disc Image),
you’re ready to write to DLT or DVD-R disc using the Write Tape or Write DVD-R tool.
This is the last step you perform with your Spruce authoring software before sending your
completed Project to a mastering/replication facility for disc replication. (Before you
instruct Spruce authoring software to write, you’ll also want to review and set the Replica-
tion properties.)

… And That’s the Idea

These past few pages are a distillation of how most Projects flow; hopefully they’ve given
you a sense of how you’ll be working with your Spruce authoring software. In the coming
chapters, you’ll learn all about the details of how to put DVDMaestro’s and
DVDConductor’s many features to work for you.

Supported Assets

As introduced in the Spruce Technologies QuickStart Guide that accompanies this User’s
Guide, Spruce DVDStations and authoring software are designed for DVD digitizing and
authoring, but not editing. This means you’ll need to edit your video, audio, and other
assets outside of DVDMaestro or DVDConductor. (For more guidance regarding this
matter, please contact Spruce Technologies Technical Support.)

However, your Spruce authoring software is able to work with a wide range of audio,
video and other assets — practically every asset supported by the DVD-Video Specifica-
tion. Here’s a rundown of all the currently supported asset formats:

Still Assets

You can import a wide range of still image formats, for use as background images or
subpictures in DVD Menus: 

• Bitmapped images (.bmp)

• Adobe Photoshop files (.psd — Photoshop native files, with layers)

• TIFF images (.tif — Tagged Image File Format) 

• JPEG images (.jpg — Joint Photographic Experts Group)
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Note: Due to the nature of JPEG, highly compressed JPEG images may suffer from un-
wanted artifacts when imported into Spruce authoring software.

Still images can also be used as “slides” within a DVD Movie presentation, either silent or
accompanied by a soundtrack.

Video Assets

Your Spruce authoring software also lets you import both video formats of the DVD-Video
Spec — including both types of common MPEG (Motion Picture Experts Group) files — for
use in DVD Movies or in “dynamic” DVD Menus:

• MPEG-1 video (.m1v, .mpv, or .vbs)

• MPEG-2 video (.m2v or .vbs )

Note: Spruce authoring software can import MPEG video files with extensions other than
those listed above; for the details, please see Chapter 4 (“Importing MPEG Video Files with
Non-Standard File Extensions”).

Note: Spruce authoring software imports elementary (not multiplexed) MPEG video streams.

Audio Assets

DVDMaestro and DVDConductor also support a broad range of audio file formats for use
in DVD Movies or in “dynamic” DVD Menus: 

• MPEG-1 Layer 2 audio (.m1a, .mpa, or .abs)

• Dolby Digital (AC-3) audio (.ac3 — mono up to six channels)

• DTS multichannel audio (.dts)

• WAV audio (.wav — Windows uncompressed PCM audio; most common Windows
audio format)

• PCM audio (.pcm — “raw” pulse code modulation audio; similar to WAV, but
without “header” and other file information)

• AIFF audio (.aif — Audio Interchange File Format uncompressed PCM audio; most
common Macintosh audio format)

Note: Spruce authoring software imports elementary (not multiplexed) MPEG audio streams.
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Subtitle Assets

Finally, although you can create individual DVD Movie subtitles directly using your Spruce
authoring software’s 

Subtitle Editor feature, you can also import three different subtitle file

formats: 

• Spruce Technologies format (.stl) 

• Daikin Scenarist™ format (.son) 

• any bitmapped image (.bmp), TIFF (.tif), or even JPEG (.jpg) file 

Note: Typically, both “.stl” and “.son” file types are a list of dozens, hundreds, or even
thousands of subtitles, each with their relative timecode location embedded and hidden as
part of the file data. These are the file types that DVDMaestro and DVDConductor use for
creating an complete subtitle stream, from the start to finish of a DVD Movie (or a portion
of a DVD Movie). On the other hand, you can import bitmapped images for use as indi-
vidual subtitles without any embedded timecode information.

Starting a New Project

If you’re familiar with other Windows-based applications of any kind, you’ll find that your
Spruce authoring software has much in common with them.

For instance, most Project-related commands — such as opening, saving, and closing
Projects — are found under the application’s pull-down “File” menu. In addition, the
Toolbar gives you quick and easy one-click access to many of the more common com-
mands and functions. (All of the pull-down menus and Toolbar items are detailed in
Chapter 11.) Also, in many instances, right-clicking with your mouse will reveal a pop-up
context menu, with various options.

Let’s go through the steps of creating a new Project that’s ready for further authoring.

Launching DVDMaestro or DVDConductor & Saving the Project
First, you’ll want to launch your Spruce authoring software, as detailed earlier in this
chapter. Once the program launches, you’ll be presented a new “Untitled” Project. If the
program is already launched, you can open a new “Untitled” Project by selecting NEW

under the File menu, and then DVDMAESTRO (or DVDCONDUCTOR) PROJECT.
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Once the new Project is open, it’s a good idea to save it to your hard drive before you
begin authoring a title.

When you first launch Spruce authoring software, you’ll see an “untitled” Project which resembles this screenshot.

To save a new Project: 

1. Under the File pull-down menu, select SAVE AS.

2. The Save As dialog will appear. This dialog behaves similarly to the Windows
Explorer, allowing you to select directories, create new folders, and more.

Note: If you need to create a new folder within the current directory, simply click on
the CREATE A NEW FOLDER icon at the top of the dialog.

3. The program will also offer a default name (“Untitled1.dvd”). To save your Project
properly, type in any name you want (up to 255 characters).
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Note: Importantly, DVDMaestro and DVDConductor use the suffix “.dvd” to recog-
nize compatible Projects. You should always use this suffix — although you don’t
actually have to type it: As long as the “Save as type” box is in its default setting (DVD

PROJECT), then the “.dvd” suffix will be added automatically to whatever name you
type.

4. Click SAVE and the Project will be saved. You’ll also notice that in the Project Man-
ager (along the far-left of the application), the Project name will change to reflect the
new name.

The Save As dialog.

Keep in mind that the Project is a document that typically takes up relatively little disc
space; saving the Project does not save any of its associated video, audio or other media
assets, except for subtitle text information. (Since Spruce authoring software only reads
your media assets, there’s no need to re-save them.) Consequently, you can save your
Projects to any hard drive or (assuming you don’t have thousands of subtitles) even a
floppy disk.

However, for efficient organization, you may want to save your Projects in the same
directory level as your media files, or in an associated directory (such as a “Current
Projects” folder, within which you would have a “Current Media Files” folder).

Next, it’s time to check the User Preferences and Project Properties for the Project.
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Checking User Preferences & Project Properties
As we mentioned earlier, your Spruce authoring software has several different types of
preferences and properties that need to be 

set. Among its new features is the ability to set

“global” User Preferences, which will apply from Project  to Project. This way, many users will
be able to set the User Preferences once, and keep working, without having to establish
individual Project Properties for each Project.

Let’s begin with a quick overview of how to open your authoring software’s User Preferences:

To open the authoring software’s User Preferences dialog:

• Under the File pull-down menu, select PREFERENCES.

• The following window will appear…

The User Preferences (Property Sheet) dialog, showing the TV System options.

As you can see, there are several “tabs” within this dialog, including General, Display, and
more. If desired, these too could be changed at this point (each of the options will be detailed
in the coming chapters). For now, however, the most important setting is the TV System Setting,
on the right-hand side of the General Tab.

Setting the TV System (NTSC/PAL)

The TV System Setting established the TV/video standard setting for the current Project. If
you are operating in a predominantly PAL or NTSC market, then we recommend setting
the preference to the standard in use in your market area.
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To set the User Preferences for TV System Settings:

• select NTSC if your final replicated discs are destined for NTSC (525/60) playback

– or –

• select PAL if the final replicated disc is destined for PAL (625/50) playback.

If you work on a mixture of Projects — some NTSC, some PAL — you can also set the TV
system on a per-Project basis by setting it within the Project Properties dialog.

To set the Project Properties for TV System Settings: 

1. Right-click on your Project name in the Project Manager (this is the topmost name in
the Project Manager, and is identified by a small “disc” icon). When the context
menu appears, select PROPERTIES. Alternately, you can ALT-double-click on the Project
name in the Project Manager. 

2. This will bring you to the Project Properties dialog, where the General Properties
dialog is the first (default) tabbed page.

3. If the final replicated disc is destined for NTSC playback, select 525/60 (NTSC).

– or –

3. If the final replicated disc is destined for PAL playback, select 625/50 (PAL).

4. At this point, you can also set the other options in this dialog (these options, includ-
ing the settings on the Disc Image and Replication tabs, will be detailed later the
coming chapters).
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The General Properties dialog, showing the TV System options.

Where to Go from Here
Once you’ve named and saved the Project, and have set the TV System properties, you’re
ready to begin authoring your title.

At this stage, most people would start encoding assets, as detailed in Chapter 5 of this
User’s Guide, or importing already encoded assets into the Project (via the Assets Bin), as
detailed in Chapter 4. Following this, you could start dragging assets into DVD Movies or
DVD Menus, as detailed in Chapters 6 and 7, and then move onto creating Subtitles (also
Chapter 6) and connections (Chapter 9). Finally, after previewing your Project, you’ll be
ready to compile the Project (and optionally create a Disc Image), then write a DLT or DVD-R
disc (Chapter 10).
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You’ll find detailed descriptions of the pull-down menus, windows, and other features of
DVDMaestro and DVDConductor throughout this User’s Guide. Since there is generally no
fixed order for authoring a Project (at least, up until it’s time to compile), feel free to move
sequentially from chapter to chapter — or to jump around as you see fit. Of course, if at
any time you encounter terms or concepts you don’t understand, please refer to the Index
at the back of this User’s Guide, or please contact Spruce Technologies Technical Support.

We trust this chapter has given you a good sense of how to “get the ball rolling” with your
Spruce authoring software, and of how Projects typically proceed.

•        •        •

Chapter 3: W
orking with Panes & Windows
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Chapter 3
Working with Panes & Windows

In this chapter, you’ll learn more about DVDMaestro’s and DVDConductor’s panes and
windows, and how to manage their onscreen appearance.

In addition to the pull-down menus and the Toolbar, a Project is comprised of several
principal onscreen components:

• Panes — the Project Manager, Assets Bin, Output Log, and RealView Previewer; 

• Windows — the Connections window, DVD Movie windows(s), and DVD Menu
window(s);

• and the Workspace — the “parent” window in which the Connections window, DVD
Movie windows(s), and DVD Menus window(s) reside. (It’s also possible to position
the panes inside the Workspace; see “Viewing Configurations,” below.)

You can hide or show any of the panes or windows via the View menu, and you can activate
anything in the Workspace via the Window menu. The Workspace itself is always visible.

How do Panes & Windows Differ?

Although similar, panes and windows do have distinct properties. Here’s a rundown of
how they differ:

• Windows are always located within the program’s Workspace area.

• By default, panes are located outside the Workspace — although if you wish, you can
“float” them in the Workspace so that they look and behave like Workspace win-
dows. (This also means that they will be “clipped” by the boundaries of the
Workspace.)
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• When they’re not floating in the Workspace, panes are either “docked” next to one
another, or are floating “on top” of the application. You can even float a pane outside
the main application window frame — so that, for instance, it’s located adjacent to
Windows Explorer. (In this case, the panes won’t be clipped in any circumstance,
even by the boundaries of the application, since they float on top of DVDMaestro or
DVDConductor.)

• In any given Project, you can only have one of each kind of pane; for instance,
there’s only one Project Manager per Project. As for the windows, you can have
multiple DVD Movie or DVD Menu windows (although per Project, only one Con-
nections window is used to make all your connections).

Viewing Configurations

Using your Spruce authoring software, you can create a wide range of “custom” viewing
configurations to suit your tastes or the Project at hand. DVDMaestro and DVDConductor
do have, however, a default viewing 

configuration, which is designed to show all of the

panes and windows in an efficient manner.

(This default viewing configuration is what we’ve used throughout this manual, whenever
we reference where something appears onscreen, and in most of the screenshots.)

Default Viewing Configuration  
When you launch your Spruce authoring software for the very first time, you’ll see the
following default viewing configuration:
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DVDMaestro’s and DVDConductor’s default viewing configuration, showing the panes docked, and the Connec-
tions window in the Workspace.

Note: Like most Windows applications, when you first launch Spruce authoring software,
the application will fill up most, but not all, of your computer monitor’s display area. If
you’d like to enlarge your view to occupy your computer monitor’s entire display area,
simply click the “maximize” button in the upper-right corner of the application window
(it’s the middle of the three buttons on the far-right of the software’s title bar). 

Once you create a “custom” viewing configuration — by resizing or moving any of the
panes or windows — you’ll override the original default viewing configuration. However,
you can recall the default setting easily.

To recall the default viewing configuration: 

1. If DVDMaestro or DVDConductor is open, first you’ll need to exit the program.

2. Hold down CONTROL-SHIFT on your keyboard.

3. Launch the program, either by clicking the icon directly, or by double-clicking on
one of your Project names.
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4. When your Project opens up, the default viewing configuration will be restored.

5. In the default viewing configuration, the Project Manager, Assets Bin, Output Log,
and RealView Previewer panes are always docked around the perimeter of the
Project. (As with any viewing configuration, your DVD Movie, DVD Menu, and
Connections windows are restricted to the Workspace — although you may need to
open those windows via the Project Manager or the View menu in order to see them).

Note: With Spruce authoring software, your viewing configuration is stored “globally.” In
other words, DVDMaestro or DVDConductor will keep using the current way you’ve
configured your onscreen panes and windows until you reconfigure them, or until you
recall the default viewing configuration. Consequently, whenever you launch a Project,
the viewing configuration will be the same as with the very last Project you opened —
even if the viewing configuration was different the previous time you launched the Project.
This way, when Projects are shared between multiple PCs running Spruce authoring software,
each operator will get to view the Project in his or her preferred viewing configuration.

Custom Viewing Configurations 
You can create a wide range of viewing configurations to suit your personal tastes or the
Project at hand. Let’s review some of the possibilities. . .

Hiding & Showing Panes & Windows

You can hide and show any pane or window. Keep in mind that hiding a window doesn’t
turn it “off”; for instance, you can hide your Connections window, but all the connections
you’ve established will remain current until you change them.

To hide any pane or window: 

• Click the item’s close (“x”) button.

– or (with panes and the Connections window only) –

• Go to the View pull-down menu, where you’ll see checkmarks that indicate whether
the panes and Connections window are shown. Click on the name of the item you
wish to hide; this will deselect it and hide it.

– or (with docked panes only) –

• Right-click on the pane’s “double-lined bar” (the left-hand or topmost edge of the
pane that has two highlighted lines). A context menu with several options will appear.
Select HIDE and the pane will disappear.
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To hide a docked pane, click its close (“x”) button, or deselect it under the View menu, or right-click on its
“double-lined bar” and select HIDE.

To show a hidden pane:

• Select the name of the pane under the View menu.

To show a hidden DVD Movie or DVD Menu window:

• Select the name of the DVD Movie or DVD Menu under the View menu;

– or –

• Double-click on the desired name in the Project Manager;

– or –

• Right-click on the DVD Movies or DVD Menus folder in the Project Manager and
select the VIEW MOVIES or VIEW MENUS option; this will open a new dialog where you can
select the DVD Movie or DVD Menu you wish to see.

To show a hidden Connections window:

• Select CONNECTIONS under the View menu;

– or –

• Click on the CONNECTIONS button in the Toolbar;

– or –

• Right-click on the Project name in the Project Manager; when the context menu
appears, select VIEW CONNECTIONS.
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Docking Panes 

When you launch your Spruce authoring software in its default viewing configuration, all
of the panes — the Project Manager, Assets Bin, Output Log, and RealView Previewer —
are “docked” next to one another.

Here are two other ways you can customize how you view docked panes:

To resize a docked pane: 

1. Move your cursor to the splitter bar (frame) that separates the pane from an adjacent
pane.

2. The cursor will change to a “resizer” cursor, allowing you to resize the pane by
dragging the frame up or down or left or right.

Resizing a docked pane.

To move a docked pane: 

1. Drag the pane by left-clicking on its “double-lined bar” (the left-hand or topmost
edge of the pane that has two highlighted lines).

2. As you drag the pane around the Project, you’ll see outlined “ghost” images showing
you the multitude of new positions in which you could dock the pane. (You’ll notice
that as you move the docked pane, the ghost images will be “snapping” into new
possible positions. Each location, you’ll also notice, is always immediately adjacent
to one or more of the other panes — hence the term “docked.” )

3. When you find the location you want, just let go and the pane will drop into place.
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Moving a docked pane. When you release the mouse, the pane will “snap” into its new docked position.

Floating Panes Outside the Workspace 

Aside from docking your panes, you can also “float” them in one of two ways. First, let’s
discuss floating them on top of your Project, but outside of the Workspace.

To float a docked pane (outside the Workspace): 

1. Double-click on the docked pane’s “double-lined bar” (the left-hand or topmost edge
of the pane that has two highlighted lines).

– or –

 Right-click on the docked pane’s double-lined bar. A context menu will appear, with
several options. De-select the ALLOW DOCKING option by left-clicking on it.

2. The pane will “pop” to the top of the project, where it will “float” to its previous
floating location, and on top of any other docked panes.

3. To resize a floating pane, simply move your cursor to the edge of the pane. You’ll see
the cursor change to a resizer cursor, allowing you to resize the pane by dragging the
frame up or down, left or right, or diagonally.

4. To re-dock a pane, right-click anywhere in the grey border that runs around the
perimeter of the pane. When you see the context menu, select ALLOW DOCKING with a
left-click. Once the context menu closes, grab the pane by its title bar, and drag it to
wherever you wish to dock it.
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A formerly docked pane, now floating outside the Workspace — and outside the DVDMaestro application. (Notice
how the visible area of the pane is not cut off by the Workspace.)

Floating your panes outside the Workspace can be convenient especially if you’re interact-
ing with other programs. For instance, if you have the Windows Explorer open next to
DVDMaestro or DVDConductor, you might find it convenient to float the Assets Bin
directly beneath it— and using the floating option, it’s simple to position the Assets Bin
wherever you want onscreen, even outside the program’s borders.

Floating Panes in the Workspace

You can also “float” panes in the Workspace, so that they look like and behave much like
Workspace windows. The main benefit of this feature is that you get to use Workbook
mode for switching between your panes and other windows in the Workspace.
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(Workbook mode lets you choose the active pane or window by clicking on tabs located
along the bottom edge of the Workspace.)

To float a docked pane in the Workspace: 

1. Right-click on its “double-lined bar” (the left-hand or topmost edge of the pane that
has two highlighted lines). A context menu will appear with several options.

2. Select the FLOAT IN WORKSPACE option by left-clicking on it.

3. The pane will “pop” into the Workspace, where it will behave just like a DVD Menu
or other window.

 

A formerly docked pane now floating inside the Workspace. (Notice here how the edge of the Workspace cuts off
the visible area of the floating pane.)



DVDMaestro User’s Guide3-12

To float a pane (that’s already floating in the Project) in the Workspace:

1. Right-click anywhere in the grey border that runs around the perimeter of the pane.
When you see the context menu, select ALLOW DOCKING with a left-click. Once the
context menu closes, grab the pane by its title bar and drag it to wherever you wish to
dock it.

2. Select the FLOAT IN WORKSPACE option by left-clicking on it.

3. The pane will “pop” into the Workspace, where it will behave just like a DVD Menu
or other window.

To resize a pane that’s floating in the Workspace: 

1. Move your cursor to the edge of the pane. You’ll see the cursor change to a resizer
cursor.

2. Using this tool, resize the pane by dragging the frame up or down, left or right, or
diagonally.

3. You can also maximize or minimize the pane, by clicking the appropriate upper-right
corner button, as you can with most windows in Windows NT.

To remove a pane from the Workspace: 

1. Right-click anywhere in the grey border that runs around the perimeter of the pane.

2. When you see the context menu, de-select FLOAT IN WORKSPACE with a left-click.

3. Once the context menu closes, the pane will automatically return to a docked or
floating-in-the-Project position (whichever was the previous state).

Workbook Mode

Workbook mode is a very handy option that lets you switch quickly between your win-
dows. This applies not only to DVD Movies, DVD Menus, and the Connections window,
but also to any panes that you have floated in the Workspace, as described immediately
above.

To enable Workbook mode, pull down the View menu and click on WORKBOOK MODE; a
checkmark indicates that it’s enabled.

When Workbook mode is enabled, you’ll see a series of tabs alongside the bottom of the
Workspace. There’s one tab for each open window. 
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When you click on one of these tabs, its associated Window will pop to the top of the
Workspace, and become the “active” window. This is the same function as selecting an
active window under the Window menu — although most people find that using the tabs
is faster and easier than going to the Window menu, or even using the keyboard shortcuts.

A custom viewing configuration showing Workbook mode. Note the tabs along the bottom edge of the Workspace.

Note: The names on the tabs may be abbreviated for space reasons. However, if you hold your
cursor just above each tab for a moment, a ToolTip will appear, showing the tab’s full name.

Other Viewing Configuration Options
You can move any window or panes that are floating in the Workspace, just by grabbing
their respective title bars. You can also resize windows in the Workspace, just as you
would resize any panes that are floating in the Workspace (as described just above).

There are also three other options you can use to create your own custom viewing con-
figurations. The options are all found under the Window pull-down menu...
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Cascade

This command will layer all visible windows (and panes in the Workspace) one on top of
the other, like cards in a deck.

The Workspace in Cascade view. (Note that Workbook mode is also selected, as indicated by the tabs along the
bottom edge of the Workspace. This would allow you to activate any windows in the Workspace simply by
clicking on their respective tabs.)

Tile

This command will arrange the visible windows (and panes in the Workspace) next to one
another, like tiles on a floor.
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The Workspace in Tile view, with Workbook mode also selected (as indicated by the tabs along the bottom edge of
the Workspace).

Arrange Icons

For most users, this will be a rarely used option. This command works only when:

• you have minimized windows and any panes in the Workspace by clicking their
respective minimize (“_”) buttons so that they appear in the Workspace as small title
bar icons; and

• you’ve moved these minimized windows away from the bottom edge of the
Workspace.
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The Workspace in Arrange Icons view. (Workbook mode is not selected in this example.)

By selecting the ARRANGE ICONS command under the Windows menu, your minimized
windows will be arranged along the bottom edge of the Workspace.

Selecting the Active Workspace Window

Although you can have multiple windows open simultaneously in the Workspace, only the
topmost window is “active.” (A window must be active in order to use its controls or enter
data; the active window also determines which pull-down menus appear; for instance, the
Movie menu is only visible if a DVD Movie window is active in the Workspace.)

One way to select the active window is to simply click on it; its title bar will turn blue and
the other windows will move to the background. However, oftentimes while using Spruce
authoring software, you’ll have maximized your Workspace windows so that only one —
the topmost active one — is visible at any given time.

In this case, there are several ways you can activate a DVD Movie or DVD Menu window:

• If you have selected WORKBOOK MODE under the View menu, then you can switch
between active windows simply by clicking the associated tab underneath the
Workspace window (see “Workbook Mode”).

– or –

• You can pull down the View menu and choose the active Workspace window by
selecting its name under MOVIES or MENUS.

– or –

• You can double-click the name of the DVD Movie or DVD Menu in the Project
Manager.
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There are also several ways you can activate the Connections window:

• If you have selected WORKBOOK MODE under the View menu, you can click on the
Connections window’s associated tab underneath the Workspace window (see
“Workbook Mode”).

– or –

• You can pull down the View menu and select CONNECTIONS.

Note: A checkmark next to the Connections window’s name does not necessarily
indicate that it is functioning as the active Workspace window. It only indicates that it
is open (not hidden).

– or –

• You can select or de-select the CONNECTIONS button in the Toolbar.

Finally, if you have floated one of the panes in the Workspace so that it behaves like a
Workspace window:

• You can also activate that pane by pulling down the View menu, then selecting the
pane’s name.

Note: As with the Connections window, a checkmark next to the pane’s name does
not necessarily indicate that it is functioning as the active Workspace window. It only
indicates that the pane is open (not hidden).

Note: If you have closed a DVD Movie or DVD Menu window (by clicking on the “x” in
the upper-right corner of the window), then you’ll need to re-open the window by return-
ing to the Project Manager or View menu to select the desired item. Also keep in mind that
if you have closed the Connections window, the only way to reopen it is to select it under
the View menu or to click on the CONNECTIONS button in the Toolbar.

•        •        •
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Chapter 4
Working with The Project Manager

The Project Manager is one of the most commonly used panes when working with
DVDMaestro or DVDConductor.

As we’ll cover, the Project Manager is used for managing most aspects of the current
Project, such as setting various properties, or creating, opening, or deleting DVD Movies
and DVD Menus. Let’s find out more…

Project Manager Overview

The Project Manager lists the name of your current Project — and all its associated DVD
Movies and DVD Menus — in either a Windows Explorer-style “tree,” or in a list of icons.

You can use the Project Manager:

• to create new DVD Movies, DVD Menus, Playlists, and Command Sequences;

• to open new or existing DVD Movies, DVD Menus, Playlists, and Command Sequences;

• to set the current Project’s properties;

• to set each DVD Movie or DVD Menu’s respective properties;

• and to rename, delete, and otherwise manage DVD Movies, DVD Menus, Command
Sequences, and Playlists.

Note: Playlists and Command Sequences are not supported in the base-level
DVDConductor, but may be added by installing the DVDPowerPack upgrade package.

The name of your Project is always shown at the top of the Project Manager and is identi-
fied by a “disc” icon. Branching beneath it are names and icons for DVD Movies and DVD
Menus. Depending on the project, this listing may also include Playlists and Command
Sequences, which we’ll detail later in this User’s Guide.
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Just as with the Windows Explorer, you can collapse (hide) branches of the Project Manager.

To hide the branches of the Project Manager: 

• Click on the “–” symbols next to folders in the Project Manager.

To once again expand (show) hidden branches:

• Click on any “+” symbols next to folders in the Project Manager.

Alternately, you can double-click any of the folder icons in the Project Manager to col-
lapse or expand the view.

The Project Manager, in Tree View mode, showing its DVD Movie and DVD Menu branches “expanded.” (Note
that if the Project Manager is sized to be very narrow, the names of the Tree View and List View tabs will not be
visible; however, if you hold your mouse above either the Tree View or List View tabs for a moment, a ToolTip
will appear showing you the name of the tab.)

When you launch a new Project, by default the name of the Project ( “Untitled1,” “Untitled2,”
etc.) will be shown at the very top of the Project Manager. You’ll also see one DVD Movie and
one DVD Menu in the Project Manager; as you create new DVD Movies and DVD Menus,
you’ll see them “stack up” in the Project Manager. When you open an existing Project, you’ll
also see the name of the Project at the top of the Project Manager window.
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You’ll also notice, if it’s a new Project you’re working on, that the only window in the
Workspace will be the Connections window. In order to work with any of the DVD Movies or
DVD Menus in the Project Manager, you’ll need to open them first, as described below.

Switching Between
‘Tree View’ & ‘List View’ Modes

By default, the Project Manager shows its elements as a branching, hierarchical tree, much in
the same way as the Windows Explorer shows folders and files in a tree style. This is called
Tree View (as shown in the previous screenshot).

You can also switch from Tree View to List View — which will show a non-branching display
of your Project and its associated DVD Movies and DVD Menus. Furthermore, there are two
variations of List View: Large Icons and Details (which shows bit-size and other information).

To see the contents of the Project Manager in List View:

• Click the LIST VIEW tab at the bottom of the Project Manager.

The Project Manager — shown in the DETAILS variation of List View mode.
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To once again view the Project Manager as a branching hierarchical tree:

• Click the TREE VIEW tab at the bottom of the Project Manager.

There are actually two variations of List View. By default, List View shows the Project
Manager’s contents as large icons. List View can also display details, showing size and
type (DVD Movie or DVD Menu) information.

To choose whether you see the List View as large icons or details:

1. Ensure you’ve selected the LIST VIEW tab at the bottom of the Project Manager.

2. Right-click anywhere in the Project Manager; this will reveal a “pop-up”-style
context menu.

3. Left-click on your choice of LARGE ICONS or DETAILS. The List View will switch to the
corresponding display.

The Project Manager — shown in the LARGE ICONS variation of List View mode.
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Note: When in List View, your Spruce authoring software will create “real” icon images
that are based upon the actual DVD Movie or DVD Menu images. This can be very useful
for keeping track of a Project. However, it does mean — if you have several dozen or
more DVD Movies or DVD Menus — that your Project may take longer to load (when you
first open it). To speed up the loading process, you can deselect the SHOW REAL ICONS option
by right-clicking anywhere in the Project Manager (while in List View). Then, the next time
you open the current Project, the real icons will be replaced by generic icons.

Creating New DVD Movies

You can use the pull-down File menu or the Toolbar to create new DVD Movies. Alter-
nately, you can use the Project Manager.

To create a new DVD Movie using the Project Manager: 

1. In the Project Manager, right-click on the name (or icon) of the current Project, the
Movies folder, or any current DVD Movie. This will reveal a pop-up context menu.

2. Left-click on the ADD NEW MOVIE option.

3. A new DVD Movie name and icon will appear in the Project Manager.

When you right-click on the name or icon of the current Project in the Project Manager, a pop-up context menu
will appear. Here you can choose, among other things, to add a new DVD Movie or a new DVD Menu.
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Creating New DVD Menus

Creating new DVD Menus is very similar to creating new DVD Movies. You can use the pull-down File menu or
the Toolbar to create new DVD Menus. You can also use the Project Manager.

To create a new DVD Menu using the Project Manager: 

1. In the Project Manager, right-click on the name (or icon) of the current Project, the
Menus folder, or any current DVD Menu. This will reveal a context menu.

2. Left-click on the ADD NEW MENU option.

3. A new DVD Menu name and icon will appear in the Project Manager.

Opening DVD Movies or DVD Menus
(Editing DVD Movies or DVD Menus)

Note: By “opening” or “editing,” we’re referring to opening a window in the Workspace —
and normally, you do this whenever you wish to edit something in a DVD Movie or DVD
Menu. You can have as many DVD Movies or DVD Menus open as you like, although
some people may prefer to keep them hidden until they need to edit them.

Note: DVD Movies and Menus consume RAM when open in the Workspace window. For
best performance, limit the number of open DVD Movies and Menus. In most situations, a
limit of about 20 items open at one time is desirable. If you find your system is operating
slowly, check to see if there are too many items open in the Workspace.

To open a new or existing DVD Movie or DVD Menu using the Project Manager: 

1. In the Project Manager, double-click on the name (or icon) of the desired DVD
Movie or DVD Menu.

– or –

In the Project Manager, right-click on the name (or icon) of the desired DVD Movie
or DVD Menu, then select EDIT DVD MOVIE or EDIT DVD MENU.
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2. A corresponding DVD Movie or DVD Menu window will open in the Workspace.

3. If a DVD Movie’s or DVD Menu’s corresponding window is already open in the
Workspace (remember, a window can be open yet be hidden by other windows),
then double-clicking on its name (or icon) in the Project Manager will “activate” the
window, making it the topmost window in the Workspace.

You can also use the View pull-down menu to open a DVD Movie or DVD Menu, as
detailed in Chapter 13.

To close a DVD Movie or DVD Menu, simply click on its close (“x”) button.

Opening Multiple DVD Movies or DVD Menus
You may open several DVD Movies or DVD Menus at once by using the View Movies
(Menus) command in the pop-up context menu from the top-level Movie or Menu folder.

Right-clicking in the Project Manager to open multiple DVD Movies; if you click on the Menus folder, the option
will read VIEW MENUS.

To open multiple DVD Movies or DVD Menus:

1. In the Project Manager window, right-click on the folder “Movies” or “Menus.” This
will reveal a pop-up context menu.

2. Select VIEW MOVIES (MENUS).

3. In the List dialog that appears, select those DVD Movies or DVD Menus that you
wish to open.

4. Click OK. The selected DVD Movies or DVD Menus will open into the Workspace.
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The List dialog that opens when you select VIEW MOVIES (MENUS).

Renaming, Deleting, or Duplicating
DVD Movies & DVD Menus

You can rename, delete, or duplicate any DVD Movie or DVD Menu using the Project Manager.

To rename, delete or duplicate a DVD Movie or DVD Menu: 

1. In the Project Manager, right-click on the name (or icon) of the desired DVD Movie
or DVD Menu, then select the desired action from the context menu.

2. If you select RENAME DVD MOVIE or RENAME DVD MENU, the item’s name will be highlighted
in the Project Manager. Simply type whatever name you wish (32 characters maximum).
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3. If you select DUPLICATE DVD MOVIE or DUPLICATE DVD MENU, a copy of your selection will
appear at the bottom of the DVD Movie folder or DVD Menu folder. The copy will
be named “[ORIGINAL NAME] Copy01”, and it will retain all the characteristics and
properties of the original item.

4. If you select DUPLICATE DVD MOVIE/CONNECTIONS or DUPLICATE DVD MENU, a copy of your
selection will also appear within the DVD Movies or DVD Menu folder, named
“[ORIGINAL NAME] Copy01”. This copy will retain all the characteristics and properties
of the original item and it will also have the connections in the Connections window.
If need be, you can alter some or all of these connections to suit the needs of the
Project.

Sorting DVD Movies & DVD Menus
within the Project Manager

Normally, your Project Manager lists DVD Movies and DVD Menus in the order in which
they were created. If you wish, however, you can sort your DVD Movies and DVD Menus
alphabetically using the Project Manager.

Right-clicking in the Project Manager to sort DVD Movies or DVD Menus.
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To sort DVD Movies and DVD Menus alphabetically within the Project Manager: 

1. In the Project Manager, right-click on the name (or icon) of the current Project; this
will reveal a context menu.

2. Left-click on the SORT option.

3. The order of all DVD Movies and DVD Menus and Command Sequences in the
Project Manager will be sorted alphabetically.

Reordering the Physical Placement
of DVD Movies and DVD Menus

One of Spruce authoring software’s more advanced features is the ability to reorder the
physical placement of DVD Movies and DVD Menus in the final compiled file structure.
This can be important in optimizing access speed of a disc by placing items that connect
one another in closer proximity.

To reorder the physical placement of DVD Movies or DVD Menus in order to optimize disc layout:

1. Right-click on the top level Movies or Menus folder in the Project Manager window.

2. Select the command RE-ORDER MOVIES (MENUS).

3. In the List dialog that appears, drag the DVD Movies or DVD Menus into the order in
which you wish them to be physically laid out on the final disc volume.
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Managing Command Sequences & Playlists
Requires DVDMaestro or DVD PowerPack Option

DVDMaestro (and the DVDPowerPack option for DVDConductor) give you the option of
working with Command Sequences. These are optional interactive scripts that use the
native machine code of an end-user’s DVD player to provide an enhanced playback
experience.

Command Sequences appear in the Project Manager as a new icon (object type), just like
DVD Movies and DVD Menus. When you create a new Project, you’ll see an empty
Command Sequences folder. You can create a new Command Sequence by right-clicking
on this folder, and selecting ADD NEW COMMAND SEQUENCE (or by using the toolbar at the top
of Maestro). For detailed information about Command Sequences, see Chapter 12 of this
User’s Guide.

DVDMaestro (and the DVDPowerPack option for DVDConductor) also offer a feature
known as Playlists. These are alternate play sequences that allow you to use or re-use
DVD Movies or individual Chapters within DVD Movies in different play order, without
occupying additional space on the final, replicated disc. You can think of them as being
like “aliases” or “shortcuts” on a computer, as they provide different ways to access the
same material without making a copy of it.

New Playlists are created only within an existing DVD Movie, as these are “sub-objects” of
a Movie that consist of an ordered list of some or all of that Movie’s Chapters. For detailed
information about Playlists, please see Chapter 6 of this User’s Guide.

Managing Command Sequences and Playlists from within the Project Manager is much
like managing DVD Movies and DVD Menus. That is, by right-clicking on Command
Sequence or Playlist icons in the Project Manager, you can open, rename, delete, dupli-
cate, and sort Command Sequences and Playlists in exactly the same way as which you
can work with DVD Movies and DVD Menus.
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Opening (& Closing) the Connections Window
From the Project Manager

Normally, you can open and close the Connections window using either the View menu
or the Connections button on the Toolbar (as detailed in Chapter 13); you can also close
the Connections window by simply clicking its close (“x”) button. However, you can also
open and close the Connections window using the Project Manager.

 Opening the Connections window from within the Project Manager.

To open or close the Connections window using the Project Manager:

1. In the Project Manager, right-click on the name (or icon) of the current Project; this
will reveal a context menu.

2. If the VIEW CONNECTIONS option has a check mark next to it, left-clicking on that option
will close the Connections window.

3. If the VIEW CONNECTIONS option does not have a check mark next to it, left-clicking on
that option will open the Connections window and bring it to the top of the
Workspace (making it the active window).
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Opening the Project Properties Dialog
via the Project Manager 

As we’ll detail in Chapter 10, your Spruce authoring software lets you set various proper-
ties on a Project-by-Project basis. These properties, which are opened via the Project
Manager, pertain to NTSC or PAL compatibility; Disc Image creation matters; Replication
matters, and optional special functions such as initializing the selection of audio, subtitle,
and camera angle streams.

Note: The Properties are not the same as the global User Preferences that are set by
selecting PREFERENCES under the pull-down File menu.

Opening the Project Properties.

To open the current Project’s properties:

1. In the Project Manager, right-click on the name (or icon) of the current Project. This
will reveal a context menu.

2. Left-click on the PROPERTIES option.

3. The Project Properties dialog will appear.

– or –

1. ALT-double-click on the Project’s name in the Project Manager.

2. The Project Properties dialog will appear.



DVDMaestro User’s Guide4-16

The Project Properties dialog has three tabbed pages — the General Properties, Disc Image
Properties, and Replication Properties. These three tabs, and all of their respective options
and features, are detailed in Chapter 10.

General Properties (DVDMaestro vs. DVDConductor)
When the Project Properties dialog first opens, you’ll be presented with the General
Properties dialog as the first (default) tabbed page.

If you are using DVDMaestro, the General Properties tab will look like this:

The General Properties dialog, showing the Target Format, Parental Level, and TV System options.

If you’re using DVDConductor, the Project Properties dialog is somewhat simpler, as some
of the features supported in this dialog are not included. If you open Project Properties in
DVDConductor, the General Tab dialog appears as shown below.
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The Project Properties dialog, as found in the standard version of DVDConductor.

Note: The additional features supported by DVDMaestro’s Project Properties dialog may
be added to DVDConductor by installing the DVDMaestro option.

For more information regarding Project Properties, please refer to Chapter 10.

Summary: Project Manager

The Project Manager helps you organize many aspects of your current Project — such as
creating, deleting, and otherwise managing DVD Movies; DVD Menus; Command Se-
quences; and Playlists. The Project Manager is also used to access the Project Properties.

Next, let’s take a look at the Assets Bin. . .

•        •        •
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Chapter 5
Working with The Assets Bin

As we’ve described earlier, DVD Movies and DVD Menus are built using video, audio and other
types of assets. (For a complete listing of the various types of assets that DVDMaestro and
DVDConductor are able to import, please see “Supported Assets” in Chapter 2.)
In most cases, these assets are imported into your Projects using — and stored in — the Assets Bin.

Assets Bin Overview

The Assets Bin is Spruce authoring software’s “storage area” for video and other assets.
You’ll use the Assets Bin whenever you wish:

• to import video, audio, and still image assets into your Project;

• to drag an imported asset into a DVD Movie or DVD Menu;

• to view detailed information about your assets;

• to sort how you view the assets;

• or to remove assets from the Project.

The Assets Bin.
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Note: The Assets Bin is not used for importing subtitle assets, whether they are subtitles
files (.son or .stl files) or whether they are individual bitmapped files (.bmp files). For
information on how to import these assets, please refer to Chapter 12.

Importing Assets into a Project

Before you can drag video, audio, or other assets into a DVD Movie or DVD Menu, you
need to “import” them into your Spruce authoring software. 

When you import an asset, you’re not copying an actual file to a new location. Rather,
you’re creating a pointer — a type of shortcut (or alias, to you Macintosh users) — from
your Spruce authoring software to a file that’s already sitting on one of your hard drives.

Note: Assets don’t become “physically” incorporated into your Project until you compile
the Project, when they are multiplexed into the final data stream. Until that time, your
Project simply “points” to the appropriate assets — which means that once you import an
asset into a DVD Movie, you mustn’t delete or otherwise move that file until after you
have compiled your Project.

For instance, let’s say you import a video file into your Project and place that file into a DVD
Movie video track. If you then play the video file (by previewing the Project), what you’re
watching is the original video file under the playback control of Spruce authoring software.

 To import assets into a Project:

1. Double-click anywhere in the Assets Bin.

– or –

Right-click within the Assets Bin (it’s okay to click on the name or icon of any files
which may already be in the Assets Bin). This will reveal a context menu with several
options. Left-click on the IMPORT MEDIA ASSET option.

2. The Import Media browser will appear. Here, you can type in the file name directly
(in “drive:\folder\file name” format) or you can browse through your hard drives and
folders to locate the desired file.

3. Click OK once you’ve typed in or found the desired file. (You can also double-click
on the desired file.)
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To import video, audio, and still image files into your Project, right-click
anywhere in the Assets Bin and select IMPORT MEDIA ASSET.

The Import Media browser.

You can also import assets by using the Windows Explorer or the Windows desktop, in the
following manner. . .

To import assets into a Project using the Windows Explorer or the Windows desktop:

1. Launch the Windows Explorer.

2. Browse through your hard drives and folders to locate the desired file.
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3. Once you’ve found the desired file, simply drag it from the Explorer directly into the
Assets Bin.

– or –

1. Right-click within the Assets Bin (it’s okay to click on the name or icon of any files
which may already be in the Assets Bin). This will reveal a context menu with two or
more options.

2. Left-click on the LAUNCH EXPLORER option.

3. This will launch the Windows Explorer. Here, you can browse through your hard
drives and folders to locate the desired file. (If you have selected a file in the Assets
Bin by left-clicking once on it, then the Windows Explorer will open in that file’s
associated folder.)

4. Once you’ve found the desired file, simply drag it from the Explorer directly into the
Assets Bin.

5. Alternately, you can also drag any still image file directly from the Explorer and add it
to an active DVD Menu. In this case, the file name will appear in the Assets Bin once
you’ve added the file to the DVD Menu. (See note below.)

– or –

1. Click on the Windows desktop, behind your open Project.

2. Locate the desired file on the desktop.

3. Once you’ve found the desired file, simply drag it from the desktop directly into the
Assets Bin.

4. Alternately, you can also drag any still image file directly from the Explorer and add it
to an active DVD Menu. In this case, the file name will appear in the Assets Bin once
you’ve added the file to the DVD Menu. (See note below.)

. . . and you’re done — the file name will now appear in the Assets Bin and is ready to be
dragged into the appropriate window.

Note: If you attempt to drag an unparsed video or audio file directly from the Explorer or
the desktop to a DVD Movie or DVD Menu, you’ll be warned that the file needs to be
parsed first before you can use it. Then drag it from the Assets Bin once it’s been parsed
(see “Parsing Imported Video & Audio Files”).
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Dragging files from the Windows desktop to the Assets Bin.

Sorting the Contents of the Assets Bin
You can sort the assets in the Assets Bin by four different ways:

• by name;

• by duration (file length; applicable only to video and audio files);

• by type (“Audio,” “Video,” “BMP-Image,” etc.); or

• by Status (“OK” indicates that the file is ready to be dragged to a DVD Movie or
DVD Menu).

To sort the contents of the Assets Bin:

1. With the Assets Bin open, click once in either the NAME, DURATION, TYPE, or STATUS tabs
at the top of the Assets Bin.

2. The contents of the Assets Bin will sort automatically with respect to which tab you
clicked.

3. To sort the contents of the Assets Bin in the opposite manner — for instance, to sort by
name, only starting from “Z” to “A” instead of “A” to “Z” — click the same tab again.

4. To resort the contents of the Assets Bin by another way, simply click on another tab.



DVDMaestro User’s Guide5-8

Viewing Imported Assets Properties
Once you’ve imported an asset into the Assets Bin, you can view its properties. This will
provide you information regarding the asset’s location on your hard drive and what type of
asset it is.

Right-clicking on an imported asset’s name will reveal the PROPERTIES option.

To view an asset’s properties:

1. Right-click on the asset name in the Assets Bin.

2. When the context menu appears, select PROPERTIES.

3. This will bring you to the Asset Properties dialog.

– or –

1. ALT-double-click on the asset name in the Assets Bin.

2. The Asset Properties dialog will open directly.
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The Asset Properties dialog.

Note: In the Asset Properties dialog, you can only view the properties that apply to the
selected asset — not change them.

Parsing Imported Video & Audio Files (& Canceling Importing) 
Note: If you’ve encoded video or audio assets using your DVDMaestro or DVDConductor
system, then this section probably won’t apply to you, since parsing is performed auto-
matically during the encoding process. Parsing as you import a video or audio file into
your Project only takes place in either of the following two circumstances:

• you’re working with files that have been encoded on a non-Spruce system;
– or –
• you’re using assets that were created with an earlier version of DVDMaestro or

DVDConductor than the one you’re currently using.

Whenever you import a video or audio file into your Project that has not already been
“parsed,” then your Spruce authoring software will automatically “parse” the file informa-
tion. Parsing confirms the file’s type and integrity and extracts other information (such as
duration). This process can take anywhere from several seconds to several minutes,
depending upon the size of the file. (DVDMaestro and DVDConductor are multithreaded
applications, so you can do other things while parsing happens in the background.) Once
a file has been parsed, a corresponding “.prv” file (for video assets) or “.pra” file (for audio
assets) will appear in the same folder where the asset resides; this is the file containing informa-
tion that Spruce authoring software uses to determine whether the asset needs parsing.
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Note: Parsing occurs only the first time you import a previously unparsed asset into a
Project. Thereafter — even if you import the file into a completely different Project —
Spruce authoring software will recognize that the file has already been parsed, and there
will be no wait time. There are three exceptions to this rule: 1) if the parsing file has been
deleted; 2) if the Asset has been changed (i.e., has a new name); and 3) if the parsing file is
“out of date,” which could occur if it was originally parsed using an older version of
DVDMaestro or DVDConductor.

If you import the file via the Assets Bin — and it has yet to be parsed — you’ll see a
progress bar in the STATUS field showing the relative progress of the parsing process. If,
however, you import an unparsed audio or video file via the Windows Explorer or from
the desktop directly into a DVD Movie or DVD Menu — “bypassing” the Assets Bin —
you’ll receive the following warning:

THIS ASSET CANNOT BE USED UNTIL THE FILE IS PARSED. PLEASE DRAG IT FROM

THE ASSETS BIN TO THE APPROPRIATE TRACK AFTER PARSING IS COMPLETE.

A progress bar in the Assets Bin shows the relative progress of the parsing process for a newly
imported file. To cancel the importing of a file, press the DELETE key on your keyboard after
clicking on the file name.

You can cancel importing a file at anytime.

To cancel importing:

• click once on the file name and press the DELETE key

– or –

• click once on the file name, then right-click and select DELETE THE SELECTED ASSET.
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Previewing Imported Still Image Files 
You can “preview” any still image already in the Assets Bin.

To view an imported image using the Picture Previewer:

1. Double-click on the still image name in the Assets Bin.

2. The Picture Previewer window will open up, showing the image in full-resolution.

Note: You cannot edit the image from within the Picture Previewer window. However, once
the image is added to a DVD Menu, you can double-click on the image, which will launch
whatever application is associated with the file extension such as Microsoft Paint™ or Adobe
Photoshop™ (see “Editing Backgrounds & Subpictures” in Chapter 7). However, please keep in
mind that in this case, since the file is already “in use” by Spruce authoring software, you’ll
need to quit DVDMaestro or DVDConductor in order to edit and save the image.

To open the Picture Previewer, simply double-click on the name
of any still image in the Assets Bin.
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Importing MPEG Video Files with Non-Standard File Extensions
When you import video files via the Assets Bin, Spruce authoring software looks for the
“.m1v,” “.mpv,” “.m2v,” or “.vbs” file extensions. However, it’s possible to import any valid
MPEG file, even with a different extension; as long as the file is one hundred percent DVD
compliant, DVDMaestro or DVDConductor will treat it as a valid MPEG stream and allow you
to import it.

Note: If you don’t see the desired file when you go to import it, simply click on the FILE OF TYPE

drop-down list and select ALL FILES (*.*) — and all the files in that directory will be shown. Then
just find the desired file and double-click; if it’s a supported file, it will be imported.

Adding Assets to DVD Movies or DVD Menus

Once you’ve imported an asset into the Assets Bin, you can add it to any DVD Movie or
DVD Menu by simply dragging the item from the Assets Bin to the appropriate track (for
DVD Movies) or the desired DVD Menu.

Note: You can drag multiple video or audio assets into a DVD Movie or DVD Menu by
holding the CONTROL key as you click on the file names (or the SHIFT key to select a range of
files), then simply dragging them to their appropriate locations.

For more information on this matter, please see “Adding Backgrounds & Subpictures to a
DVD Menu” (in Chapter 7), “Adding Video Assets to a DVD Movie” (Chapter 6), or
“Adding Audio Assets to a DVD Movie” (Chapter 6).

Deleting Assets from a Project

You can easily delete any media asset from your Project by deleting it from the Assets Bin.

Please keep in mind that when you delete an asset from a Project, you’re simply deleting a
“pointer” to the file on your hard drive. To actually delete the original file, you’ll need to
leave Spruce authoring software and explicitly delete the file from the hard drive using the
Windows recycle bin.
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To delete an asset in the Assets Bin:

1. Click once on the file name and press the DELETE key.

– or –

 Click once on the file name, then right-click and select DELETE THE SELECTED ASSET.

2. A prompt will appear asking ARE YOU SURE YOU WANT TO REMOVE THE SELECTED MEDIA FILES?
Click YES.

Note: You can select multiple assets by holding the CONTROL key as you click on the file
names (or the SHIFT key to select a range of files).

Deleting an asset from a Project.

If the asset is currently used in a DVD Movie or DVD Menu, you will receive another
prompt letting you know that the file cannot be removed from the Project. In this case, first
you’ll need to either remove the asset from the DVD Movie or DVD Menu, or delete the
particular DVD Movie or DVD Menu.



DVDMaestro User’s Guide5-14

Summary: Assets Bin

The Assets Bin allows you to manage almost all video, audio and other assets — from
importing assets into the Project, to viewing their respective properties, to removing them
from the Project.

Now we’re ready to take a detailed look at how to work with DVD Movies. . .

•        •        •

Chapter 6: W

orking with DVD Movies
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Chapter 6
Working with DVD Movies

Working with DVD Movies is in many ways the heart and soul of DVD authoring. As
you’ll see, DVDMaestro and DVDConductor make working with DVD Movies a stream-
lined, fun, and creative process.

DVD Movies are where you incorporate the major playback elements of your title —
including video content, one or more audio tracks, and, optionally, subtitles, random-
access chapters, and more. In just a few pages, we’ll describe how to create a DVD Movie
by adding these elements one-by-one, and as needed, to their respective Timelines.
Whenever someone plays back your final, replicated disc and is able to see video, hear
audio, or read subtitles, they’re experiencing the playback of one of these DVD Movies.
(The one exception to this is with “dynamic” DVD Menus, as we’ll cover in Chapter 7.)

Many DVD-Video titles are produced with just one or two DVD Movies. However, if you
intend to author a title with a variety of viewing options (such as a choice between differ-
ent aspect ratios, as described later in this chapter), you may find yourself creating several
or even dozens of DVD Movies. Fortunately, Spruce authoring software supports up to 99
DVD Movies per Project — which means you can offer your end-users a lot of different
viewing options. (These different options would be established using one or more DVD
Menus and the Connections window.)

As vital as DVD Movies are to your Project, we’ve gone to great lengths to keep them easy
to use and understand. For instance, adding a video or audio file to a DVD Movie can be
as simple as dragging it from the Assets Bin onto the DVD Movie. Subtitles files and
individual bitmapped subtitles an also be added easily, or you can create professional-
looking subtitles entirely within Spruce authoring software.

Let’s begin with an overview of a DVD Movie window.

Note: A DVD Movie is not the same as a video file, nor should it be confused with a DVD-
Video disc. We use the term “DVD Movie” to refer to a Spruce authoring software window
where you create movies — with video, audio, and, optionally, subtitle content — that
end-users can experience when they play the final, replicated disc.
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DVD Movie Overview

A typical DVD Movie. Starting at the top of the image we see the DVD Movie Control Bar, with (from left) the Zoom
Out, Zoom Framer, and Zoom In tools; the Stop, Play/Pause, and Step-Frame Advance transport controls; the
Playback Location, Start Location (top), and End Location (bottom) counters; and the Thumbnail Previewer. Moving
down, we see the Wall Clock, Marker, and Timecode Timescales. (Notice the Chapter Point Markers and PlayCursor
in the Marker Timeline.) Next is the Video Timeline, with one track visible, and showing “picons” at each Chapter
Point Marker. Beneath that is the Audio Timeline, with four tracks visible. Next is the Subtitle Timeline, with seven of
its 32 tracks visible. Finally, in the lower-left corner, we have the Status Bar, showing the DVD Movie’s current frame
rate (frames per second) and its aspect ratio (4:3).

Each DVD Movie window has four main areas, as follows:

• The DVD Movie Control Bar: 

° This area is used to adjust your view of the current DVD Movie (by zooming
in or out), and to control playback for RealView preview. This area also
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displays location information and preview thumbnail for quick reference to
play location, chapter marks, etc. The controls in this area include: Zoom
In; Zoom Out; Zoom Framer; Stop, Play/Pause, and Step-Frame Advance;
and the Playback Location counter, Start Location counter, and End Location
counter. ToolTips are available by hovering your mouse cursor above these
areas to see their names.

• The DVD Movie Timescales: 

° In this area, you’ll find indicators for Wall Clock (elapsed real time) and
timecode (SMPTE/EBU timecode). This area is also used to create and edit
Chapter Point (and other) Markers and to set the starting point (PlayCursor)
for RealView preview. The Timescales area includes the Wall Clock Times-
cale, the Marker Timescale, and the Timecode Timescale.

• The DVD Movie Timelines: 

° Here’s where you “construct” the DVD Movie, by adding — and positioning
in time — any desired video, audio, and subtitle assets. Each DVD Movie
has three Timeline areas: the Video Timeline area, Audio Timeline area, and
Subtitle Timeline area. The Video, Audio and Subtitle Timeline areas support
multiple tracks within each. Only one of these tracks can play, or be
“active,” at a time.

Note: Depending upon your viewing configuration, not all of each
Timeline’s tracks may be visible. You can expand or collapse your view of
each Timeline by clicking on the Collapse Timeline arrow in the upper-left
corner of each Timeline; by resizing each Timeline by grabbing their
respective splitter bars; or by scrolling down within each Timeline.

• The DVD Movie Status Bar: 

° The Status Bar is located along the lower edge of the DVD Movie window.
Here, you can see an indication of the DVD Movie’s current frame rate and
aspect ratio, and you can also reset the aspect ratio if needed.

In addition, DVD Movies are supported by a DVD Movie Properties dialog that lets you
specify control over available user actions, import of closed-caption (line 21) text data, and
control over AC-3 Karaoke Mix Mode.

We’ll be describing the DVD Movie Control Bar, Timescales, Timelines, and Status Bar —
as well as the DVD Movie Properties — in greater detail later in this chapter. For now, let’s
start by reviewing how we build DVD Movies. . .
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DVD Movie Tutorial:
Building a DVD Movie

Note: In this tutorial, we’ll be introducing features and concepts that will be described
in greater detail later in this chapter, and in Chapters 11 and 12. Where appropriate,
you may wish to glance ahead for more information.

In the coming pages, we’re going to lead you through the basics of building a DVD
Movie, complete with video, audio, and subtitles. If you’re new to Spruce authoring
software, we recommend that you try building a DVD Movie by following along, step-
by-step.

First, you’ll want to open and save a new Project (see Chapter 2).

Note: Don’t forget to save your Project frequently as your proceed.

By default, whenever you open a new Project, you’ll find a new DVD Movie —
entitled MOVIE1 — in the Project Manager, inside the Movies folder. The Spruce
authoring software also creates, by default, a new DVD Menu, inside the Menus
folder.

When you create a new Project, a default DVD Movie
(“Movie1” and DVD Menu (“Menu1”) appear in the Project Manager.
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Note: As we mentioned, there’s no time length limit for a DVD Movie (other than
those imposed by the DVD-Video Spec and the physical disc space available for your
chosen replication format). And while it’s not uncommon to create an entire Project
using a single DVD Movie, more elaborate projects may use several or even dozens of
DVD Movies.

At this point, before moving forward, it’s a good idea to rename the new DVD Movie
in the Movies folder to something more descriptive than just MOVIE1.

Renaming a DVD Movie
By default, each DVD Movie you create is named MOVIE1, MOVIE2, etc. You may wish to
name your DVD Movies in relation to their ultimate function, such as DIRECTOR’S CUT, FAMILY

VERSION, THEME MUSIC VIDEO and so on. DVD Movie names can be up to 32 characters long.

Renaming a DVD Movie.

To rename an existing DVD Movie:

1. Right-click on the icon of the Movie in the Project Manager.

2. Select the command RENAME MOVIE.

3. Enter the desired name.

4. Press RETURN on the keyboard.
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Generally, the names you assign to DVD Movies are for your use only. However, if
you select the option Embed Project Text Data in DVD Image in the Project Properties
dialog, then the names you assign DVD Movies will also appear as title names on
DVD players that are equipped to support the Text Display extensions of the DVD-
Video Specification (version 1.1). If you choose this option, naturally you’ll want to
take extra care in the spelling and phrasing of each DVD Movie’s name.

The Embed Project Text Data option, in the Project Properties dialog.

Opening the DVD Movie
To start building your DVD Movie using encoded video and audio assets, you will open
the DVD Movie.

To open the DVD Movie: 

• In the Project Manager, double-click on the name (or icon) of the DVD Movie.

– or –

• In the Project Manager, right-click on the name (or icon) of the desired DVD
Movie, then select EDIT MOVIE.
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Opening the DVD Movie by right-clicking on its name in the Project Manager.

When you open a DVD Movie, it appears as a window in the Workspace. You can
have multiple DVD Movies open in the Workspace, at any given time only one can be
the topmost active Window.

Note: In order to edit a DVD Movie, it must be both open and active in the
Workspace. Only one window can be active a time; that is, if there are multiple
windows open in the Workspace, the window that appears at the “front” of the
window is the active window.

Because different users prefer to work in different ways, Spruce authoring software
provides preferences and commands for handling windows in the Workspace.

Most users prefer to select the Display preferences shown above, and to work in Workbook Mode.
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Many Spruce users prefer to work with the settings shown on the previous page. For
convenience, we will adopt these settings as a convention and describe procedures in
terms applicable to them.

To review these settings, first select PREFERENCES from the File pull-down menu. Then
select the Display tab and set the first, third, sixth, and seventh checkboxes. (The
second, fourth, and fifth checkboxes are deselected.) In the View menu, we set the
selection Workbook Mode to ON.

Note: These options, including Workbook Mode, are detailed in Chapter 3.

A DVD Movie, ready for editing. Note the tabs along the bottom of the Workspace — which appear when
you’ve selected Workbook Mode, and allow you to switch between DVD Movies and other windows within
the Workspace.

With these selections, there will be only one window visible in the Workspace at a
time. Tabs along the bottom of the window provide a convenient way to activate the
desired window for editing.
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Importing Assets for use in a DVD Movie
DVD Movies include video and audio “assets,” which are encoded video and audio
files. (In Chapter 2, we discussed exactly what file format types Spruce authoring
software currently supports.)

Before you can add assets to a DVD Movie, first you need to import them into your
Project, using the Assets Bin, or via the Windows Explorer, as introduced in Chapter 4.
(We’ll review both of these methods below.)

Note: If you have yet to encode any assets of your own (as described in the accompa-
nying Spruce Technologies Encoder Guide), you’ll find sample files that you can use
on the master program disc for your version of DVDMaestro or DVDConductor.

For subtitles, you can import them as “subtitles” (script) files by right-clicking directly
in a subtitle track without using the Assets Bin. You can also create individual subtitles
directly in DVDMaestro or DVDConductor — or import individual subtitle bitmaps —
using the Subtitle Editor, as introduced later in this chapter, and as detailed in Chapter 12.

Assets vs. Tracks vs. Streams

At first, you may be confused by the difference between assets, tracks, and streams —
especially if you come from a video or audio editing background. Let’s review how
they compare. . .

• Assets are audio, video, still, or subtitles files imported into the Project, and
(except for subtitles files) found in the Assets Bin. When working with DVD
Movies, assets are added to the Video Timeline, or one of the available tracks in
the Audio or Subtitle Timelines.

• Tracks are subsections of the Timelines. With DVDMaestro and DVDConductor
with the PowerPack option, the Video Timeline has nine video tracks — letting
you incorporate up to nine different “camera angles” into a DVD Movie.
DVDConductor supports two video tracks, suitable for DVD Movies which might
incorporate, say, “primary” and “alternate” camera angles.

Note: By adding the DVDPowerPack option, DVDConductor will support nine
video tracks — the same as DVDMaestro.
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• With DVDMaestro and DVDConductor, the Audio Timeline and the Subtitle
Timeline have eight and 32 tracks respectively. This means, for instance, that you
can have eight different simultaneous audio assets in the Audio Timeline’s eight
tracks — although only one of these tracks can be the active audio track or
“audio stream,” at any given time.

• Streams refer to the active video, audio, or subtitle track. Only one video track,
single audio track, and single subtitle track can be seen or heard at any given
time when the DVD Movie plays back. Tracks which are being played back or
are designated to be played back, are known as the active streams.

Adding Video Assets to a DVD Movie
If your MPEG-encoded video assets have already been imported into the Assets Bin,
adding them to a DVD Movie is just a matter of dragging the desired asset from the
Assets Bin into track 1 of the DVD Movie’s Video Timeline.

DVDMaestro has nine video tracks, for support of up to nine camera angles.
DVDConductor supports two video tracks, but can be upgraded to nine video tracks
by adding the DVDPowerPack option.
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Adding a video asset to a DVD Movie by dragging it from the Assets Bin.

Note: A DVD Movie may contain more than one video asset, either as concatenated
video, or as multiple-angle video (as detailed in Chapter 11). For now, we’ll assume
we’re creating a DVD Movie with only a single video asset.

To add a video asset to a DVD Movie:

1. Open the DVD Movie and make it the active window.

2. Find the desired video asset within the Assets Bin. If you have yet to import the
desired video file into the Assets Bin, then:

° right-click in the Assets Bin and select IMPORT MEDIA ASSET. Using the Import
Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click OPEN and the file will appear in the
Assets Bin;

– or –

° right-click in the Assets Bin and select LAUNCH EXPLORER. Then, using Windows
Explorer, locate the file on your hard drive and drag it directly to the Assets
Bin. You can also click directly on the Windows desktop and drag the file
from the desktop to the Assets Bin.
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3. Left-click on the desired video asset in the Assets Bin and drag it into the DVD
Movie. Once you position your mouse over track 1 in the Video Timeline, release
the mouse, and the asset will be dropped into the Video Timeline. You’ll see
small “picons” (picture icons) appear in the Video Timeline — one picon for each
Chapter Point Marker start point.

Zooming In and Out

With the video asset placed in the Timeline, you may see video extending off the end
of the screen, or else it may be so small you can barely see it. As we’ll detail later in
the chapter, you can use the Zoom controls (Zoom In, Zoom Out, Zoom Framer) to
change the level of “magnification” so you can see what you are doing at a reasonable
view scale.

Note: As a useful trick, you can hold down the CONTROL key on the keyboard and click
with the mouse on the Zoom Out (“minus” sign) button. This will zoom the Timeline
to the highest level that will show the entire length of the video clip, which is often a
good place to start working.

Previewing Video

Once you’ve added the video asset to the DVD Movie, you can view the video (plus
audio and subtitles, once you add them later) in real time, using your Spruce authoring
software’s RealView Previewer and Transport Controls (Stop, Play/Pause and Step-
Frame Advance; or their keyboard equivalents), as we’ll describe later in this chapter.
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Your Spruce authoring software’s RealView previewing feature provides a fully realistic rendition of video,
audio, and subtitles, and can be viewed on full-screen video via external video monitor, as well as in the
onscreen RealView window.

Adding Audio Assets to a DVD Movie
After you’ve placed the video asset into the Video Timeline, most likely you’ll want to
place an audio asset to go with it.
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Adding an audio asset to a DVD Movie is very similar to adding a video asset.

Adding an audio asset to a DVD Movie is much the same as adding a video asset: You
simply drag the desired asset from the Assets Bin to one of the audio tracks in the DVD
Movie’s Audio Timeline.

To add an audio asset to a DVD Movie:

1. Open the DVD Movie and make it the active window, as described previously.

2. Find the desired audio asset within the Assets Bin. If you have yet to import the
desired audio file into the Assets Bin, then:

° right-click in the Assets Bin and select Launch Explorer. Then, using
Windows Explorer, locate the file on your hard drive and drag it directly to
the Assets Bin. You can also click directly on the Windows desktop and
drag the file from the desktop to the Assets Bin;
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– or –

° right-click in the Assets Bin and select import media asset. Using the Import
Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click open and the file will appear in the
Assets Bin.

3. Left-click on the desired audio asset in the Assets Bin and drag it into track 1 of
the Audio Timeline and release the mouse. The asset will be dropped into place.

You’ll see the audio asset appear as a graphic “block” in the Audio Timeline, showing
its relative length and position.

Audio Asset Timestamps & Audio/Video Synchronization

As soon as you place more than one asset into a DVD Movie, you begin to deal with
the sometimes-knotty issue of timestamps, which can have a direct impact on audio/
video synchronization. Let’s explore this further. . .

Usually (but not always), MPEG video is “timestamped.” This is embedded timecode
information, typically captured at the same time as when the source video was origi-
nally encoded. DVDMaestro and DVDConductor are able to recognize timestamping.
In fact, when you placed the original video asset into the Video Timeline, you may
have noticed that the Timecode Timescale (the one directly above the Video Timeline)
switched to correspond to the video asset’s timestamping.

Audio encoded in AC-3 format may or may not be timestamped. In the AC-3 Audio
Encoder tab of the Encoder Settings window (as detailed in the Spruce Technologies
Encoder Guide), this is determined by whether you used a linear timecode (LTC) feed
from the source transport and activated the Use LTC button (the one that resembles a
“watch”) at lower left of the tab. If this button is selected, and a valid LTC signal is
present, the encoder captures the timestamp information. If it is not, then the encoder
inserts values of “00:00:00:00” (“midnight”) for timecode throughout the asset.

Note: AC-3 (Dolby Digital™) is the only audio format in the DVD realm that allows
timestamping. MPEG-1, layer 2, PCM and DTS™ audio formats cannot embed
timecode into their streams. Therefore, the following section on timestamping audio
only refers to Dolby Digital (AC-3) audio streams.
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By selecting the LTC Timecode button, audio assets will be timestamped when encoded.

If the AC-3 stream is encoded simultaneously with video using the Spruce encoder,
then (assuming the LTC button is activated), both audio and video will have the same
timestamp information, and the timestamps can be used to provide guaranteed syn-
chronization between video and audio.

If timestamp information is not present in the AC-3 stream, or the audio timestamp
information is different from that of video, then timestamping cannot be used to
synchronize the audio and video, and other means have to be employed.

What this boils down to in practice is that your video and audio timestamps match up,
or else they don’t. There are no other cases. If the timestamps do match up (and they
will if you use the Spruce encoder as recommended), then the audio will drop into
place alongside video, in perfect sync.

If the timestamps in audio and video do not match, then you may see one or both of
the following error messages (both of which you can ignore):

Chapter 6: Working with DVD Movies 6-19

6

 T u t o r i a l

This message typically occurs when there is no actual timestamp information embed-
ded in the audio file. Spruce authoring software interprets this as a “00:00:00:00”
timestamp and may inform you that the audio timestamping begins before the video
timestamping.

This message also typically appears when there is no actual timestamp. When you
click OK or YES to both these alert messages, the audio will be placed in the Audio
Timeline with its start point aligned with the start point of the video asset.

Even if the AC-3 audio stream is encoded with the Use LTC button selected, your
system will attempt to start audio encoding at the same time as start of video. In this
case, audio synchronization, while not as tight and secure as alignment with a valid
timestamp, will still be good enough in most instances — since under most circum-
stances, the error will be less than a frame. But having no error is better than a small
error, so we recommend encoding with LTC timestamping for AC-3 audio streams
under all conditions.

By selecting IGNORE AC3 EMBEDDED TIMECODE, your Spruce authoring software will ignore any audio
timestamping; this can be useful if the audio and video timestamps differ.
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Another issue occurs when using a timestamped AC-3 audio stream that has no
defined relationship, in terms of time, to your timestamped video. In that instance, the
audio timestamp could start hours after the video timestamp. For this situation, you
can instruct your Spruce authoring software to ignore any AC-3 audio timestamping,
by selecting IGNORE AC3 EMBEDDED TIMECODE in the Movies tab of the Program Preferences
dialog. By selecting this (usually temporarily), you can drop AC-3 audio assets directly
into the Audio Timeline no matter what the relationship of their timestamps may be to
the video assets. The first sample of audio will align perfectly with the first frame of
video, without any alert messages.

Using the RealView Previewer to Preview Video with Audio

Once the audio asset is placed in parallel with the video asset, you can preview the
two together using your Spruce authoring software’s RealView Previewer feature.

The RealView Window is an onscreen video display area that opens automatically
whenever you preview a DVD Movie. (Previewing takes place by pressing the Play/
Pause transport control button; we’ll talk more about the transport controls, as well as
their associated keyboard shortcuts, later in this chapter.) The RealView Window will
play back the active video stream (as well as the active subtitle stream, if any). This
same image can also be viewed on an NTSC or PAL video monitor, assuming you
have one connected to the video display output of your Spruce decoder card. At the
same time, you can hear the active audio stream (via the audio output of your Spruce
decoder card, which is connected to your audio playback system).

Note: Please refer to “Tips for Viewing the RealView Previewer,” near the end of this chapter, for
suggestions on how to optimize your onscreen view of the RealView Window.

In order to hear audio with video, you’ll have to select which audio track will be the active
audio stream — that is, which track will be heard during RealView previewing. (For more
about streams, please see “Assets vs. Tracks vs. Streams” earlier in this chapter.)

To select the active audio stream for RealView previewing:

1. Click on the track number button (“1,” “2,” “3,”, etc.), on the left-hand side of
the desired track. The track number button will turn to a reddish highlight color,
indicating that its audio assets will be heard as the audio stream once you start
the RealView Previewer. (Naturally, you’ll need an audio asset in the track and
your audio playback system properly connected in order to hear anything.)

2. To select a different track, just click on its track number button.
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Selected audio track 2 to be the active audio stream.

Note: If you have selected the Program Preference AUTO-SELECT TRACK FOR RT PREVIEW AFTER

ASSET IS DRAGGED IN, as recommended at the start of this section, then the appropriate
track number button will be selected as soon as you drop an audio asset into the
Audio Timeline.

Note: Audio synchronization to video may be affected by issues related to
timestamping, as described immediately above.

The Display Preferences dialog (left), and the RealView Window (right), as shown floating above a DVD Movie.
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Note: Once you start RealView previewing, the track number button cannot be
selected or changed, even when play is paused. To select the track number, you must
press the Stop button (or press ESCAPE on the keyboard), then select the track number
and start RealView previewing again.

Placing & Previewing Multiple Audio Tracks

If you have audio assets for multiple audio tracks, you can place them in the same
manner as the first track. If the timestamps are congruent with video, they will drop
into place in perfect sync. If the timestamps vary from that of video, some manipula-
tion may be needed, as described later in this chapter.

A typical DVD Movie, showing audio assets in place in four audio tracks. In this instance, audio track 4 has
been selected to be the active audio stream, as indicated by its highlighted track number button.

To perform RealView previewing with multiple audio tracks, first select one of the
tracks to be the active audio stream — by clicking on its associated track number
button, as described just above — and then proceed as normal. (You may use the
Navigation Simulator to switch tracks in mid-play, but the audio is interrupted. The
use of the Navigation Simulator is described in Chapter 9.)
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Assigning Language Codes to Audio Tracks

For multiple language tracks, you can specify the language of each track. When
playing back your final, replicated disc, the DVD player can use this setting to play
back the correct track when the end-user selects a preferred audio language. (This
same process also applies to subtitle tracks, as we’ll cover later.) The DVD player can
also use this information to display the name of the selected language onscreen.

Note: You should always define the language setting when using multi-language audio
and subtitle tracks.

To define the language setting of an audio track:

1. Click once in the track’s language code button (located to the immediate left of
the track number button).

– or –

Right-click anywhere in the track and when the context menu appears, select LANGUAGE.

2. The Select Language Code dialog will appear. Choose any one of the available
languages by language code or language name.

3. Click OK (or just double-click on the language choice).
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– or –

If the track does not contain dialogue of a particular language (for instance, if it’s
instrumental music, etc.) select the LANGUAGE NOT SPECIFIED checkbox and click OK.

The correct language designations will appear in each track’s language code button.

Introducing Chapter Point Markers
With video and audio placed in their respective Timelines, you will likely wish to
place some Chapter Point Markers. These are randomly accessible chapter start
locations in a DVD Movie to which end-users can jump, forward or backward, using
the Skip Forward and Skip Backward buttons on a DVD player remote control. (They
can also be accessed from DVD Menus.) Chapter Point Markers (and other Markers)
are detailed later in this chapter; in the meantime, let’s look at the basics of how
they’re created.

Spruce authoring software provides several ways to do create Chapter Point Markers.
Here is a very simple method, ideal for shorter video clips when there is no predefined
list of Chapter Points to be implemented.
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To create a Chapter Point Marker by moving the PlayCursor:

1. Left-click and hold on the PlayCursor, which initially is found at far left of the
Marker Timescale.

2. Drag the PlayCursor to the right. You’ll see video frames moving in the Thumb-
nail Previewer — these represent the current frame location on the PlayCursor,
with respect to whichever video asset is active in the Video Timeline. (You’ll also
see these video frames in the RealView Previewer, provided you have selected
the DISPLAY THUMBNAIL IN RT PREVIEW WINDOW option in the Display tab of the Pro-
gram Preferences dialog.)

3. Once you have located a point that you would like to use as a Chapter Point
Marker, release the mouse button and press the insert key on the keyboard. A
new Chapter Point Marker will be dropped at the point you selected.

4. To create additional Chapter Point Markers, repeat steps 1 through 3.
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As you drag the PlayCursor to the right, you’ll see the current frame of the active video asset in the Thumbnail
Previewer (and also in the RealView Window, if you’ve selected DISPLAY THUMBNAIL IN RT PREVIEW WINDOW).
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Each time you “drop” a Chapter Point Marker (by releasing the mouse and pressing INSERT on the keyboard), a
Marker icon will appear in the Marker Timescale and a picon will appear in the video track showing the
frame at which the Marker is positioned. As we’ll detail later in this chapter, different types of Markers have
different icons.

Renaming Chapter Point Markers

As you place Chapter Point Markers by this method, you’ll notice they are automati-
cally named by the convention CHAPTER1, CHAPTER2, etc. (As we’ll describe later, you
can change or defeat the auto-naming convention.) Auto-naming can save you a lot of
time. However, if you create Chapter Point Markers out of sequence within the Video
Timeline — for instance, if you create CHAPTER1 near the middle of the current video
asset, and then go back near the beginning to create CHAPTER2 — then the sequence of
Chapter names may not reflect their position in time. This can be confusing, and you
may wish to rename the Chapter Points to reflect their sequence in time or the actual
content.
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Renaming a Chapter Point Marker.

To rename a Chapter Point Marker:

1. Right-click on the Chapter Point Marker you wish to rename.

2. When the pop-up context menu appears, select RENAME CHAPTER.

3. When the Change Marker Name dialog opens, enter the new name and click OK.

4. The name of the Chapter Point Marker, as it appears in the Marker Timeline, will
change to reflect the new name.

There are many other ways to auto-name, reposition, and otherwise modify Markers, as
we’ll describe later in this chapter.

Once you’ve created Chapter Point Markers, you can preview them from within the
Marker Timeline, or by using the Navigation Simulator.
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Previewing Chapter Point Markers from within the Marker Timeline

Previewing Chapter Point Markers from within the Marker Timeline.

To preview Chapter Point Markers from within the Marker Timeline:

1. Right-click on the first Chapter Point Marker you wish to preview.

2. From the pop-up context menu, select SET PLAYCURSOR. The PlayCursor icon will
jump to the position of the first Chapter Point Marker.

3. Press the onscreen Play/Pause transport control button (or your keyboard’s
spacebar) to start playing from the selected Chapter Point.

4. To re-check, press ESCAPE, then the spacebar (or click the Stop button and then the
Play/Pause button).

5. Repeat steps 1 through 4 to check other Chapter Point Markers..

Previewing Chapter Point Markers from the Navigation Simulator

The Navigation Simulator is one of the most important tools available to you in the
Spruce authoring environment. With it, you can check virtually every aspect of a DVD
title prior to committing it to compilation. We recommend you use it frequently as you
develop your title.
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Selecting the Navigation Simulator.

To open the Navigation Simulator:

1. From the Tools menu, select NAVIGATION SIMULATION.

– or –

Press the keyboard command ALT - S.

– or –

Select the Navigation Simulator icon from the main toolbar.

2. The Navigation Simulator window will appear onscreen.
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The Navigation Simulator provides a complete set of controls matching those found on
the typical DVD player remote. When you invoke the Navigation Simulator, it begins
playback of the title from the FirstPlay item (more about this later in Chapter 9). If your
Project has only a single DVD Movie, the Navigation Simulator will begin by playing
that DVD Movie.

In the lower-left corner of the Navigation Simulator, you’ll find the Movie Navigation
controls. Here, you can use the Skip Backward (<<) or Skip Forward (>>) buttons to
commence playback from the previous or next Chapter Point Marker.

To check Chapter Point Markers in the Navigation Simulator:

1. As the desired DVD Movie plays, click with the mouse on the Skip Forward (>>)
or Skip Backward (<<) buttons.

2. Playback will resume from the selected Chapter Point Marker.

Note: You will detect a pause as playback skips to the desired point. This interruption
is not reflected when the title is compiled, but is a direct result of the Navigation
Simulator’s operation using uncompiled elementary asset streams for audio, video, etc.

If you wish, it’s easy to resume playback from the beginning of the DVD Movie.

To restart title play from the beginning:

• click on the button labeled FIRST PLAY immediately above the Exit button.

The Navigation Simulator is a fully “modal” window, meaning that so long as it is
open, other authoring activities can not be performed.
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To close the Navigation Simulator window:

• click on the large button labeled EXIT at the bottom of the Navigation Simulator
window;

– or –

• click on the close (“x”) button in the window’s upper-right corner.

The Navigation Simulator has many other useful functions for authoring and verifica-
tion. These are described fully in Chapter 9.

Introducing Subtitles
Now that you’ve built a DVD Movie, with video, audio, and Chapter Point Markers,
and have previewed it both from within the Marker Timeline and from the Navigation
Simulator, you should become familiar with the operation of DVD subtitles.

Unlike subtitles in conventional video, DVD subtitles are displayed as an overlay on
top of video. This makes it possible for the viewer to switch subtitles on and off or to
select alternative subtitle streams. Subtitles are actually incorporated into DVD Movies
as graphic images and must be defined and prepared accordingly.

Your Spruce authoring software provides multiple ways to add subtitles. They can be
created individually using text-entry tools within the Spruce authoring environment as
text information, using any TrueType font, with complete control of font size, at-
tributes, color, positioning, effects, and so on. Alternately, you can import subtitles as
graphics files with text or graphics pre-rendered. You can also import what are known
as “subtitles files,” where all the subtitles are imported en masse using a text-based
script, similar to an Edit Decision List, that defines the start/stop time of each subtitle
and its content. Script import of subtitles is detailed later in Chapter 12.

For now, let’s look at how to create individual subtitles using Spruce text-entry tools.

Creating an Individual Subtitle

The Subtitle Timeline has up to 32 separate subtitle tracks. This way, for instance,
track 1 could hold English subtitles; track 2 could hold French subtitles; and so forth.
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To enter an individual subtitle, you will begin by opening the Subtitle Editor window.

Right-clicking in any subtitle track will present this pop-up context menu; select ADD INDIVIDUAL SUBTITLE to open
the Subtitle Editor.

To open the Subtitle Editor:

1. Right-click anywhere in subtitle track 1.

2. From the pop-up context menu, select ADD INDIVIDUAL SUBTITLE.

3. The Subtitle Editor will appear onscreen.
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The Subtitle Editor.

As you can see in the screenshot above, the Subtitle Editor shows the current video
frame that corresponds to the position where you clicked the mouse. The right-hand
portion of the window provides various tools for entering subtitles and controlling their
onscreen appearance and position.

You can type the text for an individual subtitle in the Subtitle Editor’s Text field.

To type text for an individual subtitle:

1. With the Subtitle Editor open, click once within the Text field.

2. Type the desired text. Add carriage returns as needed to fit text within the dotted
lines in the screen image.
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As you enter text, you will see that text rendered as an overlay on the screen image in
the left-hand portion of the Subtitle Editor window, using the Font, Size, and Position
settings defined in the other fields of the window.

If you wish, you can experiment with different settings of the Font Name, Font Size, or
other attribute and position controls in the Subtitle Editor.

After you have entered the text you wish to include in the subtitle, and made any
adjustments desired to its appearance or position, you can save the subtitle and then
exit the Subtitle Editor to return to the DVD Movie.
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To save the subtitle and exit the Subtitle Editor:

• Click on the OK button in the lower right of the Subtitle Editor window.

Note: To exit the Subtitle Editor without saving the subtitle, click on the CANCEL

button in the lower right of the Subtitle Editor window.

When you return to the DVD Movie, you will see the subtitle you created displayed as
a “block” shape within subtitle track 1, positioned at the same location at which you
right-clicked the mouse to open the Subtitle Editor. By default, the initial duration
applied to subtitles entered in this way is 5 seconds; that is, during playback, the
subtitle will appear onscreen for five seconds from its starting point.

Previewing Subtitles

Next, in order to preview your subtitles, you must first select which subtitle track will
be the active stream — that is, which subtitle track will be viewed during RealView
previewing. (For more about streams, please see “Assets vs. Tracks vs. Streams,” later
in this chapter.)
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To preview subtitles:

1. Click with the mouse on the left-hand subtitle track number button for the
subtitle track you wish to view.

Note: If you wish, you can move the PlayCursor to a position just before the first
subtitle (this way, you won’t have to wait so long to see the subtitle).

2. Hit the Play/Pause transport control button (or your keyboard’s spacebar).

The selected subtitle track will be displayed superimposed over the video in the
RealView Window (and, if you have one connected, on your external NTSC/PAL video
monitor).

Modifying Subtitle Position & Duration

As we will learn more about in Chapter 12, there are many ways you can affect the
display of subtitles, include control of subtitle color, fade-in/fade-out, character
attributes, and so on. For now, let‘s review how to change the start and end time of an
individual subtitle within the Subtitle Timeline.
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To change the duration of display for an individual subtitle:

1. Move the mouse to the left or right edge of the “block”-shaped subtitle in the
Subtitle Timeline.

2. Click and drag to change the length of the subtitle as desired. You’ll see the size
of the “block” increase or decrease to match.

After changing the duration, you can preview the altered subtitle as described previously.

To change the start/end time of a subtitle without affecting its duration:

1. Click and hold within the “body” of the subtitle in the Subtitle Timeline.

2. Drag it within the Timeline to position it as desired.
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Using these methods, you can add as many subtitles as you wish to a DVD Movie, in
as many tracks as you have available. In addition to viewing the subtitles using the
RealView Previewer, you can view them using the Navigation Simulator. The Naviga-
tion Simulator has some advantage in that you can switch between one subtitle track
and other during play, as we’ll detail in Chapter 9.

Note: When you switch subtitle tracks using the Navigation Simulator, the new subtitle
track will not appear until the next individual subtitle comes up. This mirrors the
behavior of consumer DVD players.

Spruce authoring software offers many other options for working with subtitles, as
we’ll cover in Chapter 12.

What’s Next?
DVD Movies are very flexible entities, and your Spruce authoring system offers many
ways to work with them. In the preceding pages, we’ve covered many of the basic
operations that apply to creating a DVD Movie.
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At this stage, you could carry on to create other DVD Movies, although it would
probably be a good idea for you to review the rest of this chapter. (For more advanced
video and subtitle considerations, you’ll also want to review Chapters 11 and 12.)
Alternately, you could author some other aspect of your Project, such as DVD Menus
(as described in Chapter 7) or establishing the connections (Chapter 9).

However — although it’s by no means necessary at this stage — you may find it useful
to perform an “interim” compilation of your Project and to review the results using the
DVDPlayer utility.

Checking Your Work So Far:

Performing an Interim Compilation & Emulation

If you’ve been following along with our step-by-step description of DVD Movie
authoring so far, you will now have created a short DVD Movie with a video track,
plus perhaps one or more audio tracks and a few subtitles.

If so, at this point you actually have a complete and valid Project that can be compiled
to a DVD directory structure, and viewed and “emulated” as a DVD title using the
DVDPlayer utility included in your Spruce authoring system.

Note: The coming pages are intended to serve as an introduction to compiling a
Project; for a detailed description, please refer to Chapter 10.

In general, compiling and emulation take place when you’ve completely finished all
aspects of your Project (which are probably much more complex and numerous than
the single DVD Movie we’ve just crafted). However, it is sometimes very useful to
compile interim versions of a Project in order to test the behavior of one or more
features. And there is nothing quite like playing back a real DVD title.

Sometimes it’s extremely useful to use this kind of interim compilation. In other cases,
it makes more sense to wait until you have what you believe to be a finished result. So
while these next steps may be jumping ahead in an ordinary work flow, it’s still useful
to review the procedures for compiling and emulating a simple title; chances are you’ll
perform these same procedures at various stages of your Projects.
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To compile a single-DVD movie Project:

1. Create a new DVD Project and build only a single DVD Movie (as we’ve just
described how to do). As you wish, you can include Chapter Point Markers,
multiple audio tracks, and one or more sets of subtitles.

Note: In this simple configuration, there is no need to make any navigational
connections (as detailed in Chapter 9).

2. Save the Project to disk as described in Chapter 2.

3. From the Tools pull-down menu, select COMPILE (ALT-C) or click on the Compile
icon in the main toolbar.

4. The following dialog will appear:

This dialog is used to designate the location at which you will store the compiled
DVD file structure based on your Project. You may enter a Windows path
directly in the field provided, or, as we’ll describe next, you can browse to locate
the directory where the compiled DVD file structure will reside.
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5. Click on the browse (“…”) button directly to the right of the text field in the
Directory Selection dialog. This will open a Browse dialog:

Note: The DVDPlayer utility always selects a DVD file structure (called
“Video_ts”, as we will describe presently) that is located at the top level of a main
storage volume. For this reason, we recommend that you select one of your main
storage volumes as the compilation location.

6. In the Browse for Folder dialog, select a “top-level” directory (disk volume) for
one of your hard drives (e.g., “D:”, “E:”, etc.).

Note: For now, be sure to compile your Project to a top-level directory; don’t
select any other directory (folder) on a drive.

7. Click OK. This will return you to the Directory Selection dialog, which will now
display the selected disk volume as shown below.

8. Click OK in the Directory Selection dialog.
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9. Your Project will begin compiling and the Output Log window will display
various messages such as those shown below.

Some of the messages you see may say COMPILER WARNING. There is no need to worry
about these. When the compilation is complete, you will see a message box such as
the one below.

As shown here, the three Warning messages all refer to the default DVD Menu (MENU1)
and simply indicate that it is not used in this Project and has not been constructed
properly. This will not affect playback of the DVD Movie for the purposes of this
tutorial.
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Note: In order to be valid, a DVD title must include at least one DVD Movie. How-
ever, a DVD title without a DVD Menu or with only an unused DVD Menu, is com-
pletely valid.

So long as the message in the Status section at top reads COMPILE SUCCESSFUL, your
Project has been successfully compiled. If you get a message indicating that compila-
tion was incomplete, you can investigate the problem using the information provided.
(More information about troubleshooting problems in compilation is provided in
Chapter 10.)

Once a Project has been compiled, you can view its file structure on your hard drive
in Windows Explorer. This optional step is detailed in Chapter 10.

Emulating the Title using DVDPlayer Utility

The next step in the authoring process, after compilation, is to “emulate” your title.
This is the process of playing back the Project from your hard drive as if it were an
actual DVD disc — and is vital to ensure that your Project is playing back as you
expect it to, with all of its DVD Movies, DVD Menu, connections, and so forth,
behaving as you intended.

To perform emulation, both DVDMaestro and DVDConductor include a very handy
utility called DVDPlayer. It looks like, and operates much like, a hand-held remote
control for an ordinary DVD player — and with it, you can emulate playback of your
compiled title as if it were a final replicated disc.

As soon as you start DVDPlayer, it will scan all of your DVDStation’s (or own com-
puter system’s) disk volumes until it finds a Video_ts directory at the top level of a
volume. (That’s why we compiled the title to that location.)

Chapter 6: Working with DVD Movies 6-45

6

 T u t o r i a l

The DVDPlayer utility.

To emulate the compiled title using DVDPlayer:

1. Click-hold on the Windows Start menu.

3. From the Start menu, select DVDPLAYER DRIVE C (or DVDPLAYER DRIVE D, etc., depending
on which drive you just compiled the Project to).

3. This will launch DVDPlayer (which resembles a typical remote control). The
compiled Project on the designated hard drive will then begin to play in
DVDPlayer’s Video Window.
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Note: Provided that there are no other such directories on your system (including
DVD-Video discs in the DVD-ROM drive), the player will immediately play back
the title that you compiled in the previous section.

3. DVDPlayer offer all of the functions of a typical DVD player remote control. You
can use it to jump from chapter to chapter or to select different audio and
subtitle streams.

Note: If the DVDPlayer controls do not appear, right-click anywhere in
DVDPlayer’s Video window. When the pop-up context menu appears, select
NAVIGATOR CONTROL.

The DVDPlayer interface is detailed in Chapter 10. For now, feel free to experiment
with its various functions — since there’s nothing you can do with it to harm your
compiled Project!

Now it’s time to review DVD Movie features in greater depth…

 T u t o r i a l  E n d
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DVD Movie Features

As we mentioned at the top of this chapter, DVD Movies incorporate most of the major
features of DVD playback — including video content, one or more audio tracks, and,
optionally, subtitles, random-access chapters, and other features. From an end-user’s
perspective, viewing a DVD title generally consists of watching DVD Movies and navigat-
ing among them using DVD Menus, or navigating within them using the chapters.

As we also described, each DVD Movie window has four main areas:

• the DVD Movie Control Bar, with its various controls and displays;

• three DVD Movie Timescales — the Wall Clock, Marker, and Timecode Timescales;

• the DVD Movie Timelines — the Video, Audio, and Subtitle Timelines; 

• and the DVD Movie Status Bar — indicating the DVD Movie’s current frame rate and
aspect ratio.

We’ve also mentioned that DVD Movies are supported by a Movie Properties dialog that
lets you specify control over available user actions, import of closed-caption (line 21) text
data, and control over AC-3 Karaoke Mix Mode.

Let’s take a closer look at all of four areas, as well as some of the other features of DVD
Movies…

DVD Movie Control Bar
 
The DVD Movie Control Bar is used for adjusting your view of the current DVD Movie,
and for other purposes, such as RealView previewing and showing location times.
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Here is a rundown of its controls and features…

Zoom Controls

The Zoom Controls provide the means to view any section of time at any resolution desired.

Zoom In.

The Zoom In button

The Zoom In button (keyboard “+” key) lets you increase the viewing scale or resolution of
the DVD Movie window. As you zoom in, you will see less of the Timelines and “zero in”
more to a specific portion of the Movie. For instance, by zooming in, you can fill the entire
DVD Movie with just a few seconds of the Movie — or even a frame or fraction of a frame
of the Movie. 

Typically, zooming in is most useful for locating specific transitions or establishing precise
Chapter Point Markers (or other Markers).

The Zoom In function is duplicated in the Movie pull-down menu.

Zoom Out

The Zoom Out button.

The Zoom Out button (keyboard “–” [minus] key) decreases the viewing scale or resolu-
tion of the DVD Movie window. As you zoom out, you will see more of the overall
Timelines. In this way, you can see the entire DVD Movie within the confines of the DVD
Movie window. 
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Typically, zooming out is most useful for seeing the “big picture” of your Project, since
you’ll be able to see all the assets and Chapter Point Markers at a glance.

The Zoom Out function is duplicated in the Movie pull-down menu.

Tip: To zoom the view to show the entire length of video in the current Movie, hold down
the keyboard Ctrl key and click on the Zoom Out button onscreen. (Note that the key-
board “minus” key does not work for this operation.

Zoom Framer

The Zoom Framer button.

The Zoom Framer is used to select, or frame, a portion of the DVD Movie so that the
framed area fills the entire Timeline.

Most people use the Zoom Framer to frame the asset in the Video Timeline. However, you
can also use the Zoom Framer to frame assets in the Audio or Subtitle Timelines.

To use the Zoom Framer:

1. Click on the Zoom Framer button, then position the mouse over the Video, Audio, or
Subtitle Timelines. Notice that the mouse cursor changes from an arrow to a “magni-
fying glass” icon.

2. Click in the Video (or Audio or Subtitle) Timeline at one end of the section you wish
to frame. As you hold down the mouse button, drag the mouse toward the other end
of the Timeline. You’ll notice an outline of the frame onscreen, showing the area
you’re framing.

3. Once you’ve framed the desired portion of the Timeline, release the mouse. The
Timeline will now zoom so that it is “filled” with the portion selected.
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Transport Controls
The transport controls — Stop, Play/Pause, and Step-Frame Advance (from left to right in
the Control Bar) — are used during RealView previewing of the DVD Movie.

The Transport Controls (from left to right: Stop; Play/Pause; Step-Frame Advance).

Play/Pause

When you click the Play/Pause button (or hit the keyboard spacebar) for the first time, the
RealView Window pane will appear automatically (unless it is already open). Then,
assuming you haven’t repositioned the PlayCursor, the DVD Movie will playback from the
first frame of the video asset with whatever active audio and subtitle tracks are selected.

After RealView previewing has commenced, if you click the Play/Pause button (or hit the
spacebar) again, playback will pause. To resume playback from the same frame, just click
the Play/Pause button or spacebar one more time.

The Play/Pause function is duplicated in the pull-down Movie menu.

Stop

If you click the Stop button (or hit the keyboard ESCAPE key) — either during playback or
when playback is paused — then playback will stop. The next time you click the Play/
Pause button, playback will resume from the PlayCursor’s current position. (See
“PlayCursor,” later in this chapter.)

Step-Frame Advance

If you click the Step-Frame Advance button (or S on the keyboard)— during playback,
when playback is paused, or when it is stopped — the video image in the RealView
Window will advance by a single frame at a time. Clicking Play/Pause or spacebar again at
this time will commence playback from the current frame. Clicking the Stop button
(Escape key) will stop the playback, so that if you were to click the Step-Frame Advance
button or keyboard “s” again, the RealView Window would show the frames advancing
starting at the video asset’s first frame.
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Note: You won’t hear any audio playback as you advance frame-by-frame, but you will
see subtitles if you’ve set an active subtitle stream with a subtitle asset as described later in
this chapter.

The Step-Frame Advance function is duplicated in the pull-down Movie menu.

Location Counters
The three location counters in the DVD Movie Control Bar provide indication of current
play location and the start and end time of the elements in any video, audio, or subtitle
track.

Playback Location Counter

The Playback Location counter is found directly underneath the transport controls. 

The Playback Location counter, directly below the transport controls.

This indicator has three functions:
• It shows your current playback location — in hours:minutes:seconds:frames — during

RealView previewing.

• It shows the location in the Marker Timescale of the PlayCursor if you’ve repositioned
the PlayCursor away from the start of the DVD Movie. (See “PlayCursor,” later in this
chapter.)

• It provides a way for you to enter a desired start time for the PlayCursor, from which
RealView previewing will start.

To enter a start time for the PlayCursor:

1. Click once in the Playback Location counter (in the DVD Movie Control Bar). You’ll
see its grey-colored numerals change to bright white, letting you know that you are
free to change the start time.

2. Type in a new start time using your keyboard’s numeric keypad. The numerals fill
right-to-left, meaning the first two numerals you type will be the value for the hours
field; the second two will be the value for the minutes field; and so forth.
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3. When you are finished, press the enter key. If you make a mistake, you can start over
simply by typing the first two numerals again and continuing until the
hours:minutes:seconds:frames fields are appropriately filled.

4. The PlayCursor will move to the new start time in the Marker Timescale.

Note: You don’t actually have to type in all the fields, if say, you only want to move from
“00:00:00:00” to “00:00:02:00”. In this case, just type “2-0-0-ENTER” and the position will
change.

Start Location & End Location Counters

The Start Location counter and the End Location counter are directly to the right of the
Transport Controls and the Playback Location counter. The Start Location counter is on top.

These indicators have two functions:

• They show the start and end times for any selected asset in the Video, Audio, or
Subtitle Timelines. (Simply click on the asset and the start and end times will be
displayed.)

• They provide a way for you to enter a desired start and/or end time for any audio
asset or subtitle asset by typing the time directly in the Start and/or End Location
counters.

Thumbnail Previewer

The Thumbnail Previewer is a small display area found to the right of the Location
counters. Initially, the Thumbnail Previewer is empty.
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To “scrub” video, hold down your keyboard’s CONTROL key and move the mouse (without
clicking) back and forth in the Marker Timescale. You will see frames from the video in the
Preview Thumbnail.

Also, as soon as you move the PlayCursor, Chapter Point Marker, or any other type of
Marker back and forth within the Marker Timescale, the Thumbnail Previewer displays the
current video asset frame, making it easy to locate the exact frame for Chapter Point
Markers and other purposes.

Additionally, you can elect to show the current thumbnail in the RealView Window. This
window updates much more slowly than the thumbnail display, but provides a much
larger and more accurate picture.

To display the current thumbnail in the RealView Window:

1. From the File menu, select the command Preferences (Alt + f + f).

2. In the Preferences dialog, go to the tab labeled “display”.

3. Select the checkbox labeled DISPLAY THUMBNAIL IN THE REALVIEW WINDOW. This is the last
checkbox in this tab.

As you scrub with the mouse or drag the PlayCursor or a Chapter Point Marker, you will
see the RealView Window update to show the current thumbnail, albeit with a substantial
time lag in comparison to the thumbnail itself.
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DVD Movie Timescales

The Wall Clock, Marker, and Timecode Timescales offer three different ways to obtain
timing information about a DVD Movie.

From top to bottom, this screenshot shows the Wall Clock Timescale, the Marker Timescale, and the Timecode
Timescale (underneath them is track 1 of the Video Timeline).

Note: Timescales represent the time for the particular DVD Movie and not the entire Project.

Wall Clock Timescale
The Wall Clock Timescale shows the elapsed running time for the DVD Movie — in either
seconds (“__ sec”) or in minutes (“__ min”). As such, it always starts at “0” seconds and
goes up to the entire length of the DVD Movie.

The Wall Clock Timescale.

Marker Timescale
The Marker Timescale is directly underneath the Wall Clock Timescale. Its function is to
display the position — in timecode format (hours:minutes:seconds:frames) — of the mouse
cursor within the DVD Movie (the Cursor Position display is in a small counter on the far
left of the Marker Timescale).
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The Marker Timescale.

The Marker Timescale is also used for creating and editing Chapter Point Markers and
other Markers (as detailed below), and for positioning the PlayCursor (also detailed below).

Timecode Timescale

During encoding, video and AC-3 audio may be “timestamped” with embedded timecode
information. DVDMaestro and DVDConductor recognize this information and use it to
establish the start time for the Timecode Timescale. 

The Timecode Timescale is situated directly above the Video Timeline.

Note: Spruce authoring software automatically detects the frames-per-second (fps) rates
and timecode formats for both MPEG video files and Dolby AC-3 files. Currently, the only
audio file timecode that exists in the DVD realm are Dolby AC-3 audio files.

Spruce authoring software looks to the first asset — video or audio — that you add to the
Timelines for embedded timecode information and uses its timecode to set start time for
the Timecode Timescale. If the asset is not timestamped, then the Timecode Timescale will
remain set at “midnight” (“00:00:00:00”) and will stay there until you add an asset with a
timecode start time of something other than midnight.

By default, the Timecode Timescale bases its numbers on the video or audio asset timecode.
You can, however, switch your view of the Timecode Timescale to “0-based” time.

To switch the Timecode Timescale from asset timecode to 0-based time:

1. Right-click anywhere in the Timecode Timescale.

2. When the context menu appears, select ASSET TIMECODE or ZERO-BASED TIME.

3. The change will be reflected in the Timecode Timescale.
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Switching the Timecode Timescale.

Finally, if you wish, you can offset the Timecode Timescale so that it has a different start
time. (See “Timescale Offset,” in this chapter.)

DVD Movie Timelines

The Timelines are the heart and soul of DVD Movies. It is in these parallel areas that you’ll
define the video, audio, and subtitle assets to be used in a given DVD Movie, and their
relationship to one another.

Viewing Multiple Tracks within the Timelines
As we’ve discussed, the Timelines are all comprised of tracks. Not all tracks, however,
may be visible when the DVD Movie opens. (For instance, by default, the Video Timeline
opens with just video track 1 visible.) Spruce authoring software offers several ways to
reveal — or hide — any of these additional tracks.

To reveal or hide tracks in any of the Timelines:

1. Click-drag on the splitter bar between any of the Timelines.

2. Drag up or down to hide or reveal additional tracks.

– or –

• use the scroll bar on the right-hand side of each Timeline.
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Click-dragging on the splitter bar — in this case, the one between the Audio and Subtitle Timelines — to reveal
more of the Audio Timeline’s tracks.

Sometimes you may need to adjust your view of the tracks in terms of time in order to see
more or less of the tracks from start to finish.

To view more or less of the tracks in terms of time:

• Use the Zoom tools in the DVD Movie Control Bar.

Also — for the Video and Audio Timelines only — you can use the “arrow” in the upper-
left corner of each Timeline to collapse its view down to a single track or expand it back
out to the previous view.

To collapse the Video or Audio Timeline: 

1. Click on downward-pointing Collapse Timeline arrow in the upper-left corner of the
Timeline.

2. Only track 1 will be visible and the Collapse Timeline arrow will now point to the right.

To expand the Video or Audio Timeline: 

1. Click on the right-pointing Collapse Timeline arrow in the upper-left corner of the
Timeline.

2. The Timeline’s additional tracks will reappear and the Collapse Timeline arrow will
once again point down. (You may need to scroll down or to resize the Timelines by
click-dragging the splitter bar to see tracks that might remain hidden.)
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In the screenshot above, the Audio Timeline view has been “collapsed” showing only audio track 1. (Note the
right-pointing Collapse Timeline arrow in the far-left of the Audio Timeline.)

In this screenshot, the Audio Timeline view is now “expanded” showing additional audio tracks. (Note the
Collapse Timeline arrow is now pointing downward.)

The Video Timeline
Depending upon which version of Spruce authoring software you’re using, the Video
Timeline consists of two to nine multiple video tracks, into which you can place video
assets (and, as we’ll learn in Chapter 11, still pictures) to define the picture content of a
DVD Movie. As we’ll also learn more about in Chapter 11, multiple video tracks allow
you to create titles that feature “alternate camera angles.”

DVDMaestro has nine video tracks for support of up to nine camera angles.
DVDConductor supports two video tracks, but can be upgraded to nine video tracks by
adding the DVDPowerPack option.
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The Video Timeline showing two video tracks, each with its own video asset.

When you add video assets to any of the video tracks, you’ll notice a picon (picture icon)
appear, indicating the first frame of the asset. As you create Markers, you’ll notice addi-
tional picons at each Marker location.

Note: Remember, at any given time, only one video track can be active — that is, can
serve as the active video stream during playback. The active stream is indicated by which-
ever track number button (“1,” “2,” etc.) is red.

Other Video Timeline Features & Considerations

Your Spruce authoring software offers some extremely advanced authoring capabilities
related to the Video Timeline. For instance, it’s possible to concatenate (add additional)
video assets; to trim or extend video assets; to re-order assets; and much more.

For a comprehensive review of all of your Spruce authoring software’s advanced Video
Timeline features, be sure to read Chapter 11.

The Audio Timeline
The Audio Timeline contains multiple audio tracks that are associated with the picture
content of a DVD Movie.
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A typical view of the Audio Timeline showing four audio tracks, each with a respective language code assignment
and a corresponding audio asset.

Generally, each DVD Movie will have at least one associated audio track — though some
Projects, especially multi-language Projects, may require up to eight audio tracks per DVD
Movie.

Note: Remember, at any given time, only one audio track can be active — that is, can
serve as the active audio stream during playback. The active stream is indicated by which-
ever track number button (“1,” “2,” etc.) is red.

Each audio track may be mono, stereo or full Dolby 5.1 surround. Each track also has an
associated language code button (located to the immediate left of the track number
button).

Other Audio Timeline Features & Considerations

So far in this chapter we’ve learned several important methods of working with audio
assets, including:

• how to add audio assets to a DVD Movie’s Audio Timeline;

• certain considerations regarding audio asset timestamps and audio/video sync;

• using the RealView Previewer to preview audio along with video;

• placing and previewing multiple audio tracks, including selecting the active audio
stream;

• assigning language codes to audio tracks

• and how reveal “hidden” audio tracks in the Audio Timeline.

We’ll be detailing other audio-related features elsewhere in this User’s Guide, particularly:
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• in Chapter 7, where we’ll discuss how to add audio to DVD Menus;

• and in Chapter 11, where we’ll learn more about creating synchronized audio tracks
for use with concatenated (multi-asset) video.

For now, however, let’s review two other important features and considerations regarding
the Audio Timeline:

Viewing Audio Asset Properties in the Audio Timeline (or Assets Bin)

As we detailed in Chapter 2, Spruce authoring software supports a wide range of mono,
stereo, and multichannel audio assets. Once you’ve imported an audio asset into the
Assets Bin or have added it to an audio track, you may need to review exactly what kind of
asset it may be.

To view an audio asset’s properties:

1. Right-click on the asset, either in the Assets Bin or directly in an audio track.

2. A pop-up context menu will appear. Select PROPERTIES.

3. An Audio Asset Properties dialog will appear showing all of the available information
related to that asset.

Right-clicking on an audio asset — in either the Assets Bin or an audio track — allows you to open its associated
Properties dialog.

The Properties dialog for an audio asset lists its format, length, etc.
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The Audio Asset Properties dialog for a typical audio asset.

A similar Asset Properties feature is available for video assets and is detailed in Chapter 11.

Repositioning (‘Slipping’) Audio Assets in the Audio Timeline

Once an audio asset is placed in a track, there may be circumstances when you wish to
reposition, or “slip” its start time relative to the video asset so that the audio starts later
than the video.
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To reposition an audio asset:

1. Left-click once on the audio asset in its track to select it. (A red border around the
asset will indicate that it’s selected.)

2. As you hold the mouse down, drag the audio asset to its new desired position. Once
you release the mouse, the asset’s new start time will be displayed in the Start
Location counter in the DVD Movie Control Bar.

– or –

1. Left-click once on the audio asset in its track to select it. (A red border around the
asset will indicate that it’s selected.)

2. With the asset selected, click once in the Start Location counter (in the DVD Movie
Control Bar). You’ll see its gray-colored numerals change to bright white, letting you
know that you are free to change the start time.

3. Type in a new start time using your keyboard’s numeric keypad. The numerals fill
right-to-left, meaning the first two numerals you type will be the value for the hours
field; the second two will be the value for the minutes field; and so forth.

4. When you are finished, press the enter key. If you make a mistake, you can start over
simply by typing the first two numerals again and continuing until the
hours:minutes:seconds:frames fields are appropriately filled.

5. The asset will move to the new start time.
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Note: The length of the audio asset will always be determined by the length of the source
file; there is no way to type in a new End Location time for audio assets.

When you click on the Start Location counter, you’ll see its gray-colored numerals change to bright white, letting
you know you can type in a new start time for the asset.

The Subtitle Timeline
The Subtitle Timeline uses multiple subtitle tracks to provide the end-user with a choice of
different kinds of subtitles during playback. The Subtitle Timeline may also be used to
support interactive button highlight areas in video, as we’ll detail in Chapter 12.

The Subtitle Timeline, showing a variety of subtitles in place in multiple subtitle tracks.

With Spruce authoring software, subtitles may be entered individually as text or as graphic
files or they may be imported en masse in the form of a script file (also called subtitles file)
that specifies timecode in/out and text or image information.

Note: Remember, at any given time, only one subtitle track can be active — that is, can
serve as the active subtitle stream during playback. The active stream is indicated by
whichever track number button (“1,” “2,” etc.) is red.

As with the audio tracks, each subtitle track also has an associated language code button
(located to the immediate left of the track number button).
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Other Subtitle Timeline Features & Considerations

Your Spruce authoring software offers extensive features related to the Subtitle Timeline
and subtitling in general. You’ll find all the details in Chapter 12.

Working with Chapter Point & Other Markers

Earlier in this chapter, we introduced you to Chapter Point Markers and how they can be
used to indicate chapter start points. And in Chapter 5, we discussed the “Punch Point”
Markers — Punch-In and Punch-Out — and how they’re used when you perform segment
re-encoding. In this section, we’ll learn more about how to work with Markers and how
other Markers can be used to indicate the break point on a dual-layer disc; to indicate
button highlight areas within a DVD Movie; or to function as a “general-purpose” position
indicator.

Markers are locations that you can define or “drop” within the Marker Timescale. They
function like “cue points” for the current DVD Movie. When you create a Marker by right-
clicking in the Marker Timescale, the Edit Marker dialog will appear. This is where you
select exactly what type of Marker you want, by clicking the appropriate checkmark.
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The Edit Marker dialog, which appears whenever you right-click on a Marker in the Marker Timescale.

Spruce authoring software offers five kinds of Markers, including:

• Chapter Point Markers;

• Dual-Layer Break Markers;

• Punch Point (Punch-In or Punch-Out) Markers;

• Button Highlight Markers;

• and General Purpose Markers (no checkmark).

Once you left-click at any given point in the Marker Timescale, you can designate that
point using any combination of these Markers or with none of them. In the latter case, the
Marker functions as a General Purpose Marker that simply indicates a time location using
a visible line in the Marker Timescale. This kind of utility Marker can be useful, for ex-
ample, in “spotting” times to be used for subtitling.
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The Marker Timescale, showing (from left to right) a Chapter Point Marker, a Dual-Layer Break Marker, a Punch
Point Marker, a Button Highlight Marker, and a General Purpose Marker.

The different Markers are represented onscreen by distinctive Marker “icons” and colora-
tion of the Marker’s label, as indicated in the screenshot immediately above. (Chapter
Point Marker = blue/green diamond; Dual-Layer Break Marker = circular yellow icon;
Punch Point Marker = pink triangle; Button Highlight Marker = grey square box.) This
makes it straightforward to keep track of the different types in use.

Since most DVDMaestro and DVDConductor users will find that they use the Chapter
Point Markers much more than the others, they’re a good place to start.

Chapter Point Markers
Chapter Point Markers define the starting point for the chapters in each DVD Movie. You
can have up to 99 Chapter Point Markers per DVD Movie.

By defining Chapter Point Markers, you can provide a way for an end-user to “jump
ahead” to new chapters within a DVD Movie using a remote control, as he or she watches
your final, replicated disc. Alternately, if you connect DVD Menu button highlight areas
(using the Connections window) to new Chapter Point Markers within a DVD Movie, end-
users could jump to new chapters by simply selecting the appropriate button highlight area.

Chapter Point Markers are also used to establish the transition point between the first layer
(Layer ‘0’) and the second layer (Layer ‘1’) in a dual-layer disc. (See “Disc Image Properties” in
Chapter 10.)
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Note: By design, Chapter Point Markers establish the time at which a chapter starts. Keep
in mind that each successive Chapter Point Marker also sets the point at which the preced-
ing chapter ends. For instance, once you set the start point for a “Chapter 2” Marker, it will
also function as the end point for Chapter 1 (assuming it’s the preceding Marker).

Before you begin working with Chapter Point Markers, you may wish to establish the
Chapter Point Properties, which actually apply to all Marker types.

To establish Chapter Point Properties: 

1. Right-click anywhere in the Marker Timescale. When the context menu appears,
select PROPERTIES.

2. The Chapter Point Properties dialog will appear.

3. In the Auto-Name section, select OFF if you do not want your Spruce authoring
software to automatically name Chapter Point Markers as you create them. (Remem-
ber, you can always edit an auto-named Chapter Point Marker later to change the
name.) 

– or –

Select TIMECODE BASED to automatically name the Chapter Point Marker with its current
timecode location (relative to the Timecode Timescale).

– or –

Select INDEX BASED to automatically name Chapter Point Markers by an ascending
“index count” (i.e.: “1,” “2,” “3,” etc.)
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4. If you have selected TIMECODE BASED or INDEX BASED, it’s possible to create a prefix or
root name (such as “Chapter,” “Chapter Time,” etc.) that will always precede the
auto-named timecode location or the index count (i.e., “Chapter 1,” “Chapter Time
01:22:17:23”, etc.). To do so, just type whatever prefix you like in the Prefix (Root)
name box. Spruce authoring software offers a default prefix name of “Chapter.”

5. Set your desired preference for the Snap Chapter to GOP section (see “About the
‘Snap Chapter to GOP’ Option,” immediately below).

6. When you have finished setting the properties, click OK, the dialog will close and the
properties will be set.

Note: Please keep in mind that any changes you’ve made to these properties will not be
applied to any Chapter Point Markers that already exist in the Marker Timescale.

About the ‘Snap Chapter to GOP’ Option
Due to the nature of MPEG video encoding, a video file is divided into units called
“groups-of-pictures” (GOPs). Under the constraints of the DVD-Video Specification, a
GOP varies depending upon the encoding parameters that were set for the video file in
question. An “I-frame” or Intra frame serves as the entry point to each GOP. 

As a result, with any MPEG video file, you can’t access just any individual frame. How-
ever, Spruce authoring software will let you “snap” or position any Chapter Point Marker
to the previous, next, or nearest GOP. In the process, the program will ensure that the
Chapter Point Marker is moved exactly to the first frame of the desired GOP.

Within the Chapter Point Marker Properties dialog, you’ll find the Snap Chapter to GOP
option. The setting you choose for this option will determine what happens when you
click SNAPS TO in the Edit Marker dialog. (The Edit Marker dialog is described just below in
“Managing the Chapter Point Markers.”)
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The following chart describes — with the various Snap Chapter to GOP options in the
Chapter Point Properties dialog — the Chapter Point Marker moves to when you click
SNAPS TO in the Edit Marker dialog:

Snap Chapter to GOP Setting Behavior of the SNAPS TO Button 

PREVIOUS GOP
Chapter Point Marker moves from current location to previous GOP

NEXT GOP
Chapter Point Marker moves from current location to next GOP

NEAREST GOP
Chapter Point Marker moves from current location to nearest GOP

The only potentially confusing setting is NEAREST GOP. Here, the “nearest” will be a function
of the number of frames in the present GOP and your location in that GOP. For instance, if
the file in question has 15 frames per GOP and the Chapter Point Marker’s current location
is at “frame 7,” then the nearest GOP will be backward in time. If the Chapter 

Point

Marker’s current location is at “frame 8,” then the nearest GOP will be ahead in time.

Other Marker Types   
As you may recall, Punch Point Markers (Punch-In and Punch-Out) are used for segment
re-encoding. For the details, please refer back to “Segment Re-Encoding” in your accom-
panying Spruce Technologies Encoding Guide.

Note: Remember, segment re-encoding requires either DVDMaestro or, for
DVDConductor users, the DVDEncoderPack option.

Dual Layer Break Markers make it very easy for you to define, as you author your Project,
the break points between the layers of a DVD-9 (dual-layer) disc. Your Spruce authoring
software’s dual-layer option is detailed in Chapter 10.

Button Highlight Markers allow you to define a button highlight area within a DVD Movie
for creating “interactive” subtitles, as described in depth in Chapter 12.

When a Marker is not designated as any particular type — that is, when none of the
Marker Type checkboxes have been selected — it may be used as a General Purpose
Marker. This is useful for identifying particular times in a DVD Movie, for instance, for
spotting subtitles to particular times.

Chapter 6: Working with DVD Movies 6-71

6

These four types of Markers, plus the Chapter Point Markers, can all be created, reposi-
tioned, changed, and deleted using these following techniques…

Managing the Markers
Now let’s review the ways in which you can create and edit Markers — using the Edit
Marker dialog — and also the ways in which you can reposition and delete Markers.

To create a new Marker: 

1. Left-click once at the desired location in the Marker Timescale using the Cursor
Indicator display (at the far-left of the Marker Timescale) as your guide for where to
click. (If you’re not sure of the exact location you want for the Marker yet, or you
think it may change, then just click anywhere you like in the Marker Timescale.)

2. The Edit Marker dialog will appear. You can type the Marker name (anything you
like) or you can go with the “auto-name” provided (as defined in the Chapter Point
Properties dialog). Make sure that each Marker name is unique for the current DVD
Movie, otherwise this could present problems later when you try to establish connec-
tions.

3. Choose what type of Marker you wish to create (as described above).

4. If you like, you can type in a new Start Time for the Marker in
“hours:minute:seconds:frames” format (although you may find it easier to reposition
the Marker by “jogging” it to find the best starting point, as described just below).

5. Should you wish to enter a new Start Time, you’ll also need to set the Time Format.
Select ZERO-BASED if you want to set a Start Time of “0 seconds” (00:00:00:00). Select
ASSET TIMECODE if you want to set a Start Time based upon the Timecode Timescale (as
established by the video asset’s timestamp) — or upon whatever Timescale Offset
you’ve established. (See “Timescale Offset” and “About Video Asset Timestamps” in
this chapter.)

6. If you’d like to position the Marker relative to the previous, next or nearest group of
pictures (GOP), click the appropriate SNAPS TO option — either the DEFAULT (the Default
GOP set in the Chapter Point Properties dialog) or the PREVIOUS, NEAREST, or NEXT GOP.
(These latter three choices are set by clicking, respectively, the left, middle, or right
buttons underneath the DEFAULT button.)

Note: Remember, the behaviour of the SNAPS TO button will be determined by which
Snap Chapters to GOP you set in the Chapter Point Marker Properties dialog. 
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7. The Auto Options section offers two choices. The first, labeled AUTO-UPDATE NAME WITH

T.C., is useful should you choose to auto-name a Marker with its timecode location,
then reposition the Marker after you’ve created it. If the Auto-Update option is
selected, then the name of the repositioned Marker will change to reflect its new
timecode location. If you select the other option, labeled AUTO-SET PLAY CURSOR, then
the PlayCursor will be automatically aligned to the same start time as the Marker.

8. The Cell Playback Options section offers two options, labeled STILL TIME and PAUSE

AFTER EACH VOBU. The Still Time option allows you to define a fixed number of seconds
that playback will hold the last frame before continuing play. The Pause After Each
VOBU option causes play to hold until advanced by the viewer by hitting the Play
button.

9. When you’ve finished editing the Marker information, click OK. The Edit Marker
dialog will close — and you’ll notice the Marker drop into the Marker Timescale as a
icon and a thin line across the Video, Audio, and Subtitle Timelines. (The actual icon
type depends upon what type of Marker you’ve created: Chapter Point Marker =
blue/green diamond; Dual-Layer Break Marker = circular yellow icon; Punch Point
Marker = pink triangle; Button Highlight Marker = grey square box.) You’ll also
notice that a new thumbnail image has appeared in the Video Timeline showing the
Chapter Point Marker’s starting video frame.

To edit an existing Marker: 

1. Double-click on the Marker’s icon in the Marker Timescale.

– or –

Right-click on the Marker’s icon in the Marker Timescale. When the context menu
appears, select edit marker.

2. The Edit Marker dialog will appear (as pictured a bit earlier in this section), where
you can make any desired changes. You can also change the Marker type.

3. When you’ve finished editing the Marker information, click OK. The Edit Marker
dialog will close and your changes will be implemented.

Rather than typing in a new Start Time using the Edit Marker dialog, you may find it easier
to reposition a Marker manually. This is done by “jogging” or “scrubbing” it back and forth
within the Marker Timescale (as you might jog a video tape to locate a desired frame). As
you do so, the Thumbnail Previewer display in the DVD Movie Control Bar will show the
current video asset frame, which makes it simple and quick to find the exact visual point at
which you wish to drop the Marker.
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To reposition an existing Marker by “jogging” it: 

1. In the Marker Timescale, click once and hold on the desired Marker’s icon.

2. As you continue to hold your mouse down, drag the Maker left (earlier) or right
(later) in the Marker Timescale. You’ll see the current frame of the video asset appear
in the Thumbnail Previewer display, changing as you jog the Marker back and forth.
You can also see your current position in the Cursor Location counter at the far-left of
the Marker Timescale.

3. When you find the desired location, simply let go of your mouse. The Marker will be
relocated to its new location, as reflected both by the Edit Marker dialog’s Start Time
and the new thumbnail image in the Video Timeline.

 

Just as with the PlayCursor, when you reposition a Marker
by jogging it, the Thumbnail Previewer will display the current video frame location.

To delete an existing Marker: 

1. Right-click on the Marker’s icon in the Marker Timescale. When the context menu
appears, select delete marker.

2. The Marker will be removed from the DVD Movie.

Note: Keep in mind that if you delete a Marker, it may have an impact on your Project if
you’ve used it in the Connections window or to establish a dual-layer starting point.
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Video Asset Timestamping

As we introduced earlier in this chapter, DVDMaestro and DVDConductor recognize
video asset timestamping — that is, the video file’s embedded timecode information. 

If you wish, you can offset the video asset’s timecode to a value of something other than
that of the embedded timecode. For more information on this, please see “Timescale
Offset” below, and “About Audio Asset Timestamps” earlier in this chapter.

Video Assets & DVD Movie Starting Points

DVD Movies always default their starting point to the beginning of the video asset in the
Video Timeline. Once you drag a video asset into the DVD Movie, you can’t reposition it
relative to the Video Timeline in the same way you can “slip” audio or subtitle assets
relative to their Timelines. 

You can, however, move the PlayCursor or define Chapter Point Markers in locations other
than the start of the video asset, as described below.

Note: The length of the video asset will always be determined by the length of the source
file; there is no way to establish a new End Location time for video assets.

Timescale Offset

As we’ve described, the Timecode Timescale’s starting time is established by the first asset,
video or audio, that you add to the Timelines. Normally, this first asset is video, in which
case the Timecode Timescale will reflect the video asset’s timestamping. 
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Note: The Timecode Timescale can also get its starting time from an audio file — assuming
that (a) the audio file is timestamped with embedded timecode and (b), you have yet to
add a video asset to the Video Timeline. If the audio file isn’t timestamped (and you still
have yet to add a video asset to the Video Timeline), then the Timecode Timescale start
time will automatically be set to “midnight” (“00:00:00:00”).

There may be occasions when you wish to offset the Timecode Timescale from its current
start time. For instance, let’s say your video asset’s timecode starts at midnight— but that
its associated Dolby AC-3 audio asset starts at “01:00:23:17”. In this case, if you were to
add the audio asset after the video asset, the video asset would start at midnight — and the
audio asset would start over an hour later. But what if you wanted them both to start at the
same time?

The solution is to add the video asset first — then establish a timescale offset of
“01:00:23:17” (the steps for which are described immediately below) — and then add the
audio asset. In this way, the video asset will line up perfectly with the audio asset at the
beginning of the Timescale.

Or, as another example, you might want to adjust the Timecode Timescale to reflect a
different production practice. For instance, some production companies like to use the
“hours” field to indicate reels or project versions. In this case, if the video asset’s
timestamp starts at “01:00:22:17” and you want to change the Timecode Timescale to start
at “04:00:22:17”, you would need to create a timecode offset.

To establish a timecode offset:

1. Click in the small timecode display button on the far-left of the Timecode Timescale.

2. The Set Time Offset dialog will appear. Click in the SMPTE Time Offset box and type
in the new desired time using your keyboard’s numeric keys. The fields will automati-
cally fill, left-to-right. (Be sure to type “0__” if any of the field’s values are less than
10.) Click OK.

3. The dialog will close and the start time for the Timecode Timescale will reflect the
change.

4. If at any time you wish to restore the original start time (as based upon the video
asset), just re-open the Set Time Offset dialog and click RESET VIDEO TIME OFFSET.

Note: You cannot offset a concatenated super-video file (concatenated or appended video
files are discussed in Chapter 11). In this case, the offset, if any, will be established for the
first (original) video asset in the chain.
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Setting a timecode offset.

DVD Movie Status Bar

The Status Bar is a small area located in the lower-left corner of each DVD Movie. It
provides valuable information and settings, on a per-DVD Movie basis, for both frame
rates and aspect ratios.

The Status Bar, indicating (in this case) a frame rate of 29.97 frames
per second and a 16:9 Letterbox aspect ratio.
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Video Asset Frame Rates
DVDMaestro and DVDConductor will recognize the SMPTE/EBU timecode frame rate of
any video asset you add to the Video Timeline. Valid frames per second (fps) rates include:

• 25 fps — the PAL and SECAM standard 

• 29.97 fps — the NTSC color video standard 

In addition, if the video asset has a frame rate of 29.97 fps, your Spruce authoring software will
recognize whether it is “drop-frame” (“29.97 DF”) or “non-drop-frame” (simply “29.97”). 

The currently detected frame rate appears in the lower-left corner of the DVD Movie Status Bar.

Note: The actual NTSC frame rate is close to, but not exactly, 29.97 frames per second.
Spruce authoring software uses the precise NTSC frame rate of 30 ÷ 1.001 — which is
equivalent to 29.97002997 frames per second. Knowing this formula may be useful to you
if you wanted, for instance, to calculate the precise duration of a video asset, given a
known number of frames.

Setting the Aspect Ratio
Your Spruce authoring software offers four different video aspect ratio options. Aspect
ratios are set on a per-DVD Movie basis, which means that different DVD Movies can
have different aspect ratios. Thanks to this feature, you can author DVD-Video titles that
offer users the choice of viewing 16:9 material in either “letterbox” or “pan-scan” modes.
(We’ll describe these differences below.)

For each DVD Movie, the current aspect ratio is shown in the Status Bar, just to the right of
the currently displayed video asset frame rate.

The aspect ratio options include:

• 4:3

• 16:9 Letterbox

• 16:9 Pan-Scan

• 16:9 LB/PS (16:9 Letterbox/Pan-Scan)
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Note: DVD-Video publishers tend to offer titles with aspect ratios of either 4:3, 16:9
Letterbox, or both. Two options — 16:9 Pan-Scan and 16:9 LB/PS — are rarely offered.
However, they are part of the DVD-Video Specification, and as such, DVDMaestro and
DVDConductor include them.

As you should be aware, the term “aspect ratio” describes the ratio of the video image
width relative to its height. In North America, most NTSC TV sets have an aspect ratio of
4:3, whereas outside North America, it’s common to find TVs that offer both 4:3 and the
more cinematic 16:9 aspect ratios.

With Spruce authoring software, it’s important that you set the aspect ratio in the Status Bar
to match the actual aspect ratio of the imported video asset.

Note: The Aspect Ratio setting must be set before you use the RealView Previewer; other-
wise, if it is set incorrectly, portions of the video may be cut-off from view.

To set the current DVD Movie’s aspect ratio:

1. Right-click on the aspect ratio display in the Status Bar.

2. When the pop-up context menu appears, select the desired aspect ratio.

3. The context menu will close and the aspect ratio will be set.

Changing the DVD Movie’s aspect ratio from
 4:3 to 16:9 Letterbox.

 Here are more detailed explanations of the four aspect ratio options...

4:3

Choose this option for 4:3 content. In this case, when viewed on a 4:3 TV, the video
content will fill the entire 4:3 picture frame. When viewed on a 16:9 TV, the video image
will be centered with black frames to the left and the right of the image.
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16:9 Letterbox

Many DVD-Video titles offer what’s known as a “16:9 Widescreen” format. Here, when
viewed on a 4:3 TV, the video content will be framed or “letterboxed” with black bands
above and below it. When viewed on a 16:9 TV, the video content will fill the entire 16:9
picture frame.

If you select the 16:9 Letterbox option, then end-users who are using 4:3 TVs will only be
able to view the current DVD Movie in letterbox mode — regardless of whether the video
content is Pan-Scan-encoded (as described next) or whether end-users have set their DVD
players to view 16:9 material in 16:9 Pan-Scan mode.

16:9 Pan-Scan

A rarely used option for working with 16:9 material is to encode it with “pan-scan” vector
information. (This must be done during the video encoding process.) 16:9 Pan-Scan is a
compromise approach to viewing 16:9 material on a 4:3 TV — where some information
normally on the sides of the video frame are cut off so that the video content can fill the
entire 4:3 picture frame without any letterboxes.

With 16:9 Pan-Scan, the video content will behave as normal when viewed on a 16:9 TV
and will fill the entire 16:9 picture frame. When viewed on a 4:3 TV, however, the content
will pan and scan so that the “action” area is what fills the entire 4:3 picture frame —
assuming, of course, that the content has been encoded with the pan-scan vector informa-
tion. This is a feature rarely, if ever, seen on an encoder.

(Typically, the action area is the center of the 16:9 image. However, there are times when
the action area — such as a character speaking — is off to one side of the video frame. In
this case, by panning and scanning during the encoding process, the action area won’t be
cut off from view.)

If you select the 16:9 Pan-Scan option, then end-users who are using 4:3 TVs will only be
able to view the current DVD Movie in full-screen mode — even if end-users have set
their DVD players to view 16:9 material in 16:9 Letterbox mode.

Note: If you choose the 16:9 Pan-Scan option and the content is not pan-scan vector
encoded, then only the upper-left area of the video image will be seen during playback. In
other words, only choose the 16:9 Pan-Scan option if the content is pan-scan vector
encoded.
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16:9 LB/PS (16:9 Letterbox/Pan-Scan) 

If you select this other rarely used option — and the 16:9 content has pan-scan informa-
tion — then end-users who are using 4:3 TVs will be able to choose for themselves
whether 16:9 material is presented in letterbox or full-screen (pan-scan) modes. This selection
is made by each end-user as a preferred viewing mode with his or her DVD player.

Note: If the end-user selects Pan-Scan as the viewing preference for his or her DVD player
and the content is not Pan-Scan vector encoded, then only the upper-left area of the video
image will be seen during playback. In other words, only choose the 16:9 LB/PS option if
the content is pan-scan vector-encoded.

Establishing Navigation Connections
from within a DVD Movie
As we’ll detail in Chapter 9, your Spruce authoring software’s Connections window
provides a “master view” of all your Project’s connections (and certain connections can be
made nowhere else). However, you can also establish connections from directly within the
DVD Movie (as well as a DVD Menu, as we’ll discuss in Chapter 7).

Note: In this section, we’re presenting terms and concepts that haven’t been introduced yet in this
User’s Guide. Therefore, you may wish to read Chapter 9 first, before reviewing this section.
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DVD Movie End Action and Menu Key
From within the DVD Movie, you can assign the Menu Key and End Action.

To assign a Menu Key for the entire DVD Movie:

1. Right-click in the Video Timeline, somewhere within the first Chapter of the DVD
Movie.

2. A pop-up context menu will appear; select SET MENU KEY.

3. Select the desired Target from the hierarchical listing of available destinations.

Note: Remember that the Menu Key assigned in the first chapter holds throughout, unless
you elect to make a different connection in other chapters.

To assign a Menu Key for an individual chapter in the Movie:

1. Right-click in the Video Timeline, somewhere within the chapter whose Menu Key
assignment you would like to change.

2. A pop-up context menu will appear; select SET MENU KEY.

3. Select the desired Target from the hierarchical listing of available destinations.

Assigning a Menu Key within a DVD Movie.
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Likewise, when setting an End Action for the movie in this way, be careful that you make
the assignment in the last chapter. Otherwise, the DVD Movie will be terminated early.

To assign End Action for the entire DVD Movie:

1. Right-click in the Video Timeline, somewhere within the last chapter of the DVD
Movie.

2. A pop-up context menu will appear; select set end action.

3. Select the desired Target from the hierarchy of available destinations.

End Actions for individual chapters can likewise be set by right-clicking in the particular chapter.

Note: When using context menus in the DVD Movie to create connections, it is highly
recommended that you use the Connections window to verify that connections you
intended have been created. In case of an error, this can avoid a lot of confusion later on.

Using Playlists
Each DVD Movie can have associated “Playlists.” These are alternative versions of the
DVD Movie that, for instance, may play Chapters in a different order (or the same order);
may play only one or more Chapter out of many; or may have an entirely different set of
navigational connections than the original DVD Movie. The use of Playlists for alternative
navigation objects is discussed extensively in Chapter 9.

The Playlist Editor button is found in the lower-right section of each DVD Movie window.
Clicking on this button opens the Playlist Editor which will open up “on top” of the DVD
Movie Timelines. (You can drag the splitter bar between the windows or click on the
Audio Timeline’s Collapse Timeline button to reveal the Playlist Editor button, should it be
hidden from view or should you wish to view more of it.)

DVDMaestro has Playlist functionality. In order to use this feature with
DVDConductor, you will need to upgrade to the DVDPowerPack option.
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The Playlist editing area of each DVD Movie is revealed by dragging the vertical separator at right of the Timeline,
or by clicking on the expand/conceal button.

To prepare a DVD Movie for Playlists:

1. Construct a DVD Movie as you would normally; this will serve as the “parent” DVD
Movie to any new variations you create using Playlists.

2. Insert chapters as desired into the DVD Movie. These Chapters will serve as the
building blocks for Playlists.

3. Open the DVD Movie’s Playlist Editor by clicking on the Playlist Editor button (or by
dragging on the separator bar) to open as shown above.

The  Playlist Editor has three main sections. These occupy the areas otherwise occupied by
the Video, Audio, and Subtitle Timelines.

The topmost section in the  Playlist Editor lists all of the Chapters that have been defined in
the parent DVD Movie. The defined Chapters are the building blocks available for con-
structing custom Playlists.

The second section of the  Playlist Editor is used to create and delete Playlists and to select
a Playlist for editing.



DVDMaestro/DVDConductor User’s Guide6-84

Each DVD Movie’s Playlist Editor contains three principle sections for defining and editing Playlists.

The bottommost section of the Playlist Editor is where Playlists are assembled. The Playlists
are defined by dragging chapters in succession from the topmost section.

To start defining a Playlist:

1. From the topmost section of the Playlist Editor, click and hold on the Chapter you
want to have play first in your Playlist. Drag it down into the first line of the list in the
bottommost section of the Playlist Editor.

2. The selected chapter’s name now appears in the first line of the Playlist. A new
empty line appears automatically.

3. Add chapters in the sequence in which you want them to play until the Playlist is
complete.

Chapter 6: Working with DVD Movies 6-85

6

Define the sequence of Chapters in the Playlist by dragging from the chapter list in the
upper portion of the Playlist Editor into the Playlist.

Chapters may be added to the Playlist in any sequence desired to create custom, multi-story programs.
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To define additional Playlists:

1. Click on the Add Playlist button in the center section of the Playlist Editor.

2. Follow the same steps described just above.

As you complete Playlists, they show up in the Project Manager underneath the parent
DVD Movie.

To review and edit different Playlists:

1. Select from the available Playlists in the Playlist Editor’s pull-down menu.

2. The Playlist and all of its connections will appear in the Playlist Editor.

3. Whatever changes you perform in the Playlist Editor will be incorporated into the
current Playlist.
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Multiple Playlists can be defined and edited using the pull-down menu to select the current Playlist for viewing.

To delete a defined Playlist:

1. Select the desired Playlist in the Playlist Editor’s pull-down menu.

2. Click on the Delete Playlist button.

A DVD title can contain a total of 99 Playlists. The default version of each DVD Movie
(with no Playlists) counts as a separate Playlist and decreases the total number of Playlists
available.

Chapters can also be added and deleted from Playlists by right-clicking in the entry field in
the lowermost section of the Playlist Editor. A list of available chapters and commands will
appear in a pop-up context menu.
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You can build Playlists by right-clicking on one of the entry fields in the listing section. A pop-up context menu
provides a list of available chapters.

DVD Movie Properties
In addition to Project properties, in DVDMaestro you can also set DVD Movie properties
on a per-DVD Movie basis.

The DVD Movie Properties dialog and the features it supports are not available in the
standard version of DVDConductor. Disabling end-user action and Closed Captioning
support may be added by upgrading to DVDPowerPack. Karaoke Mix mode support and
Disable Last Chapter Skip control may be added by upgrading to DVDMaestro.

DVD Movie properties pertain to:

• disabling end-user actions;

• enabling Line 21 (Closed Captioning) support;

• support for Karaoke Mix Mode for multichannel audio;

• and Disable Last Chapter Skip control.

Note: These DVD Movie properties are not the same as the global DVD Movie prefer-
ences, as established in the User Preference settings (accessed via the File pull-down
menu). Rather than being global settings which are applied to each DVD Movie, the
properties described here can be set on a per-DVD Movie basis.
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Note: Many of the following DVD Movie properties are duplicated in the Properties dialog
for DVD Menus. Please bear in mind that these settings here apply to DVD Movies,
however, and not to DVD Menus. If you want these properties also to apply to DVD
Menus, you’ll need to set them in the DVD Menus Properties dialog.

To open the DVD Movie Properties dialog:

1. Right-click on the DVD Movie’s name in the Project Manager.

2. When the context menu appears, select PROPERTIES.

3. The Movie Properties dialog will appear.

– or –

1. ALT-double-click on the DVD Movie’s name in the Project Manager.

2. The Movie Properties dialog will appear.



DVDMaestro/DVDConductor User’s Guide6-90

The DVD Movie Properties dialog showing the Disabled User Actions, Karaoke Mix Mode,
and Line 21 Support options.

Disabled User Actions  
By default, end-users will be able to activate any playback-, streaming-, or DVD Menu-
related item in your Project. These are called user actions or user operations (sometimes
abbreviated User Op, or UOP).

There may be situations in which you may wish to limit the end-user’s playback options
on a per-DVD Movie basis. A typical example would be the FBI piracy warning that
appears at the beginning of many commercial releases in the United States. To prevent
end-users from skipping over this warning, you could create a preliminary DVD Movie
that contains this warning, and then — for this DVD Movie only — disable the end-user’s
ability to skip past it.

Disabling user actions can also be useful, for instance, if you want to create one type of
disc for one group of end-users (who would have full control over all actions) and another
disc for another group of end-users (who, for instance, would not be allowed to change
audio streams).
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From within the DVD Movie Properties dialog, you can disable the following user actions
— that is, you can prevent the end-user from performing any one or more of these functions —
by clicking in the associated box.

Note: Remember, a checkmark in a user action’s box indicates that the user action is
disabled rather than enabled. Keep in mind that not all DVD-Video players support all of
the above user-action features.

The Disabled User Action options include:

• Playback Control 

° Title Play (the ability to jump to a different title by entering a title number
using a DVD player remote control)

° PTT Search/PTT Play (the ability to jump to — or play from — a new Chapter
Marker by using a remote control’s numeric keypad)

Note: The term “PTT” in the DVD-Video Specification stands for “Part of
Title,” and corresponds to a section of a video clip that most of us call a
“chapter” or a “scene.”

° Time Search/Time Play (the ability to jump to — or play from — a new time
by using a remote control’s numeric keypad)

° Stop (the ability to stop movie playback before the end of the movie)

° Resume (the ability to resume movie playback)

° Time/PTT Search (the ability to locate specific points in a video stream by
entering an exact time; this is frequently used, for example, in educational
applications, sometimes in association with bar-code reading features of
industrial DVD players)

° Still Off (the ability to prevent holding of a still image from video; this ability
is supported as Slide and Still Show features)

° Pause On/Off (the ability to pause movie playback)

° Forward Scan (the ability to scan forward through the disc)

° Backward Scan (the ability to scan backward through the disc)

° Next Program (the ability to skip forward through chapters)

° Previous Program (the ability to skip backward through chapters)
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• Stream Selection 

° Audio Stream Change (the ability to change to an alternate audio track while
the movie is playing back)

° Subpicture Stream Change (the ability to view an alternate subpicture
stream, which is the DVD-Video Specification’s term for what we call a
“subtitle stream”)

° Angle Change (the ability to view different camera angles of the same
material)

° Video Presentation Mode Change (the ability to switch between 4:3 and 16:9
aspect ratios or to switch between pan-scan and letterbox presentations)

• Button

° Selection/Activation (the ability to select and activate button highlight areas)

• Menu Call 

° Root Menu [DVD Menu] (the ability, using the MENU button on a remote
control, to access a DVD Menu — as predefined in DVDMaestro or
DVDConductor using the Connections window)

° Title Menu (the ability, using the TITLE button on a remote control, to access a
DVD Menu — as predefined in DVDMaestro or DVDConductor using the
Connections window)

° Subpicture Menu (the ability to access the subpicture menu while the movie
is playing

° Audio Menu (the ability to access the audio menu while the movie is
playing)

° Angle Menu (the ability to access the multiple camera angles menu)

° PTT Menu (the ability to access the PTT menu while the movie is playing)

Note: The PTT Menu is what we refer to as the “Chapter Menu” assignment
in the Connections window, as detailed in Chapter 9.
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Line 21 Support  
DVDMaestro offers two-field Line 21 support for closed caption files. Each DVD Movie
can have its own associated closed caption file; just as with the Disabled User Action
options, you can import closed caption files on a per-DVD Movie basis.

This function is not supported in the base-level DVDConductor, but may be added by
installing the DVDPowerPack upgrade.

We also support the Daikin Scenarist™ format for closed caption files. These are standard-
ized text files that include timecode data, caption text, and control characters. The usual
extension for these files is “.scc”.

To import any compatible closed caption file into a DVD Movie:

1. Right-click anywhere in the video track of the DVD Movie window. A context menu
will appear.

2. Left-click on IMPORT LINE 21 FILE. This will bring you to an Import Line 21 dialog, where
you can type the file name directly, or browse for the desired file.

Field Information

As you probably know, video information has two fields per frame. Closed captioning
information can be embedded in either of the two fields or in both. Most DVD players
look at the MPEG stream directly for closed captioning information. Others, however, look
for a “flag” that indicates which field is used for the closed captioning. For this reason, the
ability to indicate which field is used for closed captioning is among the DVD Movie
properties.

By nature, the Scenarist™ format only supports FIELD 1 closed captioning information.
However, you may be working with digital video files which already have closed
captioning information embedded in field 1 and/or field 2 of the video stream. Conse-
quently, we give you the option of selecting the appropriate field.

Click in the associated box to select whether your Line 21 information is FIELD 1 RECORDED,
FIELD 2 RECORDED, or both.

Note: A checkmark in a field box indicates that the choice is selected.
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Compatibility (Disable Last Chapter Skip) 

This feature is only supported in DVDMaestro. DVDConductor users may add this
feature by installing the DVDMaestro upgrade.

Not all DVD players operate the same way when the end-user presses the Next Chapter
button on his or her remote control. If the DVD player is playing back the last chapter of a
DVD Movie, most — but not all — will ignore this user action to skip to the next chapter.
Some DVD players bring the user to the next movie on the disk, which is usually not a
desired effect.

When you select DISABLE LAST CHAPTER SKIP, this forces the Next Chapter user operation to be
disabled during the last chapter of a DVD Movie. This will ensure that all players — even
those that don’t implement this operation as a default — will behave consistently in play.
Keep in mind, though, that if you check this box, this prevents the user from returning to
the beginning of a movie if they are in Chapter 1 and press the “Previous Chapter” button.
The ”Previous Chapter” button will not work until the title is in at least Chapter 2, where it
will return the user to the previous chapter.

Karaoke Mix Mode Support 

This feature is only supported in DVDMaestro. DVDConductor users may add this
feature by installing the DVDMaestro upgrade.

The DVD-Video Specification provides for use of multichannel audio streams, intended
primarily to provide special functions for use in Karaoke (sing-along) entertainment.
Assuming the viewer has a DVD player equipped to support these features, he or she can
select alternate vocal versions, a guide melody, and so forth. Spruce authoring software
provides complete support of these features.

Note: Audio to be used in Karaoke Mix Mode must be encoded with the Bitstream Mode
set for Karaoke (see Chapter 5) when it is encoded. The DVD-Video Specification provides
for Karaoke Mix Mode for all audio formats (AC-3, MPEG, PCM), in both stereo and
multichannel configurations. Spruce authoring software supports Karaoke Mix Mode with
AC-3 audio only.
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Note: If you wish to enable Karaoke Mix Mode, then — prior to opening the Karaoke Mix
Mode Properties dialogue — there must be a Karaoke Mix Mode-encoded AC3 Audio file
located in the Audio Timeline of the current DVD Movie.

To access the Karaoke Mix Properties dialog, open the Movie Properties dialog, select the checkbox labeled KARAOKE

MIX MODE, then click on the button labeled KARAOKE MIX (the button is not available unless the option is selected).

To access the Karaoke Mix Mode Properties dialog:

1. First, open the Movie Properties dialog. To do this, right-click on the icon of the
desired DVD Movie in the Project Manager and select PROPERTIES (or just (or ALT-
double-click on the desired DVD Movie).

2. In the lower right-hand corner of the Movie Properties dialog, you’ll see a checkbox labeled
karaoke mix mode. Select (check) the box, which will activate the button labeled KARAOKE MIX.
Click on this button, and the Karaoke Mix Properties dialog will open.

The Karaoke Mix mode properties are assigned by defining what
is located in each channel of the AC-3 multichannel stream.
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As you’ll see, the available role assignments vary depending upon the audio channel (ACH)
— which is directly dependent upon the Audio Coding Mode that you selected during
encoding. The roles include GUIDE VOCAL 1 or 2, GUIDE MELODY, GUIDE MELODY 1 or 2, GUIDE

MELODY A or B, and SOUND EFFECT A or B.

To use Karaoke Mix Mode:

1. With the Karaoke Mix Mode Properties dialog open, select the desired audio track.

2. Select the Channel Assignment Mode.

3. Finally, assign which aspect of the audio track is located in that channel — such as
Guide Vocal 1, or Guide Melody. All of these assignments take place within the
Karaoke Mix Properties dialog.

After Selecting Your DVD Movie Properties
When you have completed your selections in the DVD Movie Properties dialog, click OK.
This will close the dialog and return you to the current Project.

Tips for Viewing the RealView Previewer

As we’ve learned earlier in this chapter, the RealView Previewer is an excellent tool for
previewing your work as you build DVD Movies. In this section, we’ll give you some tips
to optimize your view of the RealView Previewer.

As we first described earlier in this chapter, whenever you click the Play/Pause or Step-
Frame Advance buttons (or perform the associated keyboard commands), the current DVD
Movie will play back via the RealView Window. At the same time, whatever audio tracks
and subtitle tracks have been activated will also be heard or seen. (This requires that an
audio playback system is properly connected to the audio output of your Spruce decoder
card.)

Note: If you didn’t already have the RealView Window open, it will appear automatically.
If you’d rather not see the RealView Window — say, if you prefer to preview the DVD
Movie while watching only your external NTSC or PAL monitor — you can simply move
the RealView Window “out of the way” onscreen by docking it and resizing it to a tiny
size.
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Playback will begin from the first frame of the video asset with whatever active audio and
subtitle tracks you’ve selected.

The RealView Previewer.

Note: If you have not yet previewed the video file, then selecting STEP-FRAME ADVANCE for the
first time will “prime” the video, and display whatever frame the Play Cursor is at in the
RealView Window.

Docking the RealView Window
Since the RealView Window is a pane (just like the Project Manager, for instance), you can
dock it next to any of the other panes. In fact, in your Spruce authoring software’s default
viewing configuration, the RealView Window is docked between the Output Log and the
Assets Bin. However, many users — especially those who are not watching their pre-
viewed DVD Movie only through an external video display — will prefer to float the
RealView Window on top of the application (or within the Workspace) whenever they
preview a DVD Movie, in order to see a full-screen or larger onscreen image.
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Note: The DVD Movie’s Aspect Ratio option (on the DVD Movie Status Bar) must be set
properly before you use the RealView Previewer; otherwise, areas of the video image may
be cut off.

For general information about docking, undocking, and floating the RealView Window,
please refer back to Chapter 3. However, you should also be aware of the following
specific characteristics of this pane. . .

• If the RealView Window is docked, you can float it on top of DVDMaestro or
DVDConductor by right-clicking anywhere in the pane and selecting PREVIEW FULL

SCREEN MODE.

• Should the RealView Window be hidden when you select PLAY/PAUSE in the DVD
Movie controls, the RealView Window will automatically appear before preview
playback commences.

• If you wish, you can resize the RealView Window when it is either docked or float-
ing; however, if you do, the resulting image area probably won’t match the video
file’s aspect ratio, and the video image may appear to be distorted.

• If you change the aspect ratio of the DVD Movie you wish to preview, you’ll want to
reset the RealView Window’s aspect ratio, as described next.

• You can reset the RealView Window to its proper aspect ratio in the following ways:

° If the RealView Window is floating either on top of the application or in the
Workspace, right-click anywhere inside the pane and select normalize to aspect
ratio. (This is not to be confused with the normalize button in the DVD Menu
controls, which adjusts the size of a DVD Menu image.)

– or –

° If the RealView Window is docked, right-click in the RealView Window to select
preview full screen mode, which will float the pane with the proper aspect ratio.
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Summary of Working with DVD Movies

In this chapter we learned how to create DVD Movies using video and audio assets. We
also learned how to create individual subtitles using the Subtitle Editor. As we described,
most of the major features of typical DVD-Video titles, including multiple soundtracks,
user-selectable subtitling, and random-access Chapter Points, are configured using DVD
Movies.

More information about DVD Movies is included in Chapters 11 and 13, which respec-
tively detail some of the special features particular to the Video Timeline and subtitles.

•          •          •
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Chapter 7
Working with DVD Menus

With DVDMaestro and DVDConductor you can create full-featured, visually (and audibly)
engaging DVD Menus that end-users, can view and interact with, using any DVD player.

We use the term “DVD Menus” to refer to menu screens that you incorporate into your
DVD titles using your Spruce authoring software. DVD Menus are the onscreen menus that
end-users see as they play back your final, replicated disc. (We call them DVD Menus to
differentiate from DVDMaestro’s and DVDConductor’s pull-down menus, such as the
View menu or the Tools menu.)

As with DVD Movies, it’s possible to create a DVD-Video title using a single DVD Menu.
In practice, however, it’s common to use multiple DVD Menus in each title — all of which
are easy to craft once you understand their basic operation.

Let’s begin with an overview of a DVD Menu window.

DVD Menu Overview

Each DVD Menu window has three main areas:

• The display area: 

° As we’ll learn more about, this area is used for adding assets to the DVD
Menu and also for viewing various elements (such as background images or
button highlights) as you construct the DVD Menu.

• The DVD Menu view options: 

° These options allow you to define how each DVD Menu appears onscreen as you
construct it and are adjustable on a per-DVD Menu basis. These options in the area
include: Button Preview (None, Selection Color, Action Color); View Layer (Back-
ground, Subpicture, Both); Button Outline; Full Resolution; Safe Area; SubPic
Mapped; Aspect Ratio; Normalize Window; and Video Monitor.



DVDMaestro/DVDConductor User’s Guide7-4

• The DVD Menu controls: 

° These controls allow you to define the behavior of each DVD Menu in terms
of colors, how onscreen button highlights appear to the end user, and more.
The controls are split among four selectable tabs: The Color Mapping tab;
the Buttons tab; the Playback Control tab; and the Advanced tab.

A typical DVD Menu, showing the DVD Menu view options with the Color Mapping tab selected. In the display
area, you can see both the background image and the subpicture, with three button highlights. (You can see the
background image and subpicture on their own a little later in this chapter.)
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DVD Menus are also typically comprised of three components:

• A background image (still or video): 

° This forms the overall “backdrop” visual for each menu. Most often it is a
still graphic, but Spruce authoring software also allows you to use a video
file as the background image, to create a dynamic DVD Menu (also called a
“motion menu.”) Whether still or video, these images are full-resolution
pictures, typically created using desktop graphics programs such as Adobe
Photoshop, After-Effects, etc., then imported into the Spruce authoring
environment as a graphic file (in various still image formats) or as a video
file (in MPEG-2 format).

• A subpicture image (still only): 

° This is a second image that sits as an “overlay” on top of the background
image and serves as a “mask” for creating buttons that change colors when
selected and activated. Most often, the subpicture is not visible onscreen
unless the end-user selects a button. When this happens, the shapes in the
subpicture layer mask the button highlights so that the onscreen button
image is highlighted in an appropriate and attractive way. As we’ll learn,
this masking process can take place with different degrees of opacity and
with different color mapping options.

Note: Later in this chapter, and in Chapter 8, we’ll detail how you import
subpictures into your Spruce authoring software as simplified graphics with
a fixed palette of 4 colors (red, blue, black, and white); these colors are then
“mapped” using controls that determine the actual color and opacity that
will be displayed in the final DVD title.

• One or more button highlights: 

° These are rectangular areas that you create onscreen when building a DVD
Menu, which correspond to different actions the end-user can perform. For
instance, if you were creating a “Choose Language” DVD Menu, you might
have one button highlight that, if chosen, would select the English language
audio track and another button highlight that would select the Swahili.
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Typically, you’ll draw button highlights that enclose graphic or “visible” button
images and their subpicture overlays; then you’ll establish connections
between each button highlight and some action, such as selecting an audio
track of a particular language. (One way to think of button highlights is as “hot
spots” that you draw on top of otherwise “dumb” visible buttons in the
subpicture or background; once a visible button has a button highlight, the
end-user can then access it using his or her DVD player remote control.)

You can also link each button highlight to other onscreen button highlights
by numeric assignments that match the “up-down-left-right” controls found
on DVD player remotes. In addition, each button highlight has a number
that can be directly accessed with most DVD player remote controls.

Note: Normally, when unselected, button highlights are invisible. When the
end-user selects a button using his or her DVD player remote control, the
button highlight will assume whatever colors and opacity settings you’ve
defined for its “Button Selection” state. When the end user then actuates the
button by pressing ENTER on the remote, the button highlight will shift to
whatever “Button Action” colors and opacity settings you’ve set. We’ll learn
much more about this later in this chapter and also in Chapter 8.

Finally, a DVD Menu can be:

• static — where all images are still images and there is no audio playing; 

– or –

• dynamic (also called a “motion menu”) — where, as we mentioned above, the
background image is a video file “in motion” rather than a still image. A dynamic
DVD Menu can also include audio, whether the background image is a still graphic
or motion video. Using music to accompany a still background image provides an
easy and inexpensive way to increase the entertainment value of your onscreen DVD
Menus.

Note: Unless otherwise specified, whenever we refer to backgrounds and DVD
Menus, we’re referring to static DVD Menus as opposed to dynamic DVD Menus.

We’ll detail all the DVD Menu view options and controls later in this chapter. But let’s
start by building a simple DVD Menu from scratch…
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DVD Menu Tutorial:
Building a DVD Menu

Note: In this tutorial, we’ll be introducing features and concepts that will be described
in greater detail later in this chapter and in Chapter 8. Where appropriate, you may
wish to glance ahead for more information.

Just as we did in Chapter 6 with DVD Movies, in the coming pages, we’re going to go
through the basics of building a DVD Menu, complete with background, subpicture,
and button highlights. If you’re new to Spruce authoring software, we recommend that
you try building a DVD Menu by following along, step-by-step.

First, you’ll want to open and save a new Project (see Chapter 2).

Note: Don’t forget to save your Project frequently as you proceed.

By default, whenever you open a new Project, you’ll find a new DVD Menu — entitled
MENU1 — in the Project Manager, inside the Menus folder. Although it’s not necessary, you
can rename the DVD Menu to something more descriptive than just MENU1 (this is handled
much like renaming a DVD Movie, and is detailed in Chapter 4).

 T u t o r i a l
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Opening the DVD Menu

Next, it’s time to open the DVD Menu.

Opening the DVD Menu. Note the empty display area that appears when you open a new DVD Menu.

To open a new DVD Menu: 

• In the Project Manager, double-click on the name (or icon) of the DVD Menu.

– or –

• In the Project Manager, right-click on the name (or icon) of the desired DVD
Menu, then select EDIT MENU.

The new DVD Menu window will appear in the Workspace with an empty display area.
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Adjusting How You View DVD Menus 

If portions of the DVD Menu window are hidden (such as the display area or the
controls), click on the upper-right “expand view” box. This will expand the window
to fill up the Workspace.

Click on this button to expand the view of the DVD Menu window so that it fills the entire Workspace.

As with DVD Movies, you can have multiple DVD Menus open in the Workspace.
However, at any given time, only one can be the topmost active Window.

Note: In order to edit a DVD Menu, it must be both open and active in the Work-
space. Only one window can be active a time; that is, if there are multiple windows
open in the Workspace, the window that appears at the “front” of the window is the
active window.

Because different users prefer to work in different ways, Spruce authoring software
provides preferences and commands for handling windows in the Workspace.

Most users prefer to select the Display preferences shown above and to work in Workbook Mode.
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Many Spruce users prefer to work with the settings shown above. For convenience, we
will adopt these settings as a convention and describe procedures in terms applicable
to them.

To review these settings, first select PREFERENCES from the File pull-down menu. Then
select the Display tab and set the first, third, sixth, and seventh checkboxes. (The
second, fourth, and fifth checkboxes are deselected.) In the View menu, we set the
selection Workbook Mode to ON.

Note: These options, including Workbook Mode, are detailed in Chapter 3 as well as
this chapter.

Preparing DVD Menu Assets
Before you can build a valid DVD Menu, you (or your client or service bureau) will
need to prepare the graphic and/or video assets that will serve as the DVD Menu’s
background and subpicture. These files should already be loaded onto your authoring
system’s hard drive(s) so that they can be easily imported into your current Project.

A typical background image (left) and subpicture image.

The figure above shows a simple background/subpicture pair to be used for a DVD
Menu. These can be prepared as a pair of bitmap (.BMP) or TIFF (.TIF) images or as a
two-layer Photoshop (.psd) file — with the background image on the first layer and the
subpicture on the second layer.
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The DVD-Video Specification defines the resolution for both the background and
subpicture images as follows:

• NTSC: 720 x 480 pixels

• PAL: 720 x 576 pixels

Be sure that any image files you wish to include in a DVD Menu correspond to these
resolutions.

In the example shown above, the background image is a full 24-bit color image that
was prepared in Adobe Photoshop. The subpicture is simple graphic with black and
blue visible buttons with lettering on top of a white background area.

Note: While subpictures can have their own background areas (such as the white
background in our example), these are not to be confused with “background image”
files that you’ll be importing into your DVD Menus.

As is typical, the subpicture graphic we created in this example works in concert with
the background graphic. Since the visible buttons in the subpicture match perfectly
with the corresponding visible buttons in the background image, the subpicture will be
able to “mask” the background when the end-user selects or activates button high-
lights. (We’ll learn more about this in the coming pages.)

Importing Background & Subpicture Images into the DVD Menu
Once we have these graphic files available, we need to import them into the Project
and then into the DVD Menu.
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Importing an asset into the Project, via the Assets Bin, as detailed in Chapter 4.

First, you’ll need to import the desired background and subpicture assets via the Assets Bin, as
we introduced in Chapter 4. Then, they can be added to DVD Menu directly — by simply
dragging the asset from the Assets Bin and dropping it into the DVD Menu’s display area.

Dragging and dropping an asset, directly from the Assets Bin into the DVD Menu’s display area.
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As we’ll learn much more about this later in this chapter, if the background and
subpicture are created as separate files, you’ll drag the background image into the
DVD Menu first, followed by the subpicture image. (Spruce authoring software will
automatically assign the first image you add to serve as the background and the
second image to serve as the subpicture.) If the graphics are prepared as a single two-
layer Photoshop (.psd) file, you can drag just that file from the Assets Bin into the DVD
Menu’s display area. (The first layer will automatically be assigned to serve as the
background and the second layer will be assigned to be the subpicture.)

Assigning Default Subpicture Colors

The DVD-Video Specification restricts subpictures to a maximum of four different
colors. Later in this chapter, and in Chapter 8, we’ll be detailing how your Spruce
authoring software “color maps” subpictures so that they correspond to the DVD-
Video Spec.

This process is defined using the controls in the DVD Menu’s Color Mapping tab.
Here, you’ll find three main categories (Subpicture, Buttons Selection, and Button
Action). In turn, each category has four Color Map “swatches” and opacity faders.

Note: We’ll be explaining the details later, but for now, all you need to know is that
when you bring a subpicture graphic into a DVD Menu, the original colors of the
source graphic file (in the example we gave above, these would be blue, black and
white) will be mapped to the “Subpicture” colors and opacity levels that you set using
the DVD Menu controls. These are the colors and opacities that the subpicture will
assume when none of its button highlights are selected or actuated.

Here, the Subpicture opacity faders are all set to “0” — this will make the subpicture completely transparent.
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For now, you can just set all the Subpicture faders to ‘0’. This will make the subpicture
completely transparent (until a button highlight is selected or actuated), and is a
common real-life setting for many DVD Menus.

Introducing Button Highlights
Having placed the background and subpicture images, you’re ready to define button
highlights for each of the visible buttons.

Defining a button highlight (left) with the results. Notice how the button highlight is automatically numbered
in its upper-left corner. This number will be used when establishing navigation between button highlights.

To define the button highlights, just click and drag with the mouse to surround the
each visible button.

Note: You don’t have to be very precise in this placement, so long as you surround
each desired area with a button highlight and do not overlap with the button highlights
you intend to define for the other visible buttons.

Onscreen colors for both the subpicture and button highlights are determined by each DVD Menu’s Color
Mapping controls.
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When you release the mouse button, the button highlight you’ve just created will
remain onscreen. You’ll also notice that it has been automatically given a number
(starting at “1”). As we’ll detail later, you can also name each button highlight, which
may be an easier way to keep track of them.

Also, once you release the mouse button after creating a button highlight, you may
notice that the visible buttons and button highlights change colors; this is the process
of color mapping.

Here, different Button Selection colors have been defined, directly affect the appearance of button highlights.

Experimenting with Color Mapping

Note: In this section, we’re presenting certain terms and concepts that haven’t been
defined yet. If you find yourself confused, don’t worry about color mapping for now;
just skip ahead to the next section (“Assigning Navigation”). We’ll define color map-
ping in much greater detail later in this chapter and in Chapter 8.

Color mapping, as defined by the DVD-Video Spec, is a potentially confusing topic.
Fortunately, it is one of those topics that become easier to understand once you “get
your hands dirty” by trying it in action. So for now, let’s try an initial pass at modifying
colors of both the visible buttons and the button highlights.

First, go to the Button Selection controls in the Color Mapping tab. These controls deter-
mine the appearance of the button highlights once they are selected by end-users (though
not actuated). Try changing these controls in various ways, including selecting different
colors and setting the opacity faders at various levels. (As we’ll detail later, you can change
the colors by double clicking on each “color swatch” to the immediate left of each fader.)
You’ll notice that the bottom fader changes the appearance of the source subpicture’s
white areas. (This fader is in the “Color Map 4” row of faders, and as such affects — in
accordance with the small color swatch next to the COLOR MAP 4 indication — any white
source colors.) Similarly, the second-from-the-top fader (in the “Color Map 2” row of
faders) varies the appearance of those areas in the source subpicture that are in 

black.
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Although it’s hard to tell in a black-and-white manual, the screenshots above show
Button Selection settings that:

• render the white areas of the source subpicture transparent;

• assign a translucent blue to highlight the main body of the button;

• allow the contours of the background image to show through

• and assign a white color to the body of the lettering, colored blue in the original
source subpicture, that is just a little less than opaque — yielding a slight gray
where it sits over the black lettering in the background image.

Setting the Button Action controls to create different appearances for button highlights that have been actuated.

Next, you can set the Button Action controls; these regulate the appearance of button
highlights when they are actuated by the viewer. To do this, go to the Button Preview
section in the left-hand DVD Menu view options and select the radio button labeled
ACTION COLOR. Then use the Button Action controls in the Color Mapping tab to choose
the color and opacity settings desired. When you are done, return Button Preview to
SELECTION COLOR.
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A typical DVD Menu in progress, showing the background, the subpicture, and three button highlight areas.
The Safe Area option has also been selected, as indicated by the dotted line around the perimeter of the
display area (more on this later in the chapter).

Once you’ve set the color maps as desired, it’s time to create the rest of the button
highlights for your menu. In the example shown, the easiest way to do this is to hold
down the ‘Control’ (CTRL) key on the keyboard and use the mouse to drag a copy of the
first button wherever it is needed. (Copying and otherwise managing button highlights
is detailed later in this chapter.) Otherwise, you can just click and drag to draw button
highlights as you did for the first button highlight.

Assigning Navigation (Button-to-Button Selection Order)
Consumer DVD players all come with remote controls that have up-down-left-right
“arrow” keys; these (as well as numeric keys) are used to select the buttons in a DVD
Menu. Remote controls also have an Enter key, which is used to actuate a selected
button.
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Note: Selecting a button is when the end-user moves between buttons using the arrow
keys. Actuating a button is when the end-user selects the button and then actively
chooses to initiate that button’s action by pressing ENTER. (As we’ll learn, Spruce
authoring software also features an “Auto Action Mode,” where the button is actuated
as soon as it is selected. More on this topic later in the chapter.)

DVD player remote controls feature Up-Down-Left-Right arrow keys. (This example is actually taken from the
Spruce DVDPlayer utility, a software utility that operates exactly like a typical DVD player remote control.)

To support this distinctive style of interaction, you need to define how these arrow
keys navigate between each button on the screen. To do this, we use the Navigation
display found in the Buttons tab of the DVD Menu controls.

In the Buttons tab of the DVD Menu controls, you’ll find the Navigation display. This is where you define
how a remote control’s arrow keys operate in relation to your onscreen button highlights.

The Navigation display shows a field for each of the four arrow buttons on the remote,
all surrounding the number of the currently selected button highlight. (As we’ll de-
scribe later, you can select a button by clicking once in the middle of the button
highlight.) To assign button-to-button selection order, just enter the numbers of the
buttons in each field, as shown in the examples immediately below:
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Setting the Navigation display to correspond with the remote control arrow keys. This example shows how
the Up-Down-Left-Right arrow keys could work with a DVD Menu that has three button highlights. In the left-
hand example, if button highlight 1 is currently selected, then pressing the Up or Left arrow keys will select
button highlight 2 and pressing the Down or Right keys will select button highlight 3. Similar navigational
relationships can be seen in the middle example, with button highlight 2 selected, and in the right-hand
example, with button highlight 3 selected.

It turns out that there are surprisingly many ways to navigate between even a few
buttons onscreen. As you can see in the example immediately above, it’s possible to
reach every button on the screen while pressing any one of the four remote navigation
buttons repeatedly.

Testing the DVD Menu with the Menu Navigator
Once you have completed building your DVD Menu as described, you can use the
Menu Navigator to test the DVD Menu’s behavior and its appearance on a video
display.

Note: The Menu Navigator is not to be confused with the Navigation Simulator, which
is detailed in Chapter 9. The former is for testing navigation within a DVD Menu; the
latter is for testing all of the Project’s current connections.
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To open the Menu Navigator, select VIDEO MONITOR in the DVD Menu view controls.

To open the Menu Navigator window, simply click on VIDEO MONITOR in the DVD Menu
view controls. After a moment (to compile the DVD Menu), the Menu Navigator
window will appear onscreen showing the image of the DVD Menu, complete with
button highlights. This same image will also appear (without the Menu Navigator
controls) on your NTSC/PAL video monitor (assuming it’s connected properly to the
video output of your Spruce Technologies decoder card). This way you can see the
DVD Menu exactly as it will appear when the end-user views your finished title.

With the Menu Navigator open, you can use its arrow key controls to “walk through”
the DVD Menu. In this way, you can test the selection order, button highlight colors,
and the overall effect of the current DVD Menu.
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Establishing Button Highlight Connections
Of course, button highlights are only useful once they affect playback of your final
title. This is accomplished by establishing navigation connections — “targets” for
when each button highlight is actuated — so that actuating a particular button high-
light leads of a DVD Menu the end-user somewhere (such as to a new DVD Movie, to
a new language, to a new cut of the film, or whatever).

You can establish these connections either directly within the DVD Menu or by using
the Connections window (as explained in Chapter 9). For now, let’s learn how they’re
established from within the DVD Menu.

Establishing a button highlight connection targets by right-clicking within the button highlight area.

To designate a target for a particular button highlight, just right-click within the button
highlight. A pop-up menu will appear that lets you select every possible target within
the currently configured Project for that button highlight.
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Confirming a connections target by holding the mouse cursor above the button highlight area for a moment.

Once you establish a target, you can confirm the connection by simply pointing to the
button highlight with your mouse. After a brief pause, a pop-up label will appear
indicating the current Target (destination) setting for that button highlight. Or, as
detailed in Chapter 9, you can also use the Navigation Simulator or the Connections
window to view and confirm your connections.

Now that we’ve reviewed the basic process of creating DVD Menus. Let’s take a
closer look at some of the operational details and features of DVD Menus.

 T u t o r i a l  E n d
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Creating & Managing DVD Menus 

DVD Menus as created, renamed, and deleted in exactly the same manner as DVD Movies.

Creating (Adding) New DVD Menus  
By default, whenever you open a new Project, you’ll find a new DVD Menu — entitled
MENU 1 — in the Project Manager inside the Menus folder. You’ll also find, by default, a
new DVD Movie inside the Movies folder.

While many Spruce authoring software users will find themselves creating complete
Projects with just a single DVD Movie, most users will also find themselves working with
at least several, if not dozens of, DVD Menus.

To create a new DVD Menu:

• Under the File menu, select NEW, and then select DVD MENU. You’ll see a new DVD
Menu appear in the Project Manager.

– or –

• On the Toolbar, click the NEW DVD MENU button. A new DVD Menu will appear in the
Project Manager.

– or –

1. In the Project Manager, right-click on the name (or icon) of the current Project, the
Menus folder, or any current DVD Menu.

2. When the pop-up context menu appears, select ADD NEW DVD MENU.

3. A new DVD Menu will appear in the Project Manager.
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Creating a new DVD Menu, by right-clicking on the
name of the current Project in the Project Manager.

Opening & Activating DVD Menus (Edit DVD Menu)
Once you’ve created a DVD Menu, you’ll want to open and edit it, by adding a back-
ground, a subpicture, and buttons.

When you open a DVD Menu, it appears as a window in the Workspace. You can have
multiple DVD Menus open in the Workspace, but as with any window in the Workspace,
at any given time only one can be the topmost active Window.

Note: In order to edit a DVD Menu, it must be both open and active in the Workspace.
Only one window can be active a time. If there are no other windows open in the Work-
space, then any DVD Menu you’ve opened will by default be the active window. For a
window to be active, its title bar must be highlighted; if its area overlaps other windows, it
will also become the topmost window when you click on it.

To open a DVD Menu:

1. In the Project Manager, double-click on the name (or icon) of the DVD Menu.

– or –

In the Project Manager, right-click on the name (or icon) of the desired DVD Menu,
then select EDIT DVD MENU.

2. A corresponding DVD Menu window will open in the Workspace.
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To activate a DVD Menu: 

1. If you have just opened a DVD Menu, and there are no other windows in the
Workspace, by default it will be the active window.

2. If other windows are already open in the Workspace (remember, a DVD Menu can
be open yet be hidden by other windows), then double-clicking on the DVD Menu
in the Project Manager will “activate” it.

3. Once a DVD Menu is activated, its title bar will be highlighted, and (if its area
overlaps other windows) it will become the topmost window.

There are actually many ways to manage your windows. For more details, please see
“Viewing Configurations” in Chapter 3.

Viewing DVD Menus in ‘Compact’ Layout mode
Sometimes it can be very useful to be able to see multiple DVD Menus simultaneously
within the Workspace or to see a DVD Menu and a DVD Movie together. In its default
configuration, however, your Spruce authoring software shows “full-size” DVD Menus in
the Workspace. That is, each DVD Menu will occupy all or most of the Workspace area.

One way to make more room within the Workspace is to use the Tile view or Arrange
Icons view options (as detailed in Chapter 3). In either case, each DVD Menu (as well as
DVD Movies and other windows) will occupy only a portion of the Workspace. However,
Tile view typically only shows a portion of each DVD Menu’s various controls and doesn’t
show any of the display area. As for Arrange Icons view, all you see is an ultra-minimized
title bar for each DVD Menu, with none of the controls, and none of the display area.

Your Spruce authoring software now offers a new Compact Layout mode. With this mode,
DVD Menus appear in the Workspace with a much smaller display area. Compact Layout
mode, for instance, allows you to see two or more DVD Menus, or a DVD Movie and a
DVD Menu, simultaneously within the Workspace.

Note: If you select the Compact Layout mode, the display area will shift to the left-hand
side of the DVD Menu and all of the DVD Menu view options (as detailed below) will be
organized under a new tab labeled GENERAL.
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A DVD Menu, shown in Compact Layout mode.

To view DVD Menus in Compact Layout mode:

1. Under the File pull-down menu, select PREFERENCES.

2. When the Preferences dialog opens, go to the Display tab.

3. Select (check) the option labeled USE COMPACT MENU EDITOR LAYOUT.

4. Click OK.

5. Now, any new DVD Menu you create or open will be shown in the Compact Layout
mode.

Note: Any DVD Menus that were already active in the Workspace before you se-
lected Compact Layout mode will remain full-size until you close them and reactivate
them.

‘Replacing’ Active DVD Menus (or DVD Movies) in the
Workspace 
Normally when you activate one DVD Menu, any current DVD Menus also remain active
in the Workspace. In practice, this means your Workspace can soon start to fill up with
DVD Menus as you check out and compare them (unless you take the time to close DVD
Menus before you activate new ones).

Your Spruce authoring software offers a handy viewing option which allows you to quickly
replace or swap DVD Menus in the Workspace, so that you can view and switch between
different DVD Menu with minimal effort. (This same option also allows you to replace
DVD Movie windows in the same manner.) Here’s how this is performed:
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To enable your Spruce authoring software to replace active windows in the Workspace:

1. Under the File pull-down menu, select PREFERENCES.

2. When the Preferences dialog opens, go to the Display tab.

3. Select (check) the option labeled ON ACTIVATE WORKSPACE WINDOW REPLACES CURRENT OF

SAME TYPE.

4. Click OK.

To see this feature in operation:

1. Activate a DVD Menu (or DVD Movie) by double-clicking on its icon in the Project
Manager. The window will open in the Workspace.

2. Arrange your view of the DVD Menu (or DVD Movie) window as desired; you can, if
you’re working with a DVD Menu, you can, if you like, view it in Compact Layout
mode (as described immediately above).

3. Now double-click in the Project Manager on another DVD Menu’s (or DVD Movie’s)
icon.

4. Watch the Workspace; after a second or two, you’ll see the first window be replaced
by the new one.

5. If you wish, you can now return to the first window, or view any other DVD Menu
(or DVD Movie), simply by double-clicking its icon in the Project Manager.

Note: With this feature enabled, you’ll only be able to see one DVD Menu (or DVD
Movie) at a time in the Workspace. In order to see two or more such windows in the
Workspace, you’ll need to uncheck the ON ACTIVATE WORKSPACE WINDOW REPLACES CURRENT OF

SAME TYPE.

Renaming, Deleting, Duplicating, & Sorting DVD Menus
When you create DVD Menus, they’re automatically named DVD MENU 1, DVD MENU 2, and
so forth. You may find it more convenient — especially if you have lots of DVD Menus —
to name them something related to their ultimate function, such as MAIN MENU, or LANGUAGE

CHOICE. DVD Menu names can be up to 32 characters long.

Note: These names are for your reference only and are only visible within your Project.
The end-user will never see the name for any DVD Menu, other than whatever menu
name you may want to display, using the text in a background or subpicture.
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You can also delete, duplicate, and sort your DVD Menus, by right-clicking within the
Project Manager on either the desired DVD Menu or (for sorting) the Project name. For
more information on these operations, please see Chapter 4.

Working with Still Image Assets

As we introduced earlier in this chapter, DVD Menu backgrounds and subpictures are
typically constructed using still image assets. (With dynamic DVD Menus, a video file can
be used instead of a still image for the background; we’ll detail this a later in the chapter.)

These still images are generally created outside the DVD authoring environment using a
graphics program such as Adobe Photoshop, and are then imported into the Project.

DVD Menu Image Resolution
Background images and subpictures should ideally be 720 x 480 (for NTSC) or 720 x 576
for PAL, although Spruce authoring software will automatically resize smaller or larger
images to fit. As discussed in the “Video Monitor” section later in this chapter, you also
have the option of viewing DVD Menus either on your computer monitor, using the Menu
Navigator, or on an external NTSC/PAL video monitor.

Keep in mind that DVD Menus may appear somewhat different when viewed on a com-
puter screen rather than an NTSC/PAL video monitor. For instance, a 720 x 480 DVD
Menu viewed on a video monitor will appear in a true 4:3 aspect ratio; on a PC’s com-
puter display, however, it will appear slightly wide, since a 640 x 480 is what delivers a
true 4:3 aspect ratio. (This is because the pixel aspect ratio of a video monitor makes the
individual pixel shapes taller than they are wide (rectangle pixels) whereas a computer
display generally utilizes square pixels.)

Note: Even if you choose the 16:9 option for your DVD Menus (as described later), these
same pixel dimensions apply.
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Adding Backgrounds & Subpictures to a DVD Menu
Each DVD Menu consists of a background and a subpicture — and as its name suggests,
the background sits behind, or a “layer” underneath, the subpicture. 

Before you can add a background or subpicture to a DVD Menu, you first need to import it
into your Project, either via the Assets Bin or via the Windows Explorer or desktop (see
Chapter 5). Spruce authoring software supports images in a wide variety of formats (see
Chapter 2). And remember, there are also aesthetic matters for you to consider when
choosing backgrounds — since your choice of images will affect how end-users perceive
the quality of your final, replicated disc.

Adding backgrounds and subpictures is a fairly straightforward process — especially so if
you’re able to use Adobe Photoshop graphic image files as your background or subpicture
assets. In this case, you can take advantage of one of your Spruce authoring software’s
newest features — the ability to automatically parse two-layer Photoshop files into back-
ground and subpicture images. Let’s begin with a look at this process.

Adding Two-Layer Photoshop Assets to a DVD Menu 

Among many other formats, DVDMaestro and DVDConductor are able to import Adobe
Photoshop files (these files end with the “.psd” extension) for use as background or
subpicture images within DVD Menus.

As you may know, Photoshop files can be constructed with two or more layers, which
“float” upon one another. For instance, an image might be constructed of the first layer
being an image of a bright sky, and a second layer an image of a bird. With this sort of
two-layer construction, a Photoshop user can change the sky from being bright to cloudy,
without affecting the image of the bird.

Your Spruce authoring software is able to automatically parse two-layer Photoshop files, so
that the first layer is automatically assigned to be the background image and the second
layer is automatically assigned to be the subpicture. So, for instance, if you were to import
the file we just described, the sky and bird would automatically become the background
and subpicture images, respectively.

This saves you the step of preparing separate files for background and subpicture — and it
also saves you time when you import assets for use as background and subpicture images.
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To import a two-layer Photoshop file into a DVD Menu for use as both the background and
subpicture images:

1. Open the DVD Menu and make it the active window.

2. Find the name of the desired Photoshop file within the Assets Bin. (If you wish, you
can view the image at this time by double-clicking on its name; this will launch the
Picture Previewer window.) If you have yet to import the desired background into the
Assets Bin, then:

° right-click in the Assets Bin and select the LAUNCH EXPLORER option. Then, using
Windows Explorer, locate the file on your hard drive and drag it directly to the
Assets Bin. You can also click directly on the Windows desktop and drag the file
from the desktop to the Assets Bin.

– or –

° right-click in the Assets Bin and select the IMPORT MEDIA ASSET option. Using the
Import Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click OPEN and the file will appear in the Assets
Bin.

3. Drag the selected image from the Assets Bin onto the DVD Menu’s display area.
Assuming you’ve selected a two-layer Photoshop file, the first layer will automati-
cally be parsed to serve as the background image, and the second layer will auto-
matically become the subpicture image.

Note: Once you’ve completed these steps, to see the background image alone, set the
DVD Menu’s View Layer option to BACKGROUND. To see the subpicture image alone, set the
View Layer option to SUBPICTURE. To see both the background and the subpicture images
together, set the View Layer option to BOTH.

Adding Single-Layer Assets to a DVD Menu 

Spruce authoring software’s ability to parse Photoshop file layers automatically into
subpicture and background images is a real time-saver; however, you may not always have
the option of using Photoshop files for your image assets.

In this case, the following steps describe how to add non-Photoshop assets — or single-
layer Photoshop assets — to a DVD Menu. We’ll start with adding a background, then
describe how to add a subpicture.
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To add a background to a DVD Menu from a single-layer asset:

1. Open the DVD Menu and make it the active window.

2. Find the name of the desired background within the Assets Bin. (If you wish, you can
view the image at this time by double-clicking on its name; this will launch the
Picture Previewer window.) If you have yet to import the desired background into the
Assets Bin, then:

° right-click in the Assets Bin and select the LAUNCH EXPLORER option. Then, using
Windows Explorer, locate the file on your hard drive and drag it directly to the
Assets Bin. You can also click directly on the Windows desktop and drag the file
from the desktop to the Assets Bin.

– or –

° right-click in the Assets Bin and select the IMPORT MEDIA ASSET option. Using the
Import Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click OPEN and the file will appear in the Assets
Bin.

3. Find the DVD Menu control section labeled VIEW LAYER (DVD Menu controls are in
the bottom portion of the DVD Menu window. If you don’t see any controls in the
DVD Menu, you may need to expand the view by clicking the maximize button in
the right corner of the DVD Menu window.)

4. From within the View Layer section, select the BACKGROUND option.

5. Drag the desired image from the Assets Bin into the DVD Menu. The background
image will appear in the DVD Menu — assuming your View Layer choice is BACK-
GROUND or BOTH (the background will be hidden if View Layer is set to SUBPICTURE).

– or –

Drag the desired image from the Windows Explorer (or Windows desktop) into the DVD
Menu. The background image will appear in the DVD Menu — assuming your View Layer
choice is BACKGROUND or BOTH (the background will be hidden if View Layer is set to
SUBPICTURE). The name of the image will also appear automatically in the Assets Bin.

Note: If your View Layer choice is either BACKGROUND or BOTH, your Spruce authoring
software will assume that the first file you drag to the DVD Menu is intended to be the
background. However, if the SUBPICTURE option is selected, then the image will become the
subpicture, even if it is the first file you’ve dragged to the DVD Menu.
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Note: Remember, if you’ve chosen a Photoshop file that happens to have two layers,
Spruce authoring software will automatically parse the first layer to be the background and
the second layer to be the subpicture, as detailed in the immediately preceding section.

The background image, as seen in the DVD Menu’s display. Note that the View Layer
option is set to BACKGROUND, and that BUTTON OUTLINE is not selected.

To add a subpicture to a DVD Menu from a single-layer asset:

1. Open the DVD Menu and make it the active window.

2. Find the name of the desired subpicture within the Assets Bin. (If you wish, you can
view the subpicture at this time by double-clicking on its name; this will launch the
Picture Previewer window.) If you have yet to import the desired subpicture into the
Assets Bin, then:

° right-click in the Assets Bin and select the LAUNCH EXPLORER option. Then, using
Windows Explorer, locate the file on your hard drive and drag it directly to the
Assets Bin. You can also click directly on the Windows desktop and drag the file
from the desktop to the Assets Bin.
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– or –

° right-click in the Assets Bin and select the IMPORT MEDIA ASSET option. Using the
Import Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click OPEN and the file will appear in the Assets
Bin.

3. Find the DVD Menu control section labeled VIEW LAYER. If you don’t see any controls
in the DVD Menu, you may need to expand the view by clicking the expand view
button in the right corner of the DVD Menu window.

4. From within the View Layer section, select the SUBPICTURE option.

5. Drag the desired subpicture from the Assets Bin into the DVD Menu. The subpicture
will appear in the DVD Menu — assuming your View Layer choice is SUBPICTURE or
BOTH (the subpicture will be hidden if View Layer is set to BACKGROUND).

– or –

Drag the desired image from the Windows Explorer (or Windows desktop) into the
DVD Menu. The subpicture will appear in the DVD Menu — assuming your View
Layer choice is SUBPICTURE or BOTH (the subpicture will be hidden if View Layer is set
to BACKGROUND). The name of the subpicture will also appear automatically in the
Assets Bin.

Note: Your Spruce authoring software will assume that the first file you drag to the DVD
Menu is intended to be the background — unless you’ve selected SUBPICTURE as your View
Layer option. In that case, the file will become the subpicture even if it is the first file
you’ve dragged to the DVD Menu.

Note: Remember, if you’ve chosen a Photoshop file that happens to have two layers,
Spruce authoring software will automatically parse the first layer to be the background,
and the second layer to be the subpicture, as detailed in the immediately preceding
section.
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The subpicture image, as seen in the DVD Menu’s display. Note that the View Layer
option is set to SUBPICTURE and that BUTTON OUTLINE is selected.

Adding Backgrounds & Subpictures via the Playback Control Tab
There’s yet another way to add backgrounds and subpictures to a DVD Menu — and that’s
via the DVD Menu’s Playback Control tab.

Note: Adding backgrounds and subpictures via the Playback Control Tab is intended only
for non-Photoshop files or for single-layer Photoshop files. This approach will not auto-
matically parse two-layer Photoshop files into the background and subpicture images.
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This tab is normally used to establish loop start points to create dynamic DVD Menus (with
audio and video), and so forth. However, it’s also used to remove backgrounds and
subpictures from DVD Menus. So, if you’re trying lots of different images, you may prefer
to simply keep the Playback Control tab open, where you can do as much adding and
removing of backgrounds and subpictures as you wish.

Adding a background image via the Playback Control tab.

To add a background or subpicture to a DVD Menu via its Playback Control tab:

1. Open the DVD Menu and make it the active window.

2. Within the DVD Menu controls, click on the tab titled PLAYBACK CONTROL.
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3. Find the name of the desired background or subpicture image file within the Assets
Bin. (If you wish, you can view the image at this time by double-clicking on its
name; this will launch the Picture Previewer window.) If you have yet to import the
desired background or subpicture into the Assets Bin, then:

° right-click in the Assets Bin and select the LAUNCH EXPLORER option. Then, using
Windows Explorer, locate the file on your hard drive and drag it directly to the
Assets Bin. You can also click directly on the Windows desktop and drag the file
from the desktop to the Assets Bin.

– or –

° right-click in the Assets Bin and select the IMPORT MEDIA ASSET option. Using the
Import Media browser, locate the desired file or type in its name directly (in
“drive:\folder\file name” format). Click OPEN and the file will appear in the Assets
Bin.

4. Drag the desired image from the Assets Bin onto the Playback Control tab and drop it
in either the STILL IMAGE/VIDEO STREAM box or the SUBPICTURE box. (If it’s a background
image, use the STILL IMAGE/VIDEO STREAM box.) The chosen image(s) will appear in the
DVD Menu — assuming VIEW LAYER is set to the desired choice.

– or – 

Drag the desired image from the Windows Explorer (or Windows desktop) onto the
Playback Control tab and drop it in either the STILL IMAGE/VIDEO STREAM box or the
SUBPICTURE box. The image will appear in the DVD Menu — assuming VIEW LAYER is set
to the desired choice. The name of the image will also appear automatically in the
Assets Bin.

Removing Backgrounds & Subpictures from a DVD Menu
Backgrounds and subpictures alike are removed from DVD Menus via the Playback
Control tab.

To remove a background or subpicture from a DVD Menu:

1. Open the DVD Menu and make it the active window.

2. Within the DVD Menu controls, click on the tab titled PLAYBACK CONTROL.

3. To remove the background image, find the STILL IMAGE/VIDEO STREAM box and click on
the recycle bin (trash) icon next to it. A prompt will appear asking you if you want to
remove the image from the DVD Menu; click YES.

Chapter 7: Working with DVD Menus 7-37

7

– or –

3. To remove the subpicture image, find the SUBPICTURE IMAGE box and click on the
recycle bin (trash) icon next to it. A prompt will appear asking you if you want to
remove the image from the DVD Menu; click YES.

Note: This procedure only removes images from DVD Menus; the image file names will
still appear in the Assets Bin and the files themselves will remain untouched.

Button Highlights

As described in Chapter 10 (“Understanding the Color Maps”), the buttons that end-users see
onscreen — the graphic, or “visible” buttons” — are part of the subpicture or background
image (or both), which are usually created with a separate, dedicated graphics program.

So when you “create buttons” in Spruce authoring software, what you’re really doing is
defining what portions of the subpicture or background image that Spruce authoring
software should treat as buttons. Once you do this, you can then define how each button
will be highlighted — and what actions will take place — when the end-user selects or
actuates it.

Consequently, we refer to the process of defining visible buttons in the subpicture as
“defining button highlights” or just “highlighting.”

Defining button highlights
Defining a button highlight is typically a straightforward process of “drawing” a frame
around a visible button within the DVD Menu display area…

To define a button highlight: 

1. If you haven’t already done so, add a subpicture to an active DVD Menu (see
“Adding Backgrounds & Subpictures to a DVD Menu”).

2. In the DVD Menu controls, ensure that BUTTON OUTLINE is enabled and also select BOTH

as the View Layer option.
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3. Next, identify the portion of the subpicture within the DVD Menu display area that
you wish to highlight as a button. This could be an area which resembles a button —
or it could be something less “literal” that you’d like to use as a button, such as a
piano key, a star on a flag, or a block of text. Whatever you use, this portion of the
subpicture image is what will be the “visible” button (i.e.: it’s what the end-user will
see as an onscreen button). 

4. Position your mouse to one side of the visible button. Next, frame the visible button
with a highlight by left-clicking and holding the mouse button down. As you drag the
mouse to frame the visible button, you’ll see a colored rectangle appear in the
subpicture. Release the mouse button when you have finished framing the visible
button.

5. The resulting rectangle that now frames the visible button is the highlight area —
essentially, you’ve just told your Spruce authoring software that the area within the
rectangle is a button. You’ll also notice a colored number has been automatically
assigned in the upper-left corner of the highlight area: This is the button number and
is used for navigating between multiple buttons. (You can also assign button names,
as described below; see “DVD Menu Controls: Buttons Tab.”)

6. If you make a mistake, just right-click (while you continue to hold the left mouse
button) and this will cancel the procedure. Or you can delete, move, copy, or resize
the button, as described next.
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Defining a button highlight on top of a “visible” button. Note that three other button highlights have already been
defined. Also note that we are viewing both the background and subpicture images (which were shown individu-
ally earlier), so that we can draw the button highlight around both the visible button (which in this case is part of
the background) and the text (which in this case is part of the subpicture).

Note: For end-users who are viewing your disc using a personal computer with a DVD-
ROM player, the button highlights you define will determine the selectable “hotspot areas”
that end-users can click using a mouse (assuming their DVD navigation software supports
this feature). 

End-users who are viewing your final, replicated disc on a “stand-alone” DVD

player will only see the highlight areas when they select them using their remote controls.
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Selecting button highlights
Before you are able to delete, copy, or otherwise move a button highlight, you’ll usually
need to select it within the DVD Menu display area.

To select a button highlight: 

1. With BUTTON OUTLINE enabled and SUBPICTURE or BOTH as the View Layer option, click
once in the middle of the highlight area.

2. This will select the highlighted area, as indicated by a dotted line along its perimeter,
and handles (small black “grabber” knobs) in the corners and on each side of the
rectangular highlight area. (If you’ve just defined the highlight area and haven’t
clicked anywhere else in the subpicture, the highlight area will already be selected.) 

Deleting button highlights
Deleting a button highlight is likewise a straightforward process…

To delete a button highlight: 

1. Select the button highlight.

2. Press the DELETE key on your computer keyboard.

3. The highlight area will be deleted. (You can undo this action.)

4. To delete multiple highlight areas simultaneously, simply SHIFT–LEFT-CLICK to select
multiple highlight areas, then press the DELETE key.

Moving button highlights
Button highlights can be easily repositioned…

To move a button highlight: 

1. Select the button highlight.

2. You’ll notice that the cursor changes from an arrow to a crosshair-style selector tool.
This lets you know that the highlight area is ready to be moved.

3. Left-click and hold your mouse button. Move the highlight area to any desired
location in the image and release the mouse button. (Keep in mind that wherever
you release the mouse, Spruce authoring software will treat the area bounded by the
highlight area as a button.)
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4. When the highlight area is in the new desired position, click away to some other
portion of the image. This will deselect the highlight area — a good precaution
against accidentally moving it.

5. To move multiple highlight areas simultaneously, simply hold the SHIFT key on your
keyboard and left-click to select multiple highlight areas, then proceed from Step 2
onward.

6. If you make a mistake, just right-click (while you continue to hold the left mouse
button) and this will cancel the procedure.

Copying button highlights
When working with multiple visible buttons of all the same size, you might prefer to define
just one button highlight and then copy and move it as necessary (rather than having to
define a new button highlight for each visible button.

To copy a button highlight: 

1. Select the button highlight.

2. You’ll notice that the cursor changes from an arrow to a crosshair-style selector tool.
This lets you know that the highlight area is ready to be copied.

3. While holding the CONTROL key on your keyboard, left-click and hold your mouse
button. (You can release the CONTROL key now.) As you move the mouse, you’ll see a
new outline for a highlight area — this is the copied highlight area. Position the
copied highlight area over any desired location in the subpicture and release the
mouse button. (Keep in mind that wherever you release the mouse, Spruce authoring
software will treat the area bounded by the new highlight area as a button.)

4. When the copied highlight area is in the new desired position, click away to some
other portion of the image. This will deselect the highlight area — a good precaution
against accidentally moving it.

5. To copy multiple highlight areas simultaneously, simply hold the CONTROL or the SHIFT

key on your keyboard and left-click to select multiple highlight areas, then proceed
from Step 2 onward.

6. If you make a mistake, just right-click (while you continue to hold the left mouse
button) and this will cancel the procedure.
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Resizing button highlights
Button highlights are easily resized…

To resize a button highlight: 

1. Select the button highlight.

2. You’ll notice that the cursor changes from an arrow to a crosshair-style selector tool.
Now move the cursor over one of the handles: You’ll notice that the cursor changes
from a selector tool to a resizer cursor — with two small left-right, or up-down, or
diagonal arrows. (The small arrows indicate which directions you can resize that
particular handle.) This lets you know that the highlight area is ready to be resized.

3. With the resizer cursor positioned over the desired handle, left-click and hold your
mouse button. As you move the mouse, you’ll see a new outline for your resized
highlight area. When you’ve resized the button highlight to your liking, just release
the mouse. (Keep in mind that wherever you release the mouse, that Spruce author-
ing software will treat the area underneath the highlight area as a button.)

4. If you need to resize any other handles, simply repeat Step 3.

5. Once you’ve resized the highlight area as you wish, click away to some other
portion of the image. This will deselect the highlight area — a good precaution
against accidentally moving it.

6. To resize multiple highlight areas simultaneously, simply hold the SHIFT key on your
keyboard and left-click to select multiple highlight areas, then proceed from Step 2
onward. (You only need to position the resizer cursor over one of the highlight area’s
handles.)

7. Step 6 will resize all of the selected highlight areas, but maintain their relative size
and position. If you want to resize multiple highlight areas so that they all line up to
an absolute position — that is, so that all of the highlight areas resize to the same
location on the subpicture — hold the CONTROL key on your keyboard as you position
the resizer cursor over a handle, then proceed from Step 3, above, as normal.

8. If you make a mistake, just right-click (while you continue to hold the left mouse
button) and this will cancel the procedure.
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Resizing a button highlight.

Note: In some circumstances — especially after opening multiple DVD Menus in a row — you
may find that you’re unable to create new button highlights. (It will appear as if the cursor is
“stuck” in a crosshair pattern.) If this happens, simply press the DELETE key on your keyboard.
The problem will disappear and you’ll be able to resume crafting button highlights.

DVD Menu View Options

Note: If you are viewing normally sized DVD Menus, the View Option controls appear in
the bottom area of each DVD Menu. If you have selected the Compact Layout mode (as
detailed earlier in this chapter), then the View Option controls appear under the tab
labeled general.

Each DVD Menu has a selection of controls and viewing options, which define many
characteristics of your menus, including:

• whether you are viewing a background, a subpicture, or a combined view of both;

• how the button-color states change depending on particular end-user actions;

• how original graphics file colors can be mapped or reinterpreted when the file is
added to the DVD Menu as a subpicture;

. . . as well as many other characteristics.
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In this section, we’ll provide a brief “check-list” of each of these controls.

Button Preview Options
Once you have defined button highlights (see “Defining Button highlights”), DVDMaestro
and DVDConductor let you preview what their colors will be when the end-user plays
your final, replicated disc.

Please keep in mind that by “selection,” we’re referring to when an end-user simply selects
or “scrolls through” a button — such as occurs when the end-user moves between buttons
using the arrow keys on a remote control. Selecting a button is (usually) not the same as
“actuating” a button — which is when an end-user selects a button and then initiates a
button action by pressing ENTER on a remote control. However, DVDMaestro and DVDCon-
ductor also support an “Auto Action Mode,” whereby a button is considered actuated as
soon as it is selected — which is useful, for instance, if you prompt an end-user to press a
particular remote control button number to select a particular action.

Note: In order to view either action colors or selection colors for your buttons, the View
Layer option must be set to BOTH and the DVD Menu must have both a background and a
subpicture.

In typical use, you would select one button at a time, then alternately select NONE, SELECTION

COLOR, and ACTION COLOR to see how the three possible states will look to the end-user.

None

NONE shows what the menu would look like to the end-user if no buttons were selected or
actuated.

Note: This selection previews the menu without displaying any selection or action colors.
If you have selected BOTH as the View Layer choice (which would normally be the case),
then you will see whatever colors are being mapped to the subpicture (as defined in the
Subpicture Color Mapping controls).

Selection Color 

This lets you see what the button colors will be when the end-user selects a button with his
or her remote control or when the button is automatically selected through a pre-selection
of a button, as established in the Connections window.

To preview a button’s selection color, select SELECTION COLOR, then click once in a button
highlight. (You may wish to enable the BUTTON OUTLINE option to see the boundaries of your
button highlights.)
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Action Color

This lets you see what the button colors will be when the end-user actuates a button with
his or her remote control (or when the button is automatically selected, if you’ve defined
an Auto Action Mode for that button).

To preview a button’s action color, select ACTION COLOR, then click once in a button high-
light. (You may wish to enable the BUTTON OUTLINE option to see the boundaries of your
button highlights.)

Note: You must select one button at a time to view Button Selection or Button Action colors.

View Layer Options
As you work with a DVD Menu, your Spruce authoring software lets you see either your
background or your subpicture, or a combined image of both. Of course, these images
need to be already added to a menu in order to see them.

Select BACKGROUND to view just the background. You should also select BACKGROUND before
you add a background to the DVD Menu by dragging it from the Assets Bin (unless you’re
dragging a two-layer Photoshop file, where the first layer will automatically be parsed to
be the background image).

Note: If you have yet to add a subpicture to the DVD Menu and you haven’t selected
SUBPICTURE as the View Layer option, then the first file you drag to the DVD Menu will be
the background, even if you’ve selected BOTH as the View Layer option.)

Select SUBPICTURE to view just the subpicture. You must also select SUBPICTURE before you add
a subpicture to the DVD Menu by dragging it from the Assets Bin (unless you’re dragging a
two-layer Photoshop file, where the second layer will automatically be parsed to be the
subpicture image)

Select BOTH to view both the background and the subpicture. You must also select BOTH in
order to see any of the mapped Button Preview colors or to see any of color mapping that
has been applied to the subpicture (see “DVD Menu Color Mapping Controls”).

Button Outline 
Select BUTTON OUTLINE to display or edit the boundaries of any button highlights you’ve
created (see “Defining Button highlights”). With this selection enabled, button outlines will
be seen regardless of what Button Preview or View Layer options you’ve selected.
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Note: As detailed in “Defining Button highlights,” Button Outlines are not directly visible
to the end-user; rather, they are used to frame (i.e. define) button areas.

Full Resolution 
Select FULL RESOLUTION to display the active DVD Menu in its full NTSC or PAL resolution. If
you have defined your Project as an NTSC Project, the resolution will be 720 x 480; if it’s
a PAL Project, the resolution will be 720 x 576.

By default, Spruce authoring software automatically displays active DVD Menus in full resolution.

Safe Area 
If you select SAFE AREA — and also select either BACKGROUND or BOTH as your View Layer
options — a white dotted line will be displayed around the perimeter of the background.

This dotted line shows the recommend “safe area” boundary for consumer television
display. Any portions of the background (or subpicture) which are outside the safe area
boundary might not be seen when your final, replicated disc is played back through
conventional televisions.
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Showing the safe area.

Subpic Mapped
This control lets you view an imported subpicture in either its color-mapped state (SUBPIC

MAPPED selected) or in its original colors (SUBPIC MAPPED deselected).

When you add a subpicture to a DVD Menu, its original colors are automatically con-
verted to the Color Map colors, as defined using the Subpicture color mapping controls. It
can be useful to compare the subpicture’s original colors with its color-mapped colors. To
do this, set the View Layer option to SUBPICTURE. Then, simply select SUBPIC MAPPED to see the
mapped colors and deselect it to see the original colors.
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Note: This selectable option is not available unless the View Layer option is set to
SUBPICTURE. If the View Layer is in any other setting, then the subpicture will always be
viewed in its mapped colors.

Aspect Ratio
DVD Menus now offer a selection of 16x9 or 4x3 aspect ratio. If the setting of 16x9 is
buttons and subpictures are automatically adjusted for the DVD player viewing mode.

This is valuable, as it removes the necessity to generate multiple subpictures and setting of
buttons as in competing systems.

Normalize Window
Click on NORMALIZE WINDOW to resize the active DVD Menu, along with its controls, to fit
the dimensions of the background or subpicture image. This is useful if you’ve re-sized the
DVD Menu window and wish once again to return it to an efficient view that “wraps”
around the background image or subpicture. 

This control is duplicated in the DVD Menus pull-down menu.

Video Monitor (Launch Menu Navigator) 
It can be useful to view your DVD Menus in your NTSC/PAL video monitor as you create
them, rather than just on your computer display. This is because the characteristics of the
two are considerably different and end-users will be using both. Also, as we introduced
earlier in this chapter, it can be useful to test your DVD Menu button highlights by using
the Menu Navigator. Both functions are initiated via the Video Monitor control.

To view your DVD Menus on your video monitor, select VIDEO MONITOR. The Menu Pre-
viewer window will launch and the currently active DVD Menu will appear in your video
monitor (assuming you have a video monitor connected to your Spruce decoder card
video output).
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Clicking on the VIDEO MONITOR option will launch the Menu Navigator; the same image will also appear in your
NTSC/PAL video monitor.

The Menu Navigator also has navigation buttons, which function like an end-user’s remote
control arrow keys and can be useful for previewing how the end-user will navigate
through your DVD Menus and see button highlights.

Note: Because of the intensive calculations required to perform accurate previewing, it can
take a few seconds for the DVD Menu to appear in your video monitor — or somewhat
longer for dynamic DVD Menus that include a video file.
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DVD Menu Controls: Color Mapping Tab

Among the DVD Menu controls are the Color Mapping controls — a tabbed page distin-
guished by a total of 16 “color swatches” (small color display boxes) and 12 associated
Opacity sliders.

The DVD Menu Color Mapping tab is the top-level tab of its editing controls.

The Color Mapping controls serve two main purposes, including:

• choosing which four colors you wish to use for your subpicture image (remember, a
subpicture, once added to a DVD Menu, has a maximum of four colors); and

• choosing which colors you’d like the button highlights to be depending upon their state.

Note: In this small sub-section, we describe simply how the Color Mapping controls
operate. For more details about mapping the original colors of 4-color (2-bit) subpictures
to Color Maps, please see “Chapter 8: Understanding the Color Maps.” For more details
about mapping state-dependent button colors, please see “Button Selection (Color Map-
ping Controls),” later in this chapter.

The Color Mapping controls are organized into: 

• four Color Map rows — COLOR MAP 1, COLOR MAP 2, COLOR MAP 3, and COLOR MAP 4; and

• three columns — SUBPICTURE, BUTTON SELECTION, and BUTTON ACTION. 
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To the immediate left of each Color Map name is a fixed color swatch, showing a repre-
sentative “original” color that corresponds to each Color Map. (This is explained in detail
in Chapter 8.) Under each column are four user-definable color swatches and four adjust-
able Opacity sliders, one for each Color Map row.

As we’ve described, subpictures can have a maximum of only four distinct colors; if you
import a subpicture with more than four distinct colors, each color will be converted to
one of four possible color “maps” — each of which you get to define using the SUBPICTURE

color mapping controls.

Color Mapping:
Spruce Authoring Software vs. DVD-Video Spec Terminology
If you’re familiar with the DVD-Video Specification, or other DVD authoring tools, you
may be used to seeing Color Maps referred to by different names than we use with Spruce
authoring software.

The DVD-Video Specification refers to the four Color Maps as “Emphasis 1,” “Emphasis
2,” “Pattern,” and “Background.” We feel, however, that these names are potentially
confusing (especially the term “Background,” which may sound as if it is related to a DVD
Menu’s background image, but is not). So, in keeping with our approach to DVD author-
ing — that is, to keep things as simple and clear as possible and to shield you from unnec-
essary complexities of the DVD-Video Spec — we have used different names for what we
refer to as “Color Maps.”

Here’s how our Color Map names correspond to the DVD-Video Spec’s Highlight Area names.

DVDMaestro/DVDConductor DVD-Video Spec
Color Map Equivalent Term
Color Map 1 = Emphasis 1
Color Map 2 = Emphasis 2
Color Map 3 = Pattern
Color Map 4 = Background
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Changing a DVD Menu’s Color Map Colors
(Working with Color Swatches & Color Palettes)
Under each of the Subpicture, Button Selection, and Button Action columns are four user-
definable color swatches. These show the current Color Map colors that will be mapped to
the subpicture and the highlighted button-states.

Note: There are also four “fixed,” non-user-definable color swatches to the immediate left
of each Color Map name. These show a representative original subpicture color that
corresponds to each Color Map, and they are not currently adjustable. (Again, we’ll
explain more about how color mapping works in Chapter 8, “Understanding the Color
Maps.”)

When you create a new DVD Menu, it will open with default Color Map colors. However,
it’s possible to change any or all of a DVD Menu’s Color Map colors. To do so, you need
to understand how your Spruce authoring software treats these colors. Let’s start off by
considering the following points:

• Per the DVD-Video Specification, you can have a maximum of 16 different Color Map
colors available at any one time in any one DVD Menu.

• We call this collection of 16 colors a “palette.”

• You can have only one palette per DVD Menu; however, it is possible to use different
palettes with different DVD Menus. For instance, one DVD Menu could have a
palette that offered 16 very different colors, from black to red to green; another DVD
Menu could have a palette with 16 more similar colors that might all be different
shades of blue.

• A palette is not the same as a Color Map. Palettes are a collection of available Color
Map colors with 16 such colors available in total per DVD Menu. (Color Mapping, as
we’ll detail in Chapter 8, is used to convert subpicture images and also to define what
colors the button highlights become when they are selected or actuated.)

• A color pallet is not the same as a color group. (Color groups, as detailed later in this
chapter, are a way for different button highlights to be assigned different colors when
selected or actuated.)

Armed with this knowledge, let’s look at how we can change any of the Subpicture, Button
Selection, or Button Action Color Map colors...
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To change a Color Map color: 

1. Click once on any color swatch; the DVD Menu’s current palette, with 16 colors in
total, will appear.

2. Click on the new color you’d like to use.

3. The palette will close, and the color swatch will reflect the newly chosen color.

While the DVD-Video Spec limits each DVD Menu’s palette to just 16 Color Map colors,
it is possible to edit Color Map colors, to new colors of your choice.

To edit Color Map colors: 

1. Click once on the DVD Menu’s Edit Palette button.

2. The Edit Palette window will open, showing 16 color swatches (all the current
palette colors).

The Edit Palette window.

3. Choose which color you’d like to change by clicking once on the appropriate
swatch, then:

° enter a new RGB value in the Edit Color fields;

° click APPLY (the color swatch will change to reflect the new RGB — Red, Green,
Blue — values);

° click OK to close the Edit Palette window and return to the DVD Menu.

– or –

3. Choose which color you’d like to change by double-clicking once on the appropriate
swatch.

4. A Color Editor window will appear. Here, you can define any one of millions of
different colors.



DVDMaestro/DVDConductor User’s Guide7-54

Note: Depending upon your monitor color-depth settings, as defined in the Windows NT
Display control panel, you may or may not be able to visually distinguish every color.

The Color Editor window.

5. The current palette of 16 colors (labeled CUSTOM COLORS) appears in the lower-left of
the Color Editor window.

Note: The top two rows of four colors in the Edit Palette window correspond with the
top row of eight colors in the Color Editor window.)

Clicking once on any of these colors will display its RGB and HSL (Hue, Saturation,
Luminance) values. Doing so will also place a “crosshair”-style cursor in the Color
Editor’s color field, showing you the color’s relative location in a spectrum of colors.

6. There are several ways for you to change any color in the current palette to a new
color:

° The Color Editor offers 48 “generic” colors, labeled BASIC COLORS. If you see a color
among them that you want to use, simply click on the desired custom color swatch
you wish to change; then click on the desired basic color swatch; then click ADD TO

CUSTOM COLORS. The selected custom color swatch will change, indicating the new
color.
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– or –

° Click on the desired custom color swatch you wish to change. Then click and hold
on the crosshair cursor and drag it across the color field. As you drag, the current
color setting will be displayed in the “Color|Solid” field. When you find the color
you want, simply release the mouse, then click ADD TO CUSTOM COLORS. The selected
custom color swatch will change, indicating the new color.

– or –

° Click on the desired custom color swatch you wish to change. Type in new RGB
and HSL values, then click ADD TO CUSTOM COLORS. The selected custom color swatch
will change, indicating the new color.

7. Continue changing any other colors you wish. When you’re done, click OK. (If you’ve
made a mistake, you can click CANCEL and all changes will be ignored.) The Color
Editor window will close, returning you back to the Edit Palette window.

8. At this point, you may wish to save the current palette, as described immediately
below.

9. When you’re done, click OK and you’ll be returned to the current DVD Menu.

Saving & Loading Palettes

DVDMaestro and DVDConductor let you build your own libraries of palettes, which can
be a real time-saver. You do this by saving palettes and then loading them, as desired, into
DVD Menus.

To save a palette: 

1. With the Edit Palette window open, click SAVE. (Typically, you would do this after
you’ve created a new palette; see step 8 immediately above.)

2. A Save Palette prompt will appear. Navigate to the desired directory (you might want
to create your own “Palettes” folder), type in the name of the palette (e.g., BIG PROJECT

DVD MENU COLORS) and click SAVE.

Note: Do not change the SAVE AS TYPE setting. Palettes will automatically be given an
extension of “.spf” (Spruce palette file).

3. The Save Palette prompt will close and you’ll be returned to the Edit Palette window.
The palette is now saved.
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To load a palette: 

1. With the Edit Palette window open, click LOAD.

2. A Load Palette prompt will appear. Navigate to the desired directory, such as your
“Palettes” folder, locate the desired palette (e.g., BIG PROJECT DVD MENU COLORS.SPF) and
click LOAD.

3. The Load Palette prompt will close and you’ll be returned to the Edit Palette window.
The swatches in the Edit Palette window, the Color Editor window, and in the DVD Menu
itself will be updated to reflect the newly loaded palette.

Opacity Sliders
The Opacity sliders determine how opaque or translucent the subpicture color is, in the
following manner:

• Increasing an Opacity slider’s value blends more of the subpicture color with less of
the background color (making the subpicture color more opaque).

• Decreasing an Opacity slider’s value blends less of the subpicture with more of the
background color (making the subpicture color more translucent).

For instance, a value of “15” means that the color is at its “strongest” setting — which
means it has no translucency, and none of the background image will be visible under-
neath the corresponding portion of the subpicture. A value of “0” means that the color is
effectively invisible (i.e.: the background image will be completely visible underneath the
corresponding portion of the subpicture).

To change a default Opacity level: 

1. Simply adjust the associated Opacity slider.

2. The Opacity value, from “0” to “15,” appears in the associated color swatch.
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Subpicture (Color Mapping Controls)
The Subpicture color mapping controls define how the original colors of an imported
subpicture will be mapped. Each pixel in the original subpicture will be mapped to one of
the four defined Subpicture colors (except within the button highlights when a button is
selected or actuated). These are the colors of the subpicture the end-user will see, assum-
ing he or she has not activated any buttons. Of course, if the Opacity is set to “0” the
respective color will not be visible. (See Chapter 8 for more explanation.)

Note: If you don’t add a subpicture to your DVD Menu, your Spruce authoring software
will assign a white color to the subpicture portion of the DVD Menu. Please be aware that
in this case, consequently, the Color Map 4 control can cast a color hue over the entire
DVD Menu, unless its Opacity is set to “0.”

The Subpicture column has four user-definable color swatches and four adjustable Opacity
sliders, labeled COLOR MAP 1, COLOR MAP 2, COLOR MAP 3, and COLOR MAP 4.

The default colors and Opacity levels for each of the Subpicture Color Mapping controls
are as follows:

Color Map Default Color Default Opacity Level
Color Map 1 Black 10
Color Map 2 Blue 10
Color Map 3 Light Green 15
Color Map 4 Red 0

The Color Map 4 Opacity level is “0,” since color mapping is typically used for back-
ground portions of the subpicture image. Consequently, these portions of the image will
effectively be invisible (i.e. the background image will not be cast with a red hue, unless
you raise the value of the Color Map 4 Opacity Level).
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Comparing an original subpicture image (top), with how it changes after it has been color mapped (bottom). It may
be hard to appreciate the difference in black and white (as in this User’s Guide) — so be sure to experiment for
yourself with color mapping subpictures.
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Button Selection (Color Mapping Controls)
The Button Selection controls define the colors for each of the Color Maps when a button
highlight is selected (though not actuated). These are the colors that will be applied to a
button once it has been selected by the end-user.

The Button Selection column has four user-definable color swatches and four adjustable
Opacity sliders labeled COLOR MAP 1, COLOR MAP 2, COLOR MAP 3, and COLOR MAP 4.

Note: As we’ll describe below, Button Selection colors can also be assigned to any of three
color groups. This way, it’s possible for different button highlights to one of three different
colors when selected.

The default colors and Opacity levels for each of the Color Maps in the Button Selection
controls is as follows:

Color Map Default Color Default Opacity Level
Color Map 1 Dark Grey 10
Color Map 2 Light Grey 10
Color Map 3 Turquoise 15
Color Map 4 Chartreuse Pink 8

Note: If you do not want button colors to change when selected, set the Button Selection
Color Map color and Opacity settings to the same values as the non-highlighted
(Subpicture) state.

To preview the effect of the Button Selection colors: 

1. Define one or more button highlights.

2. Set the Button Preview option to SELECTION COLOR.

3. Set the View Layer option to BOTH.

4. Click on the desired button; you should see it change to the desired color. (If you do
not see the desired color change, ensure that the correct Color Map Opacity slider is
set to a value other than “0” and that the Subpicture and Button Selection colors are
indeed different from one another.)
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Comparing how a button highlight looks if it is unselected (top), with the same button highlight area showing what
its color mapping would look like after it has been selected. (Note that in the second image, the Button Preview
setting has changed from NONE to SELECTION COLOR.)

Button Action (Color Mapping Controls)
The Button Action controls define the colors for each of the Color Maps when a button is
actuated. These are the colors that will be applied to a button once it has been actuated by
the end-user.

(By “actuated,” we’re referring to when an end-user has initiated an action for a selected
button by pressing ENTER on his or her remote control. Also, Spruce authoring software
offers an Auto 

Action Mode, whereby you can pre-program a button to be actuated once a

user selects it.)

The Button Action column has four user-definable color swatches and four adjustable
Opacity sliders, labeled COLOR MAP 1, COLOR MAP 2, COLOR MAP 3, and COLOR MAP 4.
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Note: As we’ll describe next, Button Action colors can also be assigned to any of three
color groups. This way, it’s possible for different button highlights to be one of three
different colors when actuated.

The default colors and Opacity levels for each of the Color Maps in the Button Action
controls is as follows:

Color Map Default Color Default Opacity Level
Color Map 1 Yellow 10
Color Map 2 Indigo 10
Color Map 3 Dark Green 15
Color Map 4 Burgundy 3

Note: If you do not want button colors to change when actuated, set the other Color Map
color and Opacity settings to the same values as the selected (Button Selection) state or the
non-highlighted (Subpicture) controls.

To preview the effect of the Button Action colors: 

1. Define one or more button highlights.

2. Set the Button Preview option to ACTION COLOR.

3. Set the View Layer option to BOTH.

4. Click on the desired button; you should see it change to the desired color. (If you do
not see the desired color change, ensure that the correct Color Map Opacity slider is
set to a value other than “0” and that the color maps for the Subpicture, Button
Selection, and Button Action controls are indeed different from one another.)

Color Groups (Color Mapping Controls)
As you know, the DVD-Video Spec limits the total number of available Color Map colors
to a palette of just 16 colors. Your Spruce authoring software, however, offers a clever way
to assign Button Selection and Button Action colors to any of three color groups. This way,
it’s possible for different button highlights to be one of three different colors when selected
or actuated.

Keep in mind that color groups are not the same as a palette. Each DVD Menu allows you
to assign Button Selection or Button Action colors to one of three groups — but this does
not mean there are now 48 (16 x 3) available colors. In fact, each color group uses the
exact same color palette. The difference between them is best described in an example.
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Let’s say you’re crafting a DVD Menu with visible buttons, labeled (as will be seen on the
end-user’s DVD player) PG13-RELEASE VERSION, R-RATED RELEASE VERSION, and DIRECTOR’S CUT.
Assuming these visible buttons are part of the subpicture and were all created in the same
color — which means they all will be mapped to the same Color Map color — then they’ll
all share the same highlight color when the end-user selects them.

But wouldn’t it be nice if selecting each of these different buttons resulted in a different
highlight color? This is possible by assigning their respective button highlights to three
different color groups. To accomplish this, first you need to define what the Color Map
colors are for the three different groups.

To define Button Selection and Button Action Color Map colors for the three color groups: 

1. In the Color Mapping tab, click on COLOR GROUP 1.

2. Now set the various Button Selection and Button Action Color Map colors, as we
described earlier in this chapter. These will be the Color Map colors that will apply
to any button highlights that are assigned to color group 1.

3. Once you’ve set the colors for color group 1, click on COLOR GROUP 2.

4. Set the various Button Selection and Button Action Color Map colors once again.
These will be the Color Map colors that will apply to any button highlights that are
assigned to color group 2.

5. Now click on COLOR GROUP 3.

6. Set the various Button Selection and Button Action Color Map colors once again.
These will be the Color Map colors that will apply to any button highlights that are
assigned to color group 3.

7. Finally, you’ll need to assign each button highlight to its respective color group, as
detailed in the “Groups” subsection of the next main section (“DVD Menu Controls:
Buttons Tab”).

Returning to our earlier example, by following these steps, the visible button labeled PG13-
RELEASE VERSION could turn green when actuated and blue when selected; R-RATED RELEASE

VERSION could turn pink when actuated and red when selected; and DIRECTOR’S CUT could
turn grey when actuated and black when selected.
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Saving the Current DVD Menu’s Color Maps
as the Default Color Maps
Once you’ve crafted all the Color Map settings for a DVD Menu, you can, if you wish,
save them as default DVD Menu Color Maps.

Note: Saving the Color Map settings as the default is not exactly the same as saving
palettes of colors, as described earlier in this chapter. Saving Color Map settings as a
default means that new DVD Menus will open with these Color Map settings already in
place. Saving a palette means that you’ve saved a palette of 16 colors that can be recalled,
or loaded, into other DVD Menus for purposes of creating new Color Map settings.

 To save the current DVD Menu’s colors and then use them as default DVD Menu colors:

1. Once all the colors are set as you wish, click on the ‘Menu’ pull-down menu and
select SAVE COLOR MAPS.

2. Each new DVD Menu you create will now open with the default color settings —
providing you have checked the LOAD MENU COLOR MAP SETTINGS FROM DEFAULT option in
the User Preferences dialog.

3. To see if this option is checked, click on the File pull-down menu and select PREFER-
ENCES.

4. When the Preferences dialog opens, click on the Color Mapping tab.

5. This tab has only one option: LOAD MENU COLOR MAP SETTINGS FROM DEFAULT. Assuming
you want new DVD Menus to open with the default Color Map settings, ensure this
option is checkmarked. (If you do not wish to use the default Color Map settings,
uncheck this box.)

6. Click OK. The Preferences dialog will close and new DVD Menus will open with the
default Color Map settings.

Note: If you wish to modify the default Color Maps, simply make whatever changes you
wish in a new (or existing) DVD Menu, then repeat step 1.
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DVD Menu Controls: Buttons Tab

The DVD Menu Buttons controls can be found in the second tabbed page of DVD Menu
controls. Here, you can assign certain navigation and other attributes to each of the DVD
Menu’s button highlights on a per-button highlight basis.

The Buttons tab in the DVD Menu controls, showing pre-selections for both the audio and subtitle streams.

Coordinates
This displays the line position for each of a button highlight’s four sides; these values are
not adjustable from within the Coordinates display. Rather, they simply reflect the position
for each button highlight.

To see a button highlight’s coordinates:

1. Click the BUTTONS tab.

2. Select the button highlight.

3. The highlight area’s onscreen location will now be visible in the Coordinates display.

Navigation
The Navigation display shows, and lets you change, the arrow key “navigation relation-
ships” between button highlights — that is, which button highlights are selected when the
end-user presses the arrow keys on a remote control.
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The center square of the Navigation display shows the number of the currently selected
highlight area. (You cannot type a new number in here; to change the currently selected
button highlight, just click on the area in the subpicture.) The squares that surround the
center square show which highlight areas the end-user will move to using the arrow keys
on a remote control.

To define a particular button highlight’s navigation relationship to other buttons:

 1. Click the BUTTONS tab.

2. Select the button highlight.

3. The number of the selected button highlight will appear in the center of the Naviga-
tion display.

4. Now you can set which buttons the end-user will select next with a particular
remote-control arrow key just by typing them into the empty boxes. For instance,
let’s say the DVD Menu opens with button 1 selected (as you would set up in the
Connections window) and you want to move to button 3 when the end-user presses
the remote-control RIGHT arrow key. First select button highlight area 1, and then type
“3” in the right-hand box.

Normally, you’ll want to set up navigation relationships that make sense, relative to what
end-users will see on screen. For instance, if button 2 appears directly to the right of button
1 — and button 3 appears directly underneath button 1 — you’d probably want to set the
navigation so that when the end-user presses the RIGHT arrow key, the selection moves to
button 2.  When he or she presses the DOWN arrow key, the selection moves to button 3.

If you like, you can use the same button number in more than one direction. This way you
could set up a “wrap-around” relationship — so that pressing the RIGHT arrow key continuously
keeps cycling the end-user through all the button highlights in a horizontal row.

Spruce authoring software also has an Auto Assign feature (under the Advanced tab).
When you select Auto Assign, the navigation relationships between the DVD Menu’s
buttons are intelligently assigned, based upon their relative location to one another. If
you’re building a lot of DVD Menus with a lot of button highlights, you might find it
helpful to Auto Assign the navigation relationships first — and then to confirm (and
change, if needed) the relationships using the Navigation display.
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Group (Color Group Assignment)
As we described earlier DVDMaestro and DVDConductor allow you to assign button
highlights to any one of three different color groups.

Note: Please refer to “Color Groups (Color Mapping Controls)” above, for a detailed
description of what the color groups are and how to define Button Selection and Button
Action Color Map colors for the three color groups.

These controls here, under the Buttons tab, are where we assign individual button high-
lights to one of the three color groups.

To assign a new button highlight to one of the three color groups: 

1. Create the button highlight as usual.

2. Then, under the Buttons tab, click the appropriate group (“1,” “2,” or “3). The button
highlight is now assigned to that group.

To reassign an existing button highlight to one of the three color groups: 

1. With BUTTON OUTLINE enabled and SUBPICTURE or BOTH as the View Layer option, click
once in the middle of the highlight area.

2. The will select the highlight area, as indicated by a dotted line along its perimeter,
and handles (small black “grabber” knobs) in the corners and on each side of the
rectangular highlight area. (If you’ve just defined the highlight area and haven’t
clicked anywhere else in the subpicture, the highlight area will already be selected.)

3. Under the Buttons tab, click the appropriate group (“1,” “2,” or “3”). The button
highlight is now assigned to that group.

Auto Action
The Auto Action option (not to be confused with Auto Assign) has a very simple purpose: It will
automatically “actuate” a button highlight as soon as the end-user selects the highlight area. 

Normally, with Auto Action disabled (unchecked), an end-user must first select a button
highlight (using a remote control), then actuate it by pressing ENTER on the remote. With
Auto Action enabled (checked), the button is automatically actuated as soon as it is
selected.
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Note: With Auto Action enabled, the end-user will see the Button Action color, not the
Button Selection color, when the button highlight region is selected (assuming the button
isn’t invisible.)

This is handy if you want a DVD Menu choice to lead directly to something. For instance,
let’s say you wanted to present end-users with a message in a DVD Menu that reads PRESS

THE DOWN ARROW ON YOUR REMOTE CONTROL TO START THE VIDEO. In this case, you could set up a
button highlight (probably an invisible one) that has the Auto Action option enabled. Then,
in the Connections windows, you would establish a connection between this highlight
area and the appropriate DVD Movie (for video playback). This way, when the end-user
does press the DOWN arrow key, the video will start playing without any further action on
the part of the end-user.

Note: The Auto Action option is set on a per-button highlight basis — not a per-DVD
Menu basis. This way, you can define which button highlights do or do not require the
end-user to press ENTER to be actuated.

Invisible
The Invisible option allows you to create button highlights that are invisible to the end-
user; that is, these areas remain transparent, even when selected or actuated. To create an
invisible button highlight, make sure the INVISIBLE option is enabled (checkmarked).

Are you wondering why you’d want to create highlight areas that don’t “highlight”? The
reason is simple. End-users initiate video playback, language (audio) stream choices, and
more, using their remote controls. Usually, this is done by selecting a visible button and
pressing ENTER (or just selecting the button, if the Auto Action option is selected). However,
oftentimes you might prefer to have the end-user “jump” directly to a DVD Menu or a
DVD Movie playback by instructing them to press one of the remote control’s arrow keys.

For instance (as also described in “Auto Action”), let’s say you wanted to present end-users
with a message in a DVD Menu that read PRESS THE DOWN ARROW ON YOUR REMOTE CONTROL TO

START THE VIDEO — and you don’t want them to be presented with any other visible buttons
or highlights. In this case, you could create a button highlight — and enable both AUTO

ACTION and INVISIBLE. Then, in the Connections windows, you would establish a connection
between this invisible highlight area and the appropriate DVD Movie (for video playback).
This way, when the end-user does press the DOWN arrow key, the video will start playing
without any further action on the part of the end-user — and without any further button
highlights appearing onscreen.
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Note: The Invisible option is set on a per-button highlight basis — not a per-DVD Menu basis.

Stream Pre-Selection
The Stream Pre-Selection option lets you associate the current button highlight with a
particular audio or subtitle stream, so that the pre-selected stream will play when an
associated DVD Movie starts playing.

Here’s the purpose of this option: As an example, let’s say you establish a connection (in
the Connections window) between the current button highlight and a DVD Movie, and the
DVD Movie has four audio streams and three subtitle streams. Then, let’s say you now
establish a stream pre-selection for audio stream 3 and subtitle stream 2. Next, let’s say the
end-user actuates the button highlight by selecting a visible button and pressing ENTER on a
remote control or just by selecting a visible button (if you’ve enabled the Auto Action
Mode option). At this point, the DVD Movie will start playing with whatever audio and/or
subtitle streams you’ve pre-selected.

Keep in mind that a pre-selected audio or subtitle stream will only begin playing when the
DVD Movie begins playing. There are several ways to do this, but typically you’ll create a
connection between the button highlight and a DVD Movie to have audio or subtitle
playback occur when the end-user actuates the button highlight.

Note: Stream pre-selection is set on a per-button highlight basis — not a per-DVD Menu
basis. Also, It may be easy to confuse the stream pre-selection with button pre-selection.
Remember, a stream pre-selection is used to choose an audio and/or subtitle stream once
the end-user actuates the button highlight. A button pre-selection is used when you want a
button highlight to be initially selected when a DVD Menu is presented to an end-user.
This is useful, for instance, if you want to prompt the end-user toward a particular visible
button.

Name
Spruce authoring software automatically numbers each button highlight. If you wish, you
can also name your button highlights, such as “Go Back to Main Menu.”

This is especially helpful when making connections using the Connections window (as
described in Chapter 9). If you have a lot of DVD Menus, it can be much easier to keep
track of names rather than numbers.
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Target
The Target box in the Buttons tab shows the currently selected Connections target for the
currently selected button highlight. (For detailed information about the Connections
window, targets, and other related matters, please see Chapter 9.)

In other words, let’s say you’ve created a connection between a button highlight (as the
source) and an available target using the Connection window. In this case, the name of the
target will appear in the Target box under the Buttons tab. (If there is no established
connection, this box will be empty.)

Note: The Target box is a handy reference showing whatever target you’ve established in
the Connections window. You cannot, however, change the target using this Target box; to
do so, you must return to the Connections window.

You can also view (though not change) the target for any given button highlight simply by
positioning the mouse over the highlight area in question. A pop-up label will appear,
indicating the target name.

Hold your mouse cursor above a button highlight for a second or two, and a pop-up label will appear showing that
button highlight’s current connections target.
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DVD Menu Controls: Playback Control Tab

The DVD Menu Playback Controls can be found in the third tabbed page of DVD Menu
controls. Here, you can define:

• which still images are used for the background and subpicture portions of the DVD
Menu;

• whether a video file or audio file will be used to create a “dynamic” DVD Menu;

• whether the DVD Menu “times out” after a certain period of time; and

•  the point at which the DVD Menu loops (if you’ve created a dynamic DVD Menu
with a video background image).

The Playback Control tab, showing the Loop/Subpicture Start slider.

All of the Playback Controls apply to each complete DVD Menu, as opposed to applying
on a per-button highlight basis.

Static vs. Dynamic DVD Menus
Using Spruce authoring software, you can create two different types of DVD Menus: static
and dynamic.

As the name suggests, static DVD Menus are comprised of still images — a still back-
ground, and a still subpicture. The end-user sees both of these elements together as the
onscreen DVD Menu image for however long the DVD Menu remains onscreen (or until
the DVD Menu times out; see “End State”).
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And as you might guess, dynamic DVD Menus (also called “motion menus”) are com-
prised of one or two moving streams — a video stream, with or without an audio stream —
in addition to a static subpicture image. When the end-user views a dynamic DVD Menu
that has a video stream, he or she will see a moving video stream in place of the back-
ground image for the duration of the video file (or until the DVD Menu loops; see “End
State”). If the dynamic DVD Menu also has an audio stream, the end-user will hear the
audio stream play for the duration of the video file.

Note: A video stream can be used only in place of a background image; a static subpicture
can still be seen overlaid on top of the video stream (assuming you’ve added a subpicture
to the DVD Menu).

Static and dynamic DVD Menus also differ in terms of the “end state” options — that is,
what the end-user sees after the DVD Menu has been onscreen for a particular amount of
time or after the video file finishes playing.

Static DVD Menus have one of two possible end states:

• Still — where the DVD Menu remains on the end-user’s screen indefinitely until he
or she selects and actuates an action that leads to a DVD Movie or another DVD
Menu;

– or – 

• Timeout — where the DVD Menu stays onscreen for a pre-set amount of time, before
jumping to a DVD Movie or another DVD Menu (as defined in the Connections
window).

Dynamic DVD Menus have one of three possible end states (all of which occur after the
video file has finished playing):

• Still — where the last frame of the video file remains on the end-user’s screen indefi-
nitely until he or she selects and actuates an action that leads to a DVD Movie or
another DVD Menu;

– or – 

• Timeout — where the last frame of the video file remains onscreen for a pre-set
amount of time before jumping to a DVD Movie or another DVD Menu (as defined in
the Connections window);
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– or –

• Loop mode — where the video file “loops” back and repeats playing from a pre-
defined Loop/Subpicture Start point. The video playback will continue to loop
indefinitely until the end-user selects and actuates an action that leads to a DVD
Movie or another DVD Menu.

In addition, dynamic DVD Menus also let you choose the start-point for the subpicture.
This way, the video stream can begin playing and the subpicture (with, presumably, button
highlights) won’t become visible until part-way through the video stream. In Loop mode,
this subpicture start time is the same as the loop start time. In other words, the end-user
won’t see the subpicture until the video stream finishes playing back and then loops to a
pre-defined loop start time. Then, once the video resumes playback from its loop start-
point, the subpicture will also be visible.

Still Image/Video Stream
This box is used for adding, replacing, or deleting still background images or video streams
in a DVD Menu’s background image area. (See “Static vs. Dynamic DVD Menus.”)

The Still Image/Video Stream box will display the currently selected still background
image, assuming you’ve already added the background to the DVD Menu (see “Adding
Backgrounds & Subpictures to a DVD Menu”). If you haven’t added a background, the box
will be empty.

You can also use a video stream in place of a static background image to create a “dy-
namic” DVD Menu. Here, whenever the DVD Menu appears, a video stream will play in
the background underneath the subpicture image.

You can easily add, replace, or remove still background images or video streams using the
Still Image/Video Stream box.

To add or replace a still background image or video stream using the Still Image/Video Stream box:

1. Locate the desired image in the Assets Bin. (If you have yet to import the image into
your Project, see “Importing Assets into a Project.”)

2. Drag the image from the Assets Bin to the Still Image/Video Stream box. If the DVD
Menu already has a current background still image or video stream, it will be
replaced by the newly-dragged file.
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To remove a still background image or video stream from the DVD Menu:

1. Click on the recycle (trash) icon to the right of the Still Image/Video Stream box.

2. A prompt will appear asking REMOVE STILL/VIDEO IMAGE FROM THIS MENU? Click YES.

Note: Remember, removing a still background image or video stream from a DVD Menu is
not the same as deleting it from your Project (or deleting it from your hard drive). Once it’s
removed from a DVD Menu, it will remain in the Assets Bin until you delete it from the
Project (see “Deleting Assets from a Project,” Chapter 4).

Subpicture Image
This box is used for adding, replacing, or deleting subpictures in a DVD Menu’s subpicture
image area.

The Subpicture Image box will display the currently selected subpicture, assuming you’ve
already added the subpicture to the DVD Menu (see “Adding Backgrounds & Subpictures
to a DVD Menu”). If you haven’t added a subpicture, the box will be empty.

You can easily add, replace, or remove subpictures using the Subpicture Image box.

To add or replace a subpicture using the Still Image/Video Stream box:

1. Locate the desired subpicture image file in the Assets Bin. (If you have yet to import
the subpicture into your Project, see “Importing Assets into a Project.”)

2. Drag the subpicture from the Assets Bin to the Subpicture Image box. If the DVD Menu
already has a current subpicture, it will be replaced by the newly-dragged image.

To remove a subpicture from the DVD Menu:

1. Click on the recycle (trash) icon to the right of the Subpicture Image box.

2. A prompt will appear asking REMOVE SUBPICTURE FROM THIS MENU? Click YES.

Note: Remember, removing a subpicture from a DVD Menu is not the same as deleting it
from your Project (or deleting it from your hard drive). Once it’s removed from a DVD
Menu, it will remain in the Assets Bin until you delete it from the Project (see “Deleting
Assets from a Project,” Chapter 4).
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Audio Stream
This box is used for adding, replacing, or deleting an audio stream in a “dynamic” DVD
Menu. This is an audio stream that plays whenever the DVD Menu appears, in conjunction
with the dynamic DVD Menu’s video stream and subpicture. 

The Audio Stream box will display the currently selected audio stream file, if you’ve already
added audio to the DVD Menu. If you haven’t already done so, the box will be empty.

You can easily add, replace, or remove audio streams using the Audio Stream box.

To add or replace an audio stream using the Audio Stream box:

1. Locate the desired audio file in the Assets Bin. (If you have yet to import the audio
file into your Project, see “Importing Assets into a Project.”)

2. Drag the audio file from the Assets Bin to the Audio Stream box. If the DVD Menu
already has an audio stream, it will be replaced by the newly-dragged file.

To remove an audio stream from the DVD Menu:

1. Click on the recycle (trash) icon to the right of the Audio Stream box.

2. A prompt will appear asking REMOVE AUDIO STREAM FROM THIS MENU? Click YES.

Note: Remember, removing an audio stream from a DVD Menu is not the same as deleting
it from your Project (or deleting it from your hard drive). Once it’s removed from a DVD
Menu, it will remain in the Assets Bin until you delete it from the Project (see “Deleting
Assets from a Project,” Chapter 4).

End State
The End State controls are used to define how long, after it first appears, a DVD Menu
stays visible to the end-user. If you have created a dynamic DVD Menu with a video
stream in place of a background image, these controls are also used to define what hap-
pens after the video has finished playing.

Let’s first discuss these controls as they apply to a static DVD Menu with a still background
image.
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Still & Timeout (Static DVD Menus)

With a static DVD Menu, if you have selected STILL as the End State option, then the end-
user will see the DVD Menu remain onscreen indefinitely until the user actuates one of its
buttons or returns to the previous play mode.

If you select TIMEOUT, then the end-user will see the DVD Menu remain onscreen for the
duration of the timeout period — after which, the DVD Menu will jump to whatever target
you’ve defined (in the Connections window) for the end of the timeout period. You can
adjust the timeout period from a minimum of 1 second to a maximum of 255 seconds.  

Still, Timeout, & Loop Mode (Video-Streaming Dynamic DVD Menus)

With a dynamic DVD Menu that has a video stream, if you select STILL as the End State
option, then the last frame of the video file remains on the end-user’s screen indefinitely
(once the video file has finished playing) — until he or she selects and actuates an action
that leads to a DVD Movie or another DVD Menu.

If you select TIMEOUT as the End State option, then the last frame of the video file remains
onscreen for a pre-set amount of time (once the video file has finished playing), before
jumping to a DVD Movie or another DVD Menu (as defined in the Connections window).
You can adjust the timeout period from a minimum of 1 second to a maximum of 255
seconds.

Once you add a video stream to a DVD Menu, a third End State option appears — Loop
mode. At the same time, a new area of the Playback Control tab appears — called the
Loop/Subpicture Start Previewer. This area shows three still frames from the video stream
(the first frame, a middle frame, and the final frame). It also has a slider control, called the
Loop/Subpicture Start slider.

If you select LOOP as your end state, then once the end-user sees the DVD Menu onscreen,
the video stream will start playing and continue playing until the end of the file. Then, the
video file will loop back and resume playing from whatever Loop Start Time you’ve
selected with the Loop/Subpicture Start slider. This looped playback will continue until the
end-user selects and actuates an action that leads to a DVD Movie or another DVD Menu.

Setting the Loop Point (Video-Streaming Dynamic DVD Menus)

Once you decide to loop the video stream in your dynamic DVD Menu, you need to
determine the loop point — that is, the point in time to which the video stream loops back
once it reaches the end of the video file. This is done using the Loop/Subpicture Start
Previewer and the Loop/Subpicture Start slider.
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Note: Setting a loop point also sets the subpicture start point (see “Setting the Subpicture
Start Point”).

To set a loop point: 

1. Ensure that you’ve added a video stream to the DVD Menu and that you’ve selected
LOOP as the End State option.

2. Click and drag the Loop/Subpicture Start slider.

3. As you move the slider, you’ll see the middle frame in the Loop/Subpicture Start
Previewer change: This frame shows the exact frame location of the slider, as also
indicated by the time directly underneath the middle frame.

4. When you find the desired frame from which you wish to loop the video stream,
simply let go to establish the loop point.

5. Now, once the video stream finishes playback for the first time, it will loop back and
resume playback from loop point.

Note: The time indications in the Loop/Subpicture Start Previewer are shown in
hours:minutes:seconds:frames. However, the times shown are not timecode-referenced
and have nothing to do with any DVD Movie Timescales— even if the same video file is
used in a DVD Movie. Rather, these times are “absolute” times for that particular DVD
Menu’s video stream only, showing the time elapsed from when the DVD Menu appears.

Setting the Subpicture Start Point (Dynamic DVD Menus)

The Loop/Subpicture Start Previewer and Loop/Subpicture Start slider are used for more
than just setting the loop point: You can also use them to establish the subpicture start
point — which is when the end-user sees the subpicture appear. (This applies to any
video-streaming dynamic DVD Menu in any one of the Still, Timeout, or Loop End States.)

With static DVD Menus, the end-user can see the subpicture whenever the DVD Menu is
onscreen. However, with video-streaming dynamic DVD Menus, you can delay the
subpicture’s appearance. The typical application for this is if you want end-users to see a
dynamic DVD Menu start playing a video stream for, say, a few seconds — after which,
they’ll see a subpicture appear (with, presumably, button highlights).
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To set a subpicture start point: 

1. Ensure that you’ve added a video stream to the DVD Menu (otherwise, it does not
matter what you’ve selected as the End State option).

2. Click and drag the Loop/Subpicture Start slider.

3. As you move the slider, you’ll see the middle frame in the Loop/Subpicture Start
Previewer change: This frame shows the exact frame location of the slider, as also
indicated by the timecode number directly underneath the middle frame.

4. When you find the desired frame at which you wish the subpicture to appear, simply
let go to establish the subpicture start point.

5. Now, the end-user will see the subpicture appear once the video stream’s playback
reaches the subpicture start point.

Of course, you can have the subpicture be visible as soon as the DVD Menu appears;
simply move the Loop/Subpicture Start slider all the way left, to a time reading of
“00:00:00:00”.

Please be aware that if you have selected Loop mode, then the Loop/Subpicture Start slider
does “double-duty” in the following manner:

• First, as soon as the DVD Menu appears, the end-user will see the video stream play
(without a visible subpicture).

• Then, once the video stream reaches the subpicture start point, the subpicture will
appear.

• Next, once the video stream finishes, it will resume playback from whatever loop
start point you’ve chosen (using the Loop/Subpicture Start slider). Since the loop start
point and the subpicture start point are the same, the subpicture will also continue to
be visible for as long as the video stream keeps looping.
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DVD Menu Controls: Advanced Tab

The DVD Menu Advanced Controls are the fourth and final tabbed page of DVD Menu
controls. Here, as we’ll explain in just a moment, you can utilize several advanced charac-
teristics related to DVD Menus, including:

• whether a button highlight is pre-selected, if desired;

• whether the button numbers are offset;

• whether button highlights are numbered automatically, using the Auto Assign func-
tion;

• and (for advanced DVD authoring users only) what conditions, if any, affect the
viewing of the DVD Menu.

The Advanced tab, with a Display Condition established.

All of the Advanced Controls apply to each complete DVD Menu, as opposed to applying
on a per-button highlight basis.

Button Pre-Selection
The Button Pre-Selection feature lets you pre-select a button highlight — so that when the
end-user sees the DVD Menu, a highlight area will be selected already (as indicated by its
mapped Button Selection color). In essence, you can think of this as a “prompt” for the
end-user, indicating a preferred (or default) button highlight choice — or an indication of
the title’s current state.
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You configure a button pre-selection by choosing whether the pre-selection is based upon
the audio stream or the subtitle stream. Here’s how it works. . .

Let’s say that when the end-user sees the current DVD Menu you’re constructing, he or she
sees three visible buttons labeled ENGLISH, PORTUGUESE, and NEPALI. Let’s also say that, using
the Buttons tab, you’ve defined a respective audio stream pre-selection for each — audio
stream 1 (English), audio stream 2 (Portuguese), and audio stream 3 (Nepali). And let’s also
assume that somewhere earlier during the end-user’s playback experience that he or she
already chose audio stream 3 (Nepali) as the playback language. In other words, when this
DVD Menu appears, the preceding DVD Movie’s audio stream would have been playing
back a Nepali audio track.

Now, let’s return to the Advanced tab and the Button Pre-Selection box. If, under the
circumstances we just described, you were to select AUDIO STREAM, then — once the end-
user sees this current DVD Menu appear onscreen — the visible button labeled NEPALI will
be already selected, with the appropriate Button Selection color map highlighting.

So, to sum it up, Spruce authoring software is able to pre-select a button highlight by
looking for the highlight area with an audio stream pre-selection that corresponds (in
stream number) to the current audio stream.

Button Pre-Selection can also be used with subtitle streams in much the same way: If you select
SUBTITLE STREAM, Spruce authoring software will look for the button highlight with a subtitle
stream pre-selection that corresponds (in stream number) to the current subtitle stream.

Note: Please keep in mind that only one button highlight can be pre-selected per DVD Menu,
since, as you probably understand, the end-user can select only one visible button at a time.

Button Number Offset
The Advanced tab’s Button Number Offset feature is used to compensate for numeric
discrepancies between the visible buttons and the button highlights. That is, it compen-
sates if there is a numeric difference between the buttons that end-users see onscreen and
the button highlights that you’ve defined in a DVD Menu.
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To understand this better, consider the following example. Imagine that you have three
separate (but topic-related) DVD Menus with ten visible buttons — and ten button high-
lights — in each DVD Menu. Now let’s say that:

• the visible buttons in the first DVD Menu are labeled (in the subpicture) “1” to “10”;

• the visible buttons in the second DVD Menu are labeled “11” to “20”; and

• the visible buttons in the third DVD Menu are labeled “21” to “30”.

Now, let’s say that an end-user is looking at the second DVD Menu and wants to select the
visible button labeled “11”. So he or she presses 1-1-ENTER on the remote control. Unfortu-
nately, this won’t select the desired button, since, as far as this individual DVD Menu is
concerned, there are only ten buttons — or more specifically, button highlights. And in
this case, the visible button labeled “11” is actually the second DVD Menu’s button
highlight number “1.”

So how can you setup the second — and third — DVD Menus so that the end-user can
enter the visible button number?

The solution is the Button Number Offset feature. In this example, we would set an offset
value of “10” for the second DVD Menu and “20” for the third DVD Menu. Then, when
the end-user enters “11,” Spruce authoring software will first subtract the offset value and
then select the appropriate button highlight. In this case, the numbers work like this:

11 (remote control entered number) – 10 (button number offset)

= 1 (the desired button highlight area number)

Navigation Auto Assign
The Auto Assign feature is used to automatically assign the navigation relationships
between button highlights in an “intelligent” manner based upon their relative location to
one another.

As described earlier (see “Navigation”), each button highlight you create is numbered and
has a “navigational relationship” relative to other highlight areas. These numbers allow an
end-user to select a visible button directly (by typing in the number on the remote control
keypad). The “navigation relationships” between button highlights are used to determine
which highlight area is selected next when the end-user presses the arrow keys on a
remote control.
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Button numbers are assigned automatically in the order that you create them. However,
it’s up to you — using the Navigation display under the Buttons tab — to manually set the
navigational relationships (i.e.: button 3 is to the right of button 2; button 1 is to the left of
button 2; etc.).

However, if you’re building a lot of DVD Menus with a lot of button highlights, you can
auto-assign the navigation relationships simply by clicking AUTO ASSIGN under the Advanced
tab. Then, you can confirm (and change, if needed) the relationships using the Navigation
display.

Horizontal Wrap

 If this option is enabled (checkmarked), then any horizontal rows of button highlights will
“wrap around” once you click AUTO ASSIGN. That is, they will be assigned navigational
relationships such that when the end-user reaches, say, the rightmost highlight area in a
row — and presses the RIGHT arrow again — the leftmost highlight area in that same row
will be selected automatically.

(If you were to select the rightmost button highlight and look at the Navigation display
under the Buttons tab, you’d see the right-arrow number would correspond to the leftmost
button highlight.)

Vertical Wrap

 If this option is enabled (checkmarked), then any vertical columns of button highlights will
“wrap around” once you click AUTO ASSIGN. That is, they will be assigned navigational
relationships such that when the end-user reaches, say, the bottom-most highlight area in a
column — and presses the DOWN arrow again — the topmost highlight area in that same
column will be selected automatically.

(If you were to select the bottom-most button highlight and look at the Navigation display
under the Buttons tab, you’d see the down-arrow number would correspond to the top-
most button highlight.)

Display Condition
One of Spruce authoring software’s more sophisticated features is the ability to define
under which conditions an end-user will see the current DVD Menu. This is useful, for
example, if you want a particular DVD Menu to appear — or not appear at all — if the
end-user has selected a particular audio stream or if he or she is using a DVD Player that
was sold in a particular geographical region.
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Note: This Display Condition feature is for advanced DVD authoring users only. The
setting of these parameters requires intimate knowledge of the system parameters of the
DVD-Video Specification.

There are four definable Display Condition parameters:

• a Conditional Element selection — where you define what element of a DVD Menu,
DVD Movie, or Project is being evaluated;

• a Conditional Relationship selection — where you define the nature of the relation-
ship between the conditional element and a conditional state;

• a Conditional State selection — where you define the state of the conditional ele-
ment, such as its name, number, etc.; and

• an “Otherwise” selection — where you define which DVD Menu should be dis-
played instead of the current DVD Menu, should the Display Conditions not be
satisfied. 

For instance, let’s say you want the current DVD Menu to be displayed only if the cur-
rently active audio stream is number 3 or higher — and that if this isn’t true, you would
like the DVD Menu to jump automatically to another DVD Menu named, say, “North
American Intro Menu.”

To create this particular display condition: 

1. First, you would select the Conditional Element to be AUDIO STREAM NO.

2. Next, you would use the “>=” symbol, which indicates that the “[Conditional
Element is greater than or equal to [Conditional State].”

3. Then, you would type the number “3” to be the Conditional State.

4. At this point, the entire display condition would read:

5. In the “Otherwise Go to Menu” box, select the DVD Menu named NORTH AMERICAN

INTRO MENU. (This DVD Menu needs to be initially created before you establish the
current Display Condition.)

Chapter 7: Working with DVD Menus 7-83

7

6. The Display Condition is now ready: If the end-user is listening to an audio stream
numbered 3 or higher, then this DVD Menu will display; if the end-user is listening
to audio stream 1 or 2, then this DVD Menu will not appear, and in its place, the
end-user will see the “North American Intro Menu.”

Let’s examine the possible variations of Conditional Element, Conditional Relationships,
and Conditional States.

Conditional Element Column

The Conditional Element column allows you to define which element of a DVD Menu,
DVD Movie, or even the entire Project, is evaluated to determine whether or not the
current DVD Menu should be displayed.

The elements include (DVD player system parameters are listed in parentheses):

• Always True — the default condition of the Display Condition feature, where the
DVD Menu is always displayed and where the Display Condition feature is effec-
tively disabled.

• Menu Language (SPRM 0) — this is the language preference setting of the end-user’s
DVD player.

• Audio Language (SPRM 16) — the language of the currently active audio stream, as
defined in the current DVD Movie.

• Subtitle Language (SPRM 18) — the language of the currently active subtitle stream,
as defined in the current DVD Movie.

• Audio Stream No. (SPRM 1) — the number of the currently active audio stream, as
defined in the current DVD Movie.

• Subtitle Stream No. (SPRM 2) — the number of the currently active subtitle stream, as
defined in the current DVD Movie.

• Last Played Movie (SPRM 4) — the number of the most recently played DVD Movie.

• Last Played Chapter (SPRM 7) — the number of the most recently played DVD Movie
chapter.

• Last Selected Button (SPRM 8) — the number of the most recently selected button
highlight.

• Player Region Code (SPRM 20) — the geographical region in which the end-user’s
DVD player was sold.
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• Parental Level (SPRM 13) — the parental viewing level (intended to limit children’s’
access to media), as established by the end-user.

• Video Player Configuration (SPRM 14) — which corresponds to end-user’s DVD-
Video player configuration.

• Audio Player Configuration (SPRM 15) — which corresponds to the audio capabilities
section of end-user’s DVD-Video player configuration.

Conditional Relationship Column

Here, you define the relationship between the element in the Conditional Element column
and the state in the Conditional State column, such as “Audio Stream. . . is equal to. . . 7”.
The possible relationships include:

• & (. . . “bit-wise” and. . .)

• == (. . . is exactly equal to. . .)

• != (. . . is not equal to. . .)

• >= (. . . is greater than or equal to. . . )

• > (. . . is greater than. . .)

• <= (. . . is less than or equal to. . .)

• < (. . . is less than. . .)

Conditional State Column

Here, you define the state of the conditional element — with regard to the conditional
relationship — by typing in a value or a name.

Unlike the Conditional Element or Conditional Relationship columns, this column does
not offer any pull-down choices — unless you select one of the “language” choices (which
will let you pull down to select the language). Instead, you need to type the numeric value
or name that applies (or doesn’t apply) to the conditional element.

So if you wanted to create a display condition such that the current DVD Menu will be
seen if the current subtitle language is set to FRENCH, then you would create a display
condition that looks like this:
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Alternately, if you wanted a display condition such that the current DVD Menu is dis-
played if the subtitle stream number is less than or equal to Audio Stream 2, then you
would create a display condition that looks like this:

In this example, we’re also indicating an Otherwise Go To Menu choice. Here’s how this
option works…

Otherwise Go To Menu

As pictured in the screenshot immediately above, the Otherwise Go To Menu option
indicates which DVD Menu the end-user will see if the display condition is not met
satisfactorily; that is, if the conditional element does agree with the conditional relation-
ship to the conditional state. (The available choices include all DVD Menus currently in
your Project.) In the example shown, if the subtitle stream number is not less than or equal
to Audio Stream 2, then Menu2 will be displayed.

Remember, you can also use the Display Conditions feature of the new DVD Menu that
you “otherwise go to” so that you can daisy-chain the viewing options. However, don’t
forget to set the last DVD Menu in the chain to ALWAYS TRUE to prevent an undesirable
“infinite loop” or a state where nothing ever appears onscreen.

Note: If you set a Display Condition — but don’t set anything in the Otherwise Go To
Menu column — the condition will be ignored when you compile the Project and you will
receive a warning.
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Summary of Working with DVD Menus

DVD Menus are built with a background image, a subpicture, and button highlights areas.
The background and subpicture source files are constructed outside the Spruce authoring
system, typically a graphic program such as Adobe Photoshop, and are then imported into
DVD Menus.

Button highlights, plus their color mapping and navigation attributes, are defined using
various DVD Menu controls. Each button highlight typically connects to a DVD Movie or
another DVD Menu and may also switch the selection of audio, subtitle, or camera angle
streams.

•        •        •

Chapter 8: T

ips for Designing Successful DVD Menus
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Chapter 8
Tips For Designing
Successful DVD Menus

In the previous chapter, we described how to assemble DVD Menus and to use features
such as motion video loops to create dynamic DVD Menus. This chapter will diverge a bit
from the mechanics of using Spruce authoring software to give you some design-related
tips that will help you create graphically attractive and effective DVD Menus.

Of course, graphic design is a large and open-ended subject and modern tools such as
Adobe Photoshop are worlds within themselves. In this chapter we can only suggest some
techniques and ideas for using graphic elements in DVD Menus — and as you’ll find,
experience is your best teacher.

Understanding Color Mapping

Once understood, the process of color mapping is fairly straightforward. However, our
experience has shown that this is one of the hardest parts of DVD authoring for many
people to “get.” For that reason, we’ll take some extra space here to review the concepts of
color mapping, as introduced in Chapter 7, and as we’ll elaborate on further in Chapter 12.

Color mapping is a way of defining the colors for subpicture images and button highlights.
The key point to keep in mind is that no matter what color your source subpicture images
and button highlights are originally, these colors can change when the end-user sees them
onscreen during DVD title playback. How (and, for button highlights, when) these colors
change is something for you to define, using your Spruce authoring software’s color
mapping features. Let’s begin with an overview of how subpictures are “color mapped.”
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Color Mapping & Subpictures
In accordance with the DVD-Video Spec, regardless of whatever their original colors may
have been, subpictures in a DVD title have no inherent “color.” Each subpicture’s color
and opacity (degree of opaqueness) is created by the DVD player at the time of play,
following instructions that are embedded in the disc along with the subpicture image. The
same subpicture graphic could potentially appear many times in a DVD title, each time in
a different set of colors and with different transparency.

To use Spruce terminology, after you import a subpicture into a Project, its original source
colors will be “color mapped” during playback to new “Color Map” colors that you define
during authoring. Furthermore, the DVD-Video Spec says that each individual subpicture
must be color mapped to a maximum of four colors. In other words, even if a source
subpicture contains, say, 256 colors, when the end user sees the subpicture, he or she will
only see a maximum of four Color Map colors.

So how can you use subpicture images with more than four colors? Spruce authoring
software divides the entire color spectrum into four color “ranges” — which we call Color
Map 1, 2, 3, and 4. Then, when you add subpicture image to a DVD Menu, each of its
pixels is mapped to one of the four Color Maps. In turn, the color and opacity of each
Color Map is set using the Subpicture controls in each DVD Menu’s Color Mapping tab.

Note: In Chapter 7 we pointed out that the DVD-Video Spec restricts DVD Menus to a
total of 16 Color Map colors. Only a total of four of these colors may be used for the
subpicture; as we’ll cover in the next section, it’s the button highlights that can be any of a
maximum of 16 colors.

Let’s take a closer look at this process. . .

The Color Mapping Process

In the DVD Menu Color Mapping controls, to the left of the Color Map names, are four
smaller “original” color swatches. Unlike the other user-definable color swatches, the
original color swatches are not adjustable. Rather, they represent which types of colors of
the original subpicture file will be assigned to which of the four Color Maps. 

For instance, when you add a subpicture to a DVD Menu, Spruce authoring software
automatically will assign all blue-colored pixels (plus similar colors, such as royal purple)
to Color Map 3. (This is why the representative original color swatch for Color Map 3 is
blue.) Then, using the color mapping controls for Color Map 3, you can map the “original
state” blue colors to any single color of your choice (from millions of possible colors). In
this way, you can map what was blue in the original subpicture to a new color, such as a
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shade of orange, or grey, or even blue if you like. The point is, whatever colors you choose
for all four of the Color Maps, when you’re done, your newly color-mapped subpicture
image will contain no more than four distinct colors — no matter how many colors it
started with.

So how does Spruce authoring software know which original subpicture color to map to
which Color Map color? It uses the following convention:

• Every pixel that is red in the source subpicture is mapped to Color Map 1.

• Every pixel that is black in the source subpicture is mapped to Color Map 2.

• Every pixel that is blue in the source subpicture is mapped to Color Map 3.

• Every pixel that is white in the source subpicture is mapped to Color Map 4.

What about source subpicture pixels that are neither red, black, blue nor white? As we’ll
learn later in this chapter, orange or yellow pixels, for instance, are all considered “red” and
are mapped to Color Map 1 — and other “in-between” colors are similarly mapped to red,
black, blue, or white. In other words, Spruce authoring software treats every subpicture
image as if it only has four original colors. Therefore, when you create graphics for use as
subpictures in DVDMaestro or DVDConductor, we strongly recommend you create them
using only red, black, blue and white. This way, you’ll always know which portions of your
subpicture image will be mapped to which Color Map, without guessing.

An Example

Let’s consider a typical four-color subpicture image. Although you can’t see the actual
colors on this black and white page, the screenshot on the next page shows an original
subpicture with red-colored text for numerals, each inside a black box with a blue border.
The background portion of this subpicture is white — although don’t confuse that with a
“background image,” the second, separate image we add to DVD Menus in conjunction
with a subpicture.

Note: You can see this example in color. Try it out for yourself in a Project. The example is
located on your DVDMaestro/DVDConductor program disc (or in the Spruce program
directory on your hard drive) in the following locations: “User Documentation/Example
Projects” and “Source Files/RexAndRed/Menuovly2.bmp”.
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Here, we’re viewing the original subpicture only, without the background image (View Layer = SUBPICTURE) — and
before any color mapping takes place (SubPic Mapped = unselected; Button Preview = NONE).

The screenshot below shows what happens when this subpicture is mapped.

Here, we’re viewing the same subpicture, again without the background image (View Layer = SUBPICTURE) — but
this time, showing the effect of the color mapping of the original subpicture (SubPic Mapped = selected; Button
Preview = NONE).
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It will be difficult to appreciate the effect of the color mapping in black and white —
although you can see that the black boxes are no longer black, you may be able to tell that
the numerals in this color-mapped subpicture are fainter than in the original subpicture. In
fact, the original source colors have been defined as follows:

• red has been mapped according to Color Map 1’s “Subpicture” setting — which has
been defined as a yellow color (with an Opacity level of “8”;

• black has been mapped to Color Map 2’s “Subpicture” setting — a pale blue color
(with an Opacity level of “8”);

• blue has been mapped to Color Map 3’s “Subpicture” setting — a red color (with an
Opacity level of “8”);

• and white has been mapped to Color Map 3’s “Subpicture” setting — which in this
case, has actually been set to white (with an Opacity level of “0”); in effect, the
background portion then stays the same, before and after color mapping.

 (These relatively translucent Opacity levels explain why the numerals in this color-
mapped screenshot looks somewhat fainter than the text in the original screenshot, even
on the page in black-and-white.)

Naturally, these colors are only examples — since Spruce authoring software lets you
assign a new color of your choice to any of the Color Maps. For each Color Map you can
use the DVD Menu Color Mapping controls to choose any single color out of a 24-bit
palette of colors. In other words, each of the four Color Map can be any one of millions of
possible colors.

Now that we’ve explained how subpictures are color mapped, let’s take a look at how the
same sort of process applies to button highlights. . .

Color Mapping & Button Highlight Areas
As we introduced in Chapter 7, button highlight areas can have separate color and opacity
settings depending upon their state: unselected (neutral), selected, or actuated. As we’ll
learn, in order for you to define button-state colors in a predictable manner, the portion of
the buttons that changes color needs to be part of a 4-color subpicture image.
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To start with, when you author a disc using Spruce authoring software, the buttons that
end-users see onscreen — the “visible buttons” — are part of the design of the background
image or the subpicture image, or both. These images are created outside of Spruce
authoring software, typically in a dedicated graphics program such as Adobe Illustrator™ or
Adobe Photoshop™ or even Microsoft Paint™. The advantage of creating your visible
buttons in a dedicated graphics program is that you can create visually complex and
interesting buttons — or you can create portions of images, such as the keys of a piano or
the stars in a flag, which will later “double” as buttons.

Note: For a good example of an image that demonstrates basic color mapping and button
highlight areas, locate the file named “Menuovly1.bmp” (you’ll find it inside the
“RexAndRed” folder inside “Sample Projects and Source Files” inside “User Documenta-
tion” on your hard drive or DVDMaestro/DVDConductor program disc). Then import it
into the Assets Bin and add it to a new DVD Menu. (Be sure to select subpicture as the
View Layer option before you add the image so that it will be treated as a subpicture and
not a background.)

Here’s an example of a background image that has been created with “visible” buttons (note that View Layer =
BACKGROUND).

Chapter 8: Tips for Designing Successful DVD Menus 8-9

8In this screenshot, we’re viewing both the background image with its visible buttons and the subpicture. (In order
to see the background image and subpicture together, note that View Layer = BOTH.)

In this example, the only visible evidence of the subpicture is the numeral 3 that sits on top of the lower-left visible
button. We are unable to see numerals 1, 2, and 3 because the Subpicture Opacity slider for source color “red”
(Color Map 1) is set to “0”. However, since the third visible button has been selected (by clicking on it), we can see
its associated Color Map 1 Button Selection color (in this case, a relatively light color with a strong Opacity setting
of “14”). Also note that when you view the background image and subpicture together, the subpicture is always
color mapped. (There’s no way to deselect the SubPic Mapped option.)

Since subpicture and background images are created outside of Spruce authoring software,
they present new challenges of their own. How, for instance, do you get the keys of a
piano or the stars of a flag to functions as buttons? Then, how do you get them to change
color when the user selects or actuates a button?

The solution is multifold:

1. First, as described just above, Spruce authoring software will map each of the
subpicture image’s original colors to one of the four Color Maps. (Remember, the
DVD-Video Spec requires the subpicture image to be a 4-color image; if you use
anything else for the subpicture, Spruce authoring software will use color mapping to
create a 4-color image.)
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2. Next, using the SUBPICTURE column of the Color Mapping Controls, you can assign any
single new color of your choice (from a range of millions of possible colors) to each
of the four Color Maps.

3. Next, you must define what you consider a button to be. This is done in Spruce
authoring software by “highlighting” the visible buttons with an invisible frame.

4. Finally, using the Color Map that matches the visible buttons, you can assign new
colors to your visible button highlights for each of three different states: SUBPICTURE (no
button action), SELECTION (when a button is selected), or ACTION (when a button is
actuated).

Note: For most users and applications, highlighting visible buttons is done using the
subpicture, although it is possible to use the background image. For more information
about buttons, please see Chapter 7.

Now let’s review the four Color Maps. . .

The Color Map controls.

Color Map 1
Color Map 1 is the topmost Color Map in the DVD Menu controls. Next to its label is a
small, non-adjustable, representative color swatch of red. This indicates that any portions
of the original subpicture image which are red are assigned to Color Map 1.

However, red is not the only color assigned to this Color Map: Any portions of the
subpicture which are more than 50% red and less than 50% blue — such as orange,
yellow, or red — are assigned to Color Map 1.

By default, Color Map 1 converts all Color Map 1 portions of the subpicture to black. It
also converts your buttons highlight areas to dark gray (in the Button Selection state) and to
yellow (in the Button Action state). These colors are entirely user-definable.
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Color Map 2
Color Map 2 is the second Color Map in the DVD Menu controls. Next to its label is a
representative color swatch of black. This lets you know that any portions of the subpicture
image which are black are assigned to Color Map 2.

As with Color Map 1 and its representative color of red, with Color Map 2, black is not the
only color assigned to this Color Map: Any portions of the subpicture which are less than
50% red and less than 50% blue — such as a dark gray or black — are assigned to Color
Map 2.

By default, Color Map 2 converts all Color Map 2 portions of the subpicture to blue. It also
converts your buttons highlight areas to light gray (in the Button Selection state) and indigo
(in the Button Action state).

Color Map 3
Color Map 3 is the third Color Map in the DVD Menu controls. Next to its label is a
representative color swatch of blue — letting you know that any portions of the subpicture
image which are blue are assigned to Color Map 3.

As with the other Color Maps and their representative colors, blue is not the only color
assigned to this Color Map: Any portions of the subpicture which are less than 50% red
and more than 50% blue — such as a royal purple or blue — are assigned to Color Map 2.

By default, Color Map 3 converts all Color Map 3 portions of the subpicture to light green.
It also converts your button highlights to turquoise (in the Button Selection state) and dark
green (in the Button Action state). These colors are entirely user-definable.

Color Map 4
Color Map 4 is the final Color Map in the DVD Menu controls. Next to its label is a
representative color swatch of white — which indicates that any portions of the subpicture
image which are white are assigned to Color Map 4.

But just as with the other Color Maps, white is not the only color assigned to this Color
Map: Any portions of the subpicture which are more that 50% red and more than 50%
blue — such as a lavender, pink, off-white, and white (which is all colors combined) —
are assigned to Color Map 4.

By default, Color Map 4 is set to convert all Color Map 4 portions of the subpicture to red.
It will also convert your button highlights to chartreuse pink (in the Button Selection state)
and Burgundy (in the Button Action state). These colors are entirely user-definable.
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Note: Many DVDMaestro and DVDConductor users create subpicture images with white
backgrounds. (We’re referring here to the background portion of the subpicture image and
not a separate background image.) For this reason, Color Map 4’s default Opacity level for
the subpicture is “0” — in other words, by default, a white background area of a
subpicture won’t be visible at all (until you raise the Opacity level).

Creating Successful
Background/Subpicture Combinations

One key to a graphically appealing DVD Menu is the successful combination of the
background and subpicture images. When these are integrated well, you can create DVD
Menus with button highlight areas that are sensible, attractive, and effective. To achieve
this goal, keep the following tips in mind. . .

Using a Graphics Program to Design DVD Menu Graphics
While nearly any graphics application can be used to create backgrounds and subpictures,
Adobe Photoshop is the de facto standard for still image graphics. Indeed, as we described
in Chapter 7, DVDMaestro and DVDConductor work especially well with multi-layer
Photoshop files — where the first layer of the file will automatically be assigned to be the
background image and the second layer will automatically be assigned to be the
subpicture. Whatever program you do use, however, image dimensions can be an impor-
tant consideration.

Image Dimensions 

Computer display screens use square pixels while NTSC/PAL video displays (including
consumer televisions and professional video monitors alike) use variously proportioned
rectangles for pixels. This presents a problem, since graphic images that you design on a
computer display will have somewhat different dimensions when viewed on an NTSC/PAL
video display. For less critical Projects, these discrepancies may not matter; for more
serious titles, however, they may indeed warrant your attention.

Fortunately, there is a solution — a way to create graphics as they will appear on the user’s
video display: Assuming you’re using Photoshop, first you would create the graphics at
one size, then use Photoshop’s Image Size functions to rescale the picture before it is
imported into the Spruce authoring environment. 

The table below shows the Photoshop

picture size and final output size for various combinations of aspect ratio and video standard.
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Aspect Ratio “Working” Dimension “Export” Dimension
NTSC @ 4:3 720 x 540 pixels 720 x 480 pixels
NTSC @ 16:9 720 X 446 pixels 720 x 480 pixels
PAL @ 4:3 720 x 658 pixels 720 x 576 pixels
PAL @ 16:9 720 x 519 pixels 720 x 576 pixels

You can also design at multiples of these dimensions (e.g., 1440 x 1080) and rescale
accordingly before export.

Other Background & Subpicture Design Considerations

DVD Menu background images can be created in many ways — for example by importing
a stock picture or background texture or by creating a new texture using Photoshop Filters.
The background image below was created in a few seconds by applying the Filter
“Clouds” to a flat-color backdrop.

A typical background image, showing a “Clouds” texture that was applied in Photoshop.

Apart from the graphic backdrop, much of your design in the background layer will focus on
the images of visible buttons and the legends associated with them. Very often, beveled effects
may be used to create the image of a physical button (as shown in the next screenshot).
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As you create visible buttons and other background graphic elements, try to keep different
elements on separate Photoshop layers. This will maximize the degree of control you
maintain and make if possible for you to assemble you subpicture graphic simply by
selecting the elements of the background that you want to see highlighted.

Note: As we’ve described, your Spruce authoring software can import 2-layer Photoshop
files directly to serve as the background and subpicture. For now, however, it’s fine to
work on the background image in a multi-layer file, since just below we will describe how
to “collapse” or “flatten” the background and subpicture layers just before export.

Another important tip is to switch off all anti-aliasing functions when creating elements for
the subpicture. (Since you can control the shading of the subpicture once it’s imported into
your Spruce authoring software, anti-aliasing in the source graphic can only create confu-
sion as to which pixel should be assigned to which Color Map.)

Viewing the layers of the background image; these will need to be “flattened” before it can be imported into
DVDMaestro or DVDConductor, as described in the next section.

The figure above shows a multi-layer graphic that includes the main “view” layers that will
become the background image. The layers for the “subpicture” image are separate.
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Preparing for Import

Before a DVD Menu graphic image can be imported into DVDMaestro or DVDConductor,
it must be prepared by:

• resizing the 720 x 540 pixels picture to 720 x 480 (for an NTSC 4:3 aspect ratio;
other sizes apply as in the chart we presented above);

• flattening whatever multiple background and subpicture layers you may have, so that
you end up with just a 2-layer Photoshop file.

To change the picture size, select the Photoshop Image Size function. Switch off the
“Constrain Proportions” functions (that would be opposite of what we want to achieve)
and enter the target proportions, in this case 720 x 480 (DVD standard for NTSC video).
Then click OK.

Resizing the image within Photoshop, to accommodate for the pixel size discrepancy between computer displays
and video displays.

Next, you can flatten the layers of the source picture using “Merge Down” in the
Photoshop Layers palette to create two layers only — with the background image on the
first layer and subpicture image on the second, as shown below:

Note: Before you save the flattened “export” version of your DVD Menu graphics, it is a
very good idea to save the multi-layer source version. That way, you can return to the
same design anytime in the future and make changes or use it as the jumping-off point for
a new DVD Menu design.
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Viewing the layers of the background image; these will need to be flattened before exported for use in
DVDMaestro or DVDConductor, as described in the next section.

When these two coordinated elements are imported into a DVD Menu, the button high-
lights will correspond exactly with the background elements, providing a smooth and
pleasing effect as buttons are selected and actuated.
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The background and subpicture images as they appear in the DVD Menu display area. (Note that for the View
Layer option, BOTH is selected.)

Use Sound

Keep in mind that incorporating sound into a DVD Menu can be an extremely quick and
easy way to enhance its impact, especially if the graphic images are static.

As we described in Chapter 7, you can incorporate audio simply by dragging an encoded
audio file into the DVD Menu’s display area.
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By isolating several seconds of a music elements from the production, you can easily
create an audio loop that will add to the mood of the overall presentation with very little
effort. (Library music, often called “clip tunes,” are an easy, inexpensive source for music,
especially if your Project doesn’t otherwise use music.)

Use Dynamic DVD Menus (‘Motion Menus’)

As we introduced in Chapter 7, turning a static DVD Menu into a dynamic DVD Menu—
by using a video stream in place a static background image — is a popular way to en-
hance its impact. In some DVD versions of feature films, for instance, very elaborate
“motion menus” are used with great success.

Note: Remember, motion effects are created outside of the DVD authoring environment
using “conventional” editing and effects tools. The output of these is then brought into
DVDMaestro or DVDConductor as a standard video file.

When you design dynamic DVD Menus, you’ll need to take both design considerations
and economics into account. In terms of design, remember that you are constrained by the
same factors that apply to still menus, including image pixel size. Furthermore, to be
effective, you’ll want to ensure that the subpicture image meshes well with the background
(motion) elements — and in a moving design, this may be difficult to achieve.

In terms of expense, you’ll want to consider whether the motion menu effects will add
enough to your presentation to warrant the often-considerable cost. However, you may
have access to existing video assets — such as a landscape panorama, for instance — that
could work perfectly well as a dynamic background and mesh well with the subpicture
image, while not costing you anything extra (other than the time to edit the asset into a file
of suitable length).
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Use Transition Sequences

Transition sequences are another way you can enhance the user’s experience of navigating
through your title. These take the viewer from one DVD Menu to another or from a DVD
Menu to a DVD Movie.

Transition sequences are often produced using desktop video tools and may be encoded
using software encoders such as those from Heuris Software. When using transition
sequences, make sure the start and end points of transitions match — something that’s
effectively impossible to achieve with motion video. Consequently, you’ll find that effec-
tive transition sequences connect a still images to another still image or perhaps a still
image to a video stream, if the “jump” from the end of the transition is deemed tolerable.

It’s also important to recognize that all still pictures and motion transitions need to match
perfectly in color and picture scaling. Different MPEG encoders process the picture
differently, so you may find that you have a highly-visible mismatch at a transition point.
For this purpose, it is best to use the same encoder throughout.

Use DVD Menu Groups

At times, you may wish to use a selection or actuation effect that isn’t possible using
ordinary button highlight areas in the subpicture. In these cases, you can opt to create
groups of related DVD Menus that depict different buttons in different states, using more
elaborate graphics effects. When the viewer “selects” a button, for instance, it could trigger
an automatic action that takes them to another DVD Menu (and in turn, an entirely
different “look” for the button).
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The DVD Menu Buttons tab with “Invisible” and “Auto-Action” checked.

Creating such DVD Menu groups can become rather involved, since there will typically be
numerous individual DVD Menus, each of which could represent a different button state.

As we introduced in Chapter 7, in the Buttons tab of the DVD Menu controls, you can
assign a button to be “Auto Action,” meaning that it will be automatically actuated once
selected. (As you’ll recall, button highlight areas can be neutral, selected, or actuated; the
latter is typically what initiates an action, such as taking you to another DVD Menu or
starting a DVD Movie.) If you also make that button “Invisible,” then the viewer will not
see the button highlight area at all, but will only see its target. In this case, it will be a
DVD Menu that looks much the same, but with a special graphic effect that indicates the
button has been selected.

The biggest disadvantage of using groups in this way is that button selection become
markedly slow, since during playback, the DVD player needs to jump to another DVD
Menu. For this reason, you may prefer to avoid groups or use them rarely.

Summary of Tips for
Designing Successful DVD Menus

DVD provides many possibilities for design of pleasing and effective DVD Menu graphics.
This chapter has introduced a few of the possibilities, and suggested techniques for creating
them. Of course, graphic design is a subject of far too great a depth to be covered ad-
equately in this volume, and we suggest you check out some of the many excellent texts
that cover this subject for further study.

•        •        •

Chapter 9: T

itle Navigation: Establishing Connections
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Chapter 9
Title Navigation:
Establishing Connections

Once you’ve created your DVD Movies, DVD Menus, and button highlights, you need to
establish the relationships between them that determine the title’s navigation or “flow of
play.” These relationships are called “connections.”

You can wait to establish connections until you’ve finished creating all of your DVD
Movies and DVD Menus or you can establish connections as you create each elements.
The only requirement is that you complete all intended connections before you compile a
finished title for delivery to client or replication.

What Are Connections?
Connections describe the navigational relationships between navigation “sources” and
“targets.”  For instance, let’s say you want a particular DVD Movie to play when the end-
user actuates button 3 of a DVD Menu named “Production Credits.” To do this, you’ll
need to make a connection between that button and the desired DVD Movie.

One way to do this would be to open the Connections window and to link the source (in
this case, the “Production Credits” button 3) to a target (the desired DVD Movie) by simply
dragging and dropping the listing of the target onto the listing of the source. With Spruce’s
drag-and-drop approach to the Connections window, the technique is straightforward and
the options are plentiful.

Your Spruce authoring software also lets you establish connections directly between DVD
Menu button highlights areas and DVD Movie Chapter Point Markers, as we’ll detail later
in this chapter. For now, however, let’s begin with a more detailed look at the Connections
window.
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Working with The Connections Window

The Connections window is the central “patchbay” for your DVD title — where you link
together your DVD Movies, DVD Menu button highlights areas, Playlists, and Command
Sequences. In one central location, this window provides a master view of the entire
Project’s connections and lets you change any connection.

The Connections window appears in the Workspace of your Spruce authoring software,
where it can be tiled or cascaded with other windows. It cannot be floated outside of the
Workspace or docked like a pane.

The Connections window. The upper-left Sources field lists all the possible navigation sources that can be
connected to any of the possible navigation targets in the lower Targets Bin. Connections are made by dragging
targets from the lower Targets Bin to the upper-right Target field. In this example, we’re viewing some of the
Project’s possible sources and targets. You can resize the Connections window to view more or fewer sources and
targets. As we’ll learn, the Connections window can also be viewed on a per-DVD Movie or per-DVD Menu basis
and the Sources field can be viewed in one of three levels, Advanced, Standard, or Basic.
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Activating the Connections Window
The Connections window needs to be activated — that is, it needs to be open and be the
topmost Workspace window — in order for you to work with it.

To activate the Connections window:

• click the CONNECTIONS button on the Toolbar;

– or –

• select CONNECTIONS from the View pull-down menu;

– or –

• press the key combination ALT-V-C on your keyboard.

– or –

• click on the CONNECTIONS tab at the bottom of the Workspace (assuming you have
enabled the Workbook mode, as described in Chapter 3).

Note: Once the Connections window is open and active, you can also hide it by performing
any of the first three procedures listed above.

The figure below shows the Connections window as it might appear in a very simple Project.
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As we introduced near the start of this chapter, making connections is a matter of linking
navigation sources to targets. To facilitate this, the Connections window has three areas:

• the upper-left Sources field;

• the lower-half Targets Bin;

• and the upper-right Target field.

The Sources Field
The Sources field shows various sources or navigation “starting points.” (As we’ll describe
below, you can select whether you view all possible sources or just certain sources on a
per-Project, per-DVD Movie or per-DVD Menu basis.) It’s within this field that you choose
which source(s) will connect to which target(s). For instance, you could choose as a source
a particular DVD Menu button highlight area and establish a connection so that whenever
the end-user clicks on that button highlight, playback will jump to a particular a target,
such as a DVD Movie Chapter Point Marker. Similarly, you could connect the end of a
DVD Movie (the source) back to a main DVD Menu (the target).

Among the possible sources are:

• “First Play” (the source to use when defining what happens when the end-user first
inserts the disc);

• Title Menu (what the end-user sees when he or she presses TITLE on a remote control);

• the Menu Key Action for each Chapter (what the end-user sees when he or she
presses MENU on a remote control);

• the Chapter End points for each of the Project’s DVD Movies (what happens when
each Chapter ends);

• the Movie End points for each of the Project’s DVD Movies (what happens when
each DVD Movie ends);

• the Timeout for each of the Project’s DVD Menus (what happens when a DVD Menu
has been onscreen for a predefined period of time);

• “GoUp,” “Next,” and “Previous” (which correspond to when the end-user presses the
RETURN, SKIP FORWARD, or SKIP REVERSE keys on a remote control);

• “Subtitle Menu,” “Audio Menu,” “Angle Menu,” and “Chapter Menu” (which corre-
spond to when the end-user presses the SUBTITLE, AUDIO, ANGLE, and CHAPTER menu keys
that are available on some remote controls);
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• all Playlists or Command Sequences; and

• every button for each of the Project’s DVD Menus (what happens when the end-user
actuates the button highlight area).

Note: As detailed below (“Changing the Sources Field View”), your Spruce authoring
software offers three different ways to view the Sources field: Basic, Standard, and Ad-
vanced. Depending upon which view you’ve selected, you will see fewer or more of the
possible sources. You can also view sources “globally” — on a per-Project basis — or on a
per-DVD Movie or per-DVD Menu basis.

We’ll be reviewing these sources in the coming pages. In a typical DVD Project, your
navigation sources will probably include First Play, a selection of DVD Menu buttons,
Movie End, and responses to the Menu or Title remote control key. More complex Projects
may include dozens of sources, such as DVD Menus with multiple buttons; DVD Movies
divided into various chapters; various Playlists; and Command Sequences.

The Targets Bin
The lower area of the Connections window is the Targets Bin, where all of the navigation
targets or “destinations” are stored. The targets are all of the places within your Project that
you can jump to from any possible source.

Possible targets include:

• every Chapter Point Marker for each DVD Movie or Playlist (for instance, to go to the
middle of a particular DVD Movie, your might choose its “Chapter 3” as the target);

• every DVD Menu (Button 1 will be selected as the default, unless you choose another
button highlight area, as described next);

• each of those DVD Menu’s associated button highlight areas (if you choose an
individual button highlight as the target, then it will be highlighted when the viewer
arrives at the targeted DVD Menu);

• a “Resume Play” target (when the viewer has jumped from a DVD Movie to a DVD
Menu by pressing MENU on the remote control, the Resume Play function will resume
playing the DVD Movie at the point at which it left off when the Menu key was
pressed; with most DVD players, the Resume function is activated by pressing the
MENU key again while viewing a DVD Menu); and

• every Command Sequence, if any are used in the Project.
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Note: By default, the Targets Bin always shows all of the Project’s available targets. You can,
however, choose to view selected targets (see “Changing the Targets Bin View,” later in this
chapter).

Establishing Connections in The Target Field
The Target field is the area where you actually establish and manage navigation connec-
tions between sources and targets.

Note: Many connections can also be made without even opening the Connections win-
dow, as we’ll cover later in this chapter (see “Establishing Connections Directly within a
DVD Movie or DVD Menu”).

You can establish connections in whatever order you wish. For instance, you don’t need to
establish the “First Play” connection before you establish any of the other connections.
However, you may find it easier to keep track of your Project if you establish connections
in a logical order and take care not to overlook any needed connections, nor to create
unintended connections.

Let’s review the various ways you can establish and otherwise manage connections in the
Target field. . .

Method 1: Drag-&-Drop 

The most straightforward way to establish connections is to drag the desired target out of
the Targets Bin and to drop it in the Target field next to the desired source.

To establish a connection (drag-and-drop method):

1. Open the Connections window and left-click on the desired element (a DVD Movie,
DVD Menu, or the Project) in the Project Manager.

2. Left-click on the desired target in the lower Targets Bin.

3. Drag the target from the Targets Bin to the upper-right Target field.

4. Release the mouse in the Target field, just to the right of the desired source; the
connection is now established.
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Establishing a connection between the “First Play” source and “Menu1.”

For instance, as shown above, made “Menu1” the target for the First Play source. This
means that when the disc is inserted into the player, the first item to appear onscreen will
be the DVD Menu labeled “Menu1.”

The same Project, with several other connections established.
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By repeating this drag-and-drop method of making connections, we can quickly complete
this very simple title, as shown above. (As we will learn later in this chapter, there are
several alternate ways to make connections besides dragging-and-dropping within the
Connections window.)

You can also use the drag-and-drop method to move connections from one source to
another source. . .

To move a connection: 

1. Left-click on the desired target in the Target field to the right of the source.

2. Drag the target to the right of a new source.

3. Release the mouse to drop the target in the Target field to the right of the new source;
the new connection is now established.

Note: Alternately, if you wish, you can move a connection by left-clicking on the desired target
in the upper-right Target field; then selecting CUT (under the Edit pull-down menu); then left-
clicking to the right of the new source; then selecting PASTE (under the Edit pull-down menu).

Method 2: Right-Clicking in the Target Field

In complex Projects, the number of targets can expand quite a bit. Fortunately, we offer
you an alternative to scrolling down a long list: Simply right-click in the Target field where
you wish to make a connection and a pop-up context menu will provide access to all
possible targets for the current Project.

To establish a connection (right-clicking in the Target field method):

1. Open the Connections window and left-click on the desired element (a DVD Movie,
DVD Menu, or the Project) in the Project Manager.

2. Right-click in the Target field, just to the right of the desired source.

3. A hierarchical pop-up context menu will appear, indicating MOVIES, MENUS, and
COMMAND SEQUENCES. Follow the appropriate path to select the desired target.

4. Once you select the target, its name will appear in the Target field; the connection is
now established.
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Right-clicking in the Target field opens this pop-up menu, where you can establish connections simply by
following whichever path you wish and selecting a target for the corresponding source. (This screenshot shows the
Sources field in its “Advanced” view level, which we’ll describe later in this chapter; see “Changing the Sources
Field View,” below.)

You’ll notice that the hierarchical listing continues out to show individual Chapters of
DVD Movies and Buttons for DVD Menus. As additional items are added to the Project,
the listing expands to show all available targets.

Note: You’ll also notice that the pop-up context menu offer two other choices: RESUME PLAY

and DELETE TARGET. The latter only appears if you’ve right-clicked in a field that already held
a target and is one of two ways to delete an existing target (see “Deleting a Connection,” just
below). The former offers you a quick way to resume play from any appropriate source.

Method 3: Copying a Connection

When you have multiple sources going to one particular target, such as a main DVD
Menu, the most convenient way to make these connections may be to copy the target from
one source to another source. This method is an easy and fast way to give multiple sources
the same destination (rather than having to recreate the connection for each source).

To copy a connection: 

1. While holding the CONTROL key, left-click on the desired target in the Target field to
the right of the source.

2. Drag the target to the right of a new source.

3. Release the mouse to copy and drop the target in the Target field to the right of the
new source; the new connection is now established.
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Copying an existing connection from one source to another.

Note: Alternately, if you wish, you can copy a connection by left-clicking on the desired
target in the upper-right Target field; then selecting COPY (under the Edit pull-down menu);
then left-clicking to the right of the new source; then selecting PASTE (under the Edit pull-
down menu).

Deleting a Connection

There are two ways to delete any connection. . .

To delete a connection: 

1. Highlight the connection by left-clicking on the target (in the upper-right Target field).

2. Press the DELETE key, and the connection will be removed.

– or –

1. Right-click on the target (in the upper-right Target field).

2. When the pop-up context menu appears, select DELETE TARGET and the connection will
be removed.

Default Connections for DVD Movie Chapters
DVDMaestro has two default connections that apply to DVD Movie Chapters. These
defaults streamline process of creating connections and provide seamless Chapter-to-
Chapter connections.
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The defaults include:

• “Automatic” chapter-to-chapter connections — where each chapter plays seamlessly
into the next, without having to establish a connection for each chapter’s End Action.
For instance, as Chapter 1 ends, Chapter 2 begins playing seamlessly. This continues
through all of the chapters, except for the last chapter of a DVD Movie, where you
will need to establish a connection if you want something to occur when the last
chapter of the DVD Movie has finished playing.

Note: Automatic Chapter-to-Chapter connections are not displayed in the Connec-
tions window and take place “behind the scenes” without any further action on your
part. You can override these connections simply by establishing a new connection for
any given Chapter’s End Action state. Also, if you want seamless playback between
successive Chapters, do not establish connections between Chapter End States and
new Chapter Markers — since this may introduce a slight delay between Chapters.

• Duplicate chapter-by-chapter Menu Key connections — where, once you establish a
connection for Chapter 1’s Menu Key state, the same connection will apply to each
successive Chapter’s Menu Key state. For instance, let’s say you establish a connec-
tion between the Chapter 1 Menu Key state and the a DVD Menu entitled “Main
Menu.” Thereafter, the Menu Key state for all following Chapters will also be con-
nected to “Main Menu.” In this way, the end-user will be brought to the “Main
Menu” each time he or she presses MENU on the remote control, regardless of what
Chapter is playing currently.

Note: These duplicate Menu Key connections are not displayed in the Connections
window — they too occur “behind the scenes” as soon as you establish a connection
for Chapter 1’s Menu Key action. You can override these connections simply by
establishing a new connection for any given Chapter’s Menu Key state.

A little later in this chapter, we’ll look at an example of these default connections (see
“Viewing DVD Movie Sources: An Example,” below).
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Viewing Options for the Sources Field

So far, the screenshots in this chapter have shown simple titles with relatively few sources
connections. But in the real world of DVD authoring, the number of navigation sources
can become quite unwieldy. Consequently, it can be helpful to view only particular
groups of sources at one time and some types of connections may not be relevant. Your
Spruce authoring software provides several ways to manage the display of source items.

Viewing the Sources Field by Level (Basic, Standard, &
Advanced)
You can control how few or many of the sources can be seen by designating a level of
detail — Basic, Standard, or Advanced.

To change the detail level of the Sources listing in the Connections window:

1. Right-click anywhere in the Sources field.

2. When the pop-up context menu appears, select SHOW BASIC SOURCES, SHOW STANDARD

SOURCES, or SHOW ADVANCED SOURCES. The Sources field will change accordingly.

Note: By default, the Targets Bin always shows all of the Project’s available targets,
regardless of how you’re viewing the sources — unless you choose to view selected targets
(see “Changing the Targets Bin View,” later in this chapter).
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This screenshot shows sources for a very simple title, as displayed in Basic, Standard, and Advanced views.

In Basic view level, the global settings of First Play and Title Menu are shown, along with
the Menu Key and End Action for each DVD Movie and each of the buttons for each DVD
Menu. (In this example, the title has only one DVD Movie and one DVD Menu; the flow-
of-play for this title also requires a connection to one of the available targets for each of
the sources.)

In the Standard view, the listing has been expanded to show optional individual End Action
and Menu Key links for each Chapter of the DVD Movie. In addition, a Timeout option is
available for Menu1. None of these optional connections is used in this particular example.

In the fully-expanded Advanced view level, each DVD Movie has additional options for
Next and Previous links, as well as dedicated Subtitle, Audio, and Angle Menus. In addi-
tion, each DVD Menu can include a GoUp Link corresponding to the Return key on a
DVD player remote control.

Note: The target for any GoUp Link must be a DVD Menu. You cannot connect a GoUp
Link to a DVD Menu or to a button highlight within a DVD Menu.
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You’ll notice that in this particular example, none of the optional links in the Standard or
Advanced listing are used. By viewing the title in the Basic level, we are able to see all of
the connections used in a very compact and easy-to-follow manner. As the number of
DVD Menus and DVD Movie Chapters increases, using the view levels for Sources can
help you greatly to simplify and organize your title.

Viewing the Sources Field by Item
(per-Project, per-DVD Movie, or per-DVD Menu)
Spruce authoring software also lets you view sources in the Connections window in the
following ways:

• “globally,” by the entire Project — where every possible source is listed;

– or –

• by individual DVD Movie or DVD Menu — where only that DVD Movie’s or DVD
Menu’s sources are listed.

Note: Remember, by default, the Targets Bin always shows all of the Project’s available
targets, regardless of how you’re viewing the sources — unless you choose to view se-
lected targets (see “Changing the Targets Bin View,” below).

So far in this chapter, all of our examples and screenshots have shown the global option,
which is selected as follows. . .

To view all the Project’s possible sources (global view):

1. Left-click on the Project’s icon/name in the Project Manager pane.

2. The upper left-hand column of the Connections window — the Sources field — will
list all of the Project’s sources and the label at the top of the Sources field will read ALL

SOURCES.

To view an individual DVD Movie’s or DVD Menu’s sources only:

1. Left-click once on the DVD Movie’s or DVD Menu’s icon/name in the Project
Manager pane.

2. The upper left-hand column of the Connections window — the Sources field — will
list all of that DVD Movie’s or DVD Menu’s sources. Also, the label of the top of the
Sources field will change to match the name of the selected DVD Movie or DVD
Menu (e.g., MOVIE1, MENU1, etc.)
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Tips for Viewing the Sources Field
Changing your view of the Sources field to a per-DVD Movie or per-DVD Menu basis is a
great way to stay “on top” of all your Project’s various connections, especially if you’re
authoring a relatively complex title. However, for certain connections, you’ll still want a
global view of the Sources field, showing all of the Project’s possible sources.

For instance, consider a relatively simple title with the Connections window showing a
global view of the Sources field (shown using the Standard view option):

By selecting the Project icon in the Project Manager (labeled UNTITLED3 PROJECT), we can view all the Project’s
available sources (notice that the Sources field now reads ALL SOURCES).

The top two sources in the Sources field —

• “First Play” — what happens when the end-user first inserts the disc; and

• Title Menu — what the end-user sees when he or she presses TITLE on a remote
control;

— are very important for your title’s navigational connections. And importantly, the only
time they appear in the Source field is when you view the sources globally on a per-
Project basis.
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Switching Source field views can also be helpful when trying to troubleshoot connection
problems. In some cases, viewing the field on a per-DVD Movie or per –DVD Menu basis
may help you uncover a missing or undesired connection. In other cases, the “big picture”
provided by viewing the sources globally may be what you need to identify the culprit
connection.

Viewing DVD Movie Sources: An Example

Now let’s look at the same title, only this time with the Sources field showing the sources
for the DVD Movie (MOVIE1) using the Standard view option:

By selecting the MOVIE1 icon in the Project Manager, we can view just that DVD Movie’s available sources (the
Sources field now reads MOVIE1).

• the Menu Key for each Chapter — what the end-user sees when he or she presses
MENU on a remote control; and

• the Chapter End points for each of the Project’s DVD Movies — what happens when
each Chapter ends.
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As you can see, we’ve established two connections:

• MENU1 is the target for the Chapter 1 Menu Key — so that if the end user presses the
remote control’s MENU key while the first chapter of the DVD Movie is playing back,
the title’s (only) DVD Menu will appear; and

• MENU1 is also the target for the Chapter 3 End Action — so that when the final
chapter of the DVD Movie finishes playback, the DVD Menu will automatically
appear.

You’ll also notice that there are no connections for the End Action of Chapters 1 and 2 or
for the Menu Key in Chapters 2 and 3. As we described earlier in this chapter (“Default
Connections for DVD Movie Chapters”), these actions have their own “behind the scenes”
default connections:

• automatic chapter-to-chapter connections — where, if no connection is made from
to the End Action of a DVD Movie Chapter, playback automatically continues
seamlessly into the next chapter (a connection still needs to be made for the last
chapter, however); and

• duplicate chapter-by-chapter Menu Key connections — where a Menu Key connec-
tion assigned for the first chapter holds for all succeeding chapters in that DVD
Movie, unless another connection is specified.

In other words — while you can specify different actions at the end of each chapter or in
response to the Menu Key in each Chapter — if all you want is the DVD Movie to play
back linearly with a single DVD Menu assigned throughout, then the two connections
shown are the only ones you would need to establish.
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Viewing DVD Menu Sources: An Example

Here, once again, is the same title — this time showing the sources for the DVD Menu
(MENU1) and again using the Standard view option:

Viewing just the DVD Menu’s available sources by selecting the MENU1 icon in the Project Manager. (Note that the
Sources field now reads MENU1.)

As you can see, the available sources include:

• the Timeout for each of the Project’s DVD Menus — what happens when a DVD
Menu has been onscreen for a predefined period of time (the amount of time is
established in the Playback Control tab of the DVD Menu controls); and

• every button highlight area for each of the Project’s DVD Menus — what happens
when the user actuates the button.

You’ll also notice in this example that we’ve established several connections, so that:

• if the end-user actuates button highlight areas 1, 2 or 3, the DVD Movie will corre-
spondingly begin playback from the beginning of chapters 1, 2 or 3;

• if the end-user actuates button highlight area 4, the DVD Movie will resume playback.
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As you can see in both of the preceding examples, viewing navigational Sources on a per-
DVD Movies or per-DVD Menu basis makes it easy to establish — and, equally importantly,
to keep track of — the numerous connections you’ll establish as you author your DVD title.

Sources Available Using Advanced View Level
In the preceding examples, the Sources field was set for Standard view level, which shows
the following sources:

• First Play;

• Title Menu;

• End Action for each DVD Movie chapter;

• Menu Key for each DVD Movie chapter;

• Timeout for each DVD Menu; and

• each button highlight area in each DVD Menu.

If you choose to view the Sources field in the Advanced view option (as described above,
“Viewing the Sources Field by Level”), then the following additional sources will become
available to you. . .

Previous & Next Links for DVD Movies

For each DVD Movie, choosing the Advanced view option will allow you to establish
connections for the Previous and Next buttons, which correspond to the Skip Forward and
Skip Reverse keys on the DVD player’s remote control. By default, these keys will cause
playback to jump ahead to the next chapter or jump back to the previous chapter.

Unless you make an explicit connection to a Previous or Next link, the Skip Reverse and
Skip Forward keys will have no effect when viewing the first and last chapter respectively.
By making a connection to Previous or Next, you allow the viewer to jump forward or
backward through the current DVD Movie’s chapters.

This is a very desirable function is some instances. However, the DVD-Video Specification
defines this function in such a way that the DVD player will not display play time if either
of these links is used. If you want the play time display to remain visible (which is typically
the case, at least for feature films), then you should not use Previous or Next links when
authoring your title.
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Subtitle, Audio, Angle, & Chapter Menus for DVD Movies

Some (but not all) DVD players provide a function to jump to fixed DVD Menus that are
defined as Subtitle, Audio, Angle, and Chapter, and which correspond to individual keys
on the player’s remote control.

These links can make it convenient for viewers to access DVD Menus that control these
common functions. However, be sure you design your title with other ways to reach these
DVD Menus — since not every remote control will offer these keys.

GoUp Links for DVD Menus

Most DVD players have a Return key for jumping between DVD Menus. Usually this is
used to offer an easy way to return to the top of a hierarchy of nested DVD Menus.

For example, let’s say you have a main DVD Menu labeled “Main Menu,” with a button to
select an individual scene. That button may go to a “Chapter” DVD Menu, whose buttons
might connect to other DVD Menus that list individual scenes. To make it easy to get back
to the main DVD Menu, you can assign Main Menu as the GoUp Link in each of the
“submenus.”

Viewing Options for the Targets Bin

As we noted earlier, by default, the Targets Bin always shows all of the Project’s available
targets. However, if you wish, you can also view the targets in the Targets Bin on a per-
DVD Movie or per-DVD Menu basis.

To change the detail level of the Sources listing in the Connections window:

1. Right-click in the title bar of the Targets Bin.

Note: You must click in the title bar; if you click anywhere else in the Targets Bin, the
context menu will not appear.

2. A pop-up context menu will appear with various options:

° To view all of the Project’s available targets, select SHOW ALL.

° To view the available targets for a particular DVD Movie, follow the path
labeled SHOW MOVIES and select the desired DVD Movie.

° To view the available targets for a particular DVD Menu, follow the path
labeled SHOW MENUS and select the desired DVD Menu.
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3. The contents of the Targets Bin — and the label of it title bar — will change accordingly.

Right-clicking in the Targets Bin title bar lets you view the available targets selectively.

Establishing Connections within a Movie or Menu
As we’ve detailed, the Connections window provides a “master view” with complete
control of all your Project’s connections (and certain connections can be made nowhere
else). However, in some cases you may find it quicker to establish certain connections
directly within a DVD Movie or Menu, without having to resort to the Connections
window. Let’s review these options. . .

End Action & Menu Key Connections (DVD Movies)
From within the DVD Movie, you can establish a connection for both the Menu Key and
End Action.

To establish a connection for the Menu Key (for the entire DVD Movie):

1. In the desired video track, right-click somewhere within the first chapter of the DVD
Movie.

2. When the pop-up context menu appears, select SET MENU KEY.

3. Select the desired target from the hierarchy of available targets.

4. The connection will be set, and will be reflected in the Connections window.
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Establishing a target for the Menu Key for the entire DVD Movie (accomplished by right-clicking within Chapter 1
in the video track).

As you may recall, by default, the Menu Key assigned in the first chapter holds throughout
the DVD Movie, unless you elect to make a different connection in other chapters. Therefore,
to set this connection on just an individual chapter, the first step is slightly different. . .

To establish a connection for the Menu Key (for an individual chapter in the DVD Movie):

1. In the desired video track, right-click somewhere within the desired chapter.

2. When the pop-up context menu appears, select SET MENU KEY.

3. Select the desired target from the hierarchy of available targets.

4. The connection will be set and will be reflected in the Connections window.

Similarly, when establishing a connection for the End Action of the DVD Movie, be careful
that you make the assignment in the last chapter. Otherwise, the DVD Movie’s playback
will be terminated early.
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To establish a connection for the End Action (for the entire DVD Movie):

1. In the desired video track, right-click somewhere in the last Chapter of the Movie

2. When the pop-up context menu appears, select SET END ACTION.

3. Select the desired target from the hierarchy of available targets.

4. The connection will be set, and will be reflected in the Connections window.

Establishing a target for an End Action (in this case, for Chapter 3 only) by right-clicking in the video track.

As with the Menu Key, End Actions for individual chapters (rather than the entire DVD
Movie) can likewise be set by right-clicking within the particular Chapter.

Note: When using the pull-right menus in the DVD Movie to create connections, it is
highly recommended that you use the Connections window to verify that connections you
intended have been created. In case of an error, this can avoid a lot of confusion later on.
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Button Highlight Area Connections (DVD Menus)
In much the same way you can establish connections from within a DVD Movie, you can
establish connections for button highlight areas directly within a DVD Menu.

To establish a connection for a button highlight area in a DVD Menu:

1. In the DVD Menu display area, right-click within the desired button highlight area.

2. When the pop-up context menu appears, select the desired target from the hierarchy
of available targets.

3. The connection will be set, and will be reflected in the Connections window.

Right-clicking will let you establish a target for a button highlight area (in this case, button 1) from within a DVD Menu.

Chapter 9: Title Navigation: Establishing Connections 9-27

9

You can also view each button highlight area’s current target (whether made in the Con-
nections window or in the DVD Menu itself), by simply placing your mouse cursor over
the desired button highlight (in the DVD Menu’s display area) and pausing momentarily. A
ToolTip-style label will appear showing that button highlight area’s currently assigned target.

Note: You can also use the Connections window to verify that connections you intended
have been created. In case of an error, this can avoid a lot of confusion later on.

You can confirm the connection target for any button highlight area simple by placing your mouse cursor over the
button highlight (in the DVD Menu’s display area).

Drag-&-Drop Connections (Between DVD Menu
Chapter Point Markers & DVD Menu Button Highlight Areas)
When both the DVD Movie and DVD Menu are visible in the Workspace, you can con-
nect any button highlight area (the source) to any Chapter Point Marker (the target) —
simply by dragging the button highlight area in the DVDMenu directly onto a Chapter
Point Marker in the DVD Movie.
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Dragging and dropping a button highlight area onto a Chapter Point Marker is an easy way to establish a connection
between the two. The menu above is in “Compact Menu Mode,” which is a preference under the pull-down menu,
File/Preferences/Display. The positioning was achieved by selecting the Window/Tile pull-down menu.

To connect a button highlight area and a Chapter Point Marker using the drag-and-drop method:

1. Configure the corresponding DVD Menu and DVD Movie windows in the Work-
space so that you can view both simultaneously. (Tile view mode, as introduced in
Chapter 4, can facilitate this for you.) The Menu Editor will need to be in “Compact
Menu Mode,” a preference under the File/Preferences/Display pull-down menu.

2. Click-and-hold on the desired button highlight area, then drag it to the Marker icon
of the desired Chapter Point Marker.

3. Release the mouse and the connection will be established.

Note: You can confirm the connection in the Connections window or by placing your
mouse cursor over the desired button highlight (in the DVD Menu’s display area) and
pausing momentarily; a ToolTip-style label will appear showing that button highlight
area’s currently assigned target.
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Which Connections Must be Established Using the Connections Window?

While many connections can be established directly from within a DVD Movie or DVD
Menu, some very important connections can be made only from within the Connections
window itself.

This is because certain sources can only be viewed in the Connections window, including:

• First Play & Title Menu (for the Project).

° As we described earlier, these two sources should be included in every DVD
title. They can be accessed by opening the Connections window and viewing
the Sources field globally by selecting the Project icon at the top of the Project
Manager window. (You can use Basic, Standard, or Advanced view levels).

• Previous and Next Links, plus Subtitle, Audio, Angle, and Chapter Menu.

° These optional connections for DVD Movies are available within the Connec-
tions window when using the Advanced view level.

• Timeout.

° This optional connection for DVD Menus is available in the Connections
window when using either Standard or Advanced view levels.

• GoUp Link.

° This optional connection for DVD Menus is available in the Connections
window only when using Advanced view level.

Using Playlists to Create
Alternate Play Paths for DVD Movies

So far we have described a single set of connections for every DVD Movie, with fixed
destinations for the End Action, Menu Key, etc. While you might “jump into” a DVD
Movie from any number of different sources, you can only “leave” the DVD Movie by
designated connections to specific targets.

Playlists are a way of including a single DVD Movie or any of its chapters or sequences of chapters,
in alternate play paths — without creating a duplicate DVD Movie that would occupy disc space.
You can think of the Playlist as being similar to an “alias” or “shortcut” on a computer.
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Playlist capability is an advanced feature not included with the standard version of DVDCon-
ductor. In order to add this feature, you’ll need to install the DVDPowerPack upgrade.

An Example of Using Playlists
As an example, let’s consider a “demonstration” DVD title that will be used on the floor of
a major trade show. The disc will have several DVD Movies, each of which explains a
separate product. In operation, the disc is intended to be run by a demonstrator who will
select different DVD Movies from a master DVD Menu. At the end of each DVD Movie,
playback will return to the main DVD Menu.

The following screenshot shows the Project Manager and Connections windows for the
Project in this configuration:

The Connections window shows the sources, targets, and connections used in our “demonstration” DVD example.

But what if the demonstrator might not always be present to control the title’s playback? In
this case, it would make sense to have the DVD Menu timeout after a certain period, then
start playing each DVD Movie in sequence as a continuous loop; this way, the unattended
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disc could still be attracting attention and informing passers-by. Then, when the demon-
strator returns, he or she could press the Menu key on the DVD player remote control and
return to the main DVD Menu.

Take a look at the revised Project below, which incorporates this changes:

This revised “demonstration” title demonstrates the use of Playlists.

As you can see, for each of the four “Product” DVD Movies, a Playlist has been created
underneath. This Playlist is an “alias” or “shortcut” to the DVD Movie with its own End
Action and Menu Key action.

Notice that the “Menu1:Timeout” source has been assigned to jump to the Playlist associ-
ated with the “Product 1” DVD Movie. Then at the end of that Playlist, the End Action
jumps to the Playlist of Product 2 and continues to each “Product” DVD Movie to make a
complete loop. The Menu Key for all is assigned to “Menu 1,” providing a way to break
the loop.

Consequently, this disc has two distinct ways to play the same four DVD Movies — either
as individual clips called from the main DVD Menu or as a continuous loop that is entered
automatically if no selection is made from the DVD Menu before an allotted time.
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Playlists as Navigation Objects
As Playlists are defined, they appear in the Connections window as sources and targets. In
effect, each Playlist becomes a new DVD Movie with its own chapter points; in turn, each
chapter in each Playlist has it own Menu Key Action and End Action.

When establishing connections for your Project, you can connect freely to and from
Playlists and their associated chapters.

Playlists and the chapters within them appears as source and destination items in the Connections window.

We encourage you to try working with Playlists; you’ll find they provide a powerful means
to author “multi-story” and alternate-version presentations.
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The Navigation Simulator

Just as the RealView Previewer lets you check how individual DVD Movies look and
sound, the Navigation Simulator lets you review all of your Project’s connections — by
simulating what the end-user will experience as he or she navigates through your title’s
DVD Menus and views the title’s DVD Movie contents.

The Navigation Simulator is a kind of Project “interpreter” that lets you simulate your final,
replicated disc, without having to compile your Project first. Using onscreen controls that
duplicate the controls on a typical remote, you can:

• call up and navigate DVD Menus;

• select button highlight areas;

• watch (and listen to) DVD Movies;

• and test all the connections you’ve established to DVD Movies and other targets.

In this way, you can step through your Project to ensure that the buttons behave in the
manner you expect; that selecting buttons takes you to the desired screens; that colors
change as expected; and so forth.

Testing your Project with the Navigation Simulator is a vital procedure before compiling or
creating a Disc Image or writing to DVD-R or DLT tape. It is at this stage that you have the
opportunity to identify and correct any connection errors or other problems in your title
without the time and cost it takes to re-compile or re-write to DVD-R or DLT.
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The Navigation Simulator.

To open the Navigation Simulator:

• Select the Tools pull-down menu and choose NAVIGATION SIMULATOR.

– or –

• Click the NAVIGATION SIMULATOR button on the Toolbar.

– or –

• Select the key combination ALT - S on your keyboard.

Chapter 9: Title Navigation: Establishing Connections 9-35

9

The Navigation Simulator floats on top of the Spruce authoring application. There’s no
way to dock the Navigation Simulator or to float it in the Workspace.

When the Navigation Simulator opens, it immediately starts playing the target designated
as the First Play item in the Connections window. If there is no First Play item defined,
playback will begin from the first DVD Movie.

Along the bottom portion of the Navigation Simulator, you’ll notice a set of controls and
indicators that replicate the major functions of a DVD player’s remote control. Let’s take a
look at these navigation controls and how they operate. . .

Navigation Controls
The controls in the lower-left section of the Navigation Simulator provide all of the control
functions needed for DVD navigation.

Movie Navigation

These controls duplicate the Next Chapter, Previous Chapter, and Menu keys found on all
DVD player remote controls.

The top button in the group initially reads ROOT MENU, corresponding to the “Menu” key
found on virtually all DVD player remote controls. If your Project includes connections for
Chapter, Audio, Subtitle, or Angle menus, then these options can be selected by using the
small up/down arrow buttons to the right. When viewing a DVD Menu, this button
switches to read RESUME PLAY, allowing you to return to the exact location in the DVD
Movie from which the DVD Menu was called. This emulates the operation of the Menu
key on most DVD player remotes.

The Skip buttons (“<<” and “>>”) underneath the Root Menu button simulate the function
of the Skip Forward and Skip Reverse keys on most DVD player remotes. While viewing a
DVD Movie with chapters, these keys will skip ahead to the next chapter in sequence or
back to the previous chapter. Also, if you have established Next or Previous links for your
DVD Movie, these buttons will execute these links from the first and last chapter of the
DVD Movie.



DVDMaestro User’s Guide9-36

The outer Skip buttons (“|<<” and “>>|”) are used to jump directly to the beginning or end
of the current DVD Movie, immediately executing the End Action for the entire DVD
Movie. This does not correspond to any standard function of a DVD player’s remote, but is
a convenience when simulating lengthy titles as you can test the navigation connections at
the end of the DVD Movie without having to watch a substantial portion of video.

Menu Navigation

This group of controls replicates the function of the button selection keys on a standard
DVD player’s remote. The “Up-Down-Left-Right” arrow buttons provide on-screen naviga-
tion between button highlight areas. (The arrow keys on your keyboard provide the same
function as these and are often faster to use.)

The Enter button will actuate the currently selected button highlight area, executing
whatever connection you assigned. (The Enter key on your keyboard performs the same
function.)

Note: If you wish, you can select and actuate any button highlight area in a DVD Menu by
clicking on directly it with your mouse in the display area. However, doing so bypasses
whatever connections you’ve made between button highlight areas, and if there is a
navigation error, it won’t be apparent.

The Return button executes the “GoUp Link,” if any, that you assigned to the current DVD
Menu in the Connections window. This is the same function as the Menu key on most
DVD player remotes.
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Stream Selection

These pull-down fields let you select which Audio, Subtitle, or Angle (video) track will
serve as the active stream for the current DVD Movie. You can also defeat this ability by
deselecting the ON checkbox.

With the Navigation Simulator, you will notice that any stream change, as well as any
jumps that are executed, markedly interrupt playback. For instance, you may notice a
pause of a second or more when changing audio streams, whereas on a DVD player this
operation is nearly instantaneous.

Note: This happens because the Navigation Simulator is invoked before streams are
multiplexed — working directly from elementary streams on the hard disc, multiplexing
them in real-time to feed the DVD decoder card. Consequently, when you change streams
or execute a jump, the Navigation Simulator must “pre-load” its buffer with data from the
new location or stream before it can continue to play — and this is why you see breaks in
play in simulation. Otherwise, you’ll find that the Navigation Simulator offers very accu-
rate playback and can be used to verify your title’s navigational integrity with a high
degree of confidence.

First Play

Clicking this button takes you to the initial state that end-users will experience when they
first load your final, replicated disc into their players. Please keep in mind that the Naviga-
tion Simulator always starts at the First Play point. (If there is no First Play item defined,
playback will begin from the first DVD Movie.)



DVDMaestro User’s Guide9-38

Clicking FIRST PLAY is useful whenever you want to “reset” the Navigation Simulator back to
the beginning of your title.

Title

The Title button will execute the Title Menu link, if any, as defined in the Connections
window.

Exit

Clicking this button exits the Navigation Simulator and returns you to the last state of your
Project.

State Info

This screenshot shows the State Info for a DVD Movie; for a DVD Menu, the fields are somewhat different, as
described just below.

As you move through the Project using the Navigation Simulator, this section provides you
with the information you need to know where you are at any given time. This information
is different depending upon whether the Navigation Simulator is presently “playing back”
a DVD Menu or a DVD Movie.

For DVD Movies, the fields provide the following information:

• the DVD Movie name (MOVIE);

• the current Chapter number (CHAPTER);

• the Menu key action (KEY ACTION);

• and the End Action (END ACTION).
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For DVD Menus, the fields provide the following information:

• the DVD Menu name (MENU);

• the Time Out information (MENU TIME OUT), showing how long the timeout period is
and the timeout target (if applicable);

• the current button number (BUTTON);

• and the target for the button as defined in the Connections window (BUTTON TARGET).

Displaying System Parameters and General Parameters
At lower-right of the Navigation Simulator controls is a button that reads SHOW ADVANCED>>.

By clicking this button, the Navigation Simulator will expand to show the current state of
the internal memories and registers that are used to control the DVD Player.

The Navigation Simulator, after clicking the SHOW ADVANCED button.
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These parameters are divided into two major groups. The System Parameters are internal
registers of the DVD player that show its complete state at any moment. This set of param-
eters is standardized by the DVD-Video Specification.

The System Parameters and General Parameters sections.

General Parameters are multi-purpose memories that you can apply using Command
Sequences, as detailed in Chapter 14 of this User’s Guide.

The register display functions of the Navigation Simulator are used primarily in the debug-
ging of interactive Command Sequences. The use of these displays are also discussed
extensively in Chapter 14.

To return the Navigation Simulator to its normal view, click HIDE ADVANCED.
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Summary

As we learned in this chapter, your Spruce authoring software provides:

• a simple and comprehensive Connections window to manage all navigation func-
tions;

• numerous methods for establishing and checking navigational connections;

• Playlists that make it possible to navigate through the same material by a variety of
paths;

• and a comprehensive and accurate Navigation Simulator to verify your title’s flow of
play at every step in the authoring process.

Once you have made your connections and verified them carefully using the Navigation
Simulator and the Connections window, your Project is ready for to be compiled, emu-
lated, and written to DVD-R or DLT tape for mass replication. These final steps are de-
scribed in the next chapter.

•        •        •
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Chapter 10: Preparing Your Project for Replication
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Chapter 10
Preparing Your Project for Replication
(Premastering)

Once you’ve created your DVD Movies and DVD Menus, have established your connec-
tions, and have used the RealView Previewer and Navigation Simulator to check that your
Project is working as it should, you’re ready prepare your Project for replication, a process
often known as “premastering.”

To do so, you’ll perform the following tasks:

1. Set certain Project Properties, as necessary.

2. Compile the Project using the Compile tool.

3. Emulate and review the compiled Project carefully using DVDPlayer, your Spruce
authoring software’s built-in playback emulation utility.

4. Create a Disc Image on a DVD-Recordable (DVD-R) disc or Digital Linear Tape
(DLT). Just beforehand, you’ll also need to set several other Project Properties related
to the Disc Image and to replication.

Note: As we’ll detail later in this chapter, certain users who are creating reordered hybrid
DVD-Video/DVD-ROM discs will need to use the Disc Image Creation tool to create a
Disc Image of the Project on a hard drive — before writing to tape or DVD-R.

When it comes to creating the Disc Image, often a DVD-R is made first and used for final
review, after which the final Disc image is written to DLT, which will then be ready to
send to a mastering/replication facility for disc replication. Depending on the results of
review by emulation and DVD-R, you may need to repeat one or more of these steps
before “signing off” your Project for replication.
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Setting Project Properties
(Prior to Compiling)

Note: As you prepare your title for replication, some of the parameters available in the
General, Disc Image, and Replication tabs of the Project Properties dialog need to be set
before you compile the Project; others can be set after you compile, but before you create
the Disc Image. Right now, let’s consider the former.

We first opened the Project Properties dialog briefly in Chapter 4, where we set the TV
System properties (NTSC/PAL video selection). Before compiling your Project, you may
need to set additional attributes of the Project that affect playback and mastering. (As we’ll
learn later in this chapter, you can set certain other properties after compilation, but before
creating a Disc Image.)

To open the Project Properties dialog:

1. Right-click on the Project icon in the Project Manager window.

2. From the pop-up context menu, select PROPERTIES.

The Project Properties dialog consists of three tabs of different parameters: General, Disc
Image, and Replication.
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Project Properties: General Tab

DVDMaestro’s General Properties dialog.

DVDConductor uses a simplified version of the Project Properties dialog. The additional
features supported by DVDMaestro’s Project Properties dialog may be added to DVDCon-
ductor by installing the DVDMaestro upgrade.
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The Project Properties dialog, as found in the standard version of DVDConductor.

Setting Parental Level

Parental Level is not supported in the standard version of DVDConductor. It may be
added by installing the DVDMaestro upgrade.

The Parental Level field.

In authoring, you have the option of defining the Parental Level rating, which can be used
to establish a content rating or “parental permissions level” for the title.

When your final, replicated disc is inserted into a DVD player, the player will check the
disc’s Parental Level rating against its own current, password-protected setting. If the
Parental Level of the disc exceeds the permissible rating — for example, if the DVD player
is set to allow “G”-rated titles and an “R”-rated disc is inserted — the player will refuse to
play the disc. If you do not change this selection, it will set to the default (“G”). If you
select NOT RATED from the pull-down field, the Parental Level will default to “G.”
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Setting the TV System (NTSC/PAL) Properties

As we described in Chapter 4, the TV System setting is done before you begin work on the
Project; if the setting does not match the assets used, your Spruce authoring software will
inform you and set it properly. At this stage, there should be no need to change this setting.

Initial Stream Settings for Project

If desired, you can set which, if any, of the video (angle), audio, or subtitle tracks will serve
as the initial active stream(s) for the current Project. This will override any of the DVD
player’s settings and will forcibly select the designated track as the initial active stream
during playback.

The Initial Stream settings.

To access the Initial Stream settings:

1. Open the Project Properties dialog by right-clicking on the Project icon in the Project
Manager (the top icon in Tree view), then selecting PROPERTIES. The Project Properties
dialog will appear with the General tab already selected.

2. To force an audio, subtitle, or video (angle) track to serve as an initial active stream,
click its corresponding checkbox and then select the desired track from the pull-
down field.

3. Click OK and your selection will be set.

DirectShow 5.0 Compatibility

Microsoft’s DirectShow application can be used to view DVD titles on a Windows-
equipped PC. However, some early versions of DirectShow implement DVD system
parameters in such a way that some titles may not play. (For those interested in such
matters, the specific limitation was in the handling of button highlighting information,
which is stored in the system parameter called “SPRM8.” This information was not always
stored correctly in DirectShow versions prior to 6.0.)
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To overcome this problem, Spruce authoring software adds a checkbox labeled DIRECTSHOW

5.0 COMPATIBILITY in the Project Properties dialog. Selecting this option will change the
compilation of titles in such a way that they’re guaranteed to play in early versions of
DirectShow. The trade-off for selecting this option is that menu navigation on other
playback platforms, such as stand-alone DVD players, may be slower.

Note: The version of DirectShow current as of this writing, DirectShow 6.5, does not
exhibit this problem — and fortunately, with time the number of people using earlier
versions of DirectShow software is diminishing. Spruce does not recommend using the
DirectShow 5.0 Compatibility setting unless you are specifically concerned with full
compatibility with all versions of DirectShow.

The DirectShow 5.0 Compatibility checkbox.

To ensure your title’s playback compatibility with DirectShow 5.0:

1. Open the Project Properties dialog by right-clicking on the Project icon in the Project
Manager (the top icon in Tree view), then selecting PROPERTIES. The Project Properties
dialog will appear with the General tab already selected.

2. Select the DIRECTSHOW 5.0 COMPATIBILITY checkbox.

3. Click OK and your selection will be set.

Note: If you have selected DirectShow 5.0 compatibility, please be aware that the final,
replicated disc may behave much more slowly when played back on a set-top DVD
player; for instance, it may take longer to access Chapters or to bring up DVD Menus. This
is because more DVD “Program Chains” (PGCs) are created for DirectShow compatibility,
— and these PGCs must be negotiated by the player during navigation, resulting in slower
performance.
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Embed Project Text Data into DVD Image

Embed Project Text Data is not available in the standard version of DVDConductor. It
may be added by installing the DVDMaestro upgrade.

Generally, the names you assign to DVD Movies (by renaming DVD Movie icons in the
Project Manager, as described in Chapter 6) are for your use only.

By checking this box, names that you assign DVD Movies will appear as Title names on those DVD players that
offer the feature.

However, if you select the option EMBED PROJECT TEXT DATA IN DVD IMAGE in the General tab of
the Project Properties dialog, then the names you assign DVD Movies will also appear as
Title names on DVD players that are equipped to support the Text Display extensions of
the DVD-Video Specification (version 1.1). Of course, if you choose this option, be sure to
take extra care in spelling and phrasing each DVD Movie’s name.

Note: By checking this box, some set-top players will display the name of your movie
menu and chapters on the LED display on the front of the player. Others, such as software
DVD players, will display the information in the application itself.

Project Properties: Disc Image Tab 
Note: This tab offers several parameters, but at this stage of authoring — just before you
compile the Project — the only parameters that you need to consider are those related to
Macrovision APS copy protection. All other Disc Image parameters will be set later, just
before you create the Disc Image (see “Setting Disc Image Properties [Prior to Creating a
Disc Image]”).
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The Disc Image tab of the Project Properties.

Macrovision APS

Macrovision APS is not available in the standard version of DVDConductor. It may be
added by installing the DVDMaestro upgrade.
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If your Project is to be coded for Macrovision APS copy protection, then the flags for this
function must be set in the Project Properties dialog before compiling. Macrovision Analog
Protection System (APS) is a type of analog copy protection, which alters the video signal
in such a way as to discourage end-users from making copies of your DVD-Video disc
onto their home video cassette recorders. For more important information regarding
Macrovision APS, please refer to Appendix B of this User’s Guide.

To set your Project to use Macrovision APS:

1. Open the Project Properties dialog by right-clicking on the Project icon in the Project
Manager, then, when the context menu appears, select PROPERTIES.

2. The Project Properties dialog will appear; select the Disc Image tab.

Note: As we’ll learn later in this chapter, it’s possible to open the Disc Image section
of the Project Properties by clicking the PROPERTIES button in the Disc Image Creation
tool — but if you do so, you will not be able to access the Macrovision APS settings.
To change the Macrovision APS settings, you must open the Disc Image tab of the
Project Properties dialog via the Project Manager — as described in steps 1 and 2.

3. In the Copyright Management Information section, select the second radio button
from the top, labeled MATERIAL IS COPYRIGHTED…

4. In the Copy Generation Management Systems section, select the radio button labeled
NO COPY PERMITTED.

5. In the Macrovision APS section, select TYPE 1, TYPE 2, or TYPE 3 (as detailed in Appen-
dix B of this User’s Guide).

When you select Macrovision APS, you will be presented with a message informing you of
your obligation to enter into a licensing agreement with Macrovision Corporation, who are
the owners of this technology.

Note: It is important that you execute agreements with Macrovision Corporation before
replication discs that use Macrovision APS copy protection. Again, please refer to Appen-
dix B for the details.
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Project Properties: Replication Tab
Note: At this stage of authoring — just before you compile the Project — the only param-
eters that you need to consider in the Replication Tab are those related to Regional Man-
agement Information. All other parameters in this tab will be set later, just before you
create the Disc Image (see “Setting Replication Properties [Prior to Creating a Disc Image]”).

Regional Management Information

Regional Management is not available in the standard version of DVDConductor. It may
be added by installing the DVDMaestro upgrade.

The DVD-Video Specification calls for end-user DVD-Video players to be geographically
regionalized. For instance, a DVD-Video player sold in India has an internal code identify-
ing it as a “Region 5” player; a DVD-Video player sold in Luxembourg has an internal
code identifying it as a “Region 2” player.

The purpose of this is so that discs can be tagged to play back only in authorized regions.
In this way, disc publishers aim to maintain greater control over the global distribution of
their products. For instance, in order to allow someone in Luxembourg to play your final,
replicated DVD-Video disc, you would need to tag the disc to allow playback in Region 2.

If your Project is to be coded with Regional Management Information, then you will need
to access the Replication section of the Project Properties before compiling.
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The Replication Properties dialog, showing its options.

In the Regional Management Information section of the Replication Properties dialog, you
can select which region or regions you wish to authorize for playback of your final repli-
cated disc. If you enable all six regions (a checkmark indicates that a region is enabled),
end-users will be able to play back your disc in any part of the world. To restrict regions,
simply uncheck them as desired.
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Note: As we’ll detail below, although you should set the Regional Management Informa-
tion settings prior to compiling, you can confirm these settings later, when you set the
Project Properties prior to creating a Disc Image.

Compiling the Project

During compilation, your Spruce authoring software assembles all of the current Project’s
information — including DVD Menus, DVD Movies, whatever connections you’ve estab-
lished, the assets, the language selections, and so forth. In the process, audio, video, and
graphic information are multiplexed into composite data streams and navigation informa-
tion is compiled into DVD-compliant form.

Compilation is performed using your Spruce authoring software’s Compile tool.

To compile your DVD Project using the Compile tool: 

1. Select the Tools pull-down menu and choose COMPILE.

– or –

Click the COMPILE Button on the Toolbar. 

– or –

Use the key combination ALT - C from the keyboard
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2. The Directory Selection dialog will appear. Here, you can either type top-level
directory (disk volume) for one of your hard drives (e.g., “D:\”) or the directory
(folder) name where you wish to save your compiled Project. You can also click on
the “...” button to find a desired top-level disk volume or directory. Click OK once
you’ve located it.

Note: We recommend that you compile your Project to the top level of a hard drive
volume. This is because the emulator program (DVDPlayer) always plays from the
top-level directory.

3. When you’ve chosen the desired folder, simply click OK in the Directory Selection
dialog. At this point, if you haven’t saved the Project since the last modifications, a
new dialog will appear, prompting you to save the Project before you continue.

4. Once you select ok in the Directory Selection dialog, your Project will begin compil-
ing automatically and will create “Audio_ts” and “Video_ts” folders in the selected
directory. A running, real-time “play-by-play” of your Spruce authoring software’s
activities will begin to stream in the Output Log pane, showing you what the pro-
gram is doing at any given time.
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5. When compilation is complete, the Output Log displays the message: “DVD Build
Successfully Completed.”

Note: When you compile your Project, Spruce authoring software writes an information
file labeled “.LAY” in the Video_ts folder. This file is a “snapshot” of your Project Proper-
ties, which will be used when you establish your Disc Image Properties. The reason for the
.LAY file, incidentally, is so that you can create a Disc Image based upon compiled files,
without having to re-open or recreate the original Project.

To cancel compiling:

• Click again on the COMPILE button on the Toolbar.

Once Spruce authoring software has successfully compiled your Project, the last line in the
Output Log will read DVD BUILD SUCCESSFULLY COMPLETED and a Compiler Message dialog will
appear onscreen letting you know that the compilation was successful, as shown below:

The Compiler Message, delivering the good news in the Status field: COMPIILE SUCCESSFUL.
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If the compilation failed for any reason or if you canceled the compilation, you’ll also be
notified. Furthermore, it is possible to compile your Project successfully, yet still have
potential problems. For instance, you might not have defined the connections for some of
the buttons in your DVD Menus, yet it’s still possible to compile the Project — although
you will receive notices in both the Output Log and in the dialog that appears once
compilation is complete.

Note: If you choose (at any time after you’ve originally compiled the Project) to fix some or
all of the problems that were identified during the compilation — or if at any time you
change any of the DVD Movies, DVD Menus, connections, or other aspects of the Project
— you will need to re-compile the Project before you can proceed with creating a Disc Image.

Viewing the DVD File Structure

Now that your single-DVD Movie Project is compiled, you might (optionally) wish to have
a look at the compiled Project in the Windows Explorer. Whenever you compile a Project,
your Spruce authoring software creates several new directories (folders) and files.

Viewing the contents of the Video_ts folder.
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One of the new directories is the “Video_ts” folder — which contains video and other data
pertinent to the compiled Project. It is always named Video_ts because this is defined in
the DVD-Video Specification. (If it were not so named, the resulting disc would not be a
valid DVD-Video disc!)

To view the DVD File Structure (Video_ts):

1. Open Windows Explorer. You can open a new Explorer window by right-clicking on
the Windows Start button at lower-left of the screen and selecting EXPLORE.

2. Using Windows Explorer, navigate to the disk volume you selected as the target
directory for compilation.

3. In this target directory, you will find a directory labeled VIDEO_TS. Open this directory
so that its contents can be seen in the right-hand portion of the Windows Explorer.

Inside the Video_ts directory you will find a series of files as shown above. You’ll find a
very similar selection of files in every title you compile or, for that matter, on any DVD-
Video disc on the market! Let’s take a look at the files found here.

The first file shown, [PROJECT NAME].LAY is the only file in this group that is not incorporated
in the final DVD Disc Image. It is an information file that Spruce authoring software uses to
store mastering information (such as copy protection settings, etc.).

Next in order, you will see a group of files labeled:

• VIDEO_TS.BUP

• VIDEO_TS.IFO

• VIDEO_TS.VOB

These are found on every DVD-Video disc and constitute what is known in the DVD-
Video Specification as the “Video Manager” group. They contain much of the navigation
information for the title.
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Following the Video Manager group, you’ll see a group of four files labeled:

• VTS_01_0.BUP

• VTS_01_0.IFO

• VTS_01_0.VOB

• VTS_01_1.VOB

Every DVD Movie in a DVD title will produce a corresponding group of four (or more)
files with similar names. If there were a second DVD Movie in this title, its files would be
named VTS_02_X.XXX, and so on.

The “.bup” and “.ifo” files in this group consist of navigational information, while the file
VTS_01_0.VOB would contain DVD Menu information (if there were any, which in this case
there is not). Notice that the file VTS_01_1.VOB is significantly larger than any of the other
files. This is the actual DVD Movie data, consisting of MPEG video, AC-3 (or other) audio,
and subtitle data multiplexed together into a single data stream.

Emulating the Title with DVDPlayer 

Once you’ve compiled the Project — and before creating a Disc Image — it’s time to test
your Project by running DVDPlayer, Spruce authoring software’s built-in emulation tool.

The DVDPlayer Application
Using the same decoder hardware used for real-time preview and simulation, DVDPlayer is an
actual DVD player that runs on the computer and is very useful for quality assurance.
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DVDPlayer’s Navigator Control, shown with its associated Video window.

DVDPlayer plays back compiled DVDMaestro Projects directly from the hard drive as if
they were final, replicated DVD-Video discs. (The DVDPlayer also lets you play DVD-
Video discs from the built-in DVD-ROM drive.) Because DVDPlayer operates like a stand-
alone DVD player, you can test the integrity of your Project, to ensure that all connections,
DVD Movies, DVD Menus, and other elements behave are operating as expected. All in
all, there’s no faster nor convenient way to test your Project.

Note: DVDPlayer is a product of Multimedia Solutions, Inc., and is provided for DVDMae-
stro users as a convenience. Spruce Technologies Inc. is not responsible for the develop-
ment of this program nor its technical support; nor is Spruce Technologies responsible in
any way for problems that may arise from its use; nor can Spruce Technologies guarantee
that successful Project playback using the DVDPlayer is an assurance of successful title
playback once the Project is written to tape and replicated to disc.
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Starting DVDPlayer
When you launch DVDPlayer, it looks for a compiled DVD directory (Video_ts) structure
at the root (top) level of a hard disk or DVD-ROM drive. Therefore, prior to starting
DVDPlayer, make sure that the compiled Video_ts directory for the Project you want to
emulate is at the topmost level of its associated disk drive.

 

Selecting DVDPlayer.

To start DVDPlayer and begin emulation:

1. Make sure the Video_ts directory of your Project is placed at the top level of the disk
volume. Note the drive letter (C:, D:, E:, etc.)

2. Click-hold on the Windows Start menu.

3. From the pop-up menu, select DVDPLAYER.

4. This will launch the DVDPlayer utility. The compiled Project on the topmost hard
drive will then begin to play in DVDPlayer’s Video window (and on an NTSC or PAL
video monitor if one is connected to the back of the Spruce decoder card).

Note: If you compile your title to drive D, for example, and there is a Video_ts folder on
drive C, the title on drive C will play. This is because the DVD player looks at the root of
the topmost hard drive first, scans for a Video_ts directory, and if it finds one, plays it.
Otherwise, it will move its way down to drive D, E, F, and so on. If your title is not play-
ing, look in Windows Explorer to see if there is another Video_ts on a higher drive other
than the one you wish to play. Simply changing the name of the Video_ts  directory (e.g.
Video_ts 1) or moving it inside another folder will prevent the DVD player from playing
that particular title.
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Operating DVDPlayer
DVDPlayer looks and operates much like a remote control for a consumer-style, stand-
alone DVD player. To access the DVDPlayer controls, move the cursor into the Video
window viewing area and right-click with the mouse. A pop-up context menu with the
following choices will appear. By highlighting and clicking the left mouse button (or using
the keyboard shortcut), you may choose one of the following context menu items. . .

 

Right-clicking in the Video window will display these context menu items.

Navigator Control [CTRL-N]

This displays a window with standard-looking VCR-style controls, plus directional arrows
which can help you navigate through the Project’s DVD Menus.

The Navigator Control offers a comprehensive set of playback functions.
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The four buttons on the bottom row are Open Volume control; Open Audio Stream control;
Open Subtitle control; and Open Angle control We’ve included these, as well as the other
Navigation commands and menus, with their respective keyboard shortcuts below:

[ I ] Time Elapsed/Time Remaining
[ G ] Bit rate Meter ON/OFF
[ E ] Eject
[ R ] Root Menu
[ T ] Title Menu
[ P ] Pause/Cont.
[ F ] Forward/Cont.
[ M ] Mute
[ B ] Reverse/Cont.
[ S ] Stop All
[ CTRL-P ] Panel Control
[ CTRL-U ] Numerical keypad ON/OFF
[ CTRL-T ] Time Search ON/OFF
[ CTRL-G ] Angle Control
[ CTRL-F ] Full Screen w/remote
[ CTRL-D ] Disk Database
[ CTRL-S ] Settings Menu
[ CTRL-A ] Chapter/Title Search
[ CTRL-M ] Mini Control
[ CTRL-N ] Navigation Control
[ CTRL-V ] VCR Control
[ CTRL-C ] Full Window - No Remote
[ ENTER ] Enter, in menus
[ PAGE UP ] Previous Chapter
[ PAGE DOWN ] Next Chapter
[ HOME ] Restart Chapter
[ SPACE ] Stop/Cont.

[ < > ] Arrows, Menu Navigator

Panel Control [CTRL-P]

This control is only available from within the full-screen mode. It is similar to the Naviga-
tion Control, and allows full navigation, while taking up a minimum of on-screen space.

The Panel Control uses less on-screen real estate than the Navigator Control, but offers complete navigation features.
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VCR Control [CTRL-V]

This is like a miniature version of the Navigator control, offering a reduced number of controls.

The VCR Control covers the most common playback functions.

Mini Control [CTRL-M]

This will bring up a small window with basic DVD controls: an Eject button; an LED
display; and a Pause/Play button.

The Mini Control offers only basic playback functions.

The LED-type display indicates the current playing position of the DVD title in
Hours:Minutes:Seconds.

Angle Control [CTRL-G]

This will change the viewing angle (video track) to any that is supported by the current
DVD title (e.g., scanning of the screen for IMAX movies).
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The Angle Control.

Time Search Control [CTRL-T]

This allows you to run the title from a specific point based upon total time. The slider can
be dragged to any position in the program.

The Time Search control lets you begin playback from any point in time.

Numerical Keypad [CTRL-U]

This window allows you to enter numerical values for DVD navigation. However, DVD-
Player supports direct on-screen mouse navigation, which eliminates the need for this
keypad. It is provided for completeness and is fully functional.

The Numerical Keypad.
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DVD Disc Database [CTRL-D]

This keeps a record of all DVD discs that have been played on your system and maintains
individual settings for each title. The name of the title is read directly from the DVD and
added to the database. If you prefer to watch one title in a window with high volume and
another full-screen with medium volume, DVDPlayer will automatically adjust to those
settings whenever you reinsert a previously played DVD disc. You can remove a title by
selecting it and clicking on the remove button. This allows you to establish new settings for
a specific title.

The DVD Disc database.

DVDPlayer Settings Dialog [CTRL-S]
This opens a multiple function window with the following tabbed pages. . .

The DVDPlayer Settings window.
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Volume

This allows the adjustment of playback volume for each of the 5.1 channels of audio
available in DVD.

Note: Only two channels can be controlled for the analog output. As you select each
audio channel, the volume slider will show the volume setting for that channel. To adjust,
move the slider to the right for higher volume or to the left for lower volume. Select MUTE

ALL to quickly turn off all the channels.

Spoken Language

This allows you to select the active audio stream. This is most commonly used to choose
which language you wish to hear.

SubTitle

This allows you to select whether or not to display subtitles — as well as chose the lan-
guage in which the subtitles appear.

Parental

The Parental settings allow you to select your choice of content rating (Kids, Theatrical, or
Adult). If the rating you select is not available in the current DVD, the next lower rating
will be played.

The first time you select a rating higher than Kids, you will be asked to enter a password to
protect this rating. Any future attempts to switch this rating will require the same password.
Passwords are stored in the DVD Database along with your preferences and settings for a
current title. Once a password is set, it can not be changed directly. If you forget your
password or need to change it, you must remove the current Title from the DVD Database
and enter a new password and setting.

Video Format

This lets you to chose which mode you prefer to watch your video in: Wide Screen 16:9,
Letterbox, or Pan-Scan.

Speaker

This allows the setting of speaker configurations using surround sound and to adjust the
delay used to simulate surround sound when you only have two speakers. The delay is
relative to the center speaker. If the speakers are far apart, use less delay (move the slider
to the left). If the speakers are close together, use more delay (move the slider to the right).
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Bass

This lets you redirect the bass and is useful if you do not have a center-channel speaker or
subwoofer. By selecting CENTER TO LEFT AND RIGHT, the bass is redirected to the left and right
stereo channels.

Language

This allows the viewer to select the language used for Audio Playback, Subtitle Display,
and Menu Display, if supported by the particular DVD. If your preferred languages are not
available, an error message will be displayed and you will be asked to select from the
languages available for that particular title. If you have no language preference, select
NEUTRAL, and the DVD title’s default language will be used.

Display

This sets the window location and proportions. ALWAYS ON TOP will make the DVD window
remain on the top of other applications, even when they’re active. RESIZE PROPORTIONAL will
restrict window size — so that if you attempt to increase the height of a window it will also
increase the width in proportion to the title.

Program

This offers control over the various parameters to suit your personal taste. Scan speed is the
speed at which fast forward and rewind move through a DVD title. You can increase and
decrease this speed by moving the slider. Time display affects the type of information
shown in the LED displays of the Mini-Control, VCR Control, Navigation Control, and
Panel Control. Zap speed sets how long each chapter will play when in Zap mode. You
may choose slow, medium, or fast.

Exit

Allows you to exit the DVDPlayer and the Title.

Note: You can obtain a button description by activating the menu window and holding
your cursor there for a few moments.
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Creating a Disc Image For Final Output
After the Project is compiled, and after you’ve tested it using the DVDPlayer utility, it’s
time to create a Disc Image of the Project and write it to DVD-R or DLT tape.

The DVD Disc Image is a UDF-Bridge volume that contains the complete DVD directory
structure created when you compiled the Project. If you come from a CD-ROM or DVD
authoring background, you may think of “disc images” as files that are written to a hard
drive before a disc is burned or a tape is written. DVDMaestro and DVDConductor,
however, are able to create the DVD volume structure “on-the-fly” — which means that
you can write your Project’s Disc Image directly to DVD-R or DLT tape, saving you
considerable time. In other words — with one exception that we’ll detail below — there’s
no need to create a Disc Image file on the hard disk before writing to DVD-R or DLT.

Creating the Disc Image is a three-step process, in which you’ll:

• open the Disc Image Creation tool and then configure it by choosing an Input Source
(the directory to which the Project was compiled) and Output Destination (DVD-R,
DLT, or, if necessary, hard disk);

• set and/or confirm certain Disc Image and Replication Properties;

• and finally, write the Disc Image to the chosen output destination.

Let’s review these in order. . .

Opening & Configuring the Disc Image Creation Tool
Most operations related to creating a Disc Image can be accessed by opening the Disc
Image Creation tool.
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To open the Disc Image Creation tool:

• From the Tools pull-down menu, select DISC IMAGE CREATION.

– or –

• Click on the DISC IMAGE CREATION button in the Toolbar.

– or –

• Press the key combination ALT - D on your keyboard.

Note: Under the Tools pull-down menu, in addition to the Disc Image Creation tool, you’ll
also find the Write Tape and Write DVD-R tools. The only (relatively rare) circumstance in
which you need to use either of these tools is if you’re creating a “reordered” hybrid DVD-
Video/DVD-ROM disc, which means you’ll need to write the Disc Image to a hard drive,
as we’ll discuss next. Otherwise, for almost all Spruce authoring software users, all tape
writing and disc burning operations can be performed on the fly, using the Disc Image
Creation tool.

Once the Disc Image Creation tool opens, you can configure the Input Source and Output
Destination.

Note: If a compiled Project is not already open, then the Select Source (Title Set) Directory
dialog will appear directly after you open the Disc Image Creation tool, which is used to
establish the Input Source.
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Input Source

By default, the topmost field in the dialog points to the Source (Title Set) Directory — the
directory to which the Project was compiled, and there the Video_ts folder is located. You
can use the Disc Image Creation tool to compile a Video_ts directory created in another
Project, but you will have to manually point the Input Source field to the correct directory,
by clicking BROWSE (“…”).

Output Destination: To Image File

By default, the Output Destination is set to Image File, which will create a Disc Image file on
the hard disk, after which the file can be written to DVD-R or DLT in a separate operation.

Note: Choosing an Image File is not the usual way of using this tool. Generally speaking,
instead, you will choose TO DLT TAPE or TO DVD-R as the Output Destination — since both
DVDMaestro and DVDConductor support “on-the-fly” formatting of the Disc Image
without needing to create an image file on a hard disk.

The one exception to this — as detailed later in “Creating a Reordered Hybrid DVD-Video/
DVD-ROM Title (Using the Write Tape & Write DVD-R Tools)” — is if you are creating a
“reordered” hybrid DVD-Video/DVD-ROM disc, where you choose to reorder the physical
layout of the ROM files. In this case, you should select TO IMAGE FILE as the Output Destination.

If you select TO IMAGE FILE, a default name will appear that’s based upon the name of the
current Project and its directory. The format of the name is “hard drive:\Project
folder\Project name.img”. If you wish to select another folder or another hard drive with
more storage space, click the adjacent BROWSE Button to search for a new directory.

Note: A Disc Image for a completed Project occupies exactly as much storage space on a
hard drive as it would on a replicated DVD-Video disc. When you choose the destination
directory, you need to ensure there is enough available space on the destination hard
drive. Also, it’s also a good idea to ensure that your hard drive is relatively unfragmented;
a drive maintenance program such as Norton Utilities can check and, if necessary,
defragment your hard drive.
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Output Destination: To DLT Tape

Choose this option if you’re writing the Disc Image to a DLT drive. Currently, commercial
disc replication facilities will typically expect to receive your title on DLT, rather than on a
DVD-R disc, though this may change in the future.

If you have a single DLT drive on your DVDStation’s (or own computer system’s) SCSI
chain, it will appear in the pull-down field. If you have multiple DLT drives connected to
your SCSI chain, just select the desired device using the pull-down field. (Naturally, you’ll
want to ensure the desired DLT drive is properly connected and powered on and that
you’ve loaded it with a blank DLT tape.)

If you wish to verify the tape after it has been written, to ensure there were no problems
writing the Disc Image to tape, check VERIFY AFTER WRITE. Once the tape has been written, a
verification procedure will take place and you’ll be notified if there are any problems.

Output Destination: To DVD-R Media

Choose this option if you’re writing the Disc Image to a DVD-R recorder. With the com-
mon availability of DVD-R drives, the usual practice now is to write one or more DVD-R
discs for testing purposes, even if the final delivery will be replicated discs. After quality
assurance and approval, a final DLT tape is then created.

If you have a single DVD-R recorder on your DVDStation’s (or own computer system’s)
SCSI chain, it will appear in the pull-down field. If you have multiple DVD-R recorders
connected to your SCSI chain, just select the desired device using the pull-down field.
(Naturally, you’ll want to ensure the desired recorder is properly connected and powered
on and that you’ve inserted a blank DVD-R disc.)

If you wish to verify the disc after it has been written to ensure there were no problems
writing the Disc Image to disc, check VERIFY AFTER WRITE. Once the disc has been written, a
verification procedure will take place and you’ll be notified if there are any problems.

If you wish to perform a test write — to ensure you don’t encounter any problems writing
to the blank disc, such as buffer underruns — check TEST WRITE. In this case, a simulated
burn will take place (without anything been written to the blank disc) and you’ll be
notified if there are any problems.
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Before Writing the Disc Image…

Your next step is to ensure that certain remaining Project Properties are set correctly, as
we’ll cover next…

Setting Disc Image Properties
(Prior to Creating a Disc Image)
Before creating the Disc Image, you will need to ensure that certain Project Properties are
set properly.

In this section, we’ll discuss the Disc Image Properties, which can vary depending upon
which version of Spruce authoring software you’re using.

Opening the Disc Image Properties (For DVDMaestro Users

or DVDConductor users with the DVDMaestro Upgrade)

DVDMaestro (or DVDConductor with the DVDMaestro upgrade) offers you two different
approaches to opening the Disc Image Properties dialog — and which you approach you
use is dependent upon what you need to accomplish:

• If you wish to enable Macrovision APS copy protection, you must do so (a) before
you compile your Project; and (b) you must open the Disc Image Properties dialog by
right-clicking on the Project icon in the Project Manager, selecting PROPERTIES, then
selecting the Disc Image Properties tab — and not by clicking the PROPERTIES button in
the Disc Image Creation tool. (See “Macrovision APS,” above, for more information.)

• If you wish to author a dual-layer disc, you must access the Disc Image Properties
dialog via the Disc Image Creation tool — that is, by selecting DISC IMAGE CREATION

from the Tools menu (or the Toolbar) and then clicking the PROPERTIES button. Do not
access the Disc Image Properties by right-clicking on the Project icon in the Project
Manager. (See “Dual Layer Option” on the next page for more information.)

• If you wish to author a “reordered” hybrid DVD-Video/DVD-ROM disc — where the
ROM files are physically reordered (we’ll discuss this in the coming pages) — you
must access the Disc Image Properties dialog via the Disc Image Creation tool. This
means you will need to select DISC IMAGE CREATION from the Tools menu (or the Tool-
bar) and then click the PROPERTIES button. Do not access the Disc Image Properties by
right-clicking on the Project icon in the Project Manager. (See “Dual Layer Option”
below for more information.)
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Note: If you are creating a hybrid DVD-Video/DVD-ROM disc and do not wish to
physically reorder the ROM files, then there is no need to access the Disc Image
Properties dialog by the Disc Image Creation tool. In other words, you can open them
by clicking on the Project icon in the Project Manager, the selecting PROPERTIES, the
selecting the Disc Image Properties tab.

Note: DVDPowerPack users may also access a smaller Disk Image Properties than DVDMae-
stro. There you can access dual-layer break and DVD-ROM hybrid “reordering.”

     

The Disc Image Properties dialog, as opened by clicking the PROPERTIES button in the Disc Image Creation tool (left)
and by clicking the Project icon in the Project Manager (right). Although these two dialogs look very similar, they
offer access to different options, depending upon how they were opened.

Chapter 10: Preparing Your Project for Replication (Premastering) 10-35

10

We’ll review the various options for these dialogs just below.

Opening the Disc Image Properties (For DVDConductor users)

Assuming you are using the standard version of DVDConductor, without the DVDPower-
Pack upgrade, then you can open the Disc Image Properties dialog in either of the follow-
ing ways:

• via the Disc Image Creation tool — by selecting DISC IMAGE CREATION from the Tools
menu (or the Toolbar) and then clicking the PROPERTIES button;

– or –

• via the Project Manager — by right-clicking on the Project icon in the Project
Manager, selecting PROPERTIES, then selecting the Disc Image Properties tab.

Once open, you’ll notice that the Disc Image Properties dialog is somewhat simpler than
either of the dialogs pictured immediately above:

For the standard version of DVDConductor, this is what the Disc Image Properties tab will appear like.



DVDMaestro User’s Guide10-36

As you can see, the only options available are to set the DVD Volume name and the
Layout Files, which we’ll describe below.

Note: The dual-layer features found in the DVDMaestro version of the Disc Image Properties
dialog may be added to DVDConductor by installing the DVDPowerPack upgrade. The copy-
protection features (CGMS, CSS, and APS) may be added by installing DVDMaestro.

DVD Volume Name

This is the name that will appear when the end-user inserts your replicated disc or DVD-R
into his or her DVD-ROM computer drive. Your Spruce authoring software inserts a default
name, which is the Project name. If you wish to change the name, simply select and retype
what you want.

In accordance with the DVD-Video Specification, the Project name can be a maximum of
32 characters. The only permissible characters are the 26 English language capital letters
and numerals 0 to 9. Other characters and symbols are not allowed, nor are spaces; if,
however, you wish to separate two or more names, you can use underscores (“_”). If your
active Project name differs from these specifications, your Spruce authoring software will
provide a default name in the Disc Image Properties dialog that is as close to the active
Project name as possible.

Layout Files Option

(For Creating a Hybrid DVD-Video/DVD-ROM Disc)

If you wish to create a DVD-Video-only disc, then select DVD-VIDEO ONLY. With this (default)
selection, your final disc will play back a DVD-Video title on either a consumer DVD
player or a consumer DVD-ROM player (assuming the personal computer into which it’s
installed is equipped with the appropriate decoder hardware or software).

The alternate selection (DVD-ROM) lets you prepare “hybrid” DVD-Video/DVD-ROM titles
that work as both DVD-Video titles and DVD-ROM discs.

Note: If you wish to create a reordered hybrid DVD-Video/DVD-ROM title, be sure to see
“Creating a Reordered Hybrid DVD-Video/DVD-ROM Title (Using the Write Tape & Write
DVD-R Tools),” near the end of this chapter. (Reordered hybrid title authoring is supported
by DVDMaestro and by DVDConductor with the DVDPowerPack upgrade.)
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The Layout Files option section of the Disc Image Properties dialog. If you’ve selected the Disc Image Properties
dialog via the Disc Image Creation tool, then you’ll also see a button labeled REORDER to the left of the DVD-ROM

radio button (assuming you’re using DVDMaestro or DVDConductor with the DVDPowerPack upgrade).

To create a hybrid DVD-Video/DVD-ROM title: 

1. Drag the Audio_ts and Video_ts directories — as well as any desired data files and
folders — into the folder designated as the Source (Title Set) Directory, which is
specified in the Disc Image Creation dialog.

2. Be sure you do not place the data in the Audio_ts or Video_ts folders.

3. In the Disc Image Properties dialog, select DVD-ROM. 

The resulting disc will contain both DVD-Video and DVD-ROM content.

Note: If you’re creating a hybrid DVD-Video/DVD-ROM disc, be sure to keep in mind the
following:

• Once you select the DVD-ROM option, the “Allow long Unicode File Names”
checkbox becomes enabled. This allows use of extended character set, including
spaces and punctuation and names longer than 26 characters.

• If you have selected DVD-VIDEO only and there are data files in the Source (Title Set)
Directory that are not part of your Project, Spruce authoring software will ignore
these files and use only the information in the Audio_ts and Video_ts folders. The
resulting disc will be strictly in DVD-Video format.

• As we’ve mentioned elsewhere in this chapter, if you’re creating a reordered hybrid
DVD-Video/DVD-ROM disc — and wish to physically reorder the layout of the
DVD-ROM files on the disc — you will need to write a Disc Image to a hard drive,
then use the Write Tape or Write DVD-R tools, as described later in this chapter;
see “Creating a Reordered Hybrid DVD-Video/DVD-ROM Title (Using the Write
Tape & Write DVD-R Tools).
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Dual Layer Option 

The Dual Layer Option (and related Direction of Translation setting) are not supported in
the standard version of DVDConductor. They may be added by installing the DVDPow-
erPack upgrade.

Note: The Dual Layer Option is only accessible after you have compiled your Project, and
then, only if you’ve opened the Disc Image Properties dialog via the Disc Image Creation
tool (as is described just a bit earlier in this chapter). It is not accessible if you’ve opened
the Disc Image Properties dialog via the Project Manager.

The Dual Layer Option section.

As you should be aware, the DVD-Video Specification calls for discs to be single- or two-
sided, with one or two layers per side. In this section of the Disc Image Properties dialog,
you’ll define if the current side has one or two layers, and if there is a second layer, at
which Chapter or Marker it starts.

Note: When we refer to the “first layer,” we’re referring to the “Layer 0” in the DVD-Video Spec, and
when we refer to “second layer,” we’re referring to “Layer 1” in the DVD-Video Spec. 

Click ONE LAYER if the disc side is to be single-layer (Layer 0 only). Click TWO LAYERS if the
disc side is to be dual-layered (Layer 0 plus Layer 1).

If you choose TWO LAYERS, you’ll also need to set the Chapter point at which the second
layer starts. Underneath the SECOND LAYER STARTS AT label is a pull-down box with the names
of all the Chapter Markers in the current Project. To select where the second layer starts,
simply click on the pull-down box and choose the desired Chapter Marker. 
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This dialog also displays the current size of each layer. In accordance with the DVD-Video
Spec, your Spruce authoring software supports up to 2,084,960 sectors per layer. The
Layer 0 Size window shows the amount of data, in sectors, that you’ve allocated to the first
layer; the Layer 1 Size window shows the amount of data allocated to the second. You’ll
notice that the amounts allocated will change depending upon how you’ve structured the
disc; for instance, if you change the “Second Layer starts at” setting from one Chapter
Marker to another or when you change copyright information, the relative amounts of data
in each layer will change.

Note: It’s possible to view layer sizes in either sectors (the default) or bytes. To toggle
between sectors and bytes, right-click on top of the Layer 0 Size or Layer 1 Size
windows and a context menu will appear, letting you switch between the two. As a
convenience, you will see the display toggle back and forth between sectors and bytes
every couple of seconds.

Direction of Translation (Dual Layer Discs Only)

Note: This option is only available if you have selected TWO LAYERS as the Dual Layers
Option in the Disc Image Properties dialog. Furthermore, as with the Dual Layers Option,
the Direction of Translation option is only accessible if you’ve opened the Disc Image
Properties dialog via the Disc Image Creation tool, as is described just a bit earlier in this
chapter. It is not accessible if you’ve opened the Disc Image Properties dialog via the
Project Manager.

Here, you’ll define how the laser in the end-user’s player will read the second layer of the disc.

If you select INNER (PTP), then your final, replicated disc will play back following the Parallel
Track Path (PTP ) protocol. Here, both layers will be played back in the same direction:
The playback laser in the end-user’s DVD player will read the first layer (Layer 0) from the
inside of the disc to the outside. Once the playback laser reaches the end of the first layer,
it will reset itself back to the inside of the disc where it will read the second layer (Layer 1)
from the inside of the disc to the outside.

If you select OUTER (OTP), then your final, replicated disc will play back following the
Opposite Track Path (OTP ) protocol. Here, the layers will be played back in opposite
directions: The playback laser in the end-user’s DVD player will read the first layer (Layer
0) from the inside of the disc to the outside. Once the playback laser reaches the end of
the first layer, it will access the second layer (Layer 1) starting on the outside of the disc
and will play the second layer from the outside to the inside.
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Choose OUTER if you want end-users to experience as smooth a transition as possible
between the layers. For video playback, the transition won’t be seamless — there may be a
slight delay or “blip” as the playback laser realigns itself to the second layer. In practice,
however, if you have selected the layer transition point to be at a visual dissolve or a fade-
out, the results — as far as the end-users are concerned — may be virtually seamless.

Copyright Management Information

Copyright Management Information features are not supported in the standard version of
DVDConductor. They may be added by installing the DVDMaestro upgrade.

If you do not wish to identify your completed disc as being copyrighted, then select the
MATERIAL IS NOT COPYRIGHTED option in this section. (This will create a Disc Image with a
sector size of 2048 bytes.)

The Copyright Management Information section.

If you wish to identify the disc as being copyrighted, select the MATERIAL IS COPYRIGHTED

option. (This will also create a Disc Image with a sector size of 2054 bytes.)
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Copy Generation Management System (CGMS)

CGMS features are not supported in the standard version of DVDConductor. They may
be added by installing the DVDMaestro upgrade.

Note: This section is available only if you have selected the MATERIAL IS COPYRIGHTED option.

The Copy Generation Management System (CGMS) is designed to restrict how many times,
if any, an end-user is permitted to copy a final, replicated disc.

To allow an end-user to copy your final disc at will, with no restrictions, select the COPYING

PERMITTED WITHOUT RESTRICTION option. To allow an end-user to copy your final disc just once
— without the ability to make successive copies of that first copy — then select the ONE

GENERATION COPY PERMITTED option. To prevent an end-user from making any copies of your
final disc whatsoever, then select the NO COPY PERMITTED option.

Copyright Protection System (Contents Scramble System)

The CSS feature is not supported in the standard version of DVDConductor. It may be
added by installing the DVDMaestro upgrade.

For copyright protection purposes, Spruce authoring software allows you to format your
Project so that a mastering/replication facility will be able to use Contents Scramble
System (CSS) encryption — assuming the facility is licensed and authorized to do so.

If you want to alert the mastering/replication facility to use CSS, then select FORMAT FOR CSS

ENCRYPTION. Otherwise, select DON’T FORMAT FOR CSS ENCRYPTION (the default setting).

Note: You must select NO COPY PERMITTED in order to apply the CSS Copy Protection System.
Otherwise, these options will be greyed out.
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Macrovision APS

As noted previously, Macrovision APS must be selected prior to compiling if it is to be
used in a given Project. For more information please see “Macrovision APS,” earlier in this
chapter.

Setting Replication Properties
(Prior to Creating a Disc Image)
Once you’ve set the Disc Image Properties — and before creating the Disc Image — you’ll
want to confirm that the Replication Properties are set correctly.

Opening the Replication Properties (For DVDMaestro Users only)

Similarly to the Disc Image Properties, if you use DVDMaestro, the Replication Properties
dialog can be opened in either of the following ways:

• via the Project Manager — by right-clicking on the Project icon in the Project
Manager, selecting PROPERTIES, then selecting the Replication Properties tab;

– or, only if you need to write a Disc Image to a hard drive –

• via the Write Tape tool — by selecting WRITE TAPE from the Tools menu (or the Tool-
bar) and then clicking the PROPERTIES button.

As we will learn later in this chapter (“Creating a Reordered Hybrid DVD-Video/DVD-
ROM Title (Using the Write Tape & Write DVD-R Tools)”), if you need to write a Disc
Image to a hard disk — rather than the much more typical case of writing a Disc Image
directly to DVD-R or DLT — then you can access the Replication Properties via the Write
Tape tool. Otherwise, you will need to use the first method, to open the Replication
Properties via the Project Manager.
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Opening the Replication Properties (For DVDConductor Users)

Assuming you are using the standard version of DVDConductor, then you can open the
Disc Image Properties dialog in either of the following ways:

• via the Disc Image Creation tool — by selecting DISC IMAGE CREATION from the Tools
menu (or the Toolbar) and then clicking the PROPERTIES button;
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– or –

• via the Project Manager — by right-clicking on the Project icon in the Project
Manager, selecting PROPERTIES, then selecting the Disc Image Properties tab.

In DVDConductor, the Replication Properties dialog is somewhat simpler, as some of the
features supported in this dialog are not included, as can be seen below:

The Replication Properties tab, as it appears in the base-level of DVDConductor

Note: The dual-layer features supported by the Disc Image section of the Project Properties
dialog may be added to DVDConductor by installing the DVDPowerPack upgrade. The
regionalization feature may be added by installing DVDMaestro.

The Replication Properties dialog has several sections, as follows. . .

Regional Management Information

Regional Management Information is not supported in the standard version of DVDCon-
ductor. It may be added by installing the DVDMaestro upgrade.
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The Regional Management Information setting is described in detail earlier in this chapter
(please see “Project Properties: Replication Tab”), since this setting is made prior to
compilation.

However, one of your Spruce authoring software’s many benefits is that you can define a
Regional Management Information setting for the Disc Image that is independent of the
setting used during compilation and emulation. During compilation, the Region setting in
the Video_ts directory is resolved to that of the DVDPlayer utility. When the Disc Image is
generated, the Region settings for both lead-in and Video_ts are resolved to the setting in
the Replication tab of the Project Properties dialog.

This has two benefits. First, it assures that you can successfully emulate your title, regard-
less of its final intended region. Secondly, it guarantees that the two places where the
Regional Management Information code is set (lead-in and .ifo) will agree — which in turn
will ensure that your final replicated disc will behave consistently across all playback
platforms.

Physical Specifications

This Physical Specifications section is where you define the physical attributes of your
final, replicated disc.

The options you select in this Physical Specifications section will be used to create a Data
Description Protocol (DDP) file on the DLT, which in turn will be used by the mastering/
replication facility to prepare your disc.

Note: Spruce authoring software currently supports DPP version 2.0 tape layout.

Let’s review the choices. . .

Number of sides for final disc

As you should be aware, the DVD-Video Specification calls for discs to be single- or two-sided.

In the NUMBER OF SIDES FOR FINAL DISC section, click ONE SIDED if the disc is to be a single-sided
disc. Click TWO SIDED if the disc is to be a two-sided disc. The purpose of this selection is to
provide a flag in the DPP file which will alert the mastering/replication facility that your
disc is be single or two-sided — and that they should expect two DLT tapes if it’s two-sided.
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If you have selected two-sided, unless you intend to put exactly the same information on
both sides of the disc, you will need to create two separate Disc Images. (You could use
the same Project to create two separate Disc Images by writing one Disc Image then
changing the Project and writing the next. But in most circumstances, you’ll probably want
to create a new Project for each Disc Image.)

Current side of disc

If you are creating a two-sided disc, you will need to write one tape for each side.

Note: If one or both of the sides is dual-layer, you’ll actually write two tapes for each side
— one for each layer.

The purpose of the CURRENT SIDE OF DISC selection is to provide a flag in the DPP file, which
will let the mastering/replication facility know which side of the disc the current tape
corresponds to. Select SIDE A or SIDE B as appropriate.

Replica Disc Size

For the REPLICA DISC SIZE section, 12 CM is the default option, since currently this is the most
common size for DVD-Video discs. Choose 8 CM if you intend to create a small-sized disc.

Note: At this writing, no DVD replication facilities support the 8 cm size option.

Writing the Disc Image Directly to DVD-R or DLT
Having defined the Input Source and Output Destination, as well as the Disc Image and
Replication Properties, you are now ready to write your Disc Image directly to DVD-R or DLT.

To write the Disc Image directly to DVD-R or DLT:

1. Click CREATE DISC IMAGE in the Disc Image Creation tool dialog.

2. Depending upon the media Output Destination you have selected, the system will
prompt you insert a blank DVD-R disc or a DLT tape.

3. A “thermometer”-style indicator will show the progress of writing the Disc Image and
a completion dialog will appear informing you when writing is complete and the
media is ready.
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When you write a Disc Image directly to DVD-R or DLT using the Disc Image Creation
tool, the writing takes place in the background. In other words, you can continue to work
with your Spruce authoring software or other Windows NT applications while the disc or
tape is written.

Creating a Reordered Hybrid DVD-Video/DVD-ROM
Title (Using the Write Tape & Write DVD-R Tools)

Authoring of reordered hybrid DVD-Video/DVD-ROM titles is not supported in the
standard version of DVDConductor. It may be added by installing the DVDPowerPack
upgrade.

Note: This section will apply to relatively few Spruce authoring software users. If you are
creating DVD-Video titles exclusively — or creating a hybrid DVD-Video/DVD-ROM title
without physically reordering the ROM files — then you can skip this section; in this case,
everything you need to know about writing to tape or burning a DVD-R disc is covered
earlier in this chapter (‘Creating a Disc Image For Final Output.”)

Earlier in this chapter (see “Layout Files Option,” above) we discussed how to create a
hybrid DVD-Video/DVD-ROM title. In some cases, such as when you need to optimize
access speed off the final, replicated disc, you may wish to physically reorder the ROM
files as they will appear on the disc. (This can be performed with DVDMaestro or with a
DVDPowerPack-upgraded version of DVDConductor.) Let’s review the steps. . .

To create a reordered hybrid DVD-Video/DVD-ROM title:

1. As with an ordinary (non-reordered) hybrid title, drag the Audio_ts and Video_ts
directories — as well as any desired data files and folders — into the folder desig-
nated as the Source (Title Set) Directory, which is specified in the Disc Image Cre-
ation dialog.

2. Be sure you do not place the data in the Audio_ts or Video_ts folders.

3. Open the Disc Image Creation tool (by selecting DISC IMAGE CREATION from the Tools
menu or the Toolbar).
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4. Next, open the Disc Image Properties dialog by clicking the PROPERTIES button in the
Disc Image Creation tool.

Note: You must access the Disc Image Properties dialog in this manner — do not
open it by clicking on the Project icon in the Project Manager and selecting PROPERTIES.

5. In the Disc Image Properties dialog, select DVD-ROM. 

Note: Just as with an ordinary non-reordered hybrid DVD-Video/DVD-ROM disc,
once you select the DVD-ROM option, the “Allow long Unicode File Names”
checkbox becomes enabled. This allows use of extended character set, including
spaces and punctuation and names longer than 26 characters.

6. Click the REORDER button, just to the left of DVD-ROM, as shown below:

7. The File Re-Order dialog will appear, showing the physical sequence (SEQ) in which
the files (FILE PATH NAME) will appear on the disc. To change the order of any or all files,
simply click-drag them from their current position to a new position, as shown
below:
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8. When you’re done, click OK and the File Re-Order dialog will close.

9. At this point, you can set any of the other parameters in the Disc Image Properties
dialog as required; when done, click OK.

10. Next, you can write the Disc Image to the hard drive (as described above in “Output
Destination: To Image File”).

11. Once the Disc Image has been written, you’re ready to write to tape using the Write
Tape tool or burn a disc using the Write DVD-R tool — as we’ll describe next.

Writing to Digital Linear Tape (DLT) is the final step to perform before sending your
completed Project to a mastering/replication facility for disc replication. Writing to a DVD-
R recorder is an ideal alternative for creating test discs, or a limited run of discs. Either
way, when crafting a hybrid DVD-Video/DVD-ROM disc you’ll be using the Write Tape or
Write DVD-R tools to transfer your Disc Image file from your hard drive to your chosen
medium.

Note: Before you can write to tape or DVD-R using the Write Tape or Write DVD-R tools,
you must have compiled your Project and written a Disc Image to a hard drive.
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The Write Tape (top) and Write DVD-R tools operate very much the same as the Disc Image Creation dialog, but
there are slightly different options available in each: Specifically, the Write Tape dialog includes a PROPERTIES button
to access the Replication properties. The Write DVD-R dialog includes options of foreground or background
writing (foreground may be more reliable), as well as a “Test Write” option.

To write to DLT (using the Write Tape tool) or to DVD-R (using the Write Disc tool):

1. Select the Tools pull-down menu and choose WRITE TAPE or WRITE DVD-R.

– or –

Click the WRITE TAPE or WRITE DVD-R button on the Toolbar. 

2. The Write Tape or WRITE DVD-R dialog will appear, indicating the Source (Disc Image)
File that will be written to tape or disc. The default will be the most recently created
Disc Image file.

Note: If you need to choose another file, click the adjacent BROWSE button. This will
open the Select Source (Disc Image) File dialog where you can type in the file name
directly (in “drive:\directory” format) — or use the dialog to browse your hard drives
and folders for the desired file. Once you’ve established the Source (Disc Image) File,
click OPEN. The Select Disc Image File dialog will close, leaving the Write Tape or
Write DVD-R dialog onscreen.

3. Although it’s optional, we recommend that you enable the VERIFY AFTER WRITE option
(checkmarked) which will verify your tape or disc after it has been written.
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Starting with Step 4, the procedures differ depending upon whether you are writing to
DLT or DVD-R. . .

4. If you’re writing to DLT, you can review the Replication Properties settings at this
stage by clicking the PROPERTIES button. This is particularly useful if you want to
establish different Regional Management Information from what was used for the
compiled Project. For more information, please see “Setting the Replication Proper-
ties (Prior to Creating a Disc Image),” above. When done, click OK in the Replication
Properties dialog.

5. Click WRITE TO DLT in the Write Tape tool. The system will prompt you insert a DLT
tape, after which the chosen Disc Image file will be written to your DLT drive — plus
any other necessary files, such as the lead-in information and the DPP file (running
information can be viewed in the Output Log).

6. The Output Log will indicate whether your attempt to write was successful or if there
were any problems in the process.

– or (starting back at step 4) –

4. If you’re writing to DVD-R, you might wish to perform a test write before
proceeding,to ensure you don’t encounter any problems writing to the blank disc,
such as buffer underruns. In this case check TEST WRITE; a simulated burn will take
place (without anything been written to the blank disc) and you’ll be notified if there
are any problems.

5. Next, you need to decide upon the writing method:

• in the background — where you can continue to work with your Spruce author-
ing software or other Windows NT applications while the disc is written;

– or –

• in the foreground — where the writing process “locks out” the rest of your
Spruce authoring software (as well as any other applications), so that you will be
unable to use your DVDStation (or own computer system) for any other purpose
until after the disc has been burned.

Note: In theory, writing in the foreground is a more reliable method, since it
minimizes the chance of a disc failure due to extraneous loads on the SCSI bus or
the CPU, which can be caused by other active programs.
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6. Click on the WRITE TO DVD-R (BACKGROUND) or WRITE TO DVD-R (FOREGROUND) button. The
system will prompt you to insert a blank DVD-R disc, after which the chosen Disc
Image file — plus any other necessary files, such as the lead-in information and the
DPP file — will be written to your DVD-R recorder (running information can be
viewed in the Output Log).

7. The Output Log will indicate whether your attempt to write was successful or if there
were any problems in the process.

The last line in the Output Log will indicate when you have successfully written to DLT or DVD-R.

To cancel the writing process at any time prior to completion:

• Click again on the WRITE TAPE or WRITE DVD-R button on the toolbar.

Once the Disc Image has been written to tape or disc, the following will occur. . .

• If you have written to DLT and had selected the VERIFY AFTER WRITE option, the DLT will
rewind at the end of the write process and your Spruce authoring software will verify
that the tape has been successfully written. If your Project encompasses multiple
tapes — for instance, if the title you’re authoring is dual-layer — then you’ll be
prompted to insert the appropriate tape.

• If you have written to DVD-R and had selected the VERIFY AFTER WRITE option, your
Spruce authoring software will verify that the disc has been successfully written.

• If you have written to DVD-R and had selected the TEST WRITE  option, your Spruce
authoring software will verify that the test write was successfully. In this case, you can
write the disc “for real” by returning to the Disc Image Creation (or Write DVD-R) tool;
unchecking the TEST WRITE box; then clicking on the WRITE TO DVD-R (BACKGROUND) or WRITE TO

DVD-R (FOREGROUND) button. Writing will take place as normal.
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• If you choose (at any time after you’ve written to tape) to change any of the DVD
Movies, DVD Menus, connections, or other aspects of the Project — you will need
to re-compile the Project, then create a new Disc Image and then rewrite the Project
to tape.

The Output Log

Throughout the process of creating DVD Movies, DVD Menus, connections and more, the
Output Log — the pane in the lower-left corner of your application (at least, that’s its
default location) — remains “quiet.” When you start preparing your Project for replication,
however, you’ll notice that the Output Log becomes rather “chatty,” as it provides a
running information display of your Spruce authoring software’s output-related activities.

These activities include:

• compiling a Project, or 

• creating a Disc Image, or

• writing to DLT. 

These are the only times when information is actively logged in the Output Log. However,
once you’ve completed any of these activities, any related information will continue to be
shown in the Output Log until you exit the Spruce authoring software application.

As we mentioned, in its default viewing configuration, the Output Log pane is located in
the lower-left corner of the application, below the Project Manager and to the left of the
RealView Previewer. Many users, however, may prefer to hide the Output Log until they
perform one of the three functions listed above.

The Output Log Viewing Tabs
The Output Log has two viewing tabs: COMPILE and DISC IMAGE/DLT. They contain, respec-
tively, information that pertains to compiling your Project or creating a Disc Image (or
writing a DLT). To switch between these views, simply click on the desired tab.



DVDMaestro User’s Guide10-54

To the left of the tabs are several arrow keys. These are used to reveal a hidden COMPILE or
DISC IMAGE/DLT tab — a common issue if you’ve resized the Output Log so small that only
one tab (or portion of a tab) can be seen. The far-left and far-right arrows are respectively
the GO TO BEGINNING OF TABS and GO TO END OF TAB arrows; the two inner arrows are respec-
tively the sCROLL TABS LEFT and SCROLL TABS RIGHT arrows.

The Output Log also has conventional scroll bars to let you scroll to see any desired
information logged within the pane.

What Sort of Information is Logged?
The Output Log details virtually any operation related to an output-related activity. For the
most part, you won’t need worry about much of what you see in the Output Log. For
instance, when you compile a Project, the Output Log will indicate, among other things,
that it’s starting and initializing a “build,” that it’s cleaning a directory, that it’s writing
certain folders, and so on.

Much of this information can be ignored, except for the most important information, which
is (in the final line) an indication that your chosen operation has been completed success-
fully. However, if there are problems, the Output Log will also tell you about them and
what they are. For instance, it will notify you if a key file — such as a video file — is
missing. It will let you know if there any hard drive related problems. And, if you cancel
an operation, it will indicate that too. In many cases, the information you find in the
Output Log will be your only notification if there is a problem.

Copying & Pasting the Contents of the Output Log
It’s always a good idea to have your Output Log open and visible whenever you compile a
Project, create a Disc Image or write a DLT. Also note that the information provided in the
Output Log may be vital if you are having difficulties and need to speak with someone in
Spruce Technologies’ technical support department.

For these and other circumstances where you’d like to retain a copy of Output Log infor-
mation, follow these steps. . .

To copy and paste all the contents of the Output Log:

1. Right-click anywhere in the Output Log pane.

2. When the context menu appears, select SELECT ALL.
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3. Then select COPY, which will put the contents of the Output Log into the Windows
clipboard.

4. You can now paste this information into any suitable text editing application such as
the Windows Note Pad or Microsoft Word.

To copy and paste just a portion of the contents of the Output Log:

1. Click and hold in the Output Log pane where you wish to begin selecting the
contents you wish to copy.

2. Drag down with your mouse; when you have selected everything you wish to copy,
release the mouse.

3. Right-click anywhere in the Output Log pane.

4. When the context menu appears, select COPY. This will put the contents of the Output
Log into the Windows clipboard.

You can now paste this information into any suitable text editing application, such as the
Windows Note Pad or Microsoft Word.

Summary of Preparing Your
Project for Replication

As we’ve just learned, the main steps involved in premastering include:

• compiling the Project (after setting all necessary properties);

• emulating and reviewing the compiled Project carefully using DVDPlayer;

• creating a Disc Image (after setting all necessary properties) by writing it directly to a
DVD-R disc and/or a DLT tape

– or (in the case of a reordered hybrid DVD-Video/DVD-ROM disc) –

• writing a Disc Image to a hard drive (after setting all necessary properties), then using
the Write DVD-R or Write Tape tools to write the Disc Image a DVD-R disc or DLT
tape;
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Congratulations! At this point in this User’s Guide, you should now be familiar with all of
your Spruce authoring software’s basic features and should know everything you need to
create DVD titles from start to finish. In the coming chapters, we’ll be taking a closer look at
some of the more advanced features related to the Video Timeline, creating subtitles, and
using Command Sequences.

•        •        •

Chapter 11: 

Advanced Video Timeline Features
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Chapter 11
Advanced Video Timeline Features 

In Chapter 6, we introduced DVD Movies and covered the basic features of the Video
Timeline — including how to place a video asset in a video track and how to preview it
using the RealView Previewer. Your Spruce authoring software provides a wealth of other,
more advanced Video Timeline-related features for powerful DVD authoring capabilities.

Adding & Editing Assets
within the Video Timeline

As we learned in Chapter 6, adding a single video asset to the main Video Timeline is as
easy as dragging it from the Assets Bin to a video track. To jump from that video asset to
another, you could create another DVD Movie and establish a connection between the
two DVD Movies using the Connections window. This can, though, introduce a slight
delay between the playback of the two video assets (i.e., a non-seamless transition). To
avoid this, one solution would be to leave your Spruce authoring software and to return to
your video editing system, where you could generate a new video asset that combines
both of the original video assets.

Fortunately, Spruce authoring software offers ways to combine two or more video assets
(also known as video “clips”) together in one DVD Movie — and even to perform basic
editing — without having to use an external video editing system.

Let’s review some of the options. . .

‘On the Fly’ Video Concatenation
(Adding Multiple Video Assets to a DVD Movie)
Technically speaking, the process of appending one or more video assets to another is called
“concatenation.” With Spruce authoring software, the process takes place “on the fly” —
without the time-consuming process of having to create new files — and is extremely easy.
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To add multiple video assets to a DVD Movie:

1. Open the desired DVD Movie by double-clicking on its icon in the Project Manager.

2. Assuming there’s already a video asset in place in video track 1, simply drag the
second video asset from the Assets Bin into the track. The new “clip” will appear in
the track.

3. To add any number of additional clips, simply repeat step 2.

Note: If necessary, you can use the Zoom Out tool to view the complete, concat-
enated video track.

This screenshot above shows a single video clip (depicting an exotic bird) that’s already been added to video track
1 in the Video Timeline.
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To add another video clip onto the end of the first one, simply drag the second clip from the Assets Bin into the
video track, as shown above. Now, when you preview the DVD Movie, playback will proceed seamlessly from the
first clip to the second.

You can continue to add additional video clips in any number, zooming out to view the complete concatenated
video stream.
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Encoding Requirements for Concatenated Video

In order for playback to be seamless across video “cut points,” video assets must be
encoded using a “closed” GOP structure (either IBP closed, or IBBP closed), as selected in
the encoder Settings window. For more information, please refer to your Spruce Technolo-
gies Encoding Guide, which accompanies this User’s Guide.

Selecting a closed GOP structure, as described in your Spruce Technologies Encoding Guide.

Changing the Play Order of Concatenated Video

In any concatenated video track, you can change the play order of the different assets
quite easily — simply by click-holding and dragging them from one place to another using
your mouse.

To reorder different video assets in a concatenated video track, just click-hold on the clip you wish to move and
drag it into its new location.
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No matter how you reorder the individual video assets, seamless play across the “edit
points” will be maintained.

Creating a Synchronous Audio Track

to match Concatenated Video Assets

Typically each video asset will be also have accompanying audio assets. Consequently, as
you concatenate and reorder video assets in the Video Timeline, you’ll typically want to
construct a corresponding chain of synchronized audio assets. DVDMaestro and DVDCon-
ductor make it easy to accomplish this, thanks to their ability to automatically assemble
audio tracks to match concatenated video tracks.

Note: You can only create a synchronous audio track with either PCM or AC-3 audio. This
process will not work with any other audio file format. Furthermore, the streams must be
exactly the same in terms of timecode, bitrate, number of channels, etc.

To assemble a synchronous audio track for a concatenated video track:

1. In the Audio Timeline, right-click in the audio track that you wish to use for the
synchronous audio track.

2. When the pop-up context menu appears, select CREATE SYNC AUDIO TRACK. The system
will scan the directory (or directories) that contain the video assets, looking for any
audio files with matching names.

3. The Sync Audio File dialog will appear, indicating all the matching audio files that
your Spruce authoring software was able to find.
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4. Review the Audio File list in the Sync Audio File Dialog. If any files are missing or
incorrect, click once on the to appropriate name in the Video File list, then click
ASSIGN AUDIO FILE in the Audio Association section of the dialog. When the Select
Matching Audio File dialog opens, you can browse through any available directories
to locate the desired audio file; when found, click OK and you will return to the Sync
Audio File dialog. Repeat this step as necessary for any other missing audio files.

5. Your Spruce authoring software will provide a default name and directory for the
Audio Output File that you’re about to create. If you wish, you can type a new name
or select a new directory by clicking the “…” button adjacent to the File Name field.

Note: By default — when the USE LTC is selected in the AC-3 section of the Settings
window (as described in your accompanying Spruce Technologies Encoding Guide)
— the synchronizing process uses the timestamp embedded in each audio file. If for
some reason audio is encoded without timestamps, then you must deselect the
checkbox SYNC TO AUDIO TIMECODE. In this case, the system will align the first sample of
audio in each audio file with the first frame of video in the corresponding video clip.
In most cases, satisfactory sync will be maintained even without audio timecode.
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6. In the Sync Audio File dialog, click CREATE AUDIO FILE to construct the new synchronous
audio file. A new audio file (that is the composite of all the audio files listed) will be
written to the hard drive with audio data that’s synchronized to each corresponding
video clip. The Sync Audio File dialog will close and the new audio file will appear
in the audio track (as well as the Assets Bin).

Once you create the Sync Audio File, it will appear in the Audio Timeline with all audio elements in sync with
their corresponding video assets.

Note: If you find that the audio streams created by this process contains only silence, it is a
good indication that the audio files involved do not have timecode data included. If this
occurs, simply perform the Create Audio in Sync command again, this time deselecting the
Sync Audio to Time Code button.

Video Insert Editing
(Replacing Existing Video Assets in a DVD Movie)

With DVDMaestro — or DVDConductor with the DVDEncoderPack option — you can use
the same type of insert function used in segment re-encoding to replace existing video with
material from another file. This process is called a video insert edit. To review these steps,
please refer to “Segment Re-Encoding” in your Spruce Technologies Encoding Guide,
which accompanies this User’s Guide.
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Note: When using the video insert function, some restrictions apply:

• Both existing and replacement material must be encoded using a Closed GOP
structure.

• Both existing and replacement material must be encoded using the same GOP
structure.

• The timecode of replacement material must includes the times of assets bounded
by the Punch-In and Punch–Out points in the Video Timeline.

When you perform a video insert edit, your Spruce authoring software pulls material (with
matching timecodes) and inserts it seamlessly into the Video Timeline at the appropriate
start (Punch-In) and end (Punch-Out) times. As long as the restrictions listed immediately
above are observed, you can use video insert editing to freely modify any DVD Movie
during the course of a Project.

Trimming & Extending Video Assets
Your Spruce DVD authoring software lets you trim the “head” (beginning) and “tail” (end)
of each clip in a video track. This way you can easily remove excess material at either end
of the clip or for isolating a single video clip to be combined with other clips in a new play
sequence.

Note: Trimming video with Spruce authoring software is a completely “non-destructive”
process. That is, the original source video file is in no way affected and you can always
adjust the trim at a later time. For example, let’s say you’ve dramatically trimmed a video
clip to just a fraction of its original length in the Video Timeline. At any time before
compilation, you can always return to the clip and, using the trim feature, return it to its
original length or any other desired length. Alternately, you can replace the trimmed clip
with the original video asset which will remain unchanged in the Assets Bin.

To trim a video clip:

1. Position your mouse near the head or tail of the desired video clip. You’ll notice the
cursor change from an ordinary arrow to a “bracket” with a small arrow, as pictured
immediately below.
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2. With the mouse, left-click and hold. You can now drag the mouse to the left or the
right, which will trim the video clip by “hiding” portions of it. You’ll notice that the
Thumbnail Previewer display window show a video frame indicating the current
position of the cursor. (You’ll also see a series of images of both the left and right
edge of the clip indicating that trim editing is taking place.)

3. Once your cursor is where you wish to trim to, release the mouse. The shortened clip
will snap to the left, either to the beginning of the Video Timeline, or to the end of
the preceding video clip.

A trimmed video asset.

You can preview the trimmed clip just as any other video clip in the Spruce authoring
environment. If desired, you can also extend the end (right edge) of the video clip. This
will cause the last video frame to be held until playback reaches the end of the extended
clip.
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To extend the end of a video clip (hold last frame):

1. Position your mouse near the tail of the desired video clip until the cursor changes
from a large arrow to a “bracket” with a small arrow.

2. With the mouse, left-click and hold, then drag to the right. When you reach the
desired time, release the mouse.

Extending the right edge of a video clip; this will hold the last frame until playback reaches the end of the extended clip.

The extended section of the video clip will appear in a differing shade of blue. When
RealView Previewing, the PlayCursor will continue to move to the right across this seg-
ment, but the only a still frame will be seen. (Of course, if there’s a fade-to-black at the
end of the video asset, the held still frame will be black.)

An extended video clip, positioned just before a non-extended clip.
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Creating a Synchronous Audio Track  for Trimmed Video

The Create Audio in Sync command works for trimmed or extended video as well as for
concatenated video segments. For extended video segments, the extended section is filled
by silence.

Concatenating Trimmed or Extended Video Assets

Video assets that have been trimmed or extended may be concatenated just as if they were
untrimmed. In addition, you may trim or extend any segment within a series of concat-
enated segments simply by grabbing the left of right edge of the particular segment you
want to affect.

Using Concatenation & Trimming as a Video Editing Solution
Your Spruce authoring software’s video concatenation and trimming features may be used
together to re-edit an existing segment of video to create a new program, complete with
audio — much as could be accomplished with a stand-alone video editing system.

To edit a video asset in the Video Timeline:

1. If the asset is not already in the Video Timeline, drag it from the Assets Bin into video
track 1.

2. Trim the asset’s head and/or tail to isolate a shot or section as desired.

3. Drag another (or the same) video asset from the Assets Bin into the Video Timeline to
create a concatenated video clip that follows the first (trimmed) clip.

4. Trim the head and/or tail to isolate the next shot of section.

5. If you wish, you can reorder any asset in the track simply by click-dragging it to a
new position, before, after, or between other video assets.

6. Preview the assembled edit to check if you have located the right trim points and that
the transition between the clips is occurring at the correct location.

7. Repeat steps 3 to 5 until you have assembled the video material as you wish to see it.

8. Once you’re done, right click in an audio track and select CREATE SYNC AUDIO TRACK to
produce a synchronous audio track for the entire edited program.
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A DVD Movie, showing a number of video assets in place, any of which can be trimmed, reordered, and
otherwise “edited.”

Used in this way, DVDMaestro or DVDConductor can operate as very fast and reasonably
powerful non-linear video editing system, albeit with some limitations as compared to full-
featured systems. The principle limitations include:

• Trim and concatenation can only be performed at I-frame boundaries

• Only “butt-splice” edits — where two assets are aligned immediately adjacent to one
another, so that the second asset begins exactly when the first asset ends — are
supported. No transitions (e.g., dissolves, wipes, etc.) are currently available.

• There is no “trim bin” function, which would place trimmed video clips in the Assets
Bin, to allow you to re-use isolated clips easily.

While these limitations are significant, Spruce authoring software’s trim and concatenation
features are very powerful editing features, and will only grow in power in future software
updates.
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Clip List View Mode
When working with video tracks made up of concatenated assets, you may find it useful to
view them in a “Clip List” or tabular format, rather than the default Timeline view mode.

To switch from Timeline view mode to the Clip List view mode:

1. With the desired DVD Movie already open and active in the Workspace:

° from the View pull-down menu, select VIDEO CLIP LIST VIEW MODE;

– or –

° Press the keyboard combination CTRL - I.

2. The display area in the DVD Movie will switch immediately from its ordinary
Timeline view mode to Clip List view mode, as shown below.
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A DVD Movie, shown in Clip List view mode.

As you can see, each of the various video clips already in place in the Video Timeline now
appear as a list. The information resembles a standard Edit Decision List, showing Start and
End Times, as well as Length for each clip.

Clip List view mode is extremely useful for working with groups of several (or more) video
clips. However, unlike Timeline view mode, it doesn’t provide a relative visual representa-
tion of the DVD Movie; nor does it show any of the assets in the Audio Timeline or
Subtitle Timeline — and for these reasons, you may well find yourself switching back and
forth between modes.

To switch from the Clip List view mode back to Timeline view:

• Once again select VIDEO CLIP LIST VIEW MODE from the View pull-down menu.

– or –

• Press the keyboard combination CTRL - I.
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Changing the Picon Size

You’ll notice that in Clip List view mode, each clip has an associated picon (picture icon),
showing its respective first  video frame. If you wish, you can select one of three different
sizes for the picon, which allows you to optimize the view for a larger or smaller number
of individual clips.

Changing the picon size.

To change the picon size in Clip List view mode:

1. Right-click in any of the video clip picons.

2. From the pop-up context menu, select SMALL, MEDIUM, or LARGE.

3. The picons will change size accordingly.

Re-ordering Video Clips in the Clip List View Mode

As in Timeline view mode, you can change the order of video clips while in Clip List view
mode.
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To re-order video clips from within Clip List view mode:

1. Click once on the video clip you wish to move, then release the mouse.

2. Now click again on the desired clip and this time hold the mouse down.

3. Drag the selected clip up or down to its new location.

4. Release the mouse button. The selected clip will appear in its new spot in the play
sequence.

Reordering a clip.

Clips may also be selected and moved as groups.

To move a group of clips in Clip List view mode:

1. Click on the first or last clip of the group you wish to move and drag upward or
downward to select all clips in the group.

– or –

Click on the first clip of the group you wish to move, then SHIFT-click on the last of
the group.

– or –

To select discontiguous clips, CONTROL (CTRL)-click on each of the desired clips.

2. Release the mouse, then click-hold on any of the selected clips and drag. This will
move the entire group of clips at once.
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3. As you move the group up or down, you’ll notice a red line appear before or after
each clip; this indicates the location to which the group of clips will be moved once
you release the mouse. When you arrive at the location you wish, just release the
mouse and the clips will be moved.

Moving a group of clips.

Adding Video Assets while in Clip List View Mode

As in Timeline view mode, you can add any video asset to the DVD Movie simply by
dragging it from the Assets Bin to the DVD Movie. As you do this, you’ll notice the cursor
change to an arrow with a “+” symbol, indicating that you’re adding an asset to the list.

Modifying Segment Length in Clip List View Mode

You can also trim or extend the tail (but not the head) of a video clip while in Clip List
view mode. This may be more precise in some instances than trimming with the mouse in
Timeline view mode, since you can specify the exact frame to which you wish to trim or
extend the clip.

To trim the tail of a clip, you can change either the End Time or Length parameters in the
Clip List.
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To trim the tail of a video clip while in Clip List view mode:

1. Select the End Time or the Length field so as to highlight the numerals.

2. Enter the desired End Time or Length in HOURS:MINUTES:SECONDS:FRAMES.

3. Click ENTER on your keyboard.

4. Whichever parameter you enter, the other will change automatically to reflect the
new value. Any succeeding video clips will also be updated to match.

Adjusting the End Time for the asset labeled “Scene1.”

You may also increment or decrement the End Time or Length by a specified amount.

To increment or decrement End Time or Length by a fixed amount:

1. Right-click on the End Time or Length field for the clip you wish to affect.

2. Select the appropriate radio button in the Edit Clip Length dialog.

3. Enter the amount by which you wish to change the End Time or Length.

4. Click OK. All affected End Time and Length fields are updated to their new values.
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Using the Edit Clip Length dialog to increment a length by a fixed amount.

You may also increment, decrement, or set a fixed value for the Length or End Time of a
group of clips at once.
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Incrementing the length of a group of clips.

To affect the End Time or Length of multiple video clips:

1. Select the clips you wish to affect by click-dragging.

– or –

Select the entire End Time or Length column by clicking once at the top of the
respective column.

2. Right-click on one of the End Time or Length fields of the selected clips.
3. Select the operation desired and enter the specific timecode value you wish to use.

4. Click OK. All affected timecode values will be updated.

Locking the Video Track
Once you have assembled a video track and adjusted all lengths, etc. as desired, you can
lock that track to prevent accidental changes to any of the clips. This may be done from
within either the Timeline or Clip List view modes.
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To lock the video track from the Timeline view mode:

1. Right-click anywhere in the Video Timeline.

2. From the pop-up context menu, select lock track assets.

A check mark will be shown next to this command when the track is locked. When the
track is locked, no video assets can be added, deleted, or trimmed. The track can be
unlocked by selecting the Lock Track Assets command again.

Locking the track, in Timeline view mode (left), and by clicking LOCK TRACK, in Clip List view mode.

To lock the video track from the Clip List view: 

• Click on the button labeled LOCK TRACK in the upper-left of the Clip List view window.

The Lock Track button will appear “depressed” when the track is locked. The track may be
unlocked by clicking the button again.

The Video Asset Properties Dialog
Each media asset in the Assets Bin has an associated Asset Properties dialog. This dialog is
accessed by right-clicking on the name of the asset in the Assets Bin, then selecting
PROPERTIES from the pop-up context menu.
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Opening the Asset Properties dialog by right-clicking on a video asset in the Assets Bin.

For video assets, when accessed from the Assets Bin, the Assets Properties dialog offers
NAME, TYPE, FILE OFFSET (timestamp), FILE LENGTH, and (maximum) BIT RATE fields, as shown
above.

For video assets already in place in a video track, it’s possible to get Asset Properties by
right-clicking on the asset directly from within the Video Timeline, then selecting PROPERTIES

from the context menu. In this case, all trim-related information is also included. Since a
single video asset may be used multiple times in a track with different trim information,
there may be many Properties dialogs for a given asset, each associated with a trimmed
asset.
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Opening the Asset Properties dialog, by right-clicking on a video asset in the Video Timeline; note the additional
trim-related information.

As shown above, the Asset Properties dialog for this video clip in the Video Timeline
shows the start time in the timeline (ASSET START); the length of play (ASSET LENGTH); the trim
point from the beginning of the asset source file (ASSET OFFSET); and the hold time of the last
frame if the clip is extended beyond the end of the video source file (ASSET HOLD).

Working with Multi-Angle Video

DVD provides the unique feature of allowing the user to switch between parallel video
tracks seamlessly with continuous audio. Per the DVD-Video Specification, only one video
track at a time can serve as the active (visible) stream; furthermore, there is always one
main video track with as many as eight optional, alternate tracks, for a total of nine
“camera angles” — so called because the application in mind when the DVD Spec was
written was that these would represent different camera views, or angles, of the same
subject. In reality, the different video streams may be anything.

Spruce authoring software fully supports seamless multi-angle video for each DVD Movie.
With a total of nine video tracks, DVDMaestro supports the limit of nine camera angles
(main video plus eight alternates). The base-level DVDConductor has two video tracks,
supporting two angles (main video plus one alternate); by installing the DVDPowerPack
upgrade, DVDConductor can also support up to nine angles.



DVDMaestro User’s Guide11-26

Expanding the Video Timeline
So far, as we’ve been describing DVD Movies and the Video Timeline, we’ve been
working with a single video track — video track 1 — which is used for the “main video”
stream. The additional video tracks are normally hidden in the Video Timeline, directly
below video track one.

The default view of the Video Timeline, showing just the primary video track (video track 1).

To expand the Video Timeline to show additional video tracks for alternate camera angles:

1. Click-hold on the splitter bar that separates the Video Timeline from the Audio
Timeline. The cursor will change appearance to indicate that you have “grabbed”
this bar.

2. Drag downward to expose as many video tracks (up to nine in DVDMaestro and
DVDPowerPack; two in DVD Conductor) as you wish to display. (You can also use
the scroll bar on the right side of the Video Timeline to scroll through additional
tracks.)

Note: Once you’ve dragged the splitter bar down to show anywhere from two to all nine
possible tracks, you can quickly “collapse” the Video Timeline to show just the primary
video track (video track 1) by clicking on the Collapse Timeline arrow, which is located in
the upper-left corner of the Video Timeline (adjacent to video track 1’s track number
button). To quickly expand your view of the Video Timeline again, just click the Collapse
Timeline arrow once more.
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An expanded view of the Video Timeline, showing video tracks 1 and 2. Further tracks may be revealed by pulling
down on the splitter bar between the Video Timeline and Audio Timeline, and/or by scrolling down in the Video
Timeline. Also note the Collapse Timeline arrow to the left of video track 1’s track number button.

Authoring Multi-Angle DVD Movies
With Spruce authoring software, creating multi-angle DVD Movies is relatively easy. Let’s
run through the steps.

You can add a video asset to any video track, which in turn can serve as an “angle”
stream. Per the DVD-Video Spec, however, your title must have information in the first (or
main) video track, and any alternate tracks must be “filled” in order; in other words, if your
title is going to use video track 3 as an alternate angle, you must use video track 2 as well.

Note: When encoding video assets that may be used in multi-angle DVD Movies, there are
some important encoding-related restrictions. These are detailed in the accompanying
Spruce Technologies Encoder Guide and reviewed later in this chapter (see “Restrictions
on Encoding for Multi-Angle Video”).

To add a video asset to an alternate track to serve an alternate video angle:

1. Ensure one or more video assets are already in place in video track 1.

2. Expand the Video Timeline to display one or more of the alternate video tracks.

3. Drag the desired video asset from the Assets Bin into video track 2. This new “alter-
nate angle” video asset will snap to the beginning of the Video Timeline, as shown
on the next page.
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Adding a video asset to video track 2, to serve as an alternate video angle.

Previewing Alternate Video Angles

You can preview alternate video angles by using:

• the RealView Previewer;

• the Navigation Simulator;

• or, after compiling the Project, the DVDPlayer emulation utility.

As we’ll see, there are different advantages to each approach.

As you author the DVD Movie, using the RealView Previewer is the fastest way to preview
an alternate angle, since you can launch it directly from the DVD Movie, as follows. . .

To preview an alternate video angle using the RealView Previewer:

1. Select the video track you wish to view by clicking on its associated track number
button, as pictured below. The track number button will be highlighted, indicating
that track will be the active video stream. If you wish, you can also reposition the
PlayCursor (as described in Chapter 6) so that playback starts at some time other than
the beginning of the DVD Movie.

2. Press the spacebar on your keyboard, or click the Play button. (All the transport
controls and related keyboard shortcuts were introduced in Chapter 6.)

3. The selected alternate video angle will begin playing in the RealView Window.

4. You can pause and resume playback by pressing your keyboard’s spacebar or by
clicking the Play/Pause button. To stop playback, simply click the Stop button.
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Here, the RealView Window is playing back video track 2, since it was selected to be the active video stream (by
clicking on its track number button).

One limitation of using the RealView Previewer is that you cannot switch between angles
in the middle of playback. To do that, you’ll need to use the Navigation Simulator or the
DVDPlayer — and unless you’re ready to compile the Project, the former is probably the
more quickly accessible choice.

Note: As you’ll recall from Chapter 9, the Navigation Simulator allows you to step through
your Project’s connections, playing DVD Movies and showing DVD Menus in the “flow”
order that appears in the Connections Window. Therefore, in order to use the Navigation
Simulator to play a particular DVD Movie’s main or alternate video angles, you’ll need to
ensure that the DVD Movie in question is properly “connected” in the Project. In other
words, if the DVD Movie is currently unconnected to any play action, DVD Menu button
highlight area, etc., then you will not be able to preview any of its video angles using the
Navigation Simulator.
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To preview multi-angle video using the Navigation Simulator:

1. Launch the Navigation Simulator by clicking on its icon in the main Toolbar or by
choosing NAVIGATION SIMULATOR in the Tools pull-down menu; or by pressing the
keyboard shortcut ALT – S.

2. Once the Navigation Simulator launches:

• if the multi-angle DVD Movie you wish to view is connected as the Project’s First
Play item, playback will begin in a few seconds;

– or –

• use the Navigation Simulator’s controls to navigate to the desired DVD Movie;
after which playback will begin.

3. Once playback begins, you can use the Angle pull-down field (in the Stream Selec-
tion section in the lower-left of the window) to choose which video track will be the
currently active stream.

Selecting which video track will be the active video stream (“Angle”) from within the Navigation Simulator.
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When you switch between video angles using the Navigation Simulator, you’ll notice a
distinct pause when the angles switch, rather than the seamless effect that end-viewers will
see when they view your final, replicated DVD title. This occurs because the Navigation
Simulator uses separate elementary streams and multiplexes these on the fly to feed the
MPEG decoder. Therefore, when you switch streams, the Navigation Simulator must
“dump” video already in buffers and start to read a whole new stream, which accounts for
the pause.

There is one way to preview multi-angle video while seamlessly switching streams: First,
compile the Project, then launch DVDPlayer (Spruce authoring software’s emulation
utility) to play back the compiled Project. Depending on the scope of the Project and the
duration and complexity of multiple camera angles, you may elect to wait until the full
Project is complete and compiled, or — if you want to simply check multi-angle playback
by itself — or you could compile an interim (or smaller) version of the Project.

To review multi-angle video using DVDPlayer:

1. Construct a title with the multi-angle DVD Movie you wish to review. This may be
your complete main Project or it may be a separate “subset” Project for fast compila-
tion and review without all of the DVD Menus, etc. that will eventually appear in the
complete Project.

2. Compile the title and start the DVDPlayer application, as described in Chapter 10.

3. When DVDPlayer launches, click on the “camera” button in the lower-right corner
of the Navigator Control window. This opens the small Angle Control window, which
you can use to select the desired video angle.

4. Begin playing back the title as normal, using DVDPlayer; as you wish, you can use
the Angle Control’s “left-right” buttons or pull-down field to switch between video
angles.
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Using DVDPlayer’s Angle Control to select the active video stream.

Note: When you select a new angle, there will be a short pause followed by a seamless
change between angle streams. If the transition between streams is not seamless, it prob-
ably means the video was encoded with an “open” GOP structure.

Restrictions for Encoding for Multi-Angle Video

As discussed in the Spruce Technologies Encoding Manual, when encoding video that may
be used in multi-angle DVD Movies, there are several parameter settings that must be set
as follows:

• All video streams must be encoded using a closed GOP Pattern.

• All video streams must have the same GOP structure throughout.

• The combined bit rate of any one video stream and all audio streams cannot exceed
8 Mbps (8,000,000 bps)
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To meet these requirements when encoding for use in multi-angle, you should:

• Encode all segments with the same setting of the GOP Structure and GOP Size
parameters.

• Switch the New GOP on Scene Change parameter OFF, as it will modify the GOP
structures in an uncontrollable fashion.

• If you are encoding shorter sections to be placed as multi-angle within limited areas
of a longer main video, be careful to select a GOP size that can be rendered evenly
with the length of the multi-angle section.

• Encode at bit rates that will total less than 8 Mbps when combined with all audio
streams. (You may want to go lower to ensure compliance).

If you try to assemble multi-angle streams with MPEG assets that do not meet these re-
quirements, you will encounter messages such as this:

If you have this situation, usually there is no alternative except to re-encode the assets with
parameters that meet the requirements listed above.

Creating Mixed-Angle DVD Movies
using Video Assets of Different Lengths
Authoring with multi-angle video is an exciting capability of the DVD medium — though
there are some disadvantages. The largest by far is that multi-angle video streams consume
a corresponding multiple of disc space. For instance, a DVD disc capable of holding two
hours of video (120 minutes), has its play time reduced to 60 minutes for two angles
streams (120 divided by 2), and all the way down to just 13.3 minutes (120 divided by 9) if
there are 9 camera angles.

Fortunately, there is a space-efficient method to create multi-angle DVD Movies — and
that is to build DVD Movies that have a single angle (the main video) for most of their
playing time, but that provide multiple angle streams in certain sections. This is known as
using “mixed” angles and results in a DVD Movie that looks something like this:
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A mixed-angle DVD Movie.

In the screenshot above, you can notice some important points about using mixed angles:

• The main video angle (video track 1) runs the full length of DVD Movie.

• Each multi-angle portion of the DVD Movie is aligned to a Chapter Point Marker; in
other words, corresponding video assets all start at the same chapter start point.

• In each multi-angle portion, all the video assets (in each track) are the same length.

• All multi-angle portions have the same number of angles.

If you observe these points in planning your multi-angle video, you will find it quite easy
to construct these kinds of programs.

Note: As mentioned earlier, multi-angle authoring requires that video streams have the
same GOP structure and number of GOPs. In the case of mixed-angle authoring, this
means that the shorter angle sections must match both the GOP structure and number of
GOPS for the corresponding section of the main video. As discussed in the Spruce Tech-
nologies Encoding Guide, this can be particularly tricky to accomplish, as the encoder will
truncate the last GOP to match the encode duration requests. If the duration desired does
not equal a set number of GOPS, it will be necessary to change with the duration or the
GOP structure (which then has to be applied to the main video as well).
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To construct a mixed-angle DVD Movie:

1. Import the video assets you wish to use into the Assets Bin. Make sure that these are
encoded so as to meet the requirements noted above.

2. Drag the main video asset into video track 1.

3. Expand you view of the Video Timeline to show one or more of the alternate video
tracks as required.

3. Create a Chapter Point Marker (as described in Chapter 6) where you want the first
multi-angle portion to begin. If multi-angle material starts from the beginning of the
DVD Movie, this step is not needed.

4. Click-drag the first alternate video asset into video track 2 and release it somewhere
to the right of the Chapter Point Marker.

5. The asset will “snap” left and align itself to the Chapter Point Marker. You’ll notice
that a General Purpose Marker is placed automatically at the end of the alternate
asset (if need be, it can be converted to a Chapter Point Marker, as described in
Chapter 6).

6. Repeat steps 4 and 5 for any alternate angles assets as needed, until all required
angles are filled.

7. Create additional Chapter Point Markers and alternate angle assets for all multi-angle
portion.
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Note: Remember, all multi-angle sections in a given DVD Movie must have the same
number of alternate angles, and in each section, each alternate angle asset must be
the same length.

A mixed-angle DVD Movie, with four alternate angles in place.

You may preview the mixed angle sections using the RealView Previewer, the Navigation
Simulator, or (after compilation) DVDPlayer, just as if you were previewing a full-length
multi-angle DVD Movie.

While the RealView Previewer still will not let you switch angles on the fly, it will switch
seamlessly between the main video and whatever angle is selected for preview (as indi-
cated by the highlighted track number button, as shown below), whenever playback
passes into and out of a multi-angle portion of the DVD Movie.
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Although you won’t see the “play flow” arrow on your screen, this illustration indicates which assets will be
played back in what order by the RealView Previewer (assuming the track number button for video track 3 has
been highlighted, as shown above).

To preview a mixed-angle DVD Movie using the RealView Previewer:

1. Select the video track you wish to view as the alternate angle by clicking on its
associated track number button, as pictured above. The track number button will be
highlighted, indicating that track will be the active video stream when playback
reaches the location of the first asset in that track. If you wish, you can also reposi-
tion the PlayCursor (as described in Chapter 6) so that playback starts at some time
other than the beginning of the DVD Movie — although be sure to place the Play-
Cursor before the start of the alternate angle track.

2. Press the spacebar on your keyboard, or click the Play button.

3. As the DVD Movie plays, you’ll see the image in the RealView Previewer will switch
from track 1 (the main video) to the selected track (the alternate angle) and back
again without any transition glitches. This is the same effect that will be experienced
by the viewer of the finished DVD title.

4. As usual, you can pause and resume playback by pressing your keyboard’s spacebar
or by clicking the Play/Pause button. To stop playback, simply click the Stop button.
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Creating a Slide Show

In much the same way that you assemble video assets in the Video Timeline, you can also
assemble still images — with fixed or user-controlled duration and with or without audio
and subtitles. DVD Movies consisting of still images are known as “slide shows.”

This DVD Movie combines a Slide Show (of still images) with a video asset (the last asset in video track 1).

Still images can be imported in any of a number of common file formats, including:

• bitmap (.bmp);

• TIFF (.tif);

• JPEG (.jpg);

• Photoshop (.psd);

• and other common formats.

Note: In the case of the TIFF format, most common compression methods are supported,
with exception of LZW compression.
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As we’ll see just below, still images are added and manipulated in the same manner as
video assets — by importing image files into the Assets Bin, then dragging them into the
Video Timeline, then changing position, and so on.

One big difference between working with video assets and still images, however, is that a
still image has no inherent duration. Therefore a default duration must be specified.

To specify the default duration for still images:

1. From the File pull-down menu, select PREFERENCES. The Program Preferences dialog
will open.

2. In the Slide Show Defaults section of the General tab, you can set the default length
in seconds, for each slide by simply typing in the value.

Setting the default length for still images.

Whatever value you enter here will be assigned to each still image as it is added to the
Video Timeline. This type of still is called a “timed still.” After entry, durations may be
modified in the same way as for video (see “Changing the Display Time or Order of Timed
Stills,” just below).

To add a timed still images to a DVD Movie:

1. Import the still image file into the Assets Bin just as you would import a video asset
(see Chapter 5).

2. Click-drag the still image asset from the Assets Bin to video track 1 and release the mouse.
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Note: Still images can only be added to the primary video track (video track 1).

3. The selected asset will appear as a timed still image in video track 1 with the default
duration.

4. If you wish, you can add additional still images to video track 1 by repeating steps 1
through 3.

A single still image in the Video Timeline.

You can also add a number of still images at once.

To add multiple timed still images simultaneously to a DVD Movie: 

1. Import all the desired still image files into the Assets Bin.

2. Clicking at the top of the Assets Bin window on NAME; this will sort all the still images
by name, such as SLIDE1, SLIDE2, etc.

3. Select all still image assets by:

• “lassoing” them with the cursor;

– or –

• SHIFT-clicking to select a range of assets;

– or –

• CONTROL-clicking to select a discontiguous group of assets.

4. Click-drag the still image assets from the Assets Bin and release them in video track 1.
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Note: The selected still assets will appear in video track 1 with the default duration in the
order in which they are sorted in the Assets Bin.

Multiple still images in the Video Timeline.

Changing the Display Time or Order of Timed Still Images
As we mentioned, after you import a still image into the Video Timeline, you can alter its
display time by any of the methods available for video assets, including trimming (using
Timeline view mode) or editing the End Time or Duration (using Clip List view mode).

As with multiple video assets, you can reorder any still image relative to another image
simply by click-holding on the image, then dragging it to its new location. This works
equally well whether you’re in Timeline or Clip List view mode. (In the latter mode, you
need to click once on the image, then click-hold, before reordering the image)

Since the picon that appears in Clip List view mode remains the same image for the entire
duration of the timed still image — and since that mode lets you specify exact time values
— you may find that Clip List view mode offers you the most accurate and straightforward
way to work with Slide Show images.

Previewing a Slide Show
Sequences of timed still images may be previewed just like any DVD Movie. Simply hit the
spacebar or click on the Play button at top of the window; the RealView Previewer will
launch and playback will begin.

Note: The PlayCursor can be moved to the beginning of any timed still, but cannot be
placed in the middle of the image’s play duration.
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Adding Audio to a Slide Show
You can add audio (including multiple audio tracks) to any sequence of timed stills, just as
you can with any DVD Movie.

To add audio to a Slide Show:

1. Import the encoded audio asset (.ac3, .wav. or .aiff) into the Assets Bin.

2. Click-drag the audio asset from the Assets Bin into the first available audio track.

A Slide Show with an accompanying audio track.

You can preview the slide show with audio just as you would any DVD Movie (assuming
your audio playback system is connected). Unlike a video asset, however, a sequence of
still images has no inherent timestamp associated with it. Therefore, if timestamped audio
is imported for a sequence of stills, the first sample of audio will be automatically aligned
to the beginning of the first still image.

Note: If the audio asset extends beyond the end of the last slide, the slide will be “ex-
tended” until audio playback is complete. This is in contrast to audio that extends beyond
the end of video, in which case audio playback ends as soon as the end of video is
reached.
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Adding Subtitles to a Slide Show
Subtitles may be incorporated with a sequence of stills just as for video. Subtitle display
may extend across boundaries of still images without problems. We’ll be covering subtitles
in depth in Chapter 12, but for now, here are the procedures. . .

The Subtitle Editor.

To add an individual subtitle to a Slide Show:

1. Right-click in the first available subtitle track at the location where you would like
the subtitle to appear.

2. When the pop-up context menu appears, select ADD INDIVIDUAL SUBTITLE.

3. The Subtitle Editor dialog will appear where you can enter text or specify an image
file and set the display and text rendering settings as desired.

4. Click OK. The Subtitle Editor will close and the new subtitle will appear in place in
the subtitle track where it can be moved, extended, or edited as in any DVD Movie.
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The subtitle shown in place in the Subtitle Timeline.

Combining Video Assets with a Slide Show
Video assets can be mixed with timed stills freely, providing a method to create complex
and interesting DVD Movies. For instance, among other approaches, you can mix short
video sequences between groups of still images to act as “transitions” between the stills.

A video asset, in position before a string of still images.
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To combine a video asset with a sequence of still images:

1. If necessary, import the encoded video asset into the Assets Bin.

2. Click-drag the video asset into the Video Timeline and release it. If you want the
video asset to play in the same stream as the Slide Show, drop it in video track 1. If
you want the video asset to serve as an alternate video angle, drop it another video
track.

If needed, you can trim, reorder, and otherwise manipulate the video asset as usual.
During playback, transitions between still images and video assets will be perfectly
seamless.

User-Advanced Still Images
So far we have worked with still images that advance automatically after a fixed duration;
these are known as timed still images. Alternately, you can create user-advanced still
images, which do not have a set duration, and remain onscreen until the viewer chooses
to advance them pressing the Play button on the DVD player remote control.

Setting the default for user-advanced still images.

User-advanced stills are created by defining the Slide Show default in the Preferences
dialog as STILL : LENGTH 1 VOBU, rather than defining a slide length in seconds.

Note: With this setting, the actual physical duration of the still image data on the disc is
equal to one Video Object Unit, or VOBU. Hence, the name “VOBU Still,” which some
people use to refer to a user-advanced still.
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To add user-advanced stills into the Video Timeline

1. Set the Slide Show Default setting in the General section of the Program Preferences
dialog to STILL: LENGTH 1 VOBU.

2. Click-drag the desired still image asset from the Assets Bin and release it in video
track 1.

Note: User-advanced stills may be incorporated in a DVD Movie with video assets
and/or timed stills — but they cannot be accompanied by audio.

User-advanced still images in place. Notice that each occupies approximately 1/2-second (15 frames) in the Video Timeline.

In Timeline view mode, user-advanced stills will be displayed with a duration of approxi-
mately 1/2-second (15 frames), equal to the length of one DVD Video Object Unit. When
played on the DVD player, they will display indefinitely, until the viewer clicks the Play
button on the remote control, at which time the display will advance to the next still image
(or video asset) in sequence.

Previewing User-Advanced Stills
When you use the RealView Previewer, user-advanced stills will be displayed for their
VOBU length; that is, about 1/2-second.

When you use the Navigation Simulator, however, user-advanced stills will be held (just as
they will when your title is ultimately played back on a DVD player), and can be ad-
vanced by pressing the Next button.
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Summary of Advanced Video Timeline Features
Spruce authoring software provides a wealth of advanced Video Timeline-related features,
for creating complex and effective DVD Movies. These include on-the-fly video concat-
enation; video insert editing; asset trimming; multi-angle and mixed-angle video; as well as
timed and user-advanced Slide Shows.

Next, let’s take a look at some of your Spruce authoring software’s advanced subtitle features.

•        •        •
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Chapter 12: 

Subtitles & Closed Captions
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Chapter 12
Subtitles & Closed Captions

In Chapter 6, we introduced subtitles and the Subtitle Editor window. In this chapter, we’ll
detail all the many ways in which subtitles and closed captions can be entered into your
Project. (Most of this chapter concerns subtitles, working with closed captions, or “Line
21” information, which is relatively simple, and is covered at the end of this chapter.)

There are two main ways to add subtitles to a Project:

• using individual subtitles typically created within Spruce authoring software;

– or –

• importing prepared subtitles files, which are also known as “script” files, and can
contain multiple subtitles.

Let’s begin with an comparison of these different methods — and then some examples of
working with both individual subtitles and subtitles files — before looking at some of the
more advanced ways you can work with subtitles.

Note: Portions of this chapter also appear in Chapter 6 and are repeated here for completeness.

Individual Subtitles vs. Subtitles (Script) Files
DVDMaestro and DVDConductor support two types of individual subtitles:

• individual text-based subtitles you create yourself, one-by-one, using the Subtitle
Editor (which can be edited for both color and opacity, as well as text information);

• imported graphic-based subtitles (which can be edited for color and opacity, but not
text information). 

While subtitles created by typing in the Subtitle Editor are always text-based, an imported
graphic-based subtitle could contain text (as part of its image), or a graphic illustration or
photo, or a combination of both text and picture. Also, when you import a graphic image file
for use as a subtitle, Spruce authoring software color maps it, much like a subpicture is color
mapped when imported into a DVD Menu (we’ll learn more about this later in the chapter).
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DVDMaestro and DVDConductor also import two types of subtitles (script) files:

• Spruce Technologies format (.stl) — which supports both text-based subtitles (fully
editable for color and opacity, as well as text information) and graphic-based subtitles
(editable for color and opacity). 

• Daikin-Comtec Laboratories Scenarist™ bitmap-based format (.son) — a graphic-
based subtitles format (editable for color and opacity, but not text information).

Support for .son subtitles files is not available in the standard version of DVDConductor.
It may be added by installing the DVDMaestro upgrade.

Unlike individual subtitles, both “.stl” and “.son” subtitles files are text files that typically
contain a specially coded, or scripted, list of up to thousands of subtitles, each
timestamped — with start and end timecodes embedded as part of the file’s scripting
information. This way, when you import a subtitles file into a subtitle track, each of that
file’s subtitles will appear in the track, starting — and ending — at their timestamped
locations.

Note: Once in place in the Subtitles Timeline, a subtitles file typically does not look like
one long asset. Rather, each of the subtitles it contains will be appear independent of one
another, in the track, at their respective timecodes.

On the other hand, individual subtitles are just that: single subtitle images that you can
import or create, one at a time, using the Subtitle Editor. Individual subtitles start off
without a timecode. However, once you position them in a track, they will be
timestamped accordingly.

Note: You can view the subtitle type and other useful information by ALT-double-clicking
on the subtitle asset within the Subtitle Timeline. (You can also right-click on the asset and
select PROPERTIES.) This is detailed near the end of this chapter (see “Reviewing Subtitle Asset
Properties”).
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Individual Subtitles Overview

The Subtitle Timeline has up to 32 separate subtitle tracks. This way, for instance, track 1
could hold English subtitles, track 2 could hold French subtitles, and so forth. As with
video and audio tracks, during playback only one subtitle track at a time can appear
onscreen as the active subtitle stream.

Using your Spruce authoring software’s Subtitle Editor, you can easily add individual
subtitles to any track, at any location in time.

Creating an Individual Subtitle
To create an individual subtitle, you will begin by opening the Subtitle Editor window.

Right-clicking in any subtitle track will present this context menu; select ADD INDIVIDUAL SUBTITLE to open the Subtitle Editor.
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To open the Subtitle Editor:

1. Right-click anywhere in the Subtitle Timeline (for now, use track 1).

2. From the pop-up context menu, select ADD INDIVIDUAL SUBTITLE.

3. The Subtitle Editor will appear onscreen.

The Subtitle Editor.

As you can see in the screenshot above, the Subtitle Editor shows the current video frame
that corresponds to the position where you clicked the mouse. The right-hand portion of
the window provides various tools for entering subtitles and controlling their onscreen
appearance and position.

You can type the text for an individual subtitle in the Subtitle Editor’s Text field.

To type text for an individual subtitle:

1. With the Subtitle Editor open, click once within the Text field.

2. Type the desired text. Add carriage returns as needed to fit text within the dotted lines
in the screen image.
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Text entered in the Text field appears in the Subtitle Editor’s display area.

As you enter text, you will see that text rendered as an overlay on the screen image in the
display area of the Subtitle Editor window, using the Font, Size, and Position settings
defined in the other fields of the window. (We’ll detail these settings later in this chapter.)

After you have entered the text you wish to include in the subtitle, you can save the
subtitle and exit the Subtitle Editor.

To save the subtitle and exit the Subtitle Editor:

1. Click on the OK button in the lower right of the Subtitle Editor window.

2. The Subtitle Editor will close and you’ll be returned to the DVD Movie.

Note: To exit the Subtitle Editor without saving the subtitle, click on the CANCEL button
in the lower right of the Subtitle Editor window.
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When you return to the DVD Movie, you will see the subtitle you created displayed as a
“block” shape — positioned in the same track (in this case, track 1) and at the same
location at which you right-clicked the mouse to open the Subtitle Editor. By default, the
initial duration applied to subtitles entered in this way is five seconds; that is, during
playback, the subtitle will appear onscreen for five seconds from its starting point. As we’ll
learn later in this chapter, duration and other attributes for any subtitle are easily changed
later on.

Once you save the subtitle by clicking OK in the Subtitle Editor, it will appear in the Subtitle Timeline as a “block”-
shaped icon, in whatever track you initially right-clicked. Assuming you’re working with a text-based subtitle, its
corresponding text will appear in icon. (In the screenshot above, there’s only room for the letter “Y” from the first
word “You.”

Note: If you are working with a 16:9 Widescreen aspect ratio, be sure to review “Stream-
Mapping Subtitles for Different Aspect Ratios,” near the end of this chapter.

Importing a Graphic Image File for Use as a Subtitle
As we mentioned, you can also import a graphic image file to serve as an individual
subtitle. This file can contain an image of rendered text, or some type of arbitrary graphics,
or a combination of rendered text and graphics.
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Note: When imported for use as subtitles, Spruce authoring software color maps graphic
image files in the same way that subpictures are color mapped for use in DVD Menus (as
described in Chapters 7 and 8). Consequently, as we’ll discuss later in this chapter (“Color
Mapping Considerations for Graphic Image Files”), these files should ideally consist of no
more than four colors.

To import a graphic image file for use as a subtitle: 

1. Right-click anywhere in the Subtitle Timeline (for now, use track 1).

2. From the pop-up context menu, select ADD INDIVIDUAL SUBTITLE.

3. The Subtitle Editor will appear onscreen, showing the current video frame at the
location where you clicked the mouse.

4. Under the Subpicture tab, check BITMAP FILE, as shown below:

Note: Even though this checkbox says BITMAP FILE, you can use it to import any of the
standard graphic file formats that Spruce authoring software currently supports (.bmp,
.jpg., .tif., etc.).

5. Once you do so, most of the controls and parameters in the Subpicture tab will be
grayed out, with the exception of the Bitmap File field and its associated Browse
(“…”) button.
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6. You can type in the name of the desired file in the Bitmap File field, if you know it
(be sure to include the complete directory path, as pictured in the screenshot above).
Otherwise you can click the Browse button, which will open the Select Subtitle
Bitmap File dialog:

7. Use this dialog to locate and select the bitmap file you wish to use. Click OPEN button
or hit the Return key. The dialog will close and you’ll be returned to the Subtitle
Editor.

Once you import the image file, it will appear in the Subtitle Editor’s display area. In the screenshot above, we can see a
series of faint characters and symbols (an “X,” a “?,” etc.), plus a faint border — these are all part of the imported file.
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The selected image will appear “overlaid” on top of the still video frame. At this point, you
cannot add or delete text (assuming the image has text) — although, as we’ll cover later in
this chapter (see “The Subtitle Editor”), you can adjust the onscreen position and duration
of the image and you can also change its colors.

Note: When you first import a graphic image file, you’ll notice that its onscreen colors
probably won’t match its actual (source) colors. The image may also appear to be faint.
This is because the file’s source colors are being color mapped according to the settings of
the Color Map and Opacity controls (see “The Colors Tab,” below).

Now you can save the subtitle and exit the Subtitle Editor.

To save the subtitle and exit the Subtitle Editor:

1. Click on the OK button in the lower right of the Subtitle Editor window.

2. The Subtitle Editor will close and you’ll be returned to the DVD Movie.

Note: To exit the Subtitle Editor without saving the subtitle, click on the CANCEL button
in the lower right of the Subtitle Editor window.

Just as when you create subtitles by typing them in the Subtitle Editor, when you return to
the DVD Movie, the new subtitle will appear positioned in the same track (in this case,
track 1) and at the same location at which you right-clicked the mouse to open the Subtitle
Editor. The default duration applied to graphic-based subtitles is also five seconds; that is,
during playback, the subtitle will appear onscreen for five seconds from its starting point
— and as we’ll learn, this and other attributes can be modified at any time.

Note: If you are working with a 16:9 Widescreen aspect ratio, be sure to review “Stream-
Mapping Subtitles for Different Aspect Ratios,” near the end of this chapter.
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Subtitles (Script) Files Overview

As we introduced earlier, DVDMaestro and DVDConductor import two types of subtitles
files (sometimes called “script files”), each which can containing multiple subtitles,
complete with timestamping information. These two types include:

• Spruce Technologies format (.stl) — which supports both text-based subtitles (fully
editable for color and opacity, as well as text information) and graphic-based subtitles
(editable for color and opacity). 

• Daikin-Comtec Laboratories Scenarist™ bitmap-based format (.son) — a graphic-
based subtitles format (editable for color and opacity, but not text information).

Note: As we’ll be discussing throughout this chapter, in addition to being text-based,
subtitles imported as part of a .stl file can also be graphic-based, where the subtitle is
actually a graphic image. Any text information that may appear in a graphic-based sub-
titles cannot be edited.

You can import .stl or .son files using the same procedure. . .

Importing a Subtitles File
Subtitles files are special files that are created outside of the Spruce authoring software
environment. In other words, you’ll need to have created and saved the file before you
import it into DVDMaestro or DVDConductor.

Note: Subtitles files must be scripted according to very specific guidelines. For more
information, see “Creating Subtitles (Script) Files”, later in this chapter.
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Importing a subtitles file.

To import a subtitles file:

1. Right-click anywhere in the Subtitle Timeline (for now, use track 1).

2. From the pop-up context menu, select IMPORT SUBTITLES FILE.

3. The Open Subtitle Import File dialog will appear:

3. Using this dialog, navigate to and select the text file that contains the script informa-
tion you want to import. Click OPEN.
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4. The dialog will close and you’ll be returned to the DVD Movie.

5. As you can see above, once you’ve imported the desired subtitles file, all of its
subtitles will be is positioned simultaneously at their respective timestamps in the
Subtitle Timeline — whether the file contains six subtitles or 6,000. An alert message
(as shown above) will report the number of subtitles imported as part of the file. Click
OK or hit the Return key.

Note: If you see an error message when you import a subtitle file, rather than the
confirmation above, the likeliest cause is an error in the scripting of the source
subtitles file. Refer to the description of script file formats later in this chapter to
identify and correct the error or errors.

Timestamp information for subtitles files contains both “Start” and “End” times; in other words,
these subtitles will be positioned both in terms of starting time and duration. (This is different
from individually created subtitles or imported graphic image files, which are assigned a
default duration of five seconds.) However, once you’ve imported a subtitles file, you can
reposition its associated subtitles (and change other attributes), as we’ll be covering.

Note: If you are working with a 16:9 Widescreen aspect ratio, be sure to review “Stream-
Mapping Subtitles for Different Aspect Ratios,” near the end of this chapter.
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Working with Multiple Subtitle Tracks

Your Spruce authoring software supports multiple subtitle tracks — 32 tracks in DVDMaestro.

By using multiple subtitle tracks, you can author a title with subtitles in alternate languages
and assign language codes to their respective tracks, as discussed later in this chapter (see
“Assigning Language Codes to Subtitle Tracks”). You can also create different subtitles
tracks that are optimized for different aspect ratios, as discussed in this chapter in the
section entitled, “Stream-Mapping Subtitles for Different Aspect Ratios”.

To add subtitles to a new track:

1. Right-click in the desired track.

2. Proceed as we’ve described earlier by selecting either ADD INDIVIDUAL SUBTITLE or IMPORT

SUBTITLES FILE from the context menu.

3. Once the subtitle has been saved or the file has been imported, the subtitle(s) will
appear in the new track.

The Subtitle Timeline, showing two tracks of subtitles. Note that subtitle track 1’s track number button is high-
lighted; this indicates that track 1 is set to be the active subtitle stream.
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As we first described in Chapter 6, remember that at any given time, only one subtitle track
can serve as the “active” subtitle stream during playback. To make a subtitle track active,
you simply click on its track number button (“1,” “2,” etc.). The button will turn red,
indicating that it will be the active track when you next preview your work.

Just like audio tracks, each subtitle track also has an associated language code button
(located to the immediate left of the track number button). We’ll cover more on this topic
in a few pages.

Previewing Subtitles

Once you created or imported subtitles, you’ll likely want to see how they look onscreen,
in terms of position, duration, and more. This is easily done using your Spruce authoring
software’s RealView Previewer feature.

To preview subtitles using the RealView Previewer:

1. Click with the mouse on the left-hand subtitle track number button for the subtitle
track you wish to view. This will select that track to be the active stream.

2. Hit the Play/Pause transport control button (or your keyboard’s spacebar).

Note: If you wish, before you begin playback, you can move the PlayCursor to a
position just before the first subtitle; this way, you won’t have to wait so long to see
the subtitle.

4. The selected subtitle track will be displayed superimposed over the video in the
RealView Previewer and, if you have one connected, on your external NTSC/PAL
video monitor.

Note: As with video assets, for the most accurate representation possible of how the
subtitles will look once your title is complete, we recommend you preview subtitles
using an NTSC/PAL video monitor.

You can also preview subtitles using the Navigation Simulator. This approach has some
advantage in that you can switch between one subtitle track and other during play using
the Navigation Simulator’s Stream Selection controls — much in the same manner as
changes the video track during play (as we covered in Chapter 11).
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To preview multiple subtitle tracks using the Navigation Simulator:

1. Launch the Navigation Simulator by clicking on its icon in the main Toolbar or by
choosing NAVIGATION SIMULATOR in the Tools pull-down menu; or by pressing the
keyboard shortcut ALT – S.

2. Once the Navigation Simulator launches:

• if the DVD Movie you wish to view is connected as the Project’s First Play item,
playback will begin in a few seconds;

– or –

• use the Navigation Simulator’s controls to navigate to the desired DVD Movie;
after which playback will begin.

3. Once playback begins, you can use the Subtitle pull-down field (in the Stream
Selection section in the lower-left of the window) to choose which subtitle track will
be the currently active stream.

Note: When you switch subtitle tracks using the Navigation Simulator, the new
subtitle track will not appear until the next individual subtitle comes up. This mirrors
the behavior of consumer DVD players.

Modifying Subtitle Duration & Position
Within the Subtitle Timeline

As we’ve already learned:

• individual subtitles (both those created within Spruce authoring software and those
imported as graphic image files) are preliminarily positioned in the Timeline (at the
exact location where you originally right-clicked to open the Subtitle Editor), with a
default duration of five seconds;

• subtitles that were imported as part of a subtitles (script) file are initially positioned in
a track at their respective scripted timestamps, which define Start and End (hence
duration) times.
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As we’ll detail in the next section, using the Subtitle Editor, you can directly input Start and
End time values for each subtitle in the Timeline, regardless of how it was created or
imported. For now, let‘s review how you can modify each subtitle’s length and position
from directly within the Subtitle Timeline. . .

Trimming Subtitles
In Chapter 11, we learned how you can trim the “head” (beginning) and “tail” (end) of video
assets. In a similar manner, you can trim subtitles to change their start and end times.

To modify a subtitle’s duration by trimming its head or tail:

1. Position your mouse near the head or tail of the desired subtitle in the Subtitle
Timeline. You’ll notice the cursor change from an ordinary arrow to a “bracket” with
a small arrow, as pictured below.

2. Left-click and hold, then drag the mouse to the left or the right. Dragging the head of
the subtitle adjusts its start time; dragging the tail adjusts the end time.

3. Once your cursor is where you wish to trim to, release the mouse. The subtitle’s
overall onscreen duration is the resulting distance between the head and tail.

After changing the duration, you can preview the altered subtitle as described previously.
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Repositioning Subtitles
You can also reposition a subtitle by dragging it to a new location in it track, without
changing its duration.

To reposition a subtitle without affecting its duration:

1. Click and hold within the “body” of the subtitle in the Subtitle Timeline.

2. Drag it within the Timeline to position it as desired and release the mouse.

Deleting Subtitles

You can delete any subtitle in the Subtitle Timeline simply by right-clicking on it and
selecting DELETE SUBTITLE from the pop-up context menu.

Deleting multiple subtitles is slightly different…

To delete multiple subtitles:

1. SHIFT-click on the subtitles you wish to delete.

2. Press the Delete key on your keyboard.

– or – (this approach is especially handy if you have lots of subtitles to delete…)

1. First, select all the subtitles in a track by clicking once on any single subtitle.

2. Then choose SELECT ALL from the Edit pull-down menu. (If you need to remove one or
more subtitles from the selection, you can then shift-click on them.)

3. Finally, with all the subtitles selected that you wish to delete, simply press the Delete
key on your keyboard.
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Assigning Language Codes to Subtitle Tracks

For DVD titles that contain subtitles in multiple languages, you can specify the language of
each subtitle track; the process is very similar to assigning language codes to audio tracks,
as described in Chapter 6.

When playing back your final, replicated disc, the DVD player can use this setting to play
back the correct subtitle when the viewer selects subtitles by language. The DVD player
can also use this information to display the name of the selected language onscreen.

Note: You should always define the language setting when using multi-language subtitle tracks.

The Select Language Code dialog.

To define the language setting of an subtitle track:

1. Click once in the track’s language code button (located to the immediate left of the
track number button).

– or –

Right-click anywhere in the track and when the context menu appears, select
LANGUAGE.
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2. The Select Language Code dialog will appear. Choose any one of the available
languages by language code or language name.

3. Click OK (or just double-click on the language choice).

– or –

If the track does not contain dialogue of a particular language (for instance, if it’s
instrumental music, etc.) select the LANGUAGE NOT SPECIFIED checkbox and click OK.

The correct language designations will appear in each track’s language code button.

This close-up of the Subtitle Timeline shows multiple subtitle tracks. Note the different language codes, as
indicated by each track’s respective language code button (to the left of the track’s track number button).

The Subtitle Editor

As we’ve learned up to this point, the Subtitle Editor is used for creating individual subtitles
within Spruce authoring software or for importing individual graphic-based subtitles. It’s also
used for editing any existing subtitle — even those originally imported as part of a subtitles
(script) file — giving you the tools you need to modify its textual content (where applicable),
onscreen position, appearance, and more using a variety of controls and effects.

Note: Remember, subtitles imported as image files, including graphic-based .stl subtitles,
or any Daikin-format .son subtitles, cannot be edited for textual content — since text
(assuming there is any) is simply part of the image. In this case, you would need to return
to the source file and edit it using the appropriate application (such as Photoshop). Still,
image files can be edited for color, opacity, onscreen position, etc.

As described earlier, to create an individual subtitle (or to import a graphic image file), first
you open the Subtitle Editor window by right-clicking in a subtitle track and selecting ADD

INDIVIDUAL SUBTITLE from the pop-up context menu. To modify an existing subtitle, the
procedure is similar…
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To open the Subtitle Editor window to modify an existing subtitle.

• In the Subtitle Timeline, right-click on the subtitle you wish to modify. From the pop-
up context menu, select EDIT SUBTITLE.

– or –

• Double-click on the subtitle you wish to modify.

Right-clicking on any subtitle in the Timeline will produce this context menu. Select EDIT SUBTITLE to open the
Subtitle Editor.

The Subtitle Editor will open with all of the current information displayed for the selected
subtitle.

The most basic operation of the Subtitle Editor window (entry by typing text) has been de-
scribed already. Let’s take a closer look at the features and functions of the Subtitle Editor.

Chapter 12: Subtitles & Closed Captions 12-23

12

 

The Subtitle Editor, showing the display area (left), the common parameters (upper right), and Subpicture, Colors,
and View Options tabs (middle/lower right).

You can see that the Subtitle Editor consists of three main sections:

• the display area, where you can view the current subtitle superimposed over a still-
frame video image;

• several common parameters that apply to all subtitles, including Start and Stop
Times; Fade In and Out durations, and the Forced Display option;

• and three tabs, whose parameters can vary depending upon what type of subtitle
you’re working with; they include:

° the Subpicture tab;

° the Colors tab;

° and the View Options tab.

Note: When creating interactive subtitles, as described later in this chapter, a fourth tab
appears — the Button tab.
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The Display Area
The Subtitle Editor’s display area is where you get to see your work in progress.

Note: What you actually see in the display area can be affected by the current settings of
the View Options tab (see “View Options Tab,” below). For now, we’ll presume that the
View Layer section is in its default setting, which is BOTH.

Whenever you open the Subtitle Editor, its display area will show a still-frame image of the
video asset. If you’re creating or importing a new subtitle, this frame will correspond to the
exact time where you right-clicked in the Subtitle Timeline. If you’re editing an existing
subtitle, this frame will correspond to the subtitle’s current Start Time — regardless of
where you clicked on the subtitle in the Subtitle Timeline.

The current subtitle will appear superimposed on top of the still frame. As you make
changes to any text or parameters applying to the subtitle, the changes are reflected
immediately in the display area, providing interactive feedback.

The display area, showing a subtitle over a background video image. We can also see a border that indicates the
video safe area (this can be disabled if you desire).
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Common Parameters
The Subtitle Editor’s common parameters — which (unlike certain other settings) apply to
any kind of subtitle — are located in the upper-right corner of the Subtitle Editor.

The Subtitle Editor’s common parameters section includes
Start and Stop times, Fade In and Out, and the Forced Display option.

The common parameters include Start and Stop (end) times of the current subtitle, along
with values for Fade In and Fade Out effects and a checkbox for Forced Display.

You can modify any of these parameters directly in this portion of the Subtitle Editor. Let’s
take a closed look at them…

Start & Stop Times

The Start and Stop Time fields show the time at which the current subtitle begins and ends.

To change the Start time or Stop time in the Subtitle Editor window:

1. Select the field you wish to modify (Start Time or Stop Time). Its numbers will appear
highlighted in red.

2. Enter the complete time value in HOURS:MINUTES:SECONDS:FRAMES.

3. Hit the Return or Enter key on your keyboard.

If you change the Start time, the still frame in the display area will change to show the new
corresponding start location.

Subtitle Start and Stop times can be entered for any frame, with only two restrictions:

• No two subtitles in a subtitle track can overlap.

• A subtitle cannot overlap a Chapter Point Marker. If it does, the subtitle will disap-
pear from view when the Chapter Point Marker is reached during playback.

Note: It is possible for a subtitle to be physically positioned across a Chapter Point
Marker boundary in the Subtitle Timeline — however, this playback caveat still applies.
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Fade In and Fade Out Times

The Fade In and Fade Out parameters are used to apply a transitional effect as the subtitle
starts and ends. The fade times are entered in frames, and the fade effects can be seen with
the RealView Previewer and Navigation Simulator, as well as in the final compiled title.
Fade times can be set individually for every subtitle.

Note: The DVD-Video specification provides for only 16 opacity levels. Because of this,
slow fades (larger values) will tend to show visible “stepping.” Therefore, we recommend
using values of 20 frames or less for the Fade In and Fade out times.

Forced Display

The Forced Display checkbox is used to force display of a given subtitle — 

even when subtitle

display is not enabled on the viewer’s DVD player. This can be applied selectively to any subtitle, so
that certain subtitles — such as name tags, copyright notices, or location identifiers — can be forcibly
displayed even when other subtitles, such as dialog, are switched off on the player.

Subpicture Tab
Much of the basic editing of subtitles takes place in the Subpicture tab. Before we describe
this tab’s actual controls, however it’s important to understand why it has this name.

The Subtitle Editor’s Subpicture tab.
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Why Do We Refer to ‘Subtitles’ as ‘Subpictures’?

You may be curious as to why this tab is labeled SUBPICTURE. After all, as we covered in
Chapter 7, subpictures are images you import into DVD Menus — so why are we using
this term here?

The reason is that technically speaking — at least, as far as the DVD-Video Specification is
concerned — a subtitle is a subpicture. Practically speaking, it’s true there are some
differences. For one, we think of subtitles as what we overlay onto DVD Movies, not DVD
Menus. We can also create subtitle text information using the Subtitle Editor. And subtitles
can be scripted in great numbers into subtitles files.

Even so, the relationship between a DVD Movie’s subtitles and its video assets (or still
images, in the case of Slide Shows) is essentially the same as the relationship between a
DVD Menu’s subpicture image and background image. For instance, in DVD Menus,
subpicture images are overlaid on top of background images; similarly, subtitles are
overlaid on top of the DVD Movie’s video (or still images). Furthermore, since they’re
technically subpictures, subtitles are subject to similar color and opacity modifications.

Several terms used in the Subtitle Editor reflect this relationship. To begin with, there’s the
Subpicture tab. As we’ll learn, there are also color and opacity controls, found in the
Colors tab. And finally, as we’ll detail in a few pages, the View Options tab lets you
choose whether you’re viewing the SUBPICTURE (the subtitle), the BACKGROUND (the current
still-frame video image), or BOTH.

Now let’s review the controls and parameters…

Bitmap File

As we described earlier, this checkbox will be selected when working with any graphic-
based subtitle. This includes graphic image files that are imported for use as individual
subtitles; graphic-based subtitles that are imported as part of a .stl subtitles file; and any
subtitles imported as part of a .son subtitles file.

When the BITMAP FILE checkbox is selected, the Bitmap File field is also enabled and will list
the name of the current file being edited. To import a new file, just click the adjacent
Browse (“…”) button. You can import any of the standard graphic file formats that Spruce
authoring software currently supports (.bmp, .jpg., .tif., etc.).

Note: When BITMAP FILE is selected, the only other parameters which can be changed in the
Subpicture tab are the Horizontal and Vertical Offset fields. This is because bitmap files do not
contain text information that can be edited (even though the image itself may have text).
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Text, Font Name, & Font Size
not available when working with graphic-based subtitles

Spruce authoring software gives you full text-editing capabilities when working with
subtitles that are individually created using the Subtitle Editor or with text-based subtitles
that have been imported as part of an .stl subtitles (script) file.

Text content can be entered or edited directly in the Text field. (You must first click within
the field or else hit the Tab key until the entry cursor appears in the field.)

To select the font style for the subtitle, click on the Font Name pull-down field. This lists
all TrueType fonts installed in your computer system. If you need to use other fonts (in-
cluding non-Western languages), first they’ll need to be installed.

Font size can be assigned using the Font Size pull-down field.

Note: As you change the Font Name and Font Size fields, you’ll notice they apply to the
entire subtitle. There is no way to mix fonts within a single subtitle, although every subtitle
may use a different font if you so desire.

Bold, Italic, & Underlined
not available when working with graphic-based subtitles

The character attributes of Bold, Italic, and Underlined can be assigned for the whole
subtitle or for individual words, characters, or phrases within the subtitle.
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The Bold, Italic, and Underlined checkboxes underneath the Font Size field select the
particular attribute for the whole subtitle. Use these if you want to change the appearance
of the current subtitle in its entirety.

To affect individual words and characters in a subtitle, you must embed “control codes”
into the text string that makes up the subtitle.

Note: If you are scripting .stl subtitles, bold, underlined, and italic control codes can be
imbedded directly in the text of the file; for more on this, see “Creating Subtitles (Script)
Files,” later in this chapter.

Control codes can be typed directly into the Text field and consist of an “up arrow” (^)
character followed by the letters B, U, or I. The first instance of this will switch on the
designated attribute; the second instance will switch it off.

For instance, as you can see in the next screenshot:

• ^B

° toggles Bold attribute on or off (e.g., “This is ^Bbold^B text ”).

• ^U

° toggles Underline attribute on or off (e.g., “This is ^Uunderlined^U text ”).

• ^I

° Toggles Italic attribute on or off (e.g., “This is ^Iitalic^I text ”).

These attributes may be combined as desired.

• ^B^U^I  (e.g., “This is ^B^U^Ibold/underlined/italic^B^U^I text ”)
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Four examples (detailed just above) of how control codes can be used to affect character formatting.

Horizontal & Vertical Position; Horizontal & Vertical Offset
position controls not available when working with

graphic-based subtitles (offset controls are available)

The alignment and positioning of text on the screen can be controlled with great precision,
using a combination of two sets of controls: Horizontal and Vertical Position and Horizon-
tal and Vertical offset. With them, you can assign text to appear onscreen anywhere you
wish.

The Horizontal and Vertical Position radio buttons (not available when working with
graphic-based subtitles) are found at the bottom of the Subpicture tab. They control both
the alignment of text and its initial onscreen position. For example, if you select RIGHT for
Horizontal Position and TOP for Vertical Position, the text will align to the right and will
appear in the upper right corner of the display area, as shown below.
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This subtitle is aligned according to the Horizontal and Vertical Position settings (RIGHT and TOP, respectively).

The onscreen positioning of text can be controlled precisely with the Horizontal Offset
(HORIZ OFFSET) and Vertical Offset (VERT OFFSET) fields. (These settings are available for either
text-based and graphic-based subtitles.) These are values in pixels that shift the text
position as a unit, without affecting alignment within the text itself.
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Using the Horizontal and Vertical Offset fields to shift the precise positioning of the subtitle.

Horizontal and Vertical offsets are referenced to the upper-left corner of the display area.
Thus, positive offset values for Horizontal and Vertical Offset move the text image to the
right and downward, respectively. Negative values move the text to the left and upward.

You may find that you need to shift text by some amount to keep it within the video safe
area, as indicated by the safe area outline, which is described below in “View Options
Tab.” (It’s best to be well within the safe area to respect “title” safe).

The Colors Tab
The Subtitle Editor’s Colors tab is used to define the display the colors and opacity of
subtitles, as they will appear onscreen.
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The Subtitle Editor’s Colors tab, as it appears when working with text-based subtitles (detailed just below).

The uppermost section of this tab — which contains the Subpicture Color Map controls —
determines the overall appearance of the text or graphic source information.

Note: As we’ll learn later in this chapter (“‘Interactive’ Subtitles: Adding Button Highlight
Areas to DVD Movies”), the Colors tab is also used to set Button Selection and Button
Action colors (which initially appear blank). For now, however, we’ll simply consider the
Color tab’s Subpicture controls.

These controls change somewhat depending on whether the subtitle content comes from
text (i.e., individually created subtitle or an imported .stl subtitles file) or from a graphic
source (i.e., an imported graphic image file or .son subtitles file). Let’s look at the two
variations…

Color Assignments for Text-Based Subtitles

When working with text-based subtitles (including text-based subtitles imported as part of
a .stl subtitles file), the Colors tab will appear as shown below.

Note: When you work with graphic-based subtitles, the Subtitle Editor has somewhat
different color controls.
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For text-based subtitles, the Colors tab offers four categories of Subpicture controls: Text, Outline 1, Outline 2, and
Background.

The Subtitle Editor’s Colors tab includes a collection of Subpicture controls for establishing
the colors and opacity of a subtitle. (As you may recall from Chapters 7 and 8, “opacity” is
essentially the opposite of translucency.)

The Subpicture controls are broken into four categories:

• Text — to set the color of the actual text;

• Outline 1 — to set the outline color as it is applied to each individual letter of the text;

• Outline 2 — to set an optional “second outline” that goes outside Outline 1; and

• Background — to set the color of the area behind the text (this includes the entire
screen).

Note: Normally, when crafting text-based subtitles, no background coloring is
applied, since it will cast a hue over the entire video asset for the duration of the
subtitle. This is done by setting the Background Opacity slider to “0,” as we’ll discuss
on the next page.
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Each of these four categories can be adjusted for color and opacity (which determines how
translucent or opaque the color is.)

Let’s look first at changing colors.

To change a text-based subtitle’s colors:

1. Click once on one of the four category’s color swatches (for TEXT, OUTLINE 1, OUTLINE 2,
or BACKGROUND). A palette of 20 colors will appear. 

2. Choose any of the 20 colors by clicking on them; this will set the category’s color.

– or –

2. To set a custom color, click on OTHER; a custom palette will appear, where you can
define any one of millions of different colors by using the Hue, Saturation (SAT), or
luminescence (LUM) fields; the Red, Green, or Blue fields; or by clicking in the 2-D
selection palette and adjusting the right-hand vertical control.

Note: Depending upon your monitor color-depth settings, as defined in the Windows
NT Display control panel, you may not be able to visually distinguish every color.
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3. To use the custom color, click OK. (You can also save the color for use with another
subtitle by saving it as one of 16 different “custom colors”; this is done by selecting
the color and then clicking ADD TO CUSTOM COLORS.)

Now let’s consider the Opacity sliders: As with subpictures in DVD Menus (Chapter 7),
increasing the Opacity value makes the associated subtitle color more opaque; decreasing
the value makes the associated subtitle color more translucent. In other words, if you want
the Text colors to completely block out the underlying video, you’ll want to set its Opacity
value to “15”; if you want the Text colors to be somewhat translucent, you might set the
Opacity value to “8” or thereabouts. (For more information, please see “Opacity Sliders,”
in Chapter 7.)

To change a subtitle Opacity value:

1. Click and drag the horizontal slider corresponding to category (TEXT, OUTLINE 1, OUTLINE

2, or BACKGROUND) you wish to affect.

2. As you move the slider left or right, you’ll see the number displayed in the category’s
color swatch change in value, from “0” (invisibly translucent) up to 15 (fully
opaque).

3. Once you release the mouse, you’ll see changes reflected immediately in the display
area.
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Color Assignments for Graphic-Based Subtitles

When working with graphic-based subtitles, the Colors tab will appear as shown below.

Note: This tab will appear like this with any subtitle created by importing a graphic image
file; or with any graphic-based subtitle imported as part of a .stl subtitles file; or with any
subtitle imported as part of a .son subtitles files.

For graphic-based subtitles, the Subpicture controls change to Color Map controls. Note the far-left non-adjustable

color swatches, which represent what colors in the original image file will be assigned to which of the four Color
Maps. The right-hand color swatches are editable so that you can determine the onscreen color of each Color Map.

As you can see, the Subpicture controls now show four Color Maps, each with two
associated color swatches and Opacity slider.

Note: While these controls are actually easy to operate, the principles of color mapping
can be initially bewildering. If you are not already comfortable with color mapping, we
strongly recommend you review “DVD Menu Controls: Color Mapping Tab,” in Chapter 7,
as well as “Understanding Color Mapping,” in Chapter 8, before continuing in this section.
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These controls operate in virtually the same way as the Subpicture Color Map controls
found in all DVD Menus (as described in Chapters 7 and 8). This is because once you
import a graphic-based subtitle into Spruce authoring software, its original source colors
will be “color mapped” according to how these controls are set — in the same way as a
subpicture image is color mapped once you import it into a DVD Menu.

We mentioned that each of the Color Map controls has two associated color swatches. The
far-left column of swatches cannot be changed. Rather, they serve to represent what colors
in the source image file will be assigned to which of the four Color Maps.

Note: For more about how color mapping applies to graphic-based subtitles, please “Tips
for Preparing Source Image Files for Use as Graphic-Based Subtitles,” below.

The Color Map color swatches. The far-left column cannot be changed; the right-hand column of swatches can be
edited, as we’ll detail next.

To the right of these four swatches you can see a column of slightly larger color swatches.
These are modifiable by the user, and control the color that each source color will assume
when it’s imported into Spruce authoring software and color mapped.

Using these, you can assign any 24-bit RGB color to each of the four Color Maps.

Changing a Color Map color.
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To change a graphic-based subtitle’s Color Map colors: 

1. Click once on one of the four Color Maps editable color swatches. A palette of 20
colors will appear. 

2. If the color you need is available in this palette, select it by clicking it once.

– or –

If you don’t see the color you need, click OTHER at the bottom of the palette; a custom
palette will appear, where you can define any one of millions of different colors by
using the Hue, Saturation (SAT), or luminescence (LUM) fields; the Red, Green, or Blue
fields; or by clicking in the 2-D selection palette and adjusting the right-hand vertical
control.

Note: Depending upon your monitor color-depth settings, as defined in the Windows
NT Display control panel, you may not be able to visually distinguish every color.

3. To use the custom color, click OK. (You can also save the color for use with another
subtitle by saving it as one of 16 different “custom colors”; this is done by selecting
the color and then clicking ADD TO CUSTOM COLORS.)

The color defined will become the new Color Map color to which all corresponding
source image pixels will be mapped.
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You can also adjust the Opacity value for each Color Map, where increasing the Opacity
value increases opaqueness; decreasing the value increases translucency.

The Opacity sliders (right); each Color Map’s current
Opacity value is shown in the right-hand column of color swatches.

To change a Color Map’s Opacity value:

1. Click and drag the horizontal slider corresponding to Color Map 1, 2, 3, or 4.

2. As you move the slider left or right, you’ll see the number displayed in the category’s
color swatch change in value, from “0” (invisibly translucent) up to 15 (fully
opaque).

3. Once you release the mouse, you’ll see changes reflected immediately in the display
area.

All changes that you make are reflected immediately in the Subtitle Editor’s display area.

View Options Tab
The View Options tab lets you select exactly what elements of the picture are shown in the
Subtitle Editor’s display area.
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The settings in the View Options tab determine what you see in the Subtitle Editor’s display area.

View Layer

The View Layer settings determine what you view in the Subtitle Editor’s display area.
(They do not affect what is seen in your final, compiled title.)

By setting the View Layer to be BOTH, you can see the subtitle and the “background” still-frame video image.
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The default selection for View Layer is BOTH. This shows both the “background” (the still-
frame video image) and the “subpicture” (the subtitle) overlay. (All screenshots so far in
this chapter show this mode of display.)

If you only wish to view the still-frame video image — that is, if you don’t want to see the
subtitle — select BACKGROUND. If you only wish to view the subtitle alone, without the still-
frame video image, select SUBPICTURE. Any changes you make here will be immediately
reflected in the display area.

When the View Layer is set to just BACKGROUND, the subtitle is no longer displayed.

Button Preview

These controls are designed exclusively for use with button highlight areas that are incor-
porated into DVD Movies. For more information, see “‘Interactive’ Subtitles: Adding
Button Highlight Areas to DVD Movies,” later in this chapter.
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Display

This section has three checkboxes.

If you select SAFE AREA — and also select either BACKGROUND or BOTH as your View Layer
options — a white dotted line will be displayed around the perimeter of the background.
This dotted line shows the recommend “safe area” boundary for consumer television
display. Any portions of the background (or subpicture) which are outside the safe area
boundary might not be seen when your final, replicated disc is played back through
conventional televisions.

If you select BUTTON OUTLINE, then button highlight areas that you incorporate into DVD
Movies will have outlines that are visible in the display area. For more information, see
“‘Interactive’ Subtitles: Adding Button Highlight Areas to DVD Movies,” later in this
chapter.

Finally, if you select SUBPIC MAPPED (available only for graphic-based subtitles), then the
current Color Map settings will be applied to the image. If you deselect this option, then
you can view the image’s original source colors. (This is a useful tool for comparing
“before and after” versions of your subtitles.)

Tips for Preparing Source Image Files
for Use as Graphic-Based Subtitles

The DVD medium offers many powerful ways to display subtitles, but also imposes certain
limitations. In particular, whenever you incorporate a graphic-based subtitle into a DVD
Movie, you will need to be aware of how its source image file’s original colors will be
color mapped and how its size may impact its visibility and onscreen positioning.

How Graphic-Based Subtitles are Color Mapped
You’ll recall that subtitles are essentially subpictures — and as we learned in Chapters 7
and 8, subpictures are a type of “overlay,” or “mask,” that sits on top of a DVD Menu’s
background image. In the case of subtitles, this background image is actually a DVD
Movie’s video information (or still images, in the case of Slide Shows).
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Subtitles, like other subpictures, also have no inherent colors or opacity — other than what
you define for them. In the case of text-based subtitles, these attributes can be defined
using the controls in the Subtitle Editor‘s Colors tab. For graphic-based subtitles, however,
the source image file will, of course, have its own original colors — which will be mapped
to new colors, as defined using the color mapping controls in the Subtitle Editor‘s Colors
tab. (Since the color mapping controls can be set differently for each subtitle, a single
source graphic can be used for many different subtitles, each time appearing in a com-
pletely different set of colors.)

Let’s consider an example. The picture below shows the source graphic image that was
prepared for the use in a graphic-based subtitle. Since this manual is not printed in color,
labels have been attached to show you the colors that appear in the original source. The
background portion of the image is white.

A sample source graphic image; the call-outs indicate the source (original) colors, all of which can be color
mapped to new colors.

Spruce authoring software uses the following convention for color mapping:

• Every pixel that is red in the source graphic image file is mapped to Color Map 1.

• Every pixel that is black in the source file is mapped to Color Map 2.

• Every pixel that is blue in the source file is mapped to Color Map 3.

• Every pixel that is white in the source file is mapped to Color Map 4.
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Therefore, the top row of black icons will get mapped to Color Map 2. Once you import
the image into Spruce authoring software for use as a subtitle (either via the Subtitle Editor
or as part of a subtitles file), these icons will become whatever 24-bit RGB color you
choose for Color Map 2 (see “Color Assignments for Graphic-Based Subtitles”). Similarly,
the row of red icons will become whatever color you choose for Color Map 1; the row of
blue icons and the image’s border) will become the Color Map 3 color.

As for the white background portion of the image, it will be mapped to Color Map 4 —
although you’ll probably want to set its Opacity level to “0” so that it remains invisibly
translucent. (Otherwise, if you were to increase that level, it would begin to mask the DVD
Movie’s video or still image.)

Choosing Colors for Source Graphic Image Files

Whenever you create graphic image files for use as subtitles, we recommend you create
them using only red, black, blue, and white. This way, you’ll always know which portions
of your source image will be mapped to which Color Map, without guessing.

However, Spruce authoring software allows you to use any graphic image with any colors.
In this case, each of the image’s “in-between” colors are also are mapped to one of the
four Color Maps. For instance, orange or yellow pixels are all considered “red” and are
mapped to Color Map 1 — and all other colors are similarly mapped to red, black, blue, or
white. In other words, Spruce authoring software treats every subpicture image as if it only
has four original colors.

For more tips and examples of color mapping, please refer to Chapters 7 and 8.

How Source Image Dimensions Affect Onscreen Placement
The display size of a screen in DVD video is 720 x 480 pixels for NTSC or 720 x 576
pixels for PAL. Therefore, any graphic image prepared at this resolution will occupy the
entire screen and the placement of graphic elements in the source file will essentially
determine their position on the screen.

For subtitles, however, you may prefer to prepare source graphics at sizes smaller than the
full screen dimension. (This can save a lot of storage space, especially if you have thou-
sands of subtitles.) In this case, all screen pixels outside the boundaries of the source
graphic image will be treated as though they had been white.
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Once you import these “small” images, you’ll probably want to set the subtitle’s Color
Map 4 Opacity slider to “0,” so that anything outside of the source graphic is invisibly
translucent. Also, you’ll need to use the Horizontal and Vertical Offset settings to deter-
mine the image’s onscreen position.

The screenshot below shows a graphic image that has been imported for use as a graphic-
based subtitle. The image’s original size is 560 x 70 pixels and HORZ OFFSET and VERT OFFSET

(Horizontal and Vertical Offset) are both set to “0.” As you can see, the source graphic
appears at the upper left corner of the display area.

With HORZ OFFSET and VERT OFFSET both set to “0,” this relatively small (560 x 70) imported graphic image is “pushed
up” into the upper-left corner of the display area.

In the screenshot on the next page, values of “80” and “350” have been entered for the
horizontal and vertical offsets, respectively — which has shifted the source image down so
that it is positioned in the lower center of the display area. (Although you can’t see it, the
SUBPIC MAPPED option in the View Options tab has also been selected, which applies the
current Color Map settings; this is why the image’s colors are also different from the
previous screenshot.)
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Here, new HORZ OFFSET and VERT OFFSET values (“80” and “350,” respectively) have repositioned the imported image
to a more conventional subtitle location. Note also that for this screenshot, the SUBPIC MAPPED option in the View
Options tab has been checked; as a result, the imported image now appears color mapped (albeit, in black and
white on this page).

There are other things to consider when creating source image files for use as graphic-
based subtitles. For instance, there are pixel-dimension discrepancies that can be visible
when computer-generated images are viewed on an NTSC/PAL video monitor. For solu-
tions to these and other matter, please see “Creating Successful Background/Subpicture
Combinations,” in Chapter 8.

‘Interactive’ Subtitles: Adding Button Highlight
Areas to DVD Movies

Normally, subtitles are passive elements in a title: Viewers can watch them or (except for
forced-display subtitles) not watch them, but they can’t interact with them. However,
Spruce authoring software also allows you to add button highlight areas to a DVD Movie,
so that they function like “interactive” subtitles that viewers can select or actuate — just as
with button highlight areas in DVD Menus.
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This way, once you establish connections from these button highlight areas to new targets
(such as another DVD Movie or a DVD Menu), viewers can make onscreen navigation
choices as they watch the title, by selecting either a text-based or graphic-based subtitle.

Let’s look at a text-based example. In the screenshot below, we can see two choices:
“Make Love, Not War,” or “Make War, Not Love,” over each of which a button highlight
area has been defined. Using a remote control, the viewer can select either button high-
light — which, as we’ll see, will cause its associated text to change from its “Subpicture”
color to a “Button Selection” color (both of which you can define). Once the user actuates
the choice (typically by selecting the remote ENTER key), the text will change to its defined
Button Action color — and whatever navigation connection you’ve established will be
initiated.

This screenshot shows an interactive subtitle, offering two choices that can be selected by a remote control. These
choices have been created by defining button highlight areas over the subtitle text, as detailed below.

In order to create interactive subtitles, you’ll need to perform several steps:

1. Add Button Highlight Markers in the DVD Movie Marker Timescale; these will
establish where the “interactive” subtitle starts and ends.

2. In the Subtitle Editor, define the text you wish to appear in the interactive subtitle (or
import the source graphic file, for a graphic-based subtitle).
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3. Define one or more button highlight areas on top of the subtitle.

4. Set the Subpicture, Button Selection, and Button Action colors.

5. Establish source:target connections for the new button highlight areas.

6. Test the button highlight areas using DVDPlayer.

Let’s look more closely at each of these steps…

Adding Button Highlight Markers
In order to add a button highlight area to a DVD Movie, first you need to define one or
two Button Highlight Markers.

Button Highlight Markers are defined by checking BUTTON HIGHLIGHT as the Marker Type in the Edit Marker dialog.

Defining a Button Highlight Marker is much like defining a Chapter Point Marker, as we
detailed in Chapter 6.
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To define a Button Highlight Marker:

1. Left-click in the DVD Movie’s Marker Timescale, at the approximate location (in
time) where you wish the interactive subtitle to appear onscreen. The Edit Marker
dialog will open.

– or –

Drag the PlayCursor in the Marker Timescale; this will display the current video
frame in the Thumbnail Previewer. When you see the frame where you’d like to the
button highlight area to start, release the PlayCursor and press the Insert key on your
keyboard; this will “drop” a Chapter Point Marker. Right-click on the Chapter Point
Marker’s icon and select EDIT MARKER. The Edit Marker dialog will open.

2. In the Edit Marker dialog, set the Marker Type to BUTTON HIGHLIGHT. If you wish, you
can also type in an exact Start Time (in HOURS:MINUTES:SECONDS:FRAMES).

Note: A Button Highlight Marker may also be a Chapter Point Marker or other kind of
Marker, if required.

3. Close the Edit Marker dialog by clicking OK.

4. If necessary, you can adjust the position of the Button Highlight Marker as required
by click-dragging it in the Marker Timescale (its current location relative to the video
asset will appear in the Thumbnail Previewer).

The Button Highlight Marker will set the point at which the interactive subtitle will appear.
Usually, you’ll want to add a second Button Highlight Marker to indicate where the
interactive subtitle ends.

Defining the Interactive Subtitle’s 
Text or Source Graphic Image
Once the Button Highlight Markers have been added, it’s time to open the Subtitle Editor
and to define the text (or source graphic image) that you wish to use in the interactive
subtitle.
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Opening the Subtitle Editor.

To open the Subtitle Editor (for creating the interactive subtitle):

• Right-click in the desired subtitle track somewhere to the right of the first Button
Highlight Marker (and to the left of the second Button Highlight Marker, if appli-
cable). Select ADD INDIVIDUAL SUBTITLE from the pop-up context menu.

– or –

• Double-click in the subtitle track area to the right of the Button Highlight Marker
(and to the left of the second Button Highlight Marker, if applicable).



DVDMaestro User’s Guide12-52

When you right-click in the subtitle track just to the right of the first Button Highlight Marker and select ADD

INDIVIDUAL SUBTITLE, the Subtitle Editor will have a new tab — the Button tab.

The Subtitle Editor this time opens with a fourth controls “tab” — the Button tab. You’ll
also find additional settings available on the Colors tab. As we’ll see in the coming pages,
this modified Subtitle Editor dialog replicates many of the same editing controls found in
DVD Menus.

Now its time to define whether the subtitle is text-based or graphic-based. With the former,
you can enter text directly in the Subtitle Editor; for the latter, you’ll import a graphic
image file. Both of these steps are virtually the same as when you create an ordinary (non-
interactive) individual subtitle.
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Creating the text for an interactive subtitle.

To define the interactive subtitle’s text (or source graphic image):

1. For a text-based subtitle, enter text as normal. (You’ll probably want to phrase the
text in such a way as to indicate that the end user can make a choice when the
interactive subtitle appears onscreen.) Use the Subtitle Editor font and position
controls to set the text on the screen as you would like it to appear to viewer.

– or –

For a graphic-based subtitle, select BITMAP FILE and use the Browse (“…”) button to find
the desired graphic image file. (As with a text-based subtitle, you’ll probably want to
use an image that will make it clear to the end user that there’s a choice to be made.)
If necessary, you can use the Offset controls to position the image onscreen.

2. Check FORCED DISPLAY. This will ensure that the interactive subtitle will appear on-
screen. Note: When creating interactive subtitles, always check FORCED DISPLAY.

The subtitle text (or image) will appear in the display area (in the View Options tab, ensure
that BOTH or SUBPICTURE is selected as the View Layer option).

Using an Existing subtitle 

Rather than defining the subtitle’s text or image from “scratch,” you can also use any subtitle
that’s already in place in the Subtitle Timeline. This applies to any subtitle, whether it was
created using the Subtitle Editor or imported as part of a subtitles (script) file.
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To use an existing text-based or graphic-based subtitle as an interactive subtitle:

1. Click-hold on the subtitle at its existing location.

2. Drag it just to the right of the Button Highlight Marker that defines the start of the
interactive subtitle.

3. Release your mouse. You’ll notice that the subtitle “block” (as it appears in the
subtitle track) will automatically resize itself so that it “snaps” left to start at the
Button Highlight Marker. If you’ve defined a second Button Highlight Marker, the
newly positioned subtitle’s end point will “snap” to that location. Otherwise, the end
point will extend to the end of the DVD Movie (or to the next Marker).

4. Double-click on the subtitle (or right-click and select EDIT SUBTITLE). The Subtitle Editor
will open with the subtitle’s current text or image in the display area. (The new
Button tab in the Subtitle Editor will confirm that you have positioned the subtitle in
the correct location relative to the Button Highlight Markers.) If necessary, you can
modify for the text or image as applicable.

Whether you’ve created a new subtitle or are using an existing one, at this point it’s time to
define the button highlight areas on top of the text or image.

Defining the Interactive Subtitle’s Button Highlight Areas
With the text (or image) already in the display area, next we need to “draw” button
highlight areas around the text (or portions of the image) that we wish to make interactive.

Before proceeding, select the Subtitle Editor’s Button tab.

Chapter 12: Subtitles & Closed Captions 12-55

12

The Button tab controls.

As we can see above, the Button tab has controls and parameters which replicate many of
those found in each DVD Menu.

Note: For definitions of these controls and parameters, and examples of how they operate,
see “DVD Menu Controls: Buttons Tab” in Chapter 7.
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A button highlight area, shown “drawn” over a portion of the text. This will create the first “choice.” Note also that
button highlight areas can be named in the Button tab. This name will appear in the display area (as shown above),
though it will not appear onscreen in your final, replicated title.

To create the button highlight areas for an interactive subtitle:

1. In the View Options tab, ensure that BUTTON OUTLINE is enabled; also select BOTH as the
View Layer option.

2. Next, identify the portion of the text or graphic in the display area that you wish to
highlight. Position your mouse to one side, then left-click and hold the mouse button
down. Then drag the mouse to frame the text or image; as you do so, you’ll see a
colored rectangle appear in the display area. Release the mouse button when you
have finished defining the button highlight area.

3. The resulting rectangle is the button highlight area. You’ll also notice a colored
number has been automatically assigned in the upper-left corner of the highlight
area: This is the button number and is used for navigating between multiple buttons.
(You can also assign button names in the Button tab.)
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4. If you make a mistake, just right-click (while you continue to hold the left mouse
button) and this will cancel the procedure. Or you can delete, move, copy, or resize
the button — in the exact same ways as apply to button highlight areas in DVD
Menus. (See “Defining Button Highlights,” in Chapter 7.)

5. Repeat for each additional button highlight area you need.

This second button highlight area, drawn over another portion of the text, defines the second “choice” in this
interactive subtitle.

With the button highlight areas placed, you’ll want to designate the button selection order,
as defined in the Navigation section of the Button tab. For more information about these
parameters, see “DVD Menu Controls: Buttons Tab,” in Chapter 7.

Setting the Button Highlight Area Colors

Once you’ve defined the button highlight areas in the display area, it’s time to set their
respective colors. These choices are all found in the Subtitle Editor’s Colors tab.
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The Colors tab, as it appears with text-based subtitles (left) and graphic-based subtitles.

These controls are categorized as follows:

• The Subpicture colors determine how the subtitle’s text or graphic image appear
without any button highlight areas selected.

• The Button Selection colors determine the appearance of the button highlight areas
once they are selected by end-users (though not actuated).

• The Button Action controls regulate the appearance of button highlight areas when
they are actuated by the viewer.

You’ll notice that the categories are slightly different depending upon whether you’re
working with a text-based or graphic-based subtitle. As with non-interactive subtitles, for
the former, Outline 1, Outline 2, Text, and Background options are available; for the latter,
the four Color Maps are available.
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To set the button highlight area colors as desired:

1. Select the Colors tab in the Subtitle Editor.

2. Adjust the color selection and opacity levels as desired, observing the effect in the
onscreen display area.

Note: To gauge the effect of these controls, be sure that in the View Options tab, you set
the Button Preview options to NONE, SELECTION COLOR, or ACTION COLOR, as appropriate.

For more information about using any of the Colors tab controls, refer to earlier in this
chapter, or to related sections in Chapters 7 and 8.

By clicking once within the top button highlight area, we can see the effect of the Button Selection colors applied
to that portion of the subtitle. (In the View Options tab, the Button Preview option is set to SELECTION COLOR.)

At this point, you can now close the Subtitle Editor, by clicking OK, which will return you
to the DVD Movie.
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Here, the interactive subtitle is shown in place in the Subtitle Timeline, starting at the Button Highlight Marker
location. Note that without a second Marker to the right of the first, the subtitle will run through to the end of the
DVD Movie.

In the DVD Movie’s Subtitle Timeline, you will see the subtitle “block” extend from the
Button Highlight Marker to the end of the DVD Movie (if there’s only one Button Highlight
Marker) or up to the second Button Highlight Marker.

The same interactive subtitle — only here, we have added a second Button Highlight Marker, which will define the
subtitle’s end point.

If you wish, you can also reposition the subtitle’s start or end time by clicking and dragging
the Button Highlight Marker(s).

Connecting Interactive Subtitle
Button Highlight Areas for Navigation
Once you’ve created the interactive subtitle, it’s time to connect its button highlight areas
using the Connections window.

Any button highlight areas created in the Subtitle Editor will appear as navigation sources
in the Connections window and can be linked to any navigation Target in the Project.
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Interactive subtitle button highlight areas appear as navigation sources in the Connections window. Here, we can
see that we’ve established targets for each such “Active Area.” In this case, when viewers actuate the first button
highlight area in the interactive subtitle (which we named cHOICE 1, using the Name field in the Button tab),
playback will be routed to the first chapter of the DVD Movie named BRANCH 1. If viewers actuate the second
choice, playback will be routed to the first chapter of the DVD Movie named BRANCH 2.

For more about the Connections window or source:target connections, refer to Chapter 9.

Testing Interactive Subtitle Button Highlight Areas
In order to see interactive subtitles complete with selectable button highlight areas, you’ll
need to compile the Project (or part of the Project), then emulate the title using the DVD-
Player utility.

Note: Compilation and emulation (using DVDPlayer) is detailed in Chapter 10.

Using DVDPlayer to test an interactive subtitle’s button highlight areas.
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In current versions of DVDMaestro and DVDConductor, the Navigation Simulator cannot
be used to view button highlight areas in interactive subtitles. You can use the RealView
Previewer, which will show whatever text or image may be in the subtitle, but you won’t
be able to select or actuate any of the button highlight areas. Future versions of Spruce
authoring software will support previewing functions.

Viewing Subtitles as a List

As you keep adding subtitles to your Project, it can become increasingly impractical to
work with them one-by-one using the Subtitle Editor or by trimming or dragging them in
the Subtitle Timeline . Fortunately, on a per-track basis, you can view and edit all subtitles
at once in a Subtitle List.

To list the contents of a subtitle track:

1. Right-click in the desired subtitle track.

2. From the pop-up context menu, select LIST ALL SUBTITLES.

3. The Subtitle List dialog will open, listing each subtitle.
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Viewing the subtitles as a list. (Only one subtitle track at a time can be displayed in list form.)

As shown in the screenshot above, the Subtitle List dialog lists each subtitle by number,
along with its respective “Text,” plus Start and Stop (end) times.

Note: If a subtitle was imported as a graphic image file or as part of a “.son”-format
subtitles (script) file, the Text column will be blank.

All of the fields in this dialog are editable. To change the text of a given subtitle, simply
select its Text field and type. The new subtitle content will be displayed once you click OK

in the Subtitle List dialog.

Selecting the type to edit it.
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Likewise, you can select any subtitle’s Start Time or Stop Time field and type in a new
value (in HOURS:MINUTES:SECONDS:FRAMES format).

Editing the Start Time.

The Subtitle List dialog is also very useful in dealing with scripting errors in a subtitles file.
For example, if the timecode entries for different subtitles overlap, the following dialog will
be displayed when you import the subtitles file.

If any subtitles overlap, this alert will appear.

In this case, you can easily identify the offending subtitles in the Subtitle List dialog. Simply
open the Subtitle List, then scroll until you see subtitles with highlighted text as shown
immediately below. In this case, the start time of the second subtitle comes before the stop
time of the first. Either (or both) fields may be edited to correct the error. Continuing in this
way, you can locate and correct errors, even in lengthy subtitles files.

Overlapping subtitles will appear in the Subtitle List dialog with their names highlighted.
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In addition, you can cut and paste from and to any field in the Subtitle List. You can also
select entire columns and paste the information into another subtitle track’s list — which is
especially useful if you have alternate-language subtitle tracks that share the same Start
and Stop Time values. For instance, if you find scripting errors in the subtitles file, you only
need correct them for one language. Then you can select the entire Start Time and Stop
Time columns; copy them (CTRL - C); then open the Subtitle List for the other tracks and
paste (CTRL - V) them into the respective Start Time and Stop Time columns in that dialog.

Selecting both the Start and Stop Time columns. Using the Subtitle List dialog, these values can be copied in their
entirety between subtitle tracks. This can be ideal if you need to correct the positioning of one or more of the
subtitles, then need to apply the same changes quickly to alternate-language subtitle tracks.
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About Subtitles & Slide Shows

In Chapter 11 we discussed Slide Shows — DVD Movies that incorporate still images
instead of (or in conjunction with) video assets.

Subtitles can be incorporated into a Slide Show just as if you were adding them to a
“normal” (video only) DVD Movie. They will appear “on top” of the stills, just as they
would with video and may extend across boundaries of still images without problems.

For detailed information about Slide Shows, please see Chapter 11.

Creating Subtitles (Script) Files 

If your DVD Movie needs only a few subtitles, it’s probably easiest to craft them individu-
ally, using the Subtitle Editor. However, once you’re dealing with large numbers subtitles,
it’s more efficient to import them as a subtitles, or script, file using Spruce Technologies’
proprietary “.stl” format. Subtitle scripts may also be imported in the “.son” format which
is used by some other DVD authoring systems. There are also a growing number of subtitle
spotting tools on the market, which can help you craft subtitles, and which support both
.stl and .son formats.

As we’ll learn, .stl files are perfect for creating lots of text-based subtitles, each of which
can be fully formatted and even animated. However, if you wish, it’s also easy to incorpo-
rate graphic-based subtitles into a .stl file. Let’s begin with the basics. . .

Basic .STL Script Format
You can script an .stl-format subtitles file using any word processing or text editing pro-
gram — just remember to save files in a “text only” format. (This applies even if you’re
incorporating graphic-based subtitles, as described later.) By convention, the extension
“..stl” is used, but the script file will work no matter what extension is used.
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The basic format of entry for Spruce .stl format is very simple, consisting of:

Start time (hrs:min:sec:frm) , End time , (text content)

Note that start time, end time, and content are separated by commas (“,”). A fragment of a
working script file is shown below.

//Example of a basic STL format subtitle script
01:00:03:24 , 01:00:06:29 , DVD is a powerhouse medium.
01:00:10:07 , 01:00:12:21 , Spruce Technologies puts you in the picture,
01:00:14:19 , 01:00:16:08 , with complete, state-of-the-art tools
01:00:19:22 , 01:00:22:28 , for encoding, authoring, and premastering.
01:00:25:07 , 01:00:29:18 , DVDMaestro...total DVD
01:00:36:15 , 01:00:40:11 , DVDConductor...cost-effective DVD
01:00:55:22 , 01:00:59:03 , All-in-one solutions for professional DVD.

Notice the first line begins with a double-slash (“ // ”). This indicates that the text is a
comment only and will not affect onscreen display. You can use comments throughout
your scripts to help in reading.

In-Line Control Characters in .STL Scripts
Control characters can be embedded into the subtitle text copy to insert line breaks and to
control the setting of character attributes.

All line breaks must be entered in the script file itself using the “vertical pipe” character (“ | ”)
— there are no automatic line breaks. The figure below shows a script file line that incorpo-
rates the line-break character and its result in the subtitle display.

Scripting a line break.
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Commands for italic, bold, and underlined — using the “up-arrow” (“ ^ ”) character — can
be embedded in the subtitles file exactly as for manual text entry.

Scripting character attributes.

Control Commands in .STL Scripts
In addition to the simple control characters we’ve just reviewed, the .stl file format pro-
vides for a range of commands that can control font, size, placement, fade time, etc. The
commands can be embedded directly into the script, as shown in the next example. All .stl
control commands begin with a dollar sign (“ $ ”) character.

Note: Although these attributes can be edited “manually,” using the Subtitle Editor, it is far
more efficient to embed them into the script itself.

//Example of STL format control commands
$FONTNAME = Comic Sans MS
$FONTSIZE = 28
01:00:03:24 , 01:00:06:29 , DVD is a powerhouse medium.
01:00:10:07 , 01:00:12:21 , Spruce Technologies puts you in the picture,
01:00:14:19 , 01:00:16:08 , with complete, state-of-the-art tools
01:00:19:22 , 01:00:22:28 , for encoding, authoring, and premastering.
01:00:25:07 , 01:00:29:18 , DVDMaestro...total DVD
01:00:36:15 , 01:00:40:11 , DVDConductor...cost-effective DVD
01:00:55:22 , 01:00:59:03 , All-in-one solutions for professional DVD.
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The two commands here, $FONTNAME and $FONTSIZE, control the selection of font and the
size of the font, respectively.

Following is a list of the general control commands available in the .stl subtitle script
format, with some typical values. (As we’ll cover later in this chapter, in the “Adding
Animation to .STL Subtitles Files” section, there are additional commands that perform
animated color wipes.)

//Font select and font size
$FontName = Times New Roman
$FontSize = 50

//Character attributes (global)
$Bold = FALSE
$UnderLined = TRUE
$Italic = 1

//Position Control
$HorzAlign = Center
$VertAlign = Center
$XOffset = 10
$YOffset = 10

//Contrast Control
$TextContrast = 15
$Outline1Contrast = 15
$Outline2Contrast = 7
$BackgroundContrast = 0

//Effects Control
$ForceDisplay = TRUE
$FadeIn = 3
$FadeOut = 7

//Other Controls
$TapeOffset = FALSE
$SetFilePathToken = <<path:>>

Most of the commands in this list work exactly in the way that the corresponding controls
in the Subtitle Editor operate. Take note, however, of the two commands in the group
labeled “Other Controls” — these have no counterpart in the Subtitle Editor window.
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Absolute and Relative Time ($TapeOffset command)
The default mode of time entry in the .stl script format is absolute time referenced to
timecode embedded in the video stream. By inserting the following control command:

$TapeOffset = FALSE,

. . . you can enter the script data in time relative to the beginning of video. That is, the first
frame of video will be equal to time “00:00:00:00”.

When using relative time for subtitle scripts, you may also wish to switch the control in the
timeline time display to “Zero-based” as described in Chapter 6.

Incorporating Graphic-Based Subtitles ($SetFilePathToken
command)
In the preceding examples of .stl script formatting, we have been entering subtitle content
in text format. As in the Subtitle Editor, we have the option of defining content by specify-
ing a graphic source file for each subtitle.

The command $SETFILEPATHTOKEN is used to define a string of characters that indicates when
a file path to a source file is entered. Thus, the example below;

$SetFilePathToken = <<path:>>
01:00:00:00 , 01:00:05:00 , The next subtitle is defined by a graphic file
01:00:10:00 , 01:00:15:00 , <<path:>> SecondSubtitle.bmp
01:00:20:00 , 01:00:25:00 , This one is text-entry

In this example, the first and last subtitle are defined by text. The second subtitle, however,
is defined by the graphic file “SecondSubtitle.bmp” — which resides in the same directory
as the subtitles file itself.

Filenames referenced after the “file path” token may be placed in the same directory as the
subtitles file, in which case they are referred to by the filename only, or they may be
placed in any arbitrary directory, in which case the full pathname is required, as follows:

//Looks in same directory as script file
01:00:10:00 , 01:00:15:00 , <<path:>> SecondSubtitle.bmp

//Finds arbitrary file anywhere on the system or network
01:00:10:00 , 01:00:15:00 , <<path:>>
D:\Subtitles\Bitmaps\SecondSubtitle.bmp
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Note: Even if your subtitles file consists entirely of graphic-based subtitles, you’ll see
saving the subtitles file as a text file (with a .stl extension).

Regarding .SON Script File Format
Earlier we mentioned that Spruce authoring software also supports import of subtitle script
files in a format known as “.son”.

Support for .son subtitles files is not available in the standard version of DVDConductor.
It may be added by installing the DVDMaestro upgrade.

This is a somewhat more limited script format that was originally developed by Daikin-
Comtec Laboratories for their Scenarist™ DVD authoring package. For information on the
.son script file format, consult documentation provided by Daikin-Comtec Laboratories.

Adding Animation to .STL Subtitles Files

Using Spruce Technologies’ .stl format, you can script animated color or opacity wiping
effects for use in text or graphics. This way, for instance, subtitles can be “keyed” to allow
for word-by-word pacing for Karaoke and other applications. Arbitrary animations can also
be created by changing the image on every frame of video.

Scripting Subtitle Wipes
In addition to other applications, subtitle wiping effects are very popular with Karaoke
titles — where changing subtitle colors can help singers keep pace with Karaoke lyrics. For
instance, in the screenshot on the next page, we can see the song’s current “location” (as
far as the singer is concerned) is just at the end of the word “that”:
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By scripting subtitle wipes, you can have subtitle lyrics that change color to the pace of the song — perfect for
Karaoke titles.

The basic script line for the subtitle above is as follows:

01:25:02:11 , 01:25:04:25 , Tell me all the things | that I wanna hear

By itself, this line would be placed immediately on the screen without any special effects.
To add the color wipe effect, we need to define a set of parameters that follow the affected
line, as below:

01:25:02:11 , 01:25:04:25 , Tell me all the things | that I wanna hear
{

WipeInfo: 10, 135, 347, 590, 404, 20, 0, Left, 135,590

WipeInfo: 34, 160, 405, 310, 444, 16, 0, Left, 135,590
WipeInfo: 51, 310, 405, 580, 444, 23, 0, Left, 135,590

}
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The color wipe statements are all contained with facing brackets (“ { } ”). Within the
brackets, we see (in this case) three separate lines that begin with the term WIPEINFO fol-
lowed by a colon and followed by several parameters separated by commas.

Each WipeInfo statement refers to a linear section of color wiping. Multiple WipeInfo
statements are used to provide wiping that paces with the music and also to wipe across
multiple lines of text as shown here.

Animated Wipe Parameters

The use of parameters in the first WipeInfo statement from the example above is shown
here:

Command
Tag

WipeInfo: 10, 145, 347, 590, 404, 20, 0, Left, 135, 590,

Wipe
Start

Offset
(frames)

Wipe
Rectangle
Left Side

Wipe
Rectangle

Top

Wipe
Rectangle
Right Side

Wipe
Rectangle
Bottom

Wipe
Duration
(frames)

Wipe
Sense

Wipe
Start

Wipe
Limits A

Wipe
Limits B

Note: Be sure to separate all parameters by a comma.

Let’s take a closer look at each of these parameters. . .

Command Tag (WipeInfo:)

In the .stl script format, special functions can be incorporated between brackets. The
particular functions are designated by a “tag,” which is a keyword followed by a colon.
The WipeInfo tag is the first to be implemented, and at this time, the only command tag
available.

Wipe Start Offset

This is the amount of time, in frames, that the subtitle will appear onscreen before wiping
begins. The actual time that the wipe segment begins, then, is the start time of the subtitle
plus the Wipe Start Offset.

Note: The start offset for all WipeInfo statements for a given subtitle are referenced to the
subtitle’s start time, rather than the end time of any other wipe segments. If you have
multiple wipe segments that follow one another, then the start offsets will be greater and
greater for each segment.
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Wipe Rectangle Coordinates

The next four numbers in the WipeInfo statement define the region of the screen at which
wiping will occur. The figure below shows the relationship of the coordinates to the
picture.

Wipe Rectangle coordinates, as they appear in relation to the screen.

As you can see, the Wipe Rectangle coordinates are in relation to the screen, not to the
text entry, which has its own placement control. Thus, unless you’re careful, it’s possible
to specify a wipe area that misses text completely.

Note: Different WipeInfo statements can have the same timing but different wipe rectangles.
This allows you to have multiple wipes in different directions onscreen at the same time.

Wipe Duration

This is a time value, expressed in frames, that controls how long the wipe function will
take to traverse the designated wipe rectangle. The wipe segment will begin at the time
defined by the subtitle start time plus the Wipe Start Offset — and will complete at the
time defined by the subtitle start time plus Wipe Start Offset plus Wipe Duration.
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Wipe Sense

Here, a value of “0” or “1” only applies. The Wipe Sense determines whether the wipe is
“‘positive” — where it goes from the original subtitle (source) color to the wipe color — or
“negative” — where it starts with wipe color and reveals original subtitle (source) color.

Wipe Start

Color wipes can proceed in any of four directions: left to right, right to left, top to bottom,
and bottom to top. The Wipe Start parameter designates the beginning point of the wipe
segment, which will proceed to the opposite side of the Wipe Rectangle coordinates.

Wipe Limits

The Wipe Limits can be used to exclude portions of the wipe rectangle from being affected
by the wipe. These are always in reference to the designated Wipe Start. If the Wipe Start
is set to LEFT, then the Wipe Limits default should be the left and right edge, and likewise if
Wipe Start is set to RIGHT. If Wipe Start is defined as TOP or BOTTOM, however, the Wipe
Limits will ordinarily correspond to the Top and Bottom coordinates of the wipe rectangle.

Controlling Wipe Color and Opacity
The colors and opacity of the wipe can be defined in the scripts as well. There are two
kinds of statement associated with colors. The first ($SETWIPECOLOR) defines a group of four
colors as the “palette” for wipe colors. Here’s an example:

$SetWipeColor1 = 0,255,0
$SetWipeColor2 = 0,0,0
$SetWipeColor3 = 255,165,0
$SetWipeColor4 = 255,129,145

Note: There can only be one set of $SetWipeColor commands in a subtitle script. If more
than one such group of commands is found, the colors for the whole scripts are assigned to
the last group of color commands.

The actual assignment of these four colors to the text body, outlines, and background is
handled by a separate set of commands, as below.

$WipeTextColor = 4
$WipeOutline1Color = 2
$WipeOutline2Color = 2
$WipeBackgroundColor = 1
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These commands index to the colors defined in the $SetWipeColor commands. So, by
setting $WipeTextColor to 4, the text body assumes the color defined by $SetWipeColor4.
Unlike the $SetWipeColor commands, the color index assignment commands can occur as
many times as you like. If you want to use different colors within a single text wipe, it can
be handled in this way.

Likewise, there is a set of contrast commands to control the opacity of the wipe elements.
The range of values is 0 (transparent) to 15 (opaque). As with the color indexes, these
commands can appear in the script as often as you wish.

$WipeTextContrast = 15
$WipeOutline1Contrast = 15
$WipeOutline2Contrast = 15
$WipeBackgroundContrast = 4

An Example of a Color Animated Wipe Subtitle Script

Working with color wipe animations is something best learned from experience. If you are
interested in this area, experimentation with simple scripts and changing various param-
eters will clarify the operation of this command set.

To help you in this regard, below is a fragment of a script from an actual Karaoke title
animated using .stl color wipe animation commands.

$FontName = Arial Narrow
$FontSize = 50

$WipeTextColor = 1
$WipeOutline1Color = 2
$WipeOutline2Color = 2
$WipeBackgroundColor = 4
$WipeTextContrast = 15
$WipeOutline1Contrast = 15
$WipeOutline2Contrast = 0
$WipeBackgroundContrast = 0
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01:24:21:08, 01:24:24:20, What I like about you
{

WipeInfo: 41, 145, 405, 290, 454, 10, 0, Left,
145,600
WipeInfo: 51, 300, 405, 378, 454, 10, 0, Left,
145,600
WipeInfo: 61, 390, 405, 515, 454, 12, 0, Left,
145,600
WipeInfo: 79, 515, 405, 600, 454, 4, 0, Left,
145,600

}
01:24:24:20, 01:24:27:20, Ya hold me tiiiiight
{

WipeInfo: 40, 173, 405, 230, 454, 5, 0, Left,
173,580
WipeInfo: 45, 240, 405, 422, 454, 10, 0, Left,
173,580
WipeInfo: 60, 422, 405, 580, 454, 20, 0, Left,
173,580

}
01:24:27:20, 01:24:31:02, Tell me I’m the only one
{

WipeInfo: 59, 110, 405, 270, 454, 11, 0, Left,
110,635
WipeInfo: 70, 280, 405, 440, 454, 8, 0, Left,
110,635
WipeInfo: 78, 450, 405, 540, 454, 16, 0, Left,
110,635
WipeInfo: 96, 555, 405, 635, 454, 2, 0, Left,
110,635

}
01:24:31:02, 01:24:32:10, wanna come over
{

WipeInfo: 2, 160, 405, 325, 454, 9, 0, Left,
160,555
WipeInfo: 11, 335, 405, 450, 454, 10, 0, Left,
160,555
WipeInfo: 25, 460, 405, 555, 454, 6, 0, Left,
160,555

}
01:24:32:10, 01:24:34:00, toniiiiiiiiiight
{

WipeInfo: 0, 228, 400, 517, 454, 35, 0, Left,
228,517

}
210,535
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Animation Using Individual Subtitles
Using .stl format script files, a different subtitle can be placed at every frame of video, making it
possible to create onscreen subtitle animations. Below, for instance, is a fragment of a script file
that creates “moving” subtitles by changing the $XOffset and $YOffset values.

$XOffset = 10
$YOffset = 10
00:00:01:00 , 00:00:01:01 , Subtitle Animation Test
$XOffset = 11
00:00:01:01 , 00:00:01:02 , Subtitle Animation Test
$XOffset = 12
00:00:01:02 , 00:00:01:03 , Subtitle Animation Test
$XOffset = 13
00:00:01:03 , 00:00:01:04 , Subtitle Animation Test
$XOffset = 14
00:00:01:04 , 00:00:01:05 , Subtitle Animation Test
$XOffset = 15
00:00:01:05 , 00:00:01:06 , Subtitle Animation Test
$XOffset = 16
00:00:01:06 , 00:00:01:07 , Subtitle Animation Test
$XOffset = 17
00:00:01:07 , 00:00:01:08 , Subtitle Animation Test
$XOffset = 18
00:00:01:08 , 00:00:01:09 , Subtitle Animation Test
 etc.

Animated subtitles is a potentially powerful technique for DVD authoring, but there are
some disadvantages to keep in mind. One disadvantage is that it is inherently tedious to
create these scripts because of their sheer length. Users who are qualified (or have access
to resources) may wish to create software tools to help in this process.

Another thing to be aware of is that Spruce authoring software’s DVDPlayer (emulator)
utility sometimes has trouble keeping up with subpictures on every frame. In previewing
animated subtitles, you may find some hesitancies and “hiccups” in play. In general, these
will not carry over to the finished title, though the only way to be sure is to compile and
master to DVD-R before sending off a DLT for replication.

Finally, because of the sheer number of images this type of scripting introduces, compiling
your Project may take a long time. This is especially true if you use graphic file sources
rather than text entry, as each subpicture graphic has to be parsed and compressed. This
step is not a burden for smaller numbers of subtitles, but if you use script-driven animation
extensively there may be many thousands of images to compress, resulting in unaccept-
ably long compilations.
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Reviewing Subtitle Asset Properties

Once a subtitle is in place in the Subtitles Timeline, you can review its properties. At the
same time, you can view adjust certain parameters of its associated subtitle track. All of
this is available by opening the Subtitle Properties dialog.

To view the properties of any subtitle asset in the Subtitle Timeline:

1. Right-click on the desired subtitle asset and select PROPERTIES;

– or –

ALT-double-click on the desired subtitle asset.

2. The Subtitle Properties dialog will open. With the Asset Properties tab selected (the
default), you can view the asset’s name, type, and (if applicable) its source bitmap file.

The Subtitle Asset Properties dialog.
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Stream-Mapping Subtitles
for Different Aspect Ratios

Spruce authoring software lets you associate particular subtitle tracks with specific aspect
ratios, such as 4:3, 16:9 Widescreen, etc. — by “stream mapping” subtitles according to
whatever playback aspect ratios the viewer has chosen. This way, for example, you could
craft one subtitle track with relatively “wide” subtitles proportioned to look good on top of
a 16:9 picture; you could craft another track with subtitles that look good with a 4:3
picture; and so forth. Then, when the viewer chooses to view the title in 16:9, 4:3, etc. —
and chooses to view subtitles — the “correct” subtitle track will play.

As you may recall, with Spruce authoring software, aspect ratios can be set on a per-DVD
Movie basis — and so can the stream-mapping. First, you need to confirm or set the
current DVD Movie’s aspect ratio. As we learned in Chapter 6…

To confirm the DVD Movie’s current aspect ratio:

• Look to the Status Bar (along the lower-left edge of the DVD Movie). Just to the right
of the current frame rate, you’ll see the current aspect ratio.

To set the DVD Movie’s aspect ratio:

1. Right-click on the aspect ratio display in the Status Bar.

2. When the pop-up context menu appears, select the desired aspect ratio.

3. The context menu will close and the aspect ratio will be set.

Selecting the DVD Movie’s aspect ratio.
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Note: When the DVD Movie’s source video is regular 4:3, the only available aspect ratio is
4:3. Thereafter, when the Subtitle Track Properties dialog is opened (as described next), the
only pull-down field available will be for 4:3.

Next, you need to open the Subtitle Track Properties dialog. 

To open the Subtitle Track Properties dialog:

1. Right-click on any subtitle asset and select PROPERTIES (or just ALT-double-click on the
subtitle asset).

2. The Subtitle Properties dialog will open. Select the Track Properties tab.

– or –

1. Right-click in a subtitle track and select PROPERTIES.

2. The Subtitle Properties dialog will open with Track Properties already open. (The
Asset Properties tab won’t be available in this method.)

The Subtitle Track Properties dialog. (If you select a 4:3 aspect ratio for the DVD Movie, this will be the only
available stream-mapping choice.)

The Subtitle Track Properties dialog lists the four possible aspect ratios, each with a pull-
down field. (For more about aspect ratios, please see Chapter 6.)

With this dialog, you can forcibly set the subtitle track according to whatever aspect ratio
the viewer chooses. For instance, this next screenshot shows how you can choose the
subtitle track for a 4:3 aspect ratio:
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Stream-mapping in action: In this case, subtitle track 1 is currently selected to be the active subtitle stream for this
4:3 DVD Movie.

By default, you’ll notice the pull-down field points to “itself.” That is, if you right-click on
subtitle track 1 to open the Subtitle Track Properties, the default track for each field will be
“1.” If you invoke the Subtitle Track Properties by right-clicking in subtitle track 19, the
default will be “19.”

Note: You’ll notice that these settings are labeled SUB-PICTURE STREAM MAPPING. This refers
back to what we learned with the Subtitle Editor, that in terms of color mapping, opacity
settings, and more, subtitles are treated like subpictures on top of the video stream. None-
theless, what we’re actually doing are setting which subtitle track is associated with which
playback aspect ratio.

To stream-map a subtitle track to a playback aspect ratio:

1. Click-hold in any of the four aspect ratio pull-down fields; then select the desired
track.

Note:  Each pull-down field lists 32 subtitle tracks.

2. Once you choose a new track, playback will automatically route to that track,
assuming the viewer selects that aspect ratio and chooses to view subtitles.
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Subtitle Stream-Mapping: A Closer Look
For regular 4:3 material, subtitle stream-mapping may not seem useful. However when the
video is viewed a 16:9 Aspect Ratio, it becomes important for controlling the view.

For instance, when the source video file is in Widescreen format and the DVD Movie’s
Aspect Ratio setting is 16:9 LETTERBOX (as shown below), then the viewer has two potential
viewing modes. If he or she has a Widescreen video monitor, then they will view the
material in Widescreen (full 16:9) mode. However, if he or she has an ordinary 4:3 video
monitor only, then the program will be shown in Letterbox form, with black inserted at the
top and bottom of the screen by the player.

Stream-mapping for a DVD Movie with a 16:9 Letterbox aspect ratio. In this example, if the viewer’s DVD player is
set for Widescreen playback through a 16:9 video monitor, subtitle track 1 will be the active subtitle stream; if the
player is set for Letterbox playback through a 4:3 monitor, subtitle track 2 will be the active subtitle stream.

These two viewing modes call for substantially different approaches to subtitles. Typically,
for 16:9 Widescreen mode, you’ll want your subtitles to appear over the video somewhere
in the lower-center of the screen. In Letterbox mode, however, you’ll likely want subtitles
to be spread more horizontally along the bottom of the screen to take advantage of the
black inserts in the frame.

So in this case, the following steps will let you configure your title so that the appropriate
subtitles play whether the viewer watches the title in Widescreen (on a 16:9 video moni-
tor) or in Letterbox (on a 4:3 video monitor):
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1. Set the DVD Movie’s aspect ratio to 16:9 LETTERBOX.

2. Create and format the Widescreen subtitles and place them in subtitle track 1.

3. Create and format the Letterbox subtitles and place them in subtitle track 2.

4. Open the Subtitle Track Properties dialog.

5. In the WIDE pull-down field, select “1” (the default setting, assuming you opened the
dialog by right-clicking in subtitle track 1).

6. In the LETTERBOX pull-down field, select “2”.

Now, if the viewer’s DVD player is set for Widescreen playback through a 16:9 video
monitor, subtitle track 1 will be the active subtitle stream; if the player is set for Letterbox
playback through a 4:3 monitor, subtitle track 2 will be the active subtitle stream.

Importing Closed Caption (Line 21) Information

Support for Closed Caption (Line 21) information is not available in the standard version
of DVDConductor. It may be added by installing the DVDPowerPack upgrade.

As also described in Chapter 6, DVDMaestro offers two-field Line 21 support for closed
caption files. Any closed-caption data in your title will be incorporated into the DVD
player’s video output signal, from which it can be decoded by any suitably-equipped
television or video monitor. Each DVD Movie can have its own associated closed caption
file; you can import closed caption files on a per-DVD Movie basis.

Spruce also supports the Daikin Scenarist™ format for closed caption files. These are
standardized text files that include timecode data, caption text, and control characters. The
usual extension for these files is “.scc”.
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Importing a closed caption (Line 21) file.

To import any compatible Line 21 (closed caption file) into a DVD Movie:

1. Right-click anywhere in the video track of the DVD Movie window. A context menu
will appear.

2. Left-click on IMPORT LINE 21 FILE. This will bring you to an Import Line 21 dialog:

3. Type the file name directly, or browse for the desired file. Click OPEN when you’re done.

Closed-caption data can also be entered by accessing the Properties command for the
DVD Movie.
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To import any compatible Line 21 (closed caption file) via the DVD Movie Properties dialog:

1. Right-click on the DVD Movie’s name in the Project Manager. When the context
menu appears, select PROPERTIES. (You can also ALT-double-click on the DVD Movie’s
name in the Project Manager.)

2. The Movie Properties dialog will appear, where you’ll find a section for Line 21 support:

3. Enter the name and directory of the desired Line 21 file or browse for the file by
clicking the “…” button. When you’re done, click the DVD Movie Properties OK

button and the file will be incorporated into the DVD Movie.

Summary of Subtitles & Closed Captions
As we’ve seen in this chapter, your Spruce authoring software gives you comprehensive
capabilities for entering, importing, editing, and scripting subtitles — including full color
mapping features; support for subtitles (script) files support; interactive subtitles that
incorporate button highlight areas; and real-time effects such as fades and color wipes.
This, combined with full Line 21 (closed caption) support, offers an advanced, powerful
solution for presenting a wide variety of onscreen text information.

•        •        •

Chapter 13: 

Reference (Pull-Down Menus & Toolbar)
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Chapter 13
Reference
(Pull-Down Menus & Toolbar)

In this chapter, you’ll find detailed descriptions of your Spruce authoring software’s pull-
down menus and Toolbar and all their associated features and controls.

Note: Please bear in mind this chapter is not a step-by-step tutorial for creating Projects;
for such “how to” information, refer to the proceeding chapters. This chapter is, however,
a good place to refer to if you already understand DVDMaestro’s or DVDConductor’s
basic concepts and operation, but need to know what a particular pull-down menu
command or Toolbar button does.

The pull-down menus are located in the upper-left corner of the Spruce authoring program, just beneath the title
bar. Note that if a DVD Movie is active in the Workspace, then a “Movie” pull-down menu will appear between
the View and Tools pull-down menus; if a DVD Menu is active in the Workspace, a “Menu” pull-down menu will
appear in its place

Many of Spruce authoring software’s most important options, commands, and other
operations are accessed via its pull-down menus. (Keep in mind that we’re referring here
to the menus that run along the top of the application, as opposed to DVD Menus.)

As with many Windows-based programs, Spruce authoring software’s pull-down menus
can change depending upon which program window is active, which operating mode the
program is in, and so forth. For instance, if a DVD Movie is active in the Workspace, then
a “Movie” pull-down menu will appear between the View and Tools pull-down menus; if
a DVD Menu is active in the Workspace, a “Menu” pull-down menu will appear in its place.

In the coming pages, we’ll indicate which menu items are not available when certain
windows are active.
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The Toolbar
The Toolbar is located immediately below the pull-down menus.

Note: You can hide or show the Toolbar by opening the View menu and clicking next to
TOOLBAR; a checkmark indicates that the Toolbar is being displayed.

With the Toolbar, you can access many of the most common menu commands directly,
just by clicking on the appropriate Toolbar button without having to pull down a menu.

The Toolbar. As you pass the mouse cursor over each Toolbar button and hover there for a moment, ToolTips will
appear, showing you the name of each button. 

As you pass the mouse cursor over each Toolbar button (and hover there for a moment),
ToolTips — highlighted descriptions of the buttons — will appear onscreen for a few
seconds.

In the coming pages, we’ll review all of the pull-down menu options, starting with the left-
hand File menu. Wherever applicable, we’ll also describe an associated Toolbar button.

New (Project)

New Menu
(DVD Menu)

New Movie
(DVD Movie)

New Command
Sequence

Connections
(window)

Open
(existing Project)

Save
(current Project)

Cut
Copy

Paste

Encode
(Encoder Control Panel)

Compile (tool)

Disc Image
Creation (tool)

Write DVD-R (tool)

Write Tape (tool)

Verify Tape

Navigation
Simulator

Help Topics

About
(DVDMaestro or
DVDConductor)
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The File Menu

With the File menu, you can create, save, and otherwise manage your Projects.

Some of the File menu items have corresponding keyboard shortcuts. These shortcuts can
be seen as you pull down the File menu.

The pull-down File menu.

New
When you select NEW (and a Project is already open), a “pop-up” context menu appears
with three choices, letting you create a new DVD Movie, new DVD Menu, or new Project.
These choices are also replicated on the Toolbar.

Note: When you launch DVDMaestro or DVDConductor, a new Project is created auto-
matically. If you have closed this new Project or you have closed any other Project, then
this context menu with its three choices will not appear — and selecting NEW will auto-
matically create a new untitled Project. After that point, selecting NEW will cause the
context menu with its three choices to appear.



DVDMaestro User’s Guide13-6

If you select DVD MOVIE or DVD MENU, you’ll see a new DVD Movie or new DVD Menu
appear in the Project Manager. Double-clicking on either of these will open a new DVD
Movie or DVD Menu window in the Workspace.

If you select a new DVD PROJECT, one of several things may happen. If you have just saved
your current Project or haven’t modified the current Project since opening it, then the
current Project will automatically close and a new untitled Project will be opened. If you
have modified your current Project and haven’t saved the changes, then selected a new
DVD PROJECT, the Save dialog will appear giving you the opportunity to save your changes,
discard your changes, or cancel the operation. (See “Save.”) Afterward, a new untitled
Project will appear.

Once you create a new Project, it’s a good idea to name the project by saving it before
you go any further. (See “Save As.”)

Open
Select OPEN to open a previously created Project. This choice is also replicated on the
Toolbar. When you do so, the Open File browser will appear:

Using this dialog, you can browse through your hard drives and folders to find the desired
Project. Find and select the Project you want — or type in the file name directly (in
“drive:\folder\file name” format). Click OPEN, and the Project will appear.

Note: If you already have an open Project, a Save dialog will appear giving you the
opportunity to save or discard any changes to the open Project or to cancel the operation.
(See “Save As.”) Afterward, the selected Project will appear. 

Close
Select CLOSE to close the current Project. 

If you’ve made changes to this Project and haven’t saved them, the Save dialog will appear
giving you the opportunity to save your changes, discard your changes, or cancel the
operation. (See “Save.”) Afterward, DVDMaestro or DVDConductor will remain active
(although you’ll need to open an existing Project or create a new one in order to continue
authoring).
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Save
Select SAVE to save the current Project. This choice is also replicated on the Toolbar. 

This operation will save any new changes you’ve made to the Project since the last time
you saved and will overwrite the current version of the Project on top of the previously
saved version. You cannot undo the Save operation, although Spruce authoring software
will let you undo changes even after you’ve just saved the Project with its changes.

If you’re working with a new untitled Project, please see “Save As.”

Save As
Select SAVE AS to save a current untitled Project for the first time or to save a current Project
under a different name. 

When the dialog appears, you can browse to find a desired destination drive and folder, to
which you’ll save the Project. This dialog behaves similarly to the Windows Explorer,
allowing you to select directories, create new folders, and more. To save your Project
properly, type in any name you want (up to 255 characters), then select DVD PROJECT in the
SAVE AS TYPE box.

Note: Spruce authoring software will automatically append a “.dvd” extension to your
Project name; there’s no need to type this when you save the Project.

Remember, the Project is a document that typically takes up relatively little disc space;
saving the Project does not save any of its associated video, audio or other media assets,
except for subtitle text information. (Since Spruce authoring software only reads your
media assets, there’s no need to re-save them.) Consequently, you can save your Projects
to any hard drive or (assuming you don’t have thousands of subtitles) even a floppy disk.

However, for efficient organization, you may want to save your Projects in the same
directory level as your media files or in an associated directory (such as a “Current
Projects” folder, within which you would have a “Current Media Files” folder).

Print, Print Preview, & Print Setup
Spruce authoring software will print the information in the Connections window. The
print-out appears in table form, similarly to how it appears onscreen in the Connections
window. 
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You’ll see PRINT and PRINT PREVIEW as available options only when the Connections window
is active (in the forefront of the Workspace) — whereas you can click on PRINT SETUP to
choose your printer and page size, any time you’re using Spruce authoring software. All
three of these commands behave as they do with other Windows NT applications.

Preferences
Spruce authoring software offers the ability to set “global” User Preferences, which will
apply from Project-to-Project. (These are in addition to many of the other Project-specific
properties, such as DVD Movie Properties or Replication Properties.) This way, you can set
the User Preferences once and keep working, without having to establish individual
Project Properties for each Project.

Selecting PREFERENCES opens the User Preferences (Property Sheet) dialog, which has five
“tabs,” including General, Display, Movie, Color Mapping, and WebDVD.

Most Recent Projects List
Spruce authoring software keeps track of your four most recently opened and saved
Projects and lists them at the bottom of the File menu. You can open any one of these
Projects simply by clicking on the desired Project name.

Just as if you had selected the Project using the OPEN command, this will close your current
Project; if you’ve made any unsaved changes to the current Project, the Save dialog will
appear giving you the opportunity to save your changes, discard your changes, or cancel
the operation. (See “Save.”) Afterward, the selected Project will appear.

Exit
Select EXIT to close the current Project and quit DVDMaestro or DVDConductor.  (You’ll be
prompted to save any unsaved changes to the current Project.)

This function is duplicated by clicking the “x” button in the upper-right corner of the
DVDMaestro or DVDConductor application title bar.
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The Edit Menu
With the Edit menu, you can undo or redo changes you’ve made to your Project, and in
some circumstances, perform other commands.

Please keep in mind that the Edit menu is context sensitive; exactly what you see in the
menu can depend upon what your last action was and which window within your Project
is active. For instance, if you’ve just moved an audio asset in an Audio Track and then you
select the Edit menu, the topmost command will read UNDO SET ASSET POSITION. If, however,
you’ve just deleted a subtitle asset, the topmost command will read UNDO DELETE ASSET.

The pull-down Edit menu. Remember that the UNDO and REDO functions are context-sensitive.

All of the Edit menu items have corresponding keyboard shortcuts. These shortcuts can be
seen as you pull down the Edit menu.

Undo
This command will undo previously executed editing functions (such as moving an audio asset
or repositioning a Chapter Marker). Spruce authoring software supports up to 99 levels of undo,
meaning that it will remember up to the previous 99 editing functions you’ve performed. 

Note: Not all functions can be undone. For instance, changing the language selection for
an Audio or Subtitle Track cannot be undone without going back to the track and actively
changing the language back to its previous setting. As a rule of thumb, Spruce authoring
software will let you undo only editing-related functions — such as repositioning, deleting,
or adding an item in the DVD Movie window; repositioning, deleting, or adding a Target
in the Connections window; or repositioning, deleting, or adding a button highlight area in
the DVD Menu window.
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Redo
This command will re-perform a previously undone function. For instance, let’s say you
move an Audio asset. If you next select UNDO, the Audio asset will return to its original
location. If you next select REDO, the Audio asset will return to its moved location. Then, by
alternating between UNDO and REDO, you can compare the two locations, either visually, or
by previewing the DVD Movie. 

Spruce authoring software supports up to 99 levels of redo, meaning that it will remember
up to the previous 99 undo functions you’ve performed.

Cut, Copy, & Paste
These commands are available only when the Connections window is active (topmost) in
the Workspace.

Select CUT to cut a selected Target item from the Connections window; this process re-
moves the Target item from the Connections window and retains the Target item in
memory. This choice is also replicated on the Toolbar. 

Select COPY to copy a selected Target item from the Connections window; this process puts
the copied Target item in the Windows clipboard, while leaving the original Target item in
the Connections window. This choice is also replicated on the Toolbar. 

Select PASTE to paste a previously cut or copied Target item from the Windows clipboard
into a Target destination in the Connections window. You can paste a Target item into
either a vacant space or on top of an existing Target destination. This choice is also
replicated on the Toolbar. 

Select All
This command is available only when a DVD Movie is active (topmost) in the Workspace,
and will select all assets in a particular video, audio, or subtitle track. The command will
act in whatever track you last selected an asset. It cannot be used to select multiple assets
in more than one track.

For instance, if you last clicked on an subtitle asset in track 3 of the Subtitle Timeline,
SELECT ALL will select all the subtitles in track 3. It’s especially useful for deleting or reposi-
tioning all of a track’s assets. Also, if you want to select all but one (or a few) assets in a
track, you can use SELECT ALL to select all the assets; then, by pressing CONTROL on your
keyboard, you can deselect those assets you don’t wish to delete or reposition.
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The View Menu

Using this menu, you can hide or show:

• the Toolbar;

• the Status Bar;

• the Assets Bin;

• the Output Log;

• the Project Manager;

• the RealView Previewer;

• and the Connections window.

Using the View menu, you can also:

• switch on or off Workbook mode;

• change your view of DVD Movies from the default Timeline view mode to Clip List
view mode;

• and make any of the DVD Movies or DVD Menus the active (topmost) window in the
Workspace.

(To hide or display the Workspace windows — the DVD Movie, DVD Menu, or Connec-
tions windows — please see “The Window Menu.”)

To hide or show any of these items (or to disable or enable Workbook mode or Clip List
view mode), simply click on the desired menu item. A checkmark next to a menu item
indicates that the item is being displayed (or that the mode is currently being used).
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The pull-down View menu.

Most of the View menu items have corresponding keyboard shortcuts. These shortcuts can
be seen as you pull down the View menu. You can also hide the Assets Bin, Output Log,
Project Manager, or RealView Previewer by clicking the small “x” box in the upper left-
hand or right-hand corner of each item.

Workbook Mode
Note: This option pertains to the Workspace and its associated DVD Movie, DVD Menu,
and Connections windows. It does not apply to the Assets Bin, Output Log, RealView
Window, or Project Manager unless they have been floated in the Workspace.

To select this option, pull down the View menu and click on WORKBOOK MODE; a checkmark
indicates that it’s selected.

When Workbook mode is selected, you’ll see a series of tabs alongside the bottom of the
Workspace. There’s one tab for each open Workspace window. 

When you click on one of these tabs, its associated Window will pop to the top of the
Workspace and become the “active” Workspace window. This is the same function as
selecting an active Workspace window under the Window menu — although most people
find that using the tabs is faster and easier than going to the Window menu or even using
the keyboard shortcuts.
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Clip List View Modemode:selecting
To select this option, pull down the View menu and click on CLIP LIST VIEW MODE; a
checkmark indicates that it’s selected. 

As we detailed in Chapter 11, when a DVD Movie is viewed in Clip List view mode, the
various video clips already in place in the Video Timeline will appear as a list. The infor-
mation resembles a standard Edit Decision List, showing Start and End Times, as well as
Length for each clip.

Clip List view mode is extremely useful for working with groups of several (or more) video
clips. However, unlike Timeline view mode, it doesn’t provide a relative visual representa-
tion of the DVD Movie; nor does it show any of the assets in the Audio Timeline or
Subtitle Timeline — and for these reasons, you may well find yourself switching back and
forth between modes.

To deselect Clip List view mode — and return to the default Timeline view mode — pull
down the View menu again and release the mouse on CLIP LIST VIEW MODE. (When you open
the View menu again, you’ll see that CLIP LIST VIEW MODE will be unchecked.)

Selecting the Active Workspace Window with the View Menu
As we detailed in Chapter 3, although you can have multiple windows open simulta-
neously in the Workspace, only the topmost window is “active.” (A window must be
active in order to use its controls or enter data; the active window also determines which
pull-down menus appear; for instance, the Movie menu is only visible if a DVD Movie
window is active in the Workspace.)

Using the View menu, you can activate any DVD Movie or DVD Menu; you can also
activate the Connections window. Furthermore, if you have floated any of the panes in the
Workspace, you can also make them the active Workspace window via the View menu.

For details on how to select the active Workspace window, please see Chapter 3.

Note: Keep in mind that activating a Workspace window — that is, bringing it to the front
of the Workspace — it is not a “show/hide” command. For instance, if you have closed a
DVD Movie or DVD Menu window (by clicking on the “x” in the upper-right corner of the
window), then you’ll need to re-open the window by returning to the Project Manager or
View menu to select the desired item. Also keep in mind that if you have closed the
Connections window, the only way to reopen it is to select it under the View menu or to
click on the CONNECTIONS button in the Toolbar.
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The Movie Menu
present only when a dvd movie window is active in the workspace

This menu lets you control the viewing (zoom) scale of DVD Movie Timescales, as well as
the RealView previewing of DVD Movies.

The pull-down Movie menu is only visible when a DVD Movie window is active in the Workspace.

Most of the Movie menu items have corresponding keyboard shortcuts. These shortcuts
can be seen as you pull down the Edit menu. 

Zoom In
This item is only available when using Timeline view mode and not Clip List view mode.

By selecting ZOOM IN, you increase the viewing scale or resolution of the DVD Movie
window. As you zoom in, you will see less of the overall DVD Movie and “zero in” more
to a specific portion of the Movie. For instance, by zooming in, you can fill the entire DVD
Movie with just a few seconds of the Movie — or even a frame or fraction of a frame of the
Movie. 

Typically, zooming in is most useful for locating specific transitions or establishing precise
Chapter Markers. 

The Zoom In function is duplicated in the DVD Movie controls.
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Zoom Out
This item is only available when using Timeline view mode and not Clip List view mode.

Zoom Out is essentially the opposite function of Zoom In. By selecting ZOOM OUT in the
DVD Movie menu, you decrease the viewing scale or resolution of the DVD Movie
window. As you zoom out, you will see more of the overall Movie. In this way, you can, if
you wish, see the entire DVD Movie within the confines of the DVD Movie window. 

Typically, zooming out is most useful for seeing the “big picture” of your Project, since
you’ll be able to see all the assets and Chapter Markers at a glance.

The Zoom Out function is duplicated in the DVD Movie’s controls.

Play/Pause
Selecting this menu item will begin RealView previewing of your DVD Movie, assuming a
video asset has been placed in the DVD Movie’s Video Track.

Note: Spruce authoring software will automatically display the RealView Previewer before
real-time previewing commences, should the RealView Previewer be hidden when you
select PLAY/PAUSE.

After RealView previewing has commenced, if you select PLAY/PAUSE again, playback will
pause. And by selecting PLAY/PAUSE once more, Playback will resume.

The Play/Pause function is duplicated in the DVD Movie’s controls.

Step-Frame Advance
Selecting this menu item will advance the RealView previewing of your DVD Movie from
a stopped or paused state, by a single frame at a time. If you have not yet previewed the
video, then selecting STEP-FRAME ADVANCE for the first time will “prime” the video and display
whatever frame the Play Cursor is at in the RealView Previewer window.

The Step-Frame Advance function is duplicated in the DVD Movie’s controls.
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Stop
This menu item stops RealView previewing of your DVD Movie. It also “resets” the DVD
Movie, so that when you next select PLAY/PAUSE or STEP-FRAME ADVANCE, the DVD Movie will
begin playback from its start (or from the current Playback Cursor location).

The Stop function is duplicated in the DVD Movie’s controls.

Add Marker at PlayCursor
Selecting ADD MARKER AT PLAYCURSOR will create a new Chapter Point Marker at the
PlayCursor’s current location in the Marker Timescale.

Note: This function will not operate if there is already a Marker at the PlayCursor’s current
location.

If you wish to change the newly created Chapter Point Marker to another kind of Marker,
you can always right-click on the Marker’s icon (in the Marker Timescale) and select EDIT

MARKER.

Scroll… (to First Asset; to End Asset;
Down to Next Page; Up to Previous page)
Spruce authoring software’s scrolling functions allow you to “repaginate” your view of any
DVD Movie in either Timeline or Clip List view modes.

For instance, if your current view of the DVD Movie shows just the beginning of an asset
in a video track and you’d like to see its end (or the beginning of the next asset), just click
once in the current asset, then select SCROLL TO END ASSET. Similarly, you can scroll to the
first asset in a track or you can “page” your view of the DVD Movie down (right, in
Timeline view mode) or up (left, in Timeline view mode).

Keep in mind that these scrolling functions only affect your view of a DVD Movie; they do
not reposition assets.
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The ‘Menu’ (DVD Menu) Menu
present only when a dvd menu window is active in the workspace

Note: Just to be clear, in this section, we’re referring to the pull-down menu that’s labeled
MENU — and which applies to DVD Menus only.

This menu offers you several controls that can also be accessed in the edit controls section
of each DVD Menu window. Each of these controls has a corresponding keyboard shortcut
that can be seen as you pull down the Menu menu. 

 

The pull-down ‘Menu’ menu is only visible when a DVD Menu window is active in the Workspace.

Fit Window Size
Click on FIT WINDOW size to resize the active DVD Menu — along with its controls — to fit
the dimensions of the background or subpicture image. This is useful if you’ve re-sized the
DVD Menu window and wish once again to return it to an efficient view that “wraps”
around the background image or subpicture. 

Assign Button Navigation
Spruce authoring software’s Assign Button Navigation feature is used to automatically
assign the navigation relationships between button highlight areas in an “intelligent”
manner, based upon their relative location to one another.

This control is duplicated in each DVD Menu under the ADVANCED tab, where it is also
enhanced with Horizontal Wrap and Vertical Wrap options. For a complete description of
this feature and its benefits, please see “DVD Menu Advanced Controls.”
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Save Custom Color Mappings
Once you’ve crafted all the Color Map settings for a DVD Menu, you can, if you wish,
save them as default DVD Menu Color Maps.

To do this, once all the Color Mapping controls are set as you wish, click on the ‘Menu’
pull-down menu and select SAVE CUSTOM COLOR MAPPING. Each new DVD Menu you create
will now open with the default color settings — providing you have checked the LOAD MENU

COLOR MAP SETTINGS FROM DEFAULT option in the User Preferences dialog. For more about Color
Maps, refer to Chapters 7 and 8.

The Tools Menu

This menu lets you access several tools and functions which are most commonly used as
you near completion of your Project.

All of the Tools menu items have corresponding keyboard shortcuts. These shortcuts can
be seen as you pull down the Tools menu.

The pull-down Tools menu.

For more information on the Encoder Control Panel, please see the Spruce Technologies
Encoding Guide, which accompanies this User’s Guide. For more information on the
Compile, Disc Image Creation, Write DVD-R, and Write Tape tools, please see Chapter
10. For more information on the Navigation Simulator, please see Chapter 9.
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Encode
This feature launches the Encoder Control Panel, which is used to encode video and audio
assets for use in a Project.

This feature is also duplicated on the Toolbar. 

Compile
This command launches the Compile tool, which assembles all of your current Project’s
information — including DVD Menus, DVD Movies, the connections, the assets, the
timing, the language selections, and so forth. Compiling your Project is a necessary step
before you can create a Disc Image.

The Compile command is also duplicated on the Toolbar. 

Disc Image Creation
This command launches the Disc Image Creation tool. This is used for writing Disc Images
of your Project directly to DVD-R disc or Digital Linear Tape (DLT).

Writing to DVD-R is an excellent way to “proof” your title by creating a “one-off” discs
prior to writing a tape. It’s also an economical way to produce limited numbers of discs.
Writing to DLT is the final step you perform when authoring, before sending your com-
pleted Project to a mastering/replication facility for disc replication.

For creating a reordered hybrid DVD-Video/DVD-ROM title, this tool is also used to write
the Disc Image to a hard drive as an “image file,” which can then be written to a disc
using the Write DVD-R tool, or to a DLT using the Write Tape tool. This is detailed in
Chapter 10.

The Disc Image Creation tool also used for setting some of the properties that will be
applied to your final replicated discs.

Note: Before you can create a Disc Image, you must have compiled your Project.

The Disc Image Creation command is also duplicated on the Toolbar. 
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Write DVD-R
Note: The Write DVD-R tool is used only when creating a reordered hybrid DVD-Video/DVD-
ROM title, as detailed in Chapter 10. For all other kinds of titles, , including non-reordered
hybrid titles, the Disc Image Creation tool is used for writing directly to DVD-R disc.

This command launches the Write DVD-R tool, used for writing a DVD-R disc (requires a
DVD-R recorder). Writing to DVD-R is an excellent way to “proof” your title by creating a
“one-off” discs prior to writing a tape. It’s also an economical way to limited numbers of
discs. Before you can use the Write DVD-R tool, you must have compiled your Project and
you must have written a Disc Image to a hard drive.

The Write DLT command is also duplicated on the Toolbar. 

Write Tape
Note: The Write Tape tool is used only when creating a reordered hybrid DVD-Video/
DVD-ROM title, as detailed in Chapter 10. For all other kinds of titles, including non-reordered
hybrid titles, the Disc Image Creation tool is used for writing directly to DLT tape.

This command launches the Write Tape tool, used for writing a Digital Linear Tape
(requires a DLT drive).

Writing to Digital Linear Tape (DLT) is the final step you perform when authoring, before
sending your completed Project to a mastering/replication facility for disc replication.
Before you can use the Write Tape tool, you must have compiled your Project and you
must have written a Disc Image to a hard drive.

The Write Tape command is also duplicated on the Toolbar. 

Navigation Simulator
This command launches the Navigation Simulator, which lets you preview your entire
Project — by simulating what the end-user will experience as he or she plays your title and
navigates through your title’s DVD Menus (using his or her DVD player remote control),
and more.

The Navigation Simulator command is also duplicated on the Toolbar. 
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The Window Menu

This menu allows you to hide, show, or rearrange windows within the Workspace.

The pull-down Window menu.

Window menu items have corresponding keyboard shortcuts. These shortcuts can be seen
as you pull down the File menu. 

Windows Arrangement Options
Spruce authoring software lets you arrange windows within the Workspace in several
different ways. . .

Cascade

This command will layer the Workspace windows one on top of the other.

Tile

This command will arrange the Workspace windows next to one another.

Arrange Icons

This command works only when you have minimized the Workspace windows and have
repositioned them so that they “float” in the Workspace.
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By selecting the ARRANGE ICONS command under the Windows menu, your minimized
Workspace windows will be arranged along the bottom edge of the Workspace.

Close All
Selecting CLOSE ALL will close all windows currently in the Workspace.

Currently Open Windows List 
Using the Windows pull-down menu, you can quickly choose which of the currently open
windows in the Workspace is active (topmost).

You’ll find a listing of all currently open windows in the Workspace at the bottom of the
Windows pull-down menu. The currently active window will have a checkmark next to it.
To chose another window as the active Workspace window, simply click on the Windows
pull-down menu and release your mouse on the desired window.

The Help Menu

With the Help menu, you can access Spruce authoring software’s online Help and get
important version information about your own copy of DVDMaestro or DVDConductor.

The pull-down Help menu.
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Both of the Help menu items have corresponding keyboard shortcuts. These shortcuts can
be seen as you pull down the Help menu. 

Help Topics
Select HELP TOPICS to open Spruce authoring software’s online Help file and to take you to its
table of contents.

The Help Topics command is also duplicated on the Toolbar. 

When the Help file opens, you’ll be presented with the Help topics page. Here, you can
search for a topic or browse the contents of the Help file. This file contains much of the
same information you’ll find in this manual, in a convenient, searchable format.

Navigating the Spruce authoring software Help file is similar to many Windows-based help
files. If you’re not familiar with these sort of files, here are some tips which may be of use
to you:

• The Contents page lists the main topics covered in the Help file. To select a topic,
just double-click on it.

• The Index page offers a more detailed listing of the topics, terms, and other items in
the Help file. To select an index item, just double-click on it.

• To search for something you’d like to know more about, simply go to the Index page
and type the first few letters of the word that interests you. You’ll notice that the
index will follow your typing and will highlight the closest available word to what
you’ve typed. To select a highlight item, just double-click on it.

• Within the text of the Help file, you may see underlined words. These are
“hyperlinks,” which will take you directly to a definition of the word.

• The Help file has its own menu, as well as buttons to let you return to the Contents to
search for a word, to print the page, and more. The “<<” button will return you to
the previous page; the “>>” button will take you to the next page.

When you are finished using the Help file, simply click CANCEL or the “x” button in the
upper-right corner of the window.
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About
With this command, you can find out more about your version of DVDMaestro or DVD-
Conductor.

The About command is also duplicated on the Toolbar. 

When you are finished looking at the ABOUT window, simply click OK or the “x” button in
the upper-right corner of the window.

•        •        •

Chapter 14: 
Using Command Sequences
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Chapter 14
Using Command Sequences
(for Advanced Users) 

Command Sequences are not available in the standard version of DVDConductor. They
may be added by installing the DVDPowerPack upgrade.

At Spruce Technologies, we’ve gone to great lengths to keep DVDMaestro and
DVDConductor as user-friendly as possible, by shielding you from many of the complexi-
ties of the DVD-Video Specification. As a result, your Spruce authoring software gives you
the tools you need to create Hollywood-calibre titles quickly and easily — without having
to be a programming expert. Indeed, many users will choose to skip this chapter, and will
still be able to create impressive titles using all of their Spruce authoring software’s other
features.

If you’re a relatively advanced user, however, you may wish to take advantage of some of
your Spruce authoring software’s more esoteric capabilities, by using the Command
Sequence features built into DVDMaestro and DVDPowerPack-enhanced versions of
DVDConductor. As we’ll learn, these features allow you to insert certain codes or “Com-
mand Sequences” into your titles that can communicate directly with a DVD player’s
native machine code — letting you create highly complex and interactive titles that can be
well worth the effort.

Command Sequences Overview

Command Sequences are special scripts, or codes, that you can incorporate into a Project.
By doing so, you can access the native machine code for DVD players so that new func-
tions will be available when end-users play back your final, replicated title. In this way,
the DVD-Video Specification’s full capability for interactive entertainment can be realized.
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Command Sequences appear in the Project Manager as a separate icon, similar to DVD
Movies and DVD Menus. You have the option to include dedicated Command Sequences
to accomplish functions not provided for directly in the Spruce authoring software interface.

Right-click on the Command Sequences folder in the Project window to create a new Command Sequence.

Command Sequences appear as targets in the Connections window. Using the Connec-
tions window, you can connect any source (e.g., First Play, Remote Key Action, Button
Action, etc.) to a Command Sequence.

Several Command Sequences shown in place in the Project Manager (left) and the Connections window. 

When this occurs, the Command Sequence will execute whatever sequence of events
you’ve written. Once finished, title playback will return to a DVD Movie, a DVD Menu, or
another Command Sequence.
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Command Sequences: Example 1
For this example, let’s assume we’re creating a title for salespeople and other presenters to
use as a sales tool when giving product demonstrations. We’ll also assume we’ve created a
Project with three different DVD Movies (“Soundtrack #1,” “…#2,” and “…#3”), selected
by a single DVD Menu, as shown below:

A sample Project, showing a DVD Menu that has button highlight areas that connect to three different DVD Movies.

Ordinarily, we assume the DVD player will be attended by a salesperson. But for those
times when the salesperson is not on hand, we’d like the DVD player to cycle through the
three DVD Movies automatically, in a loop fashion — so that nearby potential customers
will still be able to see product information.

To implement this, we could set a Timeout for the DVD Menu, such as “1 minute.” This
way, if the salesperson does not make a selection within a minute, the DVD player will
execute a timeout jump, which could be linked to a Command Sequence such as this one:
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The individual commands, as shown in the Command List section of the Command Sequence Editor (described below).

Here, the Command Sequence is scripted so that the automatic playback order of the DVD
Movies will rotate. (We’ll review how to enter these commands and how to view them in
the next section).

As shown below, this Command Sequence appears in the Project Manager as an icon in
the Command Sequences folder, labeled ROTATEMOVIES. It also appears in the Connections
window as the target for the source labeled MAINMENU TIMEOUT.

The Project Manager and Connections window, showing the Command Sequence in place. 
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As shown two screenshots above, this Command Sequence uses a memory location called
GPRM0. A “GPRM” is a “scratch” memory location available in every DVD player, which
can be used by a Command Sequence. (We’ll look much closer at GPRMs later in this
chapter.) Once a Command Sequence has been stored into a GPRM, it can be read later
by any other Command Sequence.

Looking at the Command Sequence instructions in the example pictured above, we can
see that each time the DVD player enters this script, the scratch memory GPRM0 is
incremented. Then the new value in GPRM0 is tested, and if is equal to or greater than
“3,” it is reset to “0.” In this way, GPRM0 acts as a simple counter that ticks off “0, 1, 2, 0,
1, 2, 0, 1, 2” and so on.

The next three commands test the value in GPRM0 and jump to one of the three DVD Movies
available. So each time the Command Sequence is executed, it selects one of the three DVD
Movies (SOUNDTRACK #1, SOUNDTRACK #2, OR SOUNDTRACK #3). When each DVD Movie completes,
it returns to the DVD Menu (MAINMENU). If no one actuates one of the DVD Menu’s button
highlight areas within the Timeout period, the DVD player jumps back into the Command
Sequence, which initiates playback of the next DVD Movie, and so on.

The Advanced section of the Navigation Simulator offers you a way to view the increments of GPRM0.
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To see this in action, you can start up the Navigation Simulator and observe the incre-
ments of GRPM0 in the Advanced area, as shown on the previous page.

Though this is a very simple example, it shows how easy scripts written in machine code
native to DVD players can be used to create titles with very advanced functions and
interactivity.

Creating & Managing Command Sequences

In the coming pages, first we’ll explain the interface for creating and editing Command
Sequences in the Spruce authoring environment, followed by a technical listing of the
commands and programming model that the DVD-Video Specification makes available.
Following that, we give another application example, with an analysis of the code that
implements a slightly more advanced selection model.

First we have to open the Command Sequence Editor.

To create a new Command Sequence and open the Command Sequence Editor:

1. By default, each Project has a Command Sequences folder in the Project Manager.
Right-click on the folder’s icon and (from the pop-up context menu) select ADD NEW

COMMAND SEQUENCE.

2. A Command Sequence will appear in the folder labeled SEQUENCE1 by default.

3. Double-click on the Command Sequence. The Command Sequence Editor will open.
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The Command Sequence Editor, before any commands have been added.

DVDMaestro and DVDConductor with the DVDPowerPack option is a complete environment for creating and
managing Command Sequences.

To add a command to the Command Sequence and choose its type:

1. With the Command Sequence Editor open, click on the Add button (or press the
Insert key on your keyboard).

2. A command will appear in the first line of the Command List. Initially it will read
NOP, or which stands for “No Operation.” To perform any meaningful work, at least
one command other than NOP is required.

3. With the command selected (it will be highlighted in blue), elect one of the Com-
mand Type buttons (NOP, Set GPRM, etc.) at the top of the screen. This will set the
Command Type for the current command.
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DVD machine commands are defined by a general Command Type, a specific selection of command within the
type, and a set of parameters.

As you choose any one of the eight different Command Types, you’ll notice that many of
the other settings in the Command Sequence Editor will change. We’ll review the Com-
mand Types and their related settings later in this chapter.

Modifying a Command within a Command Sequence
Once you create a command, you can easily modify it, delete it, or even change its order
within the Command Sequence.

To modify, delete or reorder any command:

1. With the Command Sequence Editor open, click once on the command (in the
Command List) you wish to affect. It will appear highlighted in blue.

2. To modify the command, make any possible changes using the Command Sequence
Editor. The changes will be reflected immediately.

– or –

2. To delete the command, click the DELETE button or press the Delete key on your
keyboard.

– or –

2. To reorder the command within the Command Sequence, click MOVE TO TOP, MOVE UP,
MOVE DOWN, or MOVE TO BOTTOM.
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Note: There is no “undo” function for any changes you make to a Command Sequence.
However, you can revert to the previous version of the Command Sequence by clicking
CANCEL in the Command Sequence Editor, rather than OK.

Editing an Existing Command Sequence
Whenever you create a Command Sequence (or modify it) and click OK, you will save it
“within” the current Project. Thereafter, you can easily edit it at a later time.

To edit an existing Command Sequence:

1. Double-click on its icon (within the Command Sequences folder in the Project
Manager).

– or –

Right-click on its icon (within the Command Sequences folder in the Project Man-
ager) and select EDIT COMMAND SEQUENCE from the pop-up context menu.

2. The Command Sequence Editor will appear, where you can make changes as
necessary.

Command Sequence ‘Library’ Functions
Once you’ve created a Command Sequence, you may wish to use the same (or similar)
Command Sequence in another Project. This is easily done using the Command Sequence
Editor’s Save and Load “library” controls.

To save a Command Sequence for use in another Project:

1. With the Command Sequence Editor open, click SAVE.

2. The dialog will open, where you can browse to save the Command Sequence in the
desired directory.

3. Click SAVE. The dialog will close and you’ll be returned to the Command Sequence
Editor.

To load a previously saved Command Sequence for use in the current Project:

1. With the Command Sequence Editor open, click LOAD.

Note: Be sure to open the Command Sequence Editor using a new Command Sequence
in the Project Manager; otherwise, whatever Command Sequence you load will “over-
write” whatever commands you may have in the current Command Sequence.
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2. A dialog will open, where you can browse to find the desired Command Sequence.

3. Click OPEN. The selected Command Sequence will appear in the Command Sequence
Editor.

4. If you wish to save this newly loaded Command Sequence as part of your current
Project, without any further changes at this time, click OK in the Command Sequence
Editor.

5. If you wish to edit the Command Sequence before saving it as part of the current
Project, first make whatever changes you wish, then click OK in the Command
Sequence Editor.

You can easily rename, delete, and duplicate any Command Sequence.

To rename, delete, or duplicate a Command Sequence:

1. Right-click on the Command Sequence’s icon (within the Command Sequences
folder in the Project Manager).

2. From the pop-up context menu, select the desired operation (RENAME COMMAND

SEQUENCE, DELETE COMMAND SEQUENCE, or DUPLICATE COMMAND SEQUENCE).

Before we look further at Command Types and related Command Sequence Editor settings,
let’s take a closer look at the language we use when creating Command Sequences.

The DVD Command Set:
the Language of Command Sequences

Every DVD player contains a microcontroller that executes a command set defined by the
DVD-Video Specification. This command set is used in the Command Sequences, as it is
supported by all DVD-Video playback devices.

The commands defined are at the level of microprocessor machine code, with very simple
commands to create desired functions. If you have previously worked with
microcontrollers or assembly-level programming, the commands and operations will be
familiar to you. Otherwise, you may find that some of the concepts and terms present a
challenge. Therefore, when learning Command Sequences, we suggest you proceed with
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initial deliberateness and caution — since it is very easy to author titles with Command
Sequences that just don’t work. Of course, as with all of your titles, you should use the
Navigation Simulator and test compilations of the Project using DVDPlayer to verify that
your title is playing back exactly as intended.

Input Models & Output Statements
Working with Command Sequences involves working with different kinds of “input
models” (events that cause a Command Sequence to run) and “output statements” (events
that a Command Sequence can initiate).

There are three kinds of inputs to Command Sequences:

• The first is what we call “implicit input,” which is based upon a navigational connec-
tion that has been established to a Command Sequence.

• Another is the “memory model,” which occurs when a stored value is recovered by
reading a previously written General Purpose Register Memory (GPRM) location.

• Yet another is the “system parameter model,” when a System Parameter Register
Memory (SPRM) is read to determine the setup and current state of the DVD player.)  

The first approach is indeed implicit, and is based upon standard protocols for connec-
tions, as detailed in Chapter 9. Let’s look at the other two input models. . .

The Memory Model: GPRMs

The DVD player has a limited set of memory registers (General Purpose Register Memo-
ries, or GPRMs) available for general-purpose storage and retrieval by the Command
Sequences.

There are eight 16-bit registers available, designated GPRM 0 through GPRM 7.

Each register can be used as a storage location or as a timer. In the timer mode, the register
is “preloaded” then decrements automatically once per second. Commands in the Com-
mand Sequence can test the value of the time to determine if the time has expired and
perform action condition on that result.

By definition of the DVD-Video Specification, GPRMs are cleared whenever a disc is
inserted in the player. There is no provision for non-volatile storage.
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The System Parameter Model: SPRMs 

Each DVD player operates internally via a group of system parameter registers (System
Parameter Register Memories, or SPRMs). The status of player operation (which DVD
Movie, what language, etc.) can be read by machine commands that access the SPRM
status registers.

The following list describes the system parameters that can be read by a Command
Sequence:

SPRM 0 DVD Menu Language parameter; DVD player setup by user

SPRM 1 Current audio streams; set by user or program

SPRM 2 Current overlay (subpicture) stream; set by user or program

SPRM 3 Current angle; set by user or program

SPRM 4 Current playing DVD Movie (Title); set by play

SPRM 5 Current playing DVD Movie (VTS); set by play

SPRM 6 Current PGC; set by play

SPRM 7 Current DVD Movie chapter; set by play

SPRM 8 Current Selected Button; set by viewer in play

SPRM 9 Navigation Timer; set by program, then times out

SPRM 10 Timer Target; DVD Movie to play when SPRM 9 times out

SPRM 11 Karaoke Mix for Audio; set by program or by player setup

SPRM 12 Country of Parental Management Level

SPRM 13 Parental Management Level in effect

SPRM 14

Video Output Mode (PAL/NTSC, Aspect Ratio, Letterbox Mode)

SPRM 15 Audio Playback Modes Available

SPRM 16 Initial Audio Language

SPRM 17 Language Code Extension

SPRM 18 Initial Subtitle Language

SPRM 19 Subtitle Code Extension
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These system control registers provide all the status information and control capability to
the Command Sequences.

Output Statements

Command Sequences can affect a disc’s playback in one of two ways:

• playback can jump to a new location (either a DVD Movie or DVD Menu);

• a different audio stream, subtitle stream, or video (camera angle) can be selected.

These are the only output statements available.

Conditional Instruction Execution
All commands — with the exception of NOP  commands — are subject to conditional
instruction execution.

Setting a conditional instruction execution lets you set up conditions
whereby certain commands do or do not occur depending upon the results.

Conditional instruction execution is where the DVD player processor tests a condition
(compare equals, not equals, etc.) between a GPRM, or between a GPRM and an SPRM, or
between a memory location and an immediate value. The command is executed or not
executed according to the result.
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The middle pull-down field lets you set the type of comparison.

For example, in the case above, we’ve chosen EQUAL, which means the command in question is
executed if, and only if, the condition defined by the comparison is true. In this case, the
affected command would always execute, as GPRM0 will always be equal to itself.

The available comparison operations for conditional execution are:

• Bitwise AND

• Equal

• Not Equal

• Greater Than or Equal To (>=)

• Greater Than (>)

• Less Than or Equal To (<=)

• Less Than (<)

The lists of GPRMs, SPRMs, and immediate values are the same as for the command
source fields.

Command Types 
By choosing the Command Type, you can set whether a particular command will read and
write memory; jump to a new play location; read the status of the player: set audio/
subtitle/video (angle) streams; and control execution of the Command Sequence.
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The Command Types, as they appear in the Command Sequences Editor.

There are eight Command Types.

• NOP: No Operation. 

• Set GPRM: Determine a value and load into memory (detailed below). 

• Jump: Exit sequence and play DVD Movie, or other target (detailed below). 

• Resume: Continue play of current DVD Movie. 

• Goto: Go to a specific command line (detailed below). 

• Set GPRM Mode: Set memory or time mode (detailed below). 

• Set System Stream: Set the Audio, Subtitle, and/or Video (Camera Angle) stream
(detailed below). 

• Karaoke Mix Mode: Set audio mixing for karaoke use. 

Some of these Command Types consist of only a single command function, while others
have functions and operations. Let’s look at the more complicated Command Types in
greater detail.

Set GPRM

Set GPRM, which determines a value and loads it into memory (and should not be con-
fused with Set GPRM Mode, described below), is the most extensive of the Command
Types. When you select SET GPRM, the following additional command functions become
available:



DVDMaestro User’s Guide14-18

These fields will appear in the Command Sequences Editor once you select SET GPRM as the Command Type.

The Operation Type selects one of 11 different command functions.

Selecting the Operation Type command functions for the Set GPRM Command Type.

Each of these operations takes one or two arguments and the result of the operation is
always stored into one of the eight available GPRM registers.
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Selecting where the results of the operation will be stored.

For single-argument commands such as Move or Random, the required argument may be
supplied from a GPRM register, one of the SPRM player control registers, or from an imme-
diate value supplied by the programmer.

Supplying the required argument from an SPRM register.

For commands that require two arguments, such as Add, the other argument is provided by
the same GPRM is which the result is stored.

The GPRM registers are 16 bits wide. For immediate values, a number between 0 and
65535 can be entered. The individual command functions are described on the next page.
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• Move — the value in a source GPRM, SPRM, or immediate value is moved into the
GPRM destination register.

• Swap — the value in a source GPRM is exchanged with the contents of the GPRM
destination register. This is the only command that can write two locations at once.

• Add – the value in a source GRPM or an immediate value is added to and replaces
the contents of the destination SPRM.

• Subtract — the value in a source GRPM or an immediate value is subtracted from
and replaces the contents of the destination SPRM.

• Multiply — the value in a source GRPM or an immediate value is multiplied by and
replaces the contents of the destination SPRM.

• Divide — the value in a source GRPM or an immediate value is divided by and
replaces the contents of the destination SPRM.

• Random — a random number is generated whose range is determined by a source
GPRM or an immediate value. This value replaces the contents of the destination GPRM.

• Bitwise AND — the 16 individual bits of a source GPRM, SPRM, or immediate value
are compared with the corresponding bits in the destination GPRM. The bits that are
set (value 1) in both the source and destination register are left set. Bits that are not
set on one or the other register are reset (value 0).

• Bitwise OR — the 16 individual bits of a source GPRM, SPRM, or immediate value
are compared with the corresponding bits in the destination GPRM. The bits that are
set (value 1) in either the source and destination register are left set.

• Exclusive OR — the 16 individual bits of a source GPRM, SPRM, or immediate value
are compared with the corresponding bits in the destination GPRM. The bits that are
set (value 1) in one or the other (but not both) the source and destination register are
set. Bits that are set in neither or both of the registers are reset (value 0).

Jump

Command Sequences are usually terminated by a Jump or Resume command. The Jump
command starts play of the disc at a designated location.

The destinations of Jump commands can be a DVD Movie, a chapter within a DVD Movie,
a DVD Menu (with or without setting a button highlight), or a Command Sequence.
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Setting the jump target and conditional instruction execution for the Jump Command Type.

In the case of DVD Movies, the selection of chapter can be optionally controlled by a
GPRM register. The same option is available for button selection DVD Menu targets.

Goto 

Goto is used to control the execution of program by jumping execution from the current
line to a defined line number. Usually, a goto command is combined with a conditional
execution test to provide decision-making capability in the sequence.

Setting the line number and conditional instruction execution for a Goto Command Type.

The target line number is entered explicitly in the command.
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The optional test for conditional execution is defined as for other command types. The
defined goto will take place only if the defined condition is satisfied.

Set GPRM Mode

This Command Type — not to be confused with the “Set GPRM” Command Type, de-
scribed above — sets the memory or time mode.

Selecting which mode will be used for GPRM operations.

Each GPRM can operate in one of two modes:

• In Register Mode, the register operates a memory. A value written into the GPRM
location can be read back unchanged.

• In Counter Mode, a value loaded into the register decrements automatically once per
second, until the value reaches “0.” Counter Mode is a useful way to implement
multiple timing functions within a presentation.
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Set System Stream

This Command Type lets you create commands that affect the play of the disc by switching
audio, subtitle, or angle (video) streams.

A single command can set all three stream types at once. Checkboxes provide for selecting
the stream type or types to be set by the command. The new setting for the streams can be
taken from an immediate value or from the contents of one of the GPRMs.

Setting the audio, subtitle and angle (video) streams.

As with other Command Types, an optional conditional execution test can be performed.
In that case, the Set System Stream command will be executed if and only if the defined
condition is satisfied.
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Command Sequences: Example 2

Now let’s consider a more elaborate variation of the example Project we described near
the start of this chapter.

In this more elaborate sample Project, the DVD Menu’s button highlight areas now select which audio track of a
single DVD Movie will be used as the active audio stream.
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In this case, we’ve replaced the three DVD Movies with a single DVD Movie that has three
alternate audio tracks, any one of which can selected to be the active audio stream. The
action that we wish to achieve is as follows.

• Program starts with the main DVD Menu (MAINMENU), which allows direct selection of
the audio stream.

• If the DVD Menu timeout period is exceeded, then the viewer will see the button
highlight areas in rotating order, at an interval of one second.

• After a random number of steps through the button highlight rotation, the movement
will stop and execute play of the DVD Movie, while randomly selecting which of the
three available audio tracks will be the active audio stream.

The desired action is realized by using two different Command Sequences. The first
Command Sequence, which we’ll call SETLOOP, simply initializes values for use by the
second and is called whenever we wish to jump to the DVD Menu — whether at First
Play, the end of a DVD Movie, a Menu Key action, or whatever.

The SetLoop Command Sequence reads as follows:

The SetLoop Command Sequence, as it appears in the Command List of the Command Sequences Editor.

The first two commands in the Command List insert values of “0” in GPRM0 and GRPM1.
These two memory locations will serve as the two loop counters that define the “short
loop” around the three button highlight areas and the longer count to select the random
exit.

The third command in the Command List generates a random number, whose limit is
specified as 10. Thus, a number between 1 and 10 will be stored in GPRM2. This will be
used to test whether we have incremented enough times.

The last command in the sequence jumps to MAINMENU.
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This screenshot shows the DVD Menu’s Playback Control tab, which is where the Timeout value is set.

Within the Playback Control tab of mainmenu, we’ve set a timeout value of 20 seconds. If
none of the DVD Menu button highlight areas are activated within that time, a Timeout
connection to the second Command Sequence, called ANIMATEMENU, is executed. The
instructions in that Command Sequence are as follows:

The AnimateMenu Command Sequence, as it appears in the Command List of the Command Sequences Editor.

As you can see above, the first command in this Command Sequence increments GPRM0,
which serves as the counter for the “short loop.” The next command tests the value. If it
has reached as high as “4,” then the value “‘1” is placed in the register. Thus, a value of
less than “one” is never seen by the rest of the program.

The third command increments PGRM1, which serves as the randomly determined count
that decides when we are finished incrementing and ready to play the DVD Movie.

The fourth command tests GPRM1 to see if it has reached the value of the random number
stored in GRPM2 by SetLoop. If so, then program execution jumps to Line 6, which is the
play DVD Movie sequence.
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The Connections window, showing all the current navigational connections for the Project, including the SetLoop
and AnimateMenu Command Sequences. 

If the condition “GPRM1 equal to GPRM2” is not satisfied, then the program jumps
immediately to AnimateMenu, with its button highlight areas determined by the value in
GPRM0. AnimateMenu is an exact copy of mainmenu, except that its Timeout is set to one
second instead of 20 seconds. The Timeout of AnimateMenu also connects to
AnimateMenu. So when the loop starts, the DVD player will return once per second to this
sequence until the condition of GPRM1 equal to GPRM2 is satisfied.
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When the incrementing count of GPRM1 is found to reach the randomized value in
GPRM2, then the command at Line 6 sets the audio stream according to the value in
GPRM0. The next two commands reinitialize the two loop counters (which is redundant,
as SetLoop does this), and the last command jumps out to play the DVD Movie with the
selected audio track.

Summary of Command Sequences

Command Sequences provide a powerful way to add interactivity and other functionality
to your DVD titles. In this chapter, we’ve learned how to create basic Command Se-
quences, how to enter commands and set certain parameters, and we’ve reviewed a
couple examples of how Command Sequences can be used in a DVD Project.

All of this, however, only touches the surface of what is possible with Command Se-
quences — and you’ll find that the deeper you delve into them, the greater your DVD
authoring capabilities will increase.

•        •        •

Index
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parsing imported video & audio files  5-9
previewing imported still image files  5-11
sorting contents  5-7
viewing imported assets properties  5-8

Assign Button Navigation  13-17, 13-18
Assign Button Navigation (DVD Menu)  13-17
Audio

adding to a Slide Show  11-42
Audio and Subtitle Languages  C-26
Audio Bit Stream  A-4
Audio Language  7-83
Audio Menu  9-6, 9-22, 9-29
Audio Output File  11-8
Audio Player Configuration  7-84
Audio Stream  7-71, 7-74
Audio Stream No.  7-83
Audio Timeline  6-4, 11-7
Audio_ts  10-15, 10-37, 10-47
Audio_ts folder  A-4
Auto Action  7-66
Auto Action Mode  7-60
Auto Assign  7-65
Auto-Conform  C-24

B

Background  7-5, 7-51
Background Image  7-5, 7-29, A-5

backdrop example  8-13
combination with subpicture image  8-12
image resolution  7-28
image size  7-28
picture dimensions  8-12
removing  7-36

Index
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Backward Scan  A-5
Basic view level (Sources field)  9-15
Bit-Rate  A-5
Bitmapped images (.bmp)  2-14, 2-16, A-5
Button Action  7-60, A-6

color  7-61, 7-62
previewing colors  7-61, 7-62

Button Controls
Button Selection  7-59

Button highlights  7-5, 7-37, 7-44
assigning to color group  7-66
color group  7-66
copying  7-41
coordinates  7-64
defining  7-14, 7-37
deleting  7-40
introduction  7-14
moving  7-40
numbering  7-15
resizing  7-42
selecting  7-40
vs. visible buttons  8-8
Button Highlight Area  A-6

establishing connections in a DVD Menu
7-21 9-26

Button Highlight Markers  A-16
Button Number Offset  7-79, 7-80
Button Outline  7-37, 7-40, 7-45, 7-66
Button Pre-Selection  7-78, 7-79
Button Selection  7-59, A-6

previewing colors  7-59
Button Selection (Color Mapping Controls)  7-59
Button State Controls

Button Action  7-60
Subpicture  7-57

Button states  7-50
Button Action  7-50
Button Selection  7-50
Subpicture  7-50

Buttons tab  7-18

C

Cancel writing to DLT or DVD-R  10-52
Cascade Workspace windows  13-21
Chapter  A-6
Chapter Marker Start and End points  9-6, 9-18

Chapter Menu  9-6, 9-22, 9-29
Chapter Point Marker  6-4, 9-7, A-6

adding at PlayCursor position  13-16
Chapter Previewer  A-6
Chapters  13-14
Clip List view mode  11-15

adding video assets  11-19
changing End Time or Length of video clips

11-22
changing picon size  11-17
locking the video track  11-23
modifying segment length  11-19
moving groups of clips  11-18
re-ordering video clips  11-18
selecting  13-13

close
Project  13-6, 13-8

Close All
Workspace windows  13-22

Closed Captions  A-15
closing a Project  13-6
closing and saving a Project  13-8
color groups  7-61

vs. palettes  7-61
Color Maps  8-4, 8-9, A-7

and subpictures  8-4
button highlight areas  8-7
controls  7-50
changing default colors  7-53, 7-55, 7-56
DVDMaestro vs. DVD-Video Spec terminology

7-51
experimenting with  7-15
Subpicture

4-color (2-bit) file depth  8-4
subpicture  8-4
Understanding concepts  8-3, 8-20

Color Map 1  7-50, 7-57, 7-59, 7-60, 8-7, 8-10
Color Map 2  7-50, 7-57, 7-59, 7-60, 8-7, 8-11
Color Map 3  7-50, 7-57, 7-59, 7-60, 8-7, 8-11
Color Map 4  7-50, 7-57, 7-59, 7-60, 8-7, 8-11
Color Map settings

saving  7-63, 13-18
as default DVD Menu colors  7-63, 13-18

Color Mapping Tab  7-13, 7-50
color swatches  7-50, 7-53, 8-4

original  7-51, 7-52, 8-4

Index index-5

Colors for Subtitles  C-19, C-23
Command List  14-6, 14-9, 14-25, 14-26
Command Sequence  A-7

creating new  14-8
Command Sequence Editor  14-9, 14-11

Command List section  14-9
opening  14-8

Command Sequences  4-13, 9-7, 14-3
adding command & choosing type  14-9
Command Types  14-16

Goto  14-17, 14-21
Jump  14-17, 14-20
Karaoke Mix Mode  14-17
NOP  14-17
Resume  14-17
Set GPRM  14-17
Set GPRM Mode  14-17, 14-22
Set System Stream  14-17, 14-23

conditional instruction execution  14-15
deleting  14-12
deleting a command  14-10
duplicating  14-12
DVD command set (Command Sequences

language)  14-12
editing exisiting Command Sequence  14-11
example (1)  14-5
example (2)  14-24
GPRMs  14-13
input models & output statements  14-13
language (DVD command set)  14-12
library functions  14-11
loading previously saved for use in current

Project  14-11
modifying a command  14-10
output statements (how disc playback is

affected)  14-15
overview  14-3
renaming  14-12
reordering  14-10 C-18
saving for use in other Project  14-11
SPRMs  14-13, 14-14

Command Sequences Editor  14-25, 14-26
Command Types (Command Sequences)  14-16
Compact Layout mode (DVD Menus)  7-25
Compile  13-19

tool  10-14

Compiler Message  10-16
compiling

Project  10-14, 10-16, 10-53
viewing results in the Output Log  10-53
adding backgrounds and subpictures (via the

PlaybackControl tab)
Control tab)  7-35, 7-34

Concatenation  A-7
adding multiple video assets to a DVD Movie

11-3
encoding requirements  11-6

Conditional Element  7-82, 7-83
Conditional Relationship  7-82, 7-84
Conditional State  7-82, 7-84
Connections

copying  9-11
deleting  9-12
default for DVD Movie chapters  9-12
drag-and-drop method  9-8
establishing in the Target field  9-8
right-clicking in the Target field method  9-10

Connections Window
opening or closing  4-14

Connections window  2-7, 3-3, 4-14, 9-4,
13-11, A-8

Command Sequences as targets  14-4, 14-
6, 14-27, A-7

opening  9-5
showing  3-7
Source-Target Connections

copying the connection  9-11
deleting the connection  9-12
moving the connection  9-10

sources  9-3
Sources field  9-6
Target box (in DVD Menu Button tab)  7-69
targets  9-3
Targets Bin  9-7
tips for viewing the Sources field  9-17
viewing options for the Sources field  9-14

Contents Scramble System (CSS) encryption  
10-41, A-8

Control Bar  6-4
Controlling Access  C-8
Coordinates  7-64
copy  13-10
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Copy Generation Management System (CGMS)
10-41, A-8

copying of disc
permitting  10-41
restricting  10-41

Copyright Management Information  10-40, A-8
Copyright Protection System (Contents Scramble

System)
m)  10-41

Create Audio in Sync  C-24
creating a Disc Image  10-53
CSS (Contents Scramble System) Encryption  

10-41
Current side of disc  10-46
cut  13-10

D

Daikin-Comtec Laboratories Scenarist™ bitmap-
based format (.son) subtitles file

ormat (.son) subtitles file  12-4
Data Description Protocol (DDP) file  10-45, A-8
Default Settings for Audio and Subtitle Languages

C-26
Digital Linear Tape (DLT)  A-9
Direction of Translation  A-8
DirectShow Compatibility  10-7
Disabled User Actions  A-8
Disc Image  10-31, A-9
Disc Image Creation  10-29, 13-19

before writing Disc Image  10-33
Disc Image Creation tool  A-8

opening  10-30
Disc Image Properties  10-9, A-9

opening (DVDConductor standard version)
10-35

setting prior to creating a Disc Image  10-33
display area  7-3
Display Condition  7-81, A-9, C-8

Conditional Element  7-82
Conditional Relationship  7-82
Conditional State  7-82
creating  7-82
Otherwiseselection  7-82

Display Condition interface  C-28
Display preferences  7-9
Divx (discontinued DVD distribution format)  A-9

DLT Tape (Disc Image Creation destination)  10-32
docking panes  3-8
Dolby AC-3 (Dolby Digital)  A-10
Drop-Frame  A-10
Dual Layer Break Marker  A-10
Dual Layer Disc  A-10
Dual Layer option  10-38
Dual-Layer Break Markers  A-16
DVD command set (Command Sequences

language)  14-12
DVD File Structure

viewing  10-17
DVD GPRM registers  C-14
DVD Hardware Decoder Card  A-10
DVD Jacket Picture Support  C-40
DVD Menu  2-7, 3-3, A-11

adding audio to a DVD Menu  8-17
adding backgrounds and subpictures  7-29,

7-30, 7-31, 7-32
adding single-layer assets  7-30
adding two-layer Photoshop assets  7-29
adjusting view  7-9
Advanced Controls

Button Number Offset  7-80
Button Pre-Selection  7-79
Navigation Auto Assign  7-81

Advanced Tab  7-78
background images  7-5

image resolution  7-28
image size  7-28

building a DVD Menu  7-7
button highlights  7-5
Button Preview options  7-44
Buttons Tab  7-64
color groups  7-61
Color Mapping Tab  7-50
Compact Layout mode  7-25
controls

Buttons tab  7-18
creating (adding)  7-23
creating and managing  7-23
creating new  4-8
deleting  4-10, 7-27
design tips  8-3
display area  7-3
duplicating  4-10, 7-27

Index index-7

dynamic  7-6
adding or replacing an audio stream  7-74
audio stream  7-74
deleting an audio stream  7-74

End State (dynamic)
Loop mode  7-75
Still  7-75
Timeout  7-75

End State (static)
Still  7-74
Timeout  7-74

End States  7-71
Loop mode  7-71
Static  7-71
Timeout  7-71

groups  8-19
image resolution  7-28
importing background and subpicture assets  7-11
Menu Navigator  7-48
motion  7-6
new features  1-6
opening  4-8, 7-8
opening and activating  7-24
Overview  7-3
Playback Control Tab  7-70

Loop/Subpicture Start slider  7-76
Playback Controls

Loop/Subpicture Start Point  7-76
Subpicture Start Point  7-76

preparing assets  7-10
removing backgrounds and subpictures  7-36
renaming  4-10, 7-27
reordering physical placement  4-12
replacing active DVD Menus in the Work-

space  7-26
resolution of image files  7-11
showing  3-7
sorting  4-12, 7-27
static  7-6
static vs. dynamic  7-70
subpicture images  7-5
testing with Menu Navigator  7-19
transition sequences  8-19
tutorial  7-7
view controls

Video Monitor  7-20

View Layer options  7-45
view options  7-43
visible buttons  7-6
working with still image assets  7-28

DVD Menu Controls
Advanced Tab  7-78

Button Number Offset  7-79
Button Pre-Selection  7-78
Display Condition  7-81
Navigation Auto Assign  7-80

Buttons Tab  7-64
Auto Action  7-66
Coordinates  7-64
Group (color group assignment  7-66
Invisible  7-67
Name  7-68
Navigation  7-64
Stream Pre-Selection  7-68
Target  7-69

Color Mapping Tab  7-50
Playback Control Tab  7-70

Audio Stream  7-74
End State  7-74
Still Image/Video Stream  7-72
Subpicture Image  7-73

DVD Menus  7-3
DVD Movie  2-7, 3-3, A-11

adding multiple timed still images  11-40
adding multiple video assets  11-4
adding timed still image  11-39
advanced Video Timeline features  11-3
authoring multi-angle DVD Movies  11-27
basic concepts  6-3
Control Bar  6-4
controls  7-4
creating new  4-7
deleting  4-10
duplicating  4-10
mixed-angle  11-33
new features  1-7
opening  4-8, 7-8
overview  6-4
renaming  4-10, 6-7
reordering physical placement  4-12
showing  3-7
sorting  4-12
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Status Bar  6-5
Timelines  6-5
Timescales  6-5
tutorial  6-6
view options  7-3
window  13-14

DVD player (consumer deck)
machine code  

14-3, A-7

DVD Register Mapping  C-14
DVD Volume Name  10-36, A-11
DVD-R Media (Disc Image Creation destination)

10-32
DVD-R Recorder  A-11
DVD-ROM  A-11
DVD-Video Specification  7-51, 10-36

DVD command sets (for use with Command
Sequences)  14-12

DVDConductor
current version number  13-24
DVDEncoderPack  1-5
DVDPowerPack  1-4
exiting (quitting) the application  13-8

DVDMaestro
current version number  13-24
exiting (quitting) the application  13-8

DVDMaestro & DVDConductor
basic concepts  2-5
comparison  1-4
launching & quitting  2-4
launching & saving  2-16
maximizing view of the application  3-5
new features  1-6
overview of onscreen elements  2-6
project flow overview  2-10
viewing configurations  3-4

DVDPlayer (utility)  10-19, 11-28
reviewing multi-angle video  11-31
settings  10-26
starting  10-21

DVDStation turnkey system
starting  2-3

Dynamic DVD Menus (Motion Menus)  7-6, 8-18,
A-11

E

Embed Project Text Data in DVD Image 6-8, 10-9
Embedded Text for Convergence Support  C-41
Emphasis 1  7-51
Emphasis 2  7-51
Emulation of title using DVDPlayer  10-19
Encode  13-19
Encoder Control Panel  13-19
Encoding  A-12
Encoding Button

assigning  C-42
End Action  9-21, 9-23
End Location counter  6-4, 6-5
End State  7-74, A-12
eo 11-7, 11-13

creating synchronous audio to match concat-
enated video

Exit  13-8
Exit (navigation control)  9-38
Extended Parental Management Functions  C-4
Extending Video Assets  11-10

F

File Structure
viewing  10-17

first layer  10-38
First Play  9-6, 9-17, 9-21, 9-29, 9-37, A-12
Fit Window Size  13-17

DVD Menu  13-17
flattening Photoshop layers  8-15
floating panes  3-9
Forced I-Frame Insertion  A-12
Forward Scan  A-13
Frame Rates  A-13
Full Resolution 7-46

G

General Authoring/Premastering Features  C-35
General Parameters (Navigation Simulator)  9-39
General Properties  A-13

DirectShow Compatibility  10-7
General Purpose Markers  A-16
General Purpose Register Memory (GPRM)  14-13
GIF Image  A-13
Goto (Command Type)  14-21

Index index-9

GoUp (connections source  9-6
GoUp Links (for DVD Menus)  9-22, 9-29
GPRM  14-7, 14-13
GPRM Management  C-13
Grab Still From Video  C-30
Group (Color Group Assignment)  7-66
Group-of-Pictures (GOP)  A-13
Groups

DVD Menu  8-19

H

Help file
navigating  13-23

hiding
panes  3-6
windows  3-6

Horizontal Wrap  7-81
Hybrid DVD-Video/DVD-ROM Disc  A-14

creating using the Layout Files Option  10-36

I

I-Frame (Intra Frame)  A-14
image (background or subpicture) dimensions  8-12
Images

background  7-5
subpicture  7-5

image resolution  7-28
image size  7-28

importing
assets into a Project  5-4, 5-5

importing MPEG video files  5-12
in-flight entertainment systems  C-39

when adding multiple video assets to the
Video Timeline

Initial Stream Settings  10-7
Input Source (Disc Image Creation)  10-31
International Parental Rating Levels  C-5
Inverse Telecine (NTSC Film Mode)  A-14
Invisible  7-67
ISO Publisher ID field  C-38

J

Jacket Picture  C-40
JPEG Image  A-14
Jump (Command Type)  14-20

K

Keyboard shortcuts
Edit menu  13-9
File menu  13-5
Help menu  13-23
Menus menu  13-17
Tools menu  13-18
Window menu  13-21

keyboard shortcuts
DVD Movie menu  13-14
View menu  13-12

L

Language Codes  A-15
Last Played Chapter  7-83
Last Played Movie  7-83
Last Selected Button  7-83
Layer 0  10-38
Layer 1  10-38
Layer start point (Chapter Marker)  10-38
Layers

first  10-38
information  10-38
second  10-38

Layout Files Option  10-36
DVD-Video Only  10-37
Hybrid DVD-Video/DVD-ROM  10-37

Letterbox  A-15
Line 21 Support(Closed Captions)  A-15
Locking the Video Track  11-22
Loop mode (dynamic DVD Menu End State)  

7-71, 7-75, A-15
Loop point  7-76
Loop/Subpicture Start point  7-72
Loop/Subpicture Start Previewer  7-75
Loop/Subpicture Start slider  7-75, 7-76

M

Macrovision APS Copy Protection  10-10,
10-33, 10-42, A-16

Mapping GPRMs to Multiple Named Variables
C-13

Marker Timescale  6-4, 6-5
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Markers  A-16
adding a Marker at the PlayCursor position

13-16
Menu Button Activation  C-33
Menu Editor Features  C-32
Menu Key  9-21, 9-23
Menu Language  7-83
Menu Navigation  9-36
Menu Navigator  7-19, 7-48
menus (pull-down)

changeable nature of DVDMaestro menus  2-7
changeable nature of menus  13-3
DVD Menu  13-17

Normalize Window  7-48
DVD Movie  13-14
Edit  13-9
File  13-5
Help  13-22

about DVDMaestro or DVDConductor  13-24
reference descriptions  13-3
Tools  13-18

Compile  10-14, 13-19
Disc Image Creation  13-19
Encode  13-19
Navigation Simulator  13-20
Write DVD-R  10-50, 13-20
Write Tape  10-50, 13-20

View  13-11
Assets Bin  13-11
Output Log  13-11
Project Manager  13-11
RealView Previewer  13-11
Status Bar  13-11
Toolbar  13-11
Workbook mode  13-12

Window  13-21
Cascade  3-14

Microsoft Paint  8-8
mixed-angle DVD Movie

constructing  11-35
previewing using RealView Previewer  11-37

Mixed-Angle Video  11-33
motion DVD Menus  7-6
Motion Menus  8-18
Movie Features  C-19
Movie Navigation  9-35

MPEG-1  A-16
MPEG-1 audio only (.m1a or .mpa)  2-15
MPEG-1 video only (.m1v or .mpv )  2-15
MPEG-2  A-16
MPEG-2 video only (.m2v )  2-15
Multi-Angle Video  11-25, A-17

restrictions for encoding  11-32
Multiple Colors for Subtitling  C-19
Multiple Named Variables  C-13

N

Name  7-68
navigating

DVD Menu  9-36
first play  9-37
Help file  13-23
Project  9-35

Navigation
Assign Button Navigation  13-17

navigation
assigning button-to-button selection order  7-17
simulating  2-12

Navigation Auto Assign  7-80, 7-81
Horizontal Wrap  7-81
Vertical Wrap  7-81

Navigation Controls  9-35
Navigation relationships between button

highlight a  7-65
Auto Assign  7-65

Navigation Simulator  2-12, 9-33, 11-28, 13-20,
A-17

Exit  9-38
General Parameters  9-39
navigation controls  9-35
previewing multi-angle video  11-30
State Info

DVD Movies vs. DVD Menus  9-38
System Parameters  9-39
using to check a Command Sequence  14-8
viewing Advanced settings  9-39

New
DVD Menu  13-5
DVD Movie  13-5
Project  13-5

New Authoring Features  C-3
Next (connections source)  9-6

Index index-11

Next (link for DVD Movie)  9-21, 9-29
nmen-

opening (DVDMaestro or DVDConductor with
DVDEntertainmentPack upgrade)
nmentPack upgrade)  10-42, 10-33

None (DVD Menu Button Preview option)  7-44
Normalize Window

DVD Menu  7-48
Normalize Window (DVD Menu View Layer

option)  7-48
Norton Utilities  10-31
Not Rated  C-6
NTSC  2-20, 7-46, A-17 
NTSC/PAL Monitor  A-17
Number of sides for final disc  10-45

O

Offset Button Number  7-80
ons -

connections that must be established in the
Connections window
ons window  9-29

Opacity  A-17
Opacity sliders  7-50, 7-51, 7-56, 7-57, 7-

59, 7-60
changing default levels  7-56

Opacity value  7-56
Open

DVD Menu (new)  13-5
DVD Movie (new)  13-5
most recent Projects  13-8
Project (new)  13-5
previously created Project  13-6

opening a DVD Movie  7-8
Opposite Track Path (OTP ) protocol  10-39
Otherwise Go To Menu  7-85
Output Destination (Disc Image Creation)  10-31

to DLT Tape  10-32
to DVD-R Media  10-32
to Image File  10-31

Output Log  2-9, 3-3, 10-15, 10-51, 10-52,
10-53, 13-11, A-18

copying & pasting contents  10-54
nature of information logged  10-54
viewing tabs  10-53

overlay  7-5

P

PAL/SECAM Video  2-20, 7-46 A-18
Pan-Scan  A-18
Pan-Scan Setting for 16:9 Menus  C-35
Panes  3-3, A-18

Assets Bin  3-3
docking  3-8
floating

in the Workspace  3-11
outside the Workspace  3-9

hiding  3-6
moving  3-8
Output Log  3-3
Project Manager  3-3
RealView Previewer  3-3
removing  3-12
resizing  3-8, 3-12
vs. windows  3-3

Parallel Track Path (PTP ) protocol  10-39
Parental Control Features of the Navigation

Simula  C-10
Parental Level  7-84, A-19

for Individual Movies  C-6
setting  10-6

Parental Management Functions  C-4, C-10
parsing imported video & audio files  5-9
paste  13-10
Pattern  7-51
Photoshop  8-12

changing image size within Photoshop  8-15
flattening layers to create 2-layer file  8-15
two-layer assets  7-29
two-layer file (for background and subpicture)

7-13
Physical Specifications  10-45
Play/Pause  6-4, 6-5, 13-15
Playback Control Tab  7-34, 7-70
Playback Direction information

Inner (PTP)  10-39
Outer (OTP)  10-39

Playback Location counter  6-4, 6-5
PlayCursor  6-4
Player Region Code  7-83
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Playlists  4-13, 9-7
as navigation objects  9-32
creating alternate play paths for DVD Movies

9-29
Pre-Conditions for Movie Display  C-27
Pre-Select Button  7-79
preferences

global User Preferences  13-8
premastering  10-3
Premastering Features  C-35
preparing a Project for Disc Image layout  10-37
previewing a DVD Movie  2-12
previewing imported still image files  5-11
Previous (connections source)  9-6
Previous (link for DVD Movie)  9-21
Previous Link  9-29
Printable Project Log  C-36
printing

Connections window information  13-7
Project  A-19

definition  2-5
name  10-36
open  13-6
open most recent  13-8
preparing for replication (premastering)  10-3
saving new  2-17
starting new  2-16
typical flow  2-10

Project Log  C-36
Project Manager  2-9, 3-3, 4-3, 13-11, A-19

branches  4-4
Command Sequences (folder & icons)  14-

4, A-7
creating a DVD Menu  4-8
creating a DVD Movie  4-7
opening or closing Connections window  4-14
overview  4-3
Tree View vs. List View  4-5

Project Properties  2-19, 4-15, A-19
Disc Image  10-9
DVDConductor (standard version)  10-5
DVDMaestro  10-5
opening  2-20
Replication  10-12
setting prior to compiling  10-4
setting TV System  2-20

Properties
Disc Image Creation  10-37, 10-48
Project  4-15

General  10-7
Video Asset Properties dialog  11-23

pull-down menus  13-3
Punch Point Marker  A-20
Punch Point Markers  A-16

Q

Quality Assurance Review for Parental Manage-
ment F  C-10

QuickStart Guide  1-3

R

Rating Levels 1-8  C-6
RealView Previewer  2-9, 2-12, 3-3, 11-28,

13-11, A-20
previewing alternate video angle  11-28

redo  13-10
Region 8 (Airline) Support  C-39
Regional Lock Support  C-39
Regional Management Information  10-12,

10-44, A-20, C-39
Remote Key Action  9-6, 9-18, 9-19
Removing Backgrounds & Subpictures from a

DVD Menu  7-36
Reordered Hybrid DVD-Video/DVD-ROM Disc

A-20
Reordering Command Sequences  C-18
Replica Disc Size  10-46
Replication Properties  10-12, A-20

opening (DVDConductor standard version)
10-43

setting prior to creating a Disc Image  10-42
Resolution

Normalize Window DVD Menu  7-48
NTSC/PAL  7-48

Resume Play (connections target)  9-7

S

Safe Area (DVD Menu View Layer option)  7-46,
A-20

Save
Project  13-6, 13-7, 13-8

Index index-13

Project, newly created (Save As)  13-7
Scriptable Colors for Subtitles  C-23
Scroll

Down to Next Page  13-16
To End Asset  13-16
To First Asset  13-16
Up to Previous Page  13-16

second layer  10-38
Segment Re-Encoding  A-21
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How to Use this Encoding Guide

This Encoding Guide is a companion manual to both your Spruce Technologies User’s
Guide and Quickstart Guide. In the coming pages, we’ll be discussing concepts and
features that are introduced and detailed in both of these other manuals, so we suggest you
keep them close at hand for reference. Furthermore, as we’ll cover later in this Encoding
Guide, since some encoding procedures take place directly from within DVD Movies, you
may want to review Chapter 6 of the User’s Guide before reading this Encoding Guide.

Note: This Encoding Guide does not describe how to install or connect Spruce encoding
and decoding hardware. For such information, be sure to read the Quickstart Guide, as
well as any other documentation that may have accompanied your hardware. (Spruce
DVDStations come with encoding and decoding hardware installed.)

Who Should Read this Encoding Guide?
This Encoding Guide is for anyone performing MPEG or other encoding using Spruce
Technologies software and hardware. Specifically, if you use any of our encoding hard-
ware (which includes our MPX, MP2, or ACX series encoders) — and will be encoding
video or audio assets for use with DVDMaestro or DVDConductor — this Encoding Guide
is for you.

Note: Most Spruce DVD authoring solutions, including our turnkey Spruce DVDStations,
are equipped with Spruce Technologies encoding hardware. If you’re unsure if your
authoring system is equipped with our encoding hardware, feel free to contact Spruce
Technologies Technical Support. (Complete contact information is provided in Chapter 1
of the User’s Guide.)

We encourage you to read this Encoding Guide carefully, and to allow yourself plenty of
time to practice video and audio encoding before you embark on any major Projects.

Who Can Skip this Encoding Guide?
It’s possible you may never have to encode video or audio. For instance, you might work with
an encoding specialist who always provides you with pre-encoded video and audio files — so
that you can concentrate on the authoring process. If this applies to you, feel free to skip this
Encoding Guide. However, please be aware there are some encoding related procedures
described in this Guide, such as segment based re-encoding, that may still be of interest to you,
even if someone else is responsible for the preliminary encoding of your files.
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Also, if you are using a third-party encoding system, you can skip this Encoder Guide —
although it is an excellent guide to some of the very powerful and integrated encoding
features you’ll be missing by not using Spruce encoding hardware!

Note: All Spruce authoring software also works with any MPEG-2/MPEG-1 encoding
system conforming to the requirements of the DVD-Video Specification; that is, as long as
your encoding system is able to produce DVD-V-compatible files, your Spruce authoring
software will be able to integrate them perfectly into your Project.

A Fully Integrated Approach to Encoding

Both DVDMaestro and DVDConductor have a software feature called the Encoder Control
Panel — which delivers built-in, direct support for high-quality video and audio encoding
(also known as “capturing” or “digitizing”).

When used with Spruce Technologies MPX, MP2,  and ACX-series encoding hardware, the
Encoder Control Panel provides a complete solution to MPEG and AC-3 encoding that is
fully integrated into the DVD authoring process. As we’ll see, this “integrated encoder
control” approach provides many benefits.

As an alternative approach, some facilities may wish to configure MPEG/AC-3 encoding
and DVD authoring in separate workstations, connected by a fast network — so that one
or more people can be capturing video and audio, while others are strictly authoring titles.
This approach is ideal for high-throughput, even around-the-clock operation. Spruce
authoring software and hardware fully support this mode of operation.

Special Notes for Configuring
Separate Encoding & Authoring Systems
As detailed in the Quickstart Guide, DVDMaestro and DVDConductor software utilize a
software key (“dongle”) that attaches to your PC’s parallel port and is necessary to run
either application.

We’ve made it possible for you to configure an encoding station separate from the author-
ing station — without having to purchase a second copy of DVDMaestro or DVDConduc-
tor for the encoding station. All that is necessary is to secure the appropriate encoding
hardware from Spruce Technologies for your encoding-only station. Then, with 

your

User’s Guide for Spruce Technologies DVD Encoder Hardware 7

software key connected to the encoding station’s parallel port, you can install DVDMaestro or
DVDConductor on this machine as normal. Once installed, you can remove the software key
and connect (or reconnect) it to your authoring station’s parallel port.

At this point, you’ll be able to run Spruce Technologies’ standalone encoder application —
known as “MpegEncodingStation” — on the encoder station. This application does not
require a software key and presents exactly the same interface as DVDMaestro’s or
DVDConductor’s integrated Encoder Control Panel feature.

Note: For efficient operation, both stations should be connected on a fast network, either
100base-T Ethernet or higher performance network such as Fibre Channel. Alternately,
some facilities may choose to pass files from the encoding station to the authoring station
using removable hard drives or other portable media.

Basic Encoding Concepts

Before we look at the Encoder Control Panel’s many functions and parameters in detail,
let’s take a quick overview of how to encode video and audio.

Note: This overview assumes you have a suitable video/audio source transport connected to
your authoring system. This can be a single transport, digital or analog, that supports full serial
(“9-pin”) machine control, such as a Digital Betacam™ or Beta SP™ video tape recorder, or a
9-pin compatible DAT audio recorder such as a DA98, DA88, or PCM800. Should your source
transport lack serial control capability, we’ve also included notes for performing manual-
controlled encoding.

The Big Picture

 Here are the basic steps of the encoding process that we’ll be reviewing in this section:

• First, you’ll open the Encoder Control Panel and verify that your source transport is
properly connected, not only for video and audio signals, but also for machine control
and possibly linear timecode. (Using machine control, you’ll be able to control your
source transport directly from your Spruce authoring software, which, as we’ll cover,
offers many advantages.)
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• Next, you’ll define the timecode in and out points for the source tape. This way, your
Spruce authoring software can effectively automate the process of cueing up the
source tape to the exact location where you want to begin the encoding process, and
stopping the tape at the exact location where you want to end encoding

• Then you’ll establish (and verify) the video and audio I/O (in and out) connections to
and from your authoring system.

• Next, you’ll set the encode mode and bit-rate. Since higher bit-rates require more
storage space (on both your hard drive and the final, replicated disc), we’ll introduce
some basic calculations you’ll need to perform in order to set the correct bit-rate. For
more information on bit-budgeting, please refer to the section entitled “Optimizing
the Bit-Rate” later in this User’s Guide.

• Once these parameters are established, you can start encoding.

• When encoding is complete, you’ll want to review the results.

• Finally, once you’re happy with the encoded file, you can open it in DVDMaestro or
DVDConductor, and begin (or continue) authoring.

Let’s get started…

Opening the Encoder Control Panel
Your Spruce authoring software’s Encoder Control Panel is what you’ll use to perform
encoding. In addition to MPEG encoding of analog or digital video signal’s onto your
authoring system’s hard drive(s), the Encoder Control Panel supports many features de-
signed to speed the encoding process, including machine control, timecode in and out
points, and more.

To open the Encoder Control Panel:

• From the Tools pull-down menu, select ENCODE.

– or –

• Press ALT - N on the keyboard

– or –

• Click once on the “camcorder” icon in the Toolbar

The “busy” icon will appear as the encode control software starts up. After a few seconds,
the Encoder Control Panel will appear.
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The Encoder Control Panel provides all functions required for MPEG-2 and Dolby AC-3 encoding
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Verifying Serial Machine Control
Once the Encoder Control Panel appears, you should verify that your source transport is
connected and operating properly (assuming that you are using a serially-controlled source
for video and audio).

Note: If you are not using a serially-controlled transport, then proceed to the section
Verifying Video and Audio Input below.

To verify operation of the source transport under serial control:

1. Look in the Transport Status field found in the topmost portion of the Encoder Control
Panel. This is where you can view the status of machine control.

2. If a compatible serially-controlled transport is connected and operating properly, you
will see the following:

 

3. If a compatible transport is not detected, you will see a NO TAPE DECK SOURCE message
in the Tape Deck Control:

From left to right, the transport control buttons (and their functions) are: Rewind, Frame, Step back, Stop, Play,
Pause, Frame Step Forward, Fast Forward, and Eject.

If you are using a compatible transport and you see the message above, then check
the following points:

° Is the source transport properly connected to the correct serial port? (This could be
either one of the computer COM ports or the correct serial control port on the
MPX2000 card.)

° Is the source transport switched on?
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4. Once you have located and corrected the fault in connection or the deck’s power
status, click on the Re-Scan button next to the Transport Status field. The system will
query the serial port once again to locate the connected transport. You should now
see the transport connection indicated.

5. If the transport is properly connected and turned on, but has not been switched to its
serial control mode, you will see the following message:

If you see this message, switch the source deck into its remote (9-pin) serial control
mode. The change in mode will be recognized without the need to re-scan.

Once the source transport is properly recognized, you may wish to test the system’s
control via the transport controls.

To verify operation of the source transport:

1. Insert a tape into the source transport.

2. Click the Play button in the transport controls in the Tape Deck Control portion of
the Encoder Control Panel.

3. You should see the number moving in the Tape Position window.

If you have a video and audio monitor system connected directly to the source deck, you
should see and hear the program material. You will not be able to monitor the material
from your Spruce decoder card’s video and audio outputs, however, until you begin actual
encoding.

If you wish, you can try the other transport controls in the Tape Deck Control section,
including the Cue Control slider.

Setting Timecode In & Out Points
Note: If you are performing manually controlled encoding — that is, you are not using
your Spruce authoring software’s machine control capabilities — then you can skip ahead
to the next section.
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You can now enter the In (start) and Out (end) timecodes. These values are expressed in
the standard hours:minutes:seconds:frames.

The Encoder Control section of the Encoder Control Panel, showing the In and Out fields for the start and end
timecodes (respectively).

By entering these In and Out times, your Spruce authoring software can automatically cue
up the source tape to play where you want to begin encoding and stop where you want to
end encoding (assuming you’re using a source deck that supports serial machine control).

Note: Before you can enter these time points, you must make sure the Encoder Control
section of the Encoder Control Panel is not set for Manual Encode; that is, the MANUAL

ENCODE checkbox is not selected. Also note that should the Encoder Control Panel be
closed while the MANUAL ENCODE checkbox is selected (i.e., without serial machine control
enabled), it will default to Manual Encode mode once restarted. In this case — even if a
compatible source deck is found via re-scanning — should you want to perform machine-
controlled encoding, you’ll need to ensure the Encoder Control Panel is not set for Manual
Encode.

Note: The Encoder always opens with its last known state.
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The Encoder Control section will now appear similarly to as shown below:

A typical view of the Encoder Control section, showing the In, Out, and Length values for the segment about to be
encoded.

You may enter timecodes into the In and Out fields directly by typing in the window or
you can “grab” timecodes by cueing the source deck and clicking on the corresponding
button to the left of the In or Out field. You may also define a section to encode by enter-
ing the In point only, then entering an interval of time into the Length field. When you
press ENTER, the system will calculate an Out time based on the In point and the specified
Length.

For your first encoding exercise, we recommend using a very short segment, perhaps one
minute or less. This way you can experiment without waiting a long time for each encode
to complete.

To enter encoding In and Out times:

• Click on the In time field and type in a timecode that matches a point on the source
tape you are using and press ENTER on the keyboard.

– or –

• Cue the source tape to a point you want to use as the start of encode and click on the
In: button.
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The timecode at which the deck is cued will appear in the In field.

• Enter the desired Out point in the Out: field by typing, then press Enter on the
keyboard.

– or –

• Cue the source tape to a point you want to use as the start of encode and click on the
Out: button.

– or –

• Enter a time interval (such as 00:01:00:00) in the Length field and press the Enter key
on the keyboard.

The value calculated from the previously entered In time and the Length will appear in the
Out field.

Note: If you are using Spruce Technologies MPX2000 encoding hardware, you may see a
message appear when you enter the Out or Length timecode that indicates that the Out
time has been adjusted by one or two frames. This occurs because the MPX2000 hardware
is less able to adjust its MPEG GOP (Group of Pictures; we’ll have more to say about this
later) than the MPX3000. This will not matter for this exercise, so simply click OK if you see
this message.

Once the timecode In and Out points are entered, you’ll want to verify that video and
audio data are reaching the encoder board.

Selecting Video & Audio Inputs
Next, you’ll want to verify that video and audio data are reaching the encoder board.

Note: This step should be performed whether you’re performing machine-controlled or
manually controlled encoding.

If you are using digital video and audio sources with professional-format outputs (SDI for
video, AES/EBU or S/PDIF for audio) — such as Digital Betacam — then the source outputs
are connected directly to the inputs of the encoder card. If however, you are using analog
source devices, these are routed to a Spruce Technologies Digital Connect Box (DBH100)
or another analog-to-digital converter box which converts them to digital format. The
outputs of the Digital Connect Box or other D/A converter boxes then feed the converted
signal directly to the encoder card.
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If you are using analog source with the DBH100 Digital Connect Box, then you will need
to verify correct setting of the unit before you can encode. The Digital Connect Box is
controlled a serial port connected to either the computer’s COM port or, in the case of
MPX2000 hardware, to one of the serial ports. Your Spruce authoring software communi-
cates directly to the Digital Connect Box to determine which of its inputs is selected. With
other analog-to-digital conversion boxes, you may have to change the settings directly on
the box itself.

Opening the Settings window from within the Encoder Control Panel.

To set up the Digital Connect Box under serial control:

1. In the Encoder Control Panel, go to the Tools menu and select SETTINGS WINDOW.

– or –

Press the key combination ALT -V - S on the keyboard.

2. The Settings window will appear. You should see the Digital Connect tab displayed
as shown below. (If you do not see this window, turn to “Is the Digital Connect Tab
Missing?” later in this User’s Guide.)



User’s Guide for Spruce Technologies DVD Encoder Hardware16

3. In the Digital Connect section (tab) of the Encoder Settings window, set the Video
Input to the appropriate analog video connection.

Note: For analog video input, a 3-wire component video connection (either RGB or
YUV) is recommended for best quality. If your source transport does not provide these
you can use S-Video or Composite.

4. Set the Video Standard (PAL or NTSC) to match the source material and transport.

5. For the audio input, select balanced (+4 dBu) or Unbalanced (–10 dBu) as appropri-
ate.

6. Set the Audio Sample Rate to 48 KHZ. (If you have “DVD compliant” checked under
the OPTIONS pull-down menu, the Audio Sample Rate will be set to 48 kHz and
cannot be changed.)

7. Set the Audio Sync to SLAVE TO VIDEO. This setting is important for encoding longer
segments (long–form encoding), as drift in audio/video sync can result if the audio
sample rate is not locked to a video clock reference. (This should always be selected
if both analog audio and video are connected to the digital connect box.)

8. Once you have completed these settings, you’re ready to verify the video and audio
input, which we’ll describe in the next section.
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Is the Digital Connect Tab Missing?

If you do not see the Digital Connect tab in this window, check the following points:

• Ensure that the Digital Connect box is properly connected to the correct serial port
(either COM port on the computer, or the correct serial port of MPX2000).

• Ensure that the Digital Connect box is powered on.

Note: If you are using another type of analog-to-digital converter, you will not see the
Digital Connect tab.

Once you have located and corrected the fault, close the Encoder Control Panel com-
pletely and reopen it. This reinitializes its link to the Digital Connect Box. Then open the
Settings window again.

If the application still does not recognize the Digital Connect Box, switch the unit off and
on again, then close and reopen the Encoder Control Panel and Settings window. If you
cannot establish communication with the unit (as shown by the Digital Connect tab in the
Settings window) after carefully verifying all connections and power–cycling the unit,
contact Spruce Technologies Technical Support for assistance.

Verifying Video & Audio Input
At this point, it is a good idea to verify that video and audio data are reaching the encoder
and the encoder itself is working correctly.

To do this, we will operate the encoder in its Preview mode, with Manual Encode en-
gaged. This allows us to run the encoder end-to-end, including decoding to video and
audio outputs, without actually writing data to the hard disk.

To test video and audio input and encoder throughput:

1. Set up the Encoder Control section of the Encoder Control Panel exactly as shown below:
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2. Confirm the following settings:

° ENCODE SOURCE FOR VIDEO is set to MPX3000 or MPX2000.

° ENCODE SOURCE FOR AUDIO is set to AC-3 (2 Ch. or 5.1).

° PREVIEW ONLY checkbox is selected.

° MANUAL ENCODE checkbox is selected.

3. Start your source transport (by manually pressing its Play button).

Note: Ensure that your source material has both video and audio content and that
your source transports is set to reproduce both the video and the appropriate audio
track(s).

4. Click on the large Encode Start button in the Encoder Control section.

5. You will first see the message DOWNLOADING ENCODER PARAMETER in the Status field at
bottom of the Encoder Control section, followed in a few seconds by the message
CAPTURING. In a few more seconds you should see video from the decoder card, along
with audio from your audio monitoring system.

In the event that you do not see and hear picture and sound from the decoding hardware,
first verify that your video and audio monitoring system is properly connected and
switched to receive the output of the Spruce decoder. Then verify that the source signal is
properly connected and the correct inputs to the Digital Connect Box (if used) are selected.
If you still cannot locate the fault, please contact Spruce Technologies Technical Support
for assistance.

Once you are able to see picture and sound from the decoder, click once more on the
large Encode Start/Stop button to terminate the encode Preview mode. This will also halt
the source transport (assuming it is configured for machine control; otherwise, you’ll need
to stop it manually).

Setting the Encoding Mode & Bit-Rate
After verifying the source video connection and operation using the Preview mode, you
will want to define the video encoding mode as CBR (Constant Bit-Rate). (The alternative
modes are 1- and 2-pass Variable Bit-Rate, or VBR, but we will explore those modes later.)
You will also want to make sure that the encoding bit-rate is set appropriately.
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There are a number of parameters that can be set in MPEG encoding but in most situations
these two parameters — encoding mode and bit-rate — are the two key items. You should
never encode video for any serious undertaking without verifying that these are appropri-
ately set for the conditions and use at hand.

Encoding mode and bit-rate are specified in the Settings window — which, if you are using
analog sources, you opened previously when you defined the encoding inputs. This dialog
includes settings for all of the variable parameters of video and audio encoding.

To prepare to define the encoding mode and bit-rate for video:

1. If the Settings window is not already open, select SETTINGS WINDOW from the Tools
pull-down menu (keyboard shortcut: ALT - V - S).

2. In the Settings window, select the tab labeled MPEG VIDEO ENCODER.

3. The settings for MPEG encoding parameters will appear as shown below:

The Encoder Settings Window as seen with the MPX3000. GOP sizes will appear different with the MPX2000.

The settings we are interested in now are found in the left-hand portion of the Quantiza-
tion section at top of the dialog. (For now, ignore the rest of the parameter settings.)

The first parameter to set is the encoding mode. For this encoding exercise, set this to CBR
(Constant Bit-Rate). This is the most straightforward encoding mode and for many pur-
poses, it is the superior choice. Later, we will explore the considerations and conditions
under which you may wish to use Variable Bit-rate (VBR) encoding.
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Selecting CBR encoding mode.

To set the encoding mode for CBR in the Settings window:

1. Click with the mouse to pull down the menu from the Mode selection area of the
Quantization window, as shown immediately above.

2. Select CBR, the topmost selection.

Next, you’ll set the Bit-Rate field to 8,000,000, or 8 Mbps (megabits per second).

Note: 8 Mbps is the maximum rate recommended for CBR encoding. The DVD-Video
Specification implies that slightly higher video bit-rates can be used, but real-life experi-
ence shows that many consumer DVD players have problems with sustained video bit-
rates higher than 8 Mbps. We have also found that little or no improvement can be
realized by increasing the bit-rate above this figure. Therefore, for DVD authoring pur-
poses, we recommend you limit encoding bit-rate to 8 Mbps.

Setting the bit-rate.
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To set the video bit-rate to 8 Mbps:

1. Click on the Bit-Rate pull-down menu in the Quantization section of the Settings
window, as shown on the previous page.

2. Select 8,000,000 from the menu.

– or –

1. Select the numeral area of the Bit-Rate field.

2. Type in the number 8000000. Do not enter commas.

Typing figures lets you set a more precise video encoding bit-rate — but in this case, the
desired figure is available by either method.

Selecting the Audio (“AC3 Audio Encoder”) Settings
While you are in the Settings window, you will want to also set the parameters for audio.
For this exercise, we will assume you are encoding stereo audio only. For details on
encoding of 5.1 surround audio, refer to the section later in this Encoding Guide.

The Audio settings are set using the AC3 Audio Encoder tab of the Settings window.
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To set parameters for audio encoding:

1. Open the Settings window (as described earlier) and select the tab labeled AC3 AUDIO

ENCODER.

2. Check the Audio Coding Mode setting. For stereo encoding, this should read 2/0; L,R.

3. After verifying the Audio Coding Mode, set the Data Rate field. We recommend a
setting of 224 kbps for AC-3 stereo.

Note: Dolby actually recommends a setting of 192 kbps, but we have found that a
setting of 224 kbps improves high-end response noticeably.

Setting Up for “LTC-Trigger” Audio Encoding

In the lower left region of the AC3 Audio Encoder settings tab, you’ll notice the LTC button
— a little yellow button that resembles a watch or a clock. This button may be selected if
(and only if) you have an LTC (linear, or longitudinal timecode) connection from the
source deck. In that case, audio encoding will be triggered from LTC input. Otherwise,
triggering for audio encode comes from the 9-pin serial control, as for video.

If the required LTC connection is available, then we recommend you always select this
button, as “LTC-trigger” audio encoding is more accurate than that from the 9-pin serial
control port used for video.

To set up for LTC-trigger audio encoding:

1. Assuming you have a connection for Longitudinal Timecode (LTC) from the source
deck to the audio encoder, click once on the LTC (“watch”) button at lower left. (It
turns yellow when selected.)

2. You have now armed the audio encoder for LTC-trigger.

Initiating Video & Audio Encoding
Finally, we are ready to encode. Actually, although several pages have been spent describ-
ing the steps leading up to this point, in practice you’ll find that you do not need to repeat
most of them each time you encode, and your setup and encoding will be quite efficient.

Having set up our parameters and In/Out timecodes, all you need to do is verify your
mode settings and click the Start button.
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This screenshot shows the starting state for encoding with and without machine control.

To set up and perform encoding:

1. In the Encoder Control section of the Encoder Control Panel, make sure that the
Preview Only checkbox is not selected.

2. If you are using serial machine control, deselect the Manual Encode checkbox.

Note: If you do not have serial machine control, deselection is not possible.

– or –

If you are encoding without serial machine control, then enter a value of 1 minute of
less into the Length field. This will define the length of encoding. If it is set to
00:00:00:00, then Manual Encode will continue until it is stopped by clicking the
Start/Stop button again.

3. Now you can begin encoding by clicking once on the large Start/Stop button in the
Encoder Control section. When you click this button, you will see the following
dialog appear that lets you define the filename and location of the MPEG and AC-3
files to be created:
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4. In the Save dialog, navigate to your main data drive (such as E: or F:). (If this is your
first attempt at encoding, you can use the Folder create button in the dialog to make
a new folder. Name this folder “Test Encode,” then open the newly created folder by
double-clicking on it.)

5. Enter the desired File name (such as “Test 1”) and click SAVE.
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6. If you are using serial machine control:

° Your source transport will automatically cue up to a point before the In time that
you entered; once it reaches this point, the transport drops into play.

° As it reaches the timecode of the predetermined In point, the Start/Stop button in
the Encoder Control section changes color to red, indicating that encoding is now in
progress.

° A few seconds later, the decoded preview output will begin playing back through
your video and audio monitor systems; the RealView Previewer will also launch and
simultaneously display the video on your computer display (and your PAL or NTSC
monitor if it is properly connected to the back of the Cinemaster card).

– or –

If you are not using serial machine control:

° Manually start your source deck. (It’s a good idea to have cued up the tape to one
or two seconds before the desired starting point, so that the transport is running
stable and providing clear video playback.)

° Press the Start/Stop button in the Encoder Control section (the button will turn red,
indicating that you’ve initiated encoding).

° A few seconds later, the decoded preview output will begin playing back through
your video and audio monitor systems; the RealView Previewer will also launch and
simultaneously display the video on your computer display.



User’s Guide for Spruce Technologies DVD Encoder Hardware26

Note: Preview is always created by decoding the captured and encoded input — so
what you see is what you get. The image and sound in the preview always exactly
reflects the results in the captured file.

During encoding, the status field of the Encoder Control section will indicate that you are CAPTURING [FILE NAME], as
shown above. At the same time, the RealView Previewer will launch and display the encoded video in real time.

7. If you are using serial machine control, once the source deck reaches the end of the
defined segment:

° The system will automatically drop out of encoding.

° The source transport will automatically stop.

° Your Spruce authoring software will prompt you to load the encoded asset into the
decoder section for review.

– or –

If you are not using serial machine control, once the source transport reaches the end
of the material you wish to encode:

° Press the Start/Stop button in the Encoder Control section; this will stop the encod-
ing process.

° Manually stop your source deck.

° Your Spruce authoring software will prompt you to load the encoded asset into the
decoder section for review.

Note: If you entered a value in the Length field, the numbers will decrement until
00:00:00:00, at which point the encoding will stop.
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8. In the File Preview prompt, select YES (keyboard shortcut: ALT - Y) to load the file into
the decoder for review.

9. The captured video and audio files will be loaded into the Decoder section of the
Encoder Control Panel and automatically synchronized — ready for your review.

Congratulations! You have just encoded your first video and audio using your Spruce
Technologies system.

What Files were Created During this Encoding Session?

If you use the Windows Explorer to view the contents of the directory created previously,
you will see the following items:

You will note that there is one large file with the extension “.m2v” or “.vbs” (with
MPX2000 hardware) and one much smaller file with extension “.ac3”. These are the main
video and audio files.
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You will also notice that each of these files is accompanied by a small “parameter” file that
adds extension “.PRV” (video) or “.PRA” (audio) to the name of the main file. These
parameter files contain information about the contents of the main file and are used by the
authoring system.

Note: Do not delete any of these files, as they are required for authoring!

Reviewing the Results of Encoding
Now that you have completed encoding and loaded the resulting video and audio files
into the decoder, you can review the results using the Decoder section of the Encoder
Control Panel.

From left to right, the Decoder buttons and their functions are: Return to Beginning of File, Play, Pause, and Single
Step Forward.

To playback encoded video loaded into the Decoder Control section:

1. Click on the “Play” button (right-facing arrow) in the transport controls of the De-
coder Control section.

2. Video playback will start immediately, along with synchronized audio.

Note: If you don’t wish to audition the audio during video playback, simply select the
MUTE AUDIO checkbox.

3. Playback will terminate when the end of the file is reached.
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There are several options available in the Decoder Control section that facilitate quality
assurance of encoded video and audio. The Slow Motion checkbox and the “Single-Step”
button (two vertical bars with right-facing arrow) are particularly useful in review.

Note: Audio playback will occur only during normal full-speed (1x) playback; with Slow
Motion or Single-Step playback, audio will be muted. As noted, audio can be intentionally
muted during normal playback by selecting MUTE AUDIO.

With these controls, you can locate and clearly identify any areas that may need special
attention. However, we also recommend viewing the suspect area using normal full-speed
playback — since it is in the nature of compressed video that some artifacts visible in “slo-
mo” or still frame playback are simply not visible at normal speed.

Another control useful for review is the Location slider in the middle of the Decoder
Control section. This can be used to cue playback from any desired point in the video
track. When you move the slider, the thumbnail display to its right shows the current frame
in real time. Once you park the slider, you can use the Single-Step or Play buttons to see
video starting at that location.

Now that you have set up the Encoder Control Panel and have an understanding of how to
encode files, you may wish to encode additional segments before you proceed to the next
step — which is to close the Encoder Control Panel and then to load the captured files into
the Spruce authoring environment.

Exiting the Encoder Control Panel
As long as the Encoder Control Panel is open, you can encode as many segments as you
wish, with different parameter settings and so on. Once you finish your encoding session
and have finished reviewing the results, you’re ready to close the Encoder Control Panel
and load the encoded files into DVDMaestro or DVDConductor.

Note: If you are using the Standalone Encoding application on a separate workstation, then
this section does not apply. In that case, the normal procedure will be to transfer encoded
files from the encoding system to the authoring system using a fast network or other means
of transfer. The files are then opened into the Assets Bin as described in Chapter 5 of your
User’s Guide.
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To close the Encoder Control Panel and load encoded files into the Assets Bin.

1. From the Encoder Control Panel File menu, click EXIT.

– or –

Use the key combination (ALT - F - X) from the keyboard.

– or –

Click on the small “x” at upper right of the Encoder Control Panel.

2. Whichever method you use, the following prompt will appear:

3. In the prompt dialog, select YES (keyboard shortcut: ALT - Y). The following dialog will
now appear:
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4. This dialog lists the files that you captured during your encoding session. All selected
files will be loaded into the Assets Bin when you click OK or hit RETURN on your
keyboard. You may de-select any files you do not wish to load by holding down the
CTRL key on your keyboard and clicking on the files to be de-selected.

5. Click OK or hit RETURN on your keyboard.

6. The selected files will appear immediately in the Assets Bin, as shown here:

From here you can load these files into DVD Movies or DVD Menus as normal and
resume authoring.
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Choosing the Encoding Mode
(CBR, 1-Pass, or 2-Pass VBR)

Besides determining an optimal bit-rate before you begin serious encoding, you will also
need to make a decision about which encoding mode you’ll use — Constant Bit-Rate, 1-
Pass Variable Bit-Rate or 2-Pass Variable Bit-Rate. Earlier in this Encoding Guide we noted
that for shorter program material, high-rate CBR is the way to go. Other situations may not
be so clear. Here are some notes on the characteristics and relative advantages and
disadvantages of each mode…

Constant Bit-rate (CBR) Encoding
CBR encoding has the advantage of being by far the most straightforward mode of encod-
ing and, as noted before, it gives excellent results as long as bit-rates can be kept fairly
high (generally 6 to 8 Mbps; possibly less if the material easy to encode).

The disadvantage of CBR is that it usually cannot be used on long-form material. The
reason is that the overall bit-rate, as yielded by calculation, is likely to fall beneath the
range that CBR can be trusted to encode with high quality.

Therefore, CBR is best used on material of short duration, where a high bit-rate setting can
be used. In Projects that compile many short clips into a longer piece, it also may be more
productive to encode at high-bit-rate CBR and replicate on DVD-9 or DVD-10 than to
spend the time needed to get satisfactory results with VBR on so many short pieces.

1-Pass Variable Bit-Rate (1-Pass VBR) Encoding
As the name implies, 1-Pass VBR uses some of the technology of 2-Pass VBR, but in a
single pass through the tape. With 1-Pass VBR, the bit-rate is varied “on the fly,” in direct
correspondence to the complexity of the video program material. For instance, with “easy”
material, such as talking heads, or a static landscape vista, the bit-rate might be relatively
low; with “complex” material, such as a car chase, or an action sequence with a lot of
wipes or other complex transitions, the bit-rate can rise dramatically.

The primary advantage of 1-Pass VBR over CBR is that with a given setting of the Bit-Rate
parameter (which is not necessarily the bit-rate that results in this case) it may give more
satisfactory results than with CBR; that is, the encoded files may simply look better. And as
we’ll learn more about, the advantage of 1-Pass VBR over 2-Pass VBR is that it’s a rela-
tively faster process. However….
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The disadvantages of 1-Pass VBR, it turns out, are rather severe. The nature of the process
is that the Bit-Rate parameter defined in the Setting window is only a starting point. During
the encode pass, the system will go to a higher rate (with a defined ceiling), whenever it is
deduced to be necessary, without regard to the effect on overall bit-rate and file size.

The result is that when you encode with 1-Pass VBR selected, you have no way of know-
ing what the size of the resulting file will be until the encode pass is complete — and
hence there is no way to effectively optimize settings. In some cases, the effective bit-rate
of 1-Pass VBR may be 60% higher than that of CBR, or even more — which may mean
than that files that would otherwise fit on the disc might prove too large when encoded
with 1-Pass VBR.

There is one situation in which 1-Pass VBR may be used effectively to improve quality
without losing control over file size: when the source material consists of relatively easy
material — such as talking heads, or karaoke-style music videos — interspersed with
crossfades and other transitions that are more difficult to encode. In this case, the “spikes”
of bit-rate at the transitions will occupy relatively little of the overall time and the contribu-
tion to increasing file size will be consequently smaller. In this case, you may get a 

good

result by setting the Bit-Rate parameter a little lower than the optimal CBR value calculated and
running as 1-Pass VBR. However, you must always be sure to check the size of the resulting
files to make sure you are not overflowing the capacity of the target format.

2-Pass Variable Bit-Rate (2-Pass VBR) Encoding
With 2-Pass VBR, you can combine the visual benefits of 1-Pass VBR with the space-
efficiency benefits of CBR.

The 2-Pass Variable Bit-Rate encoding is not available in the standard version of DVD-
Conductor. This feature may be added by installing the DVDEncoderPack upgrade.

As the name implies, 2-Pass VBR operates as follows: First the entire length of material is
played through the encoding system and analyzed in what is known as a “profiling” pass.
During this pass, no actual encoding is performed. The system, however, examines the
source stream frame-by-frame and determines how difficult each frame (or group or
frames) will be to encode.
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After the profiling pass, the system then calculates a bit-rate curve, or “profile,” based on
the information obtained during the profiling pass along with the settings you’ve chosen in
the Settings window for Average, Peak, and Minimum Bit-Rate. The resulting curve is
calculated to respect these limits and deliver a file whose size is equivalent (within a
margin) to the same length of material encoded in CBR at the average rate.

Finally, the material is played again through the system. During this second pass, the
system performs the actual encoding — varying the bit-rate along with the picture, to
deliver a result that is optimized for every frame or group of frames.

2-Pass VBR can be very useful, but it is not magic. It works best on longer-form material
where it has a chance to balance hard-to-encode scenes against easier material. Likewise,
it has the most “room” to work when you have a mix of easy and complex material in the
pass you wish to encode. If you have a 2-hour program that is fast-action, difficult-to-
encode material from one end to the other, then 2-Pass VBR will not yield the best results.

The biggest disadvantage of 2-Pass VBR is that it takes much more time than either CBR or
1-Pass VBR. At the very minimum, it will require at least twice as much time as the length
of the material you wish to encode. In practice, however, it takes longer than that from
start to finish. Furthermore, during the quality assurance process, you’ll likely discover
sections of the material that are not fully optimized. These must then be “hand-encoded”
using your Spruce authoring software’s segment re-encoding feature — until the results are
as desired. This requires not only lots of time but highly skilled personnel.

Also, one should not make the mistake of automatically assuming that 2-Pass VBR will
give a better result than CBR at the same rate. VBR introduces much more complexity into
the encoding process, with concomitant possibilities for error. Especially with shorter
material, 2-Pass VBR may actually introduce more problems than it alleviates.

That said, 2-Pass VBR is close to being a standard for encoding of feature films — a key
technology that allows full-length motion pictures to be delivered in the 4.7GB DVD-5
format with very good quality. Even as larger-capacity DVD formats (such as DVD-9) move
into the forefront, 2-Pass VBR continues to be an important means of increasing play time
for a given disc size.
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Encoding with 2-Pass VBR

The basic operation of 2-Pass VBR is fairly simple. All you need to do is select the 2-Pass
VBR mode, set the maximum and minimum bit-rates and set the overall bit-rate.

Hardware & Software Requirements
Encoding with 2-Pass VBR requires the use of a source video transport that supports serial
machine control. Otherwise there is no way for the system to align the two passes.

Setting Maximum, Minimum, & Overall Bit-Rate
When you select 2-Pass VBR mode in the Settings window, the Quantization section of the
MPEG Video Encoder tab will show a total of three bit-rate fields (located near the top
center of the following screenshot):

The Quantization section of the MPEG Video Encoder tab has three bit-rate fields.
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The middle Bit-Rate field (BITRATE) indicates the overall, or average, bit-rate that will be
applied. The number entered here is the same number that one would use to encode with
CBR.

The Maximum Bit-Rate field (MAX. BITRATE) indicates the peak of the VBR encoding curve.
The value set here needs to be calculated with respect to the maximum total bit-rate
allowed by the DVD-Video Specification and the audio program material to be included.
As a rule, therefore, you should avoid going above 8.5 Mbps (8,500,000 bps) as a maxi-
mum bit-rate for 2-Pass VBR. You won’t notice much difference going higher and you
should allow extra headroom for audio and safety.

The Minimum Bit-Rate field (MIN. BITRATE) indicates the floor beneath which the bit-rate will
not be allowed to dip. This is a “soft” quantity whose optimal setting may be determined
with experience. For most material, we recommend the default setting of 2 Mbps
(2,000,000 bps). As a rule, you should never go below this setting as it will introduce
severe artifacting at certain points in the bitstream.

Executing the 2-Pass VBR
Once you have set the encoding mode and the overall, maximum, and minimum bit-rates,
starting the encoding process is the same as for CBR encoding. Simply press the Start/Stop
button in the Encoder Control section, then set a name a storage location for the file to be
created.

Next, the system will cue up the tape, then roll it through the full length of the segment to
be encoded while displaying the message COLLECTING STATISTICS in the Encode Status field.
During this time, no decoder output is visible or audible.
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After you press the Start/Stop button in the Encoder Control section to begin 2-pass VBR encoding, the system will
roll through the entire desired segment to collect information, as shown by the COLLECTING STATISTICS message in the
status field.

Once the system completes this first pass, it will cue the tape back to the preroll to a point
before the In point, then roll the tape once more.

Once actual encoding begins, the status field will indicate CAPTURING [FILE NAME]. At the same time, the RealView
Previewer will launch and display the encoded video.

This time, the system will begin actual encoding, the RealView Previewer will launch, and
the decoded picture and sound will be fed monitoring system attached to the to the
decoder card’s respective outputs.
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Once the second (capture) pass is complete, the system will halt and present a dialog to
load the encoded video and audio files into the decoder, just as with CBR encoding.

Reviewing a 2-Pass VBR Encoding
After encoding a segment in 2-Pass VBR mode, we recommend you review it carefully.
Due to the nature of 2-Pass VBR encoding, it’s possible for the encoded result to look quite
acceptable in most of the stream, but to have problems in particular segments. Individual
problem areas may be addressed by using your Spruce authoring software’s segment re-
encoding features, as detailed next.

Segment Re-encoding

Your Spruce authoring software includes a very useful feature known as “segment re-
encoding.” This is the capability to re-encode individual sections of video, with individu-
ally set bit-rate and other parameters, without having to re-encode the entire asset from
start to finish.

Segment-based re-encoding is not available in the standard version of DVDConductor. It
may be added by installing the DVDEncoderPack upgrade.

These re-encoded segments are then inserted seamlessly in to the video track — making it
possible to completely optimize the results of 2-Pass VBR encoding. Segment re-encoding
is mostly performed from within the Spruce authoring environment.

Note: To explain segment re-encoding, we’ll be discussing DVD Movies and some related
terms. If you need definitions for these terms, or need general information about working
with DVD Movies, please refer to Chapter 6 of your User’s Guide.

First, we will need to load the encoded files into the DVD Movie, where we can isolate
sections for re-encoding.
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To load the encoded files into the DVD Movie:

1. Close the Encoding Control window, and load the encoded files into the Assets Bin,
as described earlier in this Encoding Guide.

2. Open a DVD Movie by double-clicking on its icon in the Project Manager. If you
wish, expand the DVD Movie window to fill the Workspace.

3. Place the encoded MPEG file into the video timeline by dragging it from the Assets
Bin.

From within the Marker Timescale, you can drag the PlayCursor back and forth to identify
the beginning and end of any sections that need to be re-encoded. (The Thumbnail
Previewer will display a video image of the PlayCursor’s current location.)

Note: The video track for the desired video asset shows a continuous “graph” of the bit-
rate as defined and executed in 2-Pass VBR.
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There are two reasons why you might use segment-based re-encoding of video:

• Specific sections of video need to be re-encoded with different parameters in order to
optimize picture quality.

– or –

• A portion of video content has changed and you would like to update it without re-
encoding the entire piece.

Once you have identified a section of the existing video asset that you wish to re-encode
— either to optimize picture quality or to replace an asset that has been changed — the
next step is to mark a “Punch-In” and a “Punch-Out.” These two punch Markers represent,
respectively, the “in-point” (for where the re-encoded segment will begin) and the “out-
point” (for where re-encoded segment will end).

To mark a Punch-In and a Punch-Out:

1. Click in the Marker Timescale at the desired time for the Punch-In.

2. When the Edit Marker dialog opens, select the Marker Type to be PUNCH POINT. If you
wish, you can also rename the Marker and adjust its location from within the Edit
Marker dialog. When done, click OK.

Note: There is no separate Marker Type choice for “Punch-In” or “Punch-Out”; all are
considered punch point Markers. Whatever punch point Marker appears earliest
(furthest left) in the Marker Timescale will be considered the Punch-In Marker; the
punch point that appears later (furthest right) will be considered the Punch-Out
Marker.

3. The Punch-in will appear in the Marker Timeline with a distinctive red “arrowhead.”

4. If desired, you can “jog” or “scrub” the Punch-In Marker to reposition its location;
this is done by clicking once and holding its red arrowhead and then dragging it left
(earlier) or right (later) in the Marker Timescale. As you do this, the current starting
frame will appear in the Thumbnail Previewer window.

5. Now you can mark the Punch-Out by clicking once more in the Marker Timescale.
As before, select PUNCH POINT in the Edit Marker dialog. As with the Punch-In Marker,
you can also reposition the Punch-Out Marker by jogging it in the Marker Timescale.
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Place the Punch-In Marker by clicking in the Marker Timescale (above the Video Timeline). Check PUNCH POINT

then, if you wish, you can rename the Marker or adjust its location. When done, click OK. Repeat the same
procedure to set the Punch-Out Marker.
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Punch-In and Punch-Out Markers can be adjusted easily, just by dragging them as you would drag Chapter Point
Markers.

Once you’ve defined the Punch-In and Punch-Out, you’re ready to perform segment re-
encoding, of the portion contained between the markers.

As you can see above, once the Punch-In and Punch-Out have been defined, you’re ready to perform segment re-
encoding for the portion of video between the two punch point Markers.
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To perform segment re-encoding between two punch points Markers:

1. In the Video Timeline, right-click on the video asset you wish you re-encode. (A
video asset will already need to be in place in the video track.)

2. When the pop-up context menu appears, select RE-ENCODE VIDEO SEGMENT.

To initiate the segment re-encoding process, right-click in the Video Timeline and select RE-ENCODE VIDEO SEGMENT

from the pop-up context menu.

3. The Encoder Control Panel will appear onscreen over the DVD Movie (and Spruce
authoring software’s other screens).

4. You’ll notice that the Clip In and Out times in the Encoder Control section of the
Encoder Control Panel correspond, respectively, to the locations of your Punch-In
and Punch-Out Markers.

Note: Encoding is set for VIDEO ONLY, as audio is not re-encoded.
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The Encoder Control Panel, showing the Clip In and Out times corresponding to the Punch-In and Punch-Out
times. This screenshot also shows the Encoder Settings window.

5. Set all the parameters for re-encoding as you wish. If desired, you can open the
Encoder Settings window (via the Encoder Control Panel’s View pull-down menu)
and make further adjustments.

6. Once all settings have been made, click START to begin re-encoding.

7. The Name Elementary Stream(s) dialog will appear:
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Click SAVE.

Note: As you’ll see, DVDMaestro will generate a name for the re-encoded segment
file based on the name of the original file and its timecode point, numbering the files
as subsequent re-encode operations are performed. If you do not wish to use the
generated name, the dialog gives you the opportunity to assign a file name and
directory path as desired.

8. Next, just as with regular machine-controlled encoding, DVDMaestro will shuttle the
source deck to start timecode location, drop it into play and begin encoding from the
exact point defined by the Punch-In. DVDMaestro will continue encoding until it
reaches the Punch-Out time.

9. Upon reaching the Punch-Out time, DVDMaestro halts encoding and prompts you to
load the file into the Decoder Control section of the Encoder Control Panel for
review. There, you can view the re-encoded segment and perform additional re-
encode operations with different settings until you’re satisfied with the segment’s
picture quality.

10. Once you’ve completed segment re-encoding (whether you do a single re-encode
pass or many), you can close out the Encoder Control Panel by clicking on the
upper-right close box.

11. When the Encoder Control Panel closes, the last segment that you re-encoded is
automatically inserted into the video track, beginning and ending at your punch
points. The new segment appears in a lighter shade to indicate that it has been
inserted into the stream as an individual segment within the video timeline.
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The re-encoded segment, shown inserted into the middle of video track 1.

Working with Multiple Versions of a Re-Encoded Segment
If you’ve created multiple versions of a re-encoded segment, the command INSERT VIDEO

SEGMENT — included in the same pop-up menu as RE-ENCODE VIDEO SEGMENT — can be used to
choose which file you wish to insert. This way you can easily review various versions, all
in context.
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Right-clicking in the video track lets you define where the re-encoded video segment will be inserted.

Note that when you use the Insert Video Segment command, the segment is placed
according to the timecodes of the video in the segment, without regard to the placement of
Punch-In and Punch-Out points. If you create a file with segment re-encode, and then
move the punch points, the previously encoded file (if inserted via timecode) will always
insert where the punch points were at the time it was encoded.

You can perform as many segment re-encodes as you wish, even within or overlaying a
previously re-encoded segment. With the segment re-encode feature, a new dimension of
power and flexibility has been added when encoding assets for use with Spruce authoring
software.
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NTSC Film Mode (Inverse Telecine)

When material is transferred from film (with a frame rate of 24 frames per second), to
NTSC video (with a frame rate of 29.97 frames per second), the differing frame rates are
resolved by converting each frame for film into two (redundant) video fields, then repeat-
ing some of the fields in a defined pattern known as the “cadence.” The whole process is
generally known by the term “3:2 pulldown.”

The Inverse Telecine feature is not available in the standard version of DVDConductor. It
may be added by installing the DVDEncoderPack upgrade.

In MPEG encoding, these redundant video fields present two problems:

• the repeated fields represent redundant information to encode, reducing encoding
efficiency by 20%; and

• the video frames that include fields from two different film frames will show “frame-
jitter” when using the Single-Step button to view frames one at a time.

During encoding, both of these problems can be addressed by using the Inverse Telecine
option in the MPEG-2 Options section of the MPEG Video Encoder tab of the Settings
window.

The Inverse Telecine option can be found in the MPEG-2
Options section of the MPEG Video Encoder tab of the Settings window.
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When the Inverse Telecine option is selected, the encoding process will automatically
attempt to detect the redundant fields inserted during the film-to-video transfer process.
During encoding, your Spruce authoring software will then skip over these frames; after
all, there’s no need to re-encode material that has already been encoded.

In place of the repeated field, the encoding process inserts a flag that indicates that one of
the fields should be repeated. Indeed, during playback of the MPEG stream or finished
DVD disc, the decoder system reads these flags and automatically repeats the needed
field(s) — in effect, performing the film-to-video transfer process on the fly. The result is
substantially more efficient encoding (a better picture for the given bit-rate), and freedom
from frame jitter.

To execute encoding with Inverse Telecine, simply select in the Inverse Telecine checkbox
in MPEG-2 Options before you begin the encoding process.

Limitations of Inverse Telecine
The process of accurately detecting the repeated fields is complex and sensitive, and there are
many situations in which the correct “cadence” may not be detected properly, including:

• When material is shot on film, but edited on video, the cadence from the film-to-
video transfer is modified from the original. This will usually cause the Inverse
Telecine to lose the cadence at least temporarily.

• If the material is extensively edited in video (such as many TV commercial spots,
which often are shot on film and subjected to fast-cut editing), Inverse Telecine may
have no chance of ever correctly detecting the cadence of repeated frames.

• When using Inverse Telecine in 2-Pass VBR encoding (these two often go together
because 2-Pass VBR tends to provide the most benefit in use on long-form feature
films), the Inverse Telecine process may not detect frames in the same way between
the first and second pass. This can create major problems, as it may cause alignment
of a low bit-rate setting with a hard-to-encode section of video. This problem princi-
pally occurs when using an analog video source, as this format is subject to noise
that varies from play to play. When using digital video sources, this type of error is
less likely to occur.

• When video includes slow-moving material, the Inverse Telecine process may have
difficulty in distinguishing the correct fields to repeat, since it depends on a threshold
of difference between fields to make the correct decision.
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Reviewing Inverse Telecine
Once you’ve encoded with Inverse Telecine, you can check the results by using the
Single-Step button in the Decoder Control section. When the telecine cadence is properly
detected, all still frames will be perfect, without field jitter. If you encounter an error in
field detection, it will show as one of more frames whose still image is not stable. Depend-
ing on the picture, the field jitter may be very pronounced.

In the left-hand frame, the telecine cadence has been properly detected; in the right-hand frame, the blurred image
shows field jitter, which strongly suggests an error in detection. If the errors are minor and infrequent, or difficult to
notice in normal full-speed (1x) playback, they may nonetheless be acceptable.

Using segment re-encoding, you may be able to correct some or all of the Inverse Telecine
errors that occur in a program. However, depending on the material and situation, you
may find that the prevalence of cadence errors is such that encoding without Inverse
Telecine may actually give a better result. Also, identification and correction of Inverse
Telecine errors in a long program can be quite time consuming, and you may have to
judge whether the situation warrants the investment of time involved.
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MPEG Encoding Parameters

The encoding mode and bit-rate are the two MPEG encoding parameters you’ll be con-
cerned with most often. These need to be tended to (even if you decide to leave them in
their current setting) for every encoding job.

With the exception of Picture Rate (in the Video Format section, which needs to be set to
follow the standard of the incoming video signal), the other options and parameters in the
MPEG Video Encoder tab of the Setting window are typically used much less often.

In the Settings Window, select the MPEG Video Encoder tab to set the encoding mode (CBR or VBR), the bit-rate,
and other MPEG video parameters.

We’ve already detailed the Inverse Telecine function, which will be of interest only to
those of you working with program material that originated on film. The balance of this
section will go through the remaining settings and options to explain their operation and to
detail how they may be used in specific situations. In general, you’ll find that most of these
parameters may be left alone most of the time.
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All of the MPEG encoding parameters are grouped in the MPEG Video Encoder tab of the
Setting window. There are four major sections for this tab:

• the Quantization section;

• the Video Format section;

• the MPEG-2 Options section; and

• the Group of Pictures section.

Let’s review them in detail…

Quantization (CBR or VBR Encoding) Section
As we covered previously in this Encoding Guide, the Quantization section is where you
set the encoding mode — Constant Bit-Rate (CBR) or Variable Bit-Rate (VBR) — and the
actual bit-rate settings (in terms of bits per second).

There are also three optional parameters:

• Quantization Scale (1 to 16); (MPX2000 only)

• Quantization Type (Non-Linear or Linear);

• Intra DC Precision (8, 9, or 10).

Encoding mode and bit-rate are all-important parameters for DVD. MPEG quantization parameters are available for
advanced applications.

As we’ll detail, only in rare circumstances would you change the default values of these
parameters…
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Quantization Scale (Quant Scale)

Quantization Scale is a parameter that is used only in the profiling function for 1-Pass and 2-
Pass VBR encoding. It is not used in CBR encoding at all, and is greyed-out when this mode is
selected.

The Quant Scale is basically a sharpness setting, “1” being the sharpest and “16” being the
least sharp. Setting the Quant Scale to “1” allows the encoder to regulate itself and apply
compression where it will most effectively yield the best quality picture for the specified
bit rate, which works well during 1-pass encodes, depending on your encoder. (See the
note below.) On a 2-Pass VBR encode, a fixed sharpness level is set at “16” as information
on the best way to encode the stream is gathered during the first pass and applied during
the second pass; our encoders are “tuned” to this value.

At Spruce Technologies, we have done extensive testing and analysis of VBR encoding, on
a wide range of materials. Based on this research, we have arrived at default values of the
Quantization Scale parameter that are selected automatically when the 1-Pass or 2-Pass
VBR modes are selected. Our testing has demonstrated nearly conclusively that these are
in fact the optimal values, and that selecting any other value will not contribute to — and
may degrade — the results of VBR encoding.

Note for the MPX2000: In 2-pass VBR, we do not recommend changing the QUANT SCALE

value from its default of 16. In 1-pass VBR, we do not recommend changing the QUANT

SCALE value from its default value of 5.

For the MPX3000, Quant Scale settings have already been optimized for this board.
Therefore, the Quant Scale setting will not appear in the Quantization dialog if the
MPX3000 is installed in the system.

Quantization Type (Quant Type)

There are two types of quantization available in MPEG-2 video encoding: linear and non-
linear (which is the default). MPEG-1 uses linear quantization only. MPEG-2 has both
types of quantization available — though non-linear is used almost exclusively, as it
provides greater dynamic range.

Note: When MPEG-2 was defined, the non-linear quantization scale was introduced as an
across-the-board improvement on the previously used linear scale. The option of linear
scale in MPEG-2 was defined only to accommodate full backward-compatibility with
MPEG-1. There are no conditions known under which a linear quantization type would be
preferable to Non-Linear type in MPEG-2.

For MPEG-2, we recommend you always select NON-LINEAR. For MPEG-1, LINEAR is the only
option available.
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Intra-DC Precision

This parameter controls the precision that is applied to relatively non-changing (static)
portions of the picture. The legal values for DVD-Video purposes are 8, 9, and 10 bits. In
most cases, the default value of 10 is suitable. In material without subtly-shaded colora-
tion, settings of 8 or 9 bits may make it possible to use somewhat lower bit-rate settings
without introducing artifacts.

In most circumstances, we recommend using only the default setting for Intra-DC Precision.

Note: For very high-motion material, you might experiment with a setting of 8 bits, al-
though it’s unlikely you’ll perceive any difference in encoding quality.

Video Format Section
The video format settings include Picture Rate, Aspect Ratio, Chroma Format, and MPEG
Format. These are general settings that will most often be defined by the type of video
source and the target application.

The Video Format section of the MPEG Encoder Settings tab sets the basic functions of frame rate, aspect ratio,
chroma format, and MPEG format.

Picture Rate

Picture rate settings are available for NTSC (29.97 fps) and PAL (25 fps). Take care that this
is set appropriately for the encoding source.

Note: When authoring, it’s necessary to match the PAL/NTSC setting of the Project Proper-
ties with the actual format of video used.

Aspect Ratio

Aspect Ratio settings are available for 4:3 (conventional TV) or 16:9 (Widescreen). When 16:9
is selected, the encoded picture will be anamorphic (squeezed) — with a flag setting that will
trigger the end-user’s DVD player to expand the picture to Widescreen or letterbox.
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Chroma Format

Chroma Format setting is fixed at 4:2:0 , as required by the DVD-Video Specification.

MPEG Format

The two available MPEG Format settings are MPEG-2 and MPEG-1. Encoding for DVD is
nearly always done using MPEG-2, as the visual quality is far superior to MPEG-1. Lower-
rate MPEG-1 may be useful in instances where very long playback time is required or
when the delivery medium is to be something other that DVD.

MPEG-2 Options Section
The MPEG-2 Specification provides a number of settings that, in most situations, may have
only a marginal impact on picture quality. We recommend you use the default settings for
most of these parameters.

The MPEG-2 Options section includes several miscellaneous parameters as shown using the MPX3000 encoder.
For NTSC work, the Inverse Telecine checkbox is of critical importance.

Note: As detailed below wherever applicable, if you are using Spruce Technologies
MPX2000 hardware, the selection of options is slightly different.

If you are using Spruce Technologies MPX2000 hardware, the MPEG-2 Options section differs slightly.
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New GOP On Scene Change

This parameter is available only when using Spruce Technologies MPX3000 hardware.
With this feature selected, the system will automatically insert an I-frame and start a new
GOP (in MPEG: Group of Pictures) whenever an abrupt change is detected in video.

In most usage, this parameter will result in better encoding quality and will provide better
control over chapter start points. When encoding for purposes that require careful control
and matching of GOP structure (such as multi-angle video), however, use of this feature
will be counterproductive. In these instances, you should switch this parameter OFF.

Concealment Motion Vectors

Concealment motion vectors are redundant information that can be optionally included in
the MPEG stream to aid error recovery in non-DVD applications. Their use in DVD is not
recommended, as they do not provide any real benefit while consuming a small amount of
bandwidth otherwise available for picture data.

Dual Prime Mode

This parameter is available only when using the MPX2000 hardware. The Dual Prime
Mode is another method provided for in the MPEG spec that adds redundant information
to the streams for error recovery purposes. At the level that Dual Prime Mode and the
Concealment Motion Vectors operate, however, DVD-Video’s own error-correction
scheme is quite robust. Consequently, their use is not recommended for DVD applications.

Alternate Scan

For the pattern of picture block-scanning, you can select ALTERNATE (default) or ZIG-ZAG

(when ALTERNATE is not checked). Alternate Scan is a more irregular pattern that is optimized
for interlaced video. The use of Alternate Scan is recommended except in the less-likely
case of encoding progressive-scan (non-interlaced) video. Zig-Zag Scan is considered the
appropriate choice for progressive-scan pictures.

Note: Increasingly, digital video cameras are offering a progressive scan option, which is
generally of most benefit for still rather than moving images. However, since many of us
are likely to be seeing more progressively scanned source material (for digital television
and computer monitors), if the source (master) video recording was digital, it may be a
good idea to ascertain whether it was captured as interlaced or progressively scanned.
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Alternate Intra VLC

This parameter is available only when using Spruce Technologies MPX2000 hardware. In
order to represent quantized values more efficiently, MPEG encoding uses variable-length
codes (VLCs) from a look-up table. MPEG-1 uses one defined table. When MPEG-2 was
introduced, the table was further optimized. The original MPEG-1 Intra VLC table is kept
available for historical reasons. The Alternate Intra VLC table improves the performance,
particularly on I-frames.

Inverse Telecine

As we detailed earlier in this Encoding Guide, the Inverse Telecine checkbox should be
selected whenever you encode material that was shot on film and transferred to NTSC
(29.97 fps) video. The Inverse Telecine function removes redundant information that’s
inserted during the process of converting from the film frame rate of 24 fps to interleaved
video at 29.97. This redundant information reduces encoding efficiency; consequently its
removal results in better overall performance.

Group of Pictures Section
MPEG-2 video is encoded as different frame types. This is done in order to exploit both
temporal (time) and spatial (2-dimensional) redundancy, which results in greater encoding
efficiency. In this section, you can define the pattern of frame types, and more.

The Group of Pictures section governs the sequence of frame types used for encoding. (If you have an MPX2000,
your screen may look different from the one above.)

GOP Pattern

The GOP Pattern parameter lets you select the pattern, or sequence, in which the three
frame types (I, B, and P) will be repeated. Available GOP patterns include I-frame only, as
well as patterns that include all three frame types. Both Open and Closed types are avail-
able as well. In general, encoding for DVD-Video should be performed using a closed
GOP type, as this allows the best random entry into the stream for jumps, fast forward, and
so forth.
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GOP Size

The GOP size can be varied according to the GOP patterns selected. Usually, larger GOP
sizes result in better encoding performance.

For most material, longer GOP Patterns and GOP size will provide the most efficient
encoding. Particular sequences of material that change continuously — such as a fade-
from-black — may benefit from encoding with smaller GOP Patterns and Sizes.

Special Considerations for
Encoding Multi-Angle Video

When encoding material for use in multi-angle video segments (multiple video tracks) of a
DVD Movie, there are certain considerations that should be observed.

• All video assets must be encoded using a closed GOP Pattern.

• All video assets must have the same GOP structure throughout.

• The combined bit-rate of the highest video and audio asset, including subtitles,
cannot exceed 8 Mbps (8,000,000 bps).

Closed GOP Pattern
To ensure compliance with the first point, select either IBBP CLOSED or IBP CLOSED as the GOP
Pattern setting.

Note: Actually, these are the recommended settings for all applications, but for multi-angle
work, it is particularly critical.
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Congruent GOP Structure
To ensure compliance with the second point (same GOP structure), observe the following
considerations:

• Encode all segments with the same setting of the GOP Structure and GOP Size
parameters.

• Switch the New GOP on Scene Change parameter OFF, as it will modify the GOP
structures in an uncontrollable fashion.

• If you are encoding shorter sections to be placed as multi-angle within limited areas
of a longer main video, be careful to select a GOP size that can be rendered evenly
with the length of the multi-angle section.

This last consideration can be difficult to understand and implement. Let’s learn more…

Selecting the Best GOP Size

Since selecting the most appropriate GOP size can be a challenge, let’s consider an
example: Suppose we have a 30-minute video program, in the middle of which we want to
have a section of exactly 5 minutes in length that has several optional camera angles
available. After encoding the main video, we then set up to encode exactly 5 minutes,
using the default GOP size of 15 frames.

Provided that 29.97 fps timecode is used, this will work out fine, since 15 frames will
equal exactly 1/2-second (actually 0.1% more, but not worth going into here). As long as
the multi-angle section is an equal number of seconds in length, it will be fine.

On the other hand, if the multi-angle section is defined to be 5 minutes 2 seconds and 4
frames, then we either have to modify the length to an even number of seconds or find a
GOP size that will work out to be an even division of the total length.

In non-drop frame timecode, 05:02:04 works out to be 9064 frames (30 frames to the
second, 1800 frames to the minute).

To find a value of GOP size that will work, we have to try dividing different numbers from
the available settings into the number of frames. Since encoding quality usually works out
better the larger the GOP size, we start from the largest size available (16 frames for the
MPX2000 and 15 frames for the MPX3000) and work our way down.
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Program Length (frames) GOP Size Number of GOPs Encoder

9064 16 566.5 MPX2000

9064 15 604.2666667 MPX3000

9064 14 647.4285714 N/A

9064 13 697.2307692 MPX2000

9064 12 755.3333333 MPX3000

9064 11 NA N/A

9064 10 906.4 MPX2000

9064 9 1007.1

11111 MPX3000

9064 8 1133 N/A

etc.

As you can see from this, the largest available value of GOP Size that will yield an even
number of GOPs from this program is 8 (11 would have worked, but its not an available
setting). This means that both the main program and the multi-angle program segments
must be encoded with this value. (Alternatively, you could encode the main program in
sections and concatenate them together, as described later in this manual.) Since 8 is
rather a low figure for GOP size, we would recommend that you change the length of the
multi-angle segment by a few frames instead, but if this is not possible then 8 would be the
only option.
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Batch Encoding

DVDMaestro and DVDConductor support batch encoding, which allows you to encode
multiple files automatically without having to set up an individual encoding procedure for
each file. The Batch window is where you define “encoding jobs” — a list of video and/or
audio files that you wish to encode automatically.

The Batch Window manages a list of successive encoding jobs to be performed automatically.

To open the Batch window:

• Select BATCH WINDOW under the View pull-down menu (keyboard shortcut: ALT - V - B).

Initially, the Batch window will appear onscreen empty.

To add encoding jobs to the Batch List:

1. In the Encoder Control Panel and the Settings window, set the encoding parameters
— including Start and End time, Bit-Rate, Encoding Mode, etc. — as desired.

2. Click on the ADD button to the right of the main list field in the Batch window. The
new job is added to the list.

3. Repeat until all the jobs required have been added to the list.

All encoding settings are stored with each entry in the Batch list, even though only the start
and end times are shown.
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To view the stored parameters for an encoding job in the Batch List:

1. Double-click on the job to be recalled. The settings of the selected entry loads into
the Encoder Control Panel and Settings window.

2. View the encoding parameters as desired from the window and control panel.

If desired, you may execute a single encode from the recalled settings. Used in this way,
the Batch window can serve as a convenient “memory bank” for frequently used settings.

Having recalled an encoding job from the list, its parameters can be modified as desired
and reentered into the list with the settings changed.

To modify an entry in the list:

1. Recall the entry you wish to modify by double-clicking on it in the Batch List.

2. Make whatever changes you desire in the Settings window and Encode Control
Panel.

3. Click on the Modify button in the Batch Window to register the changes into the
Batch List.

4. If desired, you can also change the order of entries or delete entries in the list using
the Delete button and the Move button in the left-hand portion of the window.

5. Once you are satisfied with the list of entries, you can automatically perform all of
the listed encodes in sequence.

Note: The batch file does not automatically update the saved file. The batch file must
be resaved if you make any modifications.

The Encode Start button in the Encoder Control Panel changes
its appearance when Batch Mode is active.
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To launch the batch encode process:

1. Go to the Options menu in the Encoder Control Panel and select BATCH MODE (key-
board shortcut: ALT - O- B). The Start Encode button changes to a distinctive icon to
show that Batch Mode is in effect.

Note: Batch Mode is only available when Manual Mode is deselected.

2. Click on the Start Encode button. The system will prompt you to select a name and
path for the first file.

3. Set the root filename and path using the New File dialog.

Note: With the MPX2000, some of the entries may need the Out point adjusted to
accomodate the GOP structure. If this is the case, three beeps will sound during the
batch encode.

The system will create video (.vbs or .m2v) and audio (.ac3 or .mpa) using the root
filename with numbered extensions to indicate the list entry. The items in the encode list
will be executed sequentially until done. At the end of the process, the system will offer a
prompt to load the last encoded file into the decoder for preview.

Batch Window Features
The Batch window displays a table with four columns:

• Job Number;

• Start;

• Stop;

• and Length.

Each row of the table represents a single encode operation, resulting in an audio file, a
video file, or a matched pair of files for audio and video.

You’ll find several buttons grouped on the left- and right-hand sides of the Batch window;
these will help you manage the list. The right-hand group of buttons covers the core
functions of adding, deleting, and modifying entries in the table, while the group along the
left-hand side provides mainly for changing the order of entries in the list.
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The buttons along the right-hand side include:

• Add;

• Delete;

• Modify;

• Load Batch;

• and Save Batch.

The buttons along the left-hand side include:

• Move To Top;

• Move Up;

• Move Down

• and Move to Bottom.

Let’s review the operation of these buttons. . .

Add

You’ll use this button to create entries in the batch list and set parameters for the clip you
wish to encode as a list entry — including video and audio source selections, bit-rate, its
In/Out points, and so on. When the entry is complete, click on the Add button to place the
new entry into the list. Then create the second entry, simply add it to the list and continue
as you did with the first entry.

Delete

Should you wish to remove an item from the list, select the item to be deleted, then click
the Delete button.

Modify

To modify an entry in the list, first select that item. The parameters assigned at time of
creation will reappear in the Encoder Control Panel and the Settings window. Make any
changes you wish, then click MODIFY. Changes made will be transferred to the entry.
Remember, if you modify a batch file, you must save before closing the Batch window as
the modifications are not automatically saved.
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Load Batch & Save Batch

Batch encode lists may be saved to disk and reloaded using the Load Batch and Save
Batch buttons.

Move To Top, Move Up, Move Down, & Move to Bottom

The buttons along the left-hand side of the Batch window can be used to rearrange the
order of the entries in the table, exactly as labeled.

Other Encoding Functions
(Encoder Control Panel Pull-Down Menus)

There are three pull-down menus associated with the Encoder Control Panel:

• the File menu; 

• the View menu; 

• and the Options menu. 

The commands associated with these menus are as follows. . .

File Menu (alt - f)

Load Settings (alt - f - l)

Select LOAD SETTINGS to load previously saved settings into the Encoder Control Panel.
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Save Settings (alt - f - s)

Select SAVE SETTINGS to save the current settings of the Encoder Control Panel.

Exit (alt - f - x)

Select EXIT to close the Encoder Control Panel and return to authoring your Project.

View Menu (alt - v)

Settings Window (alt - v - s)

Select SETTINGS to assign parameters for both audio and video encoding. The Settings
window is described in detail in the next section.

Note: Before you can begin encoding, it is important to see that the Encoder Settings
parameters, especially the encoding mode and bit-rate, are set properly.

Batch Window (alt - v - b)

This command opens the Batch window, where you can enter a list of audio/video clips
for automated encoding. Batch encoding operations and the Batch window are detailed
earlier in this Encoding Guide.

Preview Window (alt - v - p)

This gives you the option to open or close the RealView window. There is also an option
to normalize the RealView window to the same aspect ratio as the source file.
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Preroll Setup (alt - v - r)

This command opens a dialog where you can assign the value of Tape Preroll, which is
used with tape machines that are being controlled by your Spruce authoring software’s
machine control feature. Tape Preroll is used to give a machine a certain period of time,
usually a few seconds, to get “up to speed” before encoding starts (the In time). The default
value of Preroll is 5 seconds. The minimum preroll amount for successful operation is 1
second — unless you are using something like a DDR where “0” is necessary for proper
functionality.

Video Compensation Setup

This feature does not appear in version 2.0 of DVDMaestro or DVDConductor. Please see
the version 2.5 Addendum for information on this feature.

Options Menu (alt - o)

The selections in the Options menu are “modal” in nature; that is, when selected, that
option is in effect until the menu item is deselected.

Batch Mode (alt - o - b)

When BATCH MODE is selected, all settings for encoding are taken from the list in the Batch
window. Once encoding is initiated in Batch Mode, your Spruce authoring software will
execute individual encoding of clips until the Batch window list is completed. Note that
this option is not available if there is not a batch list open in the Batch window or if
Manual Encode is selected.

Apply Timecode to Audio (alt - o - a)

When this command is selected, audio encoding is locked to video encoding — in other
words, the time entries for video also trigger audio encoding. As long as the audio source
is also locked to video (that is, audio is derived from tracks on video or from an audio
source locked to video), video and audio will be perfectly synchronized.
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Note: If this option is disabled, you will be required to specify audio timecode In (start)
and Out (end) times during encoding. For more information, please see the “Timecode
Sub-Tab” section later in this Encoding Guide.

DVD Compliant Only (alt - o - d)

When this option is selected (which is the default case), all encoding parameters are
constrained to the ranges that ensure compliance with the DVD specification. When
encoding video and audio for other purposes, need may arise to set some parameters
outside the DVD compliant range. For that situation, you may deselect DVD COMPLIANT ONLY.

Optimizing the Bit-Rate (Bit Budgeting)

As described in the previous section on basic encoding, the two most important param-
eters of MPEG encoding, by far, are the encode mode and bit-rate. In this section, we will
detail how you can calculate the optimal bit-rate for video encoding to suit the project at
hand. In the next section, we will describe how to use Variable Bit-Rate (VBR) encoding
and under what circumstances you can benefit from its use.

Optimizing the bit-rate for video encoding is a matter determining how much storage
space is available, then dividing that by the playtime of video you need to put into that
space. It’s as simple as that.

To make this calculation accurately, you need to consider all of the following:

• the total play time for the video material to be included in the title;

• the DVD format on which it will be mastered (single or dual layer, single or dual
side, DVD-R or replicated disc);

• the total play time and track configuration(s) for all the required audio material;

• the disc requirements for all required ROM assets (all non-DVD-Video assets) — this
applied to standard DVD-Video titles as well as Hybrid (DVD-Video plus DVD-
ROM) titles;

• any special characteristics of the Project that will affect the video storage require-
ments or transfer rate (required throughput) — such as large numbers of subtitles or
still pictures;
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• and finally, the limits of video bit-rate — as defined by the DVD-Video Specification
and by the performance of real-life DVD players — including a small margin of
“overhead.”

In the coming pages, we’ll review all of these factors. Let’s begin by calculating the total
play time. . .

Calculating the Total Video Play Time
To calculate the optimal settings for video bit-rate, it’s important to know the total play
time of all A/V material to be included on disc, including not only the main video feature
and “value-added” materials such as trailers, interviews, etc. If the project you are working
on is to use motion menus, include the length of these in your calculations (if you don’t
have an accurate number, make an estimate).

Once you have all the play times, convert these to seconds then add then all together. (For
calculation, you will need the number in seconds, and it’s easier to add raw anyway). If
there is an odd number of frames left over, round up to the next second.

For example, let’s consider a hypothetical project that includes the following video
segments:

• One main feature (126 minutes, 17 seconds in length).

• An interview segment (12 minutes, 4 seconds).

• Several original theatrical trailers (totaling 3 minutes, 12 seconds).

• Several trailers for coming attractions (totaling 6 minutes, 39 seconds).

• Six “dynamic” or “motion” DVD Menus (each using a loop of video no more than 20
seconds in length).

First we convert each of these to seconds:

• Main feature = (126 x 60) + 17 = (7560 + 17) = 7577 seconds

• Interview = (12 x 60) + 4 = (720 + 4) = 724 seconds

• Trailers = (3 x 60) + 12 = 180 + 12 = 192 seconds

• Coming Attractions = (6 x 60) + 39 = 360 + 39 = 399 seconds

• Dynamic DVD Menus = 6 x 20 = 120 seconds
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Then we total these together:

• 7577 + 724 + 192 + 399 + 120 = 9012 seconds

(It goes without saying that a calculator or spreadsheet program is vital in this process!)

Now we have the first piece of information we require in order to compute the optimal bit-
rate for video encoding, and we can move onto the next consideration…

DVD Formats & Disc Capacities
The size of the “bucket” that will end up carrying your program is the next most-crucial
element in your calculation. As you probably know, DVD discs come in any of several
“flavors”:

DVD Format Description Storage Capacity Comments

DVD-5 Single-sided, single-layer 4.7GB

Lowest cost replicated disc

DVD-9 Single-sided, dual-layer 8.54GB Higher cost than DVD- 5

DVD-10 Dual-sided, single-layer 9.4GB Requires user to flip disc

DVD-13 (Side A) dual-layer 13.24GB At this writing, not available

(Side B) single-layer

DVD-17 Dual-sided, dual-layer 17.08GB At 

this writing, marginally available

DVD-R (A) 1st generation DVD-R 3.9GB

More capacity for QA and small runs

DVD-R (B) 2nd generation DVD-R 4.7GB

Expected to be available late 1999

As you can see, the capacity of the different formats varies widely. In practice, the decision
of which format to use is most often determined by factors other than storage capacity
(especially cost). Note also that in the case of dual-sided and (to a lesser extent) dual-layer
formats, you may find yourself forced to distribute the content unequally on the two sides
of the disc, complicating your calculations.

Since disc capacities are expressed in gigabytes, and video encoding bit-rates are ex-
pressed in bits-per-second — rather than bytes — it is necessary to convert the disc
capacities to raw bits. The chart below shows the capacity of each format converted to bits
(and also expanded out to the full number for easier calculations).
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DVD Format Capacity in Bytes Capacity in Bits

DVD-5 4.7GB 37,600,000,000

DVD-9 8.54GB 68,320,000,000

DVD-10 9.4GB 75,200,000,000

DVD-13 13.24GB 105,920,000,000

DVD-17 17.08GB 136,640,000,000

DVD-R (A) 3.9GB 31,200,000,000

DVD-R (B) 4.7GB 37,600,000,000

With this information in hand, we can make a preliminary calculation for the required
video bit-rate for the hypothetical project we described in the previous section. (For the
moment we won’t factor in the audio files, etc.)

As you may recall, the total duration of video in that project ended up being 9012 sec-
onds. To translate this play duration into a first-cut video bit-rate for each of the designated
formats, we simply divide the capacity in bits by the play time in seconds, as follows:

• DVD-5: 37,600,000,000 ÷ 9012 = 4,172,000 bps

• DVD-9: 68,320,000,000 ÷ 9012 = 7,581,000 bps

• DVD-10: 75,200,000,000 ÷ 9012 = 8,344,000 bps

• DVD-13: 105,920,000,000 ÷ 9012 = 11,753,217 bps

• DVD-17: 136,640,000,000 ÷ 9012 = 15,162,000 bps

• DVD-R (3.9GB): 31,200,000,000 ÷ 9012 = 3,462,000 bps

• DVD-R (4.76GB): 37,600,000,000 ÷ 9012 = 4,172,000 bps

Note: Bit-rates are rounded to the nearest thousand.

At this point, the calculation of video bit-rate is mostly useful in helping guide decisions
about which DVD format to use. The values derived from this first-cut calculation will be
reduced somewhat as we allow for audio tracks, any ROM materials included, allowances
for disc overhead, etc. However, what we want to check now is whether the figures for our
target format are likely to be able to reproduce material satisfactorily.
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The bit-rate required for acceptable quality MPEG encoding is very much dependent on
the source material. However, in general, very good quality can be obtained with minimal
effort at bit-rates of 6 Mbps (6,000,000 bps) or higher. Between 4 and 6 Mbps, variable bit-
rate techniques are needed to get acceptable results for most general market material,
although special-purpose materials may be okay with CBR. At bit-rates lower than 4 Mbps,
you may end up spending a lot of time refining the encoding process and parameters
before obtaining a good result. And below about 3.5 Mbps much of the material in the
feature film realm simply cannot be rendered acceptably.

With these figures as a guide — and keeping in mind the bit-rate available for video will
likely to be pushed lower than the numbers above (thanks to the required audio files and
other possible elements) — which would be the appropriate DVD format to use? Well, a
DVD-5 format could possibly work for this Project , but might require special attention to
encoding. DVD-9 would fit everything quite comfortably. DVD-10 or DVD-17 would be
fine as well, but considerations of user convenience — and disc replication cost — are
likely to rule these out. As for DVD-Recordable, a first-generation DVD-R (3.9GB) clearly
will not carry the full program (but may serve as to test a truncated version; a second-
generation DVD-R (4.7GB), being the same as DVD-5, might be used in a full version.

Calculating the Audio Allowances
The next stage of the calculation is to make allowance for the audio content on the disc.
Bit-rates for audio encoding are fairly closely defined for a given format or compressed or
uncompressed audio, making the calculation somewhat simpler. On the other hand, the
configuration of audio may be different in different portions of the program, making things
a little more complicated.

The following chart list the bit-rates for a single stream (track) of audio in each of several
different compressed and uncompressed formats commonly used in DVD. The DVD disc
may have as many of 8 individual tracks, each of which may be in one of these formats.

Audio Format Bit-Rate
AC-3 stereo 192 or 224 kbps
AC-3 5.1 surround 384 or 448 kbps
DTS 5.1 surround 1536 kbps
Stereo PCM @ 16-bits/48kHz 1536 kbps
Stereo PCM @ 24-bits/96kHz 4608 kbps
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In the case of both AC-3 formats (stereo and 5.1 surround), the lower bit-rate represents
Dolby’s recommendations, while the higher number represents practice of a substantial
portion of engineer’s in the field. In general we recommend using the higher rates for AC-3
encoding for better fidelity.

You’ll notice that there’s quite a wide range of bit-rates for the audio formats supported in
DVD. However, most feature film application is centered on the use of AC-3 audio, either
in surround or stereo format. DTS sound represents a small (but growing) share of the
market. Uncompressed PCM audio, especially high-resolution/high-sample rate PCM, is
generally restricted to titles of special audio interest, such as music video.

For the hypothetical Project we have been working with, let’s assume the various elements
use the following audio configurations:

• Main Feature: 2 tracks AC-3 5.1 (French and English), 1 track stereo (Spanish)

• Interview: 1 track AC-3 stereo

• Theatrical Trailers: 3 tracks AC-3 5.1

• Coming Attractions: 3 tracks AC-3 5.1

• Motion Menus: 1 track AC-3 5.1

You can see that in this Project — which resembles many DVD feature film releases — the
audio configuration is quite varied. There are two approaches we can take to the calcula-
tion: either compute the contribution for each section or use the configuration of the main
feature and hope that other factors balance out. For comparison, we will do both.

Using the duration figures for each section, along with the audio track bit-rate figures listed
previously, we can compute the total storage required for audio as follows:

 

Section

Main Feature 7577 448 + 448 + 224 kbps 1,120,000 8,486,240,000

Total 9,496,480,000

Duration
(seconds)

Bit-Rates Total Bit-Rate
(bps)

Storage Required
(bits)

Interview 724 224 kbps 224,000 162,176,000

Theatrical Trailers 192 3 x 448 kbps 1,344,000 258,048,000

Coming Attractions 399 3 x 448 kbps 1,344,000 536,256,000

Motion Menus 120 448 kbps 448,000 53,760,000
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This gives us a figure for total audio storage that can be subtracted from the volume size, to
give partially refined result for optimal video bit-rate. For comparison, lets do the calcula-
tion for total program based on the configuration in the main feature:

Section

Total Program 9012 448 + 448 + 224 kbps 1,120,000 10,093,440,000

Duration
(seconds)

Bit-Rates Total Bit-Rate
(bps)

Storage Required
(bits)

In this case the result is a little higher than then detailed result, meaning that we any error
would be on the side of safety. This may not always be the case, however, and it can be
somewhat dangerous to try to simplify calculations in this way.

Let’s revisit our bit-rate calculation from the previous section, making allowance for audio,
using the more precise figure of 9,496,480,000 bits required for audio storage in our
example project. We will perform the calculation only for DVD-5 and DVD-9, the other
formats having previously been eliminated as candidates for delivery to market:

DVD-5
(37,600,000,000 – 9,496,480,000) ÷ 9012

= 28,103,520,000 ÷ 9012
= 3,118,000 bps

DVD-9
(68,320,000,000 – 9,496,480,000) ÷ 9012

= 58,823,520,000 ÷ 9012
= 6,527,000 bps

Based on the calculation including allowance for audio, it appears that DVD-9 is the only
delivery option likely to support acceptable encoding quality — since 3.1 Mbps is simply
too low for use for a feature film for general market.

Calculating the ROM Allowances
To continue our calculations, we need to subtract any storage allotted to ROM assets, and
then provide allowance for general DVD formatting, which includes menus, subtitles, and
navigation files. Furthermore, if you are creating a Hybrid DVD disc (DVD-Video and
DVD-ROM), all files related to the ROM portion of the disc would be included in these
calculations.
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For this example, we’ll assume that there are ROM assets such as Web-link software and
other files, totaling 36 megabytes of data.

Note that ROM assets are normally expressed in computer megabytes (MB), equal to
1,048,576 bytes, rather than the exact bit and byte quantities used in expressing DVD
capacity and encoding bit-rates. Therefore, to factor these assets into our calculation, we
need to convert the “megabyte” capacity into raw bits, then subtract this from the storage
capacity left after making allowance for audio. Then we can calculate a new figure for
optimal bit-rate.

Multiplying 36 MB by 1,048,576 bytes yields a result of 37,748,736. Then we multiply this
by 8 to give a figure in bits, which we round off to 301,990,000.

Including this into the DVD-9 calculation from the last section, we get:

DVD-9
(58,823,520,000 – 301,990,000) ÷ 9012

= 58,521,530,112 ÷ 9012
= 6,493,000 bps

In this case, the effect of allowance for ROM content on encoding bit-rate has been small,
in part because DVD is such a capacious storage medium for ordinary computer assets.

Factoring for DVD ‘Overhead’
As the last stage of our calculation, we need to make an “overhead” allowance for several
less-easily quantifiable factors, including the size of DVD navigation files that will be
created during compilation (for still DVD Menus and subtitles) and for variances in encod-
ing that may give us a less-precise result than we have calculated.

The amount of this margin may vary with Projects, but for most we recommend you allow for
an overhead of 5%. Factors that might increase this margin would be large numbers of subtitle
tracks, numerous still images, a very complex navigation structure, and so on. In this area, it is
nearly impossible to make hard and fast rules, but these guidelines should allow you to
optimize encoding bit-rates without running out of space on the target DVD format.

Note: Important! Always remember to allow for overhead. If you don’t, the likely result is
that you’ll be far into your Project before discovering that it will not fit on the target disc.
This is a very expensive mistake to make in production!



User’s Guide for Spruce Technologies DVD Encoder Hardware76

To calculate the required overhead, simply multiply the result of the last calculation (after
allowance for audio and ROM content) by the inverse of the percentage margin. In this
case, we will use a margin of 5%, which translates to multiplication of the last result by
0.95. Hence:

DVD-9
6,493,000 bps x 0.95

= 6,168,000 bps

The end result of our calculation, and a good figure to use for video encoding in this
Project is:

6,168,000 bps, or 6.18 Mbps

Therefore, we may encode this Project in CBR mode at a rate of 6.18 Mbps — with
confidence that the resulting files will be able to be delivered in the DVD-9 format, with
all accompanying audio, ROM, menu, and navigation assets.

Note: In some cases, you may want to round this downward to allow for any errors of
calculation, such as not applying enough margin at the end. There will be little perceived
difference between encoding at a rounded-down value of 6 Mbps and encoding at 6.18
Mbps. The important thing to remember here is to round down — not up.

Summary of Video Bit-Rate Calculations
We’ve already examined how to calculate optimal video bit-rates in some detail, and by
now you may be feeling as though your head is spinning. However, you’ll find that in
practice, these bit-rate optimization calculations are not so difficult. In simple form, the
procedure is:

1. Determine the total play time of all video assets in the Project. Convert this to
seconds.

2. Determine the size of the target DVD format (or possible formats) and convert this to
bits.

3. Determine the amount of data required for audio by multiplying the total play time in
seconds by the bit-rates of all audio tracks and summing the results. Subtract this
number from the size of the DVD format.

4. Subtract any space required for non-DVD Video (ROM) assets.

5. Divide the resulting adjusted capacity figures by the video play time (as determined
in the first step).
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6. Multiply the resulting “bits-per-second” figure by an overhead allowance of 0.95 (or
less if your Project warrants a larger overhead safety margin).

7. If the resulting number is greater than 8,000,000 bps, use 8,000,000 bps instead.

8. Make sure that the sum of the video bit-rate and all of the audio bit-rates that occur
in audio tracks of the same video clip does not exceed 9,800,000. If it does, subtract
the sum of audio bit-rates from this number and use if instead of the previously
calculated figure.

The result is the optimal bit-rate for CBR encoding, or average bit-rate for 1-Pass or 2-Pass
VBR encoding.

AC-3 & MPEG Audio Encoding

Earlier in this Encoding Guide, we learned how to encode video and an associated stereo
audio track. In many professional situations, this is all that is required.

In other situations, however, you will need to encode stereo or 5.1 audio from separate
media, either because there is more than one stereo soundtrack involved, or because the
main soundtrack is in 5.1 discrete surround and there are no video formats that have
enough audio tracks.

Encoding ‘Wild’ Audio
In some situations, you may encode a music bed or other accompanying audio that has no
firm relationship to video. This may come from Compact Disc or other “wild” media
(“wild” in this case means without synchronized machine control).
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In this case, you will use Manual encoding with audio only.

To encode audio (only) without machine control.

1. Cue up audio source to the desired start point.

2. Setup the Encoder Control Panel as shown above. Of course, make sure that audio
connections and settings are also set up correctly.

3. Click on the Encode Start/Stop Button.

4. In the Save File dialog, select the name and location for the file to be captured. Click OK.

5. When you see the Encode Start/Stop button turn red, start the audio source.

Note: Depending on how tightly you want to cut the source material, you may need to try
a couple of times to get the start point where you want it to be.

Encoding Synchronized Audio without Video
When you are preparing a Project with multiple soundtracks that all sync to picture,
usually the individual soundtracks will be delivered on separate audio tapes, most com-
monly professional Digital Audio Tape with timecode. In order to encode these to syn-
chronize with picture, it is necessary to use a professional machine that provides serial
machine control using RS-422 protocol.

Caution: Audio Timecode

For success when encoding synchronous alternate audio tracks, it is important that the
timecode on the audio tapes have a fixed relationship to the timecode on video. Ideally,
the timecode on each audio tape will be identical with the timecode on the main video.
This makes it straightforward to encode from each audio tape in turn, without changing the
encode In/Out points.

Alternatively, you may find in some situations that the timecode on the audio tapes is
offset from that on the main video. This is workable, so long as you know the correct In
time and Out time or the offset (from which you can calculate In and Out).

The worst situation — one which is best avoided by careful planning — is when timecode
on audio has no specific relation to that on video or is in a different format. There are no
simple solutions for this kind of situation, and in many cases, the audio may have to be re-
recorded with new timecode that matches the format of the video timecode.
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Caution: Audio Sample Clock

If your source audio tapes are in digital format, you’ll need to ensure that the audio sample
clock is locked to video. If it is, then encoding will proceed smoothly. If it is not, then you
will be subject to “drift” of audio video sync over time.

In the case that the source audio is in analog format and there is no analog video feeding
the digital connect box, then it is important to set the Audio Sync setting in the Digital
Connect tab of the Settings window to INDEPENDENT. With an analog video source connected
to the digital connect box, the sync should be set to SLAVE TO VIDEO. Otherwise, you can
expect the audio/video sync to drift with time.

Caution: Audio Conformance

If you are working with multiple language tracks for a video program, make sure that all
tracks conform with picture. If they do not (a situation common in feature film work), then
there is no choice but to go into audio post and reconform the tracks to fit. This is a
complex process and well beyond the scope of this manual.

To encode synchronous audio with machine control:

1. Setup the Encoder Control Panel as shown above. Verify that audio connections and
settings are set up correctly.

2. Enter timecode values for the In and Out times.

3. Click on the Encode Start/Stop button.

4. In the Save File dialog, select the name and location for the file to be captured. Click OK.

5. The audio deck will cue to the start point and capture audio as needed.
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Encoding AC-3 5.1 Audio
Encoding audio in 5.1 format is no different than encoding stereo audio, except that the
source format is in a 6-channel configuration (Left, Center, Right, Left Surround, Right
Surround, Subwoofer).

Note: To encode 5.1 surround, you must have the Spruce Technologies ACX5100 5.1
Encoder Board installed in your system.

The audio source for 5.1 can be any form of multitrack audio, but typically it is a digital
audio multitrack tape in the DA-88 or PCM800 8mm format supported by Tascam and
Sony. This has become nearly standard practice in the industry, and is recommended.

The source transport also needs to support serial machine control in RS-422 format, a
requirement that is met by the Tascam and Sony transports.

In the AC-3 Encoder Setting portion of the Setting window, you will need to make sure that
the Audio Coding Mode setting is configured for 5.1, as shown above. Appropriate Bit-
Rate settings are either 384 or 448 kbps. (The former is recommended by Dolby. The latter
is preferred by some producers.)

To set up the audio encoder for 5.1 surround encoding:

1. In the Encoder Control section, set the Encode Source for Audio to AC-3 (5.1 CH.).

2. Open the Settings window via the View pull-down menu (keyboard shortcut: ALT - V - S).

3. In the Settings window, select the AC-3 Encoder Settings tab.
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4. In the Audio Service Configuration section of the AC-3 Encoder Settings tab, set the
Audio Coding Mode to 3/2.

5. If the Subwoofer channel is present, select LFE.

6. Set the Data Rate to either 384 or 448 kbps.

Of course, you will also need to make sure that all six source audio channels are con-
nected to the inputs of the ACX-5100. There is no defined standard for which tape channel
will correspond to which speaker channel in the surround field. The AC-3 Encoder Settings
window provides a means to define this.

To define channel routing for 5.1 surround encoding:

1. In the AC-3 Encoder Setting tab of the Settings window, select the Input/Output sub-
tab.

2. In the Digital Input section of this tab, click on the Input Channel Routing button.

3. In the Input Channel Routing dialog, select the input channel that corresponds to
each of the six speaker channels in the surround sound field.

4 Click OK.
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As with stereo audio, 5.1 surround audio may be encoded at the same time as video or in
a separate audio-only pass. The difference is that with 5.1 audio, the audio will be coming
from a separate multitrack audio transport that is synchronized to the video transport —
rather than from audio tracks on the video transport.

The Spruce encoding system is unable to control two transports simultaneously via serial
machine control. In this situation, the best method to use is to feed timecode from the
video deck to the audio deck. You can then place the audio deck into its “timecode chase”
mode. It will then follow the video deck as it is controlled by the encoding system.

Note: Your multitrack audio transport must be able to synchronize to external timecode in
order to accomplish timecode chase. And to do so, your multitrack audio transport may
require an optional synchronizer card or external synchronizer box. If in doubt, please
check with the manufacturer of your audio transport.

To encode 5.1 audio synchronized with video:

1. Connect the multitrack audio transport to timecode feed from the video transport.
Place the audio transport in timecode chase mode.

2. Configure the Encoder Control section as described above.

3. Make sure that audio settings and connections are correct.

4. Set the timecode In and Out points.

User’s Guide for Spruce Technologies DVD Encoder Hardware 83

5. Click the Encode Start/Stop button.

6. In the Save File dialog, define the name and location of the files to be captured.

7. Click OK. The system will now cue the source transports and capture audio and video
together.

If surround audio is captured in a separate pass, the procedure is the same as for capturing
stereo audio independent of video. The only difference is that the audio settings and
connections must be defined as for surround audio.

Encoding Audio in MPEG-1 Layer 2 Using the MPX2000 Encoder
Depending upon what you’ve selected as the audio encode source (in the Encoder Control
section of the Encoder Control Panel), the third tab of the Encoder Settings window will
either be the AC-3 Audio Encoder tab or the MPEG Audio Encoder tab. If you’ve selected
MPEG AUDIO as your audio encode source, then you’ll see the MPEG Audio Encoder tab.

Note: If you are using Spruce Technologies MPX2000 hardware, the source input for
MPEG audio is different than the input for AC-3 stereo. You must connect the digital audio
(from the Digital Connect box of digital audio source device) to the correct input. For
MPEG audio, the digital audio source signal is routed to the RCA (phono) connector on the
MPX2000 encoder card, rather than to the connector on the ACX2000 card. For conve-
nience, you may wish to split this signal so that it is routed continuously to both cards.

The MPEG Audio Encoder tab of the Encoder Settings window assigns all of the parameters
associated with audio encoding in the MPEG-1 Layer 2 audio format. (MPEG 1 Layer 2
files typically have an extension of “.m1a”, “.mpa”, or “.abs.”

Note: The MPX3000 will support MPEG-1 Layer 2 audio encoding in version 2.5 of the
DVDConductor/DVDMaestro software.



User’s Guide for Spruce Technologies DVD Encoder Hardware84

When encoding MPEG-1 Layer 2 audio using the MPX2000, the key setting is the bit-rate; sample rate is restricted
to 48 kHz.

As you can see in the screenshot, the settings for MPEG audio encoding are considerably
simpler than those for AC-3 audio encoding.

The settings are divided into three sections, as follows. . .

Quantization
Bit-rate

This is the most important setting in the MPEG Audio Encoder tab. The recommended bit-
rates for MPEG 1 Layer 2 audio are 192 or 224 kbps.

Sample Rate

Per the DVD-Video Specification, the sample rate for DVD-Video use is restricted to 48 kHz.

Audio Format
Mode

Stereo mode is the default format for MPEG 1 Layer 2 audio.
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MPEG Options
Encoding Layer

Layer 2 is the only valid option.

Emphasis

Emphasis may be selected as NONE or as CCITTJ17.

Original, Copyrighted, Use Protection

MPEG audio copy protection is not ordinarily used for DVD, as DVD-Video Specification’s
own protection provisions are much more robust. Therefore, we recommend you leave
these checkboxes unchecked, their default state.

AC-3 Encoding Parameters

Depending upon what you’ve selected as the audio encode source (in the Encoder Control
section of the Encoder Control Panel), the third tab of the Encoder Settings window will
either be the AC-3 Audio Encoder tab or the MPEG Audio Encoder tab. No tab will appear
if the audio encode source is set to NONE. If you’ve selected ACXPRESS as your audio encode
source, then you’ll see the AC-3 Audio Encoder tab.

The AC-3 Audio Encoder tab of the Encoder Settings window assigns all of the parameters
associated with audio encoding in the Dolby AC-3 format.
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The AC-3 Audio Encoder tab.

The settings for AC-3 encoding are divided into the general, or basic, parameters, which
are always shown. More detailed setting of parameters is available by select individual
sub-tabs in the right-hand portion of the display.

If you’ve selected AC-3 (STEREO OR 5.1) as the Encode Source in the Encoder Control
section, the AC-3 Audio Encoder tab will display parameters for Dolby Digital (AC-3)
audio encoding. If, however, you’ve selected MPEG-1 AUDIO as the Encode Source, the
parameters for MPEG 1 Layer 2 audio encoding will appear.

Note: Abbreviated definitions of AC-3 encoding parameters are provided below. The
separate document “Dolby Digital Professional Encoding Manual for ACXpress” (included
with your DVDStation or Spruce Technologies encoding hardware) contains detailed
definitions.

As you can see in the previous screenshot, the AC-3 Audio Encoder tab is divided into two
major sections: the left-hand portion, with meters and other elements, and the right-hand
portion — with five separate sub-tabs for setting up different aspects of the audio encoding.
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Let’s tour the AC-3 Audio Encoding tab, starting with the left-hand elements — all of
which remain onscreen and available, regardless of which right-hand sub-tab is selected.

The left-hand portion of the AC-3 Audio Encoding tab.

Level Meters
Six horizontal level meters are provided to monitor audio input activity: Left (L), Center (C),
Right (R), Left Surround (Ls), Right Surround (Rs) and the subwoofer channel, Low-Fre-
quency Enhancement (LFE).

If the hardware or software configuration is set to stereo encoding (2/0), only the L and R
meters are active. When 5.1 (5/1) surround encoding is performed, all six meters will be
active, assuming all channels of the input source are active.

The scale of the meters ranges from –60 dB to 0 dB.

Audio Service Configuration
The Audio Service Configuration section of the AC-3 Audio Encoding tab contains six
different parameters, constituting the most import general parameters for AC-3 encoding.

The settings available in tab section are as follows. . .
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Data Rate

The AC-3 data rate is the basic parameter that determines output quality. AC-3 supports a
wide range of data rates for different applications. For use with DVD, Dolby Laboratories
specifically recommends rates of 192 kbps for stereo and 448 kbps for 5.1 surround.

Sample Rate

This parameter must match the sample rate of the incoming source audio. For DVD use, a
sample rate of 48 kHz is the only legal value for compressed audio. By selecting the
checkbox labeled AUTO, your Spruce authoring software will automatically set the sample
rate to match the incoming source audio.

Audio Coding Mode

The Audio Coding Mode defines the configuration of audio channels as mapped to the
physical speakers. The value is expressed as two single-digit numbers separated by a slash.
The left number defines the number of front speakers, while the right number defines the
number of rear speakers. The common settings for DVD are 2/0 (stereo) and 3/2 (5-channel
surround, excluding the subwoofer or LFE channel).

LFE Enable

This indicates that a separate low-frequency enhancement (subwoofer) channel is avail-
able. Set this checkbox whenever you’re encoding 5.1 material.

Bitstream Mode

The AC-3 bitstream includes data bits that flag how the stream is used. Besides the default
setting of COMPLETE MAIN, Dolby provides settings for use by hearing impaired, commentary
tracks, and so forth. These are used in non-DVD applications only. Selection of Karaoke
Mode is used for Karaoke Mix Mode audio.

Dialogue Normalization (Dialog Normalization)

This parameter specifies the average level of dialogue relative to overall mix and is used in
encoding to help maintain the intelligibility of speech. The default value of –27 dB repre-
sents a median setting for feature film mixing, which normally carries dialogue at a level of
–24 to –31 dB below peak level. For non-feature film materials, such as a talking heads-
style television production, dialogue levels may be higher.
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Audio Bandwidth

This display-only field shows the upper-frequency bandwidth of the audio, which is
determined by the bit-rate, the audio coding mode, and the sample rate. (An upper-
frequency audio bandwidth rating of 20 kHz or higher is excellent, as it will be higher than
most people can hear.)

Use LTC, Save Configuration
& Load Configuration Buttons
Before we get to the right-hand sub-tabs of the AC-3 Audio Encoding tab, there are three
other buttons along the tab’s bottom edge you should understand. . .

The Encoder Settings dialog, showing AC3 Audio Encoder tab. The Use LTC button is the “clock” button in the
lower-left corner; the Load Configuration and Save Configuration buttons are in the lower-right corner.

Use LTC Button

This button may be selected when an LTC (linear, or longitudinal timecode) signal is
available from the video/audio source and is connect to the timecode input. Selecting this
option is especially useful when the audio source is not compatible with serial machine
control or if the control cable is not connected to the audio source.
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When you select this button, which has an image of a watch, the audio encoder will
“listen” to the audio source’s LTC signal — rather than whatever incoming timecode
reference may appear at the CPU’s serial (RS-232) control port. In this way, the process of
audio encoding is de-coupled from machine control and is triggered purely by the Start
Time and Stop Time entered in the Timecode tab in the right-hand section of the AC-3
Audio Encoding tab.

When a suitable LTC feed is available, the use of this function is highly recommended, as
it guarantees accurate synchronization between video and audio.

Save Configuration (Save Config) Button

By selecting this button, you can save all of the current settings of the AC-3 Audio Encoding
tab. When you click SAVE CONFIG, a save dialog will present itself, allowing you to save the
current configuration; you can also change default hard drive directory too, if you wish.

Load Configuration (Load Config) Button

This feature will let you restore previously saved settings for the AC-3 Audio Encoding tab.
When you click LOAD CONFIG, a open file dialog will present itself, where, if necessary, you
can also browse for the desired configuration file.

Bitstream Info Sub-Tab
Found on the right-hand side of the AC-3 Audio Encoder Settings tab, Bitstream Informa-
tion (BITSTREAM INFO) is the first of five sub-tabs.

The Bitstream Information sub-tab control the mixdown of multichannel information during 2-channel playback; it
also stores optional Audio Production Information.

User’s Guide for Spruce Technologies DVD Encoder Hardware 91

The Bitstream Information settings are used to control the mixdown of how multichannel
material is heard when played back on just a 2-channel (rather than a 5.1 surround-
capable) playback system. It’s also used to store certain optional Audio Production Infor-
mation. Let’s learn more about the parameters in this sub-tab. . .

Center Mix Level

This parameter is available only when:

• the ACXpress 5100 6-channel encoder is used;

• and a mode is set that uses three front channels (L, C, R).

The Center Mix Level defines the level of the center-channel information — relative to the
left- and right-channel information — when audio is reproduced on a two-channel (stereo
only) playback system. The available values are –3 dB, –4.5 dB, and –6 dB.

Surround Mix Level

This parameter is available only when:

• the ACXpress 5100 6-channel encoder is used;

• and a mode is set that uses one or more surround channels (Ls, Rs).

The Surround Mix Level defines the level of the surround-channel information — relative
to the left- and right-channel information — when audio is reproduced on a two-channel
(stereo only) playback system. The available values are –3 dB, –4.5 dB, and –6 dB.

Copyright Bit

This bit, set by default, indicates that the source audio material is copyrighted.

Original Bitstream

This bit, set by default, indicates that the current bitstream is an original bitstream.

Dolby Surround Mode

This parameter is available only when encoding in 2-channel (2/0) mode. It should be set
if the source material is encoded for Dolby Surround (Dolby Pro-Logic).
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Audio Production Information

As an option, the Dolby Digital (AC-3) Specification allows you to include basic informa-
tion about the audio production with the encoded audio file(s). This information is not
used in the audio decoding process; however, it may be useful to audio engineers or other
personnel during the final audio mix or disc premastering stage.

The optional Audio Production Information includes:

• Info Exists:

° This flag indicates that audio production information (mix level and room type) is
included in the bitstream. When it is selected, the encoder will incorporate the
settings of the remaining two fields into the audio output.

• Mix Level:

° Mix Level defines the monitoring level that was used in the final mixdown of the
content. This can be used by a reproduction system, for example, to adjust fre-
quency response curves for different reproduction levels.

Note: Proper encoding for Dolby Surround requires specific mix levels. For full
details, please consult the Dolby manual included with your encoder.

• Room Type:

° This indicates the type of room used during the recording and/or mixing of the
source audio. It can be used during reproduction to adjust ambience for different
playback environments.
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Preprocessing Sub-Tab
Found on the right-hand side of the AC-3 Audio Encoder Settings tab, Preprocessing is the
second of five sub-tabs.

Audio preprocessing is able to remove “out-of-band” components and to optimize the signal for reproduction in
typical home environments.

The settings in this tab are used to process audio before it is encoded, for optimal encoding
performance. Let’s begin with the upper-left section of this sub-tab. . .

Input Filtering

One of the goals for optimum audio encoding is to ensure that you encode only the audio
you need. By removing unwanted high- and low-frequency material — the so called “out-
of-band” components — you can audibly improve the final encoded audio files.

For instance, extremely low-frequency information — especially “0Hz” information, also
called “DC” — can mess up the encoding process. To prevent this, the Preprocessing tab
offers a DC High-Pass filter (detailed just below). Similarly, let’s say you’ve restricted (in
the Audio Bandwidth setting in the left-hand portion of the AC-3 Audio Encoding tab) the
audio bandwidth to 20kHz — which is, practically speaking, already higher than many
people can hear. If your source audio has audio information above 20kHz, however, this
could interfere with the encoding process — and you’d be wise to filter that audio using
the Bandwidth Low-Pass Filter (detailed just below).
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Another issue to consider is “pre-emphasis.” In the early days of digital recording, many
digital recordings were made with pre-emphasis, a slight high-frequency boost intended to
compensate for performance problems with audio Analog/Digital converters. Nowadays,
audio A/D converters have improved greatly and almost no one intentionally records with
pre-emphasis. However, it is possible you may run into a recording with pre-emphasis
(intentional or otherwise), in which case it’s a good idea to apply “de-emphasis” to even
out the frequency response.

The Input Filtering settings include:

• Digital De-emphasis:

° In the default setting of AUTO, your Spruce authoring software monitors incoming
digital audio signals, and if it detects pre-emphasis, it applies its own de-emphasis
filter automatically. By unchecking AUTO, you can also force the de-emphasis filter
ON or OFF. If you’re unsure of what setting to use, keep AUTO checked.

• DC High-Pass Filter:

° This applies a high-pass filter (also known as a “low-cut” filter) to remove any DC
components present in the incoming audio. We strongly recommend you leave this
checked (its default setting).

• Bandwidth Low-Pass Filter:

° When this filter is selected, a low-pass filter (also known as a “high-cut” filter) is
applied to incoming signal to remove any frequency components that are above
the encoding bandwidth (as displayed in the Audio Bandwidth setting in the left-
hand portion of the AC-3 Audio Encoding tab).

• LFE Low-Pass Filter:

° When selected, this applies a low-pass (or “high-cut”) filter to the input of the low-
frequency enhancement (subwoofer) channel. This will eliminate frequency
components that are above the LFE channel’s bandwidth.

Note: This parameter is available only when using the ACXpress 5100 with the LFE
channel enabled.
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Surround Channel Processing

In this section, you can provide further processing to the surround channels (if present).
The options include:

• 90-Degree Phase Shift:

° This parameter is available only when encoding in surround mode with the
ACXpress 5100. It applies a 90-degree phase shift to the surround channels. When
5.1-channel audio is played back on a 2-channel output feeding a Dolby analog
surround decoder, this phase shift will cause the surround channels to be output at
the rear, similar to the original mix.

• 3 dB Attenuation:

° This 3 dB attenuation of the surround channels matches the practices of film
mixing, in which surround channels are mixed 3 dB “hot” to compensate for the
gain structure of cinema installations. Home reproduction systems are normally
calibrated for unity gain on the surround channels, so the additional gain is re-
moved in encoding.

Dynamic Range Compression

In this section, you can define how the audio’s dynamic range — that is, the range be-
tween the loudest and quietest passages of audio — is reduced or compressed. Dynamic
range compression is applied to “even out” high- or low-level extremes to produce more
consistent listening levels.

The features of this section include:

• Compression Characteristic:

° Dolby Digital decoders provide a dynamic range compression function optimized for
listening in typical home environments. This compression uses different compression
“curves” (with different playback characteristics) for different types of material. The
Compression Characteristic should be set for the type of material being encoded. The
available settings are: FILM STANDARD, FILM LIGHT, MUSIC STANDARD, MUSIC LIGHT, and SPEECH.

• RF Overmodulation Control:

° This checkbox sets the encoder to prevent RF overmodulation in set-top decoder
boxes. It is especially important for broadcast applications, and we recommend
you leave this control checked.
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• Input Level, Line Mode, and RF Mode Meters:

° These meters provide visual references that can be useful during the AC-3 encoding
process. For more information, please refer to the “Dolby Digital Professional
Encoding Manual for ACXpress” (included with your DVDStation or Spruce Tech-
nologies encoding hardware).

Input/Output Sub-Tab
The fields in this sub-tab mostly indicate the status of your incoming digital audio signal;
they also let you set the output format of your AC-3 encoded audio.

The Input/Output sub-tab displays information about the status of incoming digital audio signal and provides for
setting the output format for encoded AC-3 audio.

This sub-tab has three sections. . .

Digital Input

In this section you can see important information about the incoming audio signal and you
can also reconfigure the input channels:

• Lock Status:

° Indicates that a valid digital audio bitstream is being received.

• Sample Rate:

° Indicates the sample rate of the current audio input bitstream, as indicated by bits
embedded in the standard input format.

User’s Guide for Spruce Technologies DVD Encoder Hardware 97

• Integrity:

° A HIGH indicator shows that the encoder is having no problems “reading” the
incoming audio signal. If there are problems with the signal, the integrity setting
will indicate MARGINAL.

• Input Channel Routing:

° The Input Channel Routing button opens a sub-dialog, where you can match input
source channels to the appropriate reproduction channels (L, C, R, etc.) for play-
back. This allows your authoring system to work with any format of multichannel
audio source without physically re-patching the system.

Digital Input Subcode

Digital audio standards allow for subcode information; these are “flags” hidden in the
incoming audio signal that indicate sample rate and other information.

Spruce authoring software is able to recognize the following types of subcode information:

• Format:

° This will indicate with PROFESSIONAL or CONSUMER.

• Sample Rate:

° Spruce authoring software recognizes either 44.1 kHz or 48 kHz audio.

Note: Remember, the DVD-Video Spec only supports a 48 kHz audio sample rate for
compressed audio.

• Emphasis:

° This indicates if the incoming audio source includes pre-emphasis (see “Pre-
Processing Sub-Tab,” above).

• Audio Bit:

° An indication of AUDIO confirms that that the incoming signal is indeed audio data,
rather than OTHER.
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Digital Output

Here, you set the digital output format to support the use of the digital audio stream for
encoded (technically non-audio) data

Normally, you should leave these settings in their default position, which are as follows:

• Format:

° This is set by default to 32-BIT PROFESSIONAL MODE. (The Dolby AC-3 spec includes this
feature primarily for laser disc premastering, which does not apply to Spruce
authoring software. However, we suggest you leave this setting in its default
position.)

• Audio Bit:

° The default mode is NON-AUDIO. (This prevents linear D/A converters from reproduc-
ing the encoded AC-3 stream if connected inadvertently.)

• Include Timecode Packets:

° By default this option is checked. (This embeds timecode packets in encoded audio
files, which in turn helps to ensure accurate audio-to-video synchronization.)

Rec/Play Sub-Tab
This sub-tab lets you access your Spruce authoring software’s record preference.

The Record/Play sub-tab: Ordinarily, this should be set to normal +time, as indicated.
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Normally, you should leave this setting in its default position, which is as follows:

Record Preferences

• File Format:

° This should always be set to NORMAL + TIME CODE so that the appropriate timecode
references will be captured. In turn, this will facilitate accurate audio-to-video
synchronization during authoring.

Timecode Sub-Tab
This sub-tab displays the audio source’s current timecode and optionally allows you to
specify timecode start and end times.

Current timecode, as well as the start and end timecodes for encoding are display in the Timecode sub-tab. If
you’ve disabled APPLY TIMECODE TO AUDIO (in the Options menu of the Encoder Control Panel), then the start and end
timecodes for audio encoding are entered here.

This sub-tab’s features include:

Current Timecode

This displays the current location value of the incoming from linear timecode this field is
only available if the Use LTC button has been selected.
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Start Timecode & Stop Timecode

The Start Timecode field lets you set a start time for audio encoding. That is, when the
incoming audio source’s timecode location (as indicated in the Current Timecode display)
reaches the desired start time, encoding will begin.

Similarly, the Stop Timecode field lets you set a stop time; when the incoming audio
source’s timecode location reaches the desired stop time, encoding will stop.

Note: If you’ve selected APPLY TIMECODE TO AUDIO in the Options menu of the Encoder
Control Panel, then the In and Out values entered in the Encoder Control Section of the
Encoder Control Panel are automatically transferred to the Start Timecode and Stop
Timecode fields in the Timecode sub-tab. These In and Out values apply to the video
encoding process, and the Apply Timecode to Audio option simply tells your Spruce
authoring software to use the same values for audio.

If, however, if you have de-selected APPLY TIMECODE TO AUDIO in the Options menu of the
Encoder Control Panel, then you can use these fields to enter separate start and stop times
for audio — independent of whatever you’ve set for video.

Summary of Encoding

Although we’ve presented a wide range of encoding-related options and configuration
issues in this Encoding Guide. you’ll find that basic video and audio encoding is very
simple to perform.

There may be, however, situations where you’re called upon to encode varying configura-
tions of audio and video, possibly with different timecode situations. You may also be
called upon to optimize video image quality in situations of varying difficulty. The infor-
mation in this Encoding Guide provides guidelines for many common situations, but as
you’ll learn, real skill in solving production problems and optimizing compression results
will come with experience.

•        •        •
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How to Use this Encoding Guide

This Encoding Guide is a companion manual to both your Spruce Technologies User’s
Guide and Quickstart Guide. In the coming pages, we’ll be discussing concepts and
features that are introduced and detailed in both of these other manuals, so we suggest you
keep them close at hand for reference. Furthermore, as we’ll cover later in this Encoding
Guide, since some encoding procedures take place directly from within DVD Movies, you
may want to review Chapter 6 of the User’s Guide before reading this Encoding Guide.

Note: This Encoding Guide does not describe how to install or connect Spruce encoding
and decoding hardware. For such information, be sure to read the Quickstart Guide, as
well as any other documentation that may have accompanied your hardware. (Spruce
DVDStations come with encoding and decoding hardware installed.)

Who Should Read this Encoding Guide?
This Encoding Guide is for anyone performing MPEG or other encoding using Spruce
Technologies software and hardware. Specifically, if you use any of our encoding hard-
ware (which includes our MPX, MP2, or ACX series encoders) — and will be encoding
video or audio assets for use with DVDMaestro or DVDConductor — this Encoding Guide
is for you.

Note: Most Spruce DVD authoring solutions, including our turnkey Spruce DVDStations,
are equipped with Spruce Technologies encoding hardware. If you’re unsure if your
authoring system is equipped with our encoding hardware, feel free to contact Spruce
Technologies Technical Support. (Complete contact information is provided in Chapter 1
of the User’s Guide.)

We encourage you to read this Encoding Guide carefully, and to allow yourself plenty of
time to practice video and audio encoding before you embark on any major Projects.

Who Can Skip this Encoding Guide?
It’s possible you may never have to encode video or audio. For instance, you might work with
an encoding specialist who always provides you with pre-encoded video and audio files — so
that you can concentrate on the authoring process. If this applies to you, feel free to skip this
Encoding Guide. However, please be aware there are some encoding related procedures
described in this Guide, such as segment based re-encoding, that may still be of interest to you,
even if someone else is responsible for the preliminary encoding of your files.



User’s Guide for Spruce Technologies DVD Encoder Hardware6

Also, if you are using a third-party encoding system, you can skip this Encoder Guide —
although it is an excellent guide to some of the very powerful and integrated encoding
features you’ll be missing by not using Spruce encoding hardware!

Note: All Spruce authoring software also works with any MPEG-2/MPEG-1 encoding
system conforming to the requirements of the DVD-Video Specification; that is, as long as
your encoding system is able to produce DVD-V-compatible files, your Spruce authoring
software will be able to integrate them perfectly into your Project.

A Fully Integrated Approach to Encoding

Both DVDMaestro and DVDConductor have a software feature called the Encoder Control
Panel — which delivers built-in, direct support for high-quality video and audio encoding
(also known as “capturing” or “digitizing”).

When used with Spruce Technologies MPX, MP2,  and ACX-series encoding hardware, the
Encoder Control Panel provides a complete solution to MPEG and AC-3 encoding that is
fully integrated into the DVD authoring process. As we’ll see, this “integrated encoder
control” approach provides many benefits.

As an alternative approach, some facilities may wish to configure MPEG/AC-3 encoding
and DVD authoring in separate workstations, connected by a fast network — so that one
or more people can be capturing video and audio, while others are strictly authoring titles.
This approach is ideal for high-throughput, even around-the-clock operation. Spruce
authoring software and hardware fully support this mode of operation.

Special Notes for Configuring
Separate Encoding & Authoring Systems
As detailed in the Quickstart Guide, DVDMaestro and DVDConductor software utilize a
software key (“dongle”) that attaches to your PC’s parallel port and is necessary to run
either application.

We’ve made it possible for you to configure an encoding station separate from the author-
ing station — without having to purchase a second copy of DVDMaestro or DVDConduc-
tor for the encoding station. All that is necessary is to secure the appropriate encoding
hardware from Spruce Technologies for your encoding-only station. Then, with 

your
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software key connected to the encoding station’s parallel port, you can install DVDMaestro or
DVDConductor on this machine as normal. Once installed, you can remove the software key
and connect (or reconnect) it to your authoring station’s parallel port.

At this point, you’ll be able to run Spruce Technologies’ standalone encoder application —
known as “MpegEncodingStation” — on the encoder station. This application does not
require a software key and presents exactly the same interface as DVDMaestro’s or
DVDConductor’s integrated Encoder Control Panel feature.

Note: For efficient operation, both stations should be connected on a fast network, either
100base-T Ethernet or higher performance network such as Fibre Channel. Alternately,
some facilities may choose to pass files from the encoding station to the authoring station
using removable hard drives or other portable media.

Basic Encoding Concepts

Before we look at the Encoder Control Panel’s many functions and parameters in detail,
let’s take a quick overview of how to encode video and audio.

Note: This overview assumes you have a suitable video/audio source transport connected to
your authoring system. This can be a single transport, digital or analog, that supports full serial
(“9-pin”) machine control, such as a Digital Betacam™ or Beta SP™ video tape recorder, or a
9-pin compatible DAT audio recorder such as a DA98, DA88, or PCM800. Should your source
transport lack serial control capability, we’ve also included notes for performing manual-
controlled encoding.

The Big Picture

 Here are the basic steps of the encoding process that we’ll be reviewing in this section:

• First, you’ll open the Encoder Control Panel and verify that your source transport is
properly connected, not only for video and audio signals, but also for machine control
and possibly linear timecode. (Using machine control, you’ll be able to control your
source transport directly from your Spruce authoring software, which, as we’ll cover,
offers many advantages.)
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• Next, you’ll define the timecode in and out points for the source tape. This way, your
Spruce authoring software can effectively automate the process of cueing up the
source tape to the exact location where you want to begin the encoding process, and
stopping the tape at the exact location where you want to end encoding

• Then you’ll establish (and verify) the video and audio I/O (in and out) connections to
and from your authoring system.

• Next, you’ll set the encode mode and bit-rate. Since higher bit-rates require more
storage space (on both your hard drive and the final, replicated disc), we’ll introduce
some basic calculations you’ll need to perform in order to set the correct bit-rate. For
more information on bit-budgeting, please refer to the section entitled “Optimizing
the Bit-Rate” later in this User’s Guide.

• Once these parameters are established, you can start encoding.

• When encoding is complete, you’ll want to review the results.

• Finally, once you’re happy with the encoded file, you can open it in DVDMaestro or
DVDConductor, and begin (or continue) authoring.

Let’s get started…

Opening the Encoder Control Panel
Your Spruce authoring software’s Encoder Control Panel is what you’ll use to perform
encoding. In addition to MPEG encoding of analog or digital video signal’s onto your
authoring system’s hard drive(s), the Encoder Control Panel supports many features de-
signed to speed the encoding process, including machine control, timecode in and out
points, and more.

To open the Encoder Control Panel:

• From the Tools pull-down menu, select ENCODE.

– or –

• Press ALT - N on the keyboard

– or –

• Click once on the “camcorder” icon in the Toolbar

The “busy” icon will appear as the encode control software starts up. After a few seconds,
the Encoder Control Panel will appear.
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The Encoder Control Panel provides all functions required for MPEG-2 and Dolby AC-3 encoding
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Verifying Serial Machine Control
Once the Encoder Control Panel appears, you should verify that your source transport is
connected and operating properly (assuming that you are using a serially-controlled source
for video and audio).

Note: If you are not using a serially-controlled transport, then proceed to the section
Verifying Video and Audio Input below.

To verify operation of the source transport under serial control:

1. Look in the Transport Status field found in the topmost portion of the Encoder Control
Panel. This is where you can view the status of machine control.

2. If a compatible serially-controlled transport is connected and operating properly, you
will see the following:

 

3. If a compatible transport is not detected, you will see a NO TAPE DECK SOURCE message
in the Tape Deck Control:

From left to right, the transport control buttons (and their functions) are: Rewind, Frame, Step back, Stop, Play,
Pause, Frame Step Forward, Fast Forward, and Eject.

If you are using a compatible transport and you see the message above, then check
the following points:

° Is the source transport properly connected to the correct serial port? (This could be
either one of the computer COM ports or the correct serial control port on the
MPX2000 card.)

° Is the source transport switched on?
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4. Once you have located and corrected the fault in connection or the deck’s power
status, click on the Re-Scan button next to the Transport Status field. The system will
query the serial port once again to locate the connected transport. You should now
see the transport connection indicated.

5. If the transport is properly connected and turned on, but has not been switched to its
serial control mode, you will see the following message:

If you see this message, switch the source deck into its remote (9-pin) serial control
mode. The change in mode will be recognized without the need to re-scan.

Once the source transport is properly recognized, you may wish to test the system’s
control via the transport controls.

To verify operation of the source transport:

1. Insert a tape into the source transport.

2. Click the Play button in the transport controls in the Tape Deck Control portion of
the Encoder Control Panel.

3. You should see the number moving in the Tape Position window.

If you have a video and audio monitor system connected directly to the source deck, you
should see and hear the program material. You will not be able to monitor the material
from your Spruce decoder card’s video and audio outputs, however, until you begin actual
encoding.

If you wish, you can try the other transport controls in the Tape Deck Control section,
including the Cue Control slider.

Setting Timecode In & Out Points
Note: If you are performing manually controlled encoding — that is, you are not using
your Spruce authoring software’s machine control capabilities — then you can skip ahead
to the next section.
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You can now enter the In (start) and Out (end) timecodes. These values are expressed in
the standard hours:minutes:seconds:frames.

The Encoder Control section of the Encoder Control Panel, showing the In and Out fields for the start and end
timecodes (respectively).

By entering these In and Out times, your Spruce authoring software can automatically cue
up the source tape to play where you want to begin encoding and stop where you want to
end encoding (assuming you’re using a source deck that supports serial machine control).

Note: Before you can enter these time points, you must make sure the Encoder Control
section of the Encoder Control Panel is not set for Manual Encode; that is, the MANUAL

ENCODE checkbox is not selected. Also note that should the Encoder Control Panel be
closed while the MANUAL ENCODE checkbox is selected (i.e., without serial machine control
enabled), it will default to Manual Encode mode once restarted. In this case — even if a
compatible source deck is found via re-scanning — should you want to perform machine-
controlled encoding, you’ll need to ensure the Encoder Control Panel is not set for Manual
Encode.

Note: The Encoder always opens with its last known state.
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The Encoder Control section will now appear similarly to as shown below:

A typical view of the Encoder Control section, showing the In, Out, and Length values for the segment about to be
encoded.

You may enter timecodes into the In and Out fields directly by typing in the window or
you can “grab” timecodes by cueing the source deck and clicking on the corresponding
button to the left of the In or Out field. You may also define a section to encode by enter-
ing the In point only, then entering an interval of time into the Length field. When you
press ENTER, the system will calculate an Out time based on the In point and the specified
Length.

For your first encoding exercise, we recommend using a very short segment, perhaps one
minute or less. This way you can experiment without waiting a long time for each encode
to complete.

To enter encoding In and Out times:

• Click on the In time field and type in a timecode that matches a point on the source
tape you are using and press ENTER on the keyboard.

– or –

• Cue the source tape to a point you want to use as the start of encode and click on the
In: button.
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The timecode at which the deck is cued will appear in the In field.

• Enter the desired Out point in the Out: field by typing, then press Enter on the
keyboard.

– or –

• Cue the source tape to a point you want to use as the start of encode and click on the
Out: button.

– or –

• Enter a time interval (such as 00:01:00:00) in the Length field and press the Enter key
on the keyboard.

The value calculated from the previously entered In time and the Length will appear in the
Out field.

Note: If you are using Spruce Technologies MPX2000 encoding hardware, you may see a
message appear when you enter the Out or Length timecode that indicates that the Out
time has been adjusted by one or two frames. This occurs because the MPX2000 hardware
is less able to adjust its MPEG GOP (Group of Pictures; we’ll have more to say about this
later) than the MPX3000. This will not matter for this exercise, so simply click OK if you see
this message.

Once the timecode In and Out points are entered, you’ll want to verify that video and
audio data are reaching the encoder board.

Selecting Video & Audio Inputs
Next, you’ll want to verify that video and audio data are reaching the encoder board.

Note: This step should be performed whether you’re performing machine-controlled or
manually controlled encoding.

If you are using digital video and audio sources with professional-format outputs (SDI for
video, AES/EBU or S/PDIF for audio) — such as Digital Betacam — then the source outputs
are connected directly to the inputs of the encoder card. If however, you are using analog
source devices, these are routed to a Spruce Technologies Digital Connect Box (DBH100)
or another analog-to-digital converter box which converts them to digital format. The
outputs of the Digital Connect Box or other D/A converter boxes then feed the converted
signal directly to the encoder card.
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If you are using analog source with the DBH100 Digital Connect Box, then you will need
to verify correct setting of the unit before you can encode. The Digital Connect Box is
controlled a serial port connected to either the computer’s COM port or, in the case of
MPX2000 hardware, to one of the serial ports. Your Spruce authoring software communi-
cates directly to the Digital Connect Box to determine which of its inputs is selected. With
other analog-to-digital conversion boxes, you may have to change the settings directly on
the box itself.

Opening the Settings window from within the Encoder Control Panel.

To set up the Digital Connect Box under serial control:

1. In the Encoder Control Panel, go to the Tools menu and select SETTINGS WINDOW.

– or –

Press the key combination ALT -V - S on the keyboard.

2. The Settings window will appear. You should see the Digital Connect tab displayed
as shown below. (If you do not see this window, turn to “Is the Digital Connect Tab
Missing?” later in this User’s Guide.)
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3. In the Digital Connect section (tab) of the Encoder Settings window, set the Video
Input to the appropriate analog video connection.

Note: For analog video input, a 3-wire component video connection (either RGB or
YUV) is recommended for best quality. If your source transport does not provide these
you can use S-Video or Composite.

4. Set the Video Standard (PAL or NTSC) to match the source material and transport.

5. For the audio input, select balanced (+4 dBu) or Unbalanced (–10 dBu) as appropri-
ate.

6. Set the Audio Sample Rate to 48 KHZ. (If you have “DVD compliant” checked under
the OPTIONS pull-down menu, the Audio Sample Rate will be set to 48 kHz and
cannot be changed.)

7. Set the Audio Sync to SLAVE TO VIDEO. This setting is important for encoding longer
segments (long–form encoding), as drift in audio/video sync can result if the audio
sample rate is not locked to a video clock reference. (This should always be selected
if both analog audio and video are connected to the digital connect box.)

8. Once you have completed these settings, you’re ready to verify the video and audio
input, which we’ll describe in the next section.
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Is the Digital Connect Tab Missing?

If you do not see the Digital Connect tab in this window, check the following points:

• Ensure that the Digital Connect box is properly connected to the correct serial port
(either COM port on the computer, or the correct serial port of MPX2000).

• Ensure that the Digital Connect box is powered on.

Note: If you are using another type of analog-to-digital converter, you will not see the
Digital Connect tab.

Once you have located and corrected the fault, close the Encoder Control Panel com-
pletely and reopen it. This reinitializes its link to the Digital Connect Box. Then open the
Settings window again.

If the application still does not recognize the Digital Connect Box, switch the unit off and
on again, then close and reopen the Encoder Control Panel and Settings window. If you
cannot establish communication with the unit (as shown by the Digital Connect tab in the
Settings window) after carefully verifying all connections and power–cycling the unit,
contact Spruce Technologies Technical Support for assistance.

Verifying Video & Audio Input
At this point, it is a good idea to verify that video and audio data are reaching the encoder
and the encoder itself is working correctly.

To do this, we will operate the encoder in its Preview mode, with Manual Encode en-
gaged. This allows us to run the encoder end-to-end, including decoding to video and
audio outputs, without actually writing data to the hard disk.

To test video and audio input and encoder throughput:

1. Set up the Encoder Control section of the Encoder Control Panel exactly as shown below:
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2. Confirm the following settings:

° ENCODE SOURCE FOR VIDEO is set to MPX3000 or MPX2000.

° ENCODE SOURCE FOR AUDIO is set to AC-3 (2 Ch. or 5.1).

° PREVIEW ONLY checkbox is selected.

° MANUAL ENCODE checkbox is selected.

3. Start your source transport (by manually pressing its Play button).

Note: Ensure that your source material has both video and audio content and that
your source transports is set to reproduce both the video and the appropriate audio
track(s).

4. Click on the large Encode Start button in the Encoder Control section.

5. You will first see the message DOWNLOADING ENCODER PARAMETER in the Status field at
bottom of the Encoder Control section, followed in a few seconds by the message
CAPTURING. In a few more seconds you should see video from the decoder card, along
with audio from your audio monitoring system.

In the event that you do not see and hear picture and sound from the decoding hardware,
first verify that your video and audio monitoring system is properly connected and
switched to receive the output of the Spruce decoder. Then verify that the source signal is
properly connected and the correct inputs to the Digital Connect Box (if used) are selected.
If you still cannot locate the fault, please contact Spruce Technologies Technical Support
for assistance.

Once you are able to see picture and sound from the decoder, click once more on the
large Encode Start/Stop button to terminate the encode Preview mode. This will also halt
the source transport (assuming it is configured for machine control; otherwise, you’ll need
to stop it manually).

Setting the Encoding Mode & Bit-Rate
After verifying the source video connection and operation using the Preview mode, you
will want to define the video encoding mode as CBR (Constant Bit-Rate). (The alternative
modes are 1- and 2-pass Variable Bit-Rate, or VBR, but we will explore those modes later.)
You will also want to make sure that the encoding bit-rate is set appropriately.
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There are a number of parameters that can be set in MPEG encoding but in most situations
these two parameters — encoding mode and bit-rate — are the two key items. You should
never encode video for any serious undertaking without verifying that these are appropri-
ately set for the conditions and use at hand.

Encoding mode and bit-rate are specified in the Settings window — which, if you are using
analog sources, you opened previously when you defined the encoding inputs. This dialog
includes settings for all of the variable parameters of video and audio encoding.

To prepare to define the encoding mode and bit-rate for video:

1. If the Settings window is not already open, select SETTINGS WINDOW from the Tools
pull-down menu (keyboard shortcut: ALT - V - S).

2. In the Settings window, select the tab labeled MPEG VIDEO ENCODER.

3. The settings for MPEG encoding parameters will appear as shown below:

The Encoder Settings Window as seen with the MPX3000. GOP sizes will appear different with the MPX2000.

The settings we are interested in now are found in the left-hand portion of the Quantiza-
tion section at top of the dialog. (For now, ignore the rest of the parameter settings.)

The first parameter to set is the encoding mode. For this encoding exercise, set this to CBR
(Constant Bit-Rate). This is the most straightforward encoding mode and for many pur-
poses, it is the superior choice. Later, we will explore the considerations and conditions
under which you may wish to use Variable Bit-rate (VBR) encoding.
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Selecting CBR encoding mode.

To set the encoding mode for CBR in the Settings window:

1. Click with the mouse to pull down the menu from the Mode selection area of the
Quantization window, as shown immediately above.

2. Select CBR, the topmost selection.

Next, you’ll set the Bit-Rate field to 8,000,000, or 8 Mbps (megabits per second).

Note: 8 Mbps is the maximum rate recommended for CBR encoding. The DVD-Video
Specification implies that slightly higher video bit-rates can be used, but real-life experi-
ence shows that many consumer DVD players have problems with sustained video bit-
rates higher than 8 Mbps. We have also found that little or no improvement can be
realized by increasing the bit-rate above this figure. Therefore, for DVD authoring pur-
poses, we recommend you limit encoding bit-rate to 8 Mbps.

Setting the bit-rate.
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To set the video bit-rate to 8 Mbps:

1. Click on the Bit-Rate pull-down menu in the Quantization section of the Settings
window, as shown on the previous page.

2. Select 8,000,000 from the menu.

– or –

1. Select the numeral area of the Bit-Rate field.

2. Type in the number 8000000. Do not enter commas.

Typing figures lets you set a more precise video encoding bit-rate — but in this case, the
desired figure is available by either method.

Selecting the Audio (“AC3 Audio Encoder”) Settings
While you are in the Settings window, you will want to also set the parameters for audio.
For this exercise, we will assume you are encoding stereo audio only. For details on
encoding of 5.1 surround audio, refer to the section later in this Encoding Guide.

The Audio settings are set using the AC3 Audio Encoder tab of the Settings window.
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To set parameters for audio encoding:

1. Open the Settings window (as described earlier) and select the tab labeled AC3 AUDIO

ENCODER.

2. Check the Audio Coding Mode setting. For stereo encoding, this should read 2/0; L,R.

3. After verifying the Audio Coding Mode, set the Data Rate field. We recommend a
setting of 224 kbps for AC-3 stereo.

Note: Dolby actually recommends a setting of 192 kbps, but we have found that a
setting of 224 kbps improves high-end response noticeably.

Setting Up for “LTC-Trigger” Audio Encoding

In the lower left region of the AC3 Audio Encoder settings tab, you’ll notice the LTC button
— a little yellow button that resembles a watch or a clock. This button may be selected if
(and only if) you have an LTC (linear, or longitudinal timecode) connection from the
source deck. In that case, audio encoding will be triggered from LTC input. Otherwise,
triggering for audio encode comes from the 9-pin serial control, as for video.

If the required LTC connection is available, then we recommend you always select this
button, as “LTC-trigger” audio encoding is more accurate than that from the 9-pin serial
control port used for video.

To set up for LTC-trigger audio encoding:

1. Assuming you have a connection for Longitudinal Timecode (LTC) from the source
deck to the audio encoder, click once on the LTC (“watch”) button at lower left. (It
turns yellow when selected.)

2. You have now armed the audio encoder for LTC-trigger.

Initiating Video & Audio Encoding
Finally, we are ready to encode. Actually, although several pages have been spent describ-
ing the steps leading up to this point, in practice you’ll find that you do not need to repeat
most of them each time you encode, and your setup and encoding will be quite efficient.

Having set up our parameters and In/Out timecodes, all you need to do is verify your
mode settings and click the Start button.
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This screenshot shows the starting state for encoding with and without machine control.

To set up and perform encoding:

1. In the Encoder Control section of the Encoder Control Panel, make sure that the
Preview Only checkbox is not selected.

2. If you are using serial machine control, deselect the Manual Encode checkbox.

Note: If you do not have serial machine control, deselection is not possible.

– or –

If you are encoding without serial machine control, then enter a value of 1 minute of
less into the Length field. This will define the length of encoding. If it is set to
00:00:00:00, then Manual Encode will continue until it is stopped by clicking the
Start/Stop button again.

3. Now you can begin encoding by clicking once on the large Start/Stop button in the
Encoder Control section. When you click this button, you will see the following
dialog appear that lets you define the filename and location of the MPEG and AC-3
files to be created:
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4. In the Save dialog, navigate to your main data drive (such as E: or F:). (If this is your
first attempt at encoding, you can use the Folder create button in the dialog to make
a new folder. Name this folder “Test Encode,” then open the newly created folder by
double-clicking on it.)

5. Enter the desired File name (such as “Test 1”) and click SAVE.
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6. If you are using serial machine control:

° Your source transport will automatically cue up to a point before the In time that
you entered; once it reaches this point, the transport drops into play.

° As it reaches the timecode of the predetermined In point, the Start/Stop button in
the Encoder Control section changes color to red, indicating that encoding is now in
progress.

° A few seconds later, the decoded preview output will begin playing back through
your video and audio monitor systems; the RealView Previewer will also launch and
simultaneously display the video on your computer display (and your PAL or NTSC
monitor if it is properly connected to the back of the Cinemaster card).

– or –

If you are not using serial machine control:

° Manually start your source deck. (It’s a good idea to have cued up the tape to one
or two seconds before the desired starting point, so that the transport is running
stable and providing clear video playback.)

° Press the Start/Stop button in the Encoder Control section (the button will turn red,
indicating that you’ve initiated encoding).

° A few seconds later, the decoded preview output will begin playing back through
your video and audio monitor systems; the RealView Previewer will also launch and
simultaneously display the video on your computer display.
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Note: Preview is always created by decoding the captured and encoded input — so
what you see is what you get. The image and sound in the preview always exactly
reflects the results in the captured file.

During encoding, the status field of the Encoder Control section will indicate that you are CAPTURING [FILE NAME], as
shown above. At the same time, the RealView Previewer will launch and display the encoded video in real time.

7. If you are using serial machine control, once the source deck reaches the end of the
defined segment:

° The system will automatically drop out of encoding.

° The source transport will automatically stop.

° Your Spruce authoring software will prompt you to load the encoded asset into the
decoder section for review.

– or –

If you are not using serial machine control, once the source transport reaches the end
of the material you wish to encode:

° Press the Start/Stop button in the Encoder Control section; this will stop the encod-
ing process.

° Manually stop your source deck.

° Your Spruce authoring software will prompt you to load the encoded asset into the
decoder section for review.

Note: If you entered a value in the Length field, the numbers will decrement until
00:00:00:00, at which point the encoding will stop.
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8. In the File Preview prompt, select YES (keyboard shortcut: ALT - Y) to load the file into
the decoder for review.

9. The captured video and audio files will be loaded into the Decoder section of the
Encoder Control Panel and automatically synchronized — ready for your review.

Congratulations! You have just encoded your first video and audio using your Spruce
Technologies system.

What Files were Created During this Encoding Session?

If you use the Windows Explorer to view the contents of the directory created previously,
you will see the following items:

You will note that there is one large file with the extension “.m2v” or “.vbs” (with
MPX2000 hardware) and one much smaller file with extension “.ac3”. These are the main
video and audio files.
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You will also notice that each of these files is accompanied by a small “parameter” file that
adds extension “.PRV” (video) or “.PRA” (audio) to the name of the main file. These
parameter files contain information about the contents of the main file and are used by the
authoring system.

Note: Do not delete any of these files, as they are required for authoring!

Reviewing the Results of Encoding
Now that you have completed encoding and loaded the resulting video and audio files
into the decoder, you can review the results using the Decoder section of the Encoder
Control Panel.

From left to right, the Decoder buttons and their functions are: Return to Beginning of File, Play, Pause, and Single
Step Forward.

To playback encoded video loaded into the Decoder Control section:

1. Click on the “Play” button (right-facing arrow) in the transport controls of the De-
coder Control section.

2. Video playback will start immediately, along with synchronized audio.

Note: If you don’t wish to audition the audio during video playback, simply select the
MUTE AUDIO checkbox.

3. Playback will terminate when the end of the file is reached.
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There are several options available in the Decoder Control section that facilitate quality
assurance of encoded video and audio. The Slow Motion checkbox and the “Single-Step”
button (two vertical bars with right-facing arrow) are particularly useful in review.

Note: Audio playback will occur only during normal full-speed (1x) playback; with Slow
Motion or Single-Step playback, audio will be muted. As noted, audio can be intentionally
muted during normal playback by selecting MUTE AUDIO.

With these controls, you can locate and clearly identify any areas that may need special
attention. However, we also recommend viewing the suspect area using normal full-speed
playback — since it is in the nature of compressed video that some artifacts visible in “slo-
mo” or still frame playback are simply not visible at normal speed.

Another control useful for review is the Location slider in the middle of the Decoder
Control section. This can be used to cue playback from any desired point in the video
track. When you move the slider, the thumbnail display to its right shows the current frame
in real time. Once you park the slider, you can use the Single-Step or Play buttons to see
video starting at that location.

Now that you have set up the Encoder Control Panel and have an understanding of how to
encode files, you may wish to encode additional segments before you proceed to the next
step — which is to close the Encoder Control Panel and then to load the captured files into
the Spruce authoring environment.

Exiting the Encoder Control Panel
As long as the Encoder Control Panel is open, you can encode as many segments as you
wish, with different parameter settings and so on. Once you finish your encoding session
and have finished reviewing the results, you’re ready to close the Encoder Control Panel
and load the encoded files into DVDMaestro or DVDConductor.

Note: If you are using the Standalone Encoding application on a separate workstation, then
this section does not apply. In that case, the normal procedure will be to transfer encoded
files from the encoding system to the authoring system using a fast network or other means
of transfer. The files are then opened into the Assets Bin as described in Chapter 5 of your
User’s Guide.
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To close the Encoder Control Panel and load encoded files into the Assets Bin.

1. From the Encoder Control Panel File menu, click EXIT.

– or –

Use the key combination (ALT - F - X) from the keyboard.

– or –

Click on the small “x” at upper right of the Encoder Control Panel.

2. Whichever method you use, the following prompt will appear:

3. In the prompt dialog, select YES (keyboard shortcut: ALT - Y). The following dialog will
now appear:
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4. This dialog lists the files that you captured during your encoding session. All selected
files will be loaded into the Assets Bin when you click OK or hit RETURN on your
keyboard. You may de-select any files you do not wish to load by holding down the
CTRL key on your keyboard and clicking on the files to be de-selected.

5. Click OK or hit RETURN on your keyboard.

6. The selected files will appear immediately in the Assets Bin, as shown here:

From here you can load these files into DVD Movies or DVD Menus as normal and
resume authoring.
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Choosing the Encoding Mode
(CBR, 1-Pass, or 2-Pass VBR)

Besides determining an optimal bit-rate before you begin serious encoding, you will also
need to make a decision about which encoding mode you’ll use — Constant Bit-Rate, 1-
Pass Variable Bit-Rate or 2-Pass Variable Bit-Rate. Earlier in this Encoding Guide we noted
that for shorter program material, high-rate CBR is the way to go. Other situations may not
be so clear. Here are some notes on the characteristics and relative advantages and
disadvantages of each mode…

Constant Bit-rate (CBR) Encoding
CBR encoding has the advantage of being by far the most straightforward mode of encod-
ing and, as noted before, it gives excellent results as long as bit-rates can be kept fairly
high (generally 6 to 8 Mbps; possibly less if the material easy to encode).

The disadvantage of CBR is that it usually cannot be used on long-form material. The
reason is that the overall bit-rate, as yielded by calculation, is likely to fall beneath the
range that CBR can be trusted to encode with high quality.

Therefore, CBR is best used on material of short duration, where a high bit-rate setting can
be used. In Projects that compile many short clips into a longer piece, it also may be more
productive to encode at high-bit-rate CBR and replicate on DVD-9 or DVD-10 than to
spend the time needed to get satisfactory results with VBR on so many short pieces.

1-Pass Variable Bit-Rate (1-Pass VBR) Encoding
As the name implies, 1-Pass VBR uses some of the technology of 2-Pass VBR, but in a
single pass through the tape. With 1-Pass VBR, the bit-rate is varied “on the fly,” in direct
correspondence to the complexity of the video program material. For instance, with “easy”
material, such as talking heads, or a static landscape vista, the bit-rate might be relatively
low; with “complex” material, such as a car chase, or an action sequence with a lot of
wipes or other complex transitions, the bit-rate can rise dramatically.

The primary advantage of 1-Pass VBR over CBR is that with a given setting of the Bit-Rate
parameter (which is not necessarily the bit-rate that results in this case) it may give more
satisfactory results than with CBR; that is, the encoded files may simply look better. And as
we’ll learn more about, the advantage of 1-Pass VBR over 2-Pass VBR is that it’s a rela-
tively faster process. However….
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The disadvantages of 1-Pass VBR, it turns out, are rather severe. The nature of the process
is that the Bit-Rate parameter defined in the Setting window is only a starting point. During
the encode pass, the system will go to a higher rate (with a defined ceiling), whenever it is
deduced to be necessary, without regard to the effect on overall bit-rate and file size.

The result is that when you encode with 1-Pass VBR selected, you have no way of know-
ing what the size of the resulting file will be until the encode pass is complete — and
hence there is no way to effectively optimize settings. In some cases, the effective bit-rate
of 1-Pass VBR may be 60% higher than that of CBR, or even more — which may mean
than that files that would otherwise fit on the disc might prove too large when encoded
with 1-Pass VBR.

There is one situation in which 1-Pass VBR may be used effectively to improve quality
without losing control over file size: when the source material consists of relatively easy
material — such as talking heads, or karaoke-style music videos — interspersed with
crossfades and other transitions that are more difficult to encode. In this case, the “spikes”
of bit-rate at the transitions will occupy relatively little of the overall time and the contribu-
tion to increasing file size will be consequently smaller. In this case, you may get a 

good

result by setting the Bit-Rate parameter a little lower than the optimal CBR value calculated and
running as 1-Pass VBR. However, you must always be sure to check the size of the resulting
files to make sure you are not overflowing the capacity of the target format.

2-Pass Variable Bit-Rate (2-Pass VBR) Encoding
With 2-Pass VBR, you can combine the visual benefits of 1-Pass VBR with the space-
efficiency benefits of CBR.

The 2-Pass Variable Bit-Rate encoding is not available in the standard version of DVD-
Conductor. This feature may be added by installing the DVDEncoderPack upgrade.

As the name implies, 2-Pass VBR operates as follows: First the entire length of material is
played through the encoding system and analyzed in what is known as a “profiling” pass.
During this pass, no actual encoding is performed. The system, however, examines the
source stream frame-by-frame and determines how difficult each frame (or group or
frames) will be to encode.
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After the profiling pass, the system then calculates a bit-rate curve, or “profile,” based on
the information obtained during the profiling pass along with the settings you’ve chosen in
the Settings window for Average, Peak, and Minimum Bit-Rate. The resulting curve is
calculated to respect these limits and deliver a file whose size is equivalent (within a
margin) to the same length of material encoded in CBR at the average rate.

Finally, the material is played again through the system. During this second pass, the
system performs the actual encoding — varying the bit-rate along with the picture, to
deliver a result that is optimized for every frame or group of frames.

2-Pass VBR can be very useful, but it is not magic. It works best on longer-form material
where it has a chance to balance hard-to-encode scenes against easier material. Likewise,
it has the most “room” to work when you have a mix of easy and complex material in the
pass you wish to encode. If you have a 2-hour program that is fast-action, difficult-to-
encode material from one end to the other, then 2-Pass VBR will not yield the best results.

The biggest disadvantage of 2-Pass VBR is that it takes much more time than either CBR or
1-Pass VBR. At the very minimum, it will require at least twice as much time as the length
of the material you wish to encode. In practice, however, it takes longer than that from
start to finish. Furthermore, during the quality assurance process, you’ll likely discover
sections of the material that are not fully optimized. These must then be “hand-encoded”
using your Spruce authoring software’s segment re-encoding feature — until the results are
as desired. This requires not only lots of time but highly skilled personnel.

Also, one should not make the mistake of automatically assuming that 2-Pass VBR will
give a better result than CBR at the same rate. VBR introduces much more complexity into
the encoding process, with concomitant possibilities for error. Especially with shorter
material, 2-Pass VBR may actually introduce more problems than it alleviates.

That said, 2-Pass VBR is close to being a standard for encoding of feature films — a key
technology that allows full-length motion pictures to be delivered in the 4.7GB DVD-5
format with very good quality. Even as larger-capacity DVD formats (such as DVD-9) move
into the forefront, 2-Pass VBR continues to be an important means of increasing play time
for a given disc size.

User’s Guide for Spruce Technologies DVD Encoder Hardware 35

Encoding with 2-Pass VBR

The basic operation of 2-Pass VBR is fairly simple. All you need to do is select the 2-Pass
VBR mode, set the maximum and minimum bit-rates and set the overall bit-rate.

Hardware & Software Requirements
Encoding with 2-Pass VBR requires the use of a source video transport that supports serial
machine control. Otherwise there is no way for the system to align the two passes.

Setting Maximum, Minimum, & Overall Bit-Rate
When you select 2-Pass VBR mode in the Settings window, the Quantization section of the
MPEG Video Encoder tab will show a total of three bit-rate fields (located near the top
center of the following screenshot):

The Quantization section of the MPEG Video Encoder tab has three bit-rate fields.
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The middle Bit-Rate field (BITRATE) indicates the overall, or average, bit-rate that will be
applied. The number entered here is the same number that one would use to encode with
CBR.

The Maximum Bit-Rate field (MAX. BITRATE) indicates the peak of the VBR encoding curve.
The value set here needs to be calculated with respect to the maximum total bit-rate
allowed by the DVD-Video Specification and the audio program material to be included.
As a rule, therefore, you should avoid going above 8.5 Mbps (8,500,000 bps) as a maxi-
mum bit-rate for 2-Pass VBR. You won’t notice much difference going higher and you
should allow extra headroom for audio and safety.

The Minimum Bit-Rate field (MIN. BITRATE) indicates the floor beneath which the bit-rate will
not be allowed to dip. This is a “soft” quantity whose optimal setting may be determined
with experience. For most material, we recommend the default setting of 2 Mbps
(2,000,000 bps). As a rule, you should never go below this setting as it will introduce
severe artifacting at certain points in the bitstream.

Executing the 2-Pass VBR
Once you have set the encoding mode and the overall, maximum, and minimum bit-rates,
starting the encoding process is the same as for CBR encoding. Simply press the Start/Stop
button in the Encoder Control section, then set a name a storage location for the file to be
created.

Next, the system will cue up the tape, then roll it through the full length of the segment to
be encoded while displaying the message COLLECTING STATISTICS in the Encode Status field.
During this time, no decoder output is visible or audible.
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After you press the Start/Stop button in the Encoder Control section to begin 2-pass VBR encoding, the system will
roll through the entire desired segment to collect information, as shown by the COLLECTING STATISTICS message in the
status field.

Once the system completes this first pass, it will cue the tape back to the preroll to a point
before the In point, then roll the tape once more.

Once actual encoding begins, the status field will indicate CAPTURING [FILE NAME]. At the same time, the RealView
Previewer will launch and display the encoded video.

This time, the system will begin actual encoding, the RealView Previewer will launch, and
the decoded picture and sound will be fed monitoring system attached to the to the
decoder card’s respective outputs.
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Once the second (capture) pass is complete, the system will halt and present a dialog to
load the encoded video and audio files into the decoder, just as with CBR encoding.

Reviewing a 2-Pass VBR Encoding
After encoding a segment in 2-Pass VBR mode, we recommend you review it carefully.
Due to the nature of 2-Pass VBR encoding, it’s possible for the encoded result to look quite
acceptable in most of the stream, but to have problems in particular segments. Individual
problem areas may be addressed by using your Spruce authoring software’s segment re-
encoding features, as detailed next.

Segment Re-encoding

Your Spruce authoring software includes a very useful feature known as “segment re-
encoding.” This is the capability to re-encode individual sections of video, with individu-
ally set bit-rate and other parameters, without having to re-encode the entire asset from
start to finish.

Segment-based re-encoding is not available in the standard version of DVDConductor. It
may be added by installing the DVDEncoderPack upgrade.

These re-encoded segments are then inserted seamlessly in to the video track — making it
possible to completely optimize the results of 2-Pass VBR encoding. Segment re-encoding
is mostly performed from within the Spruce authoring environment.

Note: To explain segment re-encoding, we’ll be discussing DVD Movies and some related
terms. If you need definitions for these terms, or need general information about working
with DVD Movies, please refer to Chapter 6 of your User’s Guide.

First, we will need to load the encoded files into the DVD Movie, where we can isolate
sections for re-encoding.
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To load the encoded files into the DVD Movie:

1. Close the Encoding Control window, and load the encoded files into the Assets Bin,
as described earlier in this Encoding Guide.

2. Open a DVD Movie by double-clicking on its icon in the Project Manager. If you
wish, expand the DVD Movie window to fill the Workspace.

3. Place the encoded MPEG file into the video timeline by dragging it from the Assets
Bin.

From within the Marker Timescale, you can drag the PlayCursor back and forth to identify
the beginning and end of any sections that need to be re-encoded. (The Thumbnail
Previewer will display a video image of the PlayCursor’s current location.)

Note: The video track for the desired video asset shows a continuous “graph” of the bit-
rate as defined and executed in 2-Pass VBR.
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There are two reasons why you might use segment-based re-encoding of video:

• Specific sections of video need to be re-encoded with different parameters in order to
optimize picture quality.

– or –

• A portion of video content has changed and you would like to update it without re-
encoding the entire piece.

Once you have identified a section of the existing video asset that you wish to re-encode
— either to optimize picture quality or to replace an asset that has been changed — the
next step is to mark a “Punch-In” and a “Punch-Out.” These two punch Markers represent,
respectively, the “in-point” (for where the re-encoded segment will begin) and the “out-
point” (for where re-encoded segment will end).

To mark a Punch-In and a Punch-Out:

1. Click in the Marker Timescale at the desired time for the Punch-In.

2. When the Edit Marker dialog opens, select the Marker Type to be PUNCH POINT. If you
wish, you can also rename the Marker and adjust its location from within the Edit
Marker dialog. When done, click OK.

Note: There is no separate Marker Type choice for “Punch-In” or “Punch-Out”; all are
considered punch point Markers. Whatever punch point Marker appears earliest
(furthest left) in the Marker Timescale will be considered the Punch-In Marker; the
punch point that appears later (furthest right) will be considered the Punch-Out
Marker.

3. The Punch-in will appear in the Marker Timeline with a distinctive red “arrowhead.”

4. If desired, you can “jog” or “scrub” the Punch-In Marker to reposition its location;
this is done by clicking once and holding its red arrowhead and then dragging it left
(earlier) or right (later) in the Marker Timescale. As you do this, the current starting
frame will appear in the Thumbnail Previewer window.

5. Now you can mark the Punch-Out by clicking once more in the Marker Timescale.
As before, select PUNCH POINT in the Edit Marker dialog. As with the Punch-In Marker,
you can also reposition the Punch-Out Marker by jogging it in the Marker Timescale.
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Place the Punch-In Marker by clicking in the Marker Timescale (above the Video Timeline). Check PUNCH POINT

then, if you wish, you can rename the Marker or adjust its location. When done, click OK. Repeat the same
procedure to set the Punch-Out Marker.
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Punch-In and Punch-Out Markers can be adjusted easily, just by dragging them as you would drag Chapter Point
Markers.

Once you’ve defined the Punch-In and Punch-Out, you’re ready to perform segment re-
encoding, of the portion contained between the markers.

As you can see above, once the Punch-In and Punch-Out have been defined, you’re ready to perform segment re-
encoding for the portion of video between the two punch point Markers.
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To perform segment re-encoding between two punch points Markers:

1. In the Video Timeline, right-click on the video asset you wish you re-encode. (A
video asset will already need to be in place in the video track.)

2. When the pop-up context menu appears, select RE-ENCODE VIDEO SEGMENT.

To initiate the segment re-encoding process, right-click in the Video Timeline and select RE-ENCODE VIDEO SEGMENT

from the pop-up context menu.

3. The Encoder Control Panel will appear onscreen over the DVD Movie (and Spruce
authoring software’s other screens).

4. You’ll notice that the Clip In and Out times in the Encoder Control section of the
Encoder Control Panel correspond, respectively, to the locations of your Punch-In
and Punch-Out Markers.

Note: Encoding is set for VIDEO ONLY, as audio is not re-encoded.
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The Encoder Control Panel, showing the Clip In and Out times corresponding to the Punch-In and Punch-Out
times. This screenshot also shows the Encoder Settings window.

5. Set all the parameters for re-encoding as you wish. If desired, you can open the
Encoder Settings window (via the Encoder Control Panel’s View pull-down menu)
and make further adjustments.

6. Once all settings have been made, click START to begin re-encoding.

7. The Name Elementary Stream(s) dialog will appear:
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Click SAVE.

Note: As you’ll see, DVDMaestro will generate a name for the re-encoded segment
file based on the name of the original file and its timecode point, numbering the files
as subsequent re-encode operations are performed. If you do not wish to use the
generated name, the dialog gives you the opportunity to assign a file name and
directory path as desired.

8. Next, just as with regular machine-controlled encoding, DVDMaestro will shuttle the
source deck to start timecode location, drop it into play and begin encoding from the
exact point defined by the Punch-In. DVDMaestro will continue encoding until it
reaches the Punch-Out time.

9. Upon reaching the Punch-Out time, DVDMaestro halts encoding and prompts you to
load the file into the Decoder Control section of the Encoder Control Panel for
review. There, you can view the re-encoded segment and perform additional re-
encode operations with different settings until you’re satisfied with the segment’s
picture quality.

10. Once you’ve completed segment re-encoding (whether you do a single re-encode
pass or many), you can close out the Encoder Control Panel by clicking on the
upper-right close box.

11. When the Encoder Control Panel closes, the last segment that you re-encoded is
automatically inserted into the video track, beginning and ending at your punch
points. The new segment appears in a lighter shade to indicate that it has been
inserted into the stream as an individual segment within the video timeline.
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The re-encoded segment, shown inserted into the middle of video track 1.

Working with Multiple Versions of a Re-Encoded Segment
If you’ve created multiple versions of a re-encoded segment, the command INSERT VIDEO

SEGMENT — included in the same pop-up menu as RE-ENCODE VIDEO SEGMENT — can be used to
choose which file you wish to insert. This way you can easily review various versions, all
in context.
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Right-clicking in the video track lets you define where the re-encoded video segment will be inserted.

Note that when you use the Insert Video Segment command, the segment is placed
according to the timecodes of the video in the segment, without regard to the placement of
Punch-In and Punch-Out points. If you create a file with segment re-encode, and then
move the punch points, the previously encoded file (if inserted via timecode) will always
insert where the punch points were at the time it was encoded.

You can perform as many segment re-encodes as you wish, even within or overlaying a
previously re-encoded segment. With the segment re-encode feature, a new dimension of
power and flexibility has been added when encoding assets for use with Spruce authoring
software.
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NTSC Film Mode (Inverse Telecine)

When material is transferred from film (with a frame rate of 24 frames per second), to
NTSC video (with a frame rate of 29.97 frames per second), the differing frame rates are
resolved by converting each frame for film into two (redundant) video fields, then repeat-
ing some of the fields in a defined pattern known as the “cadence.” The whole process is
generally known by the term “3:2 pulldown.”

The Inverse Telecine feature is not available in the standard version of DVDConductor. It
may be added by installing the DVDEncoderPack upgrade.

In MPEG encoding, these redundant video fields present two problems:

• the repeated fields represent redundant information to encode, reducing encoding
efficiency by 20%; and

• the video frames that include fields from two different film frames will show “frame-
jitter” when using the Single-Step button to view frames one at a time.

During encoding, both of these problems can be addressed by using the Inverse Telecine
option in the MPEG-2 Options section of the MPEG Video Encoder tab of the Settings
window.

The Inverse Telecine option can be found in the MPEG-2
Options section of the MPEG Video Encoder tab of the Settings window.
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When the Inverse Telecine option is selected, the encoding process will automatically
attempt to detect the redundant fields inserted during the film-to-video transfer process.
During encoding, your Spruce authoring software will then skip over these frames; after
all, there’s no need to re-encode material that has already been encoded.

In place of the repeated field, the encoding process inserts a flag that indicates that one of
the fields should be repeated. Indeed, during playback of the MPEG stream or finished
DVD disc, the decoder system reads these flags and automatically repeats the needed
field(s) — in effect, performing the film-to-video transfer process on the fly. The result is
substantially more efficient encoding (a better picture for the given bit-rate), and freedom
from frame jitter.

To execute encoding with Inverse Telecine, simply select in the Inverse Telecine checkbox
in MPEG-2 Options before you begin the encoding process.

Limitations of Inverse Telecine
The process of accurately detecting the repeated fields is complex and sensitive, and there are
many situations in which the correct “cadence” may not be detected properly, including:

• When material is shot on film, but edited on video, the cadence from the film-to-
video transfer is modified from the original. This will usually cause the Inverse
Telecine to lose the cadence at least temporarily.

• If the material is extensively edited in video (such as many TV commercial spots,
which often are shot on film and subjected to fast-cut editing), Inverse Telecine may
have no chance of ever correctly detecting the cadence of repeated frames.

• When using Inverse Telecine in 2-Pass VBR encoding (these two often go together
because 2-Pass VBR tends to provide the most benefit in use on long-form feature
films), the Inverse Telecine process may not detect frames in the same way between
the first and second pass. This can create major problems, as it may cause alignment
of a low bit-rate setting with a hard-to-encode section of video. This problem princi-
pally occurs when using an analog video source, as this format is subject to noise
that varies from play to play. When using digital video sources, this type of error is
less likely to occur.

• When video includes slow-moving material, the Inverse Telecine process may have
difficulty in distinguishing the correct fields to repeat, since it depends on a threshold
of difference between fields to make the correct decision.
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Reviewing Inverse Telecine
Once you’ve encoded with Inverse Telecine, you can check the results by using the
Single-Step button in the Decoder Control section. When the telecine cadence is properly
detected, all still frames will be perfect, without field jitter. If you encounter an error in
field detection, it will show as one of more frames whose still image is not stable. Depend-
ing on the picture, the field jitter may be very pronounced.

In the left-hand frame, the telecine cadence has been properly detected; in the right-hand frame, the blurred image
shows field jitter, which strongly suggests an error in detection. If the errors are minor and infrequent, or difficult to
notice in normal full-speed (1x) playback, they may nonetheless be acceptable.

Using segment re-encoding, you may be able to correct some or all of the Inverse Telecine
errors that occur in a program. However, depending on the material and situation, you
may find that the prevalence of cadence errors is such that encoding without Inverse
Telecine may actually give a better result. Also, identification and correction of Inverse
Telecine errors in a long program can be quite time consuming, and you may have to
judge whether the situation warrants the investment of time involved.
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MPEG Encoding Parameters

The encoding mode and bit-rate are the two MPEG encoding parameters you’ll be con-
cerned with most often. These need to be tended to (even if you decide to leave them in
their current setting) for every encoding job.

With the exception of Picture Rate (in the Video Format section, which needs to be set to
follow the standard of the incoming video signal), the other options and parameters in the
MPEG Video Encoder tab of the Setting window are typically used much less often.

In the Settings Window, select the MPEG Video Encoder tab to set the encoding mode (CBR or VBR), the bit-rate,
and other MPEG video parameters.

We’ve already detailed the Inverse Telecine function, which will be of interest only to
those of you working with program material that originated on film. The balance of this
section will go through the remaining settings and options to explain their operation and to
detail how they may be used in specific situations. In general, you’ll find that most of these
parameters may be left alone most of the time.
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All of the MPEG encoding parameters are grouped in the MPEG Video Encoder tab of the
Setting window. There are four major sections for this tab:

• the Quantization section;

• the Video Format section;

• the MPEG-2 Options section; and

• the Group of Pictures section.

Let’s review them in detail…

Quantization (CBR or VBR Encoding) Section
As we covered previously in this Encoding Guide, the Quantization section is where you
set the encoding mode — Constant Bit-Rate (CBR) or Variable Bit-Rate (VBR) — and the
actual bit-rate settings (in terms of bits per second).

There are also three optional parameters:

• Quantization Scale (1 to 16); (MPX2000 only)

• Quantization Type (Non-Linear or Linear);

• Intra DC Precision (8, 9, or 10).

Encoding mode and bit-rate are all-important parameters for DVD. MPEG quantization parameters are available for
advanced applications.

As we’ll detail, only in rare circumstances would you change the default values of these
parameters…

User’s Guide for Spruce Technologies DVD Encoder Hardware 53

Quantization Scale (Quant Scale)

Quantization Scale is a parameter that is used only in the profiling function for 1-Pass and 2-
Pass VBR encoding. It is not used in CBR encoding at all, and is greyed-out when this mode is
selected.

The Quant Scale is basically a sharpness setting, “1” being the sharpest and “16” being the
least sharp. Setting the Quant Scale to “1” allows the encoder to regulate itself and apply
compression where it will most effectively yield the best quality picture for the specified
bit rate, which works well during 1-pass encodes, depending on your encoder. (See the
note below.) On a 2-Pass VBR encode, a fixed sharpness level is set at “16” as information
on the best way to encode the stream is gathered during the first pass and applied during
the second pass; our encoders are “tuned” to this value.

At Spruce Technologies, we have done extensive testing and analysis of VBR encoding, on
a wide range of materials. Based on this research, we have arrived at default values of the
Quantization Scale parameter that are selected automatically when the 1-Pass or 2-Pass
VBR modes are selected. Our testing has demonstrated nearly conclusively that these are
in fact the optimal values, and that selecting any other value will not contribute to — and
may degrade — the results of VBR encoding.

Note for the MPX2000: In 2-pass VBR, we do not recommend changing the QUANT SCALE

value from its default of 16. In 1-pass VBR, we do not recommend changing the QUANT

SCALE value from its default value of 5.

For the MPX3000, Quant Scale settings have already been optimized for this board.
Therefore, the Quant Scale setting will not appear in the Quantization dialog if the
MPX3000 is installed in the system.

Quantization Type (Quant Type)

There are two types of quantization available in MPEG-2 video encoding: linear and non-
linear (which is the default). MPEG-1 uses linear quantization only. MPEG-2 has both
types of quantization available — though non-linear is used almost exclusively, as it
provides greater dynamic range.

Note: When MPEG-2 was defined, the non-linear quantization scale was introduced as an
across-the-board improvement on the previously used linear scale. The option of linear
scale in MPEG-2 was defined only to accommodate full backward-compatibility with
MPEG-1. There are no conditions known under which a linear quantization type would be
preferable to Non-Linear type in MPEG-2.

For MPEG-2, we recommend you always select NON-LINEAR. For MPEG-1, LINEAR is the only
option available.
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Intra-DC Precision

This parameter controls the precision that is applied to relatively non-changing (static)
portions of the picture. The legal values for DVD-Video purposes are 8, 9, and 10 bits. In
most cases, the default value of 10 is suitable. In material without subtly-shaded colora-
tion, settings of 8 or 9 bits may make it possible to use somewhat lower bit-rate settings
without introducing artifacts.

In most circumstances, we recommend using only the default setting for Intra-DC Precision.

Note: For very high-motion material, you might experiment with a setting of 8 bits, al-
though it’s unlikely you’ll perceive any difference in encoding quality.

Video Format Section
The video format settings include Picture Rate, Aspect Ratio, Chroma Format, and MPEG
Format. These are general settings that will most often be defined by the type of video
source and the target application.

The Video Format section of the MPEG Encoder Settings tab sets the basic functions of frame rate, aspect ratio,
chroma format, and MPEG format.

Picture Rate

Picture rate settings are available for NTSC (29.97 fps) and PAL (25 fps). Take care that this
is set appropriately for the encoding source.

Note: When authoring, it’s necessary to match the PAL/NTSC setting of the Project Proper-
ties with the actual format of video used.

Aspect Ratio

Aspect Ratio settings are available for 4:3 (conventional TV) or 16:9 (Widescreen). When 16:9
is selected, the encoded picture will be anamorphic (squeezed) — with a flag setting that will
trigger the end-user’s DVD player to expand the picture to Widescreen or letterbox.
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Chroma Format

Chroma Format setting is fixed at 4:2:0 , as required by the DVD-Video Specification.

MPEG Format

The two available MPEG Format settings are MPEG-2 and MPEG-1. Encoding for DVD is
nearly always done using MPEG-2, as the visual quality is far superior to MPEG-1. Lower-
rate MPEG-1 may be useful in instances where very long playback time is required or
when the delivery medium is to be something other that DVD.

MPEG-2 Options Section
The MPEG-2 Specification provides a number of settings that, in most situations, may have
only a marginal impact on picture quality. We recommend you use the default settings for
most of these parameters.

The MPEG-2 Options section includes several miscellaneous parameters as shown using the MPX3000 encoder.
For NTSC work, the Inverse Telecine checkbox is of critical importance.

Note: As detailed below wherever applicable, if you are using Spruce Technologies
MPX2000 hardware, the selection of options is slightly different.

If you are using Spruce Technologies MPX2000 hardware, the MPEG-2 Options section differs slightly.
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New GOP On Scene Change

This parameter is available only when using Spruce Technologies MPX3000 hardware.
With this feature selected, the system will automatically insert an I-frame and start a new
GOP (in MPEG: Group of Pictures) whenever an abrupt change is detected in video.

In most usage, this parameter will result in better encoding quality and will provide better
control over chapter start points. When encoding for purposes that require careful control
and matching of GOP structure (such as multi-angle video), however, use of this feature
will be counterproductive. In these instances, you should switch this parameter OFF.

Concealment Motion Vectors

Concealment motion vectors are redundant information that can be optionally included in
the MPEG stream to aid error recovery in non-DVD applications. Their use in DVD is not
recommended, as they do not provide any real benefit while consuming a small amount of
bandwidth otherwise available for picture data.

Dual Prime Mode

This parameter is available only when using the MPX2000 hardware. The Dual Prime
Mode is another method provided for in the MPEG spec that adds redundant information
to the streams for error recovery purposes. At the level that Dual Prime Mode and the
Concealment Motion Vectors operate, however, DVD-Video’s own error-correction
scheme is quite robust. Consequently, their use is not recommended for DVD applications.

Alternate Scan

For the pattern of picture block-scanning, you can select ALTERNATE (default) or ZIG-ZAG

(when ALTERNATE is not checked). Alternate Scan is a more irregular pattern that is optimized
for interlaced video. The use of Alternate Scan is recommended except in the less-likely
case of encoding progressive-scan (non-interlaced) video. Zig-Zag Scan is considered the
appropriate choice for progressive-scan pictures.

Note: Increasingly, digital video cameras are offering a progressive scan option, which is
generally of most benefit for still rather than moving images. However, since many of us
are likely to be seeing more progressively scanned source material (for digital television
and computer monitors), if the source (master) video recording was digital, it may be a
good idea to ascertain whether it was captured as interlaced or progressively scanned.
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Alternate Intra VLC

This parameter is available only when using Spruce Technologies MPX2000 hardware. In
order to represent quantized values more efficiently, MPEG encoding uses variable-length
codes (VLCs) from a look-up table. MPEG-1 uses one defined table. When MPEG-2 was
introduced, the table was further optimized. The original MPEG-1 Intra VLC table is kept
available for historical reasons. The Alternate Intra VLC table improves the performance,
particularly on I-frames.

Inverse Telecine

As we detailed earlier in this Encoding Guide, the Inverse Telecine checkbox should be
selected whenever you encode material that was shot on film and transferred to NTSC
(29.97 fps) video. The Inverse Telecine function removes redundant information that’s
inserted during the process of converting from the film frame rate of 24 fps to interleaved
video at 29.97. This redundant information reduces encoding efficiency; consequently its
removal results in better overall performance.

Group of Pictures Section
MPEG-2 video is encoded as different frame types. This is done in order to exploit both
temporal (time) and spatial (2-dimensional) redundancy, which results in greater encoding
efficiency. In this section, you can define the pattern of frame types, and more.

The Group of Pictures section governs the sequence of frame types used for encoding. (If you have an MPX2000,
your screen may look different from the one above.)

GOP Pattern

The GOP Pattern parameter lets you select the pattern, or sequence, in which the three
frame types (I, B, and P) will be repeated. Available GOP patterns include I-frame only, as
well as patterns that include all three frame types. Both Open and Closed types are avail-
able as well. In general, encoding for DVD-Video should be performed using a closed
GOP type, as this allows the best random entry into the stream for jumps, fast forward, and
so forth.
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GOP Size

The GOP size can be varied according to the GOP patterns selected. Usually, larger GOP
sizes result in better encoding performance.

For most material, longer GOP Patterns and GOP size will provide the most efficient
encoding. Particular sequences of material that change continuously — such as a fade-
from-black — may benefit from encoding with smaller GOP Patterns and Sizes.

Special Considerations for
Encoding Multi-Angle Video

When encoding material for use in multi-angle video segments (multiple video tracks) of a
DVD Movie, there are certain considerations that should be observed.

• All video assets must be encoded using a closed GOP Pattern.

• All video assets must have the same GOP structure throughout.

• The combined bit-rate of the highest video and audio asset, including subtitles,
cannot exceed 8 Mbps (8,000,000 bps).

Closed GOP Pattern
To ensure compliance with the first point, select either IBBP CLOSED or IBP CLOSED as the GOP
Pattern setting.

Note: Actually, these are the recommended settings for all applications, but for multi-angle
work, it is particularly critical.
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Congruent GOP Structure
To ensure compliance with the second point (same GOP structure), observe the following
considerations:

• Encode all segments with the same setting of the GOP Structure and GOP Size
parameters.

• Switch the New GOP on Scene Change parameter OFF, as it will modify the GOP
structures in an uncontrollable fashion.

• If you are encoding shorter sections to be placed as multi-angle within limited areas
of a longer main video, be careful to select a GOP size that can be rendered evenly
with the length of the multi-angle section.

This last consideration can be difficult to understand and implement. Let’s learn more…

Selecting the Best GOP Size

Since selecting the most appropriate GOP size can be a challenge, let’s consider an
example: Suppose we have a 30-minute video program, in the middle of which we want to
have a section of exactly 5 minutes in length that has several optional camera angles
available. After encoding the main video, we then set up to encode exactly 5 minutes,
using the default GOP size of 15 frames.

Provided that 29.97 fps timecode is used, this will work out fine, since 15 frames will
equal exactly 1/2-second (actually 0.1% more, but not worth going into here). As long as
the multi-angle section is an equal number of seconds in length, it will be fine.

On the other hand, if the multi-angle section is defined to be 5 minutes 2 seconds and 4
frames, then we either have to modify the length to an even number of seconds or find a
GOP size that will work out to be an even division of the total length.

In non-drop frame timecode, 05:02:04 works out to be 9064 frames (30 frames to the
second, 1800 frames to the minute).

To find a value of GOP size that will work, we have to try dividing different numbers from
the available settings into the number of frames. Since encoding quality usually works out
better the larger the GOP size, we start from the largest size available (16 frames for the
MPX2000 and 15 frames for the MPX3000) and work our way down.
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Program Length (frames) GOP Size Number of GOPs Encoder

9064 16 566.5 MPX2000

9064 15 604.2666667 MPX3000

9064 14 647.4285714 N/A

9064 13 697.2307692 MPX2000

9064 12 755.3333333 MPX3000

9064 11 NA N/A

9064 10 906.4 MPX2000

9064 9 1007.1

11111 MPX3000

9064 8 1133 N/A

etc.

As you can see from this, the largest available value of GOP Size that will yield an even
number of GOPs from this program is 8 (11 would have worked, but its not an available
setting). This means that both the main program and the multi-angle program segments
must be encoded with this value. (Alternatively, you could encode the main program in
sections and concatenate them together, as described later in this manual.) Since 8 is
rather a low figure for GOP size, we would recommend that you change the length of the
multi-angle segment by a few frames instead, but if this is not possible then 8 would be the
only option.
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Batch Encoding

DVDMaestro and DVDConductor support batch encoding, which allows you to encode
multiple files automatically without having to set up an individual encoding procedure for
each file. The Batch window is where you define “encoding jobs” — a list of video and/or
audio files that you wish to encode automatically.

The Batch Window manages a list of successive encoding jobs to be performed automatically.

To open the Batch window:

• Select BATCH WINDOW under the View pull-down menu (keyboard shortcut: ALT - V - B).

Initially, the Batch window will appear onscreen empty.

To add encoding jobs to the Batch List:

1. In the Encoder Control Panel and the Settings window, set the encoding parameters
— including Start and End time, Bit-Rate, Encoding Mode, etc. — as desired.

2. Click on the ADD button to the right of the main list field in the Batch window. The
new job is added to the list.

3. Repeat until all the jobs required have been added to the list.

All encoding settings are stored with each entry in the Batch list, even though only the start
and end times are shown.
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To view the stored parameters for an encoding job in the Batch List:

1. Double-click on the job to be recalled. The settings of the selected entry loads into
the Encoder Control Panel and Settings window.

2. View the encoding parameters as desired from the window and control panel.

If desired, you may execute a single encode from the recalled settings. Used in this way,
the Batch window can serve as a convenient “memory bank” for frequently used settings.

Having recalled an encoding job from the list, its parameters can be modified as desired
and reentered into the list with the settings changed.

To modify an entry in the list:

1. Recall the entry you wish to modify by double-clicking on it in the Batch List.

2. Make whatever changes you desire in the Settings window and Encode Control
Panel.

3. Click on the Modify button in the Batch Window to register the changes into the
Batch List.

4. If desired, you can also change the order of entries or delete entries in the list using
the Delete button and the Move button in the left-hand portion of the window.

5. Once you are satisfied with the list of entries, you can automatically perform all of
the listed encodes in sequence.

Note: The batch file does not automatically update the saved file. The batch file must
be resaved if you make any modifications.

The Encode Start button in the Encoder Control Panel changes
its appearance when Batch Mode is active.
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To launch the batch encode process:

1. Go to the Options menu in the Encoder Control Panel and select BATCH MODE (key-
board shortcut: ALT - O- B). The Start Encode button changes to a distinctive icon to
show that Batch Mode is in effect.

Note: Batch Mode is only available when Manual Mode is deselected.

2. Click on the Start Encode button. The system will prompt you to select a name and
path for the first file.

3. Set the root filename and path using the New File dialog.

Note: With the MPX2000, some of the entries may need the Out point adjusted to
accomodate the GOP structure. If this is the case, three beeps will sound during the
batch encode.

The system will create video (.vbs or .m2v) and audio (.ac3 or .mpa) using the root
filename with numbered extensions to indicate the list entry. The items in the encode list
will be executed sequentially until done. At the end of the process, the system will offer a
prompt to load the last encoded file into the decoder for preview.

Batch Window Features
The Batch window displays a table with four columns:

• Job Number;

• Start;

• Stop;

• and Length.

Each row of the table represents a single encode operation, resulting in an audio file, a
video file, or a matched pair of files for audio and video.

You’ll find several buttons grouped on the left- and right-hand sides of the Batch window;
these will help you manage the list. The right-hand group of buttons covers the core
functions of adding, deleting, and modifying entries in the table, while the group along the
left-hand side provides mainly for changing the order of entries in the list.
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The buttons along the right-hand side include:

• Add;

• Delete;

• Modify;

• Load Batch;

• and Save Batch.

The buttons along the left-hand side include:

• Move To Top;

• Move Up;

• Move Down

• and Move to Bottom.

Let’s review the operation of these buttons. . .

Add

You’ll use this button to create entries in the batch list and set parameters for the clip you
wish to encode as a list entry — including video and audio source selections, bit-rate, its
In/Out points, and so on. When the entry is complete, click on the Add button to place the
new entry into the list. Then create the second entry, simply add it to the list and continue
as you did with the first entry.

Delete

Should you wish to remove an item from the list, select the item to be deleted, then click
the Delete button.

Modify

To modify an entry in the list, first select that item. The parameters assigned at time of
creation will reappear in the Encoder Control Panel and the Settings window. Make any
changes you wish, then click MODIFY. Changes made will be transferred to the entry.
Remember, if you modify a batch file, you must save before closing the Batch window as
the modifications are not automatically saved.
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Load Batch & Save Batch

Batch encode lists may be saved to disk and reloaded using the Load Batch and Save
Batch buttons.

Move To Top, Move Up, Move Down, & Move to Bottom

The buttons along the left-hand side of the Batch window can be used to rearrange the
order of the entries in the table, exactly as labeled.

Other Encoding Functions
(Encoder Control Panel Pull-Down Menus)

There are three pull-down menus associated with the Encoder Control Panel:

• the File menu; 

• the View menu; 

• and the Options menu. 

The commands associated with these menus are as follows. . .

File Menu (alt - f)

Load Settings (alt - f - l)

Select LOAD SETTINGS to load previously saved settings into the Encoder Control Panel.
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Save Settings (alt - f - s)

Select SAVE SETTINGS to save the current settings of the Encoder Control Panel.

Exit (alt - f - x)

Select EXIT to close the Encoder Control Panel and return to authoring your Project.

View Menu (alt - v)

Settings Window (alt - v - s)

Select SETTINGS to assign parameters for both audio and video encoding. The Settings
window is described in detail in the next section.

Note: Before you can begin encoding, it is important to see that the Encoder Settings
parameters, especially the encoding mode and bit-rate, are set properly.

Batch Window (alt - v - b)

This command opens the Batch window, where you can enter a list of audio/video clips
for automated encoding. Batch encoding operations and the Batch window are detailed
earlier in this Encoding Guide.

Preview Window (alt - v - p)

This gives you the option to open or close the RealView window. There is also an option
to normalize the RealView window to the same aspect ratio as the source file.
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Preroll Setup (alt - v - r)

This command opens a dialog where you can assign the value of Tape Preroll, which is
used with tape machines that are being controlled by your Spruce authoring software’s
machine control feature. Tape Preroll is used to give a machine a certain period of time,
usually a few seconds, to get “up to speed” before encoding starts (the In time). The default
value of Preroll is 5 seconds. The minimum preroll amount for successful operation is 1
second — unless you are using something like a DDR where “0” is necessary for proper
functionality.

Video Compensation Setup

This feature does not appear in version 2.0 of DVDMaestro or DVDConductor. Please see
the version 2.5 Addendum for information on this feature.

Options Menu (alt - o)

The selections in the Options menu are “modal” in nature; that is, when selected, that
option is in effect until the menu item is deselected.

Batch Mode (alt - o - b)

When BATCH MODE is selected, all settings for encoding are taken from the list in the Batch
window. Once encoding is initiated in Batch Mode, your Spruce authoring software will
execute individual encoding of clips until the Batch window list is completed. Note that
this option is not available if there is not a batch list open in the Batch window or if
Manual Encode is selected.

Apply Timecode to Audio (alt - o - a)

When this command is selected, audio encoding is locked to video encoding — in other
words, the time entries for video also trigger audio encoding. As long as the audio source
is also locked to video (that is, audio is derived from tracks on video or from an audio
source locked to video), video and audio will be perfectly synchronized.



User’s Guide for Spruce Technologies DVD Encoder Hardware68

Note: If this option is disabled, you will be required to specify audio timecode In (start)
and Out (end) times during encoding. For more information, please see the “Timecode
Sub-Tab” section later in this Encoding Guide.

DVD Compliant Only (alt - o - d)

When this option is selected (which is the default case), all encoding parameters are
constrained to the ranges that ensure compliance with the DVD specification. When
encoding video and audio for other purposes, need may arise to set some parameters
outside the DVD compliant range. For that situation, you may deselect DVD COMPLIANT ONLY.

Optimizing the Bit-Rate (Bit Budgeting)

As described in the previous section on basic encoding, the two most important param-
eters of MPEG encoding, by far, are the encode mode and bit-rate. In this section, we will
detail how you can calculate the optimal bit-rate for video encoding to suit the project at
hand. In the next section, we will describe how to use Variable Bit-Rate (VBR) encoding
and under what circumstances you can benefit from its use.

Optimizing the bit-rate for video encoding is a matter determining how much storage
space is available, then dividing that by the playtime of video you need to put into that
space. It’s as simple as that.

To make this calculation accurately, you need to consider all of the following:

• the total play time for the video material to be included in the title;

• the DVD format on which it will be mastered (single or dual layer, single or dual
side, DVD-R or replicated disc);

• the total play time and track configuration(s) for all the required audio material;

• the disc requirements for all required ROM assets (all non-DVD-Video assets) — this
applied to standard DVD-Video titles as well as Hybrid (DVD-Video plus DVD-
ROM) titles;

• any special characteristics of the Project that will affect the video storage require-
ments or transfer rate (required throughput) — such as large numbers of subtitles or
still pictures;
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• and finally, the limits of video bit-rate — as defined by the DVD-Video Specification
and by the performance of real-life DVD players — including a small margin of
“overhead.”

In the coming pages, we’ll review all of these factors. Let’s begin by calculating the total
play time. . .

Calculating the Total Video Play Time
To calculate the optimal settings for video bit-rate, it’s important to know the total play
time of all A/V material to be included on disc, including not only the main video feature
and “value-added” materials such as trailers, interviews, etc. If the project you are working
on is to use motion menus, include the length of these in your calculations (if you don’t
have an accurate number, make an estimate).

Once you have all the play times, convert these to seconds then add then all together. (For
calculation, you will need the number in seconds, and it’s easier to add raw anyway). If
there is an odd number of frames left over, round up to the next second.

For example, let’s consider a hypothetical project that includes the following video
segments:

• One main feature (126 minutes, 17 seconds in length).

• An interview segment (12 minutes, 4 seconds).

• Several original theatrical trailers (totaling 3 minutes, 12 seconds).

• Several trailers for coming attractions (totaling 6 minutes, 39 seconds).

• Six “dynamic” or “motion” DVD Menus (each using a loop of video no more than 20
seconds in length).

First we convert each of these to seconds:

• Main feature = (126 x 60) + 17 = (7560 + 17) = 7577 seconds

• Interview = (12 x 60) + 4 = (720 + 4) = 724 seconds

• Trailers = (3 x 60) + 12 = 180 + 12 = 192 seconds

• Coming Attractions = (6 x 60) + 39 = 360 + 39 = 399 seconds

• Dynamic DVD Menus = 6 x 20 = 120 seconds
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Then we total these together:

• 7577 + 724 + 192 + 399 + 120 = 9012 seconds

(It goes without saying that a calculator or spreadsheet program is vital in this process!)

Now we have the first piece of information we require in order to compute the optimal bit-
rate for video encoding, and we can move onto the next consideration…

DVD Formats & Disc Capacities
The size of the “bucket” that will end up carrying your program is the next most-crucial
element in your calculation. As you probably know, DVD discs come in any of several
“flavors”:

DVD Format Description Storage Capacity Comments

DVD-5 Single-sided, single-layer 4.7GB

Lowest cost replicated disc

DVD-9 Single-sided, dual-layer 8.54GB Higher cost than DVD- 5

DVD-10 Dual-sided, single-layer 9.4GB Requires user to flip disc

DVD-13 (Side A) dual-layer 13.24GB At this writing, not available

(Side B) single-layer

DVD-17 Dual-sided, dual-layer 17.08GB At 

this writing, marginally available

DVD-R (A) 1st generation DVD-R 3.9GB

More capacity for QA and small runs

DVD-R (B) 2nd generation DVD-R 4.7GB

Expected to be available late 1999

As you can see, the capacity of the different formats varies widely. In practice, the decision
of which format to use is most often determined by factors other than storage capacity
(especially cost). Note also that in the case of dual-sided and (to a lesser extent) dual-layer
formats, you may find yourself forced to distribute the content unequally on the two sides
of the disc, complicating your calculations.

Since disc capacities are expressed in gigabytes, and video encoding bit-rates are ex-
pressed in bits-per-second — rather than bytes — it is necessary to convert the disc
capacities to raw bits. The chart below shows the capacity of each format converted to bits
(and also expanded out to the full number for easier calculations).
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DVD Format Capacity in Bytes Capacity in Bits

DVD-5 4.7GB 37,600,000,000

DVD-9 8.54GB 68,320,000,000

DVD-10 9.4GB 75,200,000,000

DVD-13 13.24GB 105,920,000,000

DVD-17 17.08GB 136,640,000,000

DVD-R (A) 3.9GB 31,200,000,000

DVD-R (B) 4.7GB 37,600,000,000

With this information in hand, we can make a preliminary calculation for the required
video bit-rate for the hypothetical project we described in the previous section. (For the
moment we won’t factor in the audio files, etc.)

As you may recall, the total duration of video in that project ended up being 9012 sec-
onds. To translate this play duration into a first-cut video bit-rate for each of the designated
formats, we simply divide the capacity in bits by the play time in seconds, as follows:

• DVD-5: 37,600,000,000 ÷ 9012 = 4,172,000 bps

• DVD-9: 68,320,000,000 ÷ 9012 = 7,581,000 bps

• DVD-10: 75,200,000,000 ÷ 9012 = 8,344,000 bps

• DVD-13: 105,920,000,000 ÷ 9012 = 11,753,217 bps

• DVD-17: 136,640,000,000 ÷ 9012 = 15,162,000 bps

• DVD-R (3.9GB): 31,200,000,000 ÷ 9012 = 3,462,000 bps

• DVD-R (4.76GB): 37,600,000,000 ÷ 9012 = 4,172,000 bps

Note: Bit-rates are rounded to the nearest thousand.

At this point, the calculation of video bit-rate is mostly useful in helping guide decisions
about which DVD format to use. The values derived from this first-cut calculation will be
reduced somewhat as we allow for audio tracks, any ROM materials included, allowances
for disc overhead, etc. However, what we want to check now is whether the figures for our
target format are likely to be able to reproduce material satisfactorily.
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The bit-rate required for acceptable quality MPEG encoding is very much dependent on
the source material. However, in general, very good quality can be obtained with minimal
effort at bit-rates of 6 Mbps (6,000,000 bps) or higher. Between 4 and 6 Mbps, variable bit-
rate techniques are needed to get acceptable results for most general market material,
although special-purpose materials may be okay with CBR. At bit-rates lower than 4 Mbps,
you may end up spending a lot of time refining the encoding process and parameters
before obtaining a good result. And below about 3.5 Mbps much of the material in the
feature film realm simply cannot be rendered acceptably.

With these figures as a guide — and keeping in mind the bit-rate available for video will
likely to be pushed lower than the numbers above (thanks to the required audio files and
other possible elements) — which would be the appropriate DVD format to use? Well, a
DVD-5 format could possibly work for this Project , but might require special attention to
encoding. DVD-9 would fit everything quite comfortably. DVD-10 or DVD-17 would be
fine as well, but considerations of user convenience — and disc replication cost — are
likely to rule these out. As for DVD-Recordable, a first-generation DVD-R (3.9GB) clearly
will not carry the full program (but may serve as to test a truncated version; a second-
generation DVD-R (4.7GB), being the same as DVD-5, might be used in a full version.

Calculating the Audio Allowances
The next stage of the calculation is to make allowance for the audio content on the disc.
Bit-rates for audio encoding are fairly closely defined for a given format or compressed or
uncompressed audio, making the calculation somewhat simpler. On the other hand, the
configuration of audio may be different in different portions of the program, making things
a little more complicated.

The following chart list the bit-rates for a single stream (track) of audio in each of several
different compressed and uncompressed formats commonly used in DVD. The DVD disc
may have as many of 8 individual tracks, each of which may be in one of these formats.

Audio Format Bit-Rate
AC-3 stereo 192 or 224 kbps
AC-3 5.1 surround 384 or 448 kbps
DTS 5.1 surround 1536 kbps
Stereo PCM @ 16-bits/48kHz 1536 kbps
Stereo PCM @ 24-bits/96kHz 4608 kbps
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In the case of both AC-3 formats (stereo and 5.1 surround), the lower bit-rate represents
Dolby’s recommendations, while the higher number represents practice of a substantial
portion of engineer’s in the field. In general we recommend using the higher rates for AC-3
encoding for better fidelity.

You’ll notice that there’s quite a wide range of bit-rates for the audio formats supported in
DVD. However, most feature film application is centered on the use of AC-3 audio, either
in surround or stereo format. DTS sound represents a small (but growing) share of the
market. Uncompressed PCM audio, especially high-resolution/high-sample rate PCM, is
generally restricted to titles of special audio interest, such as music video.

For the hypothetical Project we have been working with, let’s assume the various elements
use the following audio configurations:

• Main Feature: 2 tracks AC-3 5.1 (French and English), 1 track stereo (Spanish)

• Interview: 1 track AC-3 stereo

• Theatrical Trailers: 3 tracks AC-3 5.1

• Coming Attractions: 3 tracks AC-3 5.1

• Motion Menus: 1 track AC-3 5.1

You can see that in this Project — which resembles many DVD feature film releases — the
audio configuration is quite varied. There are two approaches we can take to the calcula-
tion: either compute the contribution for each section or use the configuration of the main
feature and hope that other factors balance out. For comparison, we will do both.

Using the duration figures for each section, along with the audio track bit-rate figures listed
previously, we can compute the total storage required for audio as follows:

 

Section

Main Feature 7577 448 + 448 + 224 kbps 1,120,000 8,486,240,000

Total 9,496,480,000

Duration
(seconds)

Bit-Rates Total Bit-Rate
(bps)

Storage Required
(bits)

Interview 724 224 kbps 224,000 162,176,000

Theatrical Trailers 192 3 x 448 kbps 1,344,000 258,048,000

Coming Attractions 399 3 x 448 kbps 1,344,000 536,256,000

Motion Menus 120 448 kbps 448,000 53,760,000
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This gives us a figure for total audio storage that can be subtracted from the volume size, to
give partially refined result for optimal video bit-rate. For comparison, lets do the calcula-
tion for total program based on the configuration in the main feature:

Section

Total Program 9012 448 + 448 + 224 kbps 1,120,000 10,093,440,000

Duration
(seconds)

Bit-Rates Total Bit-Rate
(bps)

Storage Required
(bits)

In this case the result is a little higher than then detailed result, meaning that we any error
would be on the side of safety. This may not always be the case, however, and it can be
somewhat dangerous to try to simplify calculations in this way.

Let’s revisit our bit-rate calculation from the previous section, making allowance for audio,
using the more precise figure of 9,496,480,000 bits required for audio storage in our
example project. We will perform the calculation only for DVD-5 and DVD-9, the other
formats having previously been eliminated as candidates for delivery to market:

DVD-5
(37,600,000,000 – 9,496,480,000) ÷ 9012

= 28,103,520,000 ÷ 9012
= 3,118,000 bps

DVD-9
(68,320,000,000 – 9,496,480,000) ÷ 9012

= 58,823,520,000 ÷ 9012
= 6,527,000 bps

Based on the calculation including allowance for audio, it appears that DVD-9 is the only
delivery option likely to support acceptable encoding quality — since 3.1 Mbps is simply
too low for use for a feature film for general market.

Calculating the ROM Allowances
To continue our calculations, we need to subtract any storage allotted to ROM assets, and
then provide allowance for general DVD formatting, which includes menus, subtitles, and
navigation files. Furthermore, if you are creating a Hybrid DVD disc (DVD-Video and
DVD-ROM), all files related to the ROM portion of the disc would be included in these
calculations.
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For this example, we’ll assume that there are ROM assets such as Web-link software and
other files, totaling 36 megabytes of data.

Note that ROM assets are normally expressed in computer megabytes (MB), equal to
1,048,576 bytes, rather than the exact bit and byte quantities used in expressing DVD
capacity and encoding bit-rates. Therefore, to factor these assets into our calculation, we
need to convert the “megabyte” capacity into raw bits, then subtract this from the storage
capacity left after making allowance for audio. Then we can calculate a new figure for
optimal bit-rate.

Multiplying 36 MB by 1,048,576 bytes yields a result of 37,748,736. Then we multiply this
by 8 to give a figure in bits, which we round off to 301,990,000.

Including this into the DVD-9 calculation from the last section, we get:

DVD-9
(58,823,520,000 – 301,990,000) ÷ 9012

= 58,521,530,112 ÷ 9012
= 6,493,000 bps

In this case, the effect of allowance for ROM content on encoding bit-rate has been small,
in part because DVD is such a capacious storage medium for ordinary computer assets.

Factoring for DVD ‘Overhead’
As the last stage of our calculation, we need to make an “overhead” allowance for several
less-easily quantifiable factors, including the size of DVD navigation files that will be
created during compilation (for still DVD Menus and subtitles) and for variances in encod-
ing that may give us a less-precise result than we have calculated.

The amount of this margin may vary with Projects, but for most we recommend you allow for
an overhead of 5%. Factors that might increase this margin would be large numbers of subtitle
tracks, numerous still images, a very complex navigation structure, and so on. In this area, it is
nearly impossible to make hard and fast rules, but these guidelines should allow you to
optimize encoding bit-rates without running out of space on the target DVD format.

Note: Important! Always remember to allow for overhead. If you don’t, the likely result is
that you’ll be far into your Project before discovering that it will not fit on the target disc.
This is a very expensive mistake to make in production!
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To calculate the required overhead, simply multiply the result of the last calculation (after
allowance for audio and ROM content) by the inverse of the percentage margin. In this
case, we will use a margin of 5%, which translates to multiplication of the last result by
0.95. Hence:

DVD-9
6,493,000 bps x 0.95

= 6,168,000 bps

The end result of our calculation, and a good figure to use for video encoding in this
Project is:

6,168,000 bps, or 6.18 Mbps

Therefore, we may encode this Project in CBR mode at a rate of 6.18 Mbps — with
confidence that the resulting files will be able to be delivered in the DVD-9 format, with
all accompanying audio, ROM, menu, and navigation assets.

Note: In some cases, you may want to round this downward to allow for any errors of
calculation, such as not applying enough margin at the end. There will be little perceived
difference between encoding at a rounded-down value of 6 Mbps and encoding at 6.18
Mbps. The important thing to remember here is to round down — not up.

Summary of Video Bit-Rate Calculations
We’ve already examined how to calculate optimal video bit-rates in some detail, and by
now you may be feeling as though your head is spinning. However, you’ll find that in
practice, these bit-rate optimization calculations are not so difficult. In simple form, the
procedure is:

1. Determine the total play time of all video assets in the Project. Convert this to
seconds.

2. Determine the size of the target DVD format (or possible formats) and convert this to
bits.

3. Determine the amount of data required for audio by multiplying the total play time in
seconds by the bit-rates of all audio tracks and summing the results. Subtract this
number from the size of the DVD format.

4. Subtract any space required for non-DVD Video (ROM) assets.

5. Divide the resulting adjusted capacity figures by the video play time (as determined
in the first step).
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6. Multiply the resulting “bits-per-second” figure by an overhead allowance of 0.95 (or
less if your Project warrants a larger overhead safety margin).

7. If the resulting number is greater than 8,000,000 bps, use 8,000,000 bps instead.

8. Make sure that the sum of the video bit-rate and all of the audio bit-rates that occur
in audio tracks of the same video clip does not exceed 9,800,000. If it does, subtract
the sum of audio bit-rates from this number and use if instead of the previously
calculated figure.

The result is the optimal bit-rate for CBR encoding, or average bit-rate for 1-Pass or 2-Pass
VBR encoding.

AC-3 & MPEG Audio Encoding

Earlier in this Encoding Guide, we learned how to encode video and an associated stereo
audio track. In many professional situations, this is all that is required.

In other situations, however, you will need to encode stereo or 5.1 audio from separate
media, either because there is more than one stereo soundtrack involved, or because the
main soundtrack is in 5.1 discrete surround and there are no video formats that have
enough audio tracks.

Encoding ‘Wild’ Audio
In some situations, you may encode a music bed or other accompanying audio that has no
firm relationship to video. This may come from Compact Disc or other “wild” media
(“wild” in this case means without synchronized machine control).
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In this case, you will use Manual encoding with audio only.

To encode audio (only) without machine control.

1. Cue up audio source to the desired start point.

2. Setup the Encoder Control Panel as shown above. Of course, make sure that audio
connections and settings are also set up correctly.

3. Click on the Encode Start/Stop Button.

4. In the Save File dialog, select the name and location for the file to be captured. Click OK.

5. When you see the Encode Start/Stop button turn red, start the audio source.

Note: Depending on how tightly you want to cut the source material, you may need to try
a couple of times to get the start point where you want it to be.

Encoding Synchronized Audio without Video
When you are preparing a Project with multiple soundtracks that all sync to picture,
usually the individual soundtracks will be delivered on separate audio tapes, most com-
monly professional Digital Audio Tape with timecode. In order to encode these to syn-
chronize with picture, it is necessary to use a professional machine that provides serial
machine control using RS-422 protocol.

Caution: Audio Timecode

For success when encoding synchronous alternate audio tracks, it is important that the
timecode on the audio tapes have a fixed relationship to the timecode on video. Ideally,
the timecode on each audio tape will be identical with the timecode on the main video.
This makes it straightforward to encode from each audio tape in turn, without changing the
encode In/Out points.

Alternatively, you may find in some situations that the timecode on the audio tapes is
offset from that on the main video. This is workable, so long as you know the correct In
time and Out time or the offset (from which you can calculate In and Out).

The worst situation — one which is best avoided by careful planning — is when timecode
on audio has no specific relation to that on video or is in a different format. There are no
simple solutions for this kind of situation, and in many cases, the audio may have to be re-
recorded with new timecode that matches the format of the video timecode.
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Caution: Audio Sample Clock

If your source audio tapes are in digital format, you’ll need to ensure that the audio sample
clock is locked to video. If it is, then encoding will proceed smoothly. If it is not, then you
will be subject to “drift” of audio video sync over time.

In the case that the source audio is in analog format and there is no analog video feeding
the digital connect box, then it is important to set the Audio Sync setting in the Digital
Connect tab of the Settings window to INDEPENDENT. With an analog video source connected
to the digital connect box, the sync should be set to SLAVE TO VIDEO. Otherwise, you can
expect the audio/video sync to drift with time.

Caution: Audio Conformance

If you are working with multiple language tracks for a video program, make sure that all
tracks conform with picture. If they do not (a situation common in feature film work), then
there is no choice but to go into audio post and reconform the tracks to fit. This is a
complex process and well beyond the scope of this manual.

To encode synchronous audio with machine control:

1. Setup the Encoder Control Panel as shown above. Verify that audio connections and
settings are set up correctly.

2. Enter timecode values for the In and Out times.

3. Click on the Encode Start/Stop button.

4. In the Save File dialog, select the name and location for the file to be captured. Click OK.

5. The audio deck will cue to the start point and capture audio as needed.
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Encoding AC-3 5.1 Audio
Encoding audio in 5.1 format is no different than encoding stereo audio, except that the
source format is in a 6-channel configuration (Left, Center, Right, Left Surround, Right
Surround, Subwoofer).

Note: To encode 5.1 surround, you must have the Spruce Technologies ACX5100 5.1
Encoder Board installed in your system.

The audio source for 5.1 can be any form of multitrack audio, but typically it is a digital
audio multitrack tape in the DA-88 or PCM800 8mm format supported by Tascam and
Sony. This has become nearly standard practice in the industry, and is recommended.

The source transport also needs to support serial machine control in RS-422 format, a
requirement that is met by the Tascam and Sony transports.

In the AC-3 Encoder Setting portion of the Setting window, you will need to make sure that
the Audio Coding Mode setting is configured for 5.1, as shown above. Appropriate Bit-
Rate settings are either 384 or 448 kbps. (The former is recommended by Dolby. The latter
is preferred by some producers.)

To set up the audio encoder for 5.1 surround encoding:

1. In the Encoder Control section, set the Encode Source for Audio to AC-3 (5.1 CH.).

2. Open the Settings window via the View pull-down menu (keyboard shortcut: ALT - V - S).

3. In the Settings window, select the AC-3 Encoder Settings tab.
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4. In the Audio Service Configuration section of the AC-3 Encoder Settings tab, set the
Audio Coding Mode to 3/2.

5. If the Subwoofer channel is present, select LFE.

6. Set the Data Rate to either 384 or 448 kbps.

Of course, you will also need to make sure that all six source audio channels are con-
nected to the inputs of the ACX-5100. There is no defined standard for which tape channel
will correspond to which speaker channel in the surround field. The AC-3 Encoder Settings
window provides a means to define this.

To define channel routing for 5.1 surround encoding:

1. In the AC-3 Encoder Setting tab of the Settings window, select the Input/Output sub-
tab.

2. In the Digital Input section of this tab, click on the Input Channel Routing button.

3. In the Input Channel Routing dialog, select the input channel that corresponds to
each of the six speaker channels in the surround sound field.

4 Click OK.
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As with stereo audio, 5.1 surround audio may be encoded at the same time as video or in
a separate audio-only pass. The difference is that with 5.1 audio, the audio will be coming
from a separate multitrack audio transport that is synchronized to the video transport —
rather than from audio tracks on the video transport.

The Spruce encoding system is unable to control two transports simultaneously via serial
machine control. In this situation, the best method to use is to feed timecode from the
video deck to the audio deck. You can then place the audio deck into its “timecode chase”
mode. It will then follow the video deck as it is controlled by the encoding system.

Note: Your multitrack audio transport must be able to synchronize to external timecode in
order to accomplish timecode chase. And to do so, your multitrack audio transport may
require an optional synchronizer card or external synchronizer box. If in doubt, please
check with the manufacturer of your audio transport.

To encode 5.1 audio synchronized with video:

1. Connect the multitrack audio transport to timecode feed from the video transport.
Place the audio transport in timecode chase mode.

2. Configure the Encoder Control section as described above.

3. Make sure that audio settings and connections are correct.

4. Set the timecode In and Out points.
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5. Click the Encode Start/Stop button.

6. In the Save File dialog, define the name and location of the files to be captured.

7. Click OK. The system will now cue the source transports and capture audio and video
together.

If surround audio is captured in a separate pass, the procedure is the same as for capturing
stereo audio independent of video. The only difference is that the audio settings and
connections must be defined as for surround audio.

Encoding Audio in MPEG-1 Layer 2 Using the MPX2000 Encoder
Depending upon what you’ve selected as the audio encode source (in the Encoder Control
section of the Encoder Control Panel), the third tab of the Encoder Settings window will
either be the AC-3 Audio Encoder tab or the MPEG Audio Encoder tab. If you’ve selected
MPEG AUDIO as your audio encode source, then you’ll see the MPEG Audio Encoder tab.

Note: If you are using Spruce Technologies MPX2000 hardware, the source input for
MPEG audio is different than the input for AC-3 stereo. You must connect the digital audio
(from the Digital Connect box of digital audio source device) to the correct input. For
MPEG audio, the digital audio source signal is routed to the RCA (phono) connector on the
MPX2000 encoder card, rather than to the connector on the ACX2000 card. For conve-
nience, you may wish to split this signal so that it is routed continuously to both cards.

The MPEG Audio Encoder tab of the Encoder Settings window assigns all of the parameters
associated with audio encoding in the MPEG-1 Layer 2 audio format. (MPEG 1 Layer 2
files typically have an extension of “.m1a”, “.mpa”, or “.abs.”

Note: The MPX3000 will support MPEG-1 Layer 2 audio encoding in version 2.5 of the
DVDConductor/DVDMaestro software.
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When encoding MPEG-1 Layer 2 audio using the MPX2000, the key setting is the bit-rate; sample rate is restricted
to 48 kHz.

As you can see in the screenshot, the settings for MPEG audio encoding are considerably
simpler than those for AC-3 audio encoding.

The settings are divided into three sections, as follows. . .

Quantization
Bit-rate

This is the most important setting in the MPEG Audio Encoder tab. The recommended bit-
rates for MPEG 1 Layer 2 audio are 192 or 224 kbps.

Sample Rate

Per the DVD-Video Specification, the sample rate for DVD-Video use is restricted to 48 kHz.

Audio Format
Mode

Stereo mode is the default format for MPEG 1 Layer 2 audio.
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MPEG Options
Encoding Layer

Layer 2 is the only valid option.

Emphasis

Emphasis may be selected as NONE or as CCITTJ17.

Original, Copyrighted, Use Protection

MPEG audio copy protection is not ordinarily used for DVD, as DVD-Video Specification’s
own protection provisions are much more robust. Therefore, we recommend you leave
these checkboxes unchecked, their default state.

AC-3 Encoding Parameters

Depending upon what you’ve selected as the audio encode source (in the Encoder Control
section of the Encoder Control Panel), the third tab of the Encoder Settings window will
either be the AC-3 Audio Encoder tab or the MPEG Audio Encoder tab. No tab will appear
if the audio encode source is set to NONE. If you’ve selected ACXPRESS as your audio encode
source, then you’ll see the AC-3 Audio Encoder tab.

The AC-3 Audio Encoder tab of the Encoder Settings window assigns all of the parameters
associated with audio encoding in the Dolby AC-3 format.
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The AC-3 Audio Encoder tab.

The settings for AC-3 encoding are divided into the general, or basic, parameters, which
are always shown. More detailed setting of parameters is available by select individual
sub-tabs in the right-hand portion of the display.

If you’ve selected AC-3 (STEREO OR 5.1) as the Encode Source in the Encoder Control
section, the AC-3 Audio Encoder tab will display parameters for Dolby Digital (AC-3)
audio encoding. If, however, you’ve selected MPEG-1 AUDIO as the Encode Source, the
parameters for MPEG 1 Layer 2 audio encoding will appear.

Note: Abbreviated definitions of AC-3 encoding parameters are provided below. The
separate document “Dolby Digital Professional Encoding Manual for ACXpress” (included
with your DVDStation or Spruce Technologies encoding hardware) contains detailed
definitions.

As you can see in the previous screenshot, the AC-3 Audio Encoder tab is divided into two
major sections: the left-hand portion, with meters and other elements, and the right-hand
portion — with five separate sub-tabs for setting up different aspects of the audio encoding.
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Let’s tour the AC-3 Audio Encoding tab, starting with the left-hand elements — all of
which remain onscreen and available, regardless of which right-hand sub-tab is selected.

The left-hand portion of the AC-3 Audio Encoding tab.

Level Meters
Six horizontal level meters are provided to monitor audio input activity: Left (L), Center (C),
Right (R), Left Surround (Ls), Right Surround (Rs) and the subwoofer channel, Low-Fre-
quency Enhancement (LFE).

If the hardware or software configuration is set to stereo encoding (2/0), only the L and R
meters are active. When 5.1 (5/1) surround encoding is performed, all six meters will be
active, assuming all channels of the input source are active.

The scale of the meters ranges from –60 dB to 0 dB.

Audio Service Configuration
The Audio Service Configuration section of the AC-3 Audio Encoding tab contains six
different parameters, constituting the most import general parameters for AC-3 encoding.

The settings available in tab section are as follows. . .
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Data Rate

The AC-3 data rate is the basic parameter that determines output quality. AC-3 supports a
wide range of data rates for different applications. For use with DVD, Dolby Laboratories
specifically recommends rates of 192 kbps for stereo and 448 kbps for 5.1 surround.

Sample Rate

This parameter must match the sample rate of the incoming source audio. For DVD use, a
sample rate of 48 kHz is the only legal value for compressed audio. By selecting the
checkbox labeled AUTO, your Spruce authoring software will automatically set the sample
rate to match the incoming source audio.

Audio Coding Mode

The Audio Coding Mode defines the configuration of audio channels as mapped to the
physical speakers. The value is expressed as two single-digit numbers separated by a slash.
The left number defines the number of front speakers, while the right number defines the
number of rear speakers. The common settings for DVD are 2/0 (stereo) and 3/2 (5-channel
surround, excluding the subwoofer or LFE channel).

LFE Enable

This indicates that a separate low-frequency enhancement (subwoofer) channel is avail-
able. Set this checkbox whenever you’re encoding 5.1 material.

Bitstream Mode

The AC-3 bitstream includes data bits that flag how the stream is used. Besides the default
setting of COMPLETE MAIN, Dolby provides settings for use by hearing impaired, commentary
tracks, and so forth. These are used in non-DVD applications only. Selection of Karaoke
Mode is used for Karaoke Mix Mode audio.

Dialogue Normalization (Dialog Normalization)

This parameter specifies the average level of dialogue relative to overall mix and is used in
encoding to help maintain the intelligibility of speech. The default value of –27 dB repre-
sents a median setting for feature film mixing, which normally carries dialogue at a level of
–24 to –31 dB below peak level. For non-feature film materials, such as a talking heads-
style television production, dialogue levels may be higher.
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Audio Bandwidth

This display-only field shows the upper-frequency bandwidth of the audio, which is
determined by the bit-rate, the audio coding mode, and the sample rate. (An upper-
frequency audio bandwidth rating of 20 kHz or higher is excellent, as it will be higher than
most people can hear.)

Use LTC, Save Configuration
& Load Configuration Buttons
Before we get to the right-hand sub-tabs of the AC-3 Audio Encoding tab, there are three
other buttons along the tab’s bottom edge you should understand. . .

The Encoder Settings dialog, showing AC3 Audio Encoder tab. The Use LTC button is the “clock” button in the
lower-left corner; the Load Configuration and Save Configuration buttons are in the lower-right corner.

Use LTC Button

This button may be selected when an LTC (linear, or longitudinal timecode) signal is
available from the video/audio source and is connect to the timecode input. Selecting this
option is especially useful when the audio source is not compatible with serial machine
control or if the control cable is not connected to the audio source.
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When you select this button, which has an image of a watch, the audio encoder will
“listen” to the audio source’s LTC signal — rather than whatever incoming timecode
reference may appear at the CPU’s serial (RS-232) control port. In this way, the process of
audio encoding is de-coupled from machine control and is triggered purely by the Start
Time and Stop Time entered in the Timecode tab in the right-hand section of the AC-3
Audio Encoding tab.

When a suitable LTC feed is available, the use of this function is highly recommended, as
it guarantees accurate synchronization between video and audio.

Save Configuration (Save Config) Button

By selecting this button, you can save all of the current settings of the AC-3 Audio Encoding
tab. When you click SAVE CONFIG, a save dialog will present itself, allowing you to save the
current configuration; you can also change default hard drive directory too, if you wish.

Load Configuration (Load Config) Button

This feature will let you restore previously saved settings for the AC-3 Audio Encoding tab.
When you click LOAD CONFIG, a open file dialog will present itself, where, if necessary, you
can also browse for the desired configuration file.

Bitstream Info Sub-Tab
Found on the right-hand side of the AC-3 Audio Encoder Settings tab, Bitstream Informa-
tion (BITSTREAM INFO) is the first of five sub-tabs.

The Bitstream Information sub-tab control the mixdown of multichannel information during 2-channel playback; it
also stores optional Audio Production Information.
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The Bitstream Information settings are used to control the mixdown of how multichannel
material is heard when played back on just a 2-channel (rather than a 5.1 surround-
capable) playback system. It’s also used to store certain optional Audio Production Infor-
mation. Let’s learn more about the parameters in this sub-tab. . .

Center Mix Level

This parameter is available only when:

• the ACXpress 5100 6-channel encoder is used;

• and a mode is set that uses three front channels (L, C, R).

The Center Mix Level defines the level of the center-channel information — relative to the
left- and right-channel information — when audio is reproduced on a two-channel (stereo
only) playback system. The available values are –3 dB, –4.5 dB, and –6 dB.

Surround Mix Level

This parameter is available only when:

• the ACXpress 5100 6-channel encoder is used;

• and a mode is set that uses one or more surround channels (Ls, Rs).

The Surround Mix Level defines the level of the surround-channel information — relative
to the left- and right-channel information — when audio is reproduced on a two-channel
(stereo only) playback system. The available values are –3 dB, –4.5 dB, and –6 dB.

Copyright Bit

This bit, set by default, indicates that the source audio material is copyrighted.

Original Bitstream

This bit, set by default, indicates that the current bitstream is an original bitstream.

Dolby Surround Mode

This parameter is available only when encoding in 2-channel (2/0) mode. It should be set
if the source material is encoded for Dolby Surround (Dolby Pro-Logic).
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Audio Production Information

As an option, the Dolby Digital (AC-3) Specification allows you to include basic informa-
tion about the audio production with the encoded audio file(s). This information is not
used in the audio decoding process; however, it may be useful to audio engineers or other
personnel during the final audio mix or disc premastering stage.

The optional Audio Production Information includes:

• Info Exists:

° This flag indicates that audio production information (mix level and room type) is
included in the bitstream. When it is selected, the encoder will incorporate the
settings of the remaining two fields into the audio output.

• Mix Level:

° Mix Level defines the monitoring level that was used in the final mixdown of the
content. This can be used by a reproduction system, for example, to adjust fre-
quency response curves for different reproduction levels.

Note: Proper encoding for Dolby Surround requires specific mix levels. For full
details, please consult the Dolby manual included with your encoder.

• Room Type:

° This indicates the type of room used during the recording and/or mixing of the
source audio. It can be used during reproduction to adjust ambience for different
playback environments.
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Preprocessing Sub-Tab
Found on the right-hand side of the AC-3 Audio Encoder Settings tab, Preprocessing is the
second of five sub-tabs.

Audio preprocessing is able to remove “out-of-band” components and to optimize the signal for reproduction in
typical home environments.

The settings in this tab are used to process audio before it is encoded, for optimal encoding
performance. Let’s begin with the upper-left section of this sub-tab. . .

Input Filtering

One of the goals for optimum audio encoding is to ensure that you encode only the audio
you need. By removing unwanted high- and low-frequency material — the so called “out-
of-band” components — you can audibly improve the final encoded audio files.

For instance, extremely low-frequency information — especially “0Hz” information, also
called “DC” — can mess up the encoding process. To prevent this, the Preprocessing tab
offers a DC High-Pass filter (detailed just below). Similarly, let’s say you’ve restricted (in
the Audio Bandwidth setting in the left-hand portion of the AC-3 Audio Encoding tab) the
audio bandwidth to 20kHz — which is, practically speaking, already higher than many
people can hear. If your source audio has audio information above 20kHz, however, this
could interfere with the encoding process — and you’d be wise to filter that audio using
the Bandwidth Low-Pass Filter (detailed just below).
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Another issue to consider is “pre-emphasis.” In the early days of digital recording, many
digital recordings were made with pre-emphasis, a slight high-frequency boost intended to
compensate for performance problems with audio Analog/Digital converters. Nowadays,
audio A/D converters have improved greatly and almost no one intentionally records with
pre-emphasis. However, it is possible you may run into a recording with pre-emphasis
(intentional or otherwise), in which case it’s a good idea to apply “de-emphasis” to even
out the frequency response.

The Input Filtering settings include:

• Digital De-emphasis:

° In the default setting of AUTO, your Spruce authoring software monitors incoming
digital audio signals, and if it detects pre-emphasis, it applies its own de-emphasis
filter automatically. By unchecking AUTO, you can also force the de-emphasis filter
ON or OFF. If you’re unsure of what setting to use, keep AUTO checked.

• DC High-Pass Filter:

° This applies a high-pass filter (also known as a “low-cut” filter) to remove any DC
components present in the incoming audio. We strongly recommend you leave this
checked (its default setting).

• Bandwidth Low-Pass Filter:

° When this filter is selected, a low-pass filter (also known as a “high-cut” filter) is
applied to incoming signal to remove any frequency components that are above
the encoding bandwidth (as displayed in the Audio Bandwidth setting in the left-
hand portion of the AC-3 Audio Encoding tab).

• LFE Low-Pass Filter:

° When selected, this applies a low-pass (or “high-cut”) filter to the input of the low-
frequency enhancement (subwoofer) channel. This will eliminate frequency
components that are above the LFE channel’s bandwidth.

Note: This parameter is available only when using the ACXpress 5100 with the LFE
channel enabled.
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Surround Channel Processing

In this section, you can provide further processing to the surround channels (if present).
The options include:

• 90-Degree Phase Shift:

° This parameter is available only when encoding in surround mode with the
ACXpress 5100. It applies a 90-degree phase shift to the surround channels. When
5.1-channel audio is played back on a 2-channel output feeding a Dolby analog
surround decoder, this phase shift will cause the surround channels to be output at
the rear, similar to the original mix.

• 3 dB Attenuation:

° This 3 dB attenuation of the surround channels matches the practices of film
mixing, in which surround channels are mixed 3 dB “hot” to compensate for the
gain structure of cinema installations. Home reproduction systems are normally
calibrated for unity gain on the surround channels, so the additional gain is re-
moved in encoding.

Dynamic Range Compression

In this section, you can define how the audio’s dynamic range — that is, the range be-
tween the loudest and quietest passages of audio — is reduced or compressed. Dynamic
range compression is applied to “even out” high- or low-level extremes to produce more
consistent listening levels.

The features of this section include:

• Compression Characteristic:

° Dolby Digital decoders provide a dynamic range compression function optimized for
listening in typical home environments. This compression uses different compression
“curves” (with different playback characteristics) for different types of material. The
Compression Characteristic should be set for the type of material being encoded. The
available settings are: FILM STANDARD, FILM LIGHT, MUSIC STANDARD, MUSIC LIGHT, and SPEECH.

• RF Overmodulation Control:

° This checkbox sets the encoder to prevent RF overmodulation in set-top decoder
boxes. It is especially important for broadcast applications, and we recommend
you leave this control checked.
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• Input Level, Line Mode, and RF Mode Meters:

° These meters provide visual references that can be useful during the AC-3 encoding
process. For more information, please refer to the “Dolby Digital Professional
Encoding Manual for ACXpress” (included with your DVDStation or Spruce Tech-
nologies encoding hardware).

Input/Output Sub-Tab
The fields in this sub-tab mostly indicate the status of your incoming digital audio signal;
they also let you set the output format of your AC-3 encoded audio.

The Input/Output sub-tab displays information about the status of incoming digital audio signal and provides for
setting the output format for encoded AC-3 audio.

This sub-tab has three sections. . .

Digital Input

In this section you can see important information about the incoming audio signal and you
can also reconfigure the input channels:

• Lock Status:

° Indicates that a valid digital audio bitstream is being received.

• Sample Rate:

° Indicates the sample rate of the current audio input bitstream, as indicated by bits
embedded in the standard input format.

User’s Guide for Spruce Technologies DVD Encoder Hardware 97

• Integrity:

° A HIGH indicator shows that the encoder is having no problems “reading” the
incoming audio signal. If there are problems with the signal, the integrity setting
will indicate MARGINAL.

• Input Channel Routing:

° The Input Channel Routing button opens a sub-dialog, where you can match input
source channels to the appropriate reproduction channels (L, C, R, etc.) for play-
back. This allows your authoring system to work with any format of multichannel
audio source without physically re-patching the system.

Digital Input Subcode

Digital audio standards allow for subcode information; these are “flags” hidden in the
incoming audio signal that indicate sample rate and other information.

Spruce authoring software is able to recognize the following types of subcode information:

• Format:

° This will indicate with PROFESSIONAL or CONSUMER.

• Sample Rate:

° Spruce authoring software recognizes either 44.1 kHz or 48 kHz audio.

Note: Remember, the DVD-Video Spec only supports a 48 kHz audio sample rate for
compressed audio.

• Emphasis:

° This indicates if the incoming audio source includes pre-emphasis (see “Pre-
Processing Sub-Tab,” above).

• Audio Bit:

° An indication of AUDIO confirms that that the incoming signal is indeed audio data,
rather than OTHER.



User’s Guide for Spruce Technologies DVD Encoder Hardware98

Digital Output

Here, you set the digital output format to support the use of the digital audio stream for
encoded (technically non-audio) data

Normally, you should leave these settings in their default position, which are as follows:

• Format:

° This is set by default to 32-BIT PROFESSIONAL MODE. (The Dolby AC-3 spec includes this
feature primarily for laser disc premastering, which does not apply to Spruce
authoring software. However, we suggest you leave this setting in its default
position.)

• Audio Bit:

° The default mode is NON-AUDIO. (This prevents linear D/A converters from reproduc-
ing the encoded AC-3 stream if connected inadvertently.)

• Include Timecode Packets:

° By default this option is checked. (This embeds timecode packets in encoded audio
files, which in turn helps to ensure accurate audio-to-video synchronization.)

Rec/Play Sub-Tab
This sub-tab lets you access your Spruce authoring software’s record preference.

The Record/Play sub-tab: Ordinarily, this should be set to normal +time, as indicated.
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Normally, you should leave this setting in its default position, which is as follows:

Record Preferences

• File Format:

° This should always be set to NORMAL + TIME CODE so that the appropriate timecode
references will be captured. In turn, this will facilitate accurate audio-to-video
synchronization during authoring.

Timecode Sub-Tab
This sub-tab displays the audio source’s current timecode and optionally allows you to
specify timecode start and end times.

Current timecode, as well as the start and end timecodes for encoding are display in the Timecode sub-tab. If
you’ve disabled APPLY TIMECODE TO AUDIO (in the Options menu of the Encoder Control Panel), then the start and end
timecodes for audio encoding are entered here.

This sub-tab’s features include:

Current Timecode

This displays the current location value of the incoming from linear timecode this field is
only available if the Use LTC button has been selected.
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Start Timecode & Stop Timecode

The Start Timecode field lets you set a start time for audio encoding. That is, when the
incoming audio source’s timecode location (as indicated in the Current Timecode display)
reaches the desired start time, encoding will begin.

Similarly, the Stop Timecode field lets you set a stop time; when the incoming audio
source’s timecode location reaches the desired stop time, encoding will stop.

Note: If you’ve selected APPLY TIMECODE TO AUDIO in the Options menu of the Encoder
Control Panel, then the In and Out values entered in the Encoder Control Section of the
Encoder Control Panel are automatically transferred to the Start Timecode and Stop
Timecode fields in the Timecode sub-tab. These In and Out values apply to the video
encoding process, and the Apply Timecode to Audio option simply tells your Spruce
authoring software to use the same values for audio.

If, however, if you have de-selected APPLY TIMECODE TO AUDIO in the Options menu of the
Encoder Control Panel, then you can use these fields to enter separate start and stop times
for audio — independent of whatever you’ve set for video.

Summary of Encoding

Although we’ve presented a wide range of encoding-related options and configuration
issues in this Encoding Guide. you’ll find that basic video and audio encoding is very
simple to perform.

There may be, however, situations where you’re called upon to encode varying configura-
tions of audio and video, possibly with different timecode situations. You may also be
called upon to optimize video image quality in situations of varying difficulty. The infor-
mation in this Encoding Guide provides guidelines for many common situations, but as
you’ll learn, real skill in solving production problems and optimizing compression results
will come with experience.

•        •        •

Version 2.5 New Encoding Features Addendum
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Spruce DVD Authoring System
Version 2.5 New Encoding Features

Introduction
Version 2.5 of the Spruce DVD Authoring System (DVDMaestro, DVDPowerPack, and
DVDConductor) introduces important new features for video and audio encoding for all
users of Spruce’s MPEG/AC-3 encoding solutions.

Certain features apply to particular hardware platforms, specifically the MPX 3000 en-
coder. Certain features require installation of the DVDEncoderPack for DVDConductor or
DVDVirtuoso. All feature listed are available in DVDMaestro.

Version 2.5 New Features for Video and Audio Encoding
Forced I-Frame Insertion for MPX 3000
In MPEG encoding, the ongoing sequence of video frames is divided into units known as
Groups of Pictures, or “GOPs.” The MPEG encoding algorithm searches within the GOP to
reduce data rate by eliminating redundancies from one frame to the next. This is part of the
reason that MPEG encoding can yield very high compression ratios while keeping a very
good-looking picture.

DVDMaestro Power Feature!! Forced I-Frame Insertion is not available for MPX 2000
hardware, and is an advanced encoding feature found in DVDMaestro™. I-Frame
Forcing functions may be added to DVDConductor or DVDPowerPack systems
equipped with the MPX 3000 encoder by installing the DVDEncoderPack upgrade
package.
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Each MPEG GOP is made up of three types of frames:

• the I-Frame (Intra Frame);

• the P-Frame (Predicted Frame); and

• the B-Frame (Bi-directional Frame).

The I-Frame is formed by coding entirely within the current frame (assuming the GOP
structure is “closed”, which we’ll describe later), without reference to frames that precede
or follow it. P-Frames are encoded from a “predicted” picture based on preceding frames
and B-Frames are encoded based on an interpolation from other frames that come before
and after. The I-Frame, therefore is the only type of frame that can stand by itself, without
requiring information from other frames in the GOP. Every GOP begins with an I-Frame.
Because the I-Frames have this “stand-alone” capability, chapter start points in a DVD
Movie can be entered only where an I-Frame is found. Otherwise, the picture could not be
reproduced when the chapter start point is accessed at random. Likewise, MPEG editing
functions such as trim and concatenation can be done only at the point that an I-Frame
occurs at the beginning of a GOP.

In MPEG encoding for DVD, GOP boundaries occur about every half-second (it varies, but
overall, it’s around this figure). That means when you create Chapter Point Markers (which
define chapter start points), they may have to be adjusted forward or backward to fall on
an I-Frame. In many instances, this is not a problem. However, if you wish to place a
Chapter Point Marker at a specific frame, you may need to “force” the occurrence of an I-
frame at that location. To do this, the encoding section of your Spruce DVD authoring
system gives you the capability of defining a list of time code locations where I-Frames will
be forced to occur prior to starting encoding.

Note: I-Frame Insertion is not available when using the Manual Encode mode, as there is
no way to reference a specific frame location.

When using encoding with serial machine control, you may access the I-Frame Force list
from the View menu. During encoding, every time code location in this list will be con-
verted to a forced I-Frame and may be used as a Chapter Point Marker in authoring.
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To set up the I-Frame Insertion list:

1. From the View pull-down menu in the Encoder Control Panel, select I-FRAME INSERTION

WINDOW (keyboard shortcut: ALT – V – I). (See above.)

2. The I-Frame Insertion window, as shown below, will open.

In this window, you can define time code locations that will be used to force I-frames in
the encoded video.

I-frame force points can be added by cueing the source deck and clicking on the I-Frame
Insert button in the Encoder Control Panel. By typing time code values into the I-Frame
Time Code Insertion dialog or by importing a formatted text list of time code values, this
can be accomplished.
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To enter an I-Frame Insertion point:

1. Cue the source deck to a point at which you wish to insert an I-Frame.

2. Click on the I-Frame Insert button in the Encoder Control section of the Encoder
Control Panel as shown above.

The time code of the current position of the source transport will appear in the left-
hand section of the I-Frame Time Code Insertion dialog. If the dialog is not already
open, it will appear onscreen when the I-Frame Insert button is pressed.

—or—

1. Open the I-Frame Time Code Insertion dialog.

2. Click on the main time code field.

3. Type in a time code that occurs in your source program at which you want to force
an I-Frame.

4. Click on the Add button to the right of the time code field.
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5. The entered time code will appear in a list field to the left of the time code field as
shown above.

To define the complete list of I-Frame force points, repeat the process from step 1.

Encoding with Forced I-Frames

Once a set of time code values have been entered into the I-Frame Time Code Insertion
dialog (see above), these values will be used for insertion during the encode. All that needs
to be done, then, is to execute a normal encode with machine control, with valid time
code values entered in the I-Frame Time Code Insertion dialog.
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Note: The I-Frame Insertion process is inherently limited to an accuracy of 2 frames, owing
to the nature of MPEG P- and B- frames. In reviewing MPEG with forced I-frames, you will
find that some frames are forced 1 or 2 frames later than the values specified.

Saving and Recalling I-Frame Insertion/Chapter Point Lists

The I-Frame Insertion lists you create in the I-Frame Time code Insertion window can be
saved and reopened at a later time. These lists can also be used later in the authoring
process to place Chapter Point Markers at the same locations. This can save a considerable
amount of time when defining chapter start points in a large Project. The use of  I-Frame
Insert Lists as Chapter Lists is covered in Chapter 6 of the main user manual.
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To save the current I-Frame Insertion List to your system’s hard drive:

1. Click on the Save button in the I-Frame Timecode Insertion window as shown above.

2. In the File Save dialog that appears, select the location and enter the name under
which you want to save the list file.

3. Click OK to save the file.

The I-Frame Insertion List is saved as a text-format file with the extension “.chp.” Likewise,
you can open any I-Frame Insertion List previously saved to disk.

To open a previously saved I-Frame Insertion List:

1. Click on the Open button in the I-Frame Timecode Insertion window as shown above.

2. In the Open Field dialog that appears, locate and select the I-Frame Insertion List file
you wish to open.

3. Click ok.

The selected list will appear in the I-Frame Timecode Insertion window (see below).
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Creating and Modifying the I-Frame Insertion List in Text Format

As noted above, the I-Frame Insertion Lists are actually text documents. This means that
they can be edited (or created) using any standard word processing program, including the
simple Notepad application delivered as part of the Windows NT operating system. (An
example is below.)

To view the I-Frame Insertion List in a text editing program:

1. Start up the text-editing program you prefer to use (Notepad will work fine).

2. Select OPEN from the program’s File menu.

3. In the File Open dialog, set the “filter” at bottom of the dialog to ALL FILES.

4. Locate the “.chp” file for the I-Frame Insertion List you wish to open.

5. Click OK.
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As you can see, the I-Frame Insertion List is a simple list of time codes that begins with the
following characters and words:

“$Spruce_Iframe_List”

This is the file’s “header string” and is necessary in order for your Spruce authoring soft-
ware to recognize the list. So long as this string is included, it is quite easy to create I-
Frame Insertion Lists from scratch or to modify any existing list.

To modify an existing I-Frame Insertion List in a text editing program:

1. Open the list into your word processor, as described above.

2. Make whatever additions, deletions, or modifications to the time code values you
desire.

3. Re-save the list in “text” format under the same or different name. If you use a
different name, be sure to use the extension “.chp”.

To create a new I-Frame Insertion List from scratch:

1. Create a new document in your text processing application

2. At the head of the document, enter the string “$Spruce_Iframe_List” (be sure to use
these exact characters and capitalization).

3. Enter time code values (hours:minutes:seconds:frames), in the same format as they
appear when you view an existing I-Frame Insertion List. Each entry must appear on
a separate line.

4. Save the document in “text” format; be sure to enter the extension “.chp”.

Any file created in this way can be opened as an I-Frame Insertion List or as a
Chapter List in your Spruce authoring system.

Using Externally-created EDLs as I-Frame Insertion Lists

Conventional video editing systems are able to store lists of time code locations as “Edit
Decision Lists” (EDLs). These are text documents that can describe a wide variety of
editing operations. These lists can be easily converted into a form that can be imported
into the Spruce authoring system.
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To convert an EDL file into an I-Frame Insertion List:

1. Open the file containing the time code points you want to use into a text-editing
program.

2. Strip out all information except the actual time code values you want to use as I-
Frame/Chapter points. For instance, you may wish to use a series of “time code in”
points (the point at which a video edit occurs) to establish your Project’s forced I-
Frames. Make sure each of these values appear on a separate line of text.

3. Insert the string “$Spruce_Iframe_List” at the head of the document.

4. Save the modified file in text format; be sure to enter the extension “.chp”.

This modified EDL can then be imported into the Spruce authoring system as a Chapter List
or an I-Frame Insertion List.

Delay Compensation for Video Pre-Processing
In quality-conscious MPEG encoding, it is often helpful to process the video signal prior to
encoding in order to reduce spurious video noise, excessive film grain, or other high-
frequency content that affects encoding. Today, several excellent real-time processors are
available that can enhance the quality of results in encoding by this type of signal condi-
tioning.

As with other digital video signal processing devices, these processors introduce a delay
into the video signal path, measured in frames. For real-time encoding, this delay repre-
sents a problem, since the audio and time code signals are not delayed to match.

In order to facilitate the use of digital video preprocessing in high-end encoding, a feature
has been added that will compensate for delay in the video path. When this is used, a
corresponding time advance is applied, resulting in perfect sync of audio and video as well
as frame-accurate encoding.
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To use Video Delay Compensation

1. From the View menu in the Encode/Decode Control Panel, select Video Compensa-
tion Setup (key equivalent Alt + V + C). (See above).

The Video Compensation dialog will appear.

2. Enter the value of the delay (in frames) introduced by the processing device you are
using as shown below.

To determine the correct value for the processing device you are using, consult the
manufacturer’s documentation.

Segment Re-Encoding on Networked Systems
The Spruce system offers a simple but powerful method of segment re-encoding for MPEG
video. This is often used to insert late changes into video, or to optimize multi-pass encoding.
For most-effective use, MPEG segment re-encoding is integrated into the authoring application.
Punch-in and punch-out points are entered into the video timeline, and the encode time
parameters are handed directly to the program that handles the encoding control.

DVDMaestro Power Feature!! Segment Re-encoding is an advanced encoding feature
found in DVDMaestro™. Segment Re-encoding functions may be added to DVDCon-
ductor or DVDPowerPack systems equipped with the MPX 3000 encoder by installing
the DVDEncoderPack upgrade package.
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For situations in which the authoring and encoding applications are run on different
computers, Version 2.5 introduces a method of sharing encoding settings over network,
allowing for segment re-encoding even when the encoding and authoring functions are
separated.

To set up segment re-encoding for separate computers:

1. On the authoring system, select that area to be re-encoded by placing Punch Point
markers as described in the system Encoding Manual.

2. Click-right on the video timeline between the two Punch Points. From the menu that
appears, select EXPORT RE-ENCODE SETTINGS as shown above.

3. A File Save dialog will appear as shown below. Select the location at which you will
store the file of encoder settings. This should be a directory that is accessible to the
encoding systems.
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4. Assign a file name, and click on Save.

The Encoder Setting file can be opened directly into the Encode/Decode Control Panel.

To re-encode video segment

1. Make sure that the correct source video tape is mounted and the source transport is
under control of the encoding system.

2. While the encoder software is open, go to the File menu on the Encode/Decode
Control. Select LOAD SETTINGS. (See below.)

3. In the Open Encoder Settings File dialog that appears, select the Encoder Settings file
saved from the authoring system as shown below.
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4. Select the desired file and click on Open.

The Punch-in and Punch-out points are loaded into the Encoder Control section. The
encoding parameters in the Settings Window are then updated to the settings called
for in the Encoder Settings file.

5. Update the encoding Bit-Rate and Mode settings as desired for segment re-encode.

6. Perform the encode as normal. Encode the output file to a directory that is accessible
to the authoring system or that can be moved to that system easily.

Once the re-encode file has been captured, it can be inserted directly into the original
stream at the authoring station.

To insert re-encoded section into MPEG video stream:

1. Mount the directory with the segment-re-encoded file onto the authoring station, or
copy data onto a drive accessible to that system.

2. Right-click with the mouse on the video timeline between the two Punch Points that
represent that segment you will replace.
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3. Select INSERT VIDEO SEGMENT. From the submenu that appears, select the Timecode
Based option. (See above.)

4. From the Select Segment dialog, as shown above, choose the file representing the re-
encoded segment. Click on Open.
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The re-encoded segment will be dropped directly into place in the video timeline, and it
will play back seamlessly in the RealView™ window and in the Navigation Simulator.
Upon compile, the original and re-encoded segments will be combined in a single video
object (“.vob”) file.

MPEG2 Bitrate Down to 1 Mbps
For purposes of efficient VBR encoding and for situations requiring low bit-rates, the lower
limit of MPEG-2 bit-rates has been dropped from 2 Mbps to 1 Mbps, as shown in the
Encoder  Settings window below.

Any bit-rate between 1,000,000 bits/sec and 9,600,000 bits/sec can be entered by typing
directly into the Bit-Rate dialog box (the MPX 2000 can go up to 9,800,000 bits/sec). For
information on selecting optimal bit-rates for MPEG encoding, refer to the system Encoding
Manual.
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AMPEG-1 Layer 2 Audio Encoding
Encoding of audio in MPEG-1 Layer 2 format is now supported for both the MPX 2000 and
MPX 3000 boards. The type of audio encoding is selected from the Encode Source pull-
down (Audio) in the Encoder Control section of the Encode/Decode Control Panel as
shown below.

To select the format of audio encoding:

1. Click on the Audio pull-down menu in the Encode Source section of the Encode/
Decode Control Panel.

2. Select MPX MPEG (2 CH)

The Encoder Settings window will not reflect the parameters that apply to MPEG-1 Layer 2
audio.
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Notice above that the Sample Rate is fixed 48 kHz. This is the sample rate setting that
applies to DVD.

In order to encode audio at other sample rates (such 44.1 kHz), it is necessary to deselect
the DVD Compliance forcing of the encoder from the Options menu of the Encode/
Decode Control Panel. (See below.)

To encode audio at sample rate of 44.1 kHz or 32 kHz

1. Go to the Options menu of the Encode/Decoder Control Panel

2. Select the option DVD Compliant. When this setting is off, you will have access to
settings that are out of range of the DVD specification, including audio sample rate.
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When the DVD Compliant setting is switched off, an Attention dialog appears (see above)
that indicates caution if encoding for DVD. Note that audio sample rate for compressed
audio for DVD (MPEG-1 or AC-3) is always 48 kHz.

3. In the Encoder Settings window, select the desired sample rate as shown above.
Make sure this is the correct rate of the incoming digital audio signal. If the Spruce
DCB 100 Digital Connect box is used, select the correct sample rate setting form the
Digital Connect tab of Encoder Settings.

4. Encode as normal. The resulting files will be at the designated sample rate.

PCM Audio Capture
Version 2.5 provides capability of capturing a PCM audio stream directly, without com-
pression for use in authoring. Resolution of 16 bit and sample rate of 48 kHz are sup-
ported.

Note: This is an MPX 3000 feature. This is not available on the MPX 2000 encoder.
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To capture PCM audio for authoring:

1. Click on the Audio pull-down menu in the Encode Source section of the Encode/
Decode Control Panel.

2. Select MPX PCM (2 CH).

3. Make sure that the incoming digital audio signal is at DVD standard values of 16 bits
and 48 kHz. No other sample rate or resolution is supported in Version 2.5.

4. Encode as normal. Audio will be captured in uncompressed PCM format.

Encoding and Multiplexing for Video CD
By encoding MPEG-1 video with MPEG-1 Layer 2 audio at a sample rate of 44.1 kHz, all
requirements are met for encoding for Video CD (VCD).

Unlike DVD, VCD authoring is customarily performed using MPEG-1 system streams that
have been previously multiplexed. Most Video CD authoring tools do not support author-
ing with elementary streams.

In order to support use of Spruce encoding systems in Video CD authoring, an separate
utility program is provided that can quickly multiplex MPEG-1 elementary streams for
video and audio.
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To multiplex video and audio for Video CD

1. Locate the Offline Multiplexer application (which should look like the screen above).
This program is found in a separate directory under the Utilities folder in the Spruce
folder created when the software is installed.

2. To start the program, double-click on MpegOfflineMuxer.exe.

The Offline Muxing application displays an interface dialog with spaces to define the
video and audio source files as well as the output file as shown above.

3. Type in the path of the video source file or click to the right of the Video File field to
browse.

4. Repeat for the audio source file.

An output file is automatically designated that has the root name of the video file
with the extension “.mpg”. If desired, you may designate another name and path for
the output file.

5. Click on the Mux button to initiate MPEG multiplexing.
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The Progress meter at bottom of the dialog indicates the progress of multiplexing. Upon
completion, the resulting output file may be input into standard Video CD authoring tools.

One-Button Restore of Default Settings for AC-3

Because of the numerous settings that can be associated with AC-3 encoding, a button has
been added to the bottom of the Encoder Settings window to restore the AC-3 parameters
to their default configuration. (See below.)

This default settings are fully suitable for DVD applications.

•        •        •

Index
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Application Note:  

Encoding Analog Video and Audio 

with the Spruce MPX3000™ 

Introduction 

The Spruce Technologies MPX3000™ MPEG encoder accepts serial digital video input in  
ITU-r-BT.656 bit serial interface (SDI) serial digital format.  Audio is input as AES/EBU balanced 
(XLR) digital audio.  

When it is desired to connect analog video/audio sources, there are three functions to be 
performed: Converting video to serial digital form, converting audio to digital, and synchronizing 
the audio sample clock to video frame sync. 

Converting Video 

Analog video comes from a wide variety of sources in several formats. These include those with 
heterodyned color (most consumer VHS or 8mm formats for example), those with component 
color (Betacam™ VTRs for example), and those with time base corrected (direct) color.  

Not all video analog to digital (A-to-D) converters can handle all types – be sure to select one 
that covers your needs. Additionally, you must consider whether it supports NTSC and/or PAL, 
composite, S-Video (Y-C), color difference (Y, R-Y, B-Y or YUV), or RGB. 

Converting Audio 

Analog audio comes in far fewer formats than video, but separate audio A-to-D conversion may 
be a problem due to the video synchronization requirement (see below).  

Analog audio is typically either balanced or unbalanced, at 600 ohms or High Impedance (High-
Z). Connector types include XLR, RCA, and bare wires. Note that an analog stereo pair (right 
and left) convert into a single AES/EBU signal, referred to as a channel. 

Synchronizing the Audio to the Video 

In order to maintain synchronization between video and audio, it is absolutely necessary to lock 
the audio sample clock to the video frame sync. Integrated video-audio converters generally 
provide this function. If you are evaluating separate audio A/D converters, look for a converter 
with a video reference input.  
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Recommended Products and Configuration Examples 

This application note details two approaches to connecting analog sources using 3rd party 
devices. The first approach uses a single chassis product by Digital Processing Systems™ (DPS) 
and the second uses products by Graham-Patten and AJA. Both approaches have been tested 
and proven to work by Spruce Technologies. These are by no means the only solutions 
available; there are other devices available that would provide similar results. 

MPX3000™ Audio Notes 

There are several audio related things to be aware of when connecting devices to the MPX3000: 

• Only two of the four audio channels can be active at a time.  

• The 1/2 input must always have a signal connected since it supplies the audio clock.  

• All audio input clocks must be locked to the video input clock.  

• The audio input impedance is 110 ohms. Make sure your source is the same. Use 
appropriate conversion devices when connecting unbalanced (BNC) sources. 
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Using the Digital Processing Systems™ DPS470 

The DPS470AV (NTSC) and DPS470PAV (PAL) are manufactured by Digital Processing Systems 
(DPS). They are versatile devices providing all of the needed inputs and outputs in a single one-
rack unit chassis designed to fit a standard 19" rack.  

Video Inputs 

An advantage of this device is that it provides analog composite, color difference (Y, R-Y, B-Y), 
and S-Video inputs, and due to its internal TBC, can be set for heterodyne or direct color 
sources. RGB sources are not supported. This makes it suitable for use with consumer as well as 
professional equipment. It cannot be switched between NTSC and PAL.  

Audio Inputs 

The DSP470 uses removable barrier strips to connect analog audio. There are provisions for two 
stereo channels. The analog audio can be balanced or unbalanced, 600 or 20K (High-Z) ohms. 

 

 

Usage Notes 

• The DPS470AV is shipped with its AES/EBU I/O terminated for BNC unbalanced usage 
(75 ohms). For this application, only the AES/EBU outputs are used, and the MPX 3000 
requires a balanced XLR connection (110 ohm termination). Set the termination using 
jumpers on the audio board PCB inside the chassis. See the DPS470AV documentation 
for detailed information. 
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R
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R
L

SDI SDI

AES/EBU AES/EBU

Digital
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AES 1
Out

AES 2
Out

Ch 1
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Set the following using the front panel controls: 

• Be sure to set the Sync Mode to match the type of video being input (Synchronizer for 
stable, direct color video, such as from a Sony Betacam VTR, or TBC for heterodyne 
color, such as from a VHS or 8mm source). Selecting Auto-Switch allows the DPS470AV 
to choose the proper video type automatically. 

• Set the Audio Input Source menu to ANLG to select the analog inputs.  

• Set the Analog I/P Termination to match the connected audio (600 Ohms or High Z).  

• Set the Analog Input Type to match the connected audio type (balanced or 
unbalanced).  

• You must enable the SDI Audio Embedder (set to On). Although the MPX3000 does not 
use embedded audio, this also forces the DPS-470's 48 KHz AES/EBU outputs to be 
locked to the SDI video output clock. 

Visit the DPS website at www.dps.com for more information. 
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Using Graham-Patten Audio and AJA Video Converters 

The following configuration provides the required analog to digital conversion at a lower cost 
than the DPS470AV, but uses several components as opposed to a single chassis. This approach 
works well when using professional sources; it does not support consumer sources. These 
components can be set to NTSC/525 or PAL/625 line standards. 

The Graham-Patten SoundPals™ Devices 

Graham-Patten manufactures a line of audio devices referred to as “SoundPals™”. These are all 
similar in size and shape (5.2"W x 1.62"H x 6.625"D).  

The ADC-20 provides the audio analog to digital conversion function. It has two balanced 600-
ohm XLR inputs (right and left). It has both balanced and unbalanced AES/EBU outputs. There is 
also an AES reference input that is connected to the VRG-1. 

The VRG-1 creates a reference signal to lock the ADC-20’s output to the video signal. There is a 
looping video input - connect the composite or Y video signal here. Connect the looping output 
to the video A-to-D converter. There is a switch to configure for NTSC or PAL. There are three 
reference outputs: WCLK and two AES outputs, one balanced and one unbalanced. Connect 
the unbalanced AES output to the reference input of the ADC-20.  

To make the installation rack mountable, they also have the RT-2 – a tray to hold up to three 
devices and provide the required power. The RT-2 fits a standard 19" rack and is one rack unit 
high (1.75"). If the rack tray is not used, a pair of wall mounted power supplies provides power 
for the ADC-20 and VRG-1 modules. Use PS-3A's for 115-volt installations and PS-2A's for 220-
volt installations. 

Visit the Graham-Patten website at www.gpsys.com for more information. 

The AJA Devices 

AJA manufactures a line of video products, including several analog to digital converters. There 
are separate devices for analog composite/S-Video and component video inputs. Use the AJA 
D5D for composite/S-Video systems, and the D10A for component. Both devices require stable 
TBC type sources – devices providing heterodyne color (such as most consumer VHS players) 
cannot be used. 

The AJA D5D has two BNC inputs - one for composite or Y (luminance of an S-Video source) 
and the other for C (chroma of an S-Video source). There are three ITU-r-BT.601 serial digital 
outputs. It automatically detects NTSC or PAL. It is 5.2" x 2.4" x 1". 
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The AJA D10A has four analog BNC inputs – Y/G, B-Y/B, R-Y/R, and Sync. Internal jumpers 
choose the input format (RGB or Color Difference). There are three ITU-r-BT.601 serial digital 
outputs. It automatically detects 525 or 625 line standards. It is 6" x 3" x 1". 

Visit the AJA website at www.aja.com for more information. 
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C
Spruce DVD Authoring System Version 2.5
New Authoring Features Addendum

Introduction
Version 2.5 of the Spruce Technologies family of DVD authoring software brings numerous
new features and functions to users of DVDMaestro, DVDPowerPack, and DVDConductor.
This document details the new features available in each product configuration and
provides complete documentation of their use.

There are two general groups of new features and functions to consider:

• Entirely new features and functions introduced into DVDMaestro and other product
configurations.

• Features and functions previously available to DVDMaestro users that are now also
available to users of DVDPowerPack, DVDConductor, or DVDMaestro.

The new features in version 2.5 are divided into six general categories:

• Extended Parental Management Functions

• Spruce Advanced Memory Management™

• TimeLine/Movie Features

• Menu Editor Features

• Other Authoring/Premastering Features

The master list of new features appears below, followed by details and selling points on
each. In addition, the distribution of features between different members of the product
family has been shifted to better serve the needs of the market. These changes are
summarized at the end of this document.
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Extended Parental Management Functions
Version 2.5 extends the application of DVD Parental Management functions by implementing
a group of features that support international rating levels, specification of a rating level by
individual movie, and active intervention to temporarily set the player parental level.

The Extended Parental Management Function is a feature included with DVDMaestro.
DVDConductor users may add this feature by upgrading their software to DVDMaestro.

The Project Properties Dialog
The Project Properties dialog is the starting point for setting up Parental Control functions.

To open the Project Properties dialog:

1. In the Project window, right-click with the mouse on the icon of a DVD at the top of
the “tree”. This icon is followed by the name of your current project.

2. From the menu, select PROPERTIES.

The Parental Control section of the Project Properties dialog is located in the upper
right portion of the General properties tab (as shown below).
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Settings in this portion of the Project Properties determine the overall behavior of the title with regard to Parental
Control.

Support for International Parental Rating Levels.
The list of available Rating settings has been extended to support use of Parental Control in
an International context.

SP13 Check

The first item in this list calls for particular explanation. System Parameter 13 (SPRM 13 or
SP13) is the memory location that is read by Command Sequences to determine the
current setting of Parental Level of the player.
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DVD uses an indirect method to set the Player Level. The user-defined setting of the player
is combined with a table on the DVD disc to determine the actual level read in SP13.
Selecting SP13 Check for the Rating Level of the disc will set up this table.

This allows Command Sequence scripts to read the player’s level setting accurately. This,
in turn, allows parental control functions to be implemented in Command Sequences,
which can offer greater flexibility than the built-in checks for the Rating Level of DVD title
or individual Movies within the title.

Not Rated

In the case that the disc is set to Not Rated, then no setup of the SP13 occurs. The disc can
be played on all players, regardless of player Parental Level setting.

Rating Levels 1-8

By setting a Rating Level of 1 through 8, the player will automatically refuse access to the
disc if the player’s Rating Level is lower than that of the disc. Note that five of the eight
Level selections correspond to the US ratings system of G, PG, PG-13, R, and NC-17. All
eight levels are available for international use.

Set Parental Level for Individual Movies
Optionally, Rating Levels can be assigned to each individual Movie in the title.

To set Rating Level by individual Movie

1. Open the Project Properties dialog by right-clicking on the icon at top of the Project
window. From the pull-right menu, select PROPERTIES.

2. In the Project Properties dialog, deselect the checkbox that says Apply to All Movies.
Set the overall disc Rating as desired.

Note that the overall disc rating will be as high or higher than that of any Movies
within the title.

Version 2.5 New Authoring Features Addendum C-7

C3. Click OK to close the Project Properties dialog.

4. Open the Movie Properties dialog by right-clicking on the icon representing an
individual Movie in the Project window.

5. At the lower-mid area of the Movie Properties dialog, you will see a Rating Level
selection like that in the Project Properties dialog as shown above.
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6. Select the Rating Level desired for the selected Movie.

7. Click OK to close the Movie Properties dialog.

8. Repeat to set Rating Level for each Movie in the title.

Controlling Access by Display Condition or Command Sequence
As described later in these notes, access to a Movie can be controlled by setting a Display
Condition in the Movie Properties. By setting the Display Condition to check the player
Rating Level, access to a Movie can be controlled without setting the Rating Level. The
advantage of this approach is that an alternate destination can be specified. Depending on
the design of the title, the viewer might not even be aware that their viewing selection was
being controlled.

Similar results and even greater flexibility can be attained by querying the player Rating
Level in a Command Sequence. Note that in order to check Rating Level in a Command
Sequence, it is necessary to use a GPRM (or designated variable as described below).

Set Temporary Parental Level by Command Sequence
The DVD specification provides a means of changing the Rating Level of the player
temporarily, by prompting the viewer to enter a password. At the end of play, the player
will revert automatically to it regular setting.

This type of management of parental control is considered desirable, as it provides the
viewer the protection of knowing that they cannot forget to return the player to its pro-
tected setting.

The Temporary Parental Level (Temp Parental) can be set only by Command Sequences. If it is
desired to use this type of parental control, then the Rating Level in Project Properties is set to
SP13, and management of “viewing permissions” is handled by Command Sequences.

To use Temporary Parental Level

1. Open the Project Properties dialog.

2. Set the Rating Level for Parental Control to “Check SP13”.

3. Deselect the checkbox “Apply to All Movies”.

4. Open the Movie Properties dialog for each Movie in the project and set the Rating
Level to the appropriate setting.
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C5. For each Movie that has rating protection, create a Command Sequence. This
Command Sequence will serve as “gatekeeper” for the particular Movie.

6. Open the Command Sequence Editor (as shown below) for each Movie that requires
rating protection. Place a single command in each sequence that sets the temporary
Parental Level to a suitable value, then jumps to the target Movie, as shown below.

7. In the Connections window shown below, each point at which a Menu or other
action is intended to go to one of the protected Movies, jump to the corresponding
Command Sequence that sets the Temporary Parental level (and, hence, cause the
player to prompt the viewer for the password set for that player at that level).
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Quality Assurance Review for Parental Management Functions
Quality assurance of titles that use parental control features calls for particular consider-
ations. In version 2.5, the Navigation Simulator provides only partial review of parental
control features. The DVDPlayer emulation tool also reproduces only certain aspects of
parental control, although the set support in DVDPlayer is different from that in the
Navigation Simulator. Some functions of parental control, such as Temporary Parental
Level, are not supported by either tool.

Parental Control Features of the Navigation Simulator
The Navigation Simulator, shown below, does not reproduce a player’s automatic check-
ing of Rating Level for disc or Movie. Nor does it implement the Display Condition for
Movies or Temporary Parental Level.
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It does however, allow for checking of player level by Command Sequences. As noted
before, the structure of DVD command language makes it necessary to either transfer the
SPRM to be queried into one of the variable memory registers (GPRM or part thereof) or to
preload a variable memory register with a fixed value. In either case, the temporary use a
variable memory register is required. As the Parental Level settings range from 1 to 15 (15
being “no rating set” and 1-8 corresponding to the eight parental control levels), the variable
for this purpose can be sized at 4 bits or greater, as described later in this document.

When testing Command Sequence navigation based on Parental Level using the Naviga-
tion Simulator, the player rating level can be set by entering a value into the field “13-
Parental Level” in the Advanced section. Any Command Sequence that reads SP13 will
read this value and act upon it as desired.

Note that the value of “13-Parental Level” is reset when the Navigation Simulator is
closed.
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Parental Control Features of DVDPlayer (Emulation)
After a title is compiled, it can be played using the built-in DVDPlayer. This player appli-
cation supports parental checking for the whole disc, but not for individual Movies.

Also there are only three settings available for Rating Level. DVDPlayer can also check
SP13 by Command Sequences, but it does not implement Temporary Parental Level.

The Rating Level of the DVDPlayer application, shown above, is set in the Settings window for the program.
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To set Rating Level for DVDPlayer

1. Start the DVDPlayer application.

2. Right-click in the DVDPlayer window and a menu will appear. Select PROPERTIES.

3. In the Settings window, select the Parental tab.

4. Set the Rating Level as desired. Click OK to close.

As noted, the player will check the Rating Level for whole project and by Movie. It will not
however, implement Temporary Parental Level.

Spruce Advanced GPRM Management™

Version 2.5 introduces a remarkable extension of Spruce’s advanced DVD authoring
abstraction. By mapping the individual bits of the DVD player’s GPRM memory registers,
the function of these memories is expanded from 8 16-bit registers to as many as 128
individual program variables. Each variable can be assigned a name that is used to refer to
that location throughout command sequence editing.

Spruce Advanced GPRM Management is included with DVDPowerPack and DVDMaestro.
DVDConductor users may add this feature by installing the DVDPowerPack upgrade.

Mapping GPRMs to Multiple Named Variables
The assignment of individual memory variables is performed from the new DVD Register
Mapping dialog, which is invoked from the pull-right menu for the Command Sequences
folder.
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To assign variable-length memory locations to DVD GPRM registers.

1. In the Project window, right-click on the icon of the folder for Command Sequences

2. From the menu, select the command Edit DVD Register Map

The DVD Register Mapping dialog will appear, as shown above.
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C3. Select one of the eight 16-bit GPRM registers (GPRM0-7) from the “Select Register to
Edit” pull-down as shown below:

This defines the register that will be mapped. The 16-bit GPRM register can be
divided as a single 16-bit register, as two 8-bit registers, as four 4-bit registers, eight
2-bit registers, or as sixteen single-bit flags. Different GRPM registers can be divided
differently as desired to configure the memory required for the project.

4. In the Register Allocation section of the dialog, use the Allocation Type pull-down
menu, as shown above, to define how the selected GPRM register will be divided.

An individual variable name is assigned to each separate “chunk” of the designated
GPRM. These names are used in constructing Command Sequences.
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5. Assign appropriate names to each of the variables created by “splitting” the desig-
nated GPRM, as shown above. Select names that will have meaning to you when
you use these variables in Command Sequences programming.

Once the size of the variable registers and their names are determined, these names
will appear in the Command Sequence editor just as though they were additional
GPRM registers.  This is shown below:
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To edit Command Sequences using variables assigned by Register Mapping.

1. Create a Command Sequence. Open the Command Sequence Editor by double-
clicking on the icon of the new sequence.

2. Enter individual commands as described in the Command Sequence chapter of the
User’s Guide.

3. Select variable names as desired from the pull-down menus. When the menus refer
to GPRM memory, you will see the names of the variables designated in the DVD
Register Mapping dialog instead.

The Spruce authoring system will manage the handing and masking of memory in the back-
ground, where you don’t have to worry about it. All Command Sequence functions using
advanced memory functions will behave correctly in the Navigation Simulator.
When the title is compiled, all references to variables are converted into compatible com-
mands for DVD.

Note that once a given variable has been used in a Command Sequence, the mapping of the
GPRM in the DVD Register Mapping dialog is disabled. This prevents confusion caused by
remapping variables that are used by an existing sequence. The affected GPRM can only be
remapped if every Command Sequence that refers to a variable mapped in that GPRM is deleted.

For this reason, it is best to think through the selection of variables needed for a given project
and map the GPRMs appropriately before you begin to code the Command Sequences
themselves.
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Reordering Command Sequences

In version 2.5, the order of appearance of Command Sequences in the Project window can
be changed by the user to aid in keeping track of complex sets of interacting sequences.

To reorder Command Sequences

1. In the Project window, right-click on the icon of the folder for Command Sequences

2. From the menu, select the command Re-Order Command Sequences.

The List dialog that appears shows all Command Sequences that exist in the current
project. The order of these can be changed by dragging a sequence from its current
position in the list to the new desired location.
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TimeLine/Movie Features
Version 2.5 implements several new features in assembling DVD Movies in the timeline
editing interface. These include features to:

• use different colors for different subtitles,

• control subtitle color through .stl script commands,

• use uncompressed PCM audio with the Create Audio in Sync command,

• define default settings for audio and subtitle language,

• assign preconditions for Movie display

• grab still pictures from an MPEG video stream, and

• import MPEG-encoded video in AVI file format

The details of these functions are listed below.

Multiple Colors for Subtitling
For the first time, users of Spruce DVD authoring systems can incorporate subtitles that use
different colors for different titles.
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The colors used for any subtitle or stream of subtitles can be assigned from a Palette of 16
colors associated with the Movie. This Palette can be edited as desired and will apply to
the entire Movie.

By initial default, the Outline 1, Outline 2, Text, and Background colors are indexed to the
first four colors in the Palette. The default Color Palette sets these colors to Black, Black,
White, and Red, respectively

Selection of colors for subtitles can be performed in two different ways: either by changing
the color index within the current palette or by changing the colors within the palette.
(Remember that any changes to the Palette will apply to every subtitle in the Movie, while
changing the colors within the Palette affect only specific titles.)

To edit the subtitle Color Palette

1. In the Subtitle Editor dialog, select the Colors parameter setting tab.

2. Click on the Edit Palette button at the bottom of the tab. The Edit Palette will appear
as shown below.

The left-hand portion of the Edit Palette dialog displays the current selection of 16
colors available for subtitles.

There are two methods by which you can define the setting of any color in the
current Palette:

3. Select the “color swatch” corresponding to a palette entry you would like to change.
The RGB values associated with that selection will appear in the Edit Color section.

4. Enter the new RGB values that you wish to use for the new entry.

5. Click on the Apply button.

—or—

6. Double-click on the color swatch that you wish to change. A dedicated color picker
dialog will appear.
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7. Use the controls in the Color dialog to set the color desired.

8. Click OK to close the dialog and set the current color.

In either case, you can repeat to set all colors as desired. The new Palette can be saved to
disk for use in future projects.

To complete configuring and saving the Color Palette

1. Repeat until the desired Palette is established.

2. If you wish to use this Palette in the future, click on the Save button and store the
Palette under a suitable name and path.

3. Click OK to close the Edit Palette dialog

The color settings for any individual subtitle can be altered by clicking on the color
swatches for the different elements of the title. The selection of “index” in this way
affects only the current subtitle
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To select the color of an individual subtitle

1. Open the Subtitle Editor dialog for the subtitle you wish to affect

2. Click with the left mouse button on the color swatch for Text (or Outline 1 or 2)

3. Select the desired color from the Palette selection that appears. If the color you need
does not appear, then use Edit Palette to modify the current Palette.

4. Repeat for Outline 1 and Outline 2, if desired.

The same mechanism can be used to set colors when using Bitmap files rather than
text input. The only difference is that the elements of rendered text (Outline 1,
Outline 2, Text, and Background) are replaced by Color Maps 1-4.

Because subtitles with bitmap source graphics have four colors available, it is
possible to use these to put different subtitles of different color onscreen at the same
time. This requires rendering of the source bitmap with two different colors for the
body of the two subtitles.
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CScriptable Colors for Subtitles
In the Spruce Subtitle Text List (.stl) file format, the colors of subtitle can be specified by
reference to the current Color Palette. Note that the Color Palette itself cannot be set by the
script at this time. The listing below shows the use of the color index commands in the .stl
format subtitle script. For a complete description of the .stl format, refer to the User’s Guide.

// Spruce Technologies Subtitle List Sample
//
// The control commands that redirect color references within the current Color //
Palette are as follows:
//
// $ColorIndex1
// $ColorIndex2
// $ColorIndex3
// $ColorIndex4
//
// Color Index references range from 0 to 15, with each color pointing to an
// entry in the current Color Palette. The Color Palette is defined within the // Sub-
title Editor.
//
// The initial default settings are:
// $ColorIndex1 = 0
// $ColorIndex2 = 1
// $ColorIndex3 = 2
// $ColorIndex4 = 3
//
// For text-mode entry, the Color Index numbers correspond to character
// elements as follows:
//
// $ColorIndex1 = Outline 1 (Main)
// $ColorIndex2 = Outline 2 (Alternate)
// $ColorIndex3 = Text Body
// $ColorIndex4 = Background
//
// The following lines show possible uses of the Color Index commands

$ColorIndex1 = 0
$ColorIndex2 = 1
$ColorIndex3 = 2
$ColorIndex4 = 3

01:01:01:00 , 01:01:10:00 , This shows the default color index assignments

$ColorIndex3 = 4 //Change only the Text Body Color

01:01:11:00 , 01:01:21:00 , This shows a different color for the text body

$ColorIndex1 = 4
$ColorIndex2 = 5
$ColorIndex3 = 6
$ColorIndex4 = 7

01:01:22:00 , 01:01:32:00 , This shows a complete alternate set of colors
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Color Index commands can be combined with any other commands in the .stl format.
Creative possibilities include “color wheel” animations by changing color indexes rapidly
or using different colors to indicate different persons speaking.

Auto-Conform (Create Audio in Sync) for PCM Audio
Version 2.0 of the Spruce Authoring System introduced the Create Audio in Sync feature,
which allows the automatic re-conforming of AC3 audio tracks to fit video assets that have
been trimmed and/or concatenated together.

In Version 2.5, this innovative and useful feature can also be applied to uncompressed
PCM Audio. The feature operates in the same way as for AC3. However, audio in PCM
format does not include embedded timecode information, so this function is disabled in
the case of PCM.

Also note that the DVD specification does not allow for the combination of audio in
different formats on a single track. All source files for Create Audio in Sync must be in the
same audio format.

To auto-conform audio in PCM format:

1. Place video assets in the video timeline. Trim and concatenate as desired.

2. Right-click with the mouse in the first audio timeline. Select the command Create
Audio in Sync.
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The Sync Audio File Dialog will appear, with listings for audio files that have the
same root name as the video files, if available. The format of files is detected and
displayed, with the format of the first file found determining the format of other
acceptable audio source files.

If the format of audio is PCM, then the Sync Audio to Time Code checkbox at lower
left is disabled. Video and audio files will be synchronized with reference to the first
frame of video and the first sample of audio.

3. If required, enter any additional audio files by left-clicking in the corresponding
Audio File Area and/or assign a name for the output file.

4. Click on the Create Audio File button.

The system will create a new audio file that concatenates the sections of each source
audio file that correspond to the sections of the source video files used. The resulting
file is inserted into the audio timeline and will synchronize with each Video file.

Note: If you are syncing multiple audio files to multiple video files, the “Create Audio in Sync”
function will sync the beginning of each audio file to the beginning of each video file.  What
this means is that an audio file that is longer than the video file will be chopped at the end of
the video. An audio file shorter that the video will have silence added till the end of the video.
This mean that each audio and video file will always start at the same time.
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Default Settings for Audio and Subtitle Languages
For worldwide use of the Spruce Authoring System, the Movie section of the Program
Preferences includes a specification of the default language settings for audio and subtitles,
as shown below.

To set the default audio and subtitle language:

1. From the File menu, select PREFERENCES or use the keyboard shortcut Alt + f  + f.

2. In the Program Preferences dialog, select the tab Movies.

3. Enter the 2-letter language code for the desired language default.

4. Click OK to close.

The designated language will appear as the default selection for audio and subtitle streams
in all projects.

Note that the 2-letter code entered must correspond to one of the language codes sup-
ported by the DVD specification, as indicated in the Select Language Code dialog
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CPre-Conditions for Movie Display
Version 2.5 applies the same innovative conditional display technology to DVD Movies
that has been available in the Menu Editor in DVDMaestro for some time. The interface for
assigning Display Conditions appears in the Movie Properties dialog as shown below.

The Pre-Conditions for Movie Display function is a feature included with DVDMaestro.
DVDConductor users may add this feature by upgrading their software to DVDMaestro.

One advantage that Display Condition for DVD Movies has over the same feature as
implemented for DVD Movies is that the alternate navigation target can be a Movie, a
Menu, a Command Sequence, or Resume.
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To apply Display Conditions for a DVD Movie:

1. Right-click on the icon of the Movie you wish to affect in the Project View window.

2. Select PROPERTIES.

The Movie Properties dialog will appear.

The Display Condition interface is found in the lower-right-hand portion of the
dialog. Its operation is similar to that of Display Conditions in the Menu Editor.

3. Select the parameter you wish to test from the leftmost pull-down menu. The default
condition (Always True) means the Movie will display whenever called, without
regard to any conditional testing.

4. Select the condition of the selected parameter for which you will display the current
Movie.
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5. Right-click with the mouse in the field Otherwise Go To. Select the alternate target
from the menu tree that appears.

A decision tree with multiple possible targets can be constructed by creating a series of
Movies with the same parameter tested for different conditions. The player navigation will
move instantly through the “rejected” Movies until it reaches a Movie (or other target) that
satisfies the desired condition or has not had a Display Condition assigned.
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Grab Still From Video
Version 2.5 provides a means of grabbing a bitmap directly from the video timeline for use
in Chapter Menus and other graphic elements. A bitmap can be taken from any marker,
including temporary markers that you delete after getting the required still image.

To grab still image bitmaps from MPEG-2 Video:

1. Open the Edit Marker dialog by creating a new marker or editing an existing marker
in the timeline.

2. In the Edit Marker window, click on the button at lower left that says “Save As
Bitmap”.
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3. In the file save dialog that appears, define the path and filename for the bitmap file to
be created.

A new bitmap (.bmp) file will be created at the current video resolution. This graphic
image can be used directly as a menu background, slide show image, etc., or it can be
opened into Adobe Photoshop or other graphics tools for incorporation in composite
menus.
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Menu Editor Features
Version 2.5 implements a number of new features and functions that affect DVD Menus.

10,000 Menu Limit

Prior versions of the Spruce Authoring System “limited” the number of DVD Menus in a
project to a maximum of 1,000. While this number is more than adequate for the vast
majority of DVD projects, special cases can occur that require a larger number of Menu
elements.

In version 2.5, the maximum number of DVD Menus that can be included in a project has
been increased to 10,000.

Scroll Bars in Menu Editor

When authoring on workstations with smaller-size screens, it is often not possible to size
the Menu Editor to show the entire Menu graphic at once.
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CIn Version 2.5, scroll bars have been added to the Menu Editor graphic workspace to
permit access to all parts of the window even when operating with constrained screen
space.

User-OP Control of Menu Button Activation from Numeric Keypad

Most DVD players offer access to onscreen Menu buttons by numeric entry as well as by
selection with remote or mouse.

In some instances, it is desirable to limit access by numeric entry only some of the buttons
on a menu. In Version 2.5 the Advanced tab in the Menu Editor, as shown above, provides
a field to define which buttons on the menu are available for selection by numeric keypad
entry from a player’s remote control.
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The User-OP Control of Menu Button Activation from Numeric Keypad Function is a
feature included with DVDPowerPack and DVDMaestro.  DVDConductor users may
add this feature by installing the DVDPowerPack upgrade.

To define the buttons of a DVD Menu available for selection by numeric Entry.

1. Create all buttons required on the affected Menu.

2. Select the Advanced tab in the Menu Editor.

3. Locate the pull-down menu called Key Buttons.

4. From the pull-down menu, select All (default), None, or a button number.

The button number selected will determine which keys can be selected by numeric entry.
Every key up to and including the designated key number will be available for numeric
entry. All key numbers above the designated value will be unavailable for selection by
numeric entry.
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CPan-Scan Setting for 16:9 Menus

With Version 2.5, DVD Menus configured for 16:9 aspect ratio can be displayed on 4:3
video displays in either Letterbox or Pan-Scan format. This is a global setting that affects
the entire project.

To set the display mode for 16:9 menus:

1. Open the Project Properties dialog. (Right-click on the icon at the top of the Project
View window and select PROPERTIES.)

The 16x9 Menu Aspect Ratio setting is located in the upper-left portion of the dialog,
immediately beneath the settings for TV System.

.

2. Select the mode in which you would like 16x9 Menus to display when shown on
4x3 screens.

Note that selecting Pan-Scan mode will result is loss of the left and right edges of the Menu
graphic when shown on a 4x3 screen. Be sure to design your menus so as to avoid problems.

General Authoring/Premastering Features
There are several new features in Version 2.5 that do not fit neatly into a single category.
These include:

• Ability to print a log of the current project when creating the disc image on DLT

• Support for ISO Publisher ID in the disc information

• Support for coding to restrict disc usage to in-flight entertainment only (Region 8)

• Support for NVRAM features of Phillips Pro DVD player

• Support for DVD Jacket Picture feature
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The operation of these features is detailed below.

Printable Project Log
At the time of transferring a project to DLT master, you now have the option of printing a
log of the project properties. This can be used to accompany the master tape to replication
to verify correct settings of the disc.

To print the layout properties of the current project

1. Compile the title.

2. Select the Disc Image Creation tool by clicking on its icon or by choosing it from the
Options menu.

3. In the Disc Image Creation dialog, shown above, select the option for DLT Tape. It is
not possible to print the layout settings with other options selected.

4. Click on the Create Disc Image button.
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When you click the Create Disc Image button, a dialog appears that lists the current settings of the replication
properties of the disc (shown above).

5. In Current Layout Properties dialog, select Print. The Print dialog will appear. Select
the desired Printer and settings and click on OK
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6. After the log has printed, click on OK (to continue with premastering) or click on
Cancel to return to the Disc Image Creation dialog.

The layout settings may also be printed when the Disc Image is written to the hard drive,
then transferred to DLT using the Write Tape tool.

ISO Publisher ID field
The DVD specification provides for embedding the ISO Provider ID into the disc informa-
tion of a title for copyright verification purposes. The field for setting this appears in the
General section of the Project Properties dialog as shown below.
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CThe ISO Publisher ID function is a feature included with DVDMaestro.  DVDConductor
users may add this feature by upgrading their software to DVDMaestro.

To set the Provider ID for inclusion in the finished disc:

1. Open the Project Properties dialog by right-clicking on the icon of the Project at the
top of the Project window. Select PROPERTIES.

2. Enter your ISO Provider ID code into the Provider ID field in the General tab of
Project Properties. Click OK to close.

3. Author and master your project normally. The Provider ID entered will be embedded
in the designated field in the disc information file of the finished DVD title.

Region 8 (Airline) Support
The DVD specification now supports a total of 8 “regions” in the Regional Management
Information. Region 7 has not been assigned. Region 8 is designated for in-flight entertain-
ment systems.

Regional Lock Support is a feature included with DVDMaestro.  DVDConductor users
may add this feature by upgrading their software to DVDMaestro.

If the title you create is to be used in this application, you will need to select the checkbox
for “8 –In Flight Entertnmnt” in the Replication properties section of the Project Properties
dialog. Note that this code is not selected by default.

1. Open the Project Properties dialog by right-clicking on the icon of the Project at the
top of the Project window and choose PROPERTIES.

2. Select the Replication tab of the Project Properties dialog.
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3. In the Regional Management Information section of the dialog, set the checkbox for
“8 – In Flight Entertnmnt.” Select or deselect other regions as desired.

4. Click OK to close Project Properties and continue with authoring and premastering.

DVD Jacket Picture Support
The DVD specification provides for inclusion of graphic still images, called “Jacket Pic-
ture”, that can be displayed for cataloging and selection purposes.

DVD Jacket Picture Support is a feature included with DVDMaestro.  DVDConductor
users may add this feature by upgrading their software to DVDMaestro.

While most players on the market to date do not support this feature, recent multi-disc
players make effective use of Jacket Picture to construct selection menus to choose indi-
vidual discs from a potentially large number of available discs.

Version 2.5 supports the inclusion of graphic image for Jacket Pictures.

Per the DVD specification, Jacket Picture graphics should be supplied in 3 different
resolutions for display on different platforms and display devices. The source graphics are
entered as pre-encoded MPEG-2 still graphics.

To specify graphics for inclusion as Jacket Picture:

1. Open the Project Properties dialog.

2. Click on the button labeled JACKET PICTURE, located immediately underneath the ISO
Publisher ID field.

The Jacket Picture dialog provides fields to specify source graphic files in MPEG-2
Still format for the three resolutions called for by the DVD specification

Version 2.5 New Authoring Features Addendum C-41

C

3. Use the Browse buttons to the right of each field to select the source file for each picture
scaling as shown above. Note that the source files must be pre-encoded as MPEG-2 stills.

The resolutions of each size picture, as defined by the DVD specification, are as follows:

NTSC PAL
LARGE 720 x 480 720 x 576
MEDIUM 176 x 112 176 x 144
SMALL 96 x 64 96 x 80

Embedded Text for Convergence™ Support
This is a feature that will enable support for Spruce Technologies’ Convergence™ line of
products. To turn on this feature, go to the File pull-down menu and select PREFERENCES.
Click on the WebDVD tab. The following dialog will appear.
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While this feature will support WebDVD, there are a large number of features that Embed-
ded Text Strings cover, which is outside the scope of this manual. For more information on
this, please visit the web site www.webdvd.org.

Encoding Button Assignable to a Third Party Encoding Application
This is a feature that allows you to assign the encoder button, located at the top of your
Spruce software (the leftmost button below), to a third-party encoder application.

This can be useful, for example, if you do not own Spruce hardware, but have another
hardware or software MPEG encoder in your computer.  By assigning this button to the
executable of the application, you can conveniently open the third party encoder applica-
tion while you are authoring, by clicking on the encoder button.

You can assign this feature by clicking on the File pull-down menu and select PREFERENCES.
On the General tab you will see a checkbox to Use Third Party Encoding Application.
Select this checkbox and click on the “…” button, as shown above.  A dialog will pop up
to chose the executable of the application you would like to open when you click on the
encoder button (e.g. encode.exe).
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Conclusion
This completes the explanation of new authoring features included in the Version 2.5
release of all products in the Spruce Authoring Systems, including DVDMaestro,
DVDPowerPack, and DVDConductor. For complete information on the operation of Spruce
Authoring System, refer to the main body of the User’s Guide. For information on MPEG
and AC3 encoding, refer to the separate Encoding manual.

Thank you for using Spruce’s innovative and award-winning DVD authoring products. We
hope that you enjoy the many features these products offer, including the new features in
Version 2.5.

•        •        •



DVDMaestro User’s GuideC-44

Appendix A: 

Selected Glossary



DVDMaestro User’s GuideA-2 Appendix A: DVDMaestro & DVDConductor Selected Glossary A-3

AAppendix A:
DVDMaestro & DVDConductor
Selected Glossary

1-Pass & 2-Pass VBR (Variable Bit-Rate) Encoding
See Bit-Rate.

4:3
See Aspect Ratio.

9-Pin
See Machine Control.

16:9 Letterbox
See Aspect Ratio.

AIFF
A digital audio file format supported by Spruce authoring software, for use as an imported
audio asset and one of the most common file formats for the Macintosh operating system.
Unlike Dolby AC-3 or MPEG audio, AIFF audio is uncompressed. “AIFF” stands for Audio
Interchange File Format. Its file extension is “.aif”. Also see PCM.

Angle

The standard version of DVDConductor supports two video angles (tracks). You can
increase this to nine angles (tracks) by installing the DVDPowerPack upgrade.

Per the DVD-Video Specification, DVDMaestro supports up to nine camera angles within
each DVD Movie, which allows the end-user to choose a desired point-of-view for the
video action taking place. The angles are created using multiple video tracks within the
DVD Movie’s Video Timeline.
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Appended Asset
See Concatenate and Super-Video Asset.

Aspect Ratio
The ratio of the video image width relative to its height. A conventional TV has an aspect
ratio of 4:3, while the HDTV standard has a “Widescreen” aspect ratio of 16:9. Spruce
authoring software supports both 4:3 and 16:9 aspect ratios for DVD Movies. Also see
Letterbox and Pan-Scan.

Assets
“Source” video, audio, and still image files imported into a Project for use in DVD Movies
and DVD Menus. Spruce authoring software supports a wide range of asset formats.

Assets Bin
A display area in the Spruce authoring software application used to import video, audio,
and other assets. Normally the Assets Bin resides outside the Workspace as a pane.

Audio Bit Stream
A relatively uncommon compressed digital audio file format supported by Spruce
authoring software, for use as an imported audio asset. Its file extension is “.abs”. Not to be
confused with audio stream.

Audio Stream
See Stream.

Audio Timeline
See Timelines.

Audio Track
See Tracks.

Audio_ts Folder
A folder that is created automatically by Spruce authoring software (along with a Video_ts
folder) when a Project is compiled. Currently, this folder is unused by Spruce authoring
software, since it is reserved for the forthcoming DVD-Audio Specification. (Compiled
Spruce authoring software audio information is located in the Video_ts folder.) “Audio_ts”
stands for Audio Title Set. Also see Video_ts Folder.
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ABackground Image
The primary or “background” image component of a DVD Menu. Each menu can consist
of up to two images: a background image plus a subpicture (an overlay, which sits “on
top” of the background image). Background images can be still pictures (for “static” DVD
Menus) or motion video (for “dynamic” DVD Menus). Background still images can be up
to 24-bit color and can be in bitmapped, JPEG, or TIFF formats. Also see Subpicture, DVD
Menu, and Dynamic Menu.

Backward Scan
A feature supported by most end-user DVD players and remote controls, which allows
reverse scanning of a disc’s video image.

Bitmapped Image
One of the most common still image formats. Bitmapped images are supported by Spruce
authoring software for use in background image files, subpicture files, and subtitles (mul-
tiple or individual) files. Its file extension is “.bmp”.

Bit-Rate

2-Pass Variable Bit-Rate encoding is not available in the standard version of
DVDConductor. This feature may be added by installing the DVDEncoderPack upgrade.

With Spruce authoring software, bit-rate is the allowable throughput, expressed in a
number of bits per second that is assigned to a video or audio file during encoding. Highly
compressed files operate at a relatively lower bit-rate than files with less (or no) compres-
sion. Spruce authoring software’s Encoder Control Panel supports Constant Bit-Bate (CBR)
encoding, where the bit-rate remains constant during the course of encoding — as well as
1-pass and 2-pass Variable Bit-Rate (VBR) encoding, where the bit-rate is varied in direct
correspondence to the complexity of the video program material. With 1-pass VBR, the
bit-rate is varied “on-the-fly.” With 2-pass VBR, the program material is first analyzed, and
is then encoded; 2-pass VBR takes longer to perform than 1-pass, but its results are gener-
ally superior. As detailed in the Spruce Technologies Encoding Guide that accompanies
this User’s Guide, bit-rates play a significant role when calculating available storage space
for a DVD title.
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Button Action
The state when an end-user, using a remote control, actuates a button highlight area —
including any color mapping which may take place. By choosing BUTTON ACTION in the
DVD Menu editing controls, you will be able to preview how a button highlight area will
be color mapped when the end-user actuates the button highlight area.

Button Highlight Area
An area defined within a DVD Menu as a button “hotspot” — which an end-user can
select or actuate using a remote control. Button highlight areas are typically defined on top
of visible buttons.

Button Highlight Marker
See Marker.

Button Selection
The state when an end-user, using a remote control, selects a button highlight area —
including any color mapping which may take place. By choosing BUTTON SELECTION in the
DVD Menu editing controls, you will be able to preview how a button highlight area will
be color mapped when the end-user selects the button highlight area.

Camera Angle
See Angle.

CBR (Constant Bit-Rate)
See Bit-Rate.

Chapter
A location within a DVD Movie that identifies an “alternate” starting point for video
playback. Spruce authoring software supports up to 99 chapters per DVD Movie.

Chapter Point Marker
An indicator in a DVD Movie which defines the start point for a chapter. Also see Marker.

Chapter Previewer
See Thumbnail Previewer.
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AClip List View Mode
See View Modes.

Color Mapping
The process of converting an original bitmapped image’s colors to one of four new colors
— which are determined by the settings of the color map controls: Color Map 1, Color
Map 2, Color Map 3, and Color Map 4. (In the DVD-Video Specification, these color maps
are known respectively as Emphasis 1, Emphasis 2, Pattern, and Background.) Spruce
authoring software applies color mapping to both subpicture images (which are imported
into DVD Menus) and to subtitles (whether they are individual bitmapped subtitles or
subtitles files).

Command Sequence

This DVDMaestro Power Feature can be added to the standard version of
DVDConductor by installing the DVDPowerPack upgrade.

Command Sequences are special scripts, or codes, that you can incorporate into a Project
to access the native machine code for DVD players, so that new functions will be avail-
able when end-users play back your final, replicated title. Command Sequences appear in
the Project Manager as a separate icon, similar to DVD Movies and DVD Menus. They
also appear as targets in the Connections window, where you can connect any source
(e.g., First Play, Remote Key Action, Button Action, etc.) to a Command Sequence.

Compile (Tool)
A tool used to compile the current Project. Compilation is necessary before a Disc Image
of a Project can be created (which, in turn, is necessary before the Project can be written
to tape). During compilation, Spruce authoring software assembles all the Project’s infor-
mation regarding DVD Menus, DVD Movies, connections, assets, language selections, and
so forth — and multiplexes the audio, video, and graphic overlay (including subpicture
and subtitle) streams. At the same time, Audio_ts and Video_ts folders are created and a
.LAY file is written to the Video_ts folder.

Concatenate
Concatenating is the process of appending one video stream with another, so that a DVD
Movie can effectively contain more than one video asset. A concatenated video asset is
known as a “super-video asset.”
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Connections Window
Used to establish “source:target” relationships between DVD Movies, DVD Menus, button
highlight areas, and other elements of a Project.

Copy Generation Management System
& Contents Scramble System

This is a DVDMaestro Power Feature. DVDConductor users can add it by upgrading to
DVDMaestro.

Two copy protection systems supported by DVDMaestro, which restrict how many times,
if any, an end-user is permitted to copy a final, replicated disc.

Copyright Management Information
DVDMaestro offers this option to identify your final, replicated disc as being copyrighted.

Disc Image Creation (Tool)
See Disc Image.

Data Description Protocol (DDP) File
This is the file that is written to tape when you use Spruce authoring software to write to
DLT. This file in turn is used by the mastering/replication facility to prepare your disc.

Direction of Translation
In a dual-layer disc, this defines how the laser in the end-user’s player will read the second
layer of a dual-layer disc. With the Parallel Track Path (PTP, or inner) protocol, both the
first layer (Layer 0) and the second layer (Layer 1) are played back in the same direction.
With Opposite Track Path (OTP, or outer) protocol, the layers are played back in opposite
directions. OTP is used whenever a relatively smooth transition between layers is desired.

Disabled User Actions

This is a DVDMaestro Power Feature. DVDConductor users can add it by upgrading to
DVDMaestro.
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AOptions that allow you to restrict the ability of end-users to perform various activities
during DVD playback, such as the ability to scan forward or backward or to change the
subpicture while a movie is playing back.

Disc Image
With Spruce authoring software, a Disc Image is a “snapshot” of the Project that is created
after you have compiled the Project. Technically, a Disc Image is a UDF-Bridge volume —
the same volume that gets written onto your final, replicated disc. Using the Disc Image
Creation tool, you can write a Disc Image directly to a DVD-R recorder or to a DLT drive.
You can also, if necessary, write the Disc Image to a hard drive (by selecting IMAGE FILE as
the output destination with the Disc Image Creation tool) — although this step is only
required if you are authoring a reordered hybrid DVD-Video/DVD-ROM disc. In this case,
once you have written a Disc Image to the hard drive, you can use the Write Tape or Write
DVD-R tools to write the Disc Image respectively to DLT or DVD-R. Also see Write DVD-
R (Tool), Write Tape (Tool), and Hybrid DVD-Video/DVD-ROM Disc.

Disc Image Properties
One of the three primary properties settings, as accessed by opening the Project Properties
page via the Project Manager, or via the Create Disc Image tool. In the Disc Image Proper-
ties, you choose a range of settings that are related to the Disc Image and to which copy
protection schemes (if any) you wish to employ. These include choosing the DVD Volume
Name, whether you wish to use Macrovision APS copy protection, and more.

Display Condition
An option in Spruce authoring software that allows you to establish certain conditions
under which an end-user will see the current DVD Menu. This is useful if you want a
particular DVD Menu to appear if the end-user has selected a particular audio stream or if
he or she is using a DVD player that was sold in a particular geographical region.

Divx
This now-discontinued distribution system format allowed end-users to purchase special
DVD movie discs for limited-time viewing.

Digital Linear Tape (DLT)
A standard SCSI-based digital tape drive used for creating replication-ready tapes of
Projects. Once a tape has been written successfully, it can be sent to a mastering house/
replication facility.
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Dolby AC-3 (Dolby Digital)
An audio format supported by Spruce authoring software and developed by Dolby Labora-
tories. This format supports stereo as well as multichannel “Dolby Surround” audio in
high-quality, efficiently compressed files. “Dolby Digital” is the official name by which
most consumers know the format, although many professional users still refer to “Dolby
AC-3,” the format’s original name. Its file extension is typically “.ac3”.

Drop-Frame
NTSC color video runs at a timecode frame rate of either a simple 29.97 (“non-drop”) or at
29.97 “drop-frame.” With drop-frame timecode, for every hour of video playback, a total
of 108 frames of video are dropped or skipped. This is done to compensate for the fact that
timecode running at 29.97 frames-per-second runs “slow” relative to actual “wall clock”
time. If you were to time it with a clock on the wall, you’d find that one hour of video
played back at a 29.97 fps rate actually takes 1 hour 3.6 seconds to play back. By drop-
ping, or skipping ahead, two frames each minute (except for every tenth minute), one hour
of 29.97 “drop-frame” video will take exactly 1 hour of wall clock time to play back.
When you add a video asset (with a frame rate of 29.97) to the Video Timeline of a DVD
Movie, Spruce authoring software will automatically recognize if the asset is non-drop or
drop-frame. Also see SMPTE/EBU Timecode.

Dual Layer Break Marker
See Marker.

Dual Layer Disc

This DVDMaestro Power Feature can be added to the standard version of
DVDConductor by installing the DVDPowerPack upgrade.

DVDMaestro can be used to author discs with one or two layers per side. The first layer is
known as “Layer 0”; the second layer is known as “Layer 1.” If you author a dual layer
disc, you will need to establish a Chapter Marker that will be used to define the transition
point between the two layers. A dual layer disc should not be confused with a two sided
disc.

DVD Hardware Decoder Card
With computer-based DVD playback systems (including a DVDStation turnkey system), a
DVD hardware decoder card is used to decode the MPEG video and audio streams. Not to
be confused with a video display card.
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ADVD Menu
Spruce authoring software’s term for a “menu,” as defined by the DVD-Video Specifica-
tion. (We refer to them as “DVD Menus” to distinguish them from the application’s pull-
down menus.) A DVD Menu consists of three components: a background image; a
subpicture image; and one or more button highlight areas. Spruce authoring software
provides a wide range of controls used to create a DVD Menu and to establish its charac-
teristics. Also see Dynamic Menu and Static Menu.

DVD Movie
Spruce authoring software’s term for a video clip that will be viewed on a replicated DVD-
Video disc. A DVD Movie consists of Timescales, Timelines, tracks, and other components
which are used to assemble video, audio, and subtitle information. Also see Timelines,
Timescales, and Tracks.

DVD-R Recorder
A stand-alone SCSI device that is able to record both DVD-ROM and DVD-Video discs. A
DVD-R recorder is a very useful tool for creating “one-off” discs for proofing your title
(before creating a DLT) or for burning relatively limited runs of discs.

DVD-ROM
A variation of DVD, which is supported by Spruce authoring software. A DVD-ROM
contains UDF Bridge-style data files only. See Hybrid DVD-Video/DVD-ROM Disc.

DVD Volume Name
This is the name that will appear when the end-user inserts a replicated disc into his or her
DVD-ROM computer drive. As you author a title in Spruce authoring software, the pro-
gram will default to using the same name (or a very similar name) as your Project —
though you can change this if you wish.

Dynamic DVD Menu
A DVD Menu with a video file playing in the background, in place of a conventional
“static menu,” which has a still background image. A dynamic menu can also, optionally,
have an audio file playing. Also known as a “motion menu.”
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Encoding
With Spruce authoring software, encoding is the process of “capturing” or “digitizing”
video or audio information from an external source (typically an analog or digital video or
audio deck) onto a hard drive. Encoding involves many variables and formats, as is
detailed in the Spruce Technologies Encoding Guide that accompanies this User’s Guide.
Also see bit-rate.

End State
Used to define how long, after it first appears, a DVD Menu stays visible to the end-user. If
you have created a dynamic DVD Menu with a video stream in place of a background
image, these controls are also used to define what happens after the video has finished
playing.

First Play
What the end-user sees when he or she first inserts the final, replicated disc. Spruce
authoring software always defaults to the “First Play” state when a title is being previewed
using the Navigation Simulator.

Forced I-Frame Insertion

This DVDMaestro Power Feature can be added to the standard version of
DVDConductor by installing the DVDEncoderPack upgrade.

Every Group of Pictures (GOP) begins with an I-Frame, one of three types of frames that
make up a GOP. The I-Frame (Intra Frame) is the only type of frame that can stand by itself
without requiring information from other frames in the GOP. Because the I-Frames have
this “stand-alone” capability, chapter start points in a DVD Movie can be entered only
where an I-Frame is found. Otherwise, the picture could not be reproduced when the
chapter start point is accessed at random. That means that when you create Chapter Point
Markers (which define chapter start points), they may have to be adjusted forward or
backward to fall on an I-Frame. In many instances, this is not a problem. However, if you
wish to place a Chapter Point Marker at a specific frame, you may need to “force” the
occurrence of an I-frame at that location. And to do this, DVDMaestro’s encoding features
gives you the capability of defining a list of timecode locations where I-Frames will be
forced to occur prior to starting encoding. Also see Group of Pictures.
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AForward Scan
A feature supported by most end-user DVD players and remote controls, which allows
forward scanning of a disc’s video image.

Frame Rates
Spruce authoring software supports all standard frame-per-second rates for any supported
video asset. The rates include 24 fps (the “film” standard); 25 fps (the PAL/SECAM stan-
dard); 29.97 fps (the NTSC color standard); and 30 fps (NTSC black & white standard). In
addition, with 29.97 fps, Spruce authoring software supports both “drop-frame” or “non-
drop-frame standards.

General Properties
In Spruce authoring software, one of the three primary properties settings, as accessed by
opening the Project Properties page via the Project Manager. In the General Properties,
you choose the TV System (NTSC or PAL), and the Target Format.

General Purpose Marker
See Marker.

GIF Image
A relatively common still image format that’s supported by Spruce authoring software for
use in background image files and subpicture files. “GIF” stands for Graphic Interchange
Format; its file extension is “.gif”.

Group-of-Pictures (GOP)
A unit, or subdivision, of an MPEG-2-encoded digital video file. Under the constraints of
the DVD-Video Specification, a GOP contains anywhere from one to 29 frames (in NTSC),
or from one to 25 frames (in PAL), depending upon the encoding parameters that were set
for the video file in question. An “I-frame,” or Intra frame, serves as the entry point to each
GOP and is used by Spruce authoring software to “snap” or position any Chapter Marker
to the I-frame of the previous, next, or nearest GOP. Also see Forced I-Frame Insertion.

Hotspot
See Button Highlight Area.
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Hybrid DVD-Video/DVD-ROM Disc

Support for reordered hybrid DVD-Video/DVD-ROM titles can be added to the standard
version of DVDConductor by installing the DVDPowerPack upgrade.

This variation of DVD, supported by Spruce authoring software, is a disc that contains both
DVD-Video information and DVD-ROM information. A personal computer uses a DVD-
ROM drive to read both DVD-ROM discs and DVD-Video discs (assuming the computer
also has a way to decode DVD-Video information, such as a DVD Hardware Decoder
Card).
In some cases, you may need to create a reordered hybrid DVD-Video/DVD-ROM title,
where you reorder the physical layout of the DVD-ROM files as they appear on a disc. In
this case, you will need to write a Disc Image to a hard drive before creating a DVD-R disc
or DLT tape.

I-Frame (Intra Frame)
See Forced I-Frame Insertion and Group of Pictures.

Inverse Telecine (NTSC Film Mode)

This DVDMaestro Power Feature can be added to the standard version of
DVDConductor by installing the DVDEncoderPack upgrade.

When material is transferred from film to video, redundant information can reduce encod-
ing efficiency and can introduce “frame jitter.” These problems can be resolved by using
the Inverse Telecine option in the MPEG-2 Options section of the MPEG Video Encoder
tab of the Settings window. When the Inverse Telecine option is selected, the encoding
process will automatically attempt to detect the redundant fields inserted during the film-
to-video transfer process. During encoding, your Spruce authoring software will then skip
over these frames; after all, there’s no need to re-encode material that has already been
encoded.

JPEG Image
A relatively common still image format that’s supported by Spruce authoring software for
use in background image files, subpicture files, and subtitles (multiple or individual) files.
“JPEG” stands for Joint Photographic Experts Group; its file extension is “.jpg”.
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ALanguage Codes
The ISO 639 standard defines a wide range of multiple language codes for use in creating
discs that contain multiple versions of both audio tracks and subtitle tracks. Using Spruce
authoring software’s support for language codes, you can author titles that allow the end-
user to choose — via a remote control or a DVD Menu — a preferred audio or subtitle
language. Alternately, Spruce authoring software lets you “pre-define” a particular audio
stream or subtitle stream that will automatically be presented to the end-user.

.LAY File
In Spruce authoring software, a file that is written to the Video_ts folder when a Project is
compiled. This file is a “snapshot” of all current Project Properties, which will be used
when you establish your Disc Image Properties. A .LAY file allows you to create a Disc
Image based upon that file without having to re-open or recreate the original Project.

Letterbox
A viewing option that allows a 16:9 video image to be viewed on a 4:3 television without
any cutting off any of the 16:9 image area. Spruce authoring software allows you to define
— on a per-DVD Movie basis — whether end-users can select a preference for
Widescreen “letterboxed” viewing (with black bands above and below the 16:9 image
area) or “pan-scan” viewing, where a 16:9 video image is encoded in a way such that
some information normally on the sides of the video frame is cut off, so that the video
content can fill the entire 4:3 picture frame without any letterboxes. Also see Aspect Ratio.

Line 21 Support (Closed Captions)

This DVDMaestro Power Feature can be added to the standard version of
DVDConductor by installing the DVDPowerPack upgrade.

Refers to the support of closed caption files. DVDMaestro supports the Daikin Industries
Scenarist™ format for closed caption files, which are standardized text files that include
time code data and other information. DVDMaestro also supports captioning information
that is embedded in either of the two video fields, or in both.

Loop Mode (Dynamic DVD Menu End State)
When working with “dynamic” DVD Menus, Spruce authoring software supports the
ability to loop the video file’s playback after it has finished playing for a first time. (Play-
back can resume from the start of the video file or from a time set by the Loop/Subpicture
Start slider.) The video playback will continue to loop indefinitely until the end-user selects
and actuates an action that leads to a DVD Movie or another DVD Menu. In Loop Mode,
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the DVD Menu’s subpicture won’t appear until the video file finishes playing for the first
time, then loops back to begin playing again.

Macrovision APS Copy Protection

This is a DVDMaestro Power Feature. DVDConductor users can add this feature by
upgrading to DVDMaestro.

A analog copy protection scheme which scrambles a copied video signal in order to
discourage end-users from making copies of a DVD-Video disc onto home video cassette
recorders.

Machine Control
See Serial (Machine) Control.

Marker
An category of indicators that can be “dropped” into a DVD Movie’s Marker Timescale. A
Chapter Point Marker defines the start point for a chapter. A Dual Layer Break Marker is
used to indicate a break point in a DVD Movie when authoring a Dual Layer disc. Punch
Point (Punch-In or Punch-Out) Markers are used for establishing in- and out-points when
segment re-encoding or performing a video insert edit. Button Highlight Markers are used
to establish button highlight areas within a DVD Movie. Finally, General Purpose Markers
simply indicates a time location using a visible line in the Marker Timescale. This kind of
utility Marker can be useful, for example, in “spotting” times to be used for subtitling.

Marker Timescale
See Timescales.

Motion Menu
See Dynamic DVD Menu.

MPEG-1 & MPEG-2
An audio/video compression standard, both of which are supported by Spruce authoring
software and the DVD-Video Specification. MPEG-1 video, which compares to VHS tape
quality, has been largely superseded by MPEG-2 video, which can outperform the picture
image of S-VHS tape. Both offer “near CD-quality” stereo audio performance, while
MPEG-2 audio also supports multichannel sound. “MPEG” stands for Motion Picture
Experts Group.
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AMulti-Angle Video
A feature — supported by Spruce authoring software — that allows end-users who are
viewing a DVD disc to switch between parallel video tracks seamlessly with continuous
audio. Multi-angle video is constructed using two or more video tracks in a DVD Movie’s
Video Timeline.

Navigation Simulator
A feature in Spruce authoring software that allows you to navigate a Project in the same
way an end-user would navigate through a final, replicated disc. Using onscreen controls
that duplicate the same controls found on the typical remote control, you can call up and
navigate DVD Menus; you can click on button highlight areas; you can watch (and listen
to) DVD Movies; and you can test all the connections you’ve established to DVD Movies
and other targets. When used in tandem with the RealView Previewer, the Navigation
Simulator can provide an accurate representation of how the title you are currently author-
ing will play back as a final, replicated disc.

NTSC Film Mode
See Inverse Telecine.

NTSC Video
Refers to the one of the international video display standards supported by Spruce
authoring software. NTSC is used throughout North America, Japan, and other regions of
the world. NTSC color video runs at 29.97 frames per second, with a scan rate of 525 lines
at 60 Hz. PAL and SECAM are the other two international standards. “NTSC” stands for
National Television Standards Committee.

NTSC/PAL Monitor
A video display monitor (as opposed to a computer display monitor) that’s compatible with
either NTSC video or PAL video (or SECAM video, which is largely similar to PAL).

Opacity
In Spruce authoring software, an Opacity value effectively describes the degree of a color’s
translucency, as established when color mapping subpictures and subtitle images. Increas-
ing an Opacity value “intensifies” the amount of color; decreasing Opacity lessens the
amount of color, making it more translucent.

Opposite Track Path (OTP)
See Direction of Translation.
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Output Log
A display area within the Spruce authoring software application which keeps a running log
of successful attempts to output Disc Images and to write to tape. It also keeps track of any
Project compilation or Disc Image creation problems. Normally, the Output Log resides
outside the Workspace, as a pane.

Overlay
See Subpicture.

PAL/SECAM Video
PAL and SECAM are two of the world’s three video display standards (NTSC is the other);
all are supported by Spruce authoring software. SECAM is relatively similar to PAL video (if
you are using SECAM, then selecting “PAL” within Spruce authoring software provide
video compatibility). PAL is prominent through much of Europe, South America, and most
of Africa and Asia, whereas SECAM is the predominant standard in France, Russia, and
Eastern Europe. Both PAL and SECAM run at 25 frames per second, with a scan rate of 625
lines at 50 Hz. “PAL” stands for phase alternate line; “SECAM” stands for séquential
couleur à memoire.

Panes
Within Spruce authoring software, panes are windows-like display areas which appear
outside the Workspace. The panes include the Project Manager; the Assets Bin; the
RealView Window; and the Output Log.

Pan-Scan
A viewing option that allows a 16:9 video image to fill the entire picture frame of a 4:3
television. Spruce authoring software allows you to define — on a per-DVD Movie basis
— whether end-users can select a preference for Widescreen “letterboxed” viewing (which
shows the complete 16:9 image with black bands above and below the 16:9 image area)
or “pan-scan” viewing, where a 16:9 video image is encoded in a way such that some
information normally on the sides of the video frame is cut off. With the pan-scan option,
video content can fill the entire 4:3 picture frame without any letterboxes. Also see Aspect
Ratio.

Parallel Track Path (PTP )
See Direction of Translation.
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AParental Level

This is a DVDMaestro Power Feature. DVDConductor users can add this feature by
upgrading to DVDMaestro.

In authoring, you have the option of defining the Parental Level rating, which can be used
to establish a content rating or “parental permissions level” for the title. When your final,
replicated disc is inserted into a DVD player, the player will check the disc’s Parental
Level rating against its own current, password-protected setting. If the Parental Level of the
disc exceeds the permissible rating — for example, if the DVD player is set to allow “G”-
rated titles and an “R”-rated disc is inserted — the player will refuse to play the disc. If you
do not change this selection, it will set to the default (“G”). If you select NOT RATED from the
pull-down field, the Parental Level will default to “G.”

.PCM
A digital audio format supported by Spruce authoring software. Also sometimes known as
“raw” digital audio and most common to the Windows, DOS, and UNIX operating sys-
tems. Unlike Dolby AC-3 or MPEG audio, PCM audio is uncompressed. “PCM” stands for
Pulse Code Modulation and its file extension is “.pcm”. A .WAV or .AIFF file is also an
uncompressed PCM audio file. PCM is also sometimes referred to as “LPCM” or Linear
Pulse Code Modulation.

Project
A Spruce authoring software “document” used to author a title. Similar to a “session,”
“composition,” “sequence,” or similar name that other media tools use when referring to
the current project at hand. Normally, Spruce authoring software titles are created using
just one Project per title, although there are circumstances where more than one Project
may be used to create a title, especially with dual-sided discs.

Project Manager
A display area within the Spruce authoring software application which is used for creating,
editing, duplicating, and otherwise managing DVD Movies and DVD Menus. Certain
properties settings are also accessed via the Project Manager. Normally, the Project
Manager resides outside the Workspace, as a pane.

Project Properties
In Spruce authoring software, this is a dialog where you can tab between the General Proper-
ties, the Disc Image Properties, and the Replication Properties. The Project Properties dialog is
accessed via the Project Manager by right-clicking on the name of the current Project.
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Punch Point Marker
See Marker.

RealView Previewer
A feature of Spruce authoring software that’s used to play back DVD Movies, complete
with video, audio, and subtitles. The RealView Previewer appears onscreen as a “virtual
video monitor,” which can be used in conjunction with — or in lieu of — an external
NTSC or PAL video monitor. Also see Navigation Simulator.

Regional Management Information

This is a DVDMaestro Power Feature. DVDConductor users can add this feature by
upgrading to DVDMaestro.

DVDMaestro supports the DVD-Video Specification’s definitions for geographical regions.
There are currently six such defined international regions (with a seventh for in-flight
movies being proposed as of this writing) and each DVD player sold across the world has
a corresponding regional ID. By “tagging” your Project for a limited number of regions —
or for all six regions — you can define which end-users (according to player IDs) will be
able to play back your final, replicated disc.

Reordered Hybrid DVD-Video/DVD-ROM Disc
See Hybrid DVD-Video/DVD-ROM Disc.

Replication Properties
In Spruce authoring software, one of the three primary properties settings accessed by
opening the Project Properties page via the Project Manager or via the Write Tape tool. In
the Replication Properties, you choose a range of settings that are related to the writing to
tape process or the physical aspects of the final, replicated disc — including Regional
Management Information, whether the disc will be dual layer or two sided, and more.

Safe Area
An option in Spruce authoring software that displays a dotted line around the perimeter of
a DVD Menu, showing the recommend “safe area” boundary for broadcast. Any portions
of the background (or subpicture) which are outside the safe area boundary might not be
seen when your final, replicated disc is played back through (or broadcast to) conventional
televisions.
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ASegment Re-Encoding

This DVDMaestro Power Feature can be added to the standard version of DVDConduc-
tor by installing the DVDEncodingPack upgrade.

The capability to re-encode individual sections of video with individually set bit-rate and
other parameters, without having to re-encode the entire asset from start to finish.
These re-encoded segments are then inserted seamlessly in to the video track — making it
possible to completely optimize the results of 2-Pass VBR encoding. Segment re-encoding
is mostly performed from within the Spruce authoring environment.

Serial (Machine) Control
An industry-standard protocol that allows Spruce authoring systems to control external
video and audio decks for encoding purposes. Known as “serial control” (since commands
are transmitted via an RS-422 serial control cable) or “9-Pin” (based upon the physical 9-
pin DIN connector on most machine control-capable decks) or simply “machine control.”

Slide Show
DVD Movies consisting of still images are known as “slide shows.” These still images can
exist on their own or they can be combined with video assets.

SMPTE/EBU Timecode
A standard for expressing location or length information for video or audio assets. The
standard reference is in “Hours:Minutes:Seconds:Frames” — with the number of frames
per second being 24, 25, 29.97, or 30. The standard frames-per-second rate for NTSC
color video is 29.97; the standard for PAL/SECAM video is 25. Spruce authoring software
automatically recognizes the frame rate of any video asset added to the Video Timeline
area of a DVD Movie. Spruce authoring software will also recognize the timecode
“timestamp” of any video asset that’s added to the Video Timeline and will use that
timestamp to establish the start time for the Video Timeline. “SMPTE/EBU” stands for
Society of Motion Picture & Television Engineers/European Broadcasters’ Union. Also see
Drop-Frame.

Sony 9-Pin
See Machine Control.
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Static DVD Menu
A conventional DVD Menu with a still background image. Also see Dynamic Menu.

Stream
An active video, audio, or subtitle track that’s seen or heard during DVD Movie playback.
Only one of the video, audio or subtitle tracks can be the active stream at any given time.

Stream Pre-Selection
An option within Spruce authoring software associates a button highlight area (which has
already been established as a connection to DVD Movie) with a particular audio or
subtitle stream. This way, a pre-selected audio or subtitle stream will play when the DVD
Movie starts playing. Not to be confused with Stream Selection.

Stream Selection
A feature of the DVD-Video Specification that allows end-users to change various streams
during playback, including the audio stream, the subpicture stream, the angle change, and
the aspect ratio. With Spruce authoring software, Stream Selection is one of the Disabled
User Actions that you can choose within the DVD Movie Properties dialog. Also see
Disabled User Actions. Or, within Spruce authoring software, the act of selecting an active
audio or subtitle stream within a DVD Movie.

Subpicture
An “overlay” image that sits on top of the background image in a DVD Menu. The
subpicture can be any image, but often is used to provide onscreen text for button high-
light areas. Subpictures are also created outside of Spruce authoring software and are
always 2-bit (4-color) color images; if you import a higher bit-depth image, such as a 16-
bit or 24-bit image, then Spruce authoring software will convert it to a 4-color (2-bit)
image based upon the program’s color mapping schemes. See Background Image and
DVD Menu; also see Color Mapping.

Subtitle Editor
A window in Spruce authoring software used for creating individual subtitles or for import-
ing individual bitmapped subtitles. It’s also used for editing any subtitle, including those
originally imported as part of a .stl or .son subtitles file.

Subtitle Stream
See Stream.
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ASubtitle Timeline
See Timelines.

Subtitle Track
See Tracks.

Subtitles
The DVD-Video Specification allows for subtitles to appear over the video image of any
DVD Movie. Spruce authoring software supports up to 32 different subtitle tracks per DVD
Movie, each identifiable by Language Codes. Individual subtitles can be created using the
Subtitle Editor or can be imported as any bitmapped (.bmp), TIFF (.tif), or JPEG (.jpg)
image. Subtitles (script) files can also be imported; see Subtitles (Script) File.

Subtitles (Script) File

This is a DVDMaestro Power Feature. DVDConductor users can add this feature by
upgrading to DVDMaestro.

Unlike individual subtitles that are created (or bit-mapped files that are imported) using the
Subtitle Editor, subtitles files are text files that typically contain a specially coded or
scripted list of up to thousands of subtitles, each timestamped — with start and end
timecodes embedded as part of the file data. This way, when you import a subtitles file
into a subtitle track, each of that file’s subtitles will appear in the track, starting — and
ending — at their timestamped locations. Once in place in the Subtitles Timeline, a
subtitle file typically does not look like one long asset. Rather, each of the subtitles it
contains will be appear independent of one another, in the track, at their respective
timecodes. Subtitles (script) files can be imported in Spruce Technologies text format (.stl);
or Daikin Scenarist™ bit-mapped format (.son).

Super-Video Asset
Spruce authoring software’s term for a video file that has been appended (or concatenated)
with one or more video files within a DVD Movie. Also see Concatenate.
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TGA Image
A relatively common still image format that’s supported by Spruce authoring software for
use in background image files and subpicture files. “TGA” is derived from Targa
Truevision™, a manufacturer’s format; its file extension is “.tga”.

Thumbnail Previewer
A small video display area in each DVD Movie which displays the current frame of
Chapter Marker or of the Playback Cursor (when “scrubbing” or jogging the Marker or
Cursor).

TIFF Image
A relatively common still image format that’s supported by Spruce authoring software for
use in background image files, subpicture files, and subtitles (multiple or individual) files.
“TIFF” stands for Tagged Image File Format; its file extension is “.tif”.

Timecode
See SMPTE/EBU Timecode.

Timecode Timescale
See Timescales.

Timeline View Mode
See View Modes.

Timelines
Areas of a DVD Movie that are used to “construct” the DVD Movie, by adding — and
positioning in time — any desired video, audio, and subtitle assets. Each DVD Movie has
three Timelines: the Video Timeline, Audio Timeline, and Subtitle Timeline. The Audio
and Subtitle Timelines also support multiple tracks within each Timeline; usually these are
used for multiple language versions of audio or subtitles.

Timeout
See End State.
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ATimescale Offset
An option within each DVD Movie that’s used to offset the Timecode Timescale’s starting
time relative to its current starting time. This can be helpful, for instance, if there is a
discrepancy between the video asset’s timestamp and an audio asset’s timestamp. Setting a
timescale offset can also be used, for example, to change the “hours” field to represent a
project or reel number.

Timescales
Areas in a DVD Movie that indicate time. Each DVD Movie has a Wall Clock Timescale
(which shows elapsed time); a Timecode Timescale (which shows current timecode
positioning, usually derived by the Video Asset’s timestamp); and a Marker Timescale
(which is used to create and edit Chapter Markers and to set the starting point for real-time
previewing of the DVD Movie).

Timestamp
SMPTE/EBU timecode information that is embedded within a digital video or audio file.
Spruce authoring software is able to recognize if a video file — or a Dolby AC-3 audio file
— is timestamped, and will use this information is then used to establish the start time for
the Timecode Timescale in the current DVD Movie.

Tracks

The standard version of DVDConductor supports two video tracks. You can increase this
to nine video tracks by installing the DVDPowerPack upgrade.

Tracks are subsections of the Timelines. With DVDMaestro, the Video Timeline has nine tracks
(for each of the possible camera angles) and the Audio and Subtitle Timelines have eight and
32 tracks, respectively. With the standard version of DVDConductor, the Video Timeline has
two tracks. Only one track at any given time can be the active video, audio, or subtitle stream.
Also see Angle and Stream.

Two Sided Disc
DVDMaestro can be used to author discs with one or two sides. If you are creating a two-
sided disc, you will need to write one DLT tape for each side. ( If one or both of the sides
is dual-layer, you’ll actually write two DLT tapes for each side — one for each layer.)
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TV System Properties
One of Spruce authoring software’s General Properties settings where you choose whether
the current Project is destined for NTSC or PAL playback.

UDF-Bridge Volume
A disc volume which supports both Universal Disk Format (UDF) file structure and CD-
ROM-style ISO-9660 file structure. Spruce authoring software Disc Images are UDF-Bridge
volumes.

VBR (Variable Bit-Rate) Encoding
See Bit-Rate.

Verify After Write
A strongly recommended option in Spruce authoring software that can be selected when
writing a DLT tape and which can detect potential problems once the Project has been
written to tape.

Video Display Card
A computer card designed to display an image on a computer monitor. Spruce authoring
software requires a video display card with a standard PC-compatible SVGA output,
capable of 1280 by 1024 resolution at 70 Hz. Not to be confused with a DVD hardware
decoder card.

Video Insert Editing
A process used to replace existing video in a DVD Movie video track with material from
another file. Also see Segment Re-Encoding.

Video Presentation Mode
See Aspect Ratio.

Video Stream
See Stream.

Video Timeline
See Timelines.
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AVideo Track
See Tracks.

Video_ts Folder
A folder that is created automatically by Spruce authoring software (along with an
Audio_ts folder) when a Project is compiled. The Video_ts folder contains all video, audio,
and other data pertinent to the current Project. Also see Audio_ts Folder.

View Modes
By default, DVD Movies appear in Timeline view mode, where assets in the Video
Timeline, Audio Timeline, and Subtitle Timeline appear in position relative to the running
times in the Timescales. Alternately, you can view a DVD Movie in Clip List view mode,
where the video assets appear in a list that resembles a standard Edit Decision List showing
Start and End Times as well as Length for each clip. Clip List view mode is useful for
working with groups of several (or more) video clips. However, it doesn’t provide a
relative visual representation of the DVD Movie; nor does it show any of the assets in the
Audio Timeline or Subtitle Timeline.

Wall Clock Time
A timecode-related term which refers to “real” or sometimes “elapsed” time. Unlike
timecode, which is expressed in terms of “hours:minutes:seconds:frames,” wall clock time
is expressed in terms of “hours:minutes:seconds” much the way one would express the
time on an accurate stopwatch or a wall clock.

Wall Clock Timescale
See Timescales.

.WAV
A digital audio file format supported by Spruce authoring software for use as an imported
audio asset. This is the most commonly used audio format for the Windows operating
system. Unlike Dolby AC-3 or MPEG audio, WAV audio is uncompressed. “WAV” is
derived from Windows audio/video; its file extension is “.wav”. Also see PCM.

Widescreen
See Aspect Ratio.
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Workbook Mode
An option in Spruce authoring software which lets you choose the active pane or window
by clicking on tabs located along the bottom edge of the Workspace.

Workspace
An onscreen area of the Spruce authoring software application in which the DVD Movie,
DVD Menu, and Connections windows appear. Most of the prominent windows and other
displays outside the Workspace (the Project Manager, the Assets Bin, the RealView Pre-
viewer, and the Output Log) are known as panes — although these too can be “floated”
inside the Workspace, if desired.

Write DVD-R (Tool)
Normally this tool is not used, since you can write a Disc Image directly to a DVD-R
recorder using the Disc Image Creation tool (once the Project has been compiled). How-
ever, if you are authoring a reordered hybrid DVD-Video/DVD-ROM title — where you
are adjusting the physical order of the ROM files on the final disc — then you will need to
write Disc Image to a hard drive, after which you can use the Write DVD-R tool to burn a
disc. Also see Disc Image and Hybrid DVD-Video/DVD-ROM Disc.

Write Tape (Tool)
Normally this tool is not used, since you can write a Disc Image directly to a DLT drive
using the Disc Image Creation tool (once the Project has been compiled). However, if you
are authoring a reordered hybrid DVD-Video/DVD-ROM title — where you are adjusting
the physical order of the ROM files on the final disc — then you will need to write Disc
Image to a hard drive, after which you can use the Write Tape tool to write a DLT. Also
see Disc Image and Hybrid DVD-Video/DVD-ROM Disc.

•        •        •
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Appendix B: Macrovision APS

Important Information Regarding Macrovision
APS Copy Protection From Macrovision Inc.

Macrovision digital-to-analog copy protection, the only technology available in the DVD
format to protect against unauthorized consumer copying of content to VCRs, can be
activated using the Spruce Technology authoring system.

The technology works as follows: Users seeking to activate this technology use a dialog
with radio buttons in the Spruce system to activate one of three settings for Macrovision
copy protection. These activation bits remain on the program through the DLT stage and
through replication.

When a disc with these activation bits set to ON is played back in a DVD player, the activa-
tion bits instruct the player or DVD-ROM drive to add Macrovision copy protection to the
outgoing analog video. The copy protected signal is transparent on original viewing, but
causes copies made on most VCRs to be substantially degraded. Currently most movie
DVDs being produced utilize Macrovision copy protection.

As mentioned above, there are three settings for Macrovision copy protection. “Level one”
refers to Automatic Gain Control (AGC) only; “level two” refers to AGC + 2-line colorstripe;
“level three” refers to AGC + 4-line colorstripe.

The AGC Process consists of pulses placed in the vertical interval that televisions do not
detect. When a copy is attempted, these pulses confuse a VCR’s AGC circuitry, causing
copies to exhibit characteristics such as dim and/or noisy pictures, loss of color, loss of
video, and picture tearing. This technology has been used on over two billion videocas-
settes and represents the process that is currently used on most home video product offered
for rental or sale in the U.S.

The Colorstripe Process, which is only available on NTSC, consists of changes to colorburst
information that are transparent on original viewing, but that produce horizontal lines
across the picture on unauthorized copy playback. The 2-line version of colorstripe has
bands of altered chrominance 2 horizontal lines long and the 4-line version has bands of
altered chrominance 4 lines horizontal long. Most DVD movies are currently utilizing level
2: AGC + 2-line colorstripe.
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Rights owners are charged on a per disc basis by Macrovision to be able to utilize this
technology. A Macrovision usage agreement needs to be completed by the rights owner
prior to the Macrovision activation bits being set. There is a no cost agreement between
Macrovision and authoring facilities which describes the procedures facilities are encour-
aged to follow when offering Macrovision copy protection to clients. The agreement allows
facilities to do work for Macrovision-licensed rights owners, to obtain free advertising, and
to receive payments for titles for which the activation bits have been set. Facilities interested
in this program should contact Macrovision:

Macrovision Inc.
tel: +1 (408) 743-8600 • fax: +1 (408) 743-8610

e-mail: acp-info@macrovision.com • web: www.macrovision.com.

Note: Use of analog copy protection for DVD applications is subject to the proprietary
intellectual property rights of Macrovision Corporation, of Sunnyvale, California, USA, and
users require a usage agreement with Macrovision Corporation before the analog protec-
tion system activation bits are set to ON. For further information, please contact
Macrovision via telephone, fax, or the internet, via the numbers or addresses listed above.

•        •        •


